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Confirm that the delivered product is what you have ordered. Read this manual to make sure of correct operation. 

• Be certain to read this manual carefully before performing installation, wiring, or maintenance work, or operating 
the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*.

• The SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* has been manufactured with careful regard to 
quality. However, if you intend to use this product in applications where failure of this equipment may result in 
damage to property or injury, ensure that it used in conjunction with appropriate fail-safe backup equipment.

• In this manual, safety precautions are categorized in order of importance to Warning and Caution:

SAFETY PRECAUTIONS

Warning notices are used to emphasize that improper operation may cause severe 
personal injury or death.

Caution notices are used where inattention might cause personal injury or damage to 
equipment.

 

• When using the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-*, and FT1A-*14SA-* in applications that require a high 
degree of safety such as nuclear equipment, railways, aircraft, medical equipment, and vehicles, give 
consideration to measures such as the addition of fail-safes and backup functions. In addition, we ask that you 
contact your IDEC sales office to confirm the safety of the application according to the specifications and similar 
documents.

• Turn off the power to the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* before installation, 
removal, wiring, maintenance, and inspection of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-*. Failure to turn power off may cause electrical shock or fire hazard.

• Special expertise is required to install, wire, configure, and operate the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-*. People without such expertise must not use the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-*.

• The SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* uses an LCD (liquid crystal display) as a 
display device. The liquid inside the LCD is harmful to the skin. If the LCD is broken and the liquid attaches to 
your skin or clothes, wash the liquid off using soap, and consult a doctor immediately.

• Emergency and interlocking circuits must be configured outside of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-*.

• If relays in the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* output circuits should fail, outputs may 
remain at on or off state. For output signals which may cause serious accidents, configure monitor circuits outside the 
SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*.

• The SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* self-diagnostic function may detect internal circuit 
or program errors, stop programs, and turn outputs off. Configure circuits so that the system containing the 
SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* are not jeopardized when outputs turn off.

• Do not use the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*’s internal touch switches for an 
emergency circuit. If the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* failed, the external 
equipment connected to the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* will no longer be 
protected, and serious injury to operators and equipment damage may be caused.
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• Prevent the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* from falling while moving or 
transporting, otherwise damage or malfunction of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-* will result.

• Use the product within the environmental limits given in the catalog and manual. Use of the product in high-
temperature or high-humidity environments, or in locations where it is exposed to condensation, corrosive gas 
or large shock loads can create the risk of electrocution and fire.

• The SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* are designed for use in pollution degree 2. 
Use the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* in environments of pollution degree 2. 
(based on the IEC60664-1 rating)

• Install the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* according to the instructions. Improper 
installation will result in falling, failure, electrical shock, fire hazard, or malfunction of the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-*.

• Prevent metal fragments or wire chips from dropping inside the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-* housing. Ingress of such fragments and chips may cause fire hazard, damage, and malfunction.

• Use a power supply of the rated value. Using a wrong power supply may cause fire hazard.
• The SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* uses “PS2 of EN61131” as DC power supply. 

(based on the IEC/EN61131 rating)
• Use wire of a proper size to meet the voltage and current requirements.
• Use an IEC 60127-approved fuse on the output circuit and the power line outside the FT1A-*12RA-*, FT1A-*14KA-* and 

FT1A-*14SA-*. This is required when equipment containing the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-* is destined for Europe.

• Use an EU-approved circuit breaker. This is required when equipment containing the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-* is destined for Europe.

• Make sure of safety before starting and stopping the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-*. Incorrect operation of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* may 
cause mechanical damage or accidents.

• Use the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* in a local area network if you download or 
upload the project data via the Ethernet port.

• The touch panel of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* is made of glass, and will 
break if exposed to excessive shock. Take due care when handling it.

• When more than one button is pressed at the same time, due to the detection characteristics of an analog type 
touch panel, only the gravity center of the pressed area is sensed and the unit assumes that only one button is 
pressed. Thus, when more than one button is pressed simultaneously, the resulting operation is not guaranteed.

• The screen becomes blank when the backlight is burnt out; however, the touch panel remains enabled. Incorrect 
touch panel operation will occur when operating the touch panel  when the backlight appears to be turned off 
but is actually burnt out. Note that this erroneous operation may result in damage.

• Do not push hard or scratch the touch panel and protection sheet with a hard object such as a tool, because 
they are damaged easily.

• At temperatures over the rated operating temperature, the clock accuracy is affected. Adjust the clock before use.
• For applications which require clock accuracy, adjust the clock periodically.
• Do not install the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* in areas subjected to strong 

ultraviolet rays, since ultraviolet rays may impair the quality of the LCD.
• Do not attempt to disassemble, repair or modify the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 

FT1A-*14SA-*. This can create the risk of fire or electrocution.
• When disposing of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*, do so as an industrial 

waste.
• Do not switch off the power or pull out the USB flash drive while it is being accessed, as this may result in 

destruction of the stored data. If the data on the USB flash drive is corrupted, format the USB flash drive.
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Handling of Batteries and Devices with Built-in Batteries in EU Member States

Note) The following symbol mark only applies to EU countries.

Revision history

Caution
• The contents of this manual and the WindO/I-NV3 and WindLDR applications are copyright, and all rights are 

reserved by IDEC Corporation. Unauthorized duplication, reproduction, sales, transfers, or leasing is prohibited.
• The contents of this manual and the WindO/I-NV3 and WindLDR applications are subject to change without notice.
• IDEC Corporation accepts no responsibility for circumstances arising from the use of this manual or the 

WindO/I-NV3 and WindLDR applications.
• Please contact your vendor or IDEC Corporation with any problems regarding the operation of this product.

Trademarks
WindO/I, WindLDR, WindCFG, SmartAXIS and MICRO/I are registered trademarks of IDEC CORPORATION in JAPAN. 
Microsoft and Windows are trademarks of the Microsoft Corporation of the United States, other countries, or both. 
Adobe is a trademark of Adobe Systems Incorporated.
All other company names and product names used in this manual or the WindO/I-NV3 application are trademarks of 
their respective owners.

Regarding laws and compatible standards
This product adheres to the laws and compatible standards of all countries involved as shown below.

European laws and standards
This product complies with the following EU directives.
•  Low Voltage Directive
•  EMC Directive
To comply with these directives, this product has been designed and evaluated on the basis of the following 
international and European standard.
•  IEC/EN 61131-2: 2007 (excluding the Lite digital I/O status indicators)

North American regulations/standards
This product has obtained the following certification from UL.
• UL508
• CSA C22.2 No.142
• ANSI/ISA 12.12.01
• CAN/CSA C22.2 No.213

This symbol mark means that batteries and accumulators, at their end-of life, should be 
disposed of separately from your household waste.

If a chemical symbol is printed beneath the symbol shown above, this chemical symbol means 
that the battery or accumulator contains a heavy metal at a certain concentration. This will be 
indicated as follows :
Hg : mercury (0.0005%), Cd : cadmium (0.002%), Pd : lead (0.004%)

In the European Union there are separate collection systems for used batteries and accumulators.
Please dispose of batteries and accumulators correctly in accordance with each country or local 
regulation.

March 2013: First Edition

August 2013: Second Edition

June 2014: Third Edition

February 2015: Fourth Edition

March 2016: Fifth Edition

January 2017: Sixth Edition

May 2019: Seventh Edition

December 2019: Eighth Edition
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Marine Standard
This product complies with the following the Marine Standard. (FT1A Version V120 or later)
• ABS (American Bureau of Shipping)
• DNV (Det Norske Veritas)
• LR (Lloyd’s Register)
• NK (Nippon Kaiji Kyokai)
(Touch is not allowed to be installed on open decks.)

When using the Touch as the Marine Standard Approved Products, attach a ferrite core (ZCAT3035-1330 
manufactured by TDK Corporation) to the power cables (2 turns), the cable for each communication port (2 turns). 
And attach a ferrite core (ZCAT3035-1330 manufactured by TDK Corporation) to the cable for communication 
cartridge (2turns). 

For details on the compatible standards and EU Directives, contact the distributor from which you purchased this 
product or visit our web site.
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Preface
This user’s manual describes entire functions, specifications, installation, and operation basics of the SmartAXIS. Also 
included are powerful communications of the SmartAXIS and troubleshooting procedures.
This manual describes SmartAXIS Touch (SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*) and 
WindO/I-NV3 software. The information includes drawing tools, setup procedures, and how to configure all Touch 
operator interfaces.
This user's manual describes the operation and handling of the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and 
FT1A-*14SA-*. Please read it carefully and ensure that you fully understand the functions and performance of the 
SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-* and the WindO/I-NV3 software.

Read the following materials as necessary for your particular application. 

This manual describes the FT1A Series SmartAXIS Touch and the WindO/I-NV3 software.
Unless otherwise specified, SmartAXIS refers to the FT1A Series SmartAXIS Touch.
For the FT1A Series SmartAXIS Pro and the FT1A Series SmartAXIS Lite, refer to the “SmartAXIS Pro/Lite User's 
Manual”.

Type No. References Content

FT9Y-B1390
SmartAXIS Touch User's 
Manual 
(This document)

Describes the hardware specifications of the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-*.

FT9Y-B1382
SmartAXIS Ladder 
Programming Manual

Describes basic operations for ladder programming, instructions for 
monitoring on the SmartAXIS, available devices and instruction lists, and 
details of each instruction.

FT9Y-B1386
SmartAXIS FBD 
Programming Manual

Describes basic operations for function block programming, available 
devices and function block lists, and details of each function block.

External Device Setup Manual

Describes the connection procedures and available devices for various 
communication including the PLC-Link communication, O/I Link 
communication,
and DM Link communication.

WindO/I-NV3 Help
Describes programming for the SmartAXIS Touch series, and usage 
instructions for the WindO/I-NV3 software.

WindLDR Help
Describes usage instructions for WindLDR, programming software for the 
SmartAXIS Pro/Lite series.

Character Table (PDF)

A list of fonts can be used with the SmartAXIS FT1A-*12RA-*, 
FT1A-*14KA-* and FT1A-*14SA-* and WindO/I-NV3. For restrictions on 
using the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*, 
refer to Chapter 2 “1.2 Available Text” on page 2-5.
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Symbols Used in this Document

This manual uses the following symbols to facilitate description.

Symbols

…… Useful information relating to a function

…… Information that requires special attention. Failure to operate the product in accordance with 
the information provided can lead to serious injury or damage.

 …… Indicates the chapter/page of related reference information.

OK …… Screen buttons are indicated by bold text or by using the actual graphic icon.

SHIFT, …… Keyboard keys are indicated by the keyboard inscription in capital letters or enclosed in 
square brackets.

**** …… Controls are indicated by bold text.

A
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Abbreviations, Generic Terms, and Terminology Used in this Manual
Item Description

SmartAXIS Another name for the SmartAXIS FT1A Series.
Touch The generic term for the SmartAXIS FT1A-*12RA-*, FT1A-*14KA-* and FT1A-*14SA-*.
Touch (relay output type) The generic term for the SmartAXIS FT1A-*12RA-*.
Touch (transistor output type) The generic term for the SmartAXIS FT1A-*14KA-* and the FT1A-*14SA-*.
Pro The generic term for the FT1A Series that includes an LCD, excluding the Touch.

Lite
The generic term for the FT1A Series that does not include an LCD, excluding the 
Touch.

MICRO/I Generic term used to refer to the O/I Touchscreen HG2G-S/-5S/-5F, HG3G/4G, HG1F/
2F/2S/3F/4F.

External device
Generic term used to refer to a PLC or micro computer that is connected to and 
communicates with the Touch.

FBD The abbreviation for "function block diagram".

FB
Function block
For example, the AND (logical AND) function block is written as AND FB. 

Device Address
Memory that is capable of storing values in unit of bits or words loaded on the Touch 
and external device.

System Area
Device area that is pre-allocated for exchanging screen management, error information, 
and clock data between the Touch and external device.

PLC Link Communication
A communication method that performs communication with the external device 
according to the setting of the screen and without a program.

DM Link Communication
A communication method that reads to or writes from the Touch device from a 
computer or microcomputer board.

User Communication
A communication method which performs communication with external devices such as 
barcode readers and inverters.

No External Devices
A method that is capable of operating the Touch independently without connecting to 
external device.

O/I Link
A connection format that enables connections of up to 16 units of Touch with high-
speed communication of 115,200bps.

O/I Link Master The Touch unit that is directly connected to external device on the O/I Link network.

O/I Link Slave
The Touch units that are not directly connected to external device on the O/I Link 
network.

WindO/I-NV3 Software for creating projects and data of the Touch.

WindLDR
This is the editor for the control functions of the Touch. It is launched from 
WindO/I-NV3. Operations for creating ladder program or FBD Program are similar to 
those of the WindLDR PLC programming software for the Pro and Lite.

WindCFG
This system configuration tool intuitively implements optimized settings for devices and 
system configurations through a combination of PLCs, operator interfaces, and other 
peripheral equipment by selecting icons and dragging and dropping them.

Project
Data including image data required for operating the Touch, which is created with 
WindO/I-NV3 software.

Manager
WindO/I-NV3 provides tools to manage pictures, text and script etc. With the Managers, 
you can create and manage them in your project.

Setup Generic term used to refer to the common settings in the project.
Project Settings Basic settings of operation in the Setup settings.
Alarm Log A function where the Touch collects log data of alarms.
Data Log A function where the Touch collects data of device addresses.
Script A script is an executable list of commands created by a simple programming language.
Control function The control function by ladder program or FBD program created with WindLDR.

Text Group
A group of 16 texts maximum that is in order to dynamically switch the character 
displayed on the Touch according to the value of device.

Windows Font
Text fonts that can be displayed on the Windows OS on which the WindO/I-NV3 is 
running.

Maintenance Communication Communications between the WindO/I-NV3 and Touch using a dedicated protocol.

Device Monitor
A special Popup Screen on the Touch on which value of device can be displayed or 
changed.

System Screen
Pre-allocated screen dedicated for performing initial setting of the Touch, self-diagnosis, 
and clearing the log data etc.
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External memory For the Touch, a USB flash drive.

Window
Screens that are loaded on to the Base Screen, including Popup Screen and Device 
Monitor.

Drawings Define as as non functional content (i.e. shape, picture, text).
Parts Define as functional content (i.e. button, pilot lamp, commands, etc.)
Object Define as combination of Drawings and Parts placed on WindO/I-NV3 edit screen.
Touch Switch A part that operates a function by pressing parts that have been placed on the screen.

Standard Keypad
Keypad that is displayed when operating Numerical and Character Input parts when 
Standard is selected under Type in the Keypad menu for Numerical and Character 
Input parts.

Keep Device
Generic term for internal devices that are not reset when operation is started. Even 
after the power is turned off, the values are retained by the battery.

Item Description
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This chapter describes SmartAXIS functions and system configuration examples.

  

The SmartAXIS is available in three types: the SmartAXIS Touch, the SmartAXIS Pro, and the SmartAXIS Lite. The 
SmartAXIS Touch is equipped with the HMI functions of an operator interface and PLC control functions. In addition 
to the functions of control and communication as a PLC, the SmartAXIS Pro is equipped with an LCD and operation 
buttons on the front of the module. The SmartAXIS Lite is equipped with the various control and communication 
functions as a PLC. This document describes the SmartAXIS Touch. Unless otherwise specified, SmartAXIS refers to 
FT1A Series SmartAXIS Touch. For the SmartAXIS Pro and Lite, refer to the "SmartAXIS Pro/Lite User's Manual".

The Touch is a small-size programmable controller that is fully equipped with powerful basic functions, various 
communication functions and HMI functions of an operator interface. Use WindO/I-NV3 for creating and managing 
screens and data to used with the Touch.

1.1 Type Numbers

The notation for SmartAXIS Touch type numbers is as follows.

Chapter 1 General Information for SmartAXIS

1 About the SmartAXIS

FT1A - M 12 R A - W
Body color W: Light gray
 B: Dark gray
 S: Silver

Power supply type A: DC power type (24V DC)

Output type R: Relay output
 K: Transistor output (sink output)
 S: Transistor output (source output)

Inputs/outputs 12: 12 I/O points
 14: 14 I/O points

LCD M: Monochrome LCD models
 C: Color LCD models

FT1A: Type number

For a list of models, refer to Chapter 29 “SmartAXIS Specifications”.
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1.2 Features for the Touch

This section describes the features of the Touch.
The Touch is high-performance programmable controller in a compact package and is equipped with high speed 
counters. The Touch enables you to build optimum systems to automate factories or control production lines.

■ Powerful display functions
The Touch is equipped with an LCD and the same display functions as the MICRO/I. You can monitor and modify 
values of devices and monitor basic instructions.
Also, by creating screens and programming control functions, you can display the current time, bar charts, scrolling 
messages, or simple text on the LCD screen. 

■ 32-bit and Floating Point Data Types
For arithmetic commands, it is possible to unsigned 32-bit (D: double word) and signed 32-bit (L: long) arithmetic 
processes, and floating point (F: float) arithmetic processes.

■ Supports Various Languages
Japanese, Roman, Chinese, Taiwanese, Central European, Baltic, and Cyrillic, languages are all supported. In addition 
to the included fonts you can also use any of the Windows fonts on your computer.



SmartAXIS Touch User's Manual 1-3

1 About the SmartAXIS

1

G
eneral Inform

ation for Sm
artAXIS

1.3 Special Functions for the Touch

This section describes the functions of the Touch.

● I/O Related Functions

■ Catch Input
The catch input allows it to receive short input pulses from sensors without regard to the scan time. A maximum of 
four catch inputs can be used.

■ Input Filter
The input filter can be adjusted according to the width of input signals to reject input noises. Selectable input filter 
values to pass input signals are 0 millisecond, and 3 through 15 milliseconds in 1 millisecond increments. 

■ Interrupt Input
The interrupt input can be used to call an interrupt program to respond to an external input that requires a response 
faster than the scan time. A maximum of four interrupt inputs can be used. This can only be used when ladder 
program is selected as the programming language for control function.

■ Stop and Reset Inputs
Stop input is a function to stop the ladder program or FBD program operation for the Touch. Reset input is a function 
to stop the ladder program or FBD program operation for the Touch and clear the value of control devices. Any input 
terminal on the Touch can be designated as a stop or reset input to control the Touch operation.

■ Analog Input
Analog input of 0 to 10V DC or 4 to 20 mA can be converted to a digital value of 0 to 1000. A maximum of two inputs 
can be used as analog inputs.

■ Analog Output
Analog output converts a digital value between 0 and 1000 to analog value of 0 to 10V DC or 4 to 20 mA and outputs 
it. A maximum of two outputs can be used as analog outputs.

■ Remote I/O
When the number of Touch inputs and outputs is insufficient, the number of inputs and outputs can be expanded to 
a maximum of 156 points by connecting the SmartAXIS Pro/Lite as remote I/O slaves. With the remote I/O function, 
the analog inputs on the SmartAXIS that are connected as remote I/O slaves can also be used.

■ Expanded Analog I/O
Expanded analog I/O allows the Touch to handle analog inputs for voltage, current, thermocouples, and Resistance 
thermometer outputs for voltage and current by using analog cartridges. The Touch can be expanded to a maximum 
of four analog inputs and outputs.
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● Pulse I/O Functions

■ High-speed Counter
This function counts high-speed pulse inputs that cannot be measured in normal ladder program or FBD program 
processing.
Use this function for applications such as positioning control with a rotary encoder or motor control. The Touch can 
use singlephase high-speed counters and two-phase high-speed counters. A maximum of four single-phase high-
speed counters and a maximum of one two-phase high-speed counters can be used simultaneously.

Example: Controlling a motor by counting two-phase pulse input with a high-speed counter

■ Frequency Measurement
This function measures the frequency of pulses input to an input terminal. The frequencies of a maximum of one 
input can be measured.

● Convenient Functions

■ Calendar/Clock
The Touch features a real-time clock on-board. Using the calendar and clock function, the Touch can operate 
according to the current date and time. These functions can be used to control time schedule for lighting or air 
conditioning equipments.

■ Security function
The project in the Touch can be protected against reading and/or writing by including a password in the project. This 
function is effective for security of projects.

■ “Keep” or “Clear” Designation of Touch Data
Internal relays, shift register bits, counter current values, and data register values of the control devices can be 
designated to be kept or cleared when the Touch is powered down. All or a specified range of these devices can be 
designated as keep or clear types.

■ RUN/STOP Selection at Startup when “Keep” Data is Broken
When data to be kept such as “keep” designated counter values are broken while the Touch is powered down, the 
user can select whether the ladder program starts to run or not to prevent undesirable operation at the next startup.

■ Log Data
The function allows values of devices to be logged under specified sampling conditions. The sampled values of 
devices are saved in internal memory along with the time of sampling.

■ Timer Interrupt
The timer interrupt can be used to call an interrupt program at a predetermined interval of time without being 
affected by the scan time. This can only be used when ladder program is selected as the programming language for 
control function.

■ PID control
PID control performs temperature control and other types of control using a PID (proportional, integral, derivative) 
arithmetic algorithm. PID control can be performed by automatically calculating the optimal PID value using the auto 
tuning function.
This can only be used when ladder program is selected as the programming language for control function.

Rotary
encoder

Two-phase pulses

High-speed pulse input

Touch

Pulse motor
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WindO/I-NV3 is software that is exclusively designed for operation with the Touch, for specifying settings and 
creating screens and the ladder program or FBD program. The set of data made up of settings, created screens, and 
ladder program or FBD program is called a project.
Using WindO/I-NV3, you create a project and then download it to the Touch, to build the interface necessary for 
operation.

2 About the WindO/I-NV3

Download

Upload

Download

Upload

Touch
Computer

USB flash drive
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The Touch includes multiple modes, so you switch between modes as and when necessary. These modes are called 
operating modes. The functions and the operations and conditions for switching are as follows.

3 Operating Modes

Mode Functions
Conditions required for 
switching to the mode

Run Mode
This is the mode at the time of executing project 
data. The created screen is displayed and the ladder 
program or FBD program is executed.

• Turn ON the power to the Touch.
• Press Run on the Top Page in the System 

Mode.
• The download of the project data is 

completed.

System Mode
Perform initial settings, clock settings, self-diagnosis, 
etc. for the Touch.

• Press down for 3 seconds or more at the top 
left corner of the screen to display the 
Maintenance screen, and then press 
System Mode.

• Using the screen switching button, multi-
buttons, screen switch or multi commands, 
switch to the System Mode.

• All data is cleared using WindO/I-NV3.
• Write the System Area 1 Display screen 

number (address+0) to FFFFh.

Monitor Mode

Monitor Mode is used for monitoring values of 
devices using WindO/I-NV3.
While in Monitor mode, the words "Monitor mode" 
flash at the bottom left of the screen of the Touch.

On the WindO/I-NV3 Online tab, in the 
Monitor group, click Start Monitor.

Data Transfer
Transferring data between a computer and the 
Touch.

• Download project data.

• When switched to System Mode, operation of the Touch stops.
• To display the Maintenance Screen by pressing down for 3 seconds or more at the top left of the screen, 

the Enable Maintenance check box from the System Settings tab of the Project Settings dialog box 
must be checked.

For details about Maintenance Mode, refer to Chapter 28 “1 Maintenance Screen” on page 28-1.
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The following flowchart describes the sequence of step from the screen and the ladder program or FBD program 
creation for the Touch to the Run operation.

1 Launch WindO/I-NV3
Launch WindO/I-NV3.

2 Creating a Project, Screen and ladder program or FBD program
Create a project and performing various settings.
Create display screens and ladder program or FBD program.

3 Downloading the project
Connect the computer to the Touch using a USB cable or Ethernet cable, and download the created project data to 
the internal memory of the Touch.

4 Debug
Using the monitor function, you can correct created project data while confirming actual actions.

5 Troubleshooting
If there is a module or communication-related problem with the Touch, or a problem with the screen settings, the 
ladder program or the FBD program, an appropriate message is displayed at the top of the screen.
In addition, error information is saved to a special data register. By referring to this information and repeatedly 
correcting the project, downloading, and debugging, the project can be completed.

6 RUN
Starting communication with the external device and execute various functions according to the project settings.

4 Flow from Screen and Ladder Program or FBD Program Creation to Run Operation

1 Launch the WindO/I-NV3

2 Creating a Project, Screen and Ladder Program or FBD Program

Modifying the project

5 Troubleshooting

3 Downloading the project

4 Debug

6 RUN

( refer to Chapter 2 “2.1 Starting WindO/I-NV3” on page 2-33)

Creating a new project ( refer to Chapter 3 “1.1 Creating New Project Data” on page 3-1)
         ↓
• Creating new screens ( refer to Chapter 4 “2.1 Creating Screens” on page 4-2)
• Selecting the programming language and creating the program

- Creating new ladder program ( refer to Chapter 12 “Creating Ladder Program” on page 12-5)
- Creating new FBD program ( refer to Chapter 12 “Creating FBD Program” on page 12-33)

( refer to Chapter 23 “2 Downloading” on page 23-11)

(refer to Chapter 24 “Monitor Function” on page 24-1)

( refer to Chapter 30 “Troubleshooting” on page 30-1)
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This chapter describes the minimum system requirements for WindO/I-NV3, how to start and exit it, and the 
configuration of its screens and menus.

  

1.1 Available Data

● Data types
Data type is the format of the data related to the minimum and maximum values of data that can be processed by a 
part and handling of negative and real numbers.
Data types and data ranges that can be used on the Touch and WindO/I-NV3 are listed below.

● Numeric value handling by data type
Data stored in devices is handled as described below.

Chapter 2 WindO/I-NV3 Basic Operations

1 WindO/I-NV3 Specifications

Data type
Required word 

count
Processable data range

BIN16 (+) 1 0 to 65535

BIN16 (+/-) 1 -32768 to 32767

BIN32 (+) 2 0 to 4294967295

BIN32 (+/-) 2 -2147483648 to 2147483647

BCD4 1 -999 to 9999

BCD8 2 -9999999 to 99999999

float32 2 -3.4x1038 to -1.18x10-38, 0 , 1.18x10-38 to 3.4x1038

WindLDR data types are displayed as follows: BIN16(+) as W (word), BIN16(+/-) as I (integer), BIN32(+) 
as D (double word), BIN32(+/-) as L (long), and float32 as F (float).

Data type Data handling

BIN16 (+) Data is handled as an unsigned 16-bit integer.

BIN16 (+/-)
Data is handled as an signed 16-bit integer.
If the sign bit (bit 15) is 1, the value is two’s complement.

BIN32 (+)
Handled as an unsigned 32-bit integer with the starting address 
as the lower word.

BIN32 (+/-)
Handled as a signed 32-bit integer with the starting address as 
the lower word.
If the sign bit (bit 31) is 1, the value is two’s complement.

BCD4

Data is handled as a four digit (16-bit) binary-coded decimal 
value.
Each four bits from bit 0 to bit 11 is handled as the absolute 
value for the 1st to 3rd digit.
Bit 12 to bit 15 is handled as the minus sign (-) when its value is 
F (hex) and it is handled as the absolute value for the 4th digit 
when 0 to 9 (hex).

bit bit
15 01 word

bit bit
15 01 word

Sign bit

bit
31

bit
0Upper word Lower word

bit
0

bit
31 Lower wordUpper word

Sign bit

bit bit
15 01 word

Sign

1st2nd3rd

Absolute value
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Example: Data handling

BCD8

Data is handled as an eight digit (32-bit) binary-coded decimal 
value.
Each four bits from bit 0 to bit 27 is handled as the absolute 
value for the 1st to 7th digit.
Bit 28 to bit 31 is handled as the minus sign (-) when its value is 
F (hex) and it is handled as the absolute value for the 8th digit 
when 0 to 9 (hex).

float32

Data is handled as a 32-bit floating-point real number. The number of significant digits is 6 digits. The 
floating-point type data format conforms to the IEEE (The Institute of Electrical and Electronics Engineers) 
standard for the single precision storage format as explained next.

Single precision floating-point values in IEEE 754 (32 bits)
Single precision floating-point values in IEEE 754 are expressed with a total of 32 bits (2 words) using 1 bit 
for the sign s, 8 bits for the exponent e, and 23 bits for the significand f. The sign bit indicates the sign of 
the expressed value (positive or negative). The exponent is an 8 bit signed integer with a value from -128 
to 127.

Example:

If all bits are 0, the value is “0”.

Data type Data handling

bit
0

bit
31

Absolute value

Lower wordUpper word

Sign

1st2nd3rd4th5th6th7th

s e (exponent) [bit 30 to 23]

bit
31

bit
23

f (significand) [bit 22 to 0]

Represents after the decimal of 1.xxx+127

Sign bit (0: positive, 1: negative)

bit
22

bit
0

bit
30

s e f
0 0 1 1 1 1 1 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1 . 1 × 2 - 2

The internal representation of float32 is described here, but the data for float32 (floating-point real 
numbers) is handled with a special bit configuration, so do not directly access the bits.

Data type Storing 0FFF (hex) in LDR10 Storing FFFF (hex) in LDR10

BIN16 (+)

0FFF (hex) is handled as 4095 (dec). FFFF (hex) is handled as 65535 (dec).

BIN16 (+/-)

0FFF (hex) is handled as 4095 (dec). Sign bit is 1, so FFFF (hex) is two’s complement, 
handled as -1 (dec).

Data type
Storing 0FFF (hex) in LDR10, FFFF (hex) in 

LDR11
Storing FFFF (hex) in LDR10, FFFF (hex) in 

LDR11

BIN32 (+)

0FFFFFFF (hex) is handled as 268435455 (dec). FFFFFFFF (hex) is handled as 4294967295 (dec).

bit bit
15 0

0FFF (Hex)

LDR10

0000111111111111

bit bit
15 0

FFFF (Hex)

LDR10

1111111111111111

bit bit
15 0

0FFF (Hex)

LDR10

1111111111110000

+

bit bit
15 0

FFFF (Hex)

LDR10

1111111111111111

−

bit
31

bit
0LDR11 LDR10

00001111111111111111111111111111

0FFFFFFF (Hex)

bit
31

bit
0LDR11 LDR10

1111111111111111111111111111

FFFFFFFF (Hex)

1111
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BIN32 (+/-)

The sign bit is 0, so the positive number 0FFFFFFF 
(hex) is handled as 268435455 (dec).

Sign bit is 1, so two’s complement of the negative 
number FFFFFFFF (hex), handled as -1 (dec).

Data type
Storing 5678 (hex) in LDR10, 1234 (hex) in 

LDR11
Storing F765 (hex) in LDR10, 4321 (hex) in 

LDR11

BCD8
The sign is 1 (hex), so the binary-coded decimal 

value of the positive number 2345678 (hex), 
handled as 12345678 (dec).

The sign is F (hex), so the binary-coded decimal 
value of the negative number 7654321 (hex), 

handled as -7654321 (dec).

Data type Storing 0000 (hex) in LDR10, BFA0 (hex) in LDR11

float32

In the data types BIN32 (+), BIN32 (+/-), BCD8, and float32, two words (upper word and lower word) are 
used for a single value. The Touch and external device communicate data in device addresses in one word 
units, so when the upper word and lower word are sent in separate packets, the value may have already 
changed when the data for both words is received, which may cause an unexpected result.

Data type
Storing 0FFF (hex) in LDR10, FFFF (hex) in 

LDR11
Storing FFFF (hex) in LDR10, FFFF (hex) in 

LDR11

bit
31

bit
0LDR11 LDR10

00001111111111111111111111111111

0FFFFFFF (Hex)+

bit
31

bit
0LDR11 LDR10

11111111111111111111111111111111

FFFFFFFF (Hex)−

bit
0

bit
31

2345678 (Hex)

LDR10LDR11

+

00010010001101000101011001111000

bit
0

bit
31

7654321 (Hex)

LDR10LDR11

−

00010010001101000101011001111111

bit bit
22 0

bit
31

bit
23

Exponent

LDR10LDR11

Sign Significand

10111111101000000000000000000000

0000 (Hex)BFA0 (Hex)

1 0100000000000000000000001111111

2-2 = 0.2520+21+22+23+24+25+26 = 127
Negative

−1.25×2127-127 = −1.25
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● Indirect Read and Indirect Write Settings
The indirect specification of a device address means to add a value (indirect value) to the address of the configured 
device and use that address as the actual read source or write destination. You can change the read source or write 
destination address just by changing this indirect value.

Indirect read

Add the indirect value to the address of the configured device as the read source and read the value of device specified 
indirectly.
Example: To read a value of device specified indirectly into LDR200

When the device address configured as the read source is LDR10 and the indirect value’s device address is 
D21, if 4 (indirect value: 4) is set in D21, the device address of the value actually read is LDR14.

Indirect write

Add the indirect value to the address of the configured device as the write destination and write to the value of device 
specified indirectly.
Example: To write the value in LDR20 to an indirectly specified device

When the device address configured  as the write destination is LDR100 and the indirect value’s device address 
is D20, if 3 (indirect value: 3) is set in D20, the device address of the value actually written is LDR103.

Parts you can indirectly read and indirectly write

Device configured as read source

Device with actually read value

Indirect value’s device
200LDR11
300LDR12

100LDR10

500LDR14

4D21

500LDR200

4 words
Indirect value

Read

LDR13 400

200LDR101
300LDR102

100LDR100

1000LDR103
3D20

1000LDR20

3 words
Indirect value

Device configured as write source

Device with actually written value
Indirect value’s device

Write

Part Indirect read Indirect write

Word Button YES YES

Multi-Button YES YES

Numerical Input YES YES

Character Input YES YES

Numerical Display YES NO

Word Write Command YES YES

Script Command YES YES

Multi-Command YES YES

• Enter the value for indirect values as the data type BIN16 (+). Indirect values can be set in the range of 
0 to 32767. If you enter a value for the indirect value outside this range, the value before the indirect 
value changes is maintained when reading. When writing, “Device range error” is displayed.
In scripts however, enter a value for the data type set in the script.

• For indirect device reading, decide the read source address after the indirect value changes and after the screen 
changes, and then read the value of device. For external device addresses, communication to read the value of 
device from a external device takes time, so if data is transfered or arithmetic operations are executed before 
the indirect read is finished, processing cannot be executed and the following error is displayed.

Word Button, Word Write Command: Indirect device error

Script Command: Script error
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1.2 Available Text

● Font

Supported Languages

The Touch can display multiple fonts by installing them. In addition to the fonts installed on the Touch, all Windows 
fonts displayed on your computer can be used on the display.

In addition, the Touch has a function that switches between two or more text groups dynamically. With this function, 
the registration text of buttons can be switched to different languages according to the conditions.
For details, refer to Chapter 19 “Text Group” on page 19-1.

Font Description

Fonts installed in the Touch

Fonts to be pre-loaded on the Touch.
Japanese, European, Chinese, Korean, Taiwanese, Central European, Baltic and Cyrillic 
fonts can be installed on the Touch.
The installed fonts installed can be changed as needed using WindO/I-NV3, which 
helps save and efficiently operate the user capacity.

Windows Font

All fonts used on the computer can be displayed on the Touch.
The Windows fonts allow you to display expressive characters on the Touch screen as 
needed.
Windows fonts are downloaded as part of the project data.

External device
Touch

目標達成

Goal reached

D100 : 1

D100 : 2

D100 : 3

Text ID : 1 目標達成

Group 1: Japanese

Goal reached

Group 2: English Group 3: Chinese
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Installed Fonts in the Touch

Font Name Code System Language

Standard 
Fonts

Japanese
JIS 8-bit code 
JIS level-1 and 
level-2 kanji sets

Japanese

English ISO 8859-1 (Latin1)
Icelandic, Irish, Italian, English, Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, Finnish, Faeroese, French

Optional 
Fonts

Japanese large 
font
(first standard)

JIS level-1 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-1 kanji set.
Refer to “High-quality Fonts” on page 2-9.

Japanese large 
font
(second 
standard)

JIS level-2 kanji set
* Install this font to achieve a sharper display of enlarged JIS 
level-2 kanji set.
Refer to “High-quality Fonts” on page 2-9.

Chinese GB2312 Chinese

Korean KSC5601 Korean

Taiwanese BIG5 Taiwanese

European large 
font

ISO 8859-1 (Latin1)
* Install this font to achieve a sharper display of enlarged 
European fonts.
Refer to “High-quality Fonts” on page 2-9.

Central European ANSI1250 Czech, Hungarian, Polish, Slovak, Slovene

Baltic ANSI1257 Estonian, Latvian, Lithuanian, Greenlandic, Lappish

Cyrillic ANSI1251 Bulgarian, Belarusian, Ukrainian, Serbian, Macedonian, Russian

• Japanese, European, and European large font are factory-installed.
The standard fonts cannot be replaced; however, the optional fonts can be downloaded from the 
WindO/I-NV3.

• The Touch displays the single-byte parts of Chinese, Taiwanese, and Korean with ISO 8859-1, and 
supports Hangul characters only in the double-byte part of Korean.
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Available Fonts for Parts

*1 To use a Touch-installed font, the font should be downloaded from the WindO/I-NV3 in advance. 
*2 Windows font can be used for fixed text only. Only the Touch-installed font can be used for the read device data code for the 

Message Display.
*3 Windows font can be used only when the Use Text Manager check box is selected.

Parts Description Touch installed Font*1 Windows Font

Buttons

Bit Button YES YES

Word Button YES YES

Goto Screen Button YES YES

Key Button YES YES

Keypad YES YES

Selector Switch YES YES*3

Lamps
Pilot Lamp YES YES

Multi-State Lamp YES YES

Data Displays

Numerical Input YES NO

Character Input YES NO

Message Display YES YES*2*3

Message Switching Display YES YES*3

Alarm List Display YES YES*3

Alarm Log Display YES YES*3

Numerical Display YES NO

Calendar YES NO

Charts
Bar Chart YES YES*3

Line Chart YES YES*3
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Font Size

Example: When downloading Japanese large font (level-1 kanji set), Chinese, and European large fonts: 

Example: When downloading Chinese and Korean fonts:

Example: When downloading all fonts:

Font Name Code System Size

Optional Fonts

Japanese large font (first standard) JIS level-1 kanji set 477KB

Japanese large font (second standard) JIS level-2 kanji set 424KB

Chinese GB2312 238KB

Korean KSC5601 109KB

Taiwanese BIG5 422KB

European large font ISO 8859-1 (Latin1) 102KB

Central European ANSI1250 6KB

Baltic ANSI1257 6KB

Cyrillic ANSI1251 6KB

The download size of font data is adjusted in multiples of 128KB.
The download size of font data is 128KB when the font size is 0KB or 128KB and smaller.

Font Size

Japanese large font (first standard) 477KB

Chinese 238KB

European large font 102KB

Total size of the font data 817KB

Download size of font data 896KB (817KB is adjusted in multiples of 128KB.)

Font Size

Chinese 238KB

Korean 109KB

Total size of the font data 347KB

Download size of font data 384KB (347KB is adjusted in multiples of 128KB.)

Font Size

Japanese large font (first standard) 477KB

Japanese large font (second standard) 424KB

Chinese 238KB

Korean 109KB

Taiwanese 422KB

European large font 102KB

Central European 6KB

Baltic 6KB

Cyrillic 6KB

Total size of the font data 1790KB

Download size of font data 1792KB (1790KB is adjusted in multiples of 128KB.)
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● High-quality Fonts

The high-quality fonts are the Japanese large fonts (first standard/second standard), and European fonts.
If you download high-quality fonts and select Use large font on the System tab in the Project Setting dialog box, the 
Touch can replace some of the optional fonts with the high-quality fonts.
Scaled text with a background color is replaced and displayed with these fonts for a more attractive look.

High-quality European Font Display (Size 8x16)

W

H
0.5
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1 2 3 4 5 6

0.5
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High-quality Japanese Font Display (Size 8x16)
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High-quality Japanese Font Display (Size 16x16)
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• When the high-quality fonts have not been downloaded into the Touch, the standard fonts are used even 
if Use large font is selected.

• When the Character Input part display font size is 8x16, high-quality fonts are not displayed even if Use 
large font is selected.
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● Windows Font
Selecting Windows Font for the Font property gives you access to all of the fonts installed on your computer for use 
on Drawings and Parts. This allows you to display fonts and languages that are not installed on the Touch.

Windows Font Settings

Windows Font settings are made in the Font Settings dialog box.

1 Click Change in the Windows Font group on the properties dialog box for Drawings, Parts, or on Text Manager.

2 Set each item, and then click OK.

■ Font
Select the font to use.

■ Font style
Select italic, bold, or other style.

■ Size
Select the size of the text.

■ Sample
Shows a preview using the specified font.

■ Character Pitch
Specify character spacing from 0 to 100.

■ Space between lines
Specify line spacing from 0 to 100.

■ Script
Select the character set code.

• The right end of the text may have missing dots if Font style is set to Italic. You can remedy this by 
adding an extra space at the end of the line.

• An alternate font will be used if the Project Data uses a font that does not exist on the computer. This 
means that text will appear differently if the Project Data is opened on another computer.

• The same font may also appear differently for different OS versions.
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Using Windows Fonts

This section describes how to use Windows Fonts.

To register and use a Windows Font in Text Manager

1 Select the Use Text Manager check box on the Properties dialog box for the Text from the Drawings and Parts.

• The Use Text Manager check box may appear in different locations depending on the part. This table shows 
where to find this property:

• The Alarm List Display and Alarm Log Display parts are designed to use the text registered in Text Manager so the 
Use Text Manager check box is not shown.

2 Specify the Text ID for the Windows Font set in Text Manager.

Selecting Windows Font for the Font property dialog box for the Text from the Drawings and Parts disables 
the following options:

• Style: The style set under Windows Font will be used.

• Magnification: The width by height magnification will be set to 1 x 1. Note, Magnification can be 
selected on the Message Display, Message Switching Display, and Alarm List Display 
parts, but will not be reflected on the actual text displayed. To use scrolling on these 
parts, adjust the display area for text using Magnification.

Applicable 
Drawings

Text

Applicable 
Parts

Buttons Bit Button, Word Button, Goto Screen Button, Key Button, Keypad, Selector Switch
Lamps Pilot Lamp, Multi-State Lamp
Data Displays Message Display, Message Switching Display, Alarm List Display, Alarm Log Display
Charts Bar Chart, Line Chart

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Key Button, 
Selector Switch, Pilot Lamp, Multi-State Lamp

Registration Text tab

Keypad Properties of Keypad dialog box

Message Display General tab

Message Switching Display Message tab

Bar Chart, Line Chart Scale tab

• Using the Text ID for the Windows Font set in Text Manager disables these settings in the Properties 
dialog box:

- Align Text: Multiple lines of text are shown aligned center-left when Center is selected. Text is 
shown with right-indented left-aligned when Right is selected.
With right-indented left-aligned formatting, the line containing the most number of 
characters is aligned on the right end while the other lines are aligned to the left 
end of that line.

- Vertical Writing: Horizontal writing is used.

• The maximum number for the unit in the Numerical Input and Numerical Display parts is 4 characters. 
The fifth character and any characters beyond that will appear outside the part.

• In the Message Display, variable text “\@” appears as is.
• With the Alarm List Display and Alarm Log Display, line spacing is not automatically adjusted based on 

the size of the text. Adjust it using the Line Spacing property on the Format tab.
• If text containing a carriage return is used for a label on a Bar or Line Chart, or for an Alarm List Display 

or Alarm Log Display part, it will appear truncated after the carriage return if a non-Windows Font is 
used. The entire text, including the carriage return, is shown when using a Windows Font.

Aligns text to left end of line with most characters

Aligns text to right end of line with most characters
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To select a font in the Properties dialog box

Select Windows for Font on the Properties dialog box for the Text from the Drawings or Parts.
The Font property may appear in different locations depending on the part. This table shows where to find this 
property:

● Character Code Table

Using the Character Code Table

Example: Finding the character code for the character “a” in the table.

The upper four bits of the code are hexadecimal 6.
The lower four bits of the code are hexadecimal 1.
Therefore, the character code for "a" is as follows.

Applicable 
Drawings

Text

Applicable 
Parts

Buttons Bit Button, Word Button, Goto Screen Button, Key Button, Keypad

Lamps Pilot Lamp, Multi-State Lamp

Part Location

Text Properties of Text dialog box

Bit Button, Word Button, Goto Screen Button, Key Button, Pilot Lamp, Multi-
State Lamp

Registration Text tab

Keypad Properties of Keypad dialog box

Upper 4 bits of the code (hexadecimal)

Lower 4 bits of the code (hexadecimal)

Upper 4 bits

Lower 4 bits

"a " :  6 1

For other fonts and two-byte characters, refer to the table of the relevant code system.
Japanese (two-byte characters): JIS first standard/second standard, Chinese: GB2312, Taiwanese: BIG5, 
Korean (Hangul character): KSC5601
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European Font (ISO 8859-1)

Central European Font (ANSI 1250)
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Baltic Font (ANSI 1257)

Cyrillic Font (ANSI 1251)
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Japanese Font (JIS X0201)

Control Codes

Refer to the following table when using control codes in User Communications.
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1.3 Available Number of Colors

The available number of colors that can be used on the WindO/I-NV3 are listed below.

1.4 Available Image Files

• The supported formats for image files displayed on the Touch are BMP (bit map files) and NMF (NV Metafile).
• The NMF (NV Metafile) format is used for the drawing objects created on the editing screen of WindO/I-NV3. 

Graphics can be created by selecting a drawing object on the editing screen and clicking Export as NV Metafile 
from the popup menu.

• Picture Manager supports WME (Windows Metafile), DXF, and ICO (icon files) formats. These files are converted by 
Picture Manager into bitmap files.

● About Picture Manager
Picture Manager is an application for managing graphic elements used for part diagrams and drawings. 
• When saving, deleting, or reducing graphic elements, the following operations are displayed in Picture Manager.

- On the View tab, in the Workspace group, click  (Picture Manager).
- Double click Picture Manager in the Project window.

• To set up the Picture from the Drawings, click on the editing screen where the Picture is positioned to display 
Picture Manager.

• If setting a graphic for a positioned object, display Picture Manager from the Properties dialog box.

Model Target Number of colors

Color LCD models
Picture Manager 65,536 colors

Properties of Drawings and Parts 256 colors

Monochrome LCD models
Picture Manager 8 shades

Properties of Drawings and Parts 8 shades

• The Touch cannot handle image files that are larger than the size of the screen. Images that exceed the 
screen size are not displayed.

• The Numerical Input, Character Input, Message Display, Message Switching Display, Numerical Display, 
Calendar, and Meter cannot correctly display pictures that use a transparent color.

If Picture Manager is displayed from the Properties dialog box of an object on the screen when setting the 
Picture, Reduce, Delete, and Export are disabled.
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● Saving graphic elements in Picture Manager
This section describes how to save drawing objects in Picture Manager. Saved graphic elements can be used for part 
diagrams and drawings.

Saving image files

1 Click Import in Picture Manager.

The Open dialog box is displayed.

2 Specify the image file, and then click Open.

When managing graphic elements by category, click  (Create New Category) to create a new category in 
the Category list, and select it.

Detailed settings can be made using Options from the Open dialog box. Click Options to toggle between 
showing and hiding the items. For details, refer to “Open Dialog Box Options” on page 2-28.
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The graphic element is saved in Picture Manager. The name of the image file becomes the picture name.

(Picture name)

Even when the image is saved to a different category, if a graphic element of the same name is already 
saved in that category, a confirmation message to overwrite the file is displayed.
• Click Yes to overwrite the image.

After overwriting, the image is saved in the list of the selected category, and the previous image is deleted 
from the list.
Example: The graphic element "Picture00" is saved in the category "Pic_Lib."

If the graphic element "Picture00.bmp" is saved to the category "NewBook1," the new image 
"Picture00" is saved to "NewBook1," and the image named "Picture00" that was previously in 
"Pic_Lib" is deleted.

• Click No to stop saving the graphic element.
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Selecting graphic elements from Symbol Factory

1 Click Symbol Factory in Picture Manager.
Symbol Factory is displayed.

2 Select a category of graphic elements from Categories.
A list showing pictures in the category selected from Symbols is displayed.

When managing graphic elements by category, click  (Create New Category) to create a new category in 
the Category list, and select it.

Click Options to display the Symbol Options dialog box, which can be used to modify fill color and 
background color, and to flip or rotate shapes. The settings made here are applied to all the graphic 
elements in Symbol Factory.
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3 Select a graphic element from Symbols, and then click Copy.
The Picture Name Setting dialog box is displayed.

4 Enter the name of the graphic in Picture Name.

The maximum number is 256 characters.

5 Click OK.
The graphic element is saved in Picture Manager.

You cannot use the following characters in the picture name.
\ / : , ; * ? " < > |

Detailed settings can be made using Options from the Picture Name Setting dialog box. Click Options to 
toggle between showing and hiding the items. For details, refer to “Picture Name Setting dialog box” on 
page 2-32.

If a picture contains transparency or a picture is imported with the option of enabling the transparency, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).
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Saving drawing objects drawn on the editing screen

Drawing objects drawn on the editing screen are saved as pictures, in NMF (NV Metafile) format in Picture Manager.

1 Select and right-click the drawing object, then click Copy to Picture Manager.

The Picture Name Setting dialog box is displayed.

2 Enter the name of the drawing object in Picture Name.

The maximum number is 256 characters.

Grouped drawing objects can be saved to Picture Manager as a single picture.

You cannot use the following characters in the picture name.
\ / : , ; * ? " < > |

Detailed settings can be made using Options from the Picture Name Setting dialog box. Click Options to 
toggle between showing and hiding the items. For details, refer to “Picture Name Setting dialog box” on 
page 2-32.
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3 Click OK.
The drawing object is saved in Picture Manager.

If a picture contains transparency or a picture is imported with the option of enabling the transparency, the 
transparency range is displayed in magenta (R: 255, G: 4, B: 255).
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● Saving pictures as image files
To use a picture saved in Picture Manager on another computer, save the picture as an image file.

1 Select a picture to export, and then click Export.

The Save As dialog box is displayed.

2 Specify the save location in Save in, and then click Save.

The picture name is entered as File name.

When Picture Manager is called from the Properties dialog box of an object arranged on the screen, Export 
is not enabled.

• To select multiple pictures, press and hold SHIFT or CTRL while you click the specific items.
• To save as an image file in NMF (NV Metafile) format, select and right-click the drawing object drawn on 

the editing screen, then click Export as NV Metafile.
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● Managing Pictures
This section describes items and buttons in Picture Manager, Symbol Factory, and the Picture Name Setting dialog 
box.

Picture Manager

Pictures used in pictures of part diagrams and drawings are managed using Picture Manager.

■  (Create New Category)
Creates a new category in the category list.
The default category name is "NewBookn" (n: Number).

■  (Delete Category)
Deletes a category from the category list.

■  (Rename Category)
Changes the name of the category selected in the category list. The maximum number is 256 characters.

■  (Delete)
Deletes the picture selected in the picture list. Pictures that are used in project or parts cannot be deleted.

■  (Reduce)
Deletes all the pictures not used in the project from the pictures saved in the picture list.

■  (View)

Change how items appear in the picture list. Click  to select Thumbnails or Details.

(Category)

(Category list)

(Picture list)

(Image)

(Picture name)

You cannot use the following characters in the category name.
\ / : , ; * ? " < > |
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■ (Category List)
Selects a category to save to when saving pictures.
When selecting a picture, select the category in which the arranged picture is saved.

The only default category is "Pic_Lib." To add a category, click  (Create New Category).

■ (Picture list)
The saved pictures are displayed as a list of images.

■ Import
Save pictures in Picture Manager. Click this button to display the Open dialog box. For details, refer to “Saving image 
files” on page 2-19.
Supported file formats are as follows. When selecting images that are not in a bitmap file format, the image is 
converted to a bitmap before saving.
• BMP (bitmap file)
• WMF (Windows Metafile)
• DXF and JPEG
• ICO (icon files)
• NMF (NV Metafile)

■ Export
Saves a picture selected in the picture list in BMP (bitmap) or NMF (NV Metafile) format, according to file type. Click 
this button to display the Save As dialog box. For details, refer to “Saving pictures as image files” on page 2-25.
Saved graphics can be saved using Import.

■ Symbol Factory
Display the Symbol Factory images. You can select an image provided by Symbol Factory on your project data. For 
details, refer to “Symbol Factory” on page 2-29.

■ Advanced
Displays detailed information about pictures selected in the picture list.
 

(Category):  The name of the category is displayed.

(Image): An image of the picture is displayed. If a picture contains transparency or a picture is imported 
with the option of enabling the transparency, the transparency range is displayed in magenta 
(R: 255, G: 4, B: 255).

(Picture Name): The name of the picture is displayed.

When saving image files in DXF format, take note of the following points.
• Compatible with AutoCAD Ver. 2.2 to 2002. Compatibility with AutoCAD LT97 is confirmed by IDEC.
• If TrueType fonts are used, there is no garbling of text when Japanese is included in files. SHX format is 

not supported.
• Errors may occur in conversion of coordinates, resulting in displacement of position. In addition, if an 

image is greatly reduced when resizing at the time of saving, lines in the picture may disappear.
• If either the height or width is set to 0 when saving, the aspect ratio is preserved with reference to the 

other dimension. 

To save images in NMF format without conversion to bitmap file format, select and right-click the picture on 
the editing screen, and then click Copy to Picture Manager from the popup menu. For details, refer to 
“Saving drawing objects drawn on the editing screen” on page 2-23.

(Picture Name): Displays the picture name.

(File Type): Displays the file type.

Image Size (W×H): Displays the size of the picture (W×H) in pixels

File Size: Displays the size of the file (KB).
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■ Select
Closes Picture Manager and sets the picture selected in the picture list.

■ Close
Closes Picture Manager.

Open Dialog Box Options
Specify advanced settings when saving image files.

■ Options << 
Toggles between showing and hiding the option items.

■ Apply Dithering
Selects this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully
when they are saved. 

■ Color Exchange

(Color before conversion) (Color after conversion)

(Option items)

Selects this check box to convert the color of the picture.

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 8 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent can also be selected.

If a color conversion to transparent is done when the monitor used for WindO/I-NV3 is a 16-bit color or 
256-color display, even colors other than the color specified in (Color before conversion) may appear 
transparent. However, on the Touch they will appear normally.
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Symbol Factory

Symbol Factory is an English-version library tool that offers 5,000 images.

■ Preview
Image size (W×H in pixels) and preview of the picture are displayed.

■ Categories 
The images supplied by Symbol Factory are divided into categories. Selects categories of pictures saved in Picture 
Manager.

■ Symbols
The pictures in the selected category are displayed in a list. Selects a picture saved in Picture Manager.

■ Copy
Copy a picture selected from the Symbols to Picture Manager. Click this button to display the Picture Name Setting 
dialog box.

■ Options
Modify the fill and background color and flip or rotate shapes. Click this button to display the Symbol Options dialog 
box.

For details, see online help for Symbol Factory.
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Symbol Options Dialog Box
Modify the fill color and background color, and to flip or rotate shapes. The settings made here are applied to all the 
graphic elements in Symbol Factory.

■ Fill Color

■ Orientation

Fill Color Mode: Select from the following picture color conversion methods.

Original: The color of the image is not changed.

Shaded: The image filled with different shades of the color selected in Fill Color (for a 3D 
effect).

Solid: The image is filled uniformly in the color selected in Fill Color.

Hollow: All color is deleted.

Fill Color: Selects the color used for Shaded or Solid modes. Click this button to display the Color Settings 
dialog box. Select a color from the Color Palette.
This option can only be set when Shaded or Solid are selected as the Fill Color Mode.

Shaded Solid HollowOriginal

Flip: Select from the following flipping methods.

None: The image is not flipped.

Horizontal: The image is flipped horizontally.

Vertical The image is flipped vertically.

Both The image is flipped both horizontally and vertically.

Horizontal Vertical BothNone
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■ Background Color 
Selects the background color of the image when saving an image in Picture Manager or exporting an image using 
Export Symbol from the File menu. Click this button to display the Color Settings dialog box. Select a color from the 
Color Palette.

■ OK
Saves the setting to close the Symbol Options dialog box.

■ Cancel
Closes the Symbol Options dialog box without saving the setting.

■ Defaults
Set options are returned to their default values.

Rotation: Select from the following rotation methods.

0: The image is not rotated.

90: The image is rotated 90° counterclockwise.

180: The image is rotated 180° counterclockwise.

270: The image is rotated 270° counterclockwise.

90 180 270None

When exporting an image in VML or SVG format by clicking Export Symbol from the File menu, this 
setting is not applied. 
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Picture Name Setting dialog box

Specifies a name for images saved in Picture Manager.

■ Image
An image of the picture is displayed.

■ Picture name
Enter a name for the picture. The maximum number is 256 characters.

■ Options <<
Toggles between showing and hiding the option items.

■ OK
Saves the image in Picture Manager.

■ Cancel
Stops saving the image.

■ Apply Dithering
Select this check box to perform dithering (error diffusion method) on images.
This function enables some images with tonal gradations and photo-like pictures to be rendered more beautifully 
when they are saved. 

■ Color Exchange

(Color before conversion) (Color after conversion)

(Option items)

You cannot use the following characters in the picture name.
\ / : , ; * ? " < > |

Select this check box to convert the color of the picture.

From: Specifies color before conversion. Click this button to display the Color Settings dialog box. Specify the color, 
and then click OK.

to: Selects the color after conversion (color: 256 colors, monochrome: 8 shades). Click this button to display the 
Color Palette. Select a color from the Color Palette. Transparent can also be selected.

• To make the background color of the picture saved from Symbol Factory transparent, set (Color Before 
Conversion) and Background Color in the Symbol Options dialog box to R: 254, G: 254, B: 254.

• When the monitor used for WindO/I-NV3 is a 16-bit color or 256-color display, there is a risk that one or 
more of the following phenemona occurs.
- When a color conversion to transparent is done, even colors other than the color specified in (Color 

Before Conversion) may appear transparent. However, on the Touch they will appear normally.
- If converting a background color in Symbol Factory, an image that is copied to the clipboard may have 

its colors reduced to the number of colors displayed by the computer monitor. For this reason, the color 
setting will not match and the color conversion will not be performed.
Save the image again after changing the background color to another color in Symbol Factory.
For example, if the default color (R: 254, G: 254, B: 254) in (Color before conversion) is used, and 
Background Color in Symbol Options dialog box is set to R: 254, G: 254, B: 254, the number of 
monitor colors will match, even if it's 256, so the color conversion will be performed.
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2.1 Starting WindO/I-NV3

■ Windows 10
Click Start, click All Apps, click IDEC Automation Organizer, and then click WindOI-NV3.

■ Windows 8
Click WindOI-NV3 in the tiles on the Start screen.

■ Windows 7
Click Start, click Programs, click IDEC Automation Organizer, and then click WindOI-NV3.

WindO/I-NV3 starts.

2 Starting and Exiting WindO/I-NV3

You can also start WindO/I-NV3 by double-clicking the WindO/I-NV3 icon on the desktop.
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● Automation Organizer Updater dialog box
The Automation Organizer Updater dialog box is a feature that keeps WindO/I-NV3 up to date.
If a new version of Automation Organizer is released, the Automation Organizer Updater dialog box is displayed when 
WindO/I-NV3 starts.

■ Available Updates

■ Description
This area shows the details of the latest changes in the software.

■ Preference
The Update Preference dialog box is displayed when this button is clicked.
To update information when WindO/I-NV3 starts, check this check box.
The Automation Organizer Updater dialog box will be displayed when there is an update.

■ Close
Closes the Automation Organizer Updater dialog box and start WindO/I-NV3.

In order to display the Automation Organizer Updater dialog box, your computer must be connected to the 
Internet.

Date: Shows the date the software was released.
Information: Shows the software's title and version.

Click on this link to connect to IDEC's download site.
The software can be updated by downloading and running the latest version.
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● Project Recovery dialog box
The Project Recovery dialog box is a feature to restore edited project data if your computer crashes while you were 
editing. With this feature, you can return crashed the project to its last-saved state and restore project data that was 
being edited. The Project Recovery dialog box is displayed if there is crashed project data when WindO/I-NV3 starts.

■ (Recovery data list)
This list shows recoverable data for a crashed project.

■ Open
Select the recovery data from the list, and then click this button to open the project data. The recovery data is deleted 
when the project data is saved.

■ Delete
Deletes the recovery data.

■ Cancel
Closes the Project Recovery dialog box.
Recovery data is not deleted. The Project Recovery dialog box will be displayed again the next time WindO/I-NV3 
starts.

2.2 Exiting WindO/I-NV3

Click  and then click Exit WindO/I-NV3.

WindO/I-NV3 ends.

Project Name: Shows the project name.

Last Save Time: Shows the date and time when the data was last saved.

If WindO/I-NV3 crashes in a state where you edit a screen and perform Save Screens after saving the 
project data, the screen is not saved in the project data. Select the recovery data with the Project Recovery 
dialog box and recover the project data.
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This section describes the names and functions that make up WindO/I-NV3.

■ Title bar
The title bar shows the name of the project being edited and the name of this software, “WindO/I-NV3”.

■ Application menu
The application menu displays commands for handling project data such as commands for creating new project data, 
opening project data, and saving project data. For details, refer to “3.1 Application Menu Command List” on page 2-37.

■ Quick access toolbar
The quick access toolbar is an area where you can locate commands that you use frequently. You can customize this 
toolbar by adding or deleting buttons. For details, refer to “3.2 Quick Access Toolbar” on page 2-38.

■ Ribbon
The ribbon shows commands for creating project data and transferring data to the Touch. Common commands are 
separated into their own tabs, so you can quickly execute. For details, refer to “3.3 Ribbon Command List” on page 2-41.

■ Workspace
The workspace is the area where the Project window, the Object List window, the Screen List window, the Part 
List window, and the Toolbox window are located. You can change the position and method for displaying windows 
in the workspace. For details, refer to “3.4 Windows Displayed in the Workspace” on page 2-49.

■ Editing window
The editing window is the area for editing Base Screens, Popup Screens, and Library Screens.

■ Right click menu
The right click menu is a popup menu that is displayed when right clicking the mouse on drawing objects and parts in 
a list. It displays context sensitive commands.

■ Status bar
The status bar shows information such as the type number, communication driver, project data size, and cursor 
position. You can change the items displayed on the status bar. For details, refer to “3.5 Status Bar” on page 2-53.

3 Configuration & Functions

Ribbon

Title bar

Workspace

Editing window

Right click menu

Status bar

Quick access toolbar

Application menu
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3.1 Application Menu Command List

Commands that can be executed from the application button are listed below.

Command Description

New
Interactive Quick Start

Creates project data by configuring settings displayed in dialog boxes step by 
step.

From Templates Creates project data using templates provided with WindO/I-NV3.

Open

WindO/I-NV3 Project Opens project data that has already been created.

Other Formats
Opens project data uploaded from a Touch with Downloader and project data 
saved in the Downloader format.

Save Saves the project data being edited.

Save As
WindO/I-NV3 Project Saves the project data being edited with a new name.

Other Formats
Converts the project data being edited to data that can be used with 
Downloader and saves it.

Print Prints the contents of the project data being edited.

Close Closes the project data being edited.

Recent Projects Shows the list of recently used project data, up to a maximum of ten items.

WindO/I-NV3 Options Customizes WindO/I-NV3 and configures the work environment.

Exit WindO/I-NV3 Exits WindO/I-NV3.
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3.2 Quick Access Toolbar

● Quick access toolbar buttons and menus
Click on a quick access toolbar button or click on ▼ to the right of a button and then click on the displayed command 
to execute that command.

● Customizing the quick access toolbar

If you click the  (Customize Quick Access Toolbar) button, the Customize Quick Access Toolbar menu is displayed.

You can change the quick access toolbar to any desired settings.

■ Changing the buttons displayed on the quick access toolbar
Select only the buttons you want to display on the quick access toolbar.

■ More Commands
You can add or delete quick access toolbar commands.

1 Click  on the quick access toolbar and then click More Commands.

The Customize dialog box is displayed.

Quick access toolbar
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2 Add or delete commands.

To add a command
1 Select the command to add in Choose commands from.
2 Click on the command to add from the list and then click Add>>.

The command is added.

To delete a command
Click the command to delete and then click Remove.
The command is deleted.

■ Show Below the Ribbon
You can change the position of the quick access toolbar to be located below the ribbon.

Click  on the quick access toolbar and then click Show Below the Ribbon.

If you right click a command on the quick access toolbar and click Remove from Quick Access Toolbar, 
that quick access toolbar command can be deleted.

• To change the order of the commands, click a command and then click ▲ or ▼ .
• To return to the quick access toolbar to its default settings, click Reset.
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The quick access toolbar moves below the ribbon.

To return the quick access toolbar to its original position, click , and then click Show Above the Ribbon.

■ Minimize the Ribbon
You can change the format of the ribbon to be displayed only as tabs.

Click  on the quick access toolbar and then check Minimize the Ribbon.

The ribbon is displayed as only tabs.

Click on a tab to display its commands.

To return the ribbon to its original state, click , and then click on the Minimize the Ribbon to remove the check 
mark.

You can also change the quick access toolbar display position to be below the ribbon with the following 
methods.
• Right click the quick access toolbar or the ribbon and then click Show Quick Access Toolbar Below 

the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize dialog box.

You can also return the quick access toolbar to its original position with the following methods.
• Right click the quick access toolbar or the ribbon and then click Show Quick Access Toolbar Above 

the Ribbon.
• Select the Show Quick Access Toolbar below the Ribbon check box on the Customize dialog box.

You can also change the ribbon to be displayed as only tabs with the following methods.
• Right click the quick access toolbar or the ribbon and then click Minimize the Ribbon.
• Double click a tab.
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3.3 Ribbon Command List

● Home
Home is where basic operations are performed such as creating a new screen, editing, and downloading project data.

■ Clipboard

■ Screens

■ Drawings

Command Description

Paste Pastes the contents of the clipboard.

Cut Cuts the selected object from the editing window and copies it to the clipboard.

Copy Copies the selected object to the clipboard.

Duplicate Duplicates the selected object.

Command Description

New

Base Screen Adds a new Base Screen.

Popup Screen Adds a new Popup Screen.

Library Screen Creates a new Library Screen.

Open

Base Screen Opens a Base Screen that has already been created.

Popup Screen Opens a Popup Screen that has already been created.

Library Screen Opens a Library Screen that has already been created.

Open Previous Screen Opens a screen number before the currently selected screen.

Open Next Screen Opens a screen number after the currently selected screen.

Delete Deletes the selected screen.

Reuse Copies another project’s screens.

Command Description

Shapes

Line Draws a line.

Polyline Draws a polyline.

Polygon Draws a polygon.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an arc.

Pie Draws a pie.

Equilateral Polygons
Draws equilateral polygons (equilateral triangle, equilateral diamond, equilateral 
pentagon, equilateral hexagon, equilateral octagon).

Fill
Fills the region with the same color as the fill start point with the specified color 
and pattern.

Picture Inserts a picture.

Text Inserts text.
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■ Parts

Command Description

Buttons

Bit Button Inserts a Bit Button.

Word Button Inserts a Word Button.

Goto Screen Button Inserts a Goto Screen Button.

Key Button Inserts a Key Button.

Multi-Button Inserts a Multi-Button.

Keypad Inserts a Keypad.

Selector Switch Inserts a Selector Switch.

Potentiometer Inserts a Potentiometer.

Lamps
Pilot Lamp Inserts a Pilot Lamp.

Multi-State Lamp Inserts a Multi-State Lamp.

Data Displays

Numerical Input Inserts a Numerical Input.

Character Input Inserts a Character Input.

Picture Display Inserts a Picture Display.

Message Display Inserts a Message Display.

Message Switching Display Inserts a Message Switching Display.

Alarm List Display Inserts an Alarm List Display.

Alarm Log Display Inserts an Alarm Log Display.

Numerical Display Inserts a Numerical Display.

Calendar Inserts a Calendar.

Charts

Bar Chart Inserts a Bar Chart.

Line Chart Inserts a Line Chart.

Pie Chart Inserts a Pie Chart.

Meter Inserts a Meter.

Commands

Bit Write Command Inserts a Bit Write Command.

Word Write Command Inserts a Word Write Command.

Goto Screen Command Inserts a Goto Screen Command.

Script Command Inserts a Script Command.

Multi-Command Inserts a Multi-Command.

Timer Inserts a Timer.
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■ Editing

■ Project

Command Description

Arrange

Bring to Front Moves the selected object to the front.

Send to Back Moves the selected object to the back.

Group Groups multiple objects.

Ungroup Cancels the group.

Align

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal 
Spacing Equal

Aligns selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Aligns selected objects to be equally spaced vertically.

Rotate

Rotate Right 90° Rotates selected drawing objects 90° to the right.

Rotate Left 90° Rotates selected drawing objects 90° to the left.

Flip Vertical Flips selected drawing objects vertically.

Flip Horizontal Flips selected drawing objects horizontally.

Replace
Automatically replaces a specified device address with a separate device 
address.

Select Selects objects in the editing window.

AutoResize
Automatically changes the text size to the object’s size and display 
region.

Increment Address
Enables or disables the increment address function.
A specific value is added to the value of the object’s device address when 
pasting and duplicating parts.

Command Description

Download

Project Data Downloads project data to the Touch.

Files to External Memory
Stops the Touch and then downloads Recipe files (CSV file) to the 
external memory inserted in the Touch. The Touch resumes running 
when files have finished downloading.

Files to External Memory 
while running

Downloads Recipe files (CSV file) to the external memory inserted in the 
Touch without stopping it.

Upload

Project Data Uploads project data from the Touch.

Stored Data in External 
Memory

Uploads data from the External Memory Folder for the currently running 
project.

Compare
Compare Projects

Compares the screen data and scripts in an existing project with the 
project data currently being edited and displays the results of that 
comparison.

Re-verify Updates the comparison results to the most latest state.

Target Info.
Displays version information for the Touch runtime system and project 
information.

Comm.Setup
Configures the communication target and communication conditions 
between the target and the Touch or between the computer and the 
Touch.
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● Configuration
Configuration is where you configure the system settings for the Touch that will use the project data being edited.

■ System Setup

■ Protect

● Online
Online is where you download created project data and files to the Touch, where you upload data from the Touch, 
and where you perform monitoring.

■ Transfer

■ Touch

Command Description

Project Configures Touch operations and functions.

Alarm Log Configures the alarm log.

Data Log Configures the data log.

Operation Log Configures the operation log.

Data Storage Area Changes the allocation of the data storage area.

Preventive Maintenance Configures the preventative maintenance function.

Recipe Configures recipes.

Text Group Configures text groups.

Global Script Configures one global script.

Command Description

User Accounts Configures security function, user accounts, and passwords.

Command Description

Download

Project Data Downloads project data to the Touch.

Files to External Memory
Stops the Touch and then downloads Recipe files (CSV file) to the 
external memory inserted in the Touch. The Touch resumes running 
when files have finished downloading.

Files to External Memory while 
running

Downloads Recipe files (CSV file) to the external memory inserted in 
the Touch without stopping it.

Upload

Project Data Uploads project data from the Touch.

Stored Data in External Memory
Uploads data from the External Memory Folder for the currently 
running project.

Command Description

Target Info.
Displays version information for the Touch runtime system and project 
information.

Clear

All Clears all of the data stored in the internal memory on the Touch.

Alarm Log Data Clears all of the alarm log data stored in the internal memory on the Touch.

Data Log Data Clears all of the data log data stored in the internal memory on the Touch.

Operation Log Data Clears all of the operation log data stored in the internal memory on the Touch.

Data of all Device 
Addresses

Clears the data of all device addresses.

Stored Data in External 
Memory

Clears data saved to the external memory inserted in the Touch.

Format Formats the external memory inserted in the Touch.
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■ Monitors

■ Communication

Command Description

Start/Stop Monitor
Connects the Touch to the external device and starts monitoring. This 
command also stops monitoring.

Screens Shows or hides the Screen Monitor window.

Object List
Displays a value of device in a popup and emphasizes the object that is 
satisfying the trigger condition in the object list or script editor.

Custom Shows or hides the Custom Monitor window.

Batch Shows or hides the Batch Monitor window.

External Devices
Shows or hides the External Device Monitor window during 1:N 
communication.

Back
Returns to the Base Screen that was displayed immediately before the screen 
was changed.

Forward
Advances to the Base Screen that was displayed immediately before the 
screen was changed with the Back command.

Go to Screen

First Screen Switches to the Base Screen with the smallest screen number in the project data.

Previous Screen
Switches to the Base Screen with a screen number one smaller than the Base 
Screen currently displayed. If the screen numbers are not consecutive 
numbers, this command switches to the closest number.

Screen Number Switches to the Base Screen with a specified number.

Next Screen
Switches to the Base Screen with a screen number one larger than the Base 
Screen currently displayed. If the screen numbers are not consecutive 
numbers, this command switches to the closest number.

Last Screen
Switches to the Base Screen with the largest screen number in the project 
data.

Open Current Screens Opens a monitored screen in the editing window.

Command Description

Setup
Configures the communication target and communication conditions between 
the target and the Touch or between the computer and the Touch.
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● View
View is where you can switch the workspace display and display the Tag Editor, Screen Diagram, and various managers.
You can configure the items displayed in the editing window.

■ Workspace

■ Show/Hide

Command Description

Toolbox Shows the Toolbox window. This window displays Parts and Drawings.

Project Window
Shows the Project window. This window displays the saved screens and project 
related information.

Screen List
Shows the Screen List window. The window displays the screens saved in the 
project as thumbnails.

Object List
Shows the Object List window. This window displays all of the graphics and parts 
placed in an editing screen.

Part List Shows the Part List window. This window displays the list of part images.

Tag Editor
Shows the Tag Editor. This window displays the list of registered device address, tag 
name, and comments.

Screen Diagram

Shows the Screen Diagram. This window displays the Overlapping Screen 
information, and the screen numbers and titles of the screens linked by the Goto 
Screen Button, the Goto Screen Command, the Numerical Input, the Character 
Input, the Alarm List Display and the Alarm Log Display.

Comparison Result
Shows the Comparison Result window. This window displays the results of that 
comparison of projects.

Picture Manager Shows Picture Manager. Manages the registered images for project use.

Text Manager
Shows Text Manager. Manages registered text which can be used for Text, Part objects, 
title of Popup Screen, messages with Alarm List Display and Alarm Log Display.

Script Manager Shows Script Manager. Manages registered scripts for project use.

Protocol Manager Shows Protocol Manager. Manages protocols created.

Control Function
Start up WindLDR. This is an editor for performing various control function settings 
and creating ladder programs or FBD programs.

Command Description

Part Name Shows or hides drawing object names and part names.

Device Address Shows or hides device addresses and tag names.

Trigger Condition Shows or hides trigger conditions.

Commands Shows or hides the dotted frame for commands.

Popup Screen
Shows or hides a Popup Screen’s number, display frame, and the part name of the 
part calling that Popup Screen.

Overlay Screens Shows or hides the configured overlay screens.

Security Group
Display Shows or hides the display security group set for parts.

Input Shows or hides the input security group set for parts.

Gridlines Shows or hides the gridlines in the editing window.
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■ Screens

■ Zoom

■ Window

● Format
Format is where you change the style of drawing objects, arrange objects, and change their size.

■ Shape Style

■ Text Style

Command Description

Focus Order Changes the order to move the focus with Numerical Input and Character Input.

State

Reset Returns the displayed images to the default images.

ON/OFF State Switches between the ON image and the OFF image for buttons and lamps.

Previous State Changes the image for the displayed part to the previous state.

State Number
Changes the image for the displayed part to the image for the part with the 
specified number.

Next State Changes the image for the displayed part to the next state.

Text Group Changes the displayed text to the text of the specified text group.

Active User Displays only the parts that correspond to the specified user.

Command Description

Zoom Changes the magnification of the editing window.

Command Description

Close All Closes all editing windows.

Command Description

1 dot Sets the line width to one dot.

2 dots Sets the line width to two dots.

3 dots Sets the line width to three dots.

5 dots Sets the line width to five dots.

Solid Sets the line to solid.

Dot Sets the line to dotted.

Dash Sets the line to dashes.

Long Dash Sets the line to long dashes.

Long Dash Dot Sets the line to long dash dot.

Long Dash Dot Dot Sets the line to long dash dot dot.

Pattern Changes the pattern.

Foreground Color Changes the pattern’s foreground color.

Background Color Changes the pattern’s background color.

Command Description

Regular Sets the text style to regular.

Bold Sets the text style to bold.

Shadow Gives the text a shadow.

Text Color Changes the text color.

Text Background Color Displays the text as if it were highlighted with a highlighter.

Shadow Color Changes the color of the shadow added to text given a shadow.
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■ Arrange

■ Size

Command Description

X-coordinate Changes the X-coordinate of the selected object.

Y-coordinate Changes the Y-coordinate of the selected object.

Bring to Front Moves selected object to the front.

Send to Back Moves selected object to the back.

Group Groups selected objects so they can be handled as a single object.

Ungroup Restores a grouped object to its individual objects.

Rotate Right 90° Rotates selected objects right 90°.

Rotate Left 90° Rotates selected objects left 90°.

Flip Vertical Vertically flips selected objects.

Flip Horizontal Horizontally flips selected objects.

Align Left Aligns selected objects to the left.

Align Center Aligns selected objects to the center.

Align Right Aligns selected objects to the right.

Align Top Aligns selected objects to the top.

Align Middle Aligns selected objects to the middle.

Align Bottom Aligns selected objects to the bottom.

Make Horizontal Spacing 
Equal

Arranges selected objects to be equally spaced horizontally.

Make Vertical Spacing 
Equal

Arranges selected objects to be equally spaced vertically.

Command Description

Width Changes the width of the selected object.

Height Changes the height of the selected object.

Make Same Width Makes the selected objects a uniform width.

Make Same Height Makes the selected objects a uniform height.
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3.4 Windows Displayed in the Workspace

● Changing the position of windows

Disabling docking

You can change the display position of the window by dragging and dropping the title bar of the window or its tab to 
disable docking. Windows that are not docked are called floating windows.
• If you drag the title bar of the workspace window, you can move all the docked windows together.

• If you drag the tab of a workspace window, you can move just the selected window.

Docking windows

You can dock a floating window to WindO/I-NV3’s left, right, top, or bottom frame or a separate window.

1 Drag the window’s title bar or tab.

The  (Docking) icon is displayed.

Drag and drop

Title bar

Drag and drop

Tab

Docking icon
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2 Drop the title bar or tab on the  (Docking) icon to dock that window to WindO/I-NV3’s left, right, top, or bottom 
frame or a separate window.

• If the workspace window is dropped on the  (Docking) icon, it is docked to WindO/I-NV3’s left, right, top, or 
bottom frame.

• If a floating window is dropped on the  (Docking) icon, it is docked to WindO/I-NV3’s left, right, top, or bottom 
frame or a docked window.

When the mouse cursor gets close to a  (Docking) icon while dragging the title bar or tab, the  
(Docking) icon turns blue and the location to dock the window is displayed.

Window docking location
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• If you put the mouse cursor on another window while dragging a floating windows title bar, the  (Docking) icon 

is displayed. Drop the title bar on the  (Docking) icon to dock the floating window to that window. Change the 
displayed window with the tabs.

● Changing the display method of windows

Auto Hide

If the workspace window is docked, you can change the window to automatically hide and show only its tabs.

Click the  (Auto Hide) icon to change the window to show only its tabs.

The window is displayed when you bring the mouse cursor close to the tabs.

Auto Hide icon Tabs

Mouse cursor

• Click  (Auto Hide) to secure the window in place.

• Click  (Close) to close the window.
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The editing windows are displayed side by side.

When multiple editing windows are open, you can display those windows side by side.

Drag the tab of the editing window to display side by side and drop it where the  icon is displayed.

The editing windows are displayed side by side.

Drag and drop

Tab

• You can change the active editing windows by clicking on  or  (Active Files) and selecting the 

editing window.

• Click  (Close) to close the active editing window.
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3.5 Status Bar

● Status bar items

■ Mode
This section of the status bar shows WindO/I-NV3’s current mode.

■ Type Number
This section of the status bar shows the Touch type set in the project data being edited.

■ Communication Driver
This section of the status bar shows the communication driver set in the project data being edited.

■ Data Size
This section of the status bar shows the download data file size for the project data being edited.
When you save the project, the display is updated with the latest information.

■ Position
This section of the status bar shows the X- and Y-coordinates of the mouse cursor in the editing window.

■ Text Group
This section of the status bar shows the current text group. The text displayed in the editing window changes 
according to the displayed text group.

To change the text group, click ▼ and select the text group.

■ Active User
This section of the status bar shows the active user. You can hide or show objects in the editing window according to 
the security group of the displayed user.

To change the active user, click ▼ and select the user.

■ Snap to Grid

Click  to align objects to the grid.

Mode

Type Number Communication Driver

Data Size

Position

Text Group

Active User

Snap to Grid

Grid Settings

Preview

Zoom

Zoom Slider

Zoom Out button
Zoom In button
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■ Grid Settings
You can change the style and spacing of the grid displayed in the editing window.

Click  to display the Grid Settings dialog box. Configure the items, and then click OK.

■ Preview
You can preview an edited screen.

Click  to open the preview window.

Interval: Aligns the gridlines to the specified spacing.
Enter the spacing for the gridlines in Horizontal and Vertical.

Style: Select the grid style with Dot or Line.

Color: Select the grid color.
Click this button to open the color palette. Select the color with the color palette.

(ON/OFF): Click the button to switch between the OFF image and ON image for buttons and lamps.

Copy: You can save the image displayed in the preview window as a bitmap image file by clicking Copy.

The preview display and the actual screen displayed on the Touch may differ.
For example, the image for overlay screens in the preview display is always shown in front. However, when 
drawings and parts overlap on the actual screen, parts are always shown in front irregardless of the order 
of overlay screens.
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■ Zoom
Zoom shows the magnification of the editing window.
Click Zoom on the status bar to display the Zoom dialog box.

● Customizing the status bar
You can change the commands displayed on the status bar.
Right click the status bar and check only the commands you want to display on the status bar.

Specify: You can specify the zoom magnification (50% to 400%).

You can also specify the zoom magnification by dragging the zoom slider or clicking  and .
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4.1 Configuring the Work Environment

You can configure WindO/I-NV3 settings such as mode and options when editing screens, the path when selecting files, 
and the path for automatic backups. The settings configured here are saved even when you exit WindO/I-NV3.
The procedure for configuring the work environment is shown below.

1 Click  and then click WindO/I-NV3 Options.

The WindO/I-NV3 Options dialog box is displayed.

2 Change the settings on each tab as desired.

4 Customizing WindO/I-NV3
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● Edit tab

■ Mode Settings
When placing a part on the screen, select whether or not to display the part’s Properties dialog box.

■ Properties Setting
Select whether or not to display the Properties dialog box for parts in the Advanced mode.

■ Enable Increment Address
When copying or duplicating parts, select this check box to add a specified value (-999 to 999) to the device address 
set for the original part before pasting it to the screen.

■ Enable Increment Station No.
When copying or duplicating parts, select this check box to add a specified value (-999 to 999) to the device station 
number set for the original part before pasting it to the screen.
This option can only be configured if the communication driver Connection is 1:N Communication.

■ Enable Text Auto Resizing
Select this box to automatically change the text size according to a change in part size.

■ Minimize the properties dialog box by clicking Preview button
Select this box to minimize an object's Properties dialog box when you click Preview on its properties dialog box.

■ Auto-change IME
Select this box to enter characters other than alphanumeric characters using the input method editor (IME) in text 
boxes for entering device addresses.

■ Bit Number Symbol
Select the separator for addresses and bits. When manually entering device address, you can enter either separator, 
but they will be displayed using the symbol selected here.

■ Workspace Setup
Displays the Workspace Setup dialog box. You can configure items displayed in the workspace window. For details, 
refer to “4.2 Customizing the Workspace” on page 2-59.

Placement First: The part’s Properties dialog box is not displayed. This mode is for placing the parts on the screen 
and finishing the screen’s design first.

Settings First: Displays the part’s Properties dialog box. This mode is for creating the screen while configuring the 
Properties for the parts.

Basic: Displays the Properties dialog box in Basic mode to use only basic functions.

Advanced: Displays the Properties dialog box in Advanced mode so that all functions can be used.

You can also change the mode by clicking Advanced or Basic in the Properties dialog box for parts.

You cannot enter full-width characters in text boxes that only accept alphanumeric input, even if the IME is 
enabled.
Select this box to use full-width characters in tag names in the device address settings.

Dot (WindLDR Format): Separates the address and bit with a dot.
Example: LDR100.00

Dash (WindO/I-NV3 Format): Separates the address and bit with a dash.
Example: LDR100-0
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● General tab

■ Default Path
Specifies the path when saving project data and opening files.

Click  to display the Select Path dialog box. Select the folder, and then click OK.

■ Save option

Automatic Save Every: Select this check box to automatically backup the project data at fixed time intervals (1 to 
120 minutes).

Backup Save in: Specifies the location to save the backup data.

Click  to display the Select Path dialog box. Select a folder, and then click OK.

Backup data is deleted when the project data is closed.
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■ Font Assignment
This option specifies the text font in the Properties dialog box for objects to display in text boxes and messages to 
display on the screen.
Select a Font in Settings, and then click Change Font to display the Font Settings dialog box. Select the font to 
use, and then click OK.

:

4.2 Customizing the Workspace

You can change the windows that are displayed in the workspace with the Workspace Setup dialog box.

● Screen List tab
This tab changes the Screen List window display.

■ Zoom
Select the zoom magnification for the thumbnails displayed in the Screen List window from the following.
100, 125, 150, 175, 200, 250, 300, 350, 400

● Object List tab
This tab changes the items displayed in the Object List window.

■ List Items
Shows the list of items that can be displayed in the Object List window.

■ Add
Adds an item to Display Items.
Select an item in List Items, and then click this button to add it to Display Items.

■ Delete
Deletes an item from Display Items.
Select an item in Display Items, and then click this button.

■ Display Items
Shows the list of items that are displayed in the Object List window.

Font Assignment configures the fonts displayed in WindO/I-NV3. Fonts displayed on the Touch are not 
changed. To display the same font on the Touch as the font displayed in WindO/I-NV3, select Windows Font 
in the Properties dialog box for objects or Font setting in Text Manager.
For details, refer to “Windows Font” on page 2-12.
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■ Up
Shifts the selected item upward in the Display Items list.

■ Down
Shifts the selected item downward in the Display Items list.

● Parts List tab
This tab changes the items displayed in the Part List window.

■ Show Image Name
Select this box to display the image name for parts in the Part List window.
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This section describes common settings when creating project data.

5.1 Device Address Settings

Device addresses are memory on the Touch and external devices that can store values in bit or word units.
By setting device addresses to parts and functions, you can control the screen display and operation of parts.
Device addresses are specified by combining the device type and address in the following formats.

The device address can be directly entered or it can be set with the Device Address Settings dialog box.

● Direct entry
Enter a device address with the keyboard following the basic format.
To enter the bit (0 to 15) for a word device, enter the address, the bit separator “.” or “-”, and the bit. You can enter 
the address with either separator, but it is displayed according to the Bit Number Symbol setting. Bit Number 
Symbol is set on the Edit tab of the WindO/I-NV3 Options dialog box.

● Specifying a device address with the Device Address Settings dialog box

To display the Device Address Settings dialog box, click  to the right of the text box for setting the device address. 
Use this dialog box to set the device address.

■ Target
Select the device that includes the device address to set from Touch or External Device.

■ Station No.
Specify the station number for the external device. The range that can be specified varies based on the 
communication driver selected.
This option can only be set when 1:N Communication is selected on the Connection of the Select Communication 
Driver dialog box or the Change Communication Driver dialog box.

■ Device Type
Select the device type.
The list only shows device types that can be used.

■ Address
Specify the address. The range that can be set varies based on the device type selected.

■ Bit
Specify the bit (0 to 15) of the word device when a word device is selected in Device.

■ Tag Name
Shows the tag names configured for the selected device address.

5 WindO/I-NV3 Common Operations and Settings

BitDevice type Address .Dot (WindLDR Format):

BitDevice type Address -Dash (WindO/I-NV3 Format):

Address and bit separator
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■ Comment
Shows the comments configured for the selected device address.

■ Tag Editor
Opens the Tag Editor.
With the Tag Editor, you can display the list of device addresses used in the project data being edited and configure 
tag names and comments for device addresses.

Tag names and comments configured in the Tag Editor can be used in WindLDR and WindCFG.
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5.2 Setting Conditional Expressions

Specify conditional expressions with Condition on the Trigger Condition tab.
Conditional expressions are specified by combining data and operators using the following basic format.

Directly enter the conditional expression or specify it with the Trigger Condition Settings dialog box.

● Direct entry
Enter the conditional expression with the keyboard.
• There is no limit on data or operators. However, the maximum number is 480 characters.

• To enter a device address for data, always enclose it with “[” and “]”.
Example:[LDR100] == 10

• To flip bits, enter “~” before the data.
• Parentheses “(” and “)” can be used.

• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.4 About the Priority of the Operator” on 
page 20-53.

● Configuring conditional expressions with the Trigger Condition Settings dialog box
You can easily configure a basic conditional expression using the Trigger Condition Settings dialog box.
• Up to a maximum of five items of data can be used.

• To flip the bits in data, select the Not check box.
• Operator priority is the same as scripts. For details, refer to Chapter 20 “6.4 About the Priority of the Operator” on 

page 20-53.

1 Click Condition  to display the Trigger Condition Settings dialog box.

2 Click Value or Device and enter a value or device address.

To flip the bits in data, select the Not box.

3 Select the operator.

4 Click the next Value or Device and enter a value or device address.

To flip the bits in data, select the Not box.

5 Repeat steps 3 and 4 for the necessary number of conditions.

... (within 480 characters)
to

)()(

to

If you display the Trigger Condition Settings dialog box after directly entering a conditional expression, that 
expression will be reflected in the dialog box. However, if you entered an expression that cannot be 
reflected, the portion of the expression that could not be reflected is deleted when you click OK and close 
the Trigger Condition Settings dialog box.



5 WindO/I-NV3 Common Operations and Settings

2-64 SmartAXIS Touch User's Manual

● Data and operations that can be configured

Data
You can specify these types and values of data for conditional expressions.

Operators

Specify the type of arithmetic operation to execute on the data. (In the table below,  indicates the operator’s left-
hand number,  indicates the right-hand number.)

*1 Returns 1 if satisfied or 0 if not satisfied.

Item Description

Value
Set a constant number as data.
The range that can be set differs according to the selected data type.
For details, refer to “Data types” on page 2-1.

Device Set a device address for a bit device or a word device that stores the value to be handled as data.

Operator Details

Supported 
device

Bit 
device

Word 
device

Arithmetic 
operators

+ Addition Adds  and . NO YES

- Subtraction Subtracts  from . NO YES

* Multiplication Multiplies  and . NO YES

/ Division Divides  by . NO YES

% Modulo Calculates the remainder after dividing  by . NO YES

Relational 
operators*1

== Equal to Compares if  is equal to . YES YES

!= Not equal to Compares if  is not equal to . YES YES

>= Greater than 
or equal to Compares if  is equal or greater than . NO YES

<= Less than or 
equal to Compares if  is equal or less than . NO YES

> Greater than Compares if  is greater than . NO YES

< Less than Compares if  is less than . NO YES

Bitwise 
operators

& Bitwise AND Calculates the logical product (AND) of each bit in  and . YES YES

| Bitwise OR Calculates the logical sum (OR) of each bit in  and . YES YES

^ Bitwise XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

YES YES

~ Bitwise NOT
Flips the logic of each bits of .
For word device and fixed values, 0 will be 65535 and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.

YES YES

<< Left shift Shifts each bit of  to left for  bit(s). NO YES

>> Right shift Shifts each bit of  to right for  bit(s). NO YES

Logical 
operators*1

&& Logical AND Calculates the logical product (AND) of a conditional expression 
and a conditional expression. NO YES

|| Logical OR Calculates the logical sum (OR) of a conditional expression and a 
conditional expression. NO YES

• You cannot select logical operators in the Trigger Condition Settings dialog box.
• You cannot mix bit devices and word devices in a conditional expression.

• As a basic rule, conditional expressions are calculated in order from the left, but when multiple arithmetic 
operations are combined, they are calculated according to the operator priority.
For [D10] == [D11] + [D12] * 2 + [D13], the expression is calculated in the following order.

For the operator priority, refer to Chapter 20 “6.4 About the Priority of the Operator” on page 20-53.

D10 == D11 + D12 2 +* D13

1

2

3

4
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● Setting and operation examples

Settings
Action

Direct entry
Trigger Condition Settings 

dialog box

[M0] == [M1]
The condition is satisfied if the values of 
M0 and M1 are equal.

[M0] == [M1] & [M2]
The condition is satisfied if the result of 
the AND operation on M1 and M2 is 
equal to M0.

[M0] == ~[M1]
The condition is satisfied if the result of 
flipping the bits in M1 is equal to M0.

1234 == [D0]
The condition is satisfied if the value of 
D0 equals 1234.

100 <= [D0] + [D1] + [D2] + [D3]
The condition is satisfied if the result of 
adding the values of D0 through D3 is 
100 or greater.

0 != [D0] % 10

The condition is satisfied if the value of 
the remainder after D0 is divided by 10 
does not equal 0 (the value of D10 
cannot be entirely divided by 10).

[D0] == ~[D1] & ~[D2] & [D3] &
[D4]

The condition is satisfied if the logical 
AND operation on the flipped bits of D1, 
the flipped bits of D2, the value of D3, 
and the value of D4 is equal to D0.

[D10] + [D11] == [D12] + [D13]

The condition is satisfied if the result of 
adding the values of D12 and D13 is 
equal to the result of adding the values 
D10 and D11.

[D10] == [D11] + [D12] * 2 + 
[D13]

The condition is satisfied if the result of 
adding the values of D11, D12 multiplied 
by two, and D13 is equal to the value of 
D10.

100 <= [D0] + [D1] + [D2] + [D3] 
+ [D4] + [D5] + [D6]+ [D7]

(This expression cannot be 
configured in the Trigger 
Condition Settings dialog box 
because it has over 6 items of 
data.)

The condition is satisfied if the result of 
adding the values of D0 through D7 is 
100 or greater.

1 == ([M0] && [M1]) || ([M2] && [M3])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it uses logical operators 
and it contains parentheses
 “(” and “)”.)

The condition is satisfied if the logical OR 
operation on the result of the logical AND 
operation on M0 and M1 and the result of 
the logical AND operation on M2 and M3 
is equal to 1.

[LDR10] + [LDR11] == [LDR12] * 
([LDR13] + [LDR14])

(This expression cannot be 
configured on the Trigger 
Condition Settings dialog box 
because it mixes bitwise 
operators and logical operators 
or it contains parentheses 
“(” and “)”.)

The condition is satisfied if the result of 
multiplying the value of LDR12 by the 
result of adding the values of LDR13 and 
LDR14 is equal to the result of adding 
the values of LDR10 and LDR11.
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The settings and screen data required to run the Touch are contained in a data structure called a Project. You must 
create a project using WindO/I-NV3 and WindLDR, which is an editor to set control function, started from WindO/I-
NV3 before creating the screens and configuring the settings for the Touch. This chapter describes the various 
settings required to create a project.

  

1.1 Creating New Project Data

● Create new project data by using the interactive quick start
You can create project data by following displayed dialog boxes and configuring settings step by step.

1 Click , and then click New.

A New Project dialog box is displayed.

2 Enter the project name, and then click Next.

The Select Product Series dialog box is displayed.

Chapter 3 Project

1 Creating WindO/I-NV3 Project Data

• You cannot use the following characters in the project name.
 \ / : , ; * ? “ < > |

• You cannot create project data in read-only folders or in WindO/I-NV3’s working folders (temporary 
folders that start with “~”).
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3 Select Product Series, Type Number, and Installation, and then click Next.

The Select Communication Driver dialog box is displayed.

■ Product Series
Select the Touch type.

■ Type Number
A list of type numbers associated with the selected Touch is displayed. Select the type number to use.

■ Installation
Select the Touch installation direction from the following options.
Horizontal, Vertical (Counter Clockwise), Vertical (Clockwise), Horizontal (Flip)

4 Select Manufacturer, Protocol, and Connection, and then click Next.

The Project Settings dialog box is displayed.

■ Manufacturer
Select the manufacturer name of the external device used.

■ Protocol
Shows the communication driver list for the select manufacturer. Select the communication driver to use.

■ Connection
Select the connection according to the number of external devices.

You can go back to previous step to change the setting by clicking Previous.

1:1 Communication: The Touch is connected to a single external device.

1:N Communication: The Touch is connected to multiple external devices.

You can go back to previous step to change the settings by clicking Previous.
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5 Configure the settings on each tab as necessary, and then click OK.

For details about the Project Settings dialog box, refer to “3 Project Settings Dialog Box” on page 3-19.

This concludes creating project data.
Next you will create a screen. For details, refer to Chapter 4 “3.1 Base Screen Settings” on page 4-14.

• The Project Settings dialog box can also be accessed using the following methods.
- Click Project on the Configuration tab
- Double click Project Settings in the Project window

• You can go back to previous step to change the settings by clicking Previous.
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1.2 Opening Project Data

● Opening project data
You can open project data that has already been created.

1 Click , and then click Open.

The Open dialog box is displayed.

2 Select the file, and then click Open.

Next you will open a screen. For details, refer to Chapter 4 “2.2 Opening Screens” on page 4-2.

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
the user name and enter its password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.

Click , and then click project data on the Recent Projects list to open a project data.
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1.3 Saving Project Data

● Saving project data
You can save the project data being edited.

Click , and then click Save.
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● Saving project data with a different name
You can save the project data being edited with a different name.

1 Click , and then click Save As.

The Save As dialog box is displayed.

2 Enter the project name, and then click Save.

• You cannot use the following characters in the project name.
 \ / : , ; * ? “ < > |

• You cannot create project data in read-only folders or in WindO/I-NV3’s working folders (temporary 
folders that start with “~”).
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1.4 Printing Project Data

You can print the settings for the project data being edited and its screen images.

1 Click , and then click Print.

The Print dialog box is displayed.

2 Change the settings on each tab as necessary.
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● Print Tab

■ Printer

■ Print Range
Select the items you want to print.

When the following items are selected, their tabs are displayed.

■ Copies

■ Printing Font
Displays the Font dialog box. You can change the font used when printing.

Name: Select a printer connected to the computer or Save As RTF file on disk.
You can output an RTF-formatted file by selecting Save As RTF file on disk.

Set path of RTF file: When outputting an RTF-formatted file, click this button to display the 
Save As dialog box. Specify the saved location, file name, and then 
click OK.

Status: Shows the current status of the printer.

Type: Shows the manufacturer and model of the printer.

Location: Shows the destination or the location to save the file.

Comment: Shows a comment entered in the Printer Properties dialog box.

Project Settings: Prints the project settings.

Screen Settings: Prints the screen settings, a list of the parts on the screen, and a screen image. The details are 
configured on the Screen tab.

Part List: Prints the settings for all parts used in the project.

Device List: Prints the settings for all devices used in the project.

Picture List: Prints the images and settings for drawing objects registered in Picture Manager. The details are 
configured on the Picture tab.

Library List: Prints the settings and images for Library Screens. The details are configured on the Library tab.

Text List: Prints all the text registered in Text Manager.

Script List: Prints all the scripts registered in Script Manager.

Protocol List: Prints the settings for Protocols registered in Protocol Manager. The details are configured on the 
Protocol tab.

Item Reference

Screen Settings “Screen Tab” on page 3-9

Picture List “Picture Tab” on page 3-10

Library List “Library Tab” on page 3-11

Protocol List “Protocol Tab” on page 3-12

Number of copies: Enter the number of copies to print (1 to 100).
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● Screen Tab

■ Type
Select the screens to print from the following items.
All, Base Screen, Popup Screen

■ Range
Select the screens to print from the selected type of screen.

■ Image

■ Screen image only
Prints only the screen type, number, and screen image.

■ Detailed List of Parts
Prints part settings for each screen. This can only be selected when Screen image only is cleared.

■ Device List
Prints device settings for each address. This can only be selected when Screen image only is cleared.

All: Prints all the screens.

Current Screen: Prints the selected editing window screen.

Selected Screens: Prints the selected screens. The selected screens are displayed in a list.

Add: Adds a screen to the list.
Click Add to display the Open Screens dialog box. Select Screen Type, 
select the screen in Screen List, and then click OK to add the screen to 
the list.

Delete: Deletes the screen from the list.
Select the screen in the list, and then click Delete.

State: Changes the state of the parts for printing. Select the state from the following items.
OFF, ON, ON, OFF (Both)

Zoom: Prints the screen image at the specified magnification (20% to 400%).

Invert white and black: Select this to print the screen by inverting the colors so white is black and black is white.

Overlay Screens: Select this to print the screen by displaying overlay screens.

Show Part Name: Select this to print the screen by displaying part names.

Show Device Address: Select this to print the screen by displaying device addresses.
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● Picture Tab

■ Name
Shows a list of selected drawing object names.

■ Zoom
Prints the picture at the specified magnification (20% to 400%).

Add: Adds a drawing object to the list.
Click this button to display Picture Manager. Select a picture, and then click Select to add it to the 
list.

Delete: Deletes a picture from the list.
Select the picture name, and then click this button.
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● Library Tab

■ Name
Shows a list of selected library names.

■ Zoom
Prints the library image at the specified magnification (20% to 400%).

Add: Adds a library to the list.
Click this button to display the Select Library for Print dialog box. Select a library and then click 
OK to add it to the list.

Delete: Deletes a library from the list.
Select a library name and click this button.
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● Protocol Tab

■ Name
Shows a list of selected Protocol names.

Add: Adds a Protocol to the list.
Click this button to display Protocol Manager. Select a protocol, and then click Select to add it to 
the list.

Delete: Deletes a protocol from the list.
Select a protocol name, and then click this button.
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1.5 Comparing Project Data

Compares project data during editing with the screens and scripts of saved projects. 

1 On the Home tab, in the Project group, click Compare.

The Open dialog box is displayed.

2 Select a file to compare with, then click Open.

The Comparison Result window is displayed.

Comparison results are displayed using colored text.

Blue: Complete match

Red: Different content

Green: Only saved in the open project

Gray: Only saved in the comparison project

To compare with the comparison project data again, click the arrow to the right of Compare from the 
Project group of the Home tab, then click Recompare.
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1.6 Changing Project Settings

● Changing Product Series
Changes the product series set in the project data being edited.

1 Click Change Product Series on the status bar.

The Change Product Series dialog box is displayed.

2 Select Product Series, Type Number, and Installation, and then click OK.

The Destination path for Convert dialog box is displayed.

3 Specify the save location and file name, and then click Save.

The data conversion process begins.

4 When the data is finished being converted, click Close.

Color settings (color data) are not converted.
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● Changing Communication Drivers
This section shows how to change the communication driver set in the project data being edited.

1 Click Change Communication Driver on the status bar.

The Change Communication Driver dialog box is displayed.

2 Select Manufacturer, Protocol, and Connection, and then click OK.

The confirmation message is displayed.

3 Check the message, and then click OK.

The Destination path for Convert dialog box is displayed.

4 Specify the save location and file name, and then click Save.

The data conversion process begins.
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5 When the data is finished being converted, click Close.

If there are no devices that correspond to the external device used in the current project data after 
changing the communication driver, the items set with those devices are blank.
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1.7 Closing Project Data

You can close the project data being edited.

Click , and then click Close.

If the project data being edited has not been saved, a confirmation message for saving the project data is 
displayed.

• Click Yes to save the project data and close it.
• Click No to close the project data without saving changes.
• Click Cancel to stop saving the project data.
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The Project Settings dialog box is used to configure Touch operations and functions for the project overall.
This section describes the configuration procedure for project settings.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box is displayed.

2 Change the settings on each tab as necessary.

2 Project Settings Configuration Procedure
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This section describes items and buttons on the Project Settings dialog box.

3.1 System Tab

The System tab is used to configure Touch operations.

■ Screen No. Format
Selects the type of data to use for the System Area 1 Display screen number (address+0) as BCD or BIN.

■ Start Time (sec)
Specifies the time from when the Touch power is turned on until communications start with the external device (0 to 
9999 seconds).

■ Auto Backlight OFF
Select this check box to turn off the backlight when the Touch is untouched for an extended period of time. To turn 
on the backlight, touch the screen or write 1 to System Area 1 Auto Backlight OFF bit (address+1, bit 5) or System 
Area 1 Screen display bit (address+1, bit 7).

3 Project Settings Dialog Box

Default Screen: Specifies the screen number of the Base Screen to display first when the Touch is turned on (0 to 
3000). When 0 is specified, the Touch is in the screen waiting state. Write a screen number to 
System Area 1 Display screen number (address+0) or specify the default screen number from 1 to 
3000.

Time (min): Specifies the time from when the Touch is last used to when the backlight is 
turned off (1 to 9999).

Light ON with Screen Changing: When the backlight is turned off with this function, select this check box to turn on 
the backlight when the screen is switched.
This option can only be configured when the Auto Backlight OFF check box is 
selected.
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■ Touch Sound
Select this check box to play a sound when the screen is pressed.

■ Enable Maintenance
Select this check box to display the maintenance screen during operation. The methods for displaying the 
maintenance screen are as follows.
Press the upper-left corner of the Touch screen for three seconds or more.
If the Base Screen is switched before three seconds have elapsed, the load operation for the maintenance screen will 
be canceled. Please press the screen again.

■ Use Large Font
Select this check box to display text on the Touch in high-quality fonts. The Japanese or European font is replaced 
with the high-quality fonts depending on the magnification.
To use high-quality fonts, the fonts must be downloaded to the Touch at the same time as the project. To download 
fonts, click Options in the Download dialog box to display the Options dialog box. Select the Download additional 
fonts check box, select the check boxes of the high-quality fonts to use (Japanese large font (First standard), 
Japanese large font (Second standard), European large font), and then click OK.
For details on high-quality fonts, refer to Chapter 2 “High-quality Fonts” on page 2-9.

■ Enable Two-point Push
Select this check box to enable two-point push for touch switches. When two-point push is enabled, the bottom 
switch and the switch above it operate in order.
On an analog touch panel, this function operates two overlapping switches when the two are pressed. This is not a 
function to simultaneously operate two touch switches when they are both pressed.

■ Enable Low Battery Warning
Select this check box to display a warning when the backup battery is dead.

■ Show script error*1

Select this check box to display an error message on the screen when a script error occurs.

■ Blink #TP/#CP on the Touch screen when the value in TP/CP is modified
Select this check box to flash the message "TP/CP" on the screen when the preset value of the timmer or the counter 
in control devices change. For details on "TP/CP" displayed on the screen, refer to Chapter 30 “ TP/CP” on page 30-2.

*1 Advanced mode only

Control by Device*1: Select this check box to control the touch sound with a value of device. 
This option can only be configured when Touch Sound is selected.

(Device): Specifies the word device that controls the touch sound.
Click  to display the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-61.
The control over a touch sound with a value of device is as follows.
0: Do not play the touch sound.
1: Play the touch sound.
2: Play a shortened touch sound.

Press and hold 
three or more seconds

Touch

Script error information is saved to the HMI special registers (LSD 52 and LSD 53). For details, refer to 
Chapter 20 “1.4 Script Error of HMI Function” on page 20-4.
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■ System Language
Selects the display language for the Maintenance Screen, Device Monitor, Adjust Brightness Screen*2, and Adjust 
Brightness/Contrast Screen*3 as English or Japanese.
For details, refer to Chapter 28 “1 Maintenance Screen” on page 28-1.

■ Start from 0 in Always Entry Mode of Numerical Input*1

Select this check box to display 0 when a Numerical Input that has the Always Entry Mode check box selected on 
the General tab is displayed on the screen. When this check box is cleared, the value of device is displayed.
This option is reflected for all Numerical Inputs configured in the project.

■ Storage Method of String Data*1

Selects the handling method for text entered with the Character Input and values of devices read by the Message Display.

■ Storage Method of 32-bit Numerical Data*1

Selects the handling method for the values of devices when BIN32(+), BIN32(+/-), BCD8, or float32 is selected 
for Data Type from the following.
This setting only applies to word devices. When the bit devices in control devices are handled as words, this setting is 
always from Lower word.

*1 Advanced mode only
*2 Color LCD models only
*3 Monochrome LCD models only

from Upper byte: The values of devices are read from and written to the upper byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device LDR100

from Lower byte: The values of devices are read from and written to the lower byte.
Example: When the text ABCDE is entered with the Character Input and written to the 

destination device LDR100

Device
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (hex) 'B' = 42 (hex)
LDR101 'C' = 43 (hex) 'D' = 44 (hex)
LDR102 'E' = 45 (hex) 0

NULL terminating character

Device
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (hex) 'A' = 41 (hex)
LDR101 'D' = 44 (hex) 'C' = 43 (hex)
LDR102 0 'E' = 45 (hex)

NULL terminating character

When handling strings, 0 is written to the device as the NULL terminating character and treated as the end 
of the string.

from Upper word (Excludes bit devices handled as words):
Values of the word device are read from and written to the upper word.
Example: When Data Type for the Numerical Input is BIN32(+) and the numerical value 

12345678 (hex) was entered and written to destination device LDR100

from Lower word: For word devices and bit devices handled as words, values of devices are read from and 
written to the lower word.
Example: When Data Type for the Numerical Input is BIN32(+) and the numerical value 

12345678 (hex) was entered and written to destination device LDR100

Device Stored value
LDR100 1234 (hex) Upper word
LDR101 5678 (hex) Lower word

Device Stored value
LDR100 5678 (hex) Upper word
LDR101 1234 (hex) Lower word
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■ Execution Time of Control Function (msec)
Specifies the execution time for control function (5 to 1,000).
For details, refer to Chapter 12 “Execution Period” on page 12-2.

■ Use System Area
The System Area is an area of predetermined devices to control the screen, communicate error and time information 
between the Touch and the external device. Select this check box to use the System Area. For details, refer to 
“System Area” on page 3-23.

■ Blinking Cycle
Selects the blinking cycle (displaying a drawing object by switching it on and off at a fixed interval) as 1.0 sec or 0.5 
sec.

■ Watch Dog*1

Select this check box to monitor whether or not the Touch and the external device are communicating by writing a set 
value (00FF (hex)) at a fixed interval.

■ Disable Switch*1

Select this check box to enable and disable touch switches with a value of device.
Touch switches are enabled when the value of device is 1. They are disabled when the value of device is 0.

■ Use Device Cache*1

Select this check box to execute processing by reading all the values of external devices configured for a screen when 
switching the Base Screen or when displaying a Popup Screen. On the Touch, written values are reflected regardless 
of this option.

■ Start Part with synchronous*1

Select this check box to operate commands and HMI Special Internal Relays LSM1, LSM2, LSM3, and LSM5 after 
reading all the values of external devices configured on the screen.
When this check box is cleared, all processing is immediately executed when the screen is displayed.

*1 Advanced mode only

Device: Specifies the word device to use as the System Area. The System Area is allocated starting from the 
configured device address.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use System Area 3, 4: Select this check box to use System Area 3 and 4.

Clear Keypad bit in System Area automatically*1: Select this check box to automatically set the System Area 2 
Numerical Input setting and Character Input setting bits to 0 after 
they have been set to 1.
The System Area 2 bits cleared by this function are as follows.
Numerical Input setting complete (address+3, bit 0)
Numerical Input setting cancel (address+3, bit 1)
Character Input setting complete (address+3, bit 5)
Character Input setting cancel (address+3, bit 6)

Device: Specifies the word device to write the value.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Time (sec): Specifies the interval to write the value (1 to 65535).

Device: Specifies the bit device or bit of the word device that is read to enable or disable touch switches.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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● System Area

Overview

The area of predetermined devices to control the screen and communicate error information and time information 
between the Touch and the external device is called the System Area.
The System Area on the Touch is as follows.

To use System Area 1 and 2, select the Use System Area check box on the Project Settings dialog box. To use 
System Area 3 and 4, select the Use System Area 3, 4 check box.
Specify the word device to use as the System Area in Device to allocate the System Area starting at the configured 
device address.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
Example: When Device is configured as LDR100

System Area 1

This area configures the Touch display, beep, and clearing bits.

System Area Number of word addresses User Access

System Area 1 2 Read and write

System Area 2 2 Write

System Area 3 4 Read

System Area 4 4 Write

LDR100
LDR101
LDR102
LDR103
LDR104
LDR105
LDR106
LDR107
LDR108
LDR109
LDR110
LDR111

System Area 1
(Starting address)

+1
+2
+3
+4
+5
+6
+7
+8
+9

+10
+11

System Area 2

System Area 3

System Area 4

Address Bit Function Description

+0 0 to 15 Display screen number

This bit stores the number of the screen being displayed. Write a 
value to this bit to change the screen to that number. Immediately 
after the power is turned on, the value configured by Default 
Screen in the Project Settings dialog box is stored here.
If the screen number does not exist in the project data, an error 
message (No screen data) is displayed. However, when 0 is written 
to this bit, the screen is not switched and no error message is 
displayed.

+1

0 Backlight

This bit stores the illumination state of the backlight. Write a value to 
this bit to change the state.

0: Off
Turns the backlight off.

1: On
Turns the backlight on.

1 Blink backlight (1 sec. cycle)

This bit stores the screen blink state (1 sec. cycle). Write a value to 
this bit to change the state. This bit is 0 immediately after the power 
is turned on.

0: Do not blink
Stop blinking the screen and turn it on.

1: Blink
Blinks the screen in one second intervals.
When Blink backlight (1 sec. cycle) (address+1, bit 1) and Blink 
backlight (0.5 sec. cycle) (address+1, bit 2) are both 1, the 
screen blinks at one second intervals.
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+1

2 Blink backlight 
(0.5 sec. cycle)

This bit stores the screen blink state (0.5 sec. cycle). Write a value to 
this bit to change the state. This bit is 0 immediately after the power 
is turned on.

0: Do not blink
Stop blinking the screen and turn it on.

1: Blink
Blinks the screen in 0.5 second intervals.
When Blink backlight (1 sec. cycle) (address+1, bit 1) and Blink 
backlight (0.5 sec. cycle) (address+1, bit 2) are both 1, the 
screen blinks at one second intervals.

3 to 4 Backlight color

This bit stores the color of backlight. Write a value to this bit to 
change the color.
Monochrome LCD models

00: Reserved

01: White

10: Red

11: Pink

Color LCD models

01: White

00, 10 and 11: Reserved

5 Auto Backlight OFF

This bit stores whether or not the function to automatically turn off 
the backlight is enabled when the Auto Backlight OFF check box is 
selected in the Project Settings dialog box. Write a value to this bit to 
change the state. This bit turns 0 immediately after power is turned 
on.

0: Enabled
Automatically turns off the backlight when the Touch is unused 
for an extended period of time.

1: Disabled
Does not automatically turn off the backlight when the Touch
is unused for an extended period of time. The backlight turns 
on if the value changes to 1 when the backlight is off.

6 Beep

This bit stores the beep state. Write a value to this bit to change the 
state. This bit turns 0 immediately after power is turned on.

0: Stop
Stops continuous beeping.

1: Beep
Starts continuous beeping.

7 Screen display The function is the same as for Backlight (address+1, bit0)

8 Reserved

9 Clear error
Write 1 to this bit to clear the error information bit (System Area 2 
address+2). This bit automatically changes to 0 when processing is 
finished.

10 Numerical Input setting 
clear

Write 1 to this bit to clear the Numerical Input setting complete bit 
(System Area 2 address+3, bit 0) and the Numerical Input setting 
cancel bit (System Area 2 address+3, bit 1). This bit automatically 
changes to 0 when processing is finished.

11 Character Input setting 
clear

Write 1 to this bit to clear the Character Input setting complete bit 
(System Area 2 address+3, bit 5) and the Character Input setting 
cancel bit (System Area 2 address+3, bit 6). This bit automatically 
changes to 0 when processing is finished.

12 to 15 Reserved

Address Bit Function Description
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System Area 2

This area stores Touch states and error information. These bits turn 0 immediately after power is turned on.

Address Bit Function Description

+2

0 to 2 Reserved

3 Communication error
This bit changes to 1 when a communication error occurs in 
communication with external device using Serial Interface 1 
(SIO1).

4 Reserved

5 Arithmetic error

This bit changes to 1 when executing the following arithmetic 
operations.
• A value other than 0 to 9 is used when the data type is BCD4 

or BCD8
• Dividing by zero
• When there is an inconsistency in the bar chart maximum, 

minimum, or origin setting, or the full range is 0
• When there is an inconsistency in the line chart maximum, 

minimum, or origin setting, or the full range is 0

6 Device range error
This bit changes to 1 when writing a value to a device that falls 
outside its range or when exceeding the restrictions on the 
number of configured devices.

7 Clock IC error This bit changes to 1 when the Touch internal clock stops.

8, 9 Reserved

10 Script error

This bit changes to 1 when an error occurs during script 
execution. Error details are stored in HMI Special Data Registers 
LSD52 and LSD53. For details, refer to Chapter 20 “1.4 Script 
Error of HMI Function” on page 20-4.

11 USB flash drive access error
If an error occurs when accessing an inserted USB flash drive, 
the value of this bit becomes 1.

12, 13 Reserved

14 Backup data error
This bit changes to 1 when the backup battery is dead or low 
and the data sampled by the log functions and the HMI Keep 
Registers and HMI Keep Relays are cleared.

15 Reserved

+3

0
Numerical Input setting 
complete

This bit changes to 1 when finished entering a numerical value 
with the Numerical Input. Write 0 to Numerical Input setting 
clear (address+1, bit 10) to clear this bit.

1
Numerical Input setting 
cancel

This bit changes to 1 when entering a numerical value with the 
Numerical Input was canceled. Write 0 to Numerical Input 
setting clear (address+1, bit 10) to clear this bit.

2 Backlight auto off running

The value of this bit changes to 1 when Auto Backlight OFF is 
configured and the backlight was turned off by this function. To 
configure Auto Backlight OFF, select the Auto Backlight OFF 
check box on the System tab in the Project Settings dialog box. 
This bit automatically changes to 0 when the backlight turns on.

3 Reserved

4 Transferring recipe This bit changes to 1 when transferring recipe data. This bit 
automatically changes to 0 when the transfer is finished.

5
Character Input setting 
complete

This bit changes to 1 when finished entering text with the 
Character Input. Write 0 to Character Input setting clear 
(address+1, bit 11) to clear this bit.

6 Character Input setting cancel
This bit changes to 1 when entering text with the Character 
Input is canceled. Write 0 to Character Input setting clear 
(address+1, bit 11) to clear this bit.

7 to 15 Reserved
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System Area 3

This area is for changing the Touch internal clock data.

System Area 4

This area reads the Touch internal clock data in one minute intervals.

Address Bit Function Description

+4
0 to 7 Clock data Month Enter Month (01 to 12) as a 2 digit BCD.

8 to 15 Clock data Year Enter Year (00 to 99) as a 2 digit BCD.

+5
0 to 7 Clock data Hour Enter Hour (00 to 23) as a 2 digit BCD.

8 to 15 Clock data Day Enter Day (01 to 31) as a 2 digit BCD.

+6
0 to 7 Clock data Second Enter Second (00 to 59) as a 2 digit BCD.

8 to 15 Clock data Minute Enter Minute (00 to 59) as a 2 digit BCD.

+7
0 to 14 Reserved Enter 0 in the reserved area.

15 Update Write 1 to this bit to write the entered data (address+4 to +6, bits 
0 to 15) to the Touch internal clock data.

When the value of the update bit (address+7, bit 15) becomes 1, the clock data is updated as a whole.
Year, month, day, hour, minute, and second cannot be set individually.

Address Bit Function Description

+8
0 to 7 Clock data Month These bits store the current Month (01 to 12) value as a 2 digit 

BCD.

8 to 15 Clock data Year These bits store the current Year (00 to 99) value as a 2 digit 
BCD.

+9
0 to 7 Clock data Hour These bits store the current Hour (00 to 23) value as a 2 digit 

BCD.

8 to 15 Clock data Day These bits store the current Day (01 to 31) value as a 2 digit 
BCD.

+10
0 to 7 Reserved

8 to 15 Clock data Minute These bits store the current Touch internal clock data Minute (00 
to 59).

+11
0 to 3 Clock data Day of Week

These bits store the current Day of Week value as a 2 digit BCD.
00: Sunday
01: Monday
02: Tuesday
03: Wednesday
04: Thursday
05: Friday
06: Saturday

4 to 15 Reserved
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3.2 Communication Interface Tab

The Communication Interface tab is used to configure the functions used by the Touch communication interfaces.

■ Interface Configuration
It displays the communication interfaces and Protocols to use. The settings in the Interface Settings changes 
according to the selected item from this list. The supported Protocols for each communication interface are as follows.

Item Communication Interface

Protocol

External Device 
Communication

O/I Link
Master

O/I Link
Slave

User 
Communication

1 to 3

Maintenance
Communication

Port Serial Interface
RS232C YES NO NO YES NO

RS422/485 YES YES YES YES NO

Ethernet Ethernet Interface YES NO NO YES YES

USB2 USB Interface TypeA NO NO NO YES NO

USB1 USB Interface Mini-B NO NO NO NO YES
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Functions Available with the Serial Interface
The following functions can be used with the serial interface.

• Barcode reader connection
 Refer to Chapter 22 “5 User Communication” on page 22-7.

Functions Available with the Ethernet Interface
The following functions can be used with the Ethernet interface.

• Online
 Refer to Chapter 23 “Online Function” on page 23-1.

• Debug
 Refer to Chapter 24 “Monitor Function” on page 24-1.

Functions Available with the USB Interface
The following functions can be used with a USB interface.

• Online
 Refer to Chapter 23 “Online Function” on page 23-1.

• Debug
 Refer to Chapter 24 “Monitor Function” on page 24-1.

• Barcode reader connection
 Refer to Chapter 22 “5 User Communication” on page 22-7.

■ Interface Settings
The items that can be configured vary based on the communication interface selected under Interface 
Configuration.

When Port is selected under Interface Configuration

Protocol: Selects the Protocol to use with the serial interface (RS232C) from the following.
N/A, External Device Communication, User Communication 1, User Communication 2, 
User Communication 3
Selects the protocol to use with the serial interface (RS422/485) from the following.
N/A, External Device Communication, O/I Link Master, O/I Link Slave, User 
Communication 1, User Communication 2, User Communication 3
This communication interface is not used when N/A is selected.

Baud Rate: Selects the communication speed with the external device from the following.
1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 187500
The baud rate that can be configured varies based on Protocol.

Data Bits: Selects the data length as 7 or 8.
This option can only be configured when External Device Communication, User 
Communication 1, User Communication 2, or User Communication 3 is selected for 
Protocol.

Stop Bits: Selects the stop bits as 1 or 2.
This option can only be configured when External Device Communication, User 
Communication 1, User Communication 2, or User Communication 3 is selected for 
Protocol.

Parity: Selects the parity from the following.
None, Odd, Even
This option can only be configured when External Device Communication, User 
Communication 1, User Communication 2, or User Communication 3 is selected for 
Protocol.

Flow Control: Selects the flow control method as None or ER according to the external device being used.
This option can only be configured when External Device Communication is selected for 
Protocol.

Serial Interface: Selects the standard for the serial interface to use from the following.
RS232C, RS422/485 2-wire, RS422/485 4-wire
RS422/485 4-wire can only be configured when User Communication 1, User 
Communication 2, or User Communication 3 is selected for Protocol.
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When Ethernet is selected under Interface Configuration
Example: To communicate with two Touchs and a computer via Ethernet

Set Touch A, Touch B, and the computer all to the same values: subnet mask 255.255.255.0, default 
gateway 192.168.0.24.
Set the IP addresses to values that do not conflict: Touch A IP address 192.168.0.1, Touch B IP address 
192.168.0.2, computer IP address 192.168.0.3.

ComputerEthernet communication

IP address 192.168.0.1
Subnet mask 255.255.255.0
Default gateway 192.168.0.24

192.168.0.2
255.255.255.0
192.168.0.24

192.168.0.3
255.255.255.0
192.168.0.24

External device

Touch A

External device

Touch B

Local network

• Set the IP address, subnet mask, and default gateway according to the local network environment being 
used. When Automatically obtain the IP address is selected, the network settings are automatically 
assigned from the DHCP server on the local network environment being used.

• Settings assigned from the DHCP server can be checked on the Top Page in the System Mode.
• When Automatically obtain the IP address is selected, it make take some time to acquire the 

network settings. If the download fails, increase the timeout time on the Home tab, in the Project 
group, in Comm.Setup. For details, refer to Chapter 23 “1.3 Change Communication Settings” on page 
23-5.

Protocol: N/A or External Device Communication. Varies based on the 
Communication Driver selected for Protocol.

Automatically obtain the IP address (DHCP).: Automatically sets the network when connected to a network.

Use the following IP address: Manually specifies the IP address, subnet mask, and default gateway.

IP Address: Specifies the IP address. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
When connecting multiple devices to the same 
network, make sure to assign each device a unique IP 
address.

Subnet Mask: Specifies the subnet mask. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
This value must be the same for all devices.

Default Gateway: Specifies the default gateway. (Default: 0.0.0.0)
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a 
numeric value from 0 to 255.
Set this value when using a router. Leave the value 
blank when not required.

Forbid Maintenance Communication: Select this check box to prohibit maintenance communication via 
Ethernet communication.

About Networking Terminology

IP Address: The number allocated to identify devices connected to an IP network such 
as the Internet or an intranet. The IP address is the address of each 
individual device on a network.

Subnet Mask: The subnet mask is used to indicate the position of the division between the 
network address portion and the host address portion of an IP address.

Default Gateway: The device such as a computer or a router that represents the gateway used 
when accessing devices outside the network to which the device belongs.
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When Protocol1, Protocol2, or Protocol3 is selected for Ethernet under Interface Configuration

Protocol: Selects the user communication to configure for the selected Protocol from the following.
User Communication 1, User Communication 2, User Communication 3

Operation Mode:
Selects the operation mode when performing user communication with the Ethernet interface.
TCP Client: The Touch operates as a TCP client and the external device operates as a TCP server. The 

Touch connects to the TCP server and sends and receives data.
TCP Server: The Touch operates as a TCP server and the external device operates as a TCP client. The 

Touch creates a listening port as a TCP server and waits for connections from TCP clients. 
After a connection, it sends and receives data with the TCP client.

Target: Configures the IP address and port number for the external device.
These options can only be configured when TCP Client is selected for Operation Mode.
IP Address: Specifies the IP address for the target.

The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 
255.
When connecting multiple devices to the same network, make sure to assign 
each device a unique IP address.

Port No.: Specifies the port number for the target (0 to 65535).
Change IP Address and Port Number by Device:

Select this check box and specify a word device to change the target's IP 
address and port number during operation. You can only specify an internal 
device. During the start of operation, the Touch writes the values configured 
by IP Address and Port No. to this device. After the start of operation, the 
value of device is read and the target is changed.

Click  to display the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
Example: When IP Address is set to 192.168.1.1, Port No. is 2105, and the 

device is LDR100

Touch: Configures the Touch listening port number.
These options can only be configured when TCP Server is selected for Operation Mode.
Port No. Specifies the Touch listening port number (0 to 65535).

The port numbers that cannot be used are as follows.
• Port numbers already used by the Touch: port number 2537 (for 

maintenance communication), 2538 (for pass-through), 2101 (for FC4A 
direct connection pass-through)

• When MODBUS/TCP Server is selected for Communication Driver, 
Port Number on the displayed Communication Driver Extension tab

LDR100
LDR101
LDR102
LDR103
LDR104

2105
192
168
1
1

Port number

IP address
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When USB2 is selected under Interface Configuration

When USB1 is selected under Interface Configuration

• The connection status for TCP clients and the TCP server can be checked with the value of the HMI 
Special Data Registers (LSD). The connection is disconnected when 0. The connection is connected when 
1.

LSD67-0: Connection status for User Communication 1 set to Ethernet interface

LSD67-1: Connection status for User Communication 2 set to Ethernet interface

LSD67-2: Connection status for User Communication 3 set to Ethernet interface

• To forcibly disconnect the connection with TCP clients and the TCP server, set the value of the HMI 
Special Data Registers (LSD) from 0 to 1.

LSD68-0: User Communication 1 set to Ethernet interface

LSD68-1: User Communication 2 set to Ethernet interface

LSD68-2: User Communication 3 set to Ethernet interface

• For TCP client and TCP server, make a 1:1 connection between the Touch and the external device for one 
user communication setting.

• When the Change IP Address and Port Number by Device check box is selected, the changed IP 
address and port number are reflected when data is next sent.

Protocol: Selects the Protocol used by the USB interface Type A from the following.
N/A, User Communication 1, User Communication 2, User Communication 3
This communication interface is not used when N/A is selected.

Protocol: N/A is displayed.
This communication interface is used for maintenance communication.
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3.3 Communication Driver Tab

The Communication Driver tab is used to configure the communication driver for the external device configured in 
the current project data.

■ Product Series
Shows the Touch model configured in the current project data.

■ Manufacturer
Shows the external device manufacturer configured in the current project data.

■ Protocol
Shows the communication driver name configured in the current project data.

■ External Device
These options configure the communication driver to use. For details, refer to the "External Device Setup Manual".

Transmission Wait (x 10 msec): Specifies the transmission interval for communication commands (0 to 255).

Time Out (x 100 msec): Specifies the time to wait for a response from the external device (1 to 255).

Retry Cycles: Specifies the number of times to execute a reconnection when the Touch cannot 
communicate with the external device. When the number of reconnect attempts 
reaches the number of times set here, a communication error is displayed.
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■ Ignore communication errors and continue operation
Select this check box to continue Touch operation even when a communication error occurs.
This option is only displayed when the communication driver Connection is 1:N Communication.

Display error message: Select this check box to display an error message (communication error) when a 
communication error occurs and operation continues. Ack is displayed on the error 
message (communication error).
When the Ignore communication errors and continue operation check box is 
cleared, Ack is not displayed on the error message.

Auto retry: Select this check box to automatically retry communication from the Touch to the station 
number where the communication error occurred when a communication error occurs 
and operation continues.
All other communication stops while retrying.

To manually retry communication, clear the Auto retry check box.
To retry all station numbers, write 1 in bit 1 (initialize) of the device address configured by Batch 
monitoring the communication error information for all Station Numbers.
To individually retry communication, write 1 in bit 0 (connection setting) of the device address configured by 
Monitoring communication error information for each station number, individually.

Batch monitoring the communication error information for all Station Numbers:

Specifies the device that stores communication error information for all station numbers. 
Only the HMI devices can be configured for this option.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
The information stored as error information is as follows. For details, refer to the 
"External Device Setup Manual".
• Initialization
• Conditions under which the error occurred
• Read error log
• Write error log

Monitoring communication error information for each station number, individually:

Specifies the device that stores communication error information for each station 
number. Only the HMI devices can be configured for this option.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This error information utilizes a maximum of 256 devices. Use caution so that the used 
addresses do not overlap with other addresses.
The information stored as error information is as follows. For details, refer to the 
"External Device Setup Manual".
• Connection settings
• Conditions under which the error occurred
• Read error log
• Write error log
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3.4 Communication Driver Network Tab

The Communication Driver Network tab is used to configure the information for external devices connected by 
Ethernet communication. This tab is displayed when a communication driver is selected that supports Ethernet 
communication.

■ Network List
Edits the settings for the external devices.

■ Edit
Configures the IP address and port number for the selected station number. Select a station number, and then click 
this button to display the Communication Driver Network Settings dialog box.

■ Clear
Returns the settings for the selected station number to the defaults.

Station No.: Shows the station number of external device. Double clicking the cell displays the Communication 
Driver Network Settings dialog box.

IP Address: Shows the IP address of the external device. (Default: 192.168.0.1)
Double clicking the cell allows you to specify the external device's IP address.
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.
When connecting multiple devices to the same network, make sure to assign each device a unique IP 
address.

Port No.: Shows the port number of external device. (Default: 2101)
Double clicking the cell allows you to specify the external device's port number (0 to 65535).

You can change the IP address of the station numbers for the external devices using the System Screen. In 
the Top Page in the System Screen, press Initial Setting, Comm. I/F, Ext. IP Address in order.
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● Communications Driver Network Settings Dialog Box
To communicate with an external device by using Ethernet communication, specify the Ethernet settings (IP address, 
port number) for the destination external device. The settings other than IP Address and Port vary based on the 
external device. For details, refer to the External Device Setup Manual.
Example: MODBUS/TCP Client is selected for Communication Driver

■ IP Address
Specifies the IP address of the destination external device. 
The format is “xxx.xxx.xxx.xxx”. “xxx” stands for a numeric value from 0 to 255.
When connecting multiple devices to the same network, make sure to assign each device a unique IP address.

■ Port
Specifies the port number (0 to 65,535) of the destination external device.
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3.5 Communication Driver Extension Tab

The Communication Driver Extension tab is used to configure the communication driver extension settings. 
These settings vary based on the external device. This tab is displayed when communication driver extension settings 
are required. For details, refer to the "External Device Setup Manual".
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3.6 O/I Link Tab

The O/I Link tab configures the slave stations to connect to when the Touch is used as the O/I Link Communication 
master. It configures the O/I Link station when the Touch is used as a slave. For details, refer to Chapter 22 “2 O/I 
Link Communication” on page 22-3. These options can only be configured when O/I Link Master or O/I Link 
Slave is selected for Protocol under Interface Settings on the Communication Interface tab.

■ O/I Link Type
Selects the slave station (Slave1 to Slave15).
This option can only be configured when O/I Link Slave is selected for Protocol under Interface Settings on the 
Communication Interface tab.

■ Slave Settings
Select the check boxes for the slave stations to connect to.
This option can only be configured when O/I Link Master is selected for Protocol under Interface Settings on 
the Communication Interface tab.

The slave stations to connect to when the Touch is used as an O/I Link Communication Master are enabled 
after the project is downloaded. The slave station number when the Touch is used as a slave is also enabled 
after the project is downloaded.
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3.7 User Communication Tab

The User Communication tab is used to configure communication with external devices such as barcode readers. 
For details, refer to Chapter 22 “5 User Communication” on page 22-7. This option can only be configured when User 
Communication 1, User Communication 2, or User Communication 3 is selected for Protocol under 
Interface Settings on the Communication Interface tab.

■ Settings
Edits the user communication settings. You can use up to three user communication settings.

■ Edit
Registers or changes the selected user communication settings. Select a user communication number, and then click 
this button to display the User Communication Protocol Settings dialog box.

■ Browse
Selects a Protocol to use as user communication with Protocol Manager. Click this button to display Protocol Manager.

■ Remove
Removes the Protocol selected under User Communication from the list.

User Communication: Shows the user communication number.

Protocol Name: Shows Protocol Name configured in the User Communication Protocol Settings dialog box.
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■ Protocol
Shows the Protocol defined as the selected user communication.

■ Command
Shows the command settings for the selected Protocol. Double clicking the cell displays the Data Settings dialog box.

No.: Shows the number for managing the Protocol settings. Double clicking the cell displays the 
Command Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Completed: Shows the send or receive complete report device. Double clicking the cell displays the 
Command Settings dialog box.

Status: Shows the destination device for the send or receive size and error information. Double clicking 
the cell displays the Command Settings dialog box.

Trigger Type: Shows the trigger type to execute the script. Double clicking the cell displays the Command 
Settings dialog box.

Trigger Condition: The displayed content varies based on Trigger Type.

Rising-edge, Falling-edge, While ON, or While OFF: Shows the bit device that is the 
condition. Double clicking the cell 
displays the Command Settings 
dialog box.

While satisfying the condition or Satisfy the 
condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog 
box.

Size: Shows the command size in bytes. Double clicking the cell displays the Command Settings 
dialog box.
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3.8 External Memory Tab

The External Memory tab is used to configure the destination folder on the external memory inserted in the Touch.

■ External Memory Folder
Enter the folder name for the folder in the external memory to use on the Touch within 8 alphanumeric characters 
using upper-case alphabetic characters (A to Z) and numbers (0 to 9). The default External Memory Folder name is 
“HGDATA01” .
All the data sampled with the log functions is saved in this External Memory Folder. For details on the external 
memory, refer to Chapter 26 “1 USB Flash Drives” on page 26-1.

■ Remove Files
Select this check box to erase the files saved in the External Memory Folder.

• You cannot use the following characters in the folder name.
 \ / : , ;* ? “ < > |

• After operation starts, the folders created in the External Memory Folder and the file names cannot be 
changed.

All Alarm Log files: Select this check box to erase all the Alarm Log data saved in folder. The folder name is 
"ALARMLOG".

All Data Log files: Select this check box to erase all the Data Log data saved in folder. The folder name is 
"DATALOG".

All Operation Log files: Select this check box to erase all the Operation Log data saved in all folders. The folder 
name is "OPERATIONLOG".

Trigger Device: Specifies the bit device or bit of the word device to serve as condition to delete the files.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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3.9 Autorun Tab

The Autorun tab is used to configure the USB flash drive autorun functions when inserted in the Touch. For details 
on USB flash drives, refer to Chapter 26 “1 USB Flash Drives” on page 26-1.

■ Enable USB Autorun
Select this check box to enable the USB Autorun function.
The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted in the Touch.

■ Open Popup Screen when USB flash drive is inserted
Select this check box to display a Popup Screen when a USB flash drive is inserted in the Touch.

Screen No.: Specifies the Popup Screen number (1 to 3015) to display when a USB flash drive is inserted in 
the Touch.

Coordinates X, Y: Specifies the coordinates to display the Popup Screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the Popup Screen.
The units and range for the display coordinates are as follows.

Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)
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3.10 Project Details Tab

The Project Details tab displays and configures project data information.

■ Project Name
Shows the current project name. To change the project name, enter a new project name. The maximum number is 
50 characters.

■ Project Folder Size
Shows the total size of the current project data.

■ Download Data Size
Shows the total size of the data and the total size of only the image files when the current project data is 
downloaded.

■ Location
Shows the save location for the current project data.

■ Created
Shows the date and time the current project data was created.

■ Modified
Shows the date and time the current project data was last saved.

■ Accessed
Shows the date and time the current project data was opened.

■ User
Enter the name of the creator. The maximum number is 40 characters.

■ Comment
Enter a comment for the project data. The maximum number is 40 characters.

You cannot use the following characters in the project name.
\ / : , ; * ? “ < > |



SmartAXIS Touch User's Manual 3-43

3 Project Settings Dialog Box

3

Project

■ Language
Selects the language to use for the system information from the following. This option is also reflected in the project 
name displayed in the system information on the Touch's System Screen.
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The display type for dates and times varies based on the selected language.

Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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3.11 Contents Tab

The Contents tab is used to enter a comment for the project data.

■ Description
Enter a comment for the project data. The maximum number is 511 characters. A newline is counted as two 
characters.

The content in Description is erased when the project is uploaded.
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This chapter describes the Touch special functions, how to configure them, and examples of their use.

● Function List

4 Special Functions

Function name Overview Setup location

Stop input
The ladder program or FBD program operation can be stopped with a 
specified input.

Function area 
settings

Reset input The values of the control devices can be cleared with a specified input.

Run/stop selection at 
memory backup error

Whether to start or stop the ladder program or FBD program operation 
when the Touch is powered up after the "keep" data in the RAM has 
been lost can be specified.

Run/stop selection at power 
up

Whether to start or stop the ladder program or FBD program operation 
regardless of the M8000 status when the Touch is powered up can be 
specified.

Keep and clear devices
Whether to clear or keep the device values, such as counter current 
values, when the ladder program operation starts running can be 
specified.

High-speed counter
The high-speed counters can be used to count input pulses from rotary 
encoders or proximity switches regardless of the scan time.

Catch input
The catch input can be used to receive short pulses from sensors 
regardless of the scan time.

Interrupt input
When a quick response to an external input is required, such as in 
positioning control, the interrupt input can call a subroutine to execute 
an interrupt program.

Frequency measurement
The pulse frequency of input signals to input terminals can be counted 
regardless of the scan time.

Input filter
The input filter rejects short input pulses when the Touch is used with 
input signals containing noises.

Analog input
Analog voltage inputs, such as inputs from pressure sensors, can be 
read and stored in special data registers as digital values.

Timer interrupt
When executing the same program repeatedly regardless of the scan 
time is required, the timer interrupt can call a subroutine to execute an 
interrupt program at specified time interval.

Analog output Analog values of voltage and current can be output.

Analog cartridge
Analog signals can be received or analog values can be output with the 
analog cartridge attached to the Touch (transistor output type).

Ladder Monitor Settings for running the Ladder Monitor on the LCD

Watchdog timer
settings

The watchdog timer monitors the operation and the watchdog time 
preset value can be changed.

Daylight savings time
The internal clock can automatically be adjusted according to the 
configured daylight saving time period.

Remote I/O 
The number of inputs and outputs can be expanded by connecting the 
SmartAXIS Pro/Lite as remote I/O slave.

Clock function
The Touch can operate according to the current date and time and be 
used in applications, such as lighting or air conditioning.

Instructions or FB

When the setting of control function is changed, save the project data. If project data is saved on 
WindO/I-NV3, the setting of control function is also saved.
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4.1 Function Area Settings Configuration Procedure

The function area settings are the environment settings for the Touch. The operation of the Touch when powered 
and communication port settings are configured in Function Area Settings.
This section describes the configuration procedure for the Function Area Settings.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click a button for special functions.

The Function Area Settings dialog box is displayed.

3 Change the settings as necessary.
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● Function Description

Run/Stop Control These functions run or stop the ladder program or FBD program when the Touch is turned 
on, when an error occurs, or when an external input turns on.
• Stop input
• Reset input
• Run/stop selection at memory backup error
• Run/stop selection at power up

Memory Backup These functions keep or clear Control devices (the contents of memory) when a ladder 
program or FBD program starts operation. The values of the following devices can be 
configured to be kept or cleared.
• Internal relays
• Shift registers
• Counters
• Data registers

Input & Output 
Configuration

These options configure the special functions such as the external input filter settings and 
the high-speed counter.
• High-speed counter
• Catch input
• Interrupt input
• Frequency measurement
• Input filter
• Analog input
• Timer interrupt
• Analog output

Cartridges Configure the function to use the cartridge of the Touch.
• Analog cartridge

LCD Settings Configure the LCD settings for the Touch.
• Ladder Monitor

Self Diagnostic These settings configure the watchdog timer that monitors the operating status of the 
Touch.

Calendar & Clock The Touch is equipped with an internal clock and its calendar data (year, month, day, day 
of the week) and clock data (hour, minute, second) which can be used in a ladder program 
or FBD program. Daylight savings time can also be configured for the internal clock.

Connection Settings Configure the communication mode for using the remote I/O function with the Touch.
• Remote I/O Master
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4.2 Stop Input

This section describes the function on how a ladder program or FBD program for the Touch can be stopped with 
external input.

● Function Description
This function stops execution of a ladder program or FBD program for the Touch by means of an external input, such as a 
control panel switch.
The normal external inputs of the Touch are set as stop inputs.
When a stop input is set to ON, the ladder program or FBD program is stopped during execution. When a stop input 
is set to OFF, the ladder program or FBD program executes from the top.

The external inputs that can be set as stop inputs are I0 to I7.

● Procedure
1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function) .

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Run/Stop Control.
The Function Area Settings dialog box is displayed.

3 Select the Use Stop Input check box.

4 Designate an external input (ex. I0) as a stop input.

5 Click OK.
This concludes configuring the settings.
If I0 is set to ON after a ladder program or FBD program is downloaded, these programs will stop.

*1 Even when M8000 (start control) is OFF, if a stop input is OFF, the Touch will remain in the RUN state. 
*2 Even when a stop input is OFF, since M8000 (start control) is OFF, the program will not go into RUN state.

RUN/Stop State

Start Control
(M8000)

Stop Input

RUN

STOP

ON

OFF

ON

OFF
*1 *2

While a reset input is ON, a ladder program or FBD program is stopped. For details of reset inputs, refer to 
“4.3 Reset Input” on page 3-49.
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4.3 Reset Input

This section describes the function for clearing the values of the Touch devices by means of external input.

● Function Description
This function clears execution of the Touch control devices by means of an external input, such as a control panel 
switch. The normal external inputs of the Touch are set as reset inputs.
If a reset input is ON, the ladder program or FBD program stops during execution and all control devices and general 
errors are cleared, except for special internal relays and special data registers. When a reset input is set to OFF, the 
ladder program or FBD program executes from the top.
To set the reset input to OFF and execute the ladder program or FBD program once again, it is necessary that M8000 
is ON and that stop inputs are OFF (if a stop input is set).
If these conditions are not satisfied, then even if the reset input is OFF, program execution will remain stopped and 
the ladder program or FBD program will not execute.
The external inputs that can be set as reset inputs are I0 to I7.

● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Run/Stop Control.

The Function Area Settings dialog box is displayed.

3 Select the Use Reset Input check box.

4 Designate an external input (ex. I1) as a reset input.

5 Click OK.

This concludes configuring the settings.
If I1 is set to ON after a ladder program or FBD program is downloaded, these programs will stop and the value of the 
control device will be cleared.
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The state of each data item at the time of RUN, STOP, and Reset are as follows.

Keep settings and clear settings for the internal relays, shift registers, counters, and data registers of control devices 
are configured using the Function Area Settings tab. For details about keep settings and clear settings, refer to 
“4.6 Keep and Clear Control Devices” on page 3-53.

Operation Output

Internal relays, Shift 
register bits, Counters, 

and Data register values Special 
internal 

relay

Special 
data 

register

Not-
maintained 

data 
register

Timer 
current 
valueKeep 

designation 
range

Clear 
designation 

range

RUN
Program 
operation

Program 
operation

Program 
operation

Program 
operation

Program 
operation

Program 
operation

Program 
operation

STOP OFF Maintained Maintained
Refer to 

Chapter 27.
Maintained Maintained Maintained

STOP → RUN Maintained Maintained Cleared Maintained Maintained Maintained Initialized

Reset (when 
reset input is 
turned on)

OFF Cleared Cleared Maintained Maintained Cleared Cleared

Power OFF OFF Maintained Maintained
Refer to 

Chapter 27.
Maintained Cleared Cleared
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4.4 Run/Stop Selection at Memory Backup Error

This section describes the function for setting the state of ladder programs or FBD programs when memory backup 
error is occurred.

● Function Description
If the Touch is powered OFF and left unused for long periods, resulting in a depleted backup battery, values of 
devices, current time, and other data retained by the Touch are lost. If power is supplied to the Touch when it has 
lost this retained data, a memory backup error occurs. The state of the ladder program or FBD program when such a 
memory backup error occurs can be selected.
If there is any risk of unforeseen actions occurring when the Touch is run while in this state (after memory backup 
error is occurred), set to STOP. If the Touch is always operated regardless of whether a memory backup error occurs, 
because there is no means to run ladder programs or FBD programs where it is located or for a similar reason, selected 
to RUN.

● Procedure
1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function) .

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Run/Stop Control.
The Function Area Settings dialog box is displayed.

3 Click Run under the Run/Stop Selection at Memory Backup Error.

4 Click OK.
This concludes configuring the settings.

• Thanks to a lithium-ion battery the RUN/STOP (M8000) state of the Touch immediately before it is 
powered OFF is retained, so when it is powered ON again, the Touch will operate in accordance with this 
preserved RUN/STOP state.

• If the Touch is powered ON after this retained data is lost, following a long period of disuse, for example, a 
memory backup error occurs and the value of special internal relay M8000 (start control) is lost.

• The data backup period is approximately 30 days when the backup battery is fully charged. After the 
backup period is exceeded, the retained data will be lost from the Touch.

• If a keep data error occurs when Run/Stop Selection at Memory Backup Error issues a STOP 
instruction, the Touch stops running. To start operation of the Touch, set the Touch to RUN using the 
Touch. For details, refer to Chapter 12 “Executing and Stopping Ladder Programs or FBD Programs” on 
page 12-3.

• When a memory backup error occurs, an error code is stored in special data register D8005 (general error 
code). For details, refer to Chapter 30 “2.1 General Error Codes” on page 30-3.
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4.5 Run/Stop Selection at Power Up

This section describes the function for selecting the state of ladder programs or FBD programs when the Touch is 
turned on.

● Feature Description
The state of ladder programs or FBD programs when the Touch is turned on is determined by the value of special 
internal relay M8000 (start control).

● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Run/Stop Control.

The Function Area Settings dialog box is displayed.

3 Click Keep Run/Stop State at Power Down, Run or Stop under the Run/Stop Selection at Power Up.

4 Click OK.

This concludes configuring the settings.

Configuration Operation

Keep Run/Stop State at Power 
Down

Starts running the Touch with the ladder program or FBD program in the state at power 
down when the Touch is powered up.

Run (M8000 is turned on)
Turns ON M8000 and starts running the Touch and the ladder program or FBD program 
when the Touch is powered up.

Stop (M8000 is turned off)
Turns OFF M8000, starts running the Touch and stops the ladder program or FBD 
program when the Touch is powered up.

• When the memory backup error occurs, the Touch is started or stopped according to Run/Stop 
Selection at Memory Backup Error regardless of Run/Stop Selection at Power Up.

• Stop inputs and reset inputs have a higher priority than RUN/STOP Selection at Power Up.
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4.6 Keep and Clear Control Devices

This section describes the function for retaining or clearing the Touch Control devices.

● Feature Description
Devices that can issue instructions to retain or clear data are internal relays, shift registers, counter current values, 
and data registers. Relays and registers issued with clear instructions are cleared when operation starts. Values in the 
powered OFF state are retained until power is turned on and operation starts.

● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function) .

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Memory Backup.

The Function Area Settings dialog box is displayed.

3 Click the buttons under Internal Relay, Shift Register, Counter, and Data Register to Clear all, Keep all, or Keep/Clear 
Specified Range as required.

To specify a clear/keep range, enter an upper limit and lower limit for the range. 

4 Click OK.

This concludes configuring the settings.
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● Designation
The settings and actions for each control device are as follows.

■ Internal Relay (M)

• The default setting is Clear All.

■ Shift Register (R)

• The default setting is Clear All.

■ Counter (C)

• The default setting is Keep All.

■ Data Register (D)

• The default setting is Keep All.

Configuration Operation

Clear All All internal relays are cleared when the Touch starts operation.

Keep All The states of all internal relays are retained while the Touch is powered OFF.

Keep Specified Range
The states of all internal relays are retained while the Touch is powered OFF.
Internal relays outside the specified range are cleared when operation starts.

Configuration Operation

Clear All All shift registers are cleared when the Touch starts operation.

Keep All The states of all shift registers are retained while the Touch is powered OFF.

Keep Specified Range
The states of all shift registers are retained while the Touch is powered OFF.
Shift registers outside the specified range are cleared when operation starts.

Configuration Operation

Keep All Counter current values are retained when the Touch is powered OFF.

Clear All All counter current values are cleared when the Touch starts operation.

Clear Specified Range
Only counter current values within the specified range are cleared when the Touch 
starts operation. Counter current values outside the specified range are retained.

Configuration Operation

Keep All Data register values are retained when the Touch is powered OFF.

Clear All All data register values are cleared when the Touch starts operation.

Clear Specified Range
Only data register values within the specified range are cleared when the Touch starts 
operation. Data register values outside the specified range are retained.

• Relays and registers specified under Clear All or Clear Specified Range are cleared when the Touch 
starts operation. Values in the powered OFF state are retained until power is turned on and operation 
starts.

• It is not possible to configure keep/clear settings for special data registers. This action is equivalent to 
that of Keep All.

• It is not possible to configure keep/clear settings for special internal relays. For details about actions when 
power is cut or operation is stopped, refer to Chapter 27 “Special Internal Relay (M)” on page 27-5
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4.7 High-Speed Counter

This section describes the high-speed counter for counting high-speed pulses from devices such as rotary encoders 
and proximity switches. 

● Feature Description
The high-speed counter is a function that counts high-speed pulses which cannot be read in the execution of a normal 
ladder program or FBD program. The high-speed counter has a comparator function to compare the current value 
and a preset value (target value). When the current value and the preset value match, an external output is turned on 
or an interrupt program is executed. However, the interrupt program can only be used when ladder program is 
selected as the programming language.
The high-speed counter has a single-phase high-speed counter and a two-phase high-speed counter.
To use the high-speed counter, function area settings, data registers, special internal relays, and special data 
registers must be configured.
To use the high-speed counter, the following settings are required.

Application example
This application example punches holes into a roll of paper at a regular interval. 
The two pulses (A-phase, B-phase) that carry the phase difference output from the rotary encoder are counted by the 
Touch two-phase high-speed counter.
When the current value reaches the preset value, the specified external output turns on and the perforator punches a 
hole in the roll of paper.

High-speed counter operation modes

The high-speed counter has the following two operation modes.
• Single-phase high-speed counter
• Two-phase high-speed counter

High-speed counting modes

The high-speed counter has the following three counting modes.
• Adding counter (single-phase high-speed counter)
• 2-edge count (two-phase high-speed counter)
• 4-edge count (two-phase high-speed counter)
Example: The input allocation when external input group 1 is specified as a two-phase high-speed counter

Ladder program: WindLDR function area settings and settings for data registers, special internal relays, and 
special data registers

FBD program: WindLDR function area settings and high-speed counter function block (HSC FB) settings
For details on the HSC FB, refer to Chapter 18 "The special FB" - "HSC (High-speed Counter)" in 
the "SmartAXIS FBD Programming Manual".

Paper roll

Paper feed roller

Perforator

Rotary
 encoder Two-phase pulses

High-speed pulse input

Output when count matches

SmartAXIS

Pulse motor

External input I0 I1 I2
↓ ↓ ↓

High-speed counter A-phase B-phase External clear input (Z-phase)
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● High-speed Counter External Inputs
The 12-I/O type can only use a maximum of four single-phase high-speed counters and a maximum of one dual-
phase high-speed counter.

■ Single-phase high-speed counter
The 12-I/O type cannot use external inputs I0 and I1 as single-phase high-speed counters.

■ Two-phase high-speed counter
External inputs I0/I1 (group 1) can be used as two-phase high-speed counters. External inputs I2 can be used as 
external clear inputs for group 1. In this situation, external inputs I2 cannot be used as single-phase high-speed 
counters.

*1 If not used as the external clear input (Z-phase), group 2 can be used as single-phase high-speed counters.

Group 1 2 3 4 5

External input I0 I1 I2 I3 I4 I5

Single-phase 
high-speed 
counter

– – Pulse input Pulse input Pulse input Pulse input

Group 1 2 3 4 5

External input I0 I1 I2 I3 I4 I5

Two-phase 
high-speed 
counter

Pulse input 
(A-phase)

Pulse input 
(B-phase)

External clear 

input*1

(Z-phase)
– – –
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● High-Speed Counter Operation
The high-speed counter turns on an external output or executes an interrupt program when the current value 
matches the preset value (target value).
The high-speed counter has two operation modes, single-phase high-speed counter and two-phase high-speed 
counter.
For how to configure the function to turn on an external output, refer to “Comparison Actions” on page 3-59.

■ Single-phase high-speed counter

Group 2, group 3, group 4, group 5 single-phase high-speed counter
• These groups only support adding counter.
• These groups support 10 kHz maximum pulse input and are capable of counting from 0 to 4,294,967,295 (32 bits).
• When the current value and the preset value match or an overflow occurs, an external output turns on or an 

interrupt program is executed.
• These groups only support the reset input via a special internal relay. When the reset is executed, the current value 

returns to the reset value specified by the special data registers.

■ Two-phase high-speed counter

Group 1 two-phase high-speed counter
• The two-phase high-speed counter counts by the phase difference between the A-phase and B-phase pulse input.
• These groups support 5 kHz maximum pulse input and are capable of counting from 0 to 4,294,967,295 (32 bits).
• Even higher speed counting is possible by specifying 2-edge count or 4-edge count.
• When the current value and the preset value match or an overflow or underflow occurs, an external output turns on 

or an interrupt program is executed.
• These groups support resetting the current value by the reset special internal relay or external clear input (Z-

phase). When the reset is executed, the current value returns to the reset value specified by the special data 
registers.

Counting mode Frequency

Adding counter Group 2, 3, 4, 5: 10 kHz

Group Frequency

Group 1
2-edge count: 5kHz

4-edge count: 2.5kHz
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● Counting mode
The high-speed counter has the following three counting modes.

■ Adding counter (single-phase high-speed counter)
The adding counter counts up with the rise in pulse input.

■ 2-edge count (two-phase high-speed counter)
This counter counts by the phase difference between A-phase and B-phase pulse input. When A-phase precedes B-
phase, the counter counts up with the rise and fall of B-phase. When B-phase precedes A-phase, the counter counts 
down with the rise and fall of B-phase.

■ 4-edge count (two-phase high-speed counter)
This counter counts by the phase difference between A-phase and B-phase pulse input. When A-phase precedes B-
phase, the counter counts up with the rise and fall of A-phase and B-phase. When B-phase precedes A-phase, the 
counter counts down with the rise and fall of A-phase and B-phase.

10 11 12 13 14Current value

Pulse input
(I2, I3, I4, I5)

0 1 1 0     2 23 34

B-phase

Current 
value

A-phase

0 1 2 3 4 5 6 7 7 6 5 4 3 2 1 08
Current 
value

B-phase

A-phase



SmartAXIS Touch User's Manual 3-59

4 Special Functions

3

Project

● Comparison Actions
The operating condition when comparing values is configured in the WindLDR High-speed Counter Settings, 
under Comparison Action.
The action when comparing values is Comparison Output or Interrupt Program, so specify an external output 
number or label number when comparing. However, the interrupt program can only be used when ladder program is 
selected as the programming language.

Operation

When the preset value and the current value are compared and the values match, the specified output is turned on or 
the interrupt program is executed.
A maximum of six high-speed counter preset values can be configured. For one preset value, the current value is 
compared with the same preset value each time.
When multiple preset values are configured, the preset value is changed each time the current value and preset value match.
For example, if four preset values are configured, when preset value 1 matches the current value, the comparison 
subject changes to preset value 2 → 3 → 4 in order.
When the final preset value 4 matches the current value, the preset value returns to preset value 1 and the values are compared.

■ Preset value storage locations
The preset values during high-speed counter operation are stored as 2 words in special data registers.

Specify the data registers to store the preset values in WindLDR and store those preset values in the ladder program or 
FBD program. Specify the starting address of the data registers to allocate the data registers to the individual settings in 
the comparison settings. When the high-speed counter is executed, the preset value with the number stored in Current 
Preset Value Number is active. The active preset value number for each comparison is stored in Current Preset Value 
Number and the next active preset value number is automatically stored in Next Preset Value Number. By changing 
the value of Next Preset Value Number in the ladder program or FBD program, the next active preset value number 
can be changed. The active preset value is stored for each group in the special data registers shown in the table above.

Example: Group 1, number of preset values is 3, set to device address D0000

When the current value matches preset value 1, Current Preset Value Number becomes 2 and 3 is stored in Next 
Preset Value Number.
When the device address is configured as D0000, Current Preset Value Number is stored in D0001 and Next 
Preset Value Number is stored in D0002.
For the group 1 preset value, the value of the data registers (D0004, D0005) allocated to preset value number 1 is 
stored in D8052 and D8053 as shown in the table above and it is compared to the current value.

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

Preset Value 
(Upper word) D8052 D8058 D8070 D8136 D8142

R/W
Preset Value 
(Lower word) D8053 D8059 D8071 D8137 D8143

Counting state Count
Before action

Count
Action start

Current value and 
preset value 1 

matched

Current value and 
preset value 2 

matched

Current value and 
preset value 3 

matched
Current Preset Value 
Number (D0001)

0 → 1 → 2 → 3 → 1

Next Preset Value 
Number (D0002)

1 → 2 → 3 → 1 → 2

Before the count action, set the Next 
Preset Value Number and preset value 1 
to 3 to the count values with the initialize 
pulse in ladder program or FBD program.

Preset value 1 is set 
to Current Preset 
Value Number

Preset value 2
is set.

Preset value 3
is set.

Once again, 
preset value 1 is 
set.

Repeat

When the Next Preset Value Number preset value becomes active, the high-speed counter preset value during execution 
does not change, even when the preset value for that preset value number is changed. When the current value and the current 
preset value match, the preset value with the number stored in Next Preset Value Number becomes active. Changes to the 
Next Preset Value Number data register must be performed before the preset value becomes active.
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Comparison operation flow

The comparison operation flow is as follows.

1 Start (Run) the Touch.

For the first scan, Next Preset Value Number is set to the number for preset value 1 with the initialize pulse.
For the second scan, an I/O refresh is performed in END processing and the value of Next Preset Value Number is 
transferred to Current Preset Value Number.
The content of Next Preset Value Number becomes the preset value n + 1 ("2" in this example).
When the number of preset values is 1, Next Preset Value Number is always "1".

2 Start the high-speed counter count operation.

Turn on the gate input to start the count operation.

3 Compare the Current Preset Value Number preset value and the current value. When the current value and the 
preset value match, the next number for the preset value becomes active and the high-speed counter continues 
counting.

Execute Comparison Output or Interrupt Program. (Comparison Output in this example)
• Turn on the comparison (special internal relay) for only one scan.
• Overwrite Current Preset Value Number with Next Preset Value Number and start the count with the preset 

value for Current Preset Value Number.
• Add 1 to Next Preset Value Number.

4 When the procedure is executed up to preset value 6, repeat again from the beginning with preset value 1.

Group
Group 1

 (I0 to I1)
Read/Write

Preset Value
(Upper word)

D8052
R/W

Preset Value
(Lower word)

D8053

Example: For group 1
Storage destination for the preset value that became active.
Stored by group.

The outputs (external outputs) when the values match.

The data register that stores the preset value (target value). 
Specify the starting address.

The preset value with the number that became active is 
the comparison subject with the current value and is 
stored in the special data registers.

Transfer

The Current Preset Value Number data register cannot be written to. It is read-only. 
Next Preset Value Number and Preset Value 1 to Preset Value 6 can be read and written to.
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● Procedure
To use the high-speed counter, a normal input must be specified as Two-phase High-speed Counter or Single-
phase High-speed Counter in the Function Area Settings tab. Inputs I0 to I7 on the Touch can be selected as 
normal input, high-speed counter, catch input, interrupt input, and frequency measurement.
When using normal input, catch input, interrupt input, or frequency measurement, high-speed counter cannot be 
used. The interrupt input can only be used when ladder program is selected as the programming language.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).
WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.
The Function Area Settings dialog box is displayed.

3 Select Two-phase High-speed Counter or Single-phase High-speed Counter for the group to use the high-speed counter.
The High-speed Counter Settings dialog box is displayed.

4 Configure the operation mode and the counting mode, and then click OK.
To use comparison actions, configure the comparison settings.

5 Click OK.
This concludes configuring the settings.
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● Settings

■ Operation Mode
Inputs for group 2, group 3, group 4 and group 5 can only be used as single-phase high-speed counters.
When group 1 is selected as the high-speed counter, group 2 (I2) can be used as clear input.

■ Counting Mode (single-phase high-speed counter)
The adding counter can only be used for group 2, group 3, group 4 and group 5 high-speed counters.

Adding Counter
The adding counter counts up with the rise in pulse input.

■ Counting Mode (two-phase high-speed counter)
When the two-phase high-speed counter is specified for Operation Mode for group 1, the counting mode can be 
selected as 2-edge count or 4-edge count. The two-phase counter cannot be used for the group 2, group 3, group 
4 and group 5 high-speed counters.

2-edge count
This counter counts at double the frequency of the input pulse.
This counter counts by the phase difference between the A-phase and B-phase pulse input. When A-phase precedes 
B-phase, the counter counts up with the rise and fall of B-phase. When B-phase precedes A-phase, the counter 
counts down with the rise and fall of B-phase.

4-edge count
This counter counts at quadruple the frequency of the input pulse.
This counter counts by the phase difference between A-phase and B-phase pulse input. When A-phase precedes B-
phase, the counter counts up with the rise and fall of A-phase and B-phase. When B-phase precedes A-phase, the 
counter counts down with the rise and fall of A-phase and B-phase.

■ Comparison Action
The comparison action is a function that compares the high-speed counter's current value with a preset value (target 
value).
It can use either the comparison output or an interrupt program. However, the interrupt program can only be used 
when ladder program is selected as the programming language.
• When Comparison Output is selected, the specified external output is turned on when the current value and the 

preset value match.
• When Interrupt Program is selected, the subroutine program with the specified label number is executed as the 

interrupt program when the current value and the preset value match.
Overflow and underflow can also be used for the comparison conditions.
For details on the comparison actions, refer to “Comparison Actions” on page 3-59.

■ Comparison Settings
When using the comparison output or the interrupt program as the comparison action for the high-speed counter, 
configure the external output number or the label number when there is a match. A maximum of six preset values can 
be specified for Number of Comparisons (preset value number 1 to 6).

Tag Name
Specify the Tag name which is allocated to the starting address of the data register region to store the preset values.

Device Address
Shows the address of the data register specified by the tag name.

Number of Comparisons
You can configure a maximum of six preset values (target values) for the comparison action.

Output
When a comparison action is selected, these are the external outputs specified for preset value 1 to 6.
The external outputs that can be used as comparison outputs are Q0 to Q3. 

• The preset value becomes active by the END processing in the second scan after the Touch starts 
operation. Store Preset Value in the data registers with initialize pulse M8120 input.

• When the preset value (special data register) is changed before the comparison, the preset value 
currently being used for the comparison is discarded in the program's END processing, and the 
comparison is performed with the newly configured preset value.
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Overflow
Select this check box to use overflow in the comparison action conditions (when the current value exceeds 
4,294,967,295).

Underflow
Select this check box to use underflow in the comparison action conditions (when the current value falls below 0).

■ Keep
After the current value matches the preset value, select to reset the current value to a reset value or to keep the 
value. Select this check box to keep the current value.

■ Use HSC Reset Input
Select this check box to reset the current value to a reset value with external input (high-speed counter reset input).
High-speed counter reset input can only be specified for group 1.

When high-speed counter reset input is turned on, the current value is reset to a reset value.
If high-speed counter reset input is not used, I2 is normal input.

■ Keep the current value at the time of power OFF
Select this check box to maintain the current values that have been kept with the backup battery when the Touch is 
turned on. This setting can be set for each group of Special Inputs. If this check box is cleared, the current values 
change to 0.

High-speed counter devices

The high-speed counter operates according to special internal relay and special data register settings. While the high-
speed counter is operating, the current value, control output, and operating status value are reflected in the special 
internal relays and special data registers with each scan.
The high-speed counter start and stop control signals and the current value, preset values, and reset values are 
allocated to the special internal relays and special data registers.

Device allocation table

The devices used by the high-speed counter are as follows.

Special internal relay list

When the comparison action is Comparison Output and either a preset value, overflow, or underflow has 
been enabled as a comparison condition, the text box to enter the comparison output is enabled. The 
comparison output can be specified for each of these match conditions.

Group External input

Group 1 I2

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Comparison 
Output Reset

M8030 M8040 M8055 M8166 M8173

R/W
Gate Input M8031 M8041 M8056 M8167 M8174

Reset Input M8032 M8042 M8057 M8170 M8175

Reset Status M8033 – – – –

R

Comparison ON 
Status

M8034 M8043 M8060 M8171 M8176

Overflow M8035 M8044 M8061 M8172 M8177

Underflow M8036 – – – –

Count Direction 
Flag

M8037 – – – –
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Special data register list

When using the devices above with instructions or FB where the data type unit can be specified, specify the data type 
as double word (D). When the 32-bit data storage setting in the function area settings is set to from Lower Word, 
the lower word is stored in the first device.

■ Start/stop high-speed counter
The high-speed counter can be started and stopped per group by turning the gate input on or off.

■ Current value storage locations
The current value for the single-phase high-speed counter is stored in special data registers as 2 words per group.

When the 32-bit data storage setting in the function area settings is set to from Lower Word, the lower word is 
stored in the first device.

■ Comparison ON status
When the current value and the preset value match, the special internal relay turns on for only one scan.

■ Overflow
When the current value exceeds 4,294,967,295, the special internal relay turns on for only one scan. When the 
current value overflows, it becomes 0.

■ Underflow
When the current value falls below 0, the special internal relay turns on for only one scan. When the current value 
underflows, it becomes 4,294,967,295.

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Current Value 
(Upper word)

D8050 D8056 D8068 D8134 D8140
R

Current Value 
(Lower word)

D8051 D8057 D8069 D8135 D8141

Preset Value 
(Upper word)

D8052 D8058 D8070 D8136 D8142

R/W

Preset Value 
(Lower word)

D8053 D8059 D8071 D8137 D8143

Reset Value 
(Upper word)

D8054 D8060 D8072 D8138 D8144

Reset Value 
(Lower word)

D8055 D8061 D8073 D8139 D8145

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Gate Input M8031 M8041 M8056 M8167 M8174 R/W

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Current Value 
(Upper word)

D8050 D8056 D8068 D8134 D8140
R

Current Value 
(Lower word)

D8051 D8057 D8069 D8135 D8141

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Comparison ON 
Status

M8034 M8043 M8060 M8171 M8176 R

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Overflow M8035 M8044 M8061 M8172 M8177 R

Group
1

(I0 to I1)
2

(I2)
3

(I3)
4

(I4)
5

(I5)
Read/Write

Underflow M8036 – – – – R
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■ Comparison output reset
When the special internal relay turns on, the comparison output selected on High-speed Counter Settings turns off.

■ Reset input
When reset input is turned on, the current value returns to the reset value.

■ Preset value, reset value storage locations
The preset value and the reset value for the high-speed counter are stored in special data registers as 2 words.

When the 32-bit data storage setting in the function area settings is set to from Lower Word, the lower word is 
stored in the first device.

■ HSC reset input and reset status
When the HSC reset input is enabled in group 1, turn on HSC reset input I2 to return the current value to the reset 
value.
In this situation, reset status turns on for only one scan.

To use the reset input with group 1 single-phase high-speed counter, use I2 (group 2). When not using I2 as a reset 
input, it can be used as normal input, high-speed counters, catch input, interrupt input, or frequency measurements.

■ Count direction flag
These special internal relays maintain whether group 1 current value count is being added or subtracted.
When these special internal relays are on, they indicate addition. When they are off, they indicate subtraction.

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

Comparison 
Output Reset M8030 M8040 M8055 M8166 M8173 R/W

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

Reset Input M8032 M8042 M8057 M8170 M8175 R/W

Reset input

NN-1 N+1 Reset value (initial value)Current value

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

Preset Value 
(Upper word) D8052 D8058 D8070 D8136 D8142

R/W

Preset Value 
(Lower word) D8053 D8059 D8071 D8137 D8143

Reset Value 
(Upper word) D8054 D8060 D8072 D8138 D8144

Reset Value 
(Lower word) D8055 D8061 D8073 D8139 D8145

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

HSC Reset Input I2 – – – – –

Reset Status M8033 – – – – R

HSC reset input

Reset status

NN-1 N+1 Reset value (initial value)Current value

One scan

Group 1
(I0 to I1)

2
(I2)

3
(I3)

4
(I4)

5
(I5) Read/Write

Count Direction 
Flag M8037 – – – – R
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● Timing chart 1
Single-phase high-speed counter (group 5) timing chart

Operating conditions

One preset value is used, and when the values match, output Q1 turns on and the current value is kept.

Overflow and underflow are not used.

1 When reset input (M8175) turns on, the reset value (D8144, D8155) is stored in the current value (D8140, D8141).

2 When gate input (M8174) turns on, the counting begins.

3 When the current value (D8140, D8141) and preset value 1 (D8142, D8143) match, the preset value 1 comparison 
output (Q1) and Comparison ON status (M8176) turn on. When the Keep check box is selected in the settings in the 
WindLDR High-speed Counter Settings, the current value is kept.

4 Q1 maintains the on state until comparison output reset (M8173) turns on. Preset value Comparison ON status 
(M8176) turns on for only one scan.

5 When the gate output turns off, counting stops.

Current value (D8140, D8141)

Preset value 1=6
(D8142, D8143)

Pulse input I5

Q1

M8175

M8174

M8173

M8176

(D8144, D8145)

Gate input

Preset value
Comparison ON status

Reset input

One scan

Comparison output 
reset

Preset value 1
Comparison output

14
13
12
11
10
9
8
7
6
5
4
3
2
1
0

Reset value=2

Reset

High-speed counter usage precautions
The high-speed counter starts the count operation with the following two conditions.
• The Touch starts operation.
• The gate input is turned on.
To start the count operation, turn the gate input on from off when the Touch is running. When the gate 
input is already on when the Touch is stopped, the count operation starts when the Touch is switched from 
stop to run.
When a ladder program or FBD program is downloaded during the count operation, the count operation 
stops. The count operation will restart by setting the Touch to run.
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● Timing chart 2
Two-phase high-speed counter (group 1) timing chart

Operating conditions

The counting mode is set to 2-edge count and reset input (I2) is used.
Two preset values are used, and when preset value 1 matches, output Q1 turns on and the current value is kept.
When preset value 2 matches, output Q2 turns on and the current value is cleared.
Overflow and underflow are not used.

1 When reset input (I2) turns on, the reset value (D8054, D8055) is stored in the current value (D8050, D8051).
In this situation, reset status (M8033) turns on for only one scan.

2 When gate input (M8031) turns on, counting begins.

3 When A-phase pulse (I0) precedes B-phase pulse (I1), the count goes up. When B-phase pulse (I1) precedes A-phase 
pulse (I0), the count goes down.

4 When the current value and preset value 1 (D8052, D8053) match, the preset value 1 comparison output (Q1) and 
setting value match (M8034) turn on.
When preset value 1 matches, preset value 2 is stored in the preset value (D8052, D8053) as the new preset value 
and counting continues.

5 The preset value 1 comparison output (Q1) maintains the on state until comparison output reset (M8030) turns on. 
M8034 turns on for only one scan.

Current value

Preset value 1=8

Reset value=4
(D8554, D8555)

Preset value 2=14

One scan

UP DOWN

A-phase I0

I1

11

1 0

Q1

Q2

I2

M8033

M8031

M8030

M8034

B-phase

Gate input

Preset value
Comparison ON status

Reset status

Reset input

One scan

Reset

Reset
Comparison output 
reset

Preset value 1
Comparison output

Preset value 2
Comparison output

14
13
12
11
10
9
8
7
6
5
4
3
2
1
0

One scan
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● Example 1
Using the single-phase high-speed counter in the ladder program, this example program turns on external output Q2 when 
1,000 pulses are input.

Application description

When pulses are input to input I0 and the count reaches 1,000, output Q2 is turned on.

1 In the WindLDR, on the Configuration tab, in the Function Area Settings group, click the Input Configuration.

The Function Area Settings dialog box is displayed.

2 Select the Single-phase High-speed Counter for Group 2. 

The High-speed Counter Settings dialog box is displayed.

3 Configure the settings as follows, and then click OK.

External input : Group 2 (I2)

Operation Mode : Single-phase High-speed Counter

Counting Mode : Adding Counter

Comparison Action : Comparison Output

Comparison Settings

Tag Name/Device Address : D0000 (data register)

Number of Comparisons : 1

Comparison output : Q2 (external output when matched)

Comparison1 (D4) : 0 (upper word)

Comparison1 (D5) : 1,000 (lower word)

Keep : Cleared

Reset value (D8054) : 0 (upper word)

Reset value (D8055) : 0 (lower word)

Overflow : Cleared

Underflow : Cleared

Use HSC Reset Input : Cleared

Keep the current value at the time of power OFF : OFF
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Ladder program

M8120 (initialize pulse) is a special internal relay that turns on for one scan when the Touch runs.

M8031

M8120

M8120

M8031

M8032

M0000

M0000

M0000

1st scan
Store 1,000 in preset value 1 (D0004, D0005)

3rd scan
Detect the rising edge of M0000, turn on gate input (M8031)
Start high-speed counter counting in the END processing 
after the 3rd scan is executed

Store the reset value in D8054, D8055

Store 1 in the next preset value number (D0002)

Turn off gate input (M8031)

Turn off M0000

D1-
D0002

REPS1-
1

MOV(W)

D1-
D8054

REPS1-
0

MOV(D)

D1-
D0004

REPS1-
1000

MOV(D)

2nd scan
Detect the falling edge of the initialize pulse, M0000 and M8032 turn on 
Initialize the current value with the reset value in the END processing 
after the 2nd scan is executed

M8032 (reset input) is a special internal relay that stores the preset 
value (D8054, D8055) in the current value (D8050, D8051).
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● Example 2
Using the two-phase high-speed counter, the pulses from a rotary encoder are input to the Touch and a continuous 
workpiece is marked at a regular interval.

Application description

1 In the WindLDR, on the Configuration tab, in the Function Area Settings group, click the Input Configuration.

The Function Area Settings dialog box is displayed.

2 Select the Two-phase High-speed Counter for Group 1. 

The High-speed Counter Settings dialog box is displayed.

3 Configure the settings as follows, and then click OK.

• The rotary encoder pulses are input to input I0. A 
continuous sheet of paper is marked (holes are 
punched) at a regular interval (every 2,700 
pulses).

• The rotary encoder is directly connected to the 
paper feed roller, and output pulses are counted 
by the high-speed counter and controlled.

• The cycle time is the time to count 2,700 pulses.
When the hole punch time is 0.5 seconds, the 
operation condition is 2,700 pulse count time > 
0.5 seconds.

Paper roll Paper feed roller

Perforator

Rotary encoder

Touch

External input : Group 1 (I0 to I1)

Operation Mode : Two-phase High-speed Counter

Counting Mode : 4 Edge Count

Comparison Action : Comparison Output

Comparison Settings

Tag Name/Device Address : D0000 (data register)

Number of Comparisons : 1

Comparison output : Q2 (external output when matched)

Comparison1 (D0004) : 0 (upper word)

Comparison1 (D0005) : 2,700 (lower word)

Keep : Cleared

Reset value (D8054) : 0 (upper word)

Reset value (D8055) : 0 (lower word)

Overflow : Cleared

Underflow : Cleared

Use HSC Reset Input : Cleared

Keep the current value at the time of power OFF : ON
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Program

M8120 (initialize pulse) is a special internal relay that turns on for one scan when the Touch runs.

Preset value 1=2,700

2,700 pulses

Perforation time: 0.5 seconds

Q2

M8031

M8031

M8032

M8030

M0000

M0000

M0000

M8120

Current value

Reset value 0

Comparison output Q2

M8120

SOTU

SOTD

D1-
D0004

REPS1-
2700

MOV(D)

D1-
D8054

REPS1-
0

MOV(D)

D1-
D0002

REPS1-
1

MOV(W)

TIM
5

T0

1st scan
Store 2,700 in preset value 1 (D0004, D0005)

3rd scan
Detect the rising edge of M0000, turn on gate input (M8031)
Start high-speed counter counting in the END processing after the 3rd 
scan is executed

2nd scan
Detect the falling edge of the initialize pulse, M0000 and M8032 turn on 
Initialize the current value with the reset value in the END processing 
after the 2nd scan is executed

Store 0 in the reset value (D8054, D8055)

Turn off gate input (M8031)

Turn off M0000

M8032 (reset input) is a special internal relay that stores the reset 
value (D8054, D8055) in the current value (D8050, D8051).

When the current value becomes 2,700 pulses, comparison 
output Q2 turns on 
The timer starts and comparison output reset (M8030) turns on after 
five seconds

Store 1 in the next preset value number (D0002)

In this example, Z-phase reset input is not used.
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4.8 Catch Input

This section explains catch inputs, which reliably capture short pulses such as sensor signals.

● Feature Description
Catch inputs are used to capture short pulses that change within the timeframe of a single scan. If catch inputs are 
used, ON/OFF states are stored in special internal relays (M8091 to M8094) corresponding to each group of external 
inputs, in accordance with the state of the external inputs during the time of one scan, and these signals can be used 
as input conditions. When a pulse is captured, the special internal relays turns ON or OFF during a single scan. If the 
pulse is captured again during the next scan, the special internal relays will again turn ON/OFF during the scan.
To use catch inputs, specify Catch Input for the external input group that uses catch inputs under Function Area 
Settings in WindLDR.

Catching Rising Edge of Input Pulse

Catching Falling Edge of Input Pulse

Catch Input Specifications
Minimum Turn ON Pulse Width: 50 μsec/Minimum Turn OFF Pulse Width: 50 μsec

● Input
The Touch inputs can be configured as normal inputs, high-speed counters, catch inputs, interrupt inputs, or 
frequency measurement. To use catch inputs, specify Catch Input for the applicable group under Function Area 
Settings.

The states of external inputs assigned to catch inputs are stored in the following special internal relays for each 
group. (Read Only)

The 12-I/O type cannot use external inputs I6 and I7 as catch inputs on Touch.

*1 When two or more pulses enter within one scan, subsequent pulses are ignored.

Actual Input

Catch Input Relay
(M8090-M8095)

END
Processed

1 scan time

*1

Actual Input

Catch Input Relay
(M8090-M8095)

END
Processed

1 scan time

*1

Group 1 2 3 4 5

External Input I0 I1 I2 I3 I4 I5

Catch Input – – Catch Input Catch Input Catch Input Catch Input

Group Catch Input Special Internal Relay for Catch Input

Group 2 I2 M8091

Group 3 I3 M8093

Group 4 I4 M8094

Group 5 I5 M8095

Input filter settings have no effect on the catch inputs.
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● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Select Catch Input in the Groups 1 through 6 pull-down list boxes. 

The Catch Input dialog box is displayed.

4 Select Catch Input Rising Edge or Catch Input Falling Edge in the pull-down list, and then click OK.

5 Click OK.

This concludes configuring the settings.

● Example: Maintaining Catch Input
When a catch input is received, the catch input relay assigned to a catch input is turned on for only one scan.
This example demonstrates a program to maintain a catch input status for more than one scan.

M8091

M0000

M0001 M0000

Input I2 is designated as a catch input using the 
Function Area Settings.
When input I2 is turned on, special internal relay 
M8091 is turned on, and M0000 is maintained in 
the self-holding circuit.
When NC input M1 is turned off, the self-holding 
circuit is unlatched, and M0 is turned off.
M0 is used as an input condition for the 
subsequent program instructions.
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4.9 Interrupt Input

This section explains interrupt inputs, which can be used to interrupt execution of a ladder program by means of an 
external input to execute a subroutine.
The interrupt input can only be used when ladder program is selected as the programming language.

● Feature Description
In the processing of normal ladder programs, execution proceeds iteratively from beginning to end, but if an interrupt 
input is used, ladder program execution can be temporarily paused in order to execute a subroutine, irrespective of 
scans. With an interrupt input, a subroutine of predetermined label No. is run as an interrupt program when the 
external input is turned ON. When processing of the subroutine program is ended, execution of the interrupt program 
resumes. Up to 4 interrupt inputs can be set for external input groups 2 to 5.

● Function Specification
The Touch inputs can be configured as normal inputs, high-speed counters, catch inputs, interrupt inputs, or 
frequency measurement. To use catch inputs, specify Interrupt Input for the applicable group under Function Area 
Settings.
Jump destination label Nos. are stored in special data registers (D8033 to D8035, D8037, D8038).
Whether or not an interrupt input is allowed can be checked by the interrupt input state of the special internal relay 
(ON: Allowed, OFF: Prohibited). 

The 12-I/O type cannot use external inputs I6 and I7 as interrupt inputs on Touch.

● Disable and Enable Interrupts
The interrupt inputs I2, I3, I4, and I5 and timer interrupt are normally enabled while the Touch is running, and can 
also be individually disabled using the DI instruction or enabled using the EI instruction. When interrupt inputs I2, I3, 
I4, and I5 are enabled, special internal relay are turned on, respectively. For details, refer to Chapter 16 "Interrupt 
Control Instructions" in "SmartAXIS Ladder Programming Manual".
When the Touch starts operation, interrupt inputs are set to the interrupt allowed state.

● Notes for Using Interrupt Inputs and Timer Interrupt:
• When using an interrupt input or timer interrupt, separate the interrupt program from the main program using the 

END instruction at the end of the main program.
• When an interrupt program calls another subroutine, a maximum of 3 subroutine calls can be nested. If more than 

3 calls are nested, a ladder program execution error occurs.
• When using an interrupt input or timer interrupt, include the label number of the interrupt program to be executed 

when an interrupt occurs. The label numbers stored in data registers D8033 through D8035, D8037, and D8038 
specify the interrupt programs for interrupt inputs I2, I3, I4, and I5 and timer interrupt, respectively.

• When more than one interrupt input is turned on at the same time, interrupt program execution is given priority to 
inputs I2, I3, I4 and I5, in that order. If an interrupt is initiated while another interrupt program is executed, the 
subsequent interrupt program is executed after the prior interrupt is completed. Multiple interrupt programs cannot 
be executed simultaneously.

• Make sure that the execution time of the interrupt program is shorter than interrupt intervals sufficiently.
• Interrupt programs cannot use some instructions. For details, refer to Chapter 12 “2.2 Instructions Reference” on 

page 12-14.

Group 1 2 3 4 5

External Input I0 I1 I2 I3 I4 I5

Interrupt input – –
Interrupt 

input
Interrupt 

input
Interrupt 

input
Interrupt 

input

Special Data Register 
(Jump Destination Label No.)

– – D8033 D8035 D8037 D8038

Special Internal Relay 
(Interrupt Input Status): 
Read only

– – M8071 M8073 M8074 M8075
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● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Select Interrupt Input in the Groups 1 through 6 pull-down list boxes. 

The Interrupt Input dialog box is displayed.

4 Select Interrupt Input Rising Edge, Interrupt Input Falling Edge or Interrupt Both Edges in the pull-down 
list, and then click OK.

5 Click OK.

This concludes configuring the settings.
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● Example: Interrupt Input
The following example demonstrates a program using the interrupt input function, with input I2 designated as an 
interrupt input. When the interrupt input is turned on, the input I0 status is immediately transferred to output Q0 
using the IOREF (I/O refresh) instruction before the END instruction is executed.

M8120 is the initialize pulse special internal relay.
D8033 stores 0 to designate jump destination label 0 for 
interrupt input I2.

The interrupt program is separated from the main program by 
the END instruction.

When input I2 is on, program execution jumps to label 0.

M8125 is the in-operation output special internal relay.
IOREF immediately reads input I0 status to internal relay 
M0300.
M0300 turns on or off the output Q0 internal memory.
Another IOREF immediately writes the output Q0 internal 
memory status to actual output Q0.
Program execution returns to the main program.
Insert LRET at the end of the subroutine to return to the main 
program.

To change input/output information during execution of an interrupt program, use the IOREF (Input/Output 
Refresh) instruction. The IOREF instruction is used to freely change input/output data before the END scan. 
For details, refer to Chapter 15 "Refresh Instructions" in "SmartAXIS Ladder Programming Manual".
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4.10 Frequency Measurement

This section describes frequency measurement, which measures the input frequency.

● Feature Description
These input pulses are processed in hardware, so frequencies can be measured with no relation to the scan time. 
Groups that do not use frequency measurement can be used as normal inputs, high-speed counters, catch input, or 
interrupt input. The measurement results are stored in special data registers and being updated with each scan.

● Function Specification
The Touch inputs can be configured as normal input, high-speed counters, catch input, interrupt input, and frequency 
measurement. To use frequency measurement, specify the relevant group as Frequency Measurement in 
Function Area Settings tab.
The frequency measurement results are stored in the following special data registers. (Read-only)
Any one of Groups 2, 3, 4, or 5 can be freely set.
Inputs I6 and I7 cannot be used for frequency measurement.

Group 1 2 3 4 5

External Input I0 I2 I3 I4 I5

Frequency 
measurement 
value (32 bits)

Upper 
word

– D8056 D8068 D8134 D8140

Lower 
word

– D8057 D8069 D8135 D8141

Frequency measurement 
range

200Hz to 10kHz

Measurement error
Less than ±1%

(Truncated after the decimal point)

Calculation cycle Each scan time

If the input pulse cycle is longer than the scan time, the measurement results are updated at pulse cycle + 1 
scan time.



4 Special Functions

3-78 SmartAXIS Touch User's Manual

● Procedure
To use frequency measurement, you must configure it in the Function Area Settings and download the ladder 
program or FBD program to the Touch. Frequency measurements will start when you download the ladder program 
or FBD program and set the Touch to run.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Specify Frequency Measurement for the group to use frequency measurement.

4 Click OK.

This concludes configuring the settings.
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4.11 Input Filter

The input filter function is used to reject input noises. The catch input function described in the preceding section is 
used to read short input pulses to special internal relays.

● Feature Description
The input filter rejects short input pulses when the Touch is used with input signals containing noises.
Different input filter values can be selected for inputs I0 through I7 in four groups using the Function Area Settings. 
Selectable input filter values to pass input signals are 0 millisecond, and 3 through 15 milliseconds in 1 millisecond 
increments. Default value is 3 milliseconds for all inputs I0 through I7. Inputs I10 and above on Touch are provided 
with a fixed filter of 3 milliseconds.
 

Input Filter Values and Input Operation

Depending on the selected values, the input filter has three response areas to reject or pass input signals.

The input filter rejects inputs shorter than the selected input filter value minus 2 milliseconds.

Example: Input Filter

To reject input pulses of 6 milliseconds or less, select input filter value of 8 milliseconds. Then input pulses of 8 
milliseconds plus one scan time are accepted correctly at the END processing.

Input signalsChattering

• Input signals : Input signals do not pass the filter (selected filter value minus 2 milliseconds).

• Pass area : Input signals pass the filter (selected filter value).

• Indefinite area : Input signals may be rejected or passed.

 6 msec                        8 msec

Rejected Indefinite Accepted

• Signals that pass through input filters are not necessarily captured as inputs. Normal inputs require a 
pulse width of the filter value plus one scan time to receive input signals.

• If external inputs are set as high-speed counters, interrupt inputs, frequency measurement, or analog 
inputs, input filters are disabled.
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● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 If an input to which an input filter is applied is not a normal input, select Normal Input in the corresponding group.

4 Select an input filter value for each group of inputs.

5 Click OK.

This concludes configuring the settings.

The columns displayed next to 
I0000 indicate I0 to I7.
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4.12 Analog Input

This section describes how to configure analog input signals such as those from pressure sensors.

● Feature Description
The Touch is equipped with two analog inputs. 
The FT1A-*12RA-* accepts analog input of 0 to 10V DC by converting it to 0 to 1000 digital values.
The FT1A-*14KA-* and the FT1A-*14SA-* accepts analog input of 0 to 10V DC or 4 to 20 mA by converting it to 0 to 
1000 digital values. The converted analog input values are stored in special data registers. Inputs that are not 
specified as analog inputs are digital inputs. For the on or off judgment threshold value when digital input is specified, 
refer to Chapter 29 “SmartAXIS Specifications” on page 29-1.

● Applicable Models
The type analog input that can be used varies based on the model.

● Storage Locations for the Analog Input Value and Analog Input Status
The Touch has two embedded analog inputs. The digitally converted analog input values are stored in special data 
registers (D8040 and D8041: read-only) as values between 0 and 1,000. The analog input status is also stored in 
special data registers (D8042, D8043, and D8077: read-only). These values are updated with each scan.

■ Analog Input Status (D8077)
If the analog input signal exceeds 11 V or 21 mA, the corresponding bit of D8077 turns on to indicate overflow. For 
details, refer to Chapter 27 “2.2 Control Device Addresses” on page 27-12.

■ Analog Input Status (D8042, D8043)
Details on the analog input status (D8042, D8043) are as follows.

Analog input
FT1A-*14KA-*
FT1A-*14SA-*

FT1A-*12RA-*

0 to 10 V YES YES

4 to 20 mA YES NO

Analog input terminal AI0 AI1

Special data register that stores the analog input value D8040 D8041

Special data registers that store the analog input status
D8077
D8042

D8077
D8043

Status Description Analog input value

0 Operating normally Current analog input value

1
Converting data (occurs only once during the initial 
conversion when the power is turned on)

Undefined value

2 Initializing 0

3 Parameter setting error
Correct value immediately before the error 
occurred

4 Reserved ―

5
Wiring fault (out of maximum range)
Analog input signals exceed 11 V, or 21 mA

Maximum

6
Wiring fault (out of minimum range, open current loop)
Analog input signals fall below 2 mA

Minimum

7 to 65535 Reserved ―
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● Analog Input Filter
The analog input data is averaged by the specified filter count. This can reduce rapid fluctuations in analog input.
The larger the filter value set, the slower the tracking of the change in analog input becomes.

When filtering, the input value is calculated with the equation below.

● Analog Input Allocation

Count Description

0 No filtering

1 to 255 The input value is set as the average value of n samples of analog input value. (n: Count)

Analog input value after filtering =
Total analog input values for filter count (n) worth of scans

Filter count n

Input I0 ... I5 I6 I7

Analog input terminal – – – AI0 AI1

Special data register that stores 
analog input value

– – – D8040 D8041

Special data registers that store 
analog input status

– – –
D8077
D8042

D8077
D8043
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● Procedure
To use analog input, you must configure the Function Area Settings tab and download the ladder program or FBD 
program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Under Type for the external input to use as an analog input, select Analog.

4 Under Filter (times), specify the number of times to filter, and under Signal Type, select 0 to 10V DC or 
4 to 20mA DC.

Click Default to set all the external inputs to digital.

5 Click OK.

This concludes configuring the settings.
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4.13 Timer Interrupt

This section describes the timer interrupt that executes the interrupt program at a regular time interval. 
The timer interrupt can only be used when ladder program is selected as the programming language.

● Feature Description
The timer interrupt is a function that executes a subroutine program with a predetermined label number as the 
interrupt program at a regular time interval. The Function Area Settings dialog box is used to enable the timer 
interrupt and to specify the interval, from 10 to 140 milliseconds, to execute the timer interrupt. When the timer 
interrupt is enabled, the program execution jumps to the jump destination label number stored in special data register 
D8036 repeatedly while the Touch is running. 

● Disable and Enable Interrupts
The timer interrupt is normally enabled while the Touch is running, and can also be individually disabled using the DI 
instruction or enabled using the EI instruction. When timer interrupt is enabled, Touch is turned on. When disabled, 
Touch is turned off. 
For details, refer to Chapter 16 "Interrupt Control Instructions" in "SmartAXIS Ladder Programming Manual".

● Notes for Using Timer Interrupt and Interrupt Inputs
• When using a timer interrupt or interrupt input, separate the interrupt program from the main program using the 

END instruction at the end of the main program.
• When an interrupt program calls another subroutine, a maximum of 3 subroutine calls can be nested. If more than 

3 calls are nested, a ladder program execution error occurs.
• The label numbers stored in data registers D8036 specify the interrupt programs for interrupt inputs I2, I3, I4, and 

I5 and timer interrupt, respectively.
• If an interrupt is initiated while another interrupt program is executed, the subsequent interrupt program is 

executed after the prior interrupt is completed. Multiple interrupt programs cannot be executed simultaneously.
• Make sure that the execution time of the interrupt program is shorter than interrupt intervals sufficiently.
• Interrupt programs cannot use some instructions. For details, refer to Chapter 12 “2.2 Instructions Reference” on 

page 12-14.

D8036 Timer Interrupt Jump Destination Label No. R/W

A label is the starting address of the program branch to jump to, and it is specified by the LABEL instruction.
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● Procedure
To use timer interrupt, you must configure it in the Function Area Settings in WindLDR and download the ladder 
program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Select the Use Timer Interrupt check box.

4 Specify an interval to execute the timer interrupt.

5 Click OK.

This concludes configuring the settings.

● Example: Timer Interrupt
The following example demonstrates a program of using the timer interrupt function. The Function Area Settings 
must also be completed to use the timer interrupt function as described on the preceding page.

M8120 is the initialize pulse special internal relay.
D8036 stores 0 to designate jump destination label 0 for timer 
interrupt.

The interrupt program is separated from the main program by the 
END instruction.

While the SmartAXIS is running, program execution jumps to label 
0 repeatedly at intervals selected in the Function Area Settings.
Each time the interrupt program is completed, program execution 
returns to the main program at the address where timer interrupt 
occurred.

Insert LRET at the end of the subroutine to return to the main 
program.

LABEL
0

M8120

END

Main Program

REPS1 –
0

D1 –
D8036

MOV(W)

LRET

Interrupt Program
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4.14 Analog Output

This section describes how to configure analog output signals for voltage and current.

● Feature Description
The FT1A-*14KA-* and the FT1A-*14SA-* are equipped with two analog outputs. This function converts 0 to 10 V DC 
or 4 to 20 mA analog signals into 0 to 1, 000 increment and stored in special data registers.

The FT1A-*12RA-* does not have analog output function.

● Applicable Models

● Storage Location for the Analog Output Value and Status
The analog output values (0 to 1,000) stored in the special data registers (D8044 and D8045) are converted to analog 
signals by the scan end processing in the ladder program or FBD program, and then output from AQ0 and AQ1. The 
analog output status is also stored in special data registers (D8046 and D8047: read-only). These values are updated 
with each scan.

■ Analog Output Status (D8046, D8047)
Details on the analog output status are as follows.

In the cases below, the minimum value of analog output is written to the special data registers for the 
analog outputs.
• When the Touch is reset, such as when the Touch is powered up.
• When Ladder program or FBD program is in STOP state and M8025 (Maintain Outputs While Program 

Operation Stopped) is OFF.

Analog output
FT1A-*14KA-*
FT1A-*14SA-*

FT1A-*12RA-*

0 to 10 V YES –

4 to 20 mA YES –

Analog output terminal AQ0 AQ1

Analog output value D8044 D8045

Analog output status D8046 D8047

Status Description Analog output signal

0 Operating normally Current analog output value

1 Reserved –

2 Initializing 0 V / 4 mA

3 Parameter setting error
Analog output value immediately before the 
error occurred

4 to 9 Reserved –

10 Set to unused for the Signal Type –

11
Analog outputs unsupported model (FT1A-*12RA-*) has 
been selected

–

12 to 65535 Reserved –

For input FB and output FB in FBD programs, only analog value input (AI FB) is supported. Analog value 
output is not supported. To output analog values in FBD programs, store the analog output value in the 
relevant special data register (D8044, D8045, D8176, D8177, D8186, D8187) using script programming.
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● Procedure
To use analog output, you must configure it in the Function Area Settings tab and download the ladder program or 
FBD program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Input & Output Configuration.

The Function Area Settings dialog box is displayed.

3 Under Signal Type for the external output to use as the analog output, select 0 to 10V DC or 4 to 20mA DC.

4 Click OK.

This concludes configuring the settings.
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4.15 Analog Cartridge

This section describes the analog cartridge settings.

● Feature Description
The FT1A-*14KA-* and the FT1A-*14SA-* are equipped with two slots used for attaching analog cartridges. A 
maximum of two analog cartridges can be used, and by attaching these analog cartridges, the Touch can be 
expanded to a maximum of 2in/6out, 4in/4out, or 6in/2out analog I/O.
Select the analog cartridges for the external devices and set the operation mode. The analog value and analog status 

for each channel are stored in special data registers.

● Applicable Models
Only the FT1A-*14KA-* and the FT1A-*14SA-* are capable of supporting analog cartridges.
The FT1A-*12RA-* does not support analog cartridges.

● Analog Cartridge Specifications
• The analog cartridges are available in the analog input type and analog output type.
   The analog input type is called the analog input cartridge, and the analog output type is called the analog output 
cartridge.
• The analog input cartridge is available in two types, voltage/ current input type (FC6A-PJ2A) and temperature input 

type(FC6A-PJ2CP). A single analog input cartridge has two analog inputs, and each channel can be set to a 
different operation mode.

• The analog output cartridge is available in two types, voltage output type (FC6A-PK2AV) and current output type 
(FC6A-PK2AW). A single analog output cartridge has two analog outputs, and the operation mode is common to 
both.

• To use an analog cartridge, it must be configured in the Function Area Settings tab in Control Functions.
• The analog input/output value for each analog cartridge channel are stored in special data registers. For details, 

refer to “Storage Location for the Analog Value and Analog Status” on page 3-92.

In the cases below, the minimum value of analog output is written to the special data registers for the 
analog outputs.
• When the Touch is reset, such as when the Touch is powered up.
• When Ladder program or FBD program is in STOP state and M8025 (Maintain Outputs While Program 

Operation Stopped) is OFF.

• Always turn the Touch off before removing or installing the analog cartridge. If the analog cartridge is inserted 
or removed with the power on, there is a risk of the product failure. Touch operation cannot be guaranteed. 

• The analog cartridge may be damaged if dropped. Be careful not to drop it when removing it.
• Correctly attach the analog cartridges in the slots.

Analog cartridge
FT1A-*14KA-*
FT1A-*14SA-*

FT1A-*12RA-*

FC6A-PJ2A YES –

FC6A-PJ2CP YES –

FC6A-PK2AV YES –

FC6A-PK2AW YES –
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Type Number Configuration

The type, number of analog inputs or outputs, and operation modes by analog cartridge type number are as follows.

Checking the Version Number

The analog cartridge version number is printed on the side of the analog cartridge in the location in the following 
diagram. The performance and functionality of the analog cartridge will differ by its version, so check the version 
number before use.

Type No. Type
Number of 

points
Operation mode Digital Resolution

FC6A-PJ2A Analog input 2 points

Voltage 0 to 10V DC

4,096 increments (12bit)
Current

0 to 20 mA

4 to 20 mA

FC6A-PJ2CP Analog input 2 points

Thermocouple

Type K 15,000 increments (14bit)

Type J 12,000 increments (14bit)

Type R 17,600 increments (15bit)

Type S 17,600 increments (15bit)

Type B 18,200 increments (15bit)

Type E 10,000 increments (14bit)

Type T 6,000 increments (13bit)

Type N 15,000 increments (14bit)

Type C 23,150 increments (15bit)

Resistance 
thermometer  
(RTD)

Pt100 10,500 increments (14bit)

Pt1000 8,000 increments (13bit)

Ni100 2,400 increments (12bit)

Ni1000 2,400 increments (12bit)

FC6A-PK2AV Analog output 2 points Voltage 0 to 10V DC 4,096 increments (12bit)

FC6A-PK2AW Analog output 2 points Current 4 to 20 mA 4,096 increments (12bit)

LOT No.14XS12525
MADE IN JAPAN
V100

LOT No.xxxxxxxxx
MADE IN JAPAN

V100

Version Number
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● Analog I/O Allocation
The analog inputs or analog outputs expanded by using an analog cartridge are allocated as follows.

Allocation example

Example 1: When an analog input cartridge is attached to analog cartridge port 1 and an analog output cartridge is 
attached to analog cartridge port 2

Example 2: When an analog input cartridge is only attached to analog cartridge port 2

Touch
Analog cartridge

Port 1 Port 2

Channel – – CH0 CH1 CH0 CH1

Analog number (AI/AQ) 0 1 2 3 4 5

Touch
Analog cartridge

Port 1 Port 2

Channel – – CH0 CH1 CH0 CH1

Analog input AI0 AI1 AI2 AI3 – –

Analog output AQ0 AQ1 – – AQ4 AQ5

Touch
Analog cartridge

Port 1 Port 2

Channel – – CH0 CH1 CH0 CH1

Analog input AI0 AI1 – – AI4 AI5

Analog output AQ0 AQ1 – – – –
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● Operation Setup Parameters
The analog cartridge settings are configured for each channel.
The setup parameters include the operation mode, filter, data type, minimum and maximum values, data, and status.

Operation mode

The operation mode that can be selected varies based on the analog cartridge model. Select the analog cartridge that 
corresponds to the user application and set the operation mode.
For details on the operation modes, refer to “Analog Cartridge Specifications” on page 3-88.

Filter

The analog input of analog cartridge reaches approximately 99% of analog input in the specified filter time by 
filtering. You can decrease rapid fluctuations in the analog input by setting the filter time, but increasing the filter 
time makes tracking for fluctuations in the analog input slower.

Description

0 20 40 60

Elapsed time (ms)

Analog cartridge (FC6A-PJ2A) input filter example
Filter time: 100 (ms)
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Reaches approximately 99% of the analog 
input in the specified filter time (100 ms).

Filter time (ms) Description

0 No filtering

50 to 50000
Set the analog input filter time in 50 ms increments.
Approximately 99% of the analog input is reached in the specified filter time by filtering.
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Data type

The analog value can be handled in the range of the specified data type (minimum to maximum values). The data 
types are as follows.

Analog Value Linear Conversion Minimum and Maximum
When Data Type is set to Optional range, these values set the minimum and maximum values when performing a 
linear conversion of the analog value. The minimum and maximum values can be set to any value in the range of -
32,768 to 32,767. However, the minimum value must be set to a value smaller than the maximum value.

Analog Input Value Linear Conversion Range When Set to Celsius or Fahrenheit
When data type is set to Celsius or Fahrenheit, the analog input value is linearly converted in the range in the 
following table.

Storage Location for the Analog Value and Analog Status

The special data registers that store the analog value and analog status for the analog inputs or analog outputs 
expanded by using an analog cartridge are allocated as follows. These values are updated with each scan.

Data Type Description

Binary data Analog values can be handled in the range of 0 to 4,095.

Optional range
Analog values can be handled in the range of minimum to maximum values. The minimum and 
maximum values can be set in the range of -32,768 to 32,767. For the minimum and maximum 
values, refer to the analog value linear conversion minimum and maximum.

Celsius Analog values can be handled in the linear conversion range of the temperature sensor set in the 
data type.
For details, refer to the analog input value linear conversion range when set to Celsius or 
Fahrenheit.

Fahrenheit

Operation mode
Celsius Fahrenheit

Temperature 
(°C)

Analog input 
value

Temperature 
(°F)

Analog input 
value

Thermocouple

Type K -200 to 1,300 -2000 to 13,000 -328 to 2,372 -3280 to 23,720

Type J -200 to 1,000 -2000 to 10,000 -328 to 1,832 -3280 to 18,320

Type R 0 to 1,760 0 to 17,600 32 to 3,200 320 to 32,000

Type S 0 to 1,760 0 to 17,600 32 to 3,200 320 to 32,000

Type B 0 to 1,820 0 to 18,200 32 to 3,308 320 to 33,080

Type E -200 to 800 -2000 to 8,000 -328 to 1,472 -3280 to 14,720

Type T -200 to 400 -2000 to 4,000 -328 to 752 -3280 to 7,520

Type N -200 to 1,300 -2000 to 13,000 -328 to 2,372 -3280 to 23,720

Type C 0 to 2,315 0 to 23,150 32 to 4,199 320 to 41,990

Resistance 
thermometer 
(RTD)

Pt100 -200 to 850 -2000 to 8,500 -328 to 1,562 -3280 to 15,620

Pt1000 -200 to 600 -2000 to 6,000 -328 to 1,112 -3280 to 11,120

Ni100 -60 to 180 -600 to 1,800 -76 to 356 -760 to 3,560

Ni1000 -60 to 180 -600 to 1,800 -76 to 356 -760 to 3,560

Analog input terminal/analog output terminal AI2/AQ2 AI3/AQ3 AI4/AQ4 AI5/AQ5

Analog value D8176 D8177 D8186 D8187

Analog status D8178 D8179 D8188 D8189

• The value of special data registers for channels that are not used is undefined.
• If the filter is enabled on an analog input, the value after being filtered is stored in the special data 

register.
• The analog value and analog status are updated in the scan end processing. The special data register 

values are updated regardless of whether the Touch is stopped or running.
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Analog status

The operational status of the analog input or analog output is indicated for each channel. If the status is 0, this means 
the value is normal as an analog value.

■ Analog input

*1 The analog cartridge version number is printed on the side of the analog cartridge. For details, see “Checking the Version 
Number” on page 3-89.

Status Description
Analog input 

value

0 Operating normally
Current analog 
input value

1
Converting data (occurs fro approximately 500 ms after the power is turned on and after the 
user program is downloaded.)

Undefined value

2 Initializing 0

3 to 4 Reserved –

5

Wiring error (out of the maximum ranger)

Maximum value
Signal type

Voltage DC 0 to 10 V
For V100*1: 10.0 V or higher

For V201*1 and later: 10.2 V or 
higher

current

DC 4 to 20 mA
For V100*1: 20.0 mA or higher

For V201*1 and later: 20.32 mA or 
higher

DC 0 to 20 mA
For V100*1: 20.0 mA or higher

For V201*1 and later: 20.4 mA or 
higher

Thermocouple/
Resistance 
thermometer (RTD)

The input maximum value or greater. The maximum value 
varies by the signal type. For details, refer to “Analog Input 
Value Linear Conversion Range When Set to Celsius or 
Fahrenheit” on page 3-92.

6

Wiring error (out of the maximum ranger, open current loop)

Minimum value
Signal type

Voltage DC 0 to 10 V
For V100*1: 0 V or lower

For V201*1 and later: -0.2 V or 
lower

current

DC 4 to 20 mA
For V100*1: 4.0 mA or lower

For V201*1 and later: 3.68 mA or 
lower

DC 0 to 20 mA
For V100*1: 0 mA or lower

For V201*1 and later: 0 mA or 
lower

Thermocouple/
Resistance 
thermometer (RTD)

The input minimum value or smaller. The minimum value 
varies by the signal type. For details, refer to “Analog Input 
Value Linear Conversion Range When Set to Celsius or 
Fahrenheit” on page 3-92.

7 Reserved –

8 The setting in the ladder program/ FBD program differs from the attached analog cartridge Undefined value

9 The analog cartridge has not been attached Undefined value

10 The analog cartridge has been attached, but it is set to unused for the Type Undefined value

11 Analog cartridge unsupported model (FT1A-*12RA-*) has been selected Undefined value

12 to 
65535

Reserved –
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■ Analog output

Status Description Analog output signal

0 Operating normally Current analog output value

1 Reserved –

2 Initializing 0 V / 4 mA

3 Parameter setting error
Analog output value immediately 
before the error occurred

4 to 7 Reserved –

8
The setting in the ladder program or FBD program differs from the attached 
analog cartridge

0 V / 4 mA

9 The analog cartridge has not been attached –

10 The analog cartridge has been attached, but it is set to unused for the Type 0 V / 4 mA

11 Analog cartridge unsupported model (FT1A-*12RA-*) has been selected –

12 to 
65535

Reserved –

For input FB and output FB in FBD programs, only analog value input (AI FB) is supported. Analog value 
output is not supported. To output analog values in FBD programs, store the analog output value in the 
relevant special data register (D8044, D8045, D8176, D8177, D8186, D8187) using a script.
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● Procedure
To use analog cartridges, you must configure it in the Function Area Settings tab and download the ladder 
program or FBD program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Cartridges.

The Function Area Settings dialog box is displayed.

3 Under Type for the Slot where the analog cartridge is connected, select the type of analog cartridge.

4 Click Configure for the Slot where the analog cartridge is connected.

The Analog Parameters Configuration dialog is displayed. All of the parameters for the analog cartridge can be 
configured in this dialog box. The detailed settings vary based on the type of analog cartridge.

5 Enter the filter preset value.
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6 Under Signal Type, select analog input type for each channel.

7 Under Data Type, select the data type for each channel.

8 If Optional range is selected for Data Type, set the minimum and maximum of analog value for each channel in 
the range of -32,768 to 32,767.

9 Click OK to close the Analog Parameters Configuration dialog box.

10 Click OK.

This concludes configuring the settings.
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4.16 Ladder Monitor

This section describes the function to monitor the ladder program on the LCD of the Touch.
The program monitor on the Touch is only enabled when ladder program is selected as the programming language.

● Feature Description
Two lines of the ladder program stored in the ROM can be displayed on the LCD. You can show the ladder program at 
the specified line number by specifying it using the operation buttons. The Touch saves the monitored ladder line when 
ladder program monitoring is finished, and you can resume to monitor the ladder program from the same ladder line.
You can display the details of instruction parameters or switch the on/off state of contacts using the operation buttons.
The ladder program can be monitored regardless of the Run/Stop status of the Touch.

In order to monitor the ladder program on the LCD of the Touch, you need to configure settings using WindLDR.
There are two restrictions in creating the ladder programs that can be displayed on the LCD. Create ladder programs 
considering those restrictions.
• A maximum of four ladder lines can be programmed in each ladder circuit.
• A maximum of eleven instructions can be programmed in each ladder line.

● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click LCD Settings.

The Function Area Settings dialog box is displayed.

3 Select the Enable ladder program monitoring on FT1A check box.

4 Click the OK button.

This concludes configuring the settings.

• The default value of the previously monitored ladder line number is one.
• The previously monitored ladder line number is lost at the following conditions:

- Touch is powered up.
- A project is downloaded to the Touch.
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4.17 Watchdog Timer Setting

This section describes watchdog timer setting with monitoring the operation state of the Touch.

● Feature Description
A watchdog error occurs when the processing time for one scan exceeds the allowed time while the ladder program 
or FBD program is running.
If a watchdog error occurs, the system is reset with the purpose of returning the system to normal operation.
If the watchdog error occurs frequently, you can assume that there is a hardware problem and that the Touch 
requires replacement.
Some of the reasons why a watchdog timer will occur are problems with the Touch hardware and the length of the 
processing time in the ladder program. If the processing time for one scan of the ladder program exceeds the time 
configured for the watchdog timer on the ladder program, place a NOP (no operation) instruction in the ladder 
program. The watchdog timer is reset when the NOP instruction is executed.
For FBD program, the watchdog timer cannot be reset in the program.

Watchdog timer setting time

The watchdog timer setting time can be changed in the function area settings. Decide on the watchdog timer setting 
time in either of the following two ways.
• Decide by user system specification

Determine the maximum on time (milliseconds) so the output signals do not stay on if the Touch loses control and 
set that value as the watchdog timer setting time. However, if the ladder program processing time takes longer 
than the design specification, use an NOP (no operation) instruction in the ladder program. For example, when the 
watchdog timer is set to 100 milliseconds and the maximum value for one scan is 120 milliseconds on the ladder 
program, insert an NOP instruction in the ladder logic program to ensure that the error does not occur.

• Match the ladder program processing time
Check the maximum value for one scan (D8024) and set the watchdog timer value as a value with a safety margin 
added to the maximum value.

Select the watch dog timer setting between 100 milliseconds and 5,000 milliseconds. The default time is 400 
milliseconds.

When changing the watchdog timer setting value, select an appropriate value that fully takes into 
consideration the safety of the system.
The ladder program or FBD program execution time can be checked with the value of LSD38.
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● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Self Diagnostic.

The Function Area Settings dialog box is displayed.

3 Select the preset value for watchdog timer.

4 Click OK.

This concludes configuring the settings.
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4.18 Daylight Savings Time

This section describes the function that automatically adjusts the Touch real time clock according to the daylight 
savings time settings.

● Feature Description
For regions where the Touch is used that implement daylight savings time, this function can automatically adjust the 
Touch clock using the daylight savings time settings. When the time becomes the daylight savings time start time, the 
clock is set an hour forward. When the time becomes the the daylight savings time end time, the clock is set an hour 
back.
The Touch adjusts the clock for daylight savings time on the start day and the end day. However, the clock is also 
adjusted for daylight savings time under the following conditions.
• When a ladder program or FBD program was downloaded to the Touch.
• When the Touch power is turned on.
When the current time of the Touch internal clock is set using System Area or special data registers, the time is not 
adjusted for daylight savings time, even if the time after it was set is within the daylight savings time period. Set the 
clock to the time adjusted for daylight savings time. The set date and time becomes the date and time after being 
adjusted for daylight savings time.

● Procedure
Configure daylight savings time on the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).
WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Calendar & Clock.
The Function Area Settings dialog box is displayed.

3 Select the Enable Daylight Saving Time check box.

4 Configure the start time and the end time. Specify the region using the Region list box.
If you select Custom, you are able to select any desired start time and end time.

5 Click OK.
This concludes configuring the settings.

Region Start time End time

Custom User specified User specified

USA or Canada March, 2nd Sunday, 2:00 AM November, 1st Sunday, 2:00 AM

Europe March, last Sunday, 1:00 AM October, last Sunday, 1:00 AM

Australia October, 1st Sunday, 2:00 AM April, 1st Sunday, 3:00 AM
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4.19 Clock Function

This section describes the internal clock function on the Touch.

● Feature Description
This function enable you to control time based applications such as  lighting or air conditioning equipment using the 
current time data stored in special data registers. The internal clock data is backed up by a secondary lithium battery. 
The current time is reset when the backup data is lost, so the current time will need to be set again.

● Adjusting the Date and Time with WindLDR
Set the current time on the Touch with WindLDR.

Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Monitor tab, click Monitor.

WindLDR enters monitor mode.

3 On the Online tab, in the PLC group, click Status.

The PLC Status dialog box is displayed.

4 Click Change for Calendar.

The Set Calendar and Time dialog box is displayed. The current time on the computer is displayed in the dialog box as 
the initial value. The settings can also be changed as necessary.

5 Click OK.

The date and time configured in the dialog box is written to the Touch.

Function Description

Read clock The current time (calendar, clock) is updated every 500 milliseconds and automatically 
stored in the special data registers.

Set clock Sets the current time (calendar, clock). Uses the System Area or special data registers.

Adjust function

When clock data adjust flag M8021 is turned on from off, the seconds for the current time 
are rounded up or rounded down based on 30 seconds to correct the seconds data for the 
internal clock.
If the current seconds are between 0 and 29 seconds, the seconds are set to 0 when M8021 
is turned on from off.
If the current seconds are between 30 and 59 seconds, the minutes are set to + 1 and the 
seconds are set to 0 when M8021 is turned on from off.

Calendar/clock error
M8013: This relay turns on if clock write processing or a clock adjust processing could 

not be executed normally.

M8014: This relay turns on if an error occurs while calendar/clock data is read from 
the internal clock to the special data registers (D8008 to D8014).
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● Adjusting the Date and Time with Ladder Program or FBD Program
The current time can be set on the Touch by using special data registers D8015 to D8021. Undefined values are 
stored in special data registers D8015 to D8021. Always store an appropriate value before turning on M8016, M8017, 
or M8020. 

■ Calendar Data Write Flag (M8016)
After writing data to special data registers D8015 to D8018, turn M8016 on to set the internal clock with the data in 
D8015 to D8018 as the calendar data (year, month, day, day of the week).

■ Clock Data Write Flag (M8017)
After writing data to special data registers D8019 to D8021, turn M8017 on to set the internal clock with the data in 
D8019 to D8021 as the clock data (hour, minute, second).

■ Calendar/Clock Data Write Flag (M8020)
After writing data to special data registers D8015 to D8021, turn M8020 on to set the internal clock with the data in 
D8015 to D8021 as the calendar data (year, month, day, day of the week) and the clock data (hour, minute, second).

Calendar and clock data storage locations

The calendar/clock data is stored in the following special data registers.

For the day of the week data, the values below are stored in the special data registers.

Special data 
register

Description Range Setting timing

D8008

Calendar/Clock
Current Data
(Read only)

Year 0 to 99

Every 500 msec 
If the scan time is 500 msec 
or longer, D8008 to D8014 are 
updated with each scan.

D8009 Month 1 to 12

D8010 Day 1 to 31

D8011 Day of the week 0 to 6

D8012 Hour 0 to 23

D8013 Minute 0 to 59

D8014 Second 0 to 59

D8015

Calendar/Clock
New Data

(Write only)

Year 0 to 99

–

D8016 Month 1 to 12

D8017 Day 1 to 31

D8018 Day of the week 0 to 6

D8019 Hour 0 to 23

D8020 Minute 0 to 59

D8021 Second 0 to 59

Day of the 
week

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

Value 0 1 2 3 4 5 6
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● Example ladder program 1
This example sets the calendar and clock in a ladder program.
If you turn on M8020 with the new calendar/clock data set in the write-only data registers D8015 to D8021, the 
internal clock on the Touch is updated with the current time (calendar, clock). In this example, the Touch internal 
clock is set to 9:35:00 on Tuesday February 21, 2012.

● Example ladder program 2
When I1 turns on, the seconds on the internal clock are corrected to 0 seconds.

When input I1 turns on, clock data adjust flag M8021 turns on to correct the seconds on the internal clock.

M8120 is the initialize pulse that turns on for only one scan 
at the start of operation.
When the Touch starts operating, the new calendar/clock 
data is stored in D0000 to D0006 with the MOV (move) 
instruction.

When external input I0000 turns on, the new calendar data 
is stored in special data registers D8015 to D8018.
Internal relay M0000 turns on for one scan only.

When external input I1 turns on, the new clock data is 
stored in special data registers D8019 to D8021.
Internal relay M0001 turns on for one scan only.

When external input M0000 or M0001 turns on, M8020 
turns on and the calendar/clock data is written to the 
internal clock.
(M8020: Calendar/Clock Data Write Flag)

M8125 is a special internal relay that is always on during 
operation.
While the Touch is running, the current time (calendar, 
clock) is stored in D0010 to D0016 with the MOV 
instruction.

M8120

REP
4

S1 R
D0000

MOV(W) D1 R
D8015I0000

SOTU

REP
3

S1 R
D0004

MOV(W) D1 R
D8019I0001

SOTU

M0000

M0001

REP
7

S1 R
D8008

MOV(W) D1 R
D0010M8125

M0001

M8020

REPS1 –
12

MOV(W) D1 –
D0000

M0000

REPS1 –
2

MOV(W) D1 –
D0001

REPS1 –
21

MOV(W) D1 –
D0002

REPS1 –
2

MOV(W) D1 –
D0003

REPS1 –
9

MOV(W) D1 –
D0004

REPS1 –
35

MOV(W) D1 –
D0005

REPS1 –
0

MOV(W) D1 –
D0006

I1
SOTU

M8021

The internal clock backup time is approximately 30 days (25°C TYP). If the power loss time exceeds the 
backup time, the retained clock data is lost and the current time is initialized as 00:00:00 on January 1, 
2000.
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4.20 Connection Settings

This section describes the configurations of client/server communication for TCP/IP communication related to the 
SmartAXIS control function.

● Feature Description
The SmartAXIS control function is capable of performing remote I/O communication over the Ethernet port using a 
maximum of three connections.
The connection settings required for performing communication are configured in the Function Area Settings dialog 
box.
The remote I/O master can be configured for a maximum of three connections as the communication mode used with 
each connection.
For details on the remote I/O function, refer to Chapter 12 “4 Remote I/O” on page 12-46.

● Connection Status Information and Connected IP Address
The connection status with an external device can be confirmed with special internal relays M8110 to M8112. The 
When a connection is established with the server, the corresponding special internal relay is turned on. When the 
connection is disconnected, the corresponding special internal relay is turned off. The IP addresses of the devices can 
be confirmed with special data registers D8110 to D8121.

■ Status Information

■ Connected IP Addresses

Special internal 
relay

Description Read/write

M8110 Connection 1 Status While a connection is established with the server 
or client device, the special internal relay will be 
on. When no connection is established, it will be 
off.

RM8111 Connection 2 Status

M8112 Connection 3 Status

Special data 
register

Description Read/write

D8110 to D8113
Connection 1
Connected IP Address The IP address is stored in the corresponding 

special data registers as follows.
Example: IP Address: aaa.bbb.ccc.ddd,
D8110=aaa, D8111=bbb, D8112=ccc, D8113=ddd

RD8114 to D8117
Connection 2
Connected IP Address

D8118 to D8121
Connection 3
Connected IP Address
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● Procedure
To perform remote I/O communication using a connection, you must configure the Function Area Settings tab and 
download the ladder program or FBD program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Connection Settings.

The Function Area Settings dialog box is displayed.

3 Select Communication Mode for the connection to use.

The settings dialog box for the set communication mode is displayed.
As an example here, Communication Mode is set to Remote I/O Master.
Configure the communication mode allocated to a maximum of three connections.
Set connections that are not used to Unused.

4 Specify the parameters.

5 Click OK.

This concludes configuring the settings.
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4.21 Remote Host List

This section describes the remote host list to register and manage the external devices (remote hosts) to 
communicate with on the network.

● Feature Description
When using the following Ethernet communication functions on the Touch, you must register the connections to 
communicate with as remote hosts.
• Remote I/O master
When a remote host is registered, a remote host number is automatically allocated to it.
When using the function listed above, specify the remote host number as the device to communicate with.

● Procedure

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function).

WindLDR starts.

2 On the WindLDR Project window, double-click Remote Host List.

The Remote Host List dialog box is displayed.

3 Click New.

The Remote Host dialog box is displayed.

If the Project window is not displayed, on the View tab, in the Workspace group, click Project Window 
to display the Project window on the left side of the screen.
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4 Enter the items on the Remote Host dialog.

The Remote Host dialog box is displayed.

The remote host is composed of two elements, IP Address and Port.

5 Click Add.

The remote host is registered and reflected in the remote host list.

To register another remote host, repeat the procedure in steps 4 and 5.

6 When you have finished registering all of the remote hosts, click Close.

7 Click  (Close).

The Remote Host List dialog box closes.

This concludes configuring the settings.

IP Address: Specify the remote host with an IP address. The Touch performs communication by establishing a 
connection to the specified IP address and port number.

Port: Specify the port number used in TCP/IP communication.

Comment: The comment for the remote host can be assigned. The contents or the length of the comment has 
no effect on communication.

To delete a registered remote host, select the remote host to delete in the Remote Host List dialog box, 
and click Delete.
Once a remote host is deleted, the remote host numbers of the following remote hosts are changed.
This will affect the operation of remote I/O masters that refer to these remote host numbers.
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5.1 Download Restrictions

■ Project Data Size
The size of the project data that can be downloaded to the Touch is approx. 5 MB max (including additional fonts).

■ Number of Parts
The number of parts that can be downloaded to the Touch are as follows.

5.2 Maximum Number of External Devices

■ Project
The maximum number of external devices used in global script trigger conditions, user communication trigger 
conditions, and global scripts that can be used in a single set of project data is 100 devices.

■ Data Log Settings
A maximum of 128 external devices can be used in the Data Log settings.

■ Scripts
The restrictions on the number of external devices that can be used in a single script are as follows.

5 Project Restrictions

• To check the project data size, on the Home tab, in the Project group, click Target Info. The Target 
Information dialog box is displayed. The project data size can be checked with Memory Space (byte) 
under Target Runtime Information.

• The project data size varies based on the fonts downloaded to the Touch. For details, refer to Chapter 2 
“Font Size” on page 2-8.

Parts Number of parts

Total number of Bit Buttons, Word Buttons, Goto Screen Buttons, Multi Buttons, Key Buttons 32,000 max.

Selector switches 200 max.

If the same device address is used in multiple device settings, the number of used devices is counted as 
one. It is not counted as one device per device setting.

Even if the same device address is used in multiple device settings, the number of used devices is counted 
as one device for each device setting.

Item Number of devices

Destination external devices 64 max.

Source external devices 64 max.

If the same device address is used in multiple device settings, the number of used devices is counted as 
one. It is not counted as one device per device setting.
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This chapter provides an overview of the Touch screen and describes how to setup and operate the screen.

  

1.1 Screen Types

The types of screens can be created with the WindO/I-NV3 are given below.

1.2 Screen Size

The size of the Base Screen is equal the size of the Touch screen. The Base Screen size is 240 x 100 dots.

*1 The Keypad that is displayed when operating Numerical and Character Input parts when Standard is selected under Type 
in the Keypad menu for Numerical and Character Input parts.

Chapter 4 Screen

1 Screen Overview

Screen Type Screen No. Description

Screens that can 
be created with 
WindO/I-NV3

Base Screen 1 to 3,000
The screen that is displayed when the Touch is in Run Mode. Drawing 
objects and functional parts can be created mainly on this screen which 
is displayed on the Touch.

Popup Screen 1 to 3,015

The Popup Screen that is displayed on the Base Screen when the 
Touch is in Run Mode. The size and coordinates of the screen can be 
specified and this screen can also be moved on the Base Screen.

A Popup Screen for the standard Keypad*1 will automatically be created 
in screen numbers 3,001 to 3,015.

Library Screen –

The screen that registers often used drawing objects and parts to the 
set WindO/I-NV3. References the registered screen while the project is 
being edited and can copy and appropriate drawing objects and parts 
from the screen.
This screen is not included in project data.

Screen 
provided by the 
Touch

Maintenance 
Screen

–

Using the screen that is displayed when the Touch is in Run Mode, you 
can switch from Run Mode to System Mode and load a screen to adjust 
Device Monitor and screen brightness.
For details, refer to Chapter 28 “1 Maintenance Screen” on page 28-1.
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2.1 Creating Screens

This section describes how to create Base Screens and Popup Screens.

● Creating a screen

1 On the Home tab, in the Screens group, click the arrow under New.

2 Click Base Screen or Popup Screen.

The Screen Properties dialog box is displayed.

3 Change the settings on each tab as necessary, and then click OK.

2.2 Opening Screens

● Opening a screen
You can open a single screen that has already been created.

Double click the screen to open in the Project window.

2 Creating and Manipulating WindO/I-NV3 Screens

To edit the properties for a Base Screen or Popup Screen that has already been created, double click an area 
in the editing window with no objects.

If you right click a screen in the Project window and then click Open Screens, the Open Screens dialog box 
is displayed.
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● Opening specific screens
You can open multiple screens as a group.

1 On the Home tab, in the Screens group, click the arrow to the right of Open.

2 Click the Base Screen or the Popup Screen.

The Open Screens dialog box is displayed.

3 Click the screens to open in Screen List, and then click OK.

■ Screen Type
Select the type of screen to open from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

● Opening the previous or next screen
You can open the screen with the previous screen number or the next screen number of the screen displayed in the 
active editing window.

To open the screen with the previous screen number, click  (Open Previous Screen) in the Screens group on the 

Home tab. To open the screen with the next screen number, click  (Open Next Screen).

If you right click a screen folder in the Project window and then click Open Screens, the Open Screens 
dialog box is displayed.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.3 Saving Screens

● Saving a screen
You can save a single screen.
Right click the screen to save in the Project window, and then click Save Screens.

● Saving only specific screens
You can save multiple screens as a group.

1 Right click a screen folder in the Project window, and then click Save Screens.

The Save Screens dialog box is displayed.

2 Click the screens to save in Screen List, and then click OK.

■ Screen Type
Select the type of screen to save from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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■ Screen List
This list shows the screens being edited.

■ Select All
Selects all the screens displayed in Screen List.

● Saving a screen with a different screen number
You can save the screen being edited with a different screen number.

1 Right click a screen in the Project window, and then click Save Screen As.

The Save Screen As dialog box is displayed.

2 Specify the screen number after saving, and then click OK.

■ New No.
Specify the screen number (Base Screen: 1 to 3000, Popup Screen: 1 to 3015) after saving.

■ Screen Title
Enter or change the screen title. The maximum number is 40 characters.

■ Screen List
This list shows screens that have already been created.

If you specify an existing screen number and then click OK, an overwrite confirmation message is displayed.
• Click Yes to overwrite the screen.
• Click No to stop saving the screen.
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2.4 Closing Screens

● Closing the displayed screen
You can close the active editing window.

Click  in the upper-right of the editing window.

● Closing all screens
You can close all the editing windows.

On the View tab, in the Window group, click Close All.
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● Closing a specific screen
You can close multiple editing windows as a group.

1 Right click a screen folder in the Project window, and then click Close Screens.

The Close Screens dialog box is displayed.

2 Click the screens to close in Screen List, and then click OK.

■ Screen Type
Select the type of screen to close from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows the screens being edited.

■ Select All
Selects all the screens displayed in Screen List.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.

If you specify an unsaved screen and then click OK, a save confirmation message is displayed.
• Click Yes to save the screen and close it.
• Click No to close the screen without saving the changes.
• Click Cancel to stop saving the screen.
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2.5 Duplicating Screens

You can copy a screen that has already been created to create a new screen.

1 Right click a screen folder or screen in the Project window, and then click Duplicate Screens.

The Duplicate Screens dialog box is displayed.

2 Select the screens to copy in Screen List.

3 Specify Screen No. for the new screen and the Number of copies to duplicate, and then click OK.

■ Screen Type
Select the type of screen to duplicate from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

■ Screen No.
Specify the screen number (Base Screen: 1 to 3000, Popup Screen: 1 to 3015) for the new screen.

■ Number of copies
Specify the number of screens to copy (Base Screen: 1 to 2999, Popup Screen: 1 to 3014).

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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• If multiple screens are selected in Screen List or if the Number of copies is 2 or more, consecutive 
screen numbers are added to the screens starting with the number specified in Screen No..
Example: When a screen with screen number of 1 is selected in Screen List, the Number of copies is 

3, and Screen No. is 100 is selected, then the screen numbers after duplication are “100”, 
“101”, “102”.

Example: When screens with screen numbers 3 and 5 are selected in Screen List, the Number of 
copies is 2, and Screen No. is 100 is selected, then the screen numbers after duplication are 
“100” and “102” for the screens duplicated from screen number 3 and “101” and “103” for the 
screens duplicated from screen number 5.

• If a screen number already exists after copying and you click OK on the Duplicate Screens dialog box, an 
overwrite confirmation message is displayed.
- Click Yes to overwrite the screen with the number displayed in the confirmation message.
- Click Yes To All to overwrite all the screens.
- Click No to display the next confirmation message without copying the screen with the number 

displayed in the confirmation message.
- Click Cancel to stop copying screens.

Screen List’s numbers: 1
Screen No.: 100
Number of copies: 3

Screen No.: 1 Screen No.: 100

Screen No.: 101

Screen No.: 102

Copy99 99

99

99

Screen List’s numbers: 3,  5
Screen No.: 100
Number of copies: 2

Screen No.: 3

Screen No.: 5

Screen No.: 100

Screen No.: 101

Screen No.: 102

Copy

Screen No.: 103

Copy

99

99

99

Full Full

Full
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2.6 Deleting Screens

● Deleting a screen
You can delete a single screen.

1 Right click the screen to delete in the Project window, and then click Delete Screens.

A delete confirmation message is displayed.

2 Click Yes.

The screen is deleted.
Click No or Cancel to stop deleting the screen.

● Deleting specific screens
You can delete multiple screens as a group.

1 On the Home tab, in the Screens group, click Delete.

The Delete Screens dialog box is displayed.

If you right click a screen folder in the Project window and then click Delete Screens, the Delete Screens 
dialog box is displayed.
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2 Click the screens to delete in Screen List, and then click OK.

A delete confirmation message is displayed.

■ Screen Type
Select the type of screen to delete from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens that have already been created.

■ Select All 
Selects all the screens displayed in Screen List.

3 Click Yes or Yes To All.

• Click Yes to delete the screen with the number displayed in the confirmation message. When deleting multiple 
screens, the next message to confirm deleting a screen is displayed.

• Click Yes To All to delete all the screens without displaying the confirmation message.
• Click No to display the next message to confirm deleting a screen without deleting the screen with the number 

displayed in the confirmation message. 
• Click Cancel to stop deleting screens.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items.
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2.7 Reusing Screens

You can copy screens from other project data.

1 On the Home tab, in the Screens group, click Reuse.

2 Select project data that includes the screens to copy, and then click OK.

The Open Screens dialog box is displayed.

3 Click the screens to copy in Screen List, and then click OK.

■ Screen Type
Select the type of screen to copy from the following items. The selected screen type is displayed in Screen List.
All, Base Screen, Popup Screen

■ Screen List
This list shows screens included in the source project data.

If you right click a screen folder or screen in the Project window and then click Reuse Screens, the Open 
dialog box is displayed.

If a password has been configured for the project data, the Password Screen will be displayed. Select user 
name and enter password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

To select multiple screens, press and hold SHIFT or CTRL while you click the specific items. 
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If the screen number of the screen to copy, a picture included in the screen, a text ID, or a script ID already 
exists in the project data being edited, an overwrite message is displayed.
• Click Yes to overwrite the item displayed in the confirmation message. If there are multiple redundant 

items, a confirmation message is displayed for each of those items.
• Click Yes To All to overwrite all of the picture numbers, pictures, text IDs, and script IDs.
• Click No to display a dialog box for each setting. Change the item to a unique screen number or ID 

number, and then click OK.
• Click Cancel to stop overwriting the displayed in the confirmation message. If there are multiple 

redundant items, a confirmation message is displayed for each of those items.
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The screen that is displayed when the Touch is in Run Mode. This screen places drawing objects and parts on the base 
and creates a screen that is displayed on the Touch.

3.1 Base Screen Settings

● General Tab

■ Screen Type
Select Base Screen as the screen type.
You can only select the screen type when creating a new screen.

■ No.
Enter the Base Screen’s screen number (1 to 3000).

■ Title
Enter the Base Screen’s title. The maximum number is 40 characters.

■ Size
Shows the screen size. You cannot change the size of Base Screens.

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

3 Base Screen
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● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 8 shades). Click this button to open the color 
palette. Select color with the color palette.

■ Backlight color*1

Select the backlight color for the screen from the following options.
“White”, “Red”, “Pink”

■ Overlay with Base Screen
Configure this section to display the Base Screen by overlaying screens.

*1 Monochrome LCD models only

When Overlay with Base Screen is configured, the background color for the Base Screen specified as the 
background is displayed.

1 to 5: Select these to display the Base Screen by overlaying screens.

No.: Enter the overlay screen’s screen number (1 to 3000).

Coordinates X, Y: Specify the display location of the overlay screen in coordinates. The coordinates can be set in 
the range (Screen size - 1 dot).
The origin is the upper-left corner of the screen and the X- and Y-coordinates correspond to the 
upper-left corner of the overlay window.

(0, 0)
X

Y
Base Screen

Overlay screen



3 Base Screen

4-16 SmartAXIS Touch User’s Manual

■ Display the Order of Overlapping Screens
You can select the display order of the Base Screen and the overlay screens.

Example:To display the Base Screen being edited as the background

Example: To display the Base Screen being edited above overlay screen: 3

■ Blink
Select one of the following items as the setting when the screen is blinking.

■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

Base Screen being edited

Overlay screen
(5 screens max)

Base Screen being edited

Overlay screen: 3

None: Displays the screen.

Blink (1 sec cycle): The screen display is blinked in one second intervals.

Blink (0.5 sec cycle): The screen display is blinked in half second intervals.

Backlight OFF: Turns off the backlight until the screen is touched or until System Area 1 (address+1, bit 0 or 
bit 7) is set to 1.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the 
order to move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not aligned 
to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal
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■ Security Group
Select the security group to restrict the screen display.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the User Accounts dialog box.

Click  to display the Security Group Settings dialog box. If you create a security group in the Security Group Settings 
dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding and Editing Security Groups” 
on page 21-15.

None: Any user can open this screen.

Administrator, Operator, 
Reader, (Created security group): Only a selected user can open this screen.

For details about the security function, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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3.2 Displaying Layered Base Screens

It is possible to layer and display multiple Base Screens. The coordinates and display order for layered screens can be 
set on the screen that will serve as the base. The maximum number of layered screens is five screens.

■ Coordinates
Using the upper-left corner of the screen as the origin, the upper-left area of the layered screen become the X and Y 
coordinates.

■ Display Order
This allows you to select the order of display for the screen that will serve as the base and layered screens.

Example:Displaying a Base Screen that is currently being edited as the bottom most layer

Example: Displaying a Base Screen currently being edited on the layered screen: 3.

For details about how to configure these settings, refer to “3.1 Base Screen Settings” on page 4-14.
Example: When Base Screen: 100 which has a clock placed in it is used as a layered screen, Base Screen:1 which is 

displayed as the base and Base Screen: 2 will be displayed as follows:

(0, 0)
X

Y
Base Screen

Overlay screen

Base Screen being edited

Overlay screen
(5 screens max)

Base Screen being edited

Overlay screen: 3

130

100

120

110

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:0011/Feb./22 Tue. 12:00

130

100

120

110

Base Screen: 1 Base Screen: 100 Base Screen: 2

Display for Base Screen: 1 Display for Base Screen: 2

Layering Layering

Displayed as 
the base

Displayed as 
the base

Layered Screen
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• Layered screens that have been set as layered screens will not be displayed on the screen that is 
displayed as the base.
Example: Layering and displaying Base Screen: 100 on Base Screen: 1

Layering and displaying Base Screen: 101 on Base Screen: 100

• Drawing objects and parts from layered screens may not display properly when placed outside of the 
displayed area.

130

100

120

11/Feb./22 Tue. 12:00

11/Feb./22 Tue. 12:00

130

100

120

Base Screen: 1 Base Screen: 100

Base Screen: 101

Display for Base Screen: 1

Display for Base Screen: 100

Layering

Layering

0

11/Feb./22 Tue. 12:00

130

100

120

0
11/Feb./22 Tue. 12:00

0

Displayed as 
the base

Layered Screen
Layered Screen

Layered Screen (Base Screen: 
101) is displayed.

Layered Screen (Base 
Screen: 101) is not 
displayed.

Outside of the display area

Layered Screen

Displayed as the base
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3.3 Operating When Drawing Objects and Parts Overlap

Place drawing objects and parts or parts with other parts so that they do not overlap.
When drawing objects and parts are placed or the screens are layered, if the drawing objects and parts have 
overlapped, the following behaviors will occur.

● When Drawing Objects and Parts Overlap
The parts will always be displayed on the foremost layer.

Example: A case where Base Screen: 2 is layered with base: 1 as the bottom most layer, and the Numerical Display 
belonging to Base Screen: 1 and a drawing object belonging to Base Screen: 2 overlap.

● When Parts Overlap
The following behaviors will occur when data or updated parts are displayed in front.

Example: Base Screen: 2 is layered with base: 1 as the bottom most layer, and the Numerical Display belonging to Base 
Screen: 1 and Numerical Display belonging to Base Screen: 2 overlap.

1234

1234

Base Screen: 1 Base Screen: 2

Display for Base Screen: 1

Layering

The Numerical Display for Base Screen: 1 is displayed in front

5671234

1234

5679999

567

Base Screen: 1 Base Screen: 2

Display for Base Screen: 1

Layering

The Numerical Display for Base Screen: 1 and 2 is unchanged

The Numerical Display for Base Screen: 1 is changed
The Numerical Display for Base Screen: 2 is unchanged

The numerical 
value changes

The Numerical Display for Base Screen: 1 is displayed in front

The Numerical Display for Base Screen: 2 is displayed in front

12341234
567Base Screen: 2

Base Screen: 1

For the Message Display, Message Switching Display, and Alarm List Display, when the Scroll check box is 
selected on the Format tab, the display is not correctly displayed when a part overlaps it.
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● When touch switches have overlapped
Pressing the touch switch activates the touch switch of the bottom most Base Screen and displays it in front.

Example: A case where Base Screen: 2 is layered with base: 1 as the bottom most layer (Touch switch two-point 
push: disabled)

Base Screen: 1 Base Screen: 2

Display for Base Screen: 1

Layering

Press the switch for Base Screen: 2

The switch for Base Screen: 1 activates
The switch for Base Screen: 2 does not activate

The switch for Base Screen: 1 and 2 has not been pressed

The switch for Base Screen: 2 is displayed in front

The switch for Base Screen: 1 is displayed in front

When touch switch two-point push is enabled, the touch switches will be activated and the display will be 
updated in order starting from the switch located one layer above the bottom-most switch. Touch switch two-
point push is selecting the check box labeled Enable Two-point Push under the System tab in the Project 
Settings dialog box.

The touch switch two-point push is a function performed on the analog touch panel that activates both 
switches when two overlapped touch switches have been pressed. There is no function that activates both 
switches simultaneously when two switches have been pressed.
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The Popup Screen that is displayed on the Base Screen when the Touch is in Run Mode. The size and coordinates of the 
screen can be specified and this screen can also be moved on the Base Screen.

4.1 Popup Screen Settings

● General Tab

■ Screen Type
Select Popup Screen for the screen type.
You can only select the screen type when creating a new screen.

■ No.
Enter the Popup Screen’s screen number (1 to 3015).
However, screen numbers 3001 to 3015 are Popup Screens for standard Keypads for Numerical Input and Character 
Input.

■ Font
Select the font to use for the title from the following choices:
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
This option can only be selected when Use Text Manager is cleared.

■ Use Text Manager
Select this to use text registered in Text Manager for the screen title.
However, the text color is white, not the color set in Text Manager.

■ Text ID

Specify the Text Manager ID number (1 to 32000) to use text registered in Text Manager. Click  to display Text 
Manager.
This option can only be set when Use Text Manager is selected.

■ Title
Enter the Popup Screen’s title. The maximum number is 40 characters. This title is displayed in the Popup Screen’s title 
bar.
This option can only be entered when Use Text Manager is cleared.

4 Popup Screen

To enter Unicode text, click  to display the Unicode Input dialog box. Enter the text in the Unicode Input 
dialog box, and then click OK.
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■ Size

■ Screen List
This list shows screens that have already been created. It is only displayed when creating a new screen.

● Options Tab

■ Background Color
Select the screen’s background color (color: 256 colors, monochrome: 8 shades). Click this button to open the color 
palette. Select the color with the color palette.

■ Superimpose
Displays the Popup Screen’s background as completely transparent. The screen underneath the popup screen can be 
seen.

■ Title Bar
Select this to display the title bar on the Popup Screen. The text set in Title on the General tab is displayed in the title 
bar.
The title bar is not displayed if superimpose is set.

■ Close while changing Base Screen
Select this to close the displayed Popup Screen when changing the Base Screen.

Width, Height: Specify the width (40 dots to Base Screen width) and the height (40 dots to Base Screen height) of the 
Popup Screen.

If you select Superimpose, the buttons underneath the Popup Screen set to superimpose are active.

Move Button: Select this to display the  (Move) button on the title bar.

Close Button: Select this to display the  (Close) button on the title bar.
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■ Focus Order
Sets the focus order for Numerical Input and Character Input. The focus order is the order the focus moves between 
Numerical Input or Character Input when the user presses the ENT key. Text can be input in Numerical Input or 
Character Input that has focus. The focus order number starts from 0.

■ Security Group
Select a security group to restrict displaying the screen.
This option can only be set when Use Security functions is selected. The Use Security functions check box is set 
on General tab in the User Accounts dialog box.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security Group Settings 
dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding and Editing Security Groups” 
on page 21-15.

Vertical: The focus moves vertically from top to bottom.

Horizontal: The focus moves horizontally from left to right.

Custom: Sets the desired order for moving the focus.
On the View tab, in the Screens group, click Focus Order, and then click the parts in the order to 
move the focus.

The focus moves in the following order when Numerical Input and Character Input on the screen is not aligned 
to the left or top.

1

4

3

2

1

4

3

21234

5

890

67

1234

5
890

67Vertical

X-axis left to right

Y-axis up to down

Horizontal

None: Any user can open this screen.

Administrator, Operator, 
Reader, (Created security group): Only selected users can open this screen.

For details about the security function, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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4.2 Popup Screen Configuration

■ Title Bar
Displays buttons and the title of the Popup Screen.
Pressing the title bar of the screen allows you to move the screen to the front.

■   (Move)
Moves the Popup Screen.

Close ButtonMove Button

Title Bar

Screen Display Area

Touch Touch Touch

When there is a title bar on the Popup Screen, touch switches that are within 20 dots of the title bar will not 
respond.

1 Press . 2 Press the position where the 
screen will be moved to.

3 The screen will move the position 
that was pressed.

Touch Touch Touch

The location that was touched will 
become the location of     .

• The Popup Screen can be moved in the range where  can be displayed.

• The Popup Screen will be moved in units of 1 dot.
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■  (Close) 

Closes the Popup Screen.

■ Screen Display Area
The area where drawing objects and parts are placed.

4.3 Standard Keypad Popup Screen

A Popup Screen that places a regular Keypad used for Numerical and Character Input on screen numbers 3001 to 3015 
with the WindO/I-NV3.

Decimal (Number Value) Keypad Uppercase (Alphabet) Keypad

• The Standard Keypad Popup Screen can also place drawing objects and parts in the same manner as 
Popup Screen numbers 1 to 3000.

• Screen numbers 3001 to 3015 are screen numbers that are empty when a new project has been created 
and are handled as normal Popup Screens.

• Deleting a Standard Keypad Popup Screen and recreating a new Popup Screen of the same screen 
number will place the same Keypad.
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5.1 Screen Number Restrictions

The number of screens and layered screens that can be created in a single project and the number of Popup Screens 
that can be displayed on the Base Screen are as follows:

■ Base Screen

■ Popup Screen

5.2 Maximum Number of Parts

■ Number of Parts That Can be Placed on a Single Screen

■ Number of Parts That Can be Displayed on a Single Screen
In addition to the currently displayed Base Screen, this includes layered screens and currently displayed Popup Screens.

*1 The maintenance screen is not included.

5 Screen Restrictions

Item Number of screens

Number of screens that can be created 3,000 max.

Number of layered screens 5 max.

Item Number of screens

Number of screens that can be created 3,015 max.

Number of screens that can be displayed on the Base Screen
3 max. (Including the Device Monitor and Ladder 

Monitor*1)

Screen Number of Parts

Base Screen 960 max.

Popup Screen 480 max.

Parts Number of Parts

Alarm List Display, Alarm Log Display Limit to 1.  Either one but can't be both.

Numerical Inputs and Character Inputs in a constant state of 
input

Limit to 1.  Either one but can't be both.

Potentiometer 32 max.

Numerical Input 255 max.

Character Input 255 max.
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5.3 Maximum Number of External Device Address

The number of  write-destination devices for usable external device addresses and the number of read-source devices 
from the external device addresses differ depending on the screen type.

■ Base Screen (Includes Layered Screens)

■ Popup Screen

5.4 Vertical Installation Restrictions

Even if you choose for them to be installed and displayed vertically, the next screen will be the same as horizontal 
installation and display.
• System Mode
• Maintenance Screen

• Brightness/contrast adjustment screen*1, brightness adjustment screen*2

• Password Screen

*1 Monochrome LCD models only
*2 Color LCD models only

External Device Address Number of Devices

Write-destination Device 512 max.

Read-source Devices 256 max.

External Device Address Number of Devices

Write-destination Device 128 max.

Read-source Devices 64 max.

If the same device address is used in multiple device settings, the used number of devices will be counted as 
one device. It will not be counted as one point per device setting.
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6.1 What You Can Do with Library Screens

A Library Screen is a screen where you can register frequently used drawing objects, parts, and operations in 
WindO/I-NV3. These screens can be accessed while editing project data. You can quickly create screens by using Library 
Screens.
To copy Library Screens to other computers and use them as common Library Screens, use the import and export 
functions.

6 Using Library Screens

Project data 1

Project data 2 Project data 3

Creating Library Screens

Copying drawing objects and 
parts on Library Screen

Library 1 Library 2 Library 3
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6.2 Creating a Library Screen

1 On the Home tab, in the Screens group, click ▼ under New.

2 Click the Library Screen.

The Create Library dialog box is displayed.

3 Enter a name in New Library and then click OK.

The Library Screen is displayed.

■ New Library
Enter the name for the Library Screen. Maximum number is 40 characters.

■ Library List
This list displays the registered Library Screens.

4 Configure parts and drawing objects in the Library Screen and create the screen.

You cannot use the following characters in the library name.
. \ / : * ? " < > |
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5 When you are finished creating the Library Screen, click  in the upper right of the screen.

A save confirmation message is displayed.

6 Click Yes.

This saves the Library Screen and then closes it.
Click No to close the Library Screen without saving it.
Click Cancel to return to the editing window without saving the Library Screen.

6.3 Using a Library Screen

Open a registered Library Screen to use for creating a Base Screen or Popup Screen.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Library Screen.

The Open Library dialog box is displayed.

3 Select the Library Screen and then click OK.

■ Library List
This list displays registered Library Screens.

■ Delete
Deletes the Library Screen selected in Library List.

■ Import
Imports an exported Library Screen.

■ Export
Exports the Library Screen selected in Library List.

To select multiple screens,  key + click the specific screens or  key + click the specific screens.Shift Ctrl 
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4 Drag and drop or copy and paste objects to use from the Library Screen to the screen being edited.

Editing Screen Library Screen

Drag and drop

You can re-edit objects placed on the edited screen from the Library Screen.
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6.4 Deleting Library Screens

You can delete multiple Library Screens as a group.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Library Screen.

The Open Library dialog box is displayed.

3 Select the Library Screen to delete in Library List and then click Delete.

A delete confirmation message is displayed.

4 Click Yes or Yes To All.

• Click Yes to delete the Library Screen with the library name displayed in the confirmation message. When deleting 
multiple Library Screens, the next message to confirm deleting a Library Screen is displayed.

• Click Yes to All to delete all the Library Screens without displaying the confirmation message.
• Click No to display the next message to confirm deleting a Library Screen without deleting the Library Screen with 

the library name displayed in the confirmation message. You will return to the editing window when finished 
confirming all the Library Screens.

• Click Cancel to stop deleting Library Screens and return to the editing window.

To select multiple screens,  key + click the specific screens or  key + click the specific screens.Shift Ctrl 



6 Using Library Screens

4-34 SmartAXIS Touch User’s Manual

6.5 Exporting Library Screens

To use created Library Screens on another computer, export those Library Screens.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Library Screen.

The Open Library dialog box is displayed.

3 Select the Library Screens to export in Library List and then click Export.

The Save As dialog box is displayed.

4 Specify Save in and click Save.

To select multiple screens,  key + click the specific screens or  key + click the specific screens.Shift Ctrl 
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6.6 Importing Library Screens

To use Library Screens created on another computer, import those exported Library Screens into WindO/I-NV3.

1 On the Home tab, in the Screens group, click ▼ to the right of Open.

2 Click the Library Screen.

The Open Library dialog box is displayed.

3 Click Import.

The Open dialog box is displayed.

4 Select a Library Screen file (*.r2f) and click Open.

The imported Library Screen is displayed in Library List.
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This chapter contains an overview of drawings and parts that are used when creating a screen and a description of 
the types of drawings and parts.

  

Drawings and parts are used by placing them on Base Screens and Popup Screens.

Drawings include objects such as straight lines, polygons, circles, pictures, and static text.

Parts are objects that generate a variety of events when triggered by a change in the values of devices or by touch.
 

Chapter 5 Drawings and Parts

1 Overview
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This section describes the drawing objects that can be drawn in WindO/I-NV3.

2.1 Shapes

2.2 Picture

Loads drawing objects that are registered in Picture Manager onto the edit screen.

2.3 Text

Draws text. The maximum number is 3,750 characters.
Loads text that is registered in Text Manager.

2 Drawing Objects

Shapes Function

Basic Shapes Line Draws a line.

Polyline Draws a polyline.

Polygon Draws an object that connects two or more vertices with straight lines.

Rectangle Draws a rectangle.

Circle/Ellipse Draws a circle or ellipse.

Arc Draws an elliptical arc.

Pie Draws a pie.

Equilateral Polygon Draws a equilateral polygon. (triangle, diamond, pentagon, hexagon, or octagon)

Paint Paints the closed region of the drawing object.
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This section describes the parts that can be used on the Touch.

3.1 Buttons

3.2 Lamps

3.3 Data Displays

3.4 Charts

3 Part Types

Part Description

Bit Button Writes a 0 or 1 to a bit device.

Word Button Writes a value to a word device. Can be used to indirectly specify the destination address or 
to perform operations on the written value.

Goto Screen Button Switches to another screen or displays a window.

Key Button Performs a variety of functions including uploading and downloading, copying files, and 
operating other parts.

Multi-Button Executes multiple commands at once.

Keypad A part comprised of Key Buttons. Enters numbers and characters into numerical or 
character input parts.

Selector Switch Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 
1 and all other values as 0.

Potentiometer Writes a value selected by pressing a slider button to a word device.

Part Description

Pilot Lamp Displays images. Switches the displayed image according to the value of a bit device.

Multi-State Lamp Displays images. Switches the displayed image according to the value of a word device.

Part Description

Numerical Input Uses either a Keypad or Key Button to write entered numbers.

Character Input Uses either a Keypad or Key Button to write the character code for entered characters.

Picture Display Displays images. Switches, moves or enlarges/reduces the displayed image according to the 
value of a word device, the bit status within a word device or at a fixed period.

Message Display Loads fixed text strings and values of word device as character codes and displays them on 
the screen.

Message Switching Display Switches the displayed fixed text string according to the value of a word device or the bit 
status within a word device.

Alarm List Display Switches the displayed fixed text string according to the value of device. Can display alarms 
and multiple fixed text strings.

Alarm Log Display Displays the alarm log stored in the internal memory of the Touch.

Numerical Display Displays the numerical in the specified format.

Calendar Displays the date and time using the Touch's calendar data.

Part Description

Bar Chart Displays values of devices in a Bar Chart.

Line Chart Displays data logs and values of devices in a Line Chart.

Pie Chart Displays values of devices in a Pie Chart.

Meter Displays values of devices using a needle gauge.
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3.5 Commands

Part Description

Bit Write Command Writes a 0 or 1 to a bit device when certain trigger conditions are satisfied.

Word Write Command
Writes a value to a word device when certain trigger conditions are satisfied. Can be used to 
indirectly specify the destination address or to perform operations on the written value.

Goto Screen Command
Switches to another screen or displays a window when certain trigger conditions are 
satisfied.

Script Command Executes a script when certain trigger conditions are satisfied.

Multi-Command Executes multiple commands at once when certain trigger conditions are satisfied.

Timer
Starts a countdown when certain trigger conditions are satisfied, and writes 1 to an internal 
device (HMI Timer Relay LTC) after the set time has elapsed.
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This chapter describes the procedures for drawing with shapes and the procedures for configuring pictures and text.

  

1.1 Line

● Line Drawing Procedure
This section describes the procedure for drawing lines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Line) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) to start drawing the line on the edit screen.

3 Drag the mouse to the ending point location.

A line is drawn that connects the starting point and ending point.

Chapter 6 Drawings

1 Shapes

Ending
point

Starting
point

Drag

To change the style of the drawn line, perform one of the following operations.
• Double click the line to open the Properties dialog box
• Select the line and select the style with Shape Style on the Format tab
• Select the line and right click to display the popup menu
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● Properties of Line Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the line from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the line (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Blink
Select this check box to make the line blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Point1, Point2

X, Y: Specifies the starting point and ending point of the line in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y

Screen

Line

Ending
point

Starting
point
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1.2 Polyline

● Polyline Drawing Procedure
This section describes the procedure for drawing polylines.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polyline) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (starting point) to start drawing the polyline on the edit screen.

3 Click the corner point locations in order.

A line is drawn that connects the starting point and the various corner point locations in the order that they were 
created.

4 Double click at the ending point location.

A line is drawn that connects the last corner point and the ending point.

Ending
point

Starting
point

Corner
point

Corner
point

The maximum number of corner points in a polyline, including the starting point and the ending point, is 
300 points.

• To change the style of the drawn polyline, perform one of the following operations.
- Double click the polyline to open the Properties dialog box
- Select the polyline and select the style with Shape Style on the Format tab
- Select the polyline and right click to display the popup menu

• To change the starting point, corner points, or the ending point of the drawn polyline, select the polyline 

and right click on it, and then click Reshape.  is displayed on the polyline. Drag  to the desired 

location. Double click the edit screen or press the  key to finish changing the shape.
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● Properties of Polyline Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polyline from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polyline from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Line Color
Selects the line color for the polyline (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Blink
Select this check box to make the polyline blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates

■ Size

X, Y: Specifies the display position of the polyline in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the polyline is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y

Screen

Polyline

W, H: Specifies the size of the polyline in width and height.

W: 1 to (Base Screen horizontal size)

H: 1 to (Base Screen vertical size)

Width

Height

Screen

Polyline
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1.3 Polygon

● Polygon Drawing Procedure
This section describes the procedure for drawing polygons.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Polygon) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click at the location (starting point) to start drawing the polygon on the edit screen.

3 Click the corner point locations in order.

A line is drawn that connects the starting point and the various corner point locations in the order that they were 
created.

4 Double click at the ending point location.

A polygon is drawn with the starting point and ending point connected.

Corner
point

Starting
point

Ending
point

Corner
point

• To change the style of the drawn polygon, perform one of the following operations.
- Double click the polygon to open the Properties dialog box
- Select the polygon and select the style with Shape Style on the Format tab
- Select the polygon and right click to display the popup menu

• To change the starting point, corner points, or the ending point of the drawn polygon, select the polygon 

and right click on it, and then click Reshape.  is displayed on the polygon. Drag  to the desired 

location. Double click the edit screen or press the  key to finish changing the shape.



1 Shapes

6-6 SmartAXIS Touch User’s Manual

● Properties of Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the polygon (color: 256 colors, monochrome: 8 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern for the polygon.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Blink
Select this check box to make the polygon blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

X, Y: Specifies the display position of the polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the polygon is the X and Y coordinates.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Polygon

W, H: Specifies the size of the polygon in width and height.
W: 1 to (Base Screen horizontal size)
H: 1 to (Base Screen vertical size)

Width

Height

Screen

Polygon
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1.4 Rectangle

● Rectangle Drawing Procedure
This section describes the procedure for drawing rectangles.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Rectangle) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) to start drawing the rectangle on the edit screen.

3 Drag the mouse to the ending point location so that location becomes the opposite angle of the rectangle.

A rectangle is drawn with the starting point and ending point set to opposite angles.

Ending
point

Drag

Starting
point

To change the style of the drawn rectangle, perform one of the following operations.
• Double click the rectangle to open the Properties dialog box
• Select the rectangle and select the style with Shape Style on the Format tab
• Select the rectangle and right click to display the popup menu
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● Properties of Rectangle Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the rectangle from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the rectangle from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the rectangle (color: 256 colors, monochrome: 8 
shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern for the rectangle.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Blink
Select this check box to make the rectangle blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Round Type
Selects the style of the rectangle's corners from the following.
None, Curve, Straight

■ Round Radius
Specifies the rounding radius (1 to 200). However, the range that can be configured is where round radius x 2 is a 
value smaller than Size W and Size H.
This option can only be configured when Curve or Straight is selected for Round Type.

Curve StraightNone

For Curve For Straight

Round Radius Round Radius
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■ Shadow
Selects the style of shadow attached to the rectangle from the following. This option draws the rectangle in a three-
dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

■ Coordinates 

■ Size

Convex ConcaveNone

X, Y: Specifies the display position of the rectangle in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle is the X 
and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Rectangle

W, H: Specifies the size of the rectangle in width and height.

W: 1 to (Base Screen horizontal size)

H: 1 to (Base Screen vertical size)

Width

Height

Screen

Rectangle
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1.5 Circle/Ellipse

● Circle/Ellipse Drawing Procedure
This section describes the procedure for drawing circles and ellipses.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Circle/Ellipse) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) to start drawing the circle or ellipse on the edit 
screen.

3 Drag the mouse to the ending point location so that location becomes the opposite angle of the rectangle.

A circle or ellipse is drawn that inscribes the rectangle made from the opposite angles of the starting point and the 
ending point.

Ending
point

Drag

Starting
point

To change the style of the drawn circle or ellipse, perform one of the following operations.
• Double click the circle or ellipse to open the Properties dialog box
• Select the circle or ellipse and select the style with Shape Style on the Format tab
• Select the circle or ellipse and right click to display the popup menu
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● Properties of Circle/Ellipse Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the circle or ellipse from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the circle or ellipse from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the circle or ellipse (color: 256 colors, monochrome: 
8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern for the circle or ellipse.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Blink
Select this check box to make the circle or ellipse blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Shadow
Selects the style of shadow attached to the circle or ellipse from the following. This option draws the circle or ellipse 
in a three-dimensional manner.
None, Convex, Concave
This option can only be configured when 1 dot is selected for Line Width and Solid is selected for Line Type.

Convex ConcaveConvex
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■ Coordinates 

■ Size

X, Y: Specifies the display position of the circle or ellipse in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle or ellipse is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Circle/ellipse

W, H: Specifies the size of the circle or ellipse in width and height.

W: 3 to (Base Screen horizontal size)

H: 3 to (Base Screen vertical size)

Width

Height

Screen

Circle/ellipse
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1.6 Arc

● Arc Drawing Procedure
This section describes the procedure for drawing arcs.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Arc) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) to start drawing the arc on the edit screen.

3 Drag the mouse to the ending point location so that location becomes the opposite angle of the rectangle.

An arc is drawn that inscribes the rectangle made from the opposite angles of the starting point and the ending point.

Ending
point

Drag

Starting
point

• To change the style of the drawn arc, perform one of the following operations.
- Double click the arc to open the Properties dialog box
- Select the arc and select the style with Shape Style on the Format tab
- Select the arc and right click to display the popup menu

• To change the starting point or the ending point of the drawn arc, select the arc and right click on it, and 

then click Reshape.  is displayed on the arc. Drag  to the desired location. Double click the edit 

screen or press the  key to finish changing the shape.
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● Properties of Arc Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the arc from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the arc from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Line Color
Selects the line color for the arc (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Blink
Select this check box to make the arc blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

X, Y: Specifies the display position of the arc in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the arc is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen
Arc

W, H: Specifies the size of the arc in width and height.

W: 3 to (Base Screen horizontal size)

H: 3 to (Base Screen vertical size)

Width

Height

Screen
Arc
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1.7 Pie

● Pie Drawing Procedure
This section describes the procedure for drawing pies.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Pie) under Basic Shapes.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) to start drawing the pie on the edit screen.

3 Drag the mouse to the ending point location so that location becomes the opposite angle of the rectangle.

A pie is drawn that inscribes the rectangle made from the opposite angles of the starting point and the ending point.

Ending
point

Drag

Starting
point

• To change the style of the drawn pie, perform one of the following operations.
- Double click the pie to open the Properties dialog box
- Select the pie and select the style with Shape Style on the Format tab
- Select the pie and right click to display the popup menu

• To change the central angle of the drawn pie, select the pie and right click on it, and then click Reshape. 

 is displayed on the pie. Drag  to the desired location. Double click the edit screen or press the 

 key to finish changing the shape.
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● Properties of Pie Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the pie from the following.
1 dot, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the pie from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot is selected 
for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the pie (color: 256 colors, monochrome: 8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern for the pie.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Blink
Select this check box to make the pie blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the pie in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the circle with the same center as the pie is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen
Pie
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■ Size

W, H: Specifies the size of the pie in width and height.

W: 3 to (Base Screen horizontal size)

H: 3 to (Base Screen vertical size)

Width

Height

Screen
Pie
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1.8 Equilateral Polygons

● Equilateral Polygons Drawing Procedure
This section describes the procedure to draw equilateral polygons (equilateral triangle, equilateral diamond, 
equilateral pentagon, equilateral hexagon, equilateral octagon).

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Equilateral Triangle),  (Equilateral 
Diamond),  (Equilateral Pentagon),  (Equilateral Hexagon), or  (Equilateral Octagon) under Equilateral 
Polygons.

The mouse cursor changes to  (pencil).

2 Click and hold the mouse button at the location (starting point) on the edit screen to start drawing the square that will 
circumscribe the equilateral polygon.

3 Drag the mouse to the ending point location so that location becomes the opposite angle of the square.

An equilateral polygon is drawn that inscribes the square made from the opposite angles of the starting point and the 
ending point.

Ending
point

Drag

Starting
point

To change the style of the drawn square, perform one of the following operations.
• Double click the square to open the Properties dialog box
• Select the square and select the style with Shape Style on the Format tab
• Select the square and right click to display the popup menu
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● Properties of Equilateral Polygon Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Line Width
Selects the line width for the equilateral polygon from the following.
1 dot, 2 dots, 3 dots, 5 dots
3 dots and 5 dots can only be configured when Solid is selected for Line Type.

■ Line Type
Selects the line type for the equilateral polygon from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot
Dot, Dash, Long Dash, Long Dash Dot, and Long Dash Dot Dot can only be configured when 1 dot or 2 dots 
is selected for Line Width.

■ Foreground Color, Background Color
Selects the foreground color and the background color to use for the equilateral polygon (color: 256 colors, 
monochrome: 8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern for the equilateral polygon.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Blink
Select this check box to make the equilateral polygon blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

X, Y: Specifies the display position of the equilateral polygon in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the square that 
circumscribes the equilateral polygon is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Equilateral polygon
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■ Size

W, H: Specifies the size of the equilateral polygon in width and height.

W: 1 to (Base Screen horizontal size)

H: 1 to (Base Screen vertical size)

Width

Height

Screen

Equilateral polygon
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1.9 Fill

● Fill Configuration Procedure
This section describes the fill configuration procedure.

1 On the Home tab, in the Drawings group, click Shapes, and then click  (Fill) under Fill.

The mouse cursor changes to  (pencil).

2 Click on a section where multiple shapes overlap on the edit screen.

The section where multiple shapes overlap is filled with the Foreground Color, Background Color, and Pattern 
of the shape last drawn or the shape that last had its style changed. The clicked location is the fill starting point.

Fill starting point

• To change the fill style, perform one of the following operations.
- Double click the fill starting point to open the Properties dialog box
- Select the fill starting point and select the style with Shape Style on the Format tab
- Select the fill starting point and right click to display the popup menu

• If you move the fill starting point, the closed region where it was moved to is filled.

• To select the fill starting point, click  on the edit screen or select Fill on the Object List window.
Fill starting point Fill starting point
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● Properties of Fill Dialog Box
This section describes items and buttons in the Properties dialog box.

■ Foreground Color, Background Color
Selects the foreground color and the background color to fill with (color: 256 colors, monochrome: 8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

■ Pattern
Selects the pattern to fill with.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Coordinates 

X, Y: Specifies the display position of the fill start position in coordinates.
The upper-left corner of the screen is the origin.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y

Screen

Fill start point
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2.1 Picture Configuration Procedure

This section describes the picture configuration procedure.

1 On the Home tab, in the Drawings group, click Picture.

The mouse cursor changes to  (picture).

2 Click the location on the edit screen to place the picture.

Picture Manager is displayed.

3 Select a picture, and then click Select.

The selected picture, is placed on the screen.

2 Picture

To change the picture that was placed on the screen, perform one of the following operations.
• Double click the picture to open the Properties dialog box, and then click Browse
• Replace the picture in Picture Manager
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2.2 Properties of Picture Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Changes the picture placed on the screen. Click this button to display Picture Manager.

■ Blink
Select this check box to make the picture blink.
The blink interval is specified with Blinking Cycle on the System tab in the Project Settings dialog box.

■ Coordinates 

■ Size

X, Y: Specifies the display position of the picture in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the picture is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Picture

W, H: Specifies the size of the picture in width and height.

W: 1 to (Base Screen horizontal size)

H: 1 to (Base Screen vertical size)

Width

Height

Screen

Picture
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3.1 Text Configuration Procedure

This section describes the configuration procedure for text.

1 On the Home tab, in the Drawings group, click Text.

The mouse cursor changes to  (text).

2 Click the location on the edit screen to place the text.

The Properties of Text dialog box is displayed.

3 Enter the text to display in Text and configure the options as necessary.

The maximum number is 3,750 characters.

4 Click OK.

The text is placed on the screen.

3 Text

To change the style of the text placed on the screen, perform one of the following operations. You can 
change the entered text in the Properties dialog box.
• Double click the text to open the Properties dialog box
• Select the text and select the style with Text Style on the Format tab
• Select the text and right click to display the popup menu
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3.2 Properties of Text dialog box

This section describes items and buttons in the Properties dialog box.

■ Font
Selects the font to use to display text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
This option can only be configured if the Use Text Manager check box is cleared.

■ Style
Selects the style of text from the following.
Regular, Bold, Shadow
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
Top when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Vertical Writing
Select this check box to display text vertically.
This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for installations of Windows that support East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
left edge

Horizontal
display

Next
characters
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■ Windows Font
Configures the font to use as the Windows Font.
Select Windows for Font to display the current settings. To change the settings, click Change to display the Font 
Settings dialog box.
This option can only be configured if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.

■ Text
Enter the text to display. The maximum number is 3,750 characters.
The characters that can be entered vary based on the font selected by Font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

■ Text Color
Selects the color for the displayed text (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Magnification

This option can only be configured when Japanese, European, Chinese, Taiwanese, Korean, Central 
European, Baltic, or Cyrillic is selected for Font.

■ Background Color
Selects the background color for the text (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Animation
Selects whether or not to make the text blink.

■ Shadow Color
Selects the shadow color for the text (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
This option can only be configured when Shadow is selected for Style.

• To enter Unicode characters, click  to display the Unicode Input dialog box. Enter the characters in 
the Unicode Input dialog box, and then click OK.

• A newline is counted as two characters.

W, H: Selects the zoom factor for characters (0.5, 1 to 8).

Normal: The text does not blink.

Blink: The text blinks.
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■ Coordinates 

■ Use Text Area
Select this check box to specify a text area and adjust the display position of the text with the specified text area.

X, Y: Specifies the display position of the text or the text area in coordinates.
With the upper-left corner of the screen as the origin, the upper-left corner of the rectangle that 
circumscribes the text or the upper-left corner of the text area is the X and Y coordinates.
When the Use Text Area check box is cleared, the coordinates are for the text. When the Use Text 
Area check box is selected, the coordinates are for the text area.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

IDEC IDEC

(0, 0)
X

Y

(0, 0)
X

Y

Screen

Text

Screen

Text area

When Use Text Area is cleared When Use Text Area is selected

W, H: Specifies the size of the text area in width and height.

W: 1 to (Base Screen horizontal size)

H: 1 to (Base Screen vertical size)

IDEC

Width

Height

Screen

Text area
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This chapter describes the setup for the button parts and related Touch operations.

  

1.1 How the Bit Button is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

Chapter 7 Buttons

1 Bit Button

Touch External device

0

1

Pressing the button writes a 1 to the 
bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Pressing the button writes a 0 to the 
bit device. Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Momentary

■ Alternate

■ Toggle

■ Move

Pressing the button writes a 1 to the 
bit device.
Releasing the button writes a 0 to the 
bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Each press of the button alternately 
writes a 1 or 0 to the bit device. Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Pressing the button inverts the value 
of the bit device.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Pressing the button writes the value 
in the source bit device to the value in 
the destination bit device.

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move
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1.2 Bit Button Configuration Procedure

This section describes the configuration procedure for Bit Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

2 Click a point on the edit screen where you want to place the Bit Button.

3 Double-click the dropped Bit Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Bit Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a 1 to the bit device.

Reset: Pressing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 1

WriteAction Write

Release

Initial image

Press ReleasePress

0

Operation and 
view

Data written 0

WriteAction Write
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■ Destination Device
Specify the destination bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Momentary: Pressing the button writes a 1 to the bit device.
Releasing the button writes a 0 to the bit device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 10 0

WriteAction WriteWrite Write

Pressing and holding the button until the screen changes causes a 0 to be written to the bit device.

Alternate: Each press of the button alternately writes a 1 or 0 to the bit device.

Toggle: Pressing the button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the button writes the value in the source bit device to the value in the destination bit 
device.

Release

Initial image

Press ReleasePress

1

Operation and 
view

Data written 0

WriteAction Write

Release

Initial image

Press ReleasePress

Operation and 
view

ToggleAction Toggle

Release

Initial image

Press ReleasePress

Move

Operation and 
view

Action Move
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■ Write
Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit in a word device is specified, the same value is written to same bit of contiguous word devices.

■ Source Data
Specifies the device that stores the data to be written.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of devices at the 
destination.

*1 Advanced mode only

*1

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5
Destination Device: M0

bit bit
15 0

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5
Destination Device: D0-15

Device: Specify the source bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Transfer: Specify the number of bit devices (1 to 64) to transfer.

Device: LM0

Transfer: 4

1LM0

0LM1

0LM2

1LM3

Destination Device: M0

1M0

0M1

0M2

1M3
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device: The drawing objects assigned to the OFF and ON states are displayed when the value of device is 0 
and 1, respectively. Specifies the device used to switch the drawing object display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the Touch activates the assigned function. If No Image 
is selected, the settings for View and Registration Text are disabled.

Selecting Device in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address M0 as Device in View Switching Method, if the value 
of M0 changes, the display image will switch according to the value of M0 even if the button is not 
pressed.

0

M0

1

M0

Touch External device

View Switching Method (Device): M0

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Blink
Select this check box if blinking is desired (alternating ON and OFF) when a part is ON.

Standard: Uses the default graphics contained within WindO/I-NV3.

Picture: Uses an image file saved in Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Blink

ON image

OFF image
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device is selected for View Switching Method on the 
General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always Enabled: The Button is always enabled.

While ON: Enables the Button when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always Enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Button state



SmartAXIS Touch User’s Manual 7-13

1 Bit Button

7

Buttons

While OFF: Enables the Button when the value of device is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 milliseconds).
The button activates after it is held down for a specified period of time.

Hold down for three seconds

Touch Touch

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.



SmartAXIS Touch User’s Manual 7-15

1 Bit Button

7

Buttons

Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B
User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment comments about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Button is Used

Writes a value to a word device. Can be used to indirectly specify the destination address or to perform operations on 
the written value.

• Pressing the button writes a constant value to a word device.

• Pressing the button writes the value of device address to a word device.

• Pressing the button performs arithmetic on the value to write before writing it to a word device.

2 Word Button

Touch External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

100→D1

External device
D0= 123

D1= 0

D0= 123

D1= 123

Move

Value in device

Destination word device

D0→D1

Touch

External device
D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

D0+D1→D2

Touch
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■ Set

■ Move

■ Momentary

■ Alternate

Pressing the button writes a constant 
value to a word device. Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

Pressing the button writes the value in 
the source device to the destination 
word device.

ReleasePress ReleasePress

Initial image

Write

Value in device

Operation and 
view

Action

Data written

Write

Value in device

Pressing the button writes the 
constant value of ON data to a word 
device.
Releasing the button writes the 
constant value of OFF data to a word 
device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Each press of the button alternately 
writes the fixed value of ON data and 
OFF data to the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data
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■ Add, Sub, Multi, Div, Mod, OR, AND, XOR
Pressing the button performs 
arithmetic on the value in a reference 
device and a constant value or the 
value in a device address and writes 
the result to a word device.

Example: Add (Addition)
Pressing the button adds the 
value in the Source 1 to the 
Source 2 value and writes 
the sum in the word device.

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓
Write

Operation and 
view

Action

Value of 
Reference Device 100 200 300 400 500

Data

Value of
Destination Device 240 420

50 40 30 20 10

Addition

↓
Write

0 240 420
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2.2 Word Button Configuration Procedure

This section describes the configuration procedure for Word Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Word Button.

2 Click a point on the edit screen where you want to place the Word Button.

3 Double-click the dropped Word Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Word Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the behavior of the button from the following:

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Set: Pressing the button writes a constant value to a word device.

Move: Pressing the button writes the value in the source device to the destination word device.

Release

Initial image

Press ReleasePress

Write

Value

Operation and 
view

Action

Data written

Write

Value

ReleasePress ReleasePress

Initial image

Write

Value in device

Operation and 
view

Action

Data written

Write

Value in device
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Momentary: Pressing the button writes the constant value of ON data to a word device.
Releasing the button writes the constant value of OFF data to a word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

ON data

Write

OFF data

Write

OFF data

Pressing and holding the button until the screen changes causes the OFF data to be written to the word 
device.

Alternate: Each press of the button alternately writes the fixed value of ON data and OFF data to the word 
device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Pressing the button performs arithmetic on the value in a reference device and a constant value 
or the value in a device address and writes the result to a word device.

Example: Add (Addition)
Pressing the button adds the value in the Source 1 to the Source 2 value and writes 
the sum in the word device.

ReleasePress ReleasePress

Initial image

Write

ON data

Operation and 
view

Action

Data written

Write

OFF data

Release

Initial image

Press ReleasePress

Arithmetic 
operation

↓

Write

Operation and
 view

Action

Data written Result

Arithmetic 
operation

↓

Write

Result

Release

Initial image

Press ReleasePress

Addition

↓
Write

Operation and 
view

Action

Value of 
Reference Device 100 200 300 400 500

Data

Value of
Destination Device 240 420

50 40 30 20 10

Addition

↓
Write

0 240 420
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■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
BIN16(+) and BIN32(+) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data handled by the operation selected for Action Mode.

*1 Advanced mode only

BIN16(+) and BIN32(+) can only be set if Action Mode is set to Move. Because the number of devices 
to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4, BCD8 or float32 is selected and the arithmetic data contains a value inexpressible in BCD, a 1 is 
written to System Area 2 Arithmetic error bit (address+2, bit 5) and an error message is displayed.
For details, refer to Chapter 3 “Arithmetic error” on page 3-25.

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set, Momentary, or Alternate.
If Action Mode is set to Momentary or Alternate, the value in the ON Data is written when the button 
is ON, and the value in the OFF Data is written when the button is OFF.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values in 
hexadecimal.

Device: Use a word device.
Specify the device. 

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the source word device 
according to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 
2-4.

Transfer Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the same data in 2 

continuous word devices will be written to the destination device 3 times.

*1
:

Device: LDR0

Write: 3

999LDR0

Destination Device: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000
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■ Destination Device

*1 Advanced mode only

Destination Device: Specify the destination word device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device according 
to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Write Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Momentary, Alternate, or 
Move.
Example: If Data Type is set to BIN16(+) and Write is set to 5, the same data will be 

written to 5 continuous word addresses.

Example: If Data Type is set to BIN32(+) and Write is set to 5, the same data will be 
written to a total of 10 word addresses (2 words 5 times).

*1
:

Destination Device: LDR10
Write: 5

Data Type: BIN16(+)
Source Data: 12345

12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words

Destination Device: LDR10
Write: 5

Data Type: BIN32(+)
Source Data: 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

10 words
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device: The drawing objects assigned to the OFF and ON states are displayed when the value of device is 0 
and 1, respectively. Specifies the device used to switch the drawing object display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the Touch activates the assigned function. If No Image 
is selected, the settings for View and Registration Text are disabled.

Selecting Device in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address M0 as Device in View Switching Method, if the value 
of M0 changes, the display image will switched according to the value of M0 even if the button is 
not pressed.

0

M0

1

M0

Touch External device

View Switching Method (Device): M0

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Blink
Select this check box if blinking is desired (alternating ON and OFF) when a part is ON.

Standard: Uses the default graphics contained within WindO/I-NV3.

Picture: Uses an image file saved in Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Blink

ON image

OFF image
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device is selected for View Switching Method on the 
General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always Enabled: The Button is always enabled.

While ON: Enables the Button when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always Enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Button state
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While OFF: Enables the Button when the value of device is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 milliseconds).
The button activates after it is held down for a specified period of time.

Hold down for three seconds

Touch Touch

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Button is Used

Switches to another screen or displays a window.

• Pressing the button switches between Base Screens.

• Pressing the button opens and closes other windows (such as the Popup Screen, Device Monitor, Ladder Monitor, 
Password Screen, and Adjust Contrast Screen).

• Pressing the button switches to the System Mode.

• Pressing the button resets the current screen.

3 Goto Screen Button

Touch Touch

130 Full

Tank 1

Touch Touch

D51

D52 456

D53 0

999

123

Touch

D51

D52 456

D53 0

999

123

Touch

Touch Touch

130

Touch Touch

130 0
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3.2 Goto Screen Button Configuration Procedure

This section describes the configuration procedure for Goto Screen Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

2 Click a point on the edit screen where you want to place the Goto Screen Button.

3 Double-click the dropped Goto Screen Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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3.3 Properties of Goto Screen Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.
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■ Action Mode
Select the behavior of the button from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen. For details, refer to Chapter 4 “3 Base Screen” on 
page 4-14.

Open Popup Screen: Opens a Popup Screen. For details, refer to Chapter 4 “4 Popup Screen” on page 4-
22.

Close Popup Screen: Closes a Popup Screen. For details, refer to Chapter 4 “4 Popup Screen” on page 4-
22.

Open Device Monitor Screen: Opens the Device Monitor Screen. For details, refer to Chapter 24 “2.2 Device 
Monitor” on page 24-19.

Close Device Monitor Screen: Closes the Device Monitor Screen. For details, refer to Chapter 24 “2.2 Device 
Monitor” on page 24-19.

Open Ladder Monitor: Opens the Ladder Monitor. For details, refer to Chapter 24 “2.3 Ladder Monitor” on 
page 24-23.

Close Ladder Monitor: Closes the Ladder Monitor. For details, refer to Chapter 24 “2.3 Ladder Monitor” on 
page 24-23.

Open Password Screen: Opens the Password Screen. For details, refer to Chapter 21 “4.1 Entering the 
Password on the Touch” on page 21-36.

Close Password Screen: Closes the Password Screen. For details, refer to CChapter 21 “4.1 Entering the 
Password on the Touch” on page 21-36.

Open Adjust contrast Screen: Opens the Adjust contrast Screen. For details, refer to Chapter 28 “1.3 Adjusting 
Screen Brightness” on page 28-2.

Close Adjust contrast Screen: Closes the Adjust contrast Screen. For details, refer to Chapter 28 “1.3 Adjusting 
Screen Brightness” on page 28-2.

Switch to System Mode: Switches to the Top Page in the System Mode. For details, refer to Chapter 28 “2 
System Mode Overview” on page 28-3.

Reset current screen: Resets the current Base Screen.

• Open Ladder Monitor and Close Ladder Monitor can only operate when ladder program is selected 
as the programming language in control function.

• When the current Base Screen is reset using the Reset current screen function, the window and 
internal devices restart as if the Base Screens were switched.
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■ Goto Screen

■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Screen No.: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to
(from 1 to 3,000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3,015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device*1: Select this check box and specify a device to specify the screen number 
using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust contrast Screen, or Open Movie 
File Screen.

Use Reference Device*1: Select this check box and specify a device to specify the coordinates 
using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the
device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen.

Button: Pressing the button changes the drawing object displayed.
Device: The drawing objects assigned to the OFF and ON states are displayed when the value of device is 

0 and 1, respectively. Specifies the device used to switch the drawing object display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the Touch activates the assigned function. If No 
Image is selected, the settings for View and Registration Text are disabled.

Selecting Device in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address M0 as Device in View Switching Method, if the value 
of M0 changes, the display image will switched according to the value of M0 even if the button is not 
pressed.

0

M0

1

M0

Touch External device

View Switching Method (Device): M0

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Blink
Select this check box if blinking is desired (alternating ON and OFF) when a part is ON.

Standard: Uses the default graphics contained within WindO/I-NV3.

Picture: Uses an image file saved in Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Blink

ON image

OFF image
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device is selected for View Switching Method on the 
General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always Enabled: The Button is always enabled.

While ON: Enables the Button when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always Enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Button state
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While OFF: Enables the Button when the value of device is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 milliseconds).
The button activates after it is held down for a specified period of time.

Hold down for three seconds

Touch Touch

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Key Button is Used

Performs a variety of functions including uploading and downloading project files, and operating other parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

• Operating the Alarm List Display or Alarm Log Display

4 Key Button

1230

Touch

Touch

Show focus. Move focus.

Key Button

Display reference screen.

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen
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4.2 Key Button Configuration Procedure

This section describes the configuration procedure for Key Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Key Button.

2 Click a point on the edit screen where you want to place the Key Button.

3 Double-click the dropped Key Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Key Button Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Key Type
Select the function for the Key Button.

The settings explained below appear depending on the type of key selected.

■ Popup Screen No.
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “4.5 Key Browser” on page 7-66.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key, the label for that key is assigned as the Registration Text.
• The function of Key button will affect on the next scan when the trigger condition is satisfied.
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■ Scroll Size
Key Buttons Pg. Up and Pg. Dwn scroll the list up and down, respectively. Key Buttons Fcs. Up and Fcs. Dwn move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Pg. Up, Pg. Dwn, Fcs. Up, and Fcs. Dwn are selected using the Key Browser.

■ Transfer Setting
Key Buttons Download Project and Upload Project perform the data transfer function specified by their names. 
These settings specify the source, data to be transfered, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: This is set to the USB flash drive on which the project file to transfer (.ZNV) was saved.

File Path: Specify the path to the project file (.ZNV) to transfer. The maximum number is 247  
characters.
Example: Where “FT_DEMO_1.ZNV” is a project file saved on the root directory of a USB 

flash drive: 
FT_DEMO_1.ZNV

Destination: Specify where to save the project uploaded from Touch. The location is the USB flash drive.

Folder Path: Specify the path to the folder where the uploaded project file will be saved. The 
maximum number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive: 

Uploaded_Project
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device: The drawing objects assigned to the OFF and ON states are displayed when the value of device is 0 
and 1, respectively. Specifies the device used to switch the drawing object display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the Touch activates the assigned function. If No Image 
is selected, the settings for View and Registration Text are disabled.

Selecting Device in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address M0 as Device in View Switching Method, if the value 
of M0 changes, the display image will switched according to the value of M0 even if the button is 
not pressed.

0

M0

1

M0

Touch External device

View Switching Method (Device): M0

OFF image:

ON image:
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Blink
Select this check box if blinking is desired (alternating ON and OFF) when a part is ON.

Standard: Uses the default graphic for WindO/I-NV3.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Blink

ON image

OFF image
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device is selected for View Switching Method on the 
General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always Enabled: The Button is always enabled.

While ON: Enables the Button when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always Enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Button state
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While OFF: Enables the Button when the value of device is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 milliseconds).
The button activates after it is held down for a specified period of time.

Hold down for three seconds

Touch Touch

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.



4 Key Button

7-62 SmartAXIS Touch User’s Manual

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.4 Key Buttons

● For Keypad
These keys can be used for Numerical Input and Character Input:

■ Numerical Input Keypad

■ Character Input Keypad

Key Operation

. Inputs a decimal point.

0 to 9 Inputs a number from 0 to 9.

A to F Inputs a character from A to F.

+/- Toggles the sign.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen that is opened as 
the Keypad, if this key is placed on it.

CLR Clears the data input thus far and stands by for further input.

BS Deletes the character to the left of the character at the cursor position. 

ENT
Writes the characters input as a numeric value to a device. After the data is written, the focus 
can be moved according to the Focus Order setting. Focus Order can be set on the Options 
tab of the Screen Properties dialog box.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

The Alt key can be used, for instance, to switch between a decimal and a hexadecimal Keypad.

Key Operation

! Inputs a !.

" Inputs a ".

# Inputs a #.

$ Inputs a $.

% Inputs a %.

&. Inputs a &.

' Inputs a '.

( Inputs a (.

) Inputs a ).

* Inputs a *.

+ Inputs a +.

, Inputs a ,.

- Inputs a -.

. Inputs a .

/ Inputs a /.

0 to 9 Inputs a number from 0 to 9.

: Inputs a :.

; Inputs a ;.

< Inputs a <.

= Inputs a =.



4 Key Button

7-64 SmartAXIS Touch User’s Manual

> Inputs a >.

? Inputs a ?.

@ Inputs a @.

A to Z Inputs a character from A to Z.

[ Inputs a [.

\ Inputs a .\

] Inputs a ].

^ Inputs a ^.

_ Inputs a _.

' Inputs a '.

a to z Inputs a character from a to z.

{ Inputs a {.

| Inputs a |.

} Inputs a }.

˜ Inputs a ˜.

(Keys dependent on 
Language setting)

Inputs the text displayed according to the language selected in the Language setting. For a list 
of the characters input using these keys, refer to Chapter 2 “1.2 Available Text” on page 2-5.

CAN
Clears the data input thus far and cancels the input. Closes the Popup Screen if it is opened as 
a Keypad.

CLR Clears the data input thus far and stands by for further input.

DEL Deletes the character at the cursor.

BS Deletes the character to the left the cursor.

ENT
Writes the text input in ASCII code form to a device. After the data is written, the focus can be 
moved according to the Focus Order setting. Focus Order can be set on the Options tab of 
the Screen Properties dialog box.

SP Inputs a space.

Cur. > Moves the cursor right.

< Cur. Moves the cursor left.

< Fcs.
Moves the focus one item before the current one as per the Focus Order setting. Focus 
Order can be set on the Options tab of the Screen Properties dialog box.

Fcs. >
Moves the focus one item after the current one as per the Focus Order setting. Focus Order 
can be set on the Options tab of the Screen Properties dialog box.

Alt
The Alt key switches the Popup Screen opened as a Keypad. Closes the Popup Screen that is 
opened as the Keypad and opens another Popup Screen as the Keypad.

Key Operation

Press and hold the < Cur. and Cur. > keys for more than one second to cause it to move repeatedly.

The Alt key can be used, for instance, to switch between Keypads for lower case and upper case letters.
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● For Data Transfer Keys
These keys can be used to execute Data Transfer functions.

For details about Data Transfer functions, refer to Chapter 25 “Data Transfer Function” on page 25-1.

● For Alarm Displays
These keys can be used for the Alarm List Display and Alarm Log Display parts.

■ Alarm List Display

■ Alarm Log Display

Key Operation

Download Project Downloads a project file (ZNV format) saved on an external memory to the Touch.

Upload Project
Uploads the project used for operation on the Touch and saves the project file (ZNV format) to 
an external memory.

Key Operation

Pg. Up Scrolls up the number of lines (1 to 1023) specified in Scroll Size.

Pg. Dwn Scrolls down the number of lines (1 to 1023) specified in Scroll Size.

Fcs. Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing REVERSE.

Fcs. Dwn
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing REVERSE.

REVERSE Toggles the focus between show and hide.

Ref. The reference screen appears.

Press and hold the Pg. Up, Pg. Dwn, < Cur., and Cur. > keys for more than one second to move the 
focus repeatedly.

Key Operation

Fcs. Up
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing REVERSE.

Fcs. Dwn
Moves the focus the number of lines (1 to 1023) specified in Scroll Size. The current point of 
focus can be shown by pressing REVERSE.

REVERSE Toggles the focus between show and hide.

CHECK Shows the date and time the alarm that has focus was confirmed.

All Chk. Shows the date and time that all alarms were confirmed.

Del. Clears the alarm that has focus.

Del. All Clears all alarms.

Ref. Shows the reference screen for the alarm that has focus.

Stop Buzzer and Screen 
Flashing

Stops the sound of the buzzer and screen flashing when an alarm occurs.

Press and hold the Fcs. Up and Fcs. Dwn keys for more than one second to move the focus repeatedly.
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4.5 Key Browser

Select the key using the Key Browser. The Key Browser closes when a key is selected. The name of the key is shown 
in Key Type. Settings that apply to the selected key are displayed.

Select the key type from the following uses:
Keypad, Data Transfer, Alarm Display

■ Keypad
These buttons are used for Numerical Input and Character Input:

■ Data Transfer
These buttons are used to execute Data Transfer functions.

When you select a key, the label for that key is assigned as the Registration Text.
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■ Alarm Display
These buttons are used to manipulate the Alarm List Display and Alarm Log Display parts.
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5.1 How the Multi-Button is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Button.

• Pressing the button writes a 1 to a bit device, and the value in a word device to another device.

• When the button is pressed, executes the script and switches the Base Screen

5 Multi-Button

Command Description

Bit Write Writes a 0 or 1 to the specified bit device when pressed.

Word Write
Writes a value to a word device when pressed. You can specify the destination address indirectly, and 
perform arithmetic on the value to be written.

Goto Screen Switches screens or opens other windows when pressed.

Key Performs downloads or uploads when pressed. Also used to manipulate other parts.

Script Executes a script when pressed.

Touch External device

10

D0= 123

D1= 0

D0= 123

D1= 123

Move

Touch

// Script A

[D 100] = [D 100] + 1;

if ([D 100] >= 50)

{

     [D 100] = 0;

}

Executes the script
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5.2 Multi-Button Configuration Procedure

This section describes the configuration procedure for Multi-Buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Multi-Button.

2 Click a point on the edit screen where you want to place the Multi-Button.

3 Double-click the dropped Multi-Button and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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5.3 Properties of Multi-Button Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the button is OFF or ON.

■ Action Mode
Select the Action Mode for the Multi-Button: Momentary or Alternate.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

Momentary: The button turns ON when pressed, and OFF when released.

Alternate: The button switches between ON and OFF each time it is pressed.
?

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action ONOFF OFF

Release

Initial image

Press ReleasePress

ON

Operation and 
view

Action OFF
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■ Multi-Function
Use this grid to add or edit commands to execute when the Multi-Button is pressed.

Function List: Lists the commands to be executed.
Command Type: Shows the command type.
Command Name: Shows the command name.
Device: Shows the setting when one of the following Command Type is selected.

Shows the destination device for the Bit Write and Word Write commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan of the Touch when the Multi-Button is pressed.

• If multiple Key commands are set, only the first and second Key commands in the Function List are 
executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

• The function of Key command will affect on the next scan when the trigger condition is satisfied.

Command Type: Select the command to add.
Bit Write: Writes a 0 or 1 to the bit device or bit of the word device. For details, refer to 

“Properties of Bit Write for Multi-Functions dialog box” on page 7-73. 
Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 

address or to perform operations on the written value. For details, refer to 
“Properties of Word Write for Multi-Functions dialog box” on page 7-74. 

Goto Screen: Switches to another screen or displays a window. For details, refer to “Properties 
of Goto Screen for Multi-Functions dialog box” on page 7-76. 

Key: Performs a variety of functions including uploading and downloading, copying 
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions dialog box” on page 7-78.

Script: Executes the script. For details, refer to “Properties of Script for Multi-Functions 
dialog box” on page 7-80.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function List.

Delete: Deletes a command from the list.
Select the command in the list, and then click this button.

Copy: Copies a command in the list.
Select a command in the list, and then click this button. A copy of the selected command is added 
to the end of the list.

Up: Shifts the selected command upward in the list.
Down: Shifts the selected command downward in the list.
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■ View Switching Method*1

Select how to display the ON/OFF status of the button.

*1 Advanced mode only

Button: Pressing the button changes the drawing object displayed.

Device: The drawing objects assigned to the OFF and ON states are displayed when the value of device is 0 
and 1, respectively. Specifies the device used to switch the drawing object display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

No Image: The button is not displayed on the screen. The button appears as a dashed line frame on the edit 
screen. Pressing the corresponding area on the Touch activates the assigned function. If No Image 
is selected, the settings for View and Registration Text are disabled.

Selecting Device in View Switching Method allows you to create an illuminated pushbutton.
The illuminated pushbutton switches state (or image) according to ON or OFF state of the device address, 
allowing you to display the state of a device that is being operated.

Example: When you set an external device address M0 as Device in View Switching Method, if the value 
of M0 changes, the display image will switched according to the value of M0 even if the button is 
not pressed.

0

M0

1

M0

Touch External device

View Switching Method (Device): M0

OFF image:

ON image:
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Properties of Bit Write for Multi-Functions dialog box

Sets the Bit Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Destination Device
Specify the destination bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write” on page 7-6.

■ Source Data
Specifies the device that stores the data to be written.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 7-6.

*1 Advanced mode only

Set: Pressing the button writes a 1 to the bit device.

Reset: Pressing the button writes a 0 to the bit device.

Set & Reset: Pressing the button writes a 1 to the bit device.
Releasing the button writes a 0 to the bit device.

Toggle: Pressing the button inverts the value of the bit device.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: Pressing the button writes the value in the source bit device to the value in the destination bit 
device.

For details about the Action Mode, refer to “Action Mode” on page 7-4. However, Set & Reset for the 
Multi-Button has the same function as Momentary for the Bit Button.

Device: Specify the source bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Transfer: Specify the number of bit devices (1 to 64) to transfer.
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Properties of Word Write for Multi-Functions dialog box

Sets the Word Write command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
BIN16(+) and BIN32(+) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Pressing the button writes a constant value to a word device.

Move: Pressing the button writes the value in the source device to the destination word device.

Set ON & OFF Data: Pressing the button writes the constant value of ON data to a word device.
Releasing the button writes the constant value of OFF data to a word device.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Pressing the button performs arithmetic on the value in a reference device and a constant 
value or the value in a device address and writes the result to a word device.

For details about the Action Mode, refer to “Action Mode” on page 7-21. However, Set ON & OFF Data 
for the Multi-Button has the same function as Momentary for the Word Button.

BIN16(+) and BIN32(+) can only be set if Action Mode is set to Move. Because the number of devices 
to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4, BCD8 or float32 is selected and the arithmetic data contains a value inexpressible in BCD, a 1 is 
written to System Area 2 Arithmetic error bit (address+2, bit 5) and an error message is displayed.
For details, refer to Chapter 3 “Arithmetic error” on page 3-25.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device

*1 Advanced mode only

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the button is 
ON, and the value in the OFF Data is written when the button is OFF.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values in 
hexadecimal.

Device: Use a word device.
Specify the device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the source word device 
according to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on 
page 2-4.

Transfer*1: Specify the number of word devices (1 to 64) to transfer.
This setting is enabled only if Action Mode is set to Move.
For details, refer to “Transfer” on page 7-23.

Destination Device: Specify the destination word device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device according
to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF Data.
For details, refer to “Write” on page 7-24.
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Properties of Goto Screen for Multi-Functions dialog box

Sets the Goto Screen command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the behavior of the Multi-Button from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Ladder Monitor: Opens the Ladder Monitor.

Close Ladder Monitor: Closes the Ladder Monitor.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust contrast Screen: Opens the Adjust contrast Screen.

Close Adjust contrast Screen: Closes the Adjust contrast Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

• Open Ladder Monitor and Close Ladder Monitor can only operate when ladder program is selected 
as the programming language in control function.

• When the current Base Screen is reset using the Reset current screen function, the window and 
internal devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen No.: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to
(from 1 to 3,000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3,015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device*1: Select this check box and specify a device to specify the screen 
number using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as 
the origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust contrast Screen, or Open Movie 
File Screen.

Use Reference Device*1: Select this check box and specify a device to specify the coordinates 
using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen.

With the HG2F/2S/3F/4F, window display coordinates are automatically adjusted to a position in multiples of
20 dots.
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Properties of Key for Multi-Functions dialog box

Sets the Key command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key command.

The settings explained below appear depending on the type of key selected.

■ Popup Screen No.
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

■ Scroll Size
Key Buttons Pg. Up and Pg. Dwn scroll the list up and down, respectively. Key Buttons Fcs. Up and Fcs. Dwn move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Pg. Up, Pg. Dwn, Fcs. Up, and Fcs. Dwn are selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to “4.5 Key Browser” on page 7-66.

(Key): Displays the name of the key selected using the Key Browser.

• When you select a key, the label for that key is assigned as the Registration Text.
• The function of Key command will affect on the next scan when the trigger condition is satisfied.
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■ Transfer Setting
Key commands Download Project and Upload Project perform the data transfer function specified by their 
names.
These settings specify the source, data to be transfered, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: This is set to the USB flash drive on which the project file to transfer (.ZNV) was saved.

File Path: Specify the path to the project file (.ZNV) to transfer. The maximum number is 247
characters.
Example: Where “FT_DEMO_1.ZNV” is a project file saved on the root directory of a USB 

flash drive:
FT_DEMO_1.ZNV

Source: Specify where to save the project uploaded from Touch. The location is the USB flash drive.

File Path: Specify the path to the folder where the uploaded project file will be saved. The maximum 
number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive:

Uploaded_Project
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Properties of Script for Multi-Functions dialog box

Sets the script command for the Multi-Button.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32,000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● View Tab
Only Coordinates and Size can be configured when No Image is selected for View Switching Method on the 
General tab.

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Blink
Select this check box if blinking is desired (alternating ON and OFF) when a part is ON.

Standard: Uses the default graphics contained within WindO/I-NV3.

Picture: Uses an image file saved in Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Blink

ON image

OFF image
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab
These options can only be configured when Button or Device is selected for View Switching Method on the 
General tab.

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.



5 Multi-Button

7-84 SmartAXIS Touch User’s Manual

■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Button is enabled and operational while the condition is satisfied. The Button is disabled and not operational 
while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Button is not operational.
While LM0 is 1, the condition is satisfied and the Button is operational.

Trigger Type: Selects the condition to enable the Button from the following.

Always Enabled: The Button is always enabled.

While ON: Enables the Button when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Always Enabled

Button state

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Button state
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While OFF: Enables the Button when the value of device is 0.

While satisfying the condition:

Enables the Button when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Button state

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Condition

Button state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ ON delay
Select this check box to use the ON delay function.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Time (x100 msec): Specify the length of time that the button must be held down before activation by selecting a 
value from 0 to 600 (units of 10 milliseconds).
The button activates after it is held down for a specified period of time.

Hold down for three seconds

Touch Touch

Button
Does not
operate

Button
Operates

This feature protects against mistaken operation by ensuring that the button will not be activated if touched 
accidentally.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.



5 Multi-Button

7-88 SmartAXIS Touch User’s Manual

Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Button on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Keypad is Used

A part comprised of Key Buttons. Enters numbers and characters into Numerical or Character Input parts.

• Entering numbers in the Numerical Input

• Entering characters in the Character Input

6 Keypad

1230

Touch

Numerical Input

Keypad

Touch

Character Input

Keypad

Do not use the Keypad part with the Goto Screen Button or a combination of Goto Screen Commands. For 
details, refer to “4 Key Button” on page 7-49.
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6.2 Keypad Configuration Procedure

This section describes the configuration procedure for Keypads.

1 On the Home tab, in the Parts group, click Buttons, and then click Keypad.

2 Click a point on the edit screen where you want to place the Keypad.

3 Double-click the dropped Keypad and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Keypad Properties dialog box is displayed until OK is clicked.
 Refer to “6.3 Properties of Keypad Dialog Box” on page 7-92.

After OK on the Keypad Properties dialog box is clicked, double clicking the Keypad thereafter displays the 
Properties dialog box for the Key Buttons as a group.
This allows editing of settings common to each button.
• View: “View Tab” on page 7-54
• Registration Text: “Registration Text Tab” on page 7-56
• Options: “Options Tab” on page 7-60

The Options tab only appears in Advanced mode. To switch to Advanced mode, click Advanced.
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6.3 Properties of Keypad Dialog Box

This section describes items and buttons in the Properties dialog box.

■ Browse
Select a prebuilt Keypad within WindO/I-NV3.
Displays the Standard Browser when clicked. Select numeric keys or character keys registered in the Standard 
Browser.

■ Button

■ Registration Text

■ Coordinates

Foreground Color, Background Color:

Select the foreground and background color to use for the Keypad (color: 256 colors, 
monochrome: 8 shades).
Displays the Color Palette when the Color button is clicked. Select a color from the Color 
Palette.

Pattern: Select a pattern to use for the Keypad.
Displays the Pattern Palette when the Pattern button is clicked. Select a pattern from the 
Pattern Palette.

Font: Select one of the following fonts to use for the text on the buttons.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.

Style: Select a character style: Regular or Bold.

Magnification W, H: Select the zoom factor (0.5, 1 to 8) to use on the text.
This setting is only enabled when Font is set to Japanese, European, Chinese, Taiwanese, 
Korean, Central European, Baltic or Cyrillic.

Text Color: Select the text color (color: 256 colors, monochrome: 8 shades).
Displays the Color Palette when the Color button is clicked. Select a color from the Color Palette.

X, Y: Specify the display coordinates of the Keypad.
X and Y specify the upper left corner of the Keypad using the upper left corner of the screen as 
the origin.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Keypad
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■ Size

W, H: Specify the size of the Keypad by specifying width and height.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Keypad
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7.1 How the Selector Switch is Used

Writes a 0 or 1 to a bit device. This is an exclusive control that only writes a single value as 1 and all other values as 0.

• Switching between two Run Modes (Manual and Auto)

• Switching between three Run Modes (Filling - Stop - Discharge)

7 Selector Switch

Automatic Manual

Automatic

Auto Manual

Auto Manual Auto Manual

R-button

Ch2Ch1

L-button

Knob

Press L-button to
switch to Auto.

Press R-button to
switch to Manual.

Operate 
manually

F S D F S D F S D

F S D

R-button

Ch3Ch2Ch1

L-button

Knob

Press L-button to
switch to Filling.

Switch to Stop.
(The operation varies based 

on the switch type.)

Press R-button to 
switch to Discharge.
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7.2 Selector Switch Configuration Procedure

This section describes the configuration procedure for Selector Switch buttons.

1 On the Home tab, in the Parts group, click Buttons, and then click Selector Switch.

2 Click a point on the edit screen where you want to place the Selector Switch.

3 Double-click the dropped Selector Switch and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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7.3 Properties of Selector Switch Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switch Type
The 2-notch action is as follows.
• When the knob is at Ch1 (left), pressing the right button switches the selector knob to Ch2 (right).

During this action, the device for Ch1 is set to 0 and Ch2 is set to 1.
• When the knob is at Ch2 (right), pressing the left button switches the selector knob to Ch1 (left).

During this action, the device for Ch1 is set to 1 and Ch2 is set to 0.

The 3-notch action is as follows.
• The knob behaves as follows for 3-Notch No-return, 3-Notch R-return, and 3-Notch L-return button:

- Press R-button: knob switches from Ch1 (left) -> Ch2 (middle) -> Ch3 (right), in that order.
- Press L-button: knob switches from Ch3 (right) -> Ch2 (middle) -> Ch1 (left), in that order.

• Switching the knob writes 1 to the device for the new knob position, and 0 to the devices for the other two 
channels.

Whether the knob returns and the direction it returns depends on the switch type.
Select the switch type from the following.

2-Notch No-return: The knob does not return when the operator's finger is released.

Release

Default state

Press R-button ReleasePress L-button

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written
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2-Notch R-return: After the knob switches from Ch1 to Ch2, it returns to Ch1 when the R-button is released.

2-Notch L-return: After the knob switches from Ch2 to Ch1, it returns to Ch2 when the L-button is released.

3-Notch No-return: The knob does not return when the operator's finger is released.

3-Notch R-return: • If the knob is switched to Ch3, it returns to Ch2 when the button is released.
• If the knob is switched to Ch1, or from Ch1 to Ch2, it stays where it is even if the button is 

released.

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press

0

1

1

0

Write Write

Ch1

 Ch2

Action

Operation 
and view

Data 
written

Release

Default state

Press R-button ReleasePress L-buttonReleasePress L-button

0

0

1

Ch1

 Ch2

0

1

0Ch3

1

0

0

WriteAction Write

Operation 
and view

Write

Data 
written

ReleasePress R-button ReleasePress R-buttonReleasePress L-button

Default state

0

0

1

1

0

0

0

1

0

0

1

0

Write Write WriteWrite

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written
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■ Notch
Register and edit the settings for each notch to each channel.

3-Notch L-return: • If the knob is switched to Ch1, it returns to Ch2 when the button is released.
• If the knob is switched to Ch2, or from Ch3 to Ch2, it stays where it is even if the button is 

released.

3-Notch Both-return: If the knob is switched to Ch1 or Ch3, it returns to Ch2 when the button is released.

Release

Default state

Press L-button ReleasePress L-buttonReleasePress R-button

0

11

0

1

00

1

0

Write Write Write Write

0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

Release

Default state

Press L-buttonReleasePress R-button

0

1

1

01

0

0

1

Write Write Write Write

0 0

0 0

Ch1

 Ch2

Ch3

Action

Operation 
and view

Data 
written

Use Text Manager: Select this check box to use the text registered in Text Manager as the Registration 
Text for each channel.

(List of Notch settings): This list shows the notch settings for each channel.

No.: Shows the channel to be output. The number of notches selected in the Switch 
Type determines the number of channels.
Double clicking the cell displays the Notch Settings dialog box where you can edit the 
notch settings. For details, refer to “Notch Settings dialog box” on page 7-100.

Device: Shows the destination bit device or bit in the destination word device.
Double clicking the cell displays the Device Address Settings dialog box where you 
can edit the device address. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Text: Shows the Registration Text for the channel.
Double clicking the cell displays the Unicode Input dialog box where you can edit the 
Registration Text.
If you select the Use Text Manager check box, the text ID is shown. Double 
clicking the cell displays Text Manager where you can edit the text.

Color: Shows the color of the Registration Text for the channel.
Double clicking the cell displays Color Palette. Select a color from the Color Palette.

Set: Registers or changes the notch settings. Selecting a number that has already been registered 
changes the existing notch settings.
Clicking Set displays the Notch Settings dialog box where you can configure the notch. For 
details, refer to “Notch Settings dialog box” on page 7-100.
Notches are always registered from Ch1.
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Insert: Inserts a notch setting entry above the currently selected position.
Select the channel number from the list where you want to insert the notch setting, and then 
click Insert. This displays the Notch Settings dialog box where you can configure the notch. 
The notch settings at the point of insertion shift down one line. Notch settings cannot be 
inserted if all channel numbers have a notch setting.

Remove: Deletes the registered notch setting from the list.
Select the channel number in the list, and then click Remove.

Default Position: Selects the default position of the knob when the Touch starts operation and the Selector 
Switch is first displayed on the screen.

Ch1: Makes Ch1 the default knob position. Writes 1 to the device 
configured for Ch1, writes 0 to the devices configured for the 
other channels.

Ch2: Makes Ch2 the default knob position. Writes 1 to the device 
configured for Ch2, writes 0 to the devices configured for the 
other channels.

Ch3: Makes Ch3 the default knob position. Writes 1 to the device 
configured for Ch3, writes 0 to the devices configured for the 
other channels.

Read from Destination Device: The position of the knob is determined by the value of 
device.

The default knob position is fixed for these two switch types because of the return functionality.
2- Notch R-return: Ch1
2-Note L-return, 3-Notch Both-return: Ch2

• If Default Position is Ch1, Ch2, or Ch3, the position of the knob does not change even if the value in 
the device configured for the channel changes, unless the change is caused by the buttons on the 
Selector Switch. If Default Position is Read from Destination Device, the position of the knob 
changes according to the value of device configured for the channel.

• When a Selector Switch is redisplayed immediately after switching the screen or when a hidden Selector 
Switch is redisplayed, values are not written to the destination devices for the channels.

• If the value in the device used to determine the default knob position contains an illegal value, the knob 
will be shown as follows:
- 2- Notch No-return: Ch1
- 3-Notch: Ch2



7 Selector Switch

7-100 SmartAXIS Touch User’s Manual

Notch Settings dialog box

This dialog configures a notch for a channel. If the channel has already been set with a notch, the setting is 
overwritten.

■ Destination Device
Specify the destination bit device or bit in the destination word device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Text
Enter the Registration Text for the channel.
The characters that can be entered depends on the font selected for Font on the Format tab. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

■ Text ID
To use the text registered in Text Manager as the Registration Text for the channel, specify the ID number from 1 to 
32,000.

Click  to display Text Manager.
This setting is only enabled if you select the Use Text Manager check box.

■ Text Color
Select the Registration Text color for the channel (color: 256 colors, monochrome: 8 shades).
Displays the Color Palette when the Color button is clicked. Select a color from the Color Palette.

To enter Unicode characters, click  to display the Unicode Input dialog box. Enter the characters in the 
Unicode Input dialog box, and then click OK.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Knob
Selects the knob color of the Selector Switch (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

■ Switch

Knob

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the 
Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to display the Pattern Palette. Select a pattern from 
the Pattern Palette.

Flange

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the 
Color Palette.

Pattern: Selects a pattern for the button.
Click the Pattern button to display the Pattern Palette. Select a pattern from 
the Pattern Palette.

Buttons
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.

■ Magnification
W, H: Selects the magnification (0.5, 1 to 8) for text display.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Selector Switch is enabled and operational while the condition is satisfied. The Selector Switch is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Selector Switch is not operational.
While LM0 is 1, the condition is satisfied and the Selector Switch is operational.

Trigger Type: Selects the condition to enable the Selector Switch from the following.

Always Enabled: The Selector Switch is always enabled.

While ON: Enables the Selector Switch when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Selector Switch 
state

Enabled

1

0

Value of Device

Disabled

Selector 
Switch state

Disabled DisabledEnabledEnabledEnabled
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While OFF: Enables the Selector Switch when the value of device is 0.

While satisfying the condition:

Enables the Selector Switch when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of Device

Selector 
Switch state

Disabled DisabledEnabled Enabled

Selector 
Switch state

DisabledDisabledDisabled Enabled Enabled Enabled

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab of 
the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Selector Switch on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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8.1 How the Potentiometer is Used

Writes a value to a word device by pressing a slider button.

• The slider display position increases and decreases while the button is depressed. The value of the slider at the 
displayed position is written to the device when the button is released.

The slider indicates the value written to the device. When the value is increased or decreased, the slider display 
position also changes.
The slider moves between a user-defined minimum and maximum value.
The input value increases and decreases while the button is depressed. The value of the slider at the displayed 
position is written to the device when the button is released.

8 Potentiometer

D0  : 0

Value of slider at 
displayed position

105

127

Value of slider at 
displayed position

D0  : 127

Touch

D0  :

Value of slider at 
displayed position

0

External device

0

Write to device

Default state Press R-button Release Press L-button Release

Operation 
and view

Slider StopMoves rightStop StopMoves left

Value Increases Decreases

Action Write Write

The slider display position does not change when the value of Destination Device changes unless it was 
changed by the Potentiometer buttons. However, immediately after the screen is switched and immediately 
after the part is displayed on the screen, the slider is displayed at the position specified by the value of 
Destination Device.
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8.2 Potentiometer Configuration Procedure

This section describes the configuration procedure for Potentiometer parts.

1 On the Home tab, in the Parts group, click Buttons, and then click Potentiometer.

2 Click a point on the edit screen where you want to place the Potentiometer.

3 Double-click the dropped Potentiometer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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8.3 Properties of Potentiometer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Data Type
Select the data type handled by the Potentiometer.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Minimum
Specify the minimum value that can be entered. The minimum value varies based on the data type.

■ Maximum
Specify the maximum value that can be entered. The maximum value varies based on the data type.

■ Destination Device
Specify the destination word device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Slider Color
Selects the slider color of the Potentiometer (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Slider

Plate color

Foreground Color, Background Color: Selects the foreground and background colors of the flange (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the 
Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to display the Pattern Palette. Select a pattern from 
the Pattern Palette.

Flange



SmartAXIS Touch User’s Manual 7-113

8 Potentiometer

7

Buttons

■ Switch

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the 
Color Palette.

Pattern: Selects a pattern for the button.
Click the Pattern button to display the Pattern Palette. Select a pattern from 
the Pattern Palette.

Buttons

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Potentiometer is enabled and operational while the condition is satisfied. The Potentiometer is disabled and not 
operational while the condition is not satisfied.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the Potentiometer is not operational.
While LM0 is 1, the condition is satisfied and the Potentiometer is operational.

Trigger Type: Selects the condition to enable the Potentiometer from the following.

Always Enabled: The Potentiometer is always enabled.

While ON: Enables the Potentiometer when the value of device is 1.

LM0:

Touch

0

LM0: 1

Button
Does not
operate

Button
Operates

Condition 
Not 

satisfied

Condition 
Satisfied

Enabled

Potentiometer 
state

1

0

Value of Device

Disabled Disabled DisabledEnabledEnabledEnabled

Potentiometer 
state



SmartAXIS Touch User’s Manual 7-115

8 Potentiometer

7

Buttons

While OFF: Enables the Potentiometer when the value of device is 0.

While satisfying the condition:

Enables the Potentiometer when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Disabled

Value of Device

Disabled DisabledEnabled Enabled

Potentiometer 
state

DisabledDisabledDisabled Enabled Enabled Enabled

Potentiometer 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

Since the display security group is Group A, User2 can view the buttons. But since the input security group is Group B, 
User2 cannot operate the buttons.
Suppose that the Password Screen is now opened and User3 logs in to the system. Group A buttons can be displayed, 
and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box under the System tab 
of the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Potentiometer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes the setup for the lamp parts and related Touch operations.

  

1.1 How the Pilot Lamp is Used

Pilot Lamp parts display drawing objects. The value of a bit device is used to switch the drawing object displayed.

• Switch and display pictures by the values of devices

Chapter 8 Lamps

1 Pilot Lamps

Touch
External device

0

1
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1.2 Pilot Lamp Configuration Procedure

This section describes the configuration procedure for Pilot Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Pilot Lamp.

2 Click a point on the Edit screen where you want to place the Pilot Lamp.

3 Double-click the dropped Pilot Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Pilot Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ >>OFF Text, >>ON Text
Applies the text entered in the Part Name field to the Text field under the OFF or ON fields on the Registration 
Text tab. This is used as the Registration Text when the lamp is OFF or ON.

■ Action Mode
Select the action when the part is ON.

To specify the Registration Text to use when the button is ON, select the Set by State check box on the 
Registration Text tab. If left unchecked, the same Registration Text assigned for the OFF state is 
displayed for the ON state as well.

No Blink (only ON): Displays the drawing object for the ON state when the trigger condition is satisfied.

Blink (ON + Blink): When the condition is satisfied and the value of the trigger device is 1, the object blinks 
(alternates between the drawing object for the ON and OFF states at fixed time interval). The 
blinking interval can be set with the Blinking Cycle setting on the System tab of the Project 
Settings dialog box.

Blink Trigger Device: Specify the bit device to cause the lamp to blink.
The lamp blinks when the value of device is 1. The action for No Blink 
applies when the value is 0.

Click  to display the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
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Example: When Action Mode is Blink (ON + Blink), Blink Trigger Device is M0, and on the Trigger Condition 
tab, Trigger Type is While ON, Device is LM0

0

Displayed drawing object

Trigger Condition: Device LM0 value 1 1 0

0Action Mode: Value in trigger device M0 0 1 1

Displays OFF 
drawing objectAction Displays ON 

drawing object Blinking Displays OFF 
drawing object

The lamp will neither turn on or blink if the trigger conditions are not met. Lamp trigger conditions are 
configured on the Trigger Condition tab.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser or Picture Manager, depending on the setting for Image Type.

■ OFF button, ON button
Displays the graphic when ON or OFF. Clicking the ON button or OFF button switches the image displayed on the 
View tab.

■ OFF, ON
Selects the color and pattern of the standard graphic when ON and OFF.

■ Not Display Image*1

Select this check box to display no drawing object in the OFF state.

*1 Advanced mode only

Standard: Uses the default graphic for WindO/I-NV3.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Foreground Color, Background Color:

Selects the foreground and background colors of the standard graphic (color: 256 colors, 
monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

If the Not Display Image check box is selected:
• The Recover Background function will always be enabled.
• Text set as registration text for the OFF state will be displayed.
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■ Recover Background*1

Select this check box to recover the background of the area where the picture had been displayed after the picture is 
switched. When this check box is cleared, the background is filled with the screen's Background Color.
When parts or drawings are arranged so they overlap the background of the Pilot Lamp (below), the background of 
parts and drawings is displayed as follows if the Pilot Lamp picture is hidden.

Can only be set when Picture is selected for Image Type.
However, when the background part is the Alarm List Display, Alarm Log Display, bar chart, line chart, or pie chart, 
the missing sections will remain.

■ Coordinates

■ Size

*1 Advanced mode only

Pilot Lamp

Check box cleared Check box selected

Drawing

Since background parts and 
drawings are redrawn, they 
return to their original state.

The screen is filled with 
Background Color, so 
background parts and 
drawings are missing.

If the Recover Background check box is selected, the number of parts that can be placed on a single 
screen decreases. If an error message appears when the Picture Display is displayed on the Touch, clear 
the Recover Background check box or reduce the number of parts.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.
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■ OFF, ON

Text: Inputs characters to be displayed on parts. The maximum number is 3,750 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Text ID: Specifies the Text Manager ID No. (1 to 32000) when using the text registered in Text Manager.

Click  to display Text Manager.

Can only be set when the Use Text Manager check box is selected.

Text Color: Selects the color of the text displayed on the part (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change to 
display the Font dialog box.
Can only be set when the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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● Trigger Condition Tab

The Pilot Lamp is on while the condition is satisfied, and it is off while the condition is not satisfied. The Pilot Lamp 
displays the ON graphic when on and it displays the OFF graphic when off.
Example: When Trigger Type is While ON and Device is LM0

When LM0 is 0, condition is not satisfied, so Lamp displays OFF graphic.
When LM0 is 1, condition is satisfied, so Lamp displays OFF graphic.

■ Trigger Type
Selects the condition to turn on the Pilot Lamp from the following.

LM0:

Touch

0

LM0: 1

Condition
Not satisfied

Condition
Satisfied

Lamp
Displays OFF graphic

Lamp
Displays ON graphic

While ON: Turns on the Pilot Lamp when the value of device is 1.

1

0

Value of Device

On Off

Pilot Lamp status

Off OffOn On
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■ Data Type
Selects the type of data handled by the conditional expression for the on condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as the on condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Specifies the conditional expression for the on condition.
This option can only be configured when While satisfying the condition is selected for Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment for the on condition. The maximum number is 80 characters.

While OFF: Turns on the Pilot Lamp when the value of device is 0.

While satisfying the condition: Turns on the Pilot Lamp when the condition is satisfied.

1

0

On On OnOff Off Off

Pilot Lamp status

Value of Device

On OffOff OffOn On

Pilot Lamp status

Condition

Satisfied

Not satisfied
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Pilot Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Multi-State Lamp is Used

Multi-state lamp parts display drawing objects. The value of a specified word device is used to switch the drawing 
object to be displayed.

• Switch and display pictures by the values of devices

2 Multi-State Lamps

External device
Touch

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

 State: 0State: 1State: 2
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2.2 Multi-State Lamp Configuration Procedure

This section describes the configuration procedure for Multi-State Lamps.

1 On the Home tab, in the Parts group, click Lamps, and then click Multi-State Lamp.

2 Click a point on the edit screen where you want to place the Multi-State Lamp.

3 Double-click the dropped Multi-State Lamp and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Multi-State Lamp Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specify the method to switch drawing objects from the following:

Bit: Switches the drawing object displayed, according to the status of the bits.
Example: When Bit is selected and the bits of trigger device D0 are allocated to the following pictures.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Trigger device D0 value

Picture

State:  0 State:  1State:  2

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

No picture
Display picture 

for bit 1
Display picture 

for bit 2

0001 0010 0100 1000 1110 1100

State:  0 State:  1 State:  1State:  2 State: 2

Picture to display

Trigger device D0 
bit state

Action

If multiple bits are 1, display 
the picture for the lowest 
order bit.

If all bits in the device are 0 or if a bit 
with no associated picture becomes 1, 
display nothing.
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■ Trigger Device
Specifies the word device to use as the condition for switching the drawing object.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Value: Switches the drawing object displayed, according to the value of the device.
Example: When Value is selected and the values of Trigger Device D0 are allocated to the following 

pictures.

Switches the picture to display according to the value of the device.

0 1 2Trigger device D0 value

Picture

State: 2State:  1State:  0

Display picture for 0 Display picture for 1 Display picture for 2 No picture

0 1 2 3

State:  0 State:  1 State: 2

Picture to display

Trigger device D0 value

Action

If the value of device 
has no picture associated 
with it, display nothing.
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● View Tab

■ Image Type
Select the type of graphic to be used to represent the part.

■ Recover Background*1

Select this check box to recover the background of the area where the picture had been displayed after the picture is 
switched. When this check box is cleared, the background is filled with the screen's Background Color.
When parts or drawings are arranged so they overlap the background of the Multi-State Lamp (below), the 
background of parts and drawings is displayed as follows if the Multi-State Lamp picture is hidden.

Can only be set when Picture is selected for Image Type.
However, when the background part is the Alarm List Display, Alarm Log Display, bar chart, line chart, or pie chart, 
the missing sections will remain.

*1 Advanced mode only

Standard: Uses the default graphic for WindO/I-NV3.

Picture: Uses an image file saved using Picture Manager.
For details about image file restrictions, refer to Chapter 2 “1.4 Available Image Files” on page 2-18.

Multi-State Lamp

Check box cleared Check box selected

Drawing

Since background parts and 
drawings are redrawn, they 
return to their original state.

The screen is filled with 
Background Color, so 
background parts and 
drawings are missing.

If the Recover Background check box is selected, the number of parts that can be placed on a single 
screen decreases. If an error message appears when the Multi-State Lamp is displayed on the Touch, clear 
the Recover Background check box or reduce the number of parts.
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Registration Text Tab

■ Font
Selects the font used for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.
Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Magnification

Can only be set when Font is set to Japanese, European, Chinese, Taiwanese, Korean, Central European, 
Baltic or Cyrillic.

■ Align Text Vertical
Selects text alignment in the vertical direction.
Top, Center, Bottom
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects text alignment in the horizontal direction.
Left, Center, Right, Center-Left
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Set by State
Select this check box if displaying different text when ON and OFF.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for text display.

W, H: Selects the magnification (0.5, 1 to 8) for text display.



SmartAXIS Touch User’s Manual 8-21

2 Multi-State Lamps

8

Lam
ps

● State Tab

■ Number of States
Specify the number of drawing objects (1 to 16) to display by switching.

■ Settings
Lists the state settings. The list shows various settings such as the state number and file name for the drawing object.

State: Shows the state number. Double clicking the cell displays the State Settings dialog box where 
you can edit the state settings. For details, refer to “State Settings dialog box” on page 8-22.

Image: Shows the name or a file name for a drawing object. Double clicking the cell opens the View 
Browser if Standard is selected under Image Type on the View tab, or Picture Manager if 
Picture is selected. This allows you to change the drawing object to display.

Text: Shows the registration text. Double clicking the cell displays the Unicode Input dialog box. If you 
selected the Use Text Manager check box on the Registration Text tab, the Text Manager 
dialog box will appear. This allows you to change the registration text.

Fg.Color, Bg.Color: Shows the foreground and background colors (color: 256 colors, monochrome: 8 shades) for 
standard images. Double clicking the cell opens the Color Palette where you can change the 
foreground and background colors. This setting can only be changed if Image Type is set to 
Standard on the View tab.

Pattern: Shows the pattern for standard images. Double clicking the cell opens the Pattern Palette where 
you can change the pattern of the image. This setting can only be changed if Image Type is set 
to Standard on the View tab.

Text Color Shows the color of the registration text. Double clicking the cell opens the Color Palette where 
you can change the color of the text.

Blink: Indicates whether to display the drawing object blinking or constantly lit. Double clicking the cell 
toggles between Y for yes and N for no.

Windows Font: Shows the currently set Windows Font. Double clicking the cell displays the Font Settings dialog 
box where you can change the Windows Font. This setting can only be changed when 
Windows is selected for Font on the Registration Text tab.

Set: Registers the state settings to the list. If you select a state number that is already registered, 
that number is overwritten with the new settings.
Click this button to display the State Settings dialog box. For details, refer to “State Settings 
dialog box” on page 8-22.

Insert: Inserts the settings in the position selected on the list.
Select a state number in the list, and then click this button to display the State Settings dialog 
box. The settings at the insertion point shift down one line. Settings cannot be inserted if all 
state numbers are configured.

Remove: Deletes the registered settings from the list.
Select a state number, and then click this button to delete the selected settings from the list.
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■ Image
Shows the image for the state number selected in the Settings list.

■ Copy to next State
Select this check box to register or change all state settings at once.
This option copies the current settings to all state numbers after the selected state number when the settings are set 
or changed.

State Settings dialog box

This dialog box sets the drawing object and registration text to display.

■ Image

■ Text
Enter the text to display. The maximum number is 3,750 characters.
The characters that can be entered depends on the font selected for Font on the Registration Text tab. For details, 
refer to Chapter 2 “1.2 Available Text” on page 2-5.
This setting is only enabled when the Use Text Manager check box is cleared on the Registration Text tab.

■ Text ID
To use the text registered in Text Manager, specify the ID number from 1 to 32000.
This setting is only enabled when the Use Text Manager check box is selected on the Registration Text tab.

■ Color

■ Windows Font
Specify the Windows Font to use.
The current settings are displayed by selecting Windows in the Font property on the Registration Text tab. To 
change the settings, click Change to display the Font Settings dialog box.
The text ID setting is only enabled if the Use Text Manager check box is cleared.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

Browse: Select the drawing object to use for the lamp part. Clicking this button opens the View Browser 
if Standard is selected under Image Type on the View tab, or Picture Manager if Picture is 
selected.

Image: Shows the selected drawing object.

Foreground Color, Background Color:
Select the foreground and background color to use for standard images (color: 256 colors, 
monochrome: 8 shades).
Clicking either button opens the Color Palette. Select a color from the Color Palette.

Pattern: Select the pattern for a standard image. Clicking this button opens the Pattern Palette. Select a 
pattern from the Pattern Palette.

Text Color: Select the text color (color: 256 colors, monochrome: 8 shades) for the registration text.
Clicking this button opens the Color Palette. Select a color from the Color Palette.

Blink: Select this check box to cause the image to blink (alternately display the ON and OFF drawing 
object at fixed time interval).
The blinking interval can be set with the Blinking Cycle setting on the System tab of the 
Project Settings dialog box.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-State Lamp on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to configure the Data Display parts and their operation on the Touch.

  

1.1 How the Numerical Input is Used

The Numerical Input features a display mode that displays the current value of device and an entry mode that enters 
a value using the keypad or key buttons and writes that value to a device. When the part is displayed on the screen, 
the Numerical Input is in display mode. To enter a value by pressing the keypad or key buttons, touch the Numerical 
Input to switch it to entry mode. In entry mode, the value of device is displayed until a value is entered.
The Numerical Input can perform the following functions.

• Write a value entered with the keypad or key buttons to a device

• Display the current value of device

• Enter and display decimal numbers

• Display the entered value as * (asterisk)

Chapter 9 Data Displays

1 Numerical Input

External device
Touch

999

999 D100: 999
Numerical Input

Standard keypad

External device
Touch

1234
D100: 1234

External device
Touch

12.30

12.3

12.30

External device
Touch

****
****

****
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1.2 Numerical Input Configuration Procedure

This section describes the configuration procedure for Numerical Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

2 Click a point on the edit screen where you want to place the Numerical Input.

3 Double-click the dropped Numerical Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Numerical Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Keypad
Configures the keypad for entering values in the Numerical Input.

*1 Advanced mode only

Use as Display for Keypad*1: Select this check box to only use the Numerical Input as a part to display the 
value entered with the keypad.

Type: According to the location where the keypad is configured, selects the type from the following.

Standard: Uses the standard keypad. The standard keypad is the keypad configured as 
the Popup Screen for the standard keypad (screen number 3000 to 3015).
This is the keypad for the type configured by Display Type.

Popup: Uses a keypad configured as a Popup Screen.

Current Screen: Uses the keypad configured on the same screen as the Numerical Input.

Screen No.: Specifies the screen number of the Popup Screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the Popup Screen configured as the keypad in 
a location where it will not overlap the Numerical Input.
This option can only be configured if Standard or Popup is selected for 
Type.

Coordinates X, Y: Specifies the display location of the Popup Screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the Popup Screen.
This option can only be configured when Popup is selected for Type and the Adjust location 
automatically check box is cleared.
Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)
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■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Data Type: Selects the type of data for the value.
The data type that can be configured differs according to Display Type. For the data 
types that can be configured, see the table for Digits.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

BIN16 (+), BIN16 (+/-) 1 to 5

BIN32 (+), BIN32 (+/-) 1 to 10

BCD4 1 to 4

BCD8 1 to 8

float32 1 to 10

Hexadecimal 
display

BIN16 (+) 1 to 4

BIN32 (+) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

If Data Type is BIN16(+), BIN16(+/-), BIN32(+), BIN32(+/-), BCD4, or BCD8 and the Display 
Floating Point check box is selected, a decimal value will be displayed on the Numerical Input when a 
decimal value is entered on the keypad in entry mode, but an integer is written to the device. In display 
mode, source data is an integer, but the value is displayed with a decimal point added at the number of 
floating digits configured for the Numerical Input.
However, if float32 is selected for Data Type, both the destination data and the source data are decimal 
values.
Example: When Display Type is configured as Decimal, Data Type is BIN16(+), the Display Floating 

Point check box is selected, Digits is 5, Floating Digits is 3, and Destination Device is D100

External device
Touch

12.345 D100: 12345
12.345

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is 
selected. The range of digits that can be set for the fractional part varies based on the 
display type and data type. The range of digits that can be set for the fractional part is as 
follows.

Display Type Data Type Floating Digits

Decimal display

BIN16 (+), BIN16 (+/-) 1 to Digits

BIN32 (+), BIN32 (+/-) 1 to Digits

BCD4 1 to Digits

BCD8 1 to Digits

float32 1 to 8

Hexadecimal 
display

BIN16 (+) --

BIN32 (+) --
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■ Input Method
These options specify the destination for entered values.

■ Always Entry Mode*1

Select this check box to enter values by pressing the keypad and key buttons without touching the Numerical Input 
displayed on the screen.
To display 0 on the Numerical Input until a value is entered, select the Start from 0 in Always Entry Mode of 
Numerical Input check box on the System tab in the Project Settings dialog box. To display the value of device, 
clear the Start from 0 in Always Entry Mode of Numerical Input check box.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry Mode check box is selected and the Start from 0 in Always Entry Mode of 

Numerical Input check box is selected on the System tab in the Project Settings dialog box

*1 Advanced mode only

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is 
selected.
Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34
When Floating Symbol is /(slash) 12/34

Floating Symbol is not reflected on the standard keypad. To change the decimal point symbol on the 
standard keypad, please change the keypad button.

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.
Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234
Not Display Sign: Select this check box to hide the - (negative) symbol when displaying negative values.

This option can only be configured when Data Type is BCD4, BCD8, or float32.

Destination Device: Specifies the word device to write the entered value to.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device by the 
value of this device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Enter a value

Display value being entered
(Entry mode)

Display 0
(Entry mode)

Press ENT

Write value to device
(Entry mode)

0

Action

Operations and display

999999

Value of Destination Device 99912341234

Not displayed on Numerical Input.

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured on a single 
screen.
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Example: When the Always Entry Mode check box is cleared

■ Focus is moved by ENT button*1

When multiple Numerical Inputs are configured on the screen, select this check box to continue entering values on 
each of the Numerical Inputs.
Each time ENT is pressed, the focus moves between the Numerical Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Numerical Inputs in the order to move the focus.
Example: When Numerical Input A and B are configured and the Focus is moved by ENT button check box for 

Numerical Input A is selected and the Focus is moved by ENT button check box for Numerical Input B is 
cleared

*1 Advanced mode only

Press Numerical Input Enter a value

Enter 999

Press ENT

Display value of 
device

(Entry mode)

Write value to device
(Entry mode)

Display value of 
device

(Display mode)

Display focus
(Entry mode)

Display value of 
device

(Display mode)

1234

Operations and 
display

1234 999

Value of 
Destination Device

Action

1234 999

999123412341234 999

Press Numerical Input A Enter a value Press ENT Enter a value Press ENT

Move focus from 
Numerical Input A to B

Write value of device
(Entry mode)

Display value of device 
(Display mode)

Display value of device 
(Display mode)

Display value of device 
(Entry mode)

Write value to device
(Entry mode)

Display value of device 
(Display mode)

Display value of device 
(Entry mode)

Display focus
(Entry mode)

Display focus
(Entry mode)

Display value of device 
(Display mode)

1234

567

1234

567

1234

567

999

567

999

567

999

567

999

333

999

333

567

1234

Operations 
and display

1234 999 999

567

1234 999

Numerical Input A 
Value of 

Destination Device

Numerical Input A
Action

Numerical Input B
Action

567

1234A

B

Numerical Input B 
Value of 

Destination Device

567

999

567 567

333

999

567

333

999

333

999

333
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■ Update the display by ENT button*1

Select this check box to display the current value unchanged and update the display when a value is entered and ENT 
is pressed.
When this check box is cleared, the display updates with each press of a number button to display the number being 
entered.

*1 Advanced mode only

When a value outside the input range is entered and ENT is pressed, “?” is shown in the display. The value 
is not written to the device.

Press Numerical Input Enter a value Press ENT

Display value of device 
(Entry mode)

Write value to device
(Entry mode)

Display value of device 
(Display mode)

Display focus
(Entry mode)

Display value of device 
(Display mode)

1234

Operations and display
1234 999 999

1234 999

Value of Destination Device

Numerical Input display

Keypad display

Action

1234 999

1234

1234

-

1234

1234

1234

1234

1234

999

999

999

999

999

999

-

Numerical Input

Keypad display
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Size
Selects the text size as 8x16 or 16x16.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Numerical Value with “*” *1

Select this check box to display the entered value as * (asterisks).
Nothing is displayed if the value of device is 0 when this check box is selected and the Suppress Zeros check box is 
selected on the General tab. When this check box is selected in entry mode, nothing is displayed until a value is 
entered from the key buttons or keypad. If ENT is pressed with nothing displayed, 0 is written to the destination 
device.

■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

*1 Advanced mode only

Text ID: Specifies the Text Manager ID No. (1 to 32000).

Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to enter or display.

Value: Specifies the minimum and/or the maximum as a constant.

Device: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device is selected, these options specify the source word devices.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

• Select BIN16(+), BIN16(+/-), BIN32(+), BIN32(+/-), BCD4 or BCD8 for Data Type under the 
General tab, and to display a fractional number specify the values of Minimum and Maximum as an 
integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of device to display exceeds the data range that can be processed for the data type selected 
under Data Format on the General tab, “?” is displayed.

• If the entered value exceeds the allowable range or if it exceeds the data range that can be processed for 
the data type selected under Data Format on the General tab, “?” is displayed and the value is not 
written to the device.
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■ When Data Over
These options configure the operation of the part when the value entered with the keypad exceeds the allowable 
range.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If you attempt to enter “140”, which is higher than the maximum of “100”, or “-10”, which is lower than the 
minimum of “0”, the value is not written and “?” is displayed. 1 is written to When Data Over report 
device LM0.

Report: Select this check box and specify the report device to write 1 in this device when the entered data or 
the value of device to display exceeds the allowable range.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Operations 
and 

display

0

0

Entered data

80

80

80

?????

10

10

80

Written data

140

10

?????

10

80 10

-10

Data over notification: LM0 10 0 1

Range: Value
    Minimum: 0
    Maximum: 100
When Data Over
    Report: Selected
    Report device: LM0
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Numerical Input is enabled and operational while the condition is satisfied. The Numerical Input is disabled and 
not operational while the condition is not satisfied.
Example: When Trigger Type is While ON, Device is LM0

While LM0 is 0, the condition is not satisfied and the Numerical Input is not operational.
While LM0 is 1, the condition is satisfied and the Numerical Input is operational.

Trigger Type: Selects the condition to enable the Numerical Input from the following.

Always Enabled: The Numerical Input is always enabled.

While ON:  Enables the Numerical Input when the value of device is 1.

LM0:

Touch

Condition 
Not 

satisfied

0

LM0:
Condition 
Satisfied

1 Operational

123

123

Not 
operational

Always Enabled

Numerical Input
state

123

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Numerical Input
state

123 123 123 123123 123
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While OFF: Enables the Numerical Input when the value of device is 0.

While satisfying the condition:

Enables the Numerical Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Numerical Input
state

123 123 123123 123 123

Satisfied

Not satisfied

Disabled Disabled DisabledEnabled Enabled Enabled

Numerical Input
state

Condition

123 123 123123 123 123
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Groups
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130

999

Line Chart and Bar Chart
Display: Group A

Numerical Input
Display: Group A
Input: Group B

Numerical Display
Display: None

Touch

130

Touch

130

999

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

User1 User2

Touch

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch

130130

999999

999

User2 User3

Touch

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Can operate
Button

Cannot operate
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■ Input with Arithmetic Operation
To apply arithmetic operations to values entered using a keypad and writing the results, select this check box and 
input the arithmetic formula.
Example: To divide the value of device when entered by 60

■ Display with Arithmetic Operation
To apply arithmetic operations to values of devices and writing the results, select this check box and input the 
arithmetic formula.
Example: To multiple the value of device when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

Data

Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.4 About the Priority of the Operator” on page 20-53.

External device Touch

D0 700

42000÷60

Write value of 
entered value 
divided by 60

42000

Numerical Input
Destination Device: D0
Input with Arithmetic Operation: @/60

Item Description

@
The device on which the arithmetic operation is performed is specified in the arithmetic formula. Only 
1 device can be set for an arithmetic operation.
The device is as specified for Destination Device under the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected using Data Format under the General 
tab. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Specifies the bit device or word device for the arithmetic formula.

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

External device Touch

D0 1234

1234×60

Display value 
multiplied by 60 for
the value of device

74040

Numerical Input
Destination Device: D0
Display with Arithmetic Operation: @*60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Examples of Arithmetic Formula Input

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered using the 
Keypad and write the result to the device.

To perform the arithmetic operation and display the result, add 1 to the value of device and display 
the result.

[LDR 0] + @ + 
100

To perform the arithmetic operation and input the result, add the value of LDR0 to the value entered 
using the Keypad and add 100, and write the result to the device.

To perform the arithmetic operation and display the result, add the value of LDR0 to the value of 
device and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical AND operation of the value 
entered using the Keypad and 3 to the device.

To perform the arithmetic operation and display the result, a logical AND operation of the value of 
device and 3 is displayed.

Item Description

To enable touch sounds on the Touch, select the Enable Touch Sound check box on the System tab in 
the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Numerical Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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1.4 How to Enter Values

Use the keypad or key buttons to write a value to a device with the Numerical Input. The input methods are as 
follows.

■ Pressing the Numerical Input and Entering Values from the Standard Keypad
Arrange a Numerical Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
Touch

1234

999

1234

999

999

D100: 1234

D100: 1234

D100: 999

999
D100: 999

Press Numerical Input

Write value 
to device

Press ENT

Display value of device 
(Entry mode)

Display value of device 
(Entry mode)

Close standard keypad

Display standard keypad

Enter "999"

Display value of device 
(Display mode)

Display value of device 
(Display mode)

When the following operations are performed, entry mode is canceled and the current value of device is 
displayed in the Numerical Input. To enter a value, press the Numerical Input again to set it to entry mode.
• CAN is pressed.
• When the Focus is moved by ENT button check box on the General tab is cleared, a value was 

written to the device by pressing ENT.
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■ Without Pressing the Numerical Input, Directly Entering Values from a Keypad on the Same Screen
Arrange a Numerical Input and a keypad on the same screen. In the properties dialog box for the Numerical Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

1.5 Advanced Usage

● Using the System Area
• When finished entering a value by pressing ENT, 1 is written to the System Area 2 Numerical Input setting 

complete bit (address+3, bit 0).

• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Numerical Input setting cancel 

bit (address+3, bit 1). However, if the keypad is closed by pressing  (close) on the Popup Screen's title bar or 
another Numerical Input is pressed before finished entering the value by pressing ENT, entry mode is canceled and 
1 is not written to the System Area 2 Numerical Input setting cancel bit (address+3, bit 1).

• To clear the System Area 2 Numerical Input setting complete bit or the Numerical Input setting cancel bit, write 1 
to System Area 1 Numerical Input setting clear bit (address+1, bit 10). To automatically clear these bits when the 
Numerical Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area automatically 
check box on the System tab in the Project Settings dialog box.

External device
Touch

999

1234
D100: 1234

D100: 999

999
D100: 999

Write value
 to device

Press ENT

Display value of device 
(Entry mode)

Display value of device 
(Entry mode)

Display value of device 
(Entry mode)

Enter "999"

If the System Area 2 Numerical Input setting complete bit (address+3, bit 0) is set to another function's 
execution condition, that function can be executed when ENT is pressed.
Example: To simultaneously close a Popup Screen when ENT is pressed

In the Properties of Goto Screen Command dialog box, on the General tab, select Close Popup 
Screen for Action Mode. On the Trigger Condition tab, select Rising-edge for Trigger 
Type, and configure Device as the System Area 2 Numerical Input setting complete bit 
(address+3, bit 0).
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2.1 How the Character Input is Used

The Character Input features a display mode that displays the character codes in current values of devices as text and 
an entry mode that enters text using the keypad or key buttons and writes the character codes for the entered text to 
devices. When the part is displayed on the screen, the Character Input is in display mode. To enter text by pressing 
the keypad or key buttons, touch the Character Input to switch it to entry mode.
The Character Input can perform the following functions.

• Write the character codes for text entered with the keypad or key buttons to devices

• Display the character codes in current values of devices as text

• Display entered text as * (asterisk)

2 Character Input

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’

‘I’ ‘E’

D102 : 

D103 : 

D104 : (NULL)‘S’

‘   ’ ‘S’

External device
Touch

FT  SERIES_

FT  SERIES
Character Input

Standard keypad

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

D102 : 

D103 : 

D104 : ‘S’ (NULL)

‘ I ’ ‘E’

‘E’ ‘R’

‘   ’ ‘S’

External device
Touch

FT  SERIES

External device
Touch

****

********
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2.2 Character Input Configuration Procedure

This section describes the configuration procedure for Character Inputs.

1 On the Home tab, in the Parts group, click Data Displays, and then click Character Input.

2 Click a point on the edit screen where you want to place the Character Input.

3 Double-click the dropped Character Input and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Character Input Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Keypad
Configures the keypad for entering text in the Character Input.

*1 Advanced mode only

Use as Display for Keypad*1: Select this check box to only use the Character Input as a part to display the 
text entered with the keypad.

Type: According to the location where the keypad is configured, selects the type from the following.

Standard: Uses the standard keypad. The standard keypad is the keypad configured as 
the Popup Screen for the standard keypad (screen number 3000 to 3015).

Popup: Uses a keypad configured as a Popup Screen.

Current Screen: Uses the keypad configured on the same screen as the Character Input.

Screen No.: Specifies the screen number of the Popup Screen configured as the keypad (1 to 3015).
This option can only be configured if Popup is selected for Type.

Adjust location automatically: Select this check box to display the Popup Screen configured as the keypad in a 
location where it will not overlap the Character Input.
This option can only be configured if Standard or Popup is selected for Type.

Coordinates X, Y: Specifies the display location of the Popup Screen configured as the keypad.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left 
corner of the Popup Screen.
This option can only be configured when Popup is selected for Type and the Adjust location 
automatically check box is cleared.
Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)
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■ Data Format
Specifies the digits to display.

■ Input Method
These options configure the destination for the character codes for the entered text.

■ Always Entry Mode*1

Select this check box to enter text by directly pressing the keypad and key buttons without touching the Character 
Input displayed on the screen.
This option can only be configured if Current Screen is selected for Type.
Example: When the Always Entry mode check box is selected

Example: When the Always Entry Mode check box is cleared

*1 Advanced mode only

Input Digits: Specifies the number of digits that can be entered with the Character Input (1 to 127).

Display Digits: Specifies the number of digits that can be displayed in the Character Input display (1 to 100).

Destination Device: Specifies the destination word device for the character codes for the entered text.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device by the 
value of this device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
For details on indirect writing, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.

Enter textPress CLR Press ENT

4944(Hex)

4543(Hex)

‘ I ’ ‘D’4654(Hex)‘F’ ‘T’ 4654(Hex)‘F’ ‘T’4654(Hex)‘F’ ‘T’

Display text being 
entered (Entry mode)

Display values of devices 
as text (Entry mode)

Display only focus
(Entry mode)

Write character codes to 
devices (Entry mode)

Enter IDECDeletes text

‘E’ ‘C’

IDEC_FT_ _ IDEC_

Action

Operations 
and display

Value of 
Destination Device

Only one Numerical Input or one Character Input set to Always Entry Mode can be configured on a single 
screen.

Enter text

Enter IDEC

Press Character Input Press ENT

4944(Hex)

4543(Hex)

‘ I ’ ‘D’

Display text being 
entered (Entry mode)

Display focus
(Entry mode)

Write character codes to 
devices (Entry mode)

4844(Hex)

4543(Hex)

‘ I ’ ‘D’

Display values of devices 
as text (Display mode)

Display values of devices 
as text (Display mode)

4654(Hex)‘F’ ‘T’ 4654(Hex)‘F’ ‘T’ 4654(Hex)‘F’ ‘T’

Press CLR

4654(Hex)‘F’ ‘T’

Display only focus
(Entry mode)

Deletes text

‘C’‘E’‘E’ ‘C’

IDEC_IDEC_FT_ IDECFT

Action

Operations 
and display

Value of 
Destination Device

_
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■ Focus is moved by ENT button*1

When multiple Character Inputs are configured on the screen, select this check box to continue entering text on each 
of the Character Inputs.
Each time ENT is pressed, the focus moves between the Character Inputs according to Focus Order. On the View 
tab, in the Screens group, click Focus Order, and then click the Character Inputs in the order to move the focus.
Example: When Character Input A and B are configured and the Focus is moved by ENT button check box for 

Character Input A is selected and the Focus is moved by ENT button check box for Character Input B is 
cleared

■ Update the display by ENT button*1

Select this check box to display the current text unchanged and update the display when text is entered and ENT is 
pressed.
When this check box is cleared, the display updates with each press of a character button to display the character 
being entered.

*1 Advanced mode only

Press Character Input A Enter text Press ENT

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4120(Hex)

4D49(Hex)

534D(Hex)

4152(Hex)

5400(Hex)

4654(Hex)‘F’ ‘T’

4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’

4654(Hex)‘F’ ‘T’

4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’

4654(Hex)‘F’ ‘T’

4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’ 4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’

4654(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’

4654(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4654(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

4352(Hex)

4100(Hex)

4D49(Hex)‘ I ’

‘R’

‘M’

‘C’

Enter text Press ENT

Display values of devices 

as text (Display mode)

Display focus

(Entry mode)

Display focus 

(Entry mode)

Display values of devices 

as text (Display mode)

Display values of devices 

as text (Display mode)

Move focus from 

Character Input A to B

Write character codes to 
devices (Entry mode)

Display text being 
entered (Entry mode)

Write character codes to 
devices (Entry mode)

4352(Hex)

4120(Hex)

4D49(Hex)

534D(Hex)

4152(Hex)

5400(Hex)

4654(Hex)

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

Press ENT

Display text being 
entered (Entry mode)

Display values of devices 

as text (Display mode)

‘T’

‘ I ’

‘R’

‘M’

‘C’

‘O’ ‘   ’

‘S’

‘A’ ‘R’

‘T’

‘F’ ‘T’

‘   ’ ‘S’

‘E’ ‘R’

‘ I ’ ‘E’

‘S’ (NULL)

‘F’ ‘T’

‘   ’ ‘S’

‘E’ ‘R’

‘ I ’ ‘E’

‘S’ (NULL)

‘F’ ‘T’

‘   ’ ‘S’

‘E’ ‘R’

‘ I ’ ‘E’

‘S’ (NULL)

‘F’ ‘T’

‘   ’ ‘S’

‘E’ ‘R’

‘ I ’ ‘E’

‘S’ (NULL)

(NULL)

‘A’ ‘R’

‘ I ’

‘R’

‘M’

‘C’

‘O’ ‘   ’

‘S’ ‘M’

‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)‘O’ (NULL)

‘   ’ ‘S’

‘E’ ‘R’

‘ I ’ ‘E’

‘S’ (NULL)

‘M’

(NULL)

Character Input A 
Action

Operations and 
display

FT_ FT  SERIES_ FT  SERIES_ MICRO_ 

A

B MICRO

FT

MICRO

FT_

MICRO

FT_

MICRO

FT SERIES_ FT SERIES

MICRO_

FT SERIES

MICRO_

FT SERIES

MICRO SMART_

MICRO  SMART_ MICRO  SMART_

Character Input B 
Action

Character Input A 
Value of 

Destiation Device

Character Input B 
Value of 

Destiation Device

FT SERIES

MICRO SMART

Press Character Input Enter text Press ENT

‘F’ ‘T’ 4654(Hex)

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

4654(Hex)‘F’ ‘T’ 4654(Hex)‘F’ ‘T’ 4654(Hex)‘F’ ‘T’ 4654(Hex)

2053(Hex)

4552(Hex)

4943(Hex)

5300(Hex)

Display values of devices 
as text (Display mode)

Display focus 
(Entry mode)

Display values of devices 
as text (Display mode)

Write character codes to 
devices (Entry mode)

Display text being 
entered (Entry mode)

FT

Hide

FT

FT

FT

FT SERIES

FT SERIES

FT SERIES

FT SERIES

Hide

‘S’ (NULL)

‘ I ’ ‘E’

‘E’ ‘R’

‘   ’ ‘S’

‘F’ ‘T’

‘S’ (NULL)

‘ I ’ ‘E’

‘E’ ‘R’

‘   ’ ‘S’

Action

Character Input 
display

Operations and 
display

FT_ FT  SERIES_ FT  SERIES_

Value of
Destination Device

FT FT_ FT_ FT SERIES_ FT SERIES

Keypad display
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font for displaying text from the following.
Japanese, European, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Size
Selects the text size as 8x16 or 16x16.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.
This option can configure the text color in display mode and in entry mode. However, for Entry Mode text color can 
be set only when the Reverse check box is cleared.

■ Reverse
Select this check box to reverse the text color and plate color during display mode when in entry mode.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Display Character with “*”*1

Select this check box to display the entered characters as * (asterisks).
If this check box is selected, nothing is displayed until a value is entered from the key buttons or keypad when the 
Character Input is in entry mode. If ENT is pressed with nothing displayed, 0 is written to the destination device.

■ Change Font with Device*1

Select this check box to change the font to display the text with a value of device.
The keypad (Popup Screen) can also be changed when Standard or Popup is selected for Type under Keypad on 
the General tab.

*1 Advanced mode only

Trigger Device: Specifies the word device (2 words) to use as the condition to change the font.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Example: With Trigger Device set to D100, to enter Central European text from Popup Screen 
100 using a Character Input for entering European text from the standard keypad 
(Popup Screen 3003)
Write 6 to D100 and 100 to D101.

Font number Popup Screen No.

1st word 3rd word2nd word Font number

1. Japanese
2. European
6. Central European
7. Baltic
8. Cyrillic

Popup Screen 
No.

1 to 3015
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

■ Input Condition
The Character Input is enabled and operational while the condition is satisfied. The Character Input is disabled and 
not operational while the condition is not satisfied.
Example: When Trigger Type is While ON, Device is LM0

While LM0 is 0, the condition is not satisfied and the Character Input is not operational.
While LM0 is 1, the condition is satisfied and the Character Input is operational.

Trigger Type: Selects the condition to enable the Character Input from the following.

Always Enabled: The Character Input is always enabled.

While ON:  Enables the Character Input when the value of device is 1.

LM0:

Touch

0

LM0: 1 Operational
Condition 
Satisfied

Condition 
Not 

satisfied

IDEC

IDEC

Not 
operational

Always Enabled

Character Input 
state

IDEC

1

0

Disabled Enabled Disabled DisabledEnabled Enabled

Value of Device

Character Input 
state

IDEC IDEC IDEC IDECIDEC IDEC
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While OFF: Enables the Character Input when the value of device is 0.

While satisfying the condition:

Enables the Character Input when the condition is satisfied.

Data Type: Selects the type of data handled by the conditional expression for the input condition.
This option can only be configured if While satisfying the condition is selected for Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as the input condition.
This option can only be configured when While ON or While OFF is selected for Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Specifies the conditional expression for the input condition.
This option can only be configured when While satisfying the condition is selected for Trigger 
Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Comment: Enter a comment for the input condition. The maximum number is 80 characters.

1

0

Enabled Enabled EnabledDisabled Disabled Disabled

Value of Device

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC

Disabled Disabled DisabledEnabled Enabled Enabled

Satisfied

Not satisfied

Condition

Character Input 
state

IDEC IDEC IDECIDEC IDEC IDEC
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Groups
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

■ No Touch Sound
This function is to disable touch sounds only for specified parts when the Touch makes touch sounds.
Select this check box to display disable touch sounds for this part.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130

FT  SERIES

Line Chart and Bar Chart
Display: Group A

Character Input
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch Touch Touch

130

FT  SERIES

User1 User2

130130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

FT  SERIES_

FT  SERIES_

FT  SERIES FT  SERIES

User2 User3

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Can operate

Button

Cannot operate

To enable touch sounds on the Touch, select the Enable Touch Sound check box on the System tab in 
the Project Settings dialog box.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Character Input on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.4 How to Enter Text

Use the keypad or key buttons to write character codes to devices with the Character Input. The input methods are as 
follows.

■ Pressing the Character Input and Entering Text from the Standard Keypad
Arrange a Character Input on the screen and in its properties dialog box, on the General tab, under Keypad, select 
Standard for Type.

External device
Touch

FT SERIE

FT SERIES_

FT

FT_

FT SERIES_

FT SERIES

D100 : 4654(Hex)‘F’ ‘T’

D100 : 4654(Hex)‘F’ ‘T’

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘S’ (NULL)

‘ I ’ ‘E’

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

Press Character Input

Write text character 
codes to devices

Press ENT

Display values of device as text 
(Entry mode)

Display values of device as text 
(Entry mode)

Close standard keypad

Display standard keypad

Enter text as 
"FT SERIES"

Display values of device as text 
(Display mode)

Display values of device as text 
(Display mode)

When the following operations are performed, entry mode is canceled and the current values of devices are 
displayed as character codes on the Character Input. To enter text, press the Character Input again to 
select it and set it to entry mode.
• CAN is pressed.
• When the Focus is moved by ENT button check box on the General tab is cleared, a value was 

written to the device by pressing ENT.
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■ Without Pressing the Character Input, Directly Entering Text from a Keypad on the Same Screen
Arrange a Character Input and a keypad on the same screen. In the properties dialog box for the Character Input, on 
the General tab, under Keypad, select Current Screen for Type and select the Always Entry Mode check box.

■ Changing the Language and Entering Text
Select the Change Font with Device check box on the Format tab in the properties dialog box.
It is convenient to use this setting together with the text group settings.
The font and Popup Screen with this setting will change simultaneously with the text group change and text can be 
entered with the same font as the text group.
Select the Use Dynamic Text check box in the Text Group Settings dialog box and specify the same device in 
Trigger Device as the Trigger Device for this setting.

2.5 String Data Storage Method

The entered text is stored in the upper byte and lower byte according to the Storage Method of String Data 
setting. Storage Method of String Data is configured on the System tab in the Project Settings dialog box.
For details, refer to Chapter 3 “3.1 System Tab” on page 3-19.

Example: When the destination device is LDR100 and the entered text is ABCDE

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

External device
Touch

FT_

FT SERIES_

FT SERIES

D100 : 4654(Hex)‘F’ ‘T’

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

D100 : 

D101 : 

4654(Hex)‘F’ ‘T’

2053(Hex)

4552(Hex)

4945(Hex)

5300(Hex)

‘E’ ‘R’D102 : 

D103 : 

D104 : 

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

‘   ’ ‘S’

‘ I ’ ‘E’

‘S’ (NULL)

Write text character 
codes to devices

Press ENT

Display values of device as text
(Entry mode)

Display values of device as text
(Entry mode)

Display values of device as text
(Entry mode)

Enter text as 
"FT SERIES"

Device
Stored value

Upper byte Lower byte
LDR100 'A' = 41 (Hex) 'B' = 42 (Hex)
LDR101 'C' = 43 (Hex) 'D' = 44 (Hex)
LDR102 'E' = 45 (Hex) 0

NULL terminating character

Device
Stored value

Upper byte Lower byte
LDR100 'B' = 42 (Hex) 'A' = 41 (Hex)
LDR101 'D' = 44 (Hex) 'C' = 43 (Hex)
LDR102 0 'E' = 45 (Hex)

NULL terminating character

When handling strings, 0 is written to the device as the NULL terminating character and treated as the end 
of the string.
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2.6 Advanced Usage

● Using the System Area
• When finished entering text by pressing ENT, 1 is written to the System Area 2 Character Input setting complete bit 

(address+3, bit 5).
• When CAN is pressed, entry mode is canceled and 1 is written to the System Area 2 Character Input setting cancel 

bit (address+3, bit 6). However, if the keypad is closed by pressing  (close) on the Popup Screen's title bar or 
another Character Input is pressed and selected before finished entering the text by pressing ENT, entry mode is 
canceled and 1 is not written to the System Area 2 Character Input setting cancel bit (address+3, bit 5).

• To clear the System Area 2 Character Input setting complete bit or the Character Input setting cancel bit, write 1 to 
System Area 1 Character Input setting clear bit (address+1, bit 11). To automatically clear these bits when the 
Character Input keypad is pressed in entry mode, select the Clear Keypad bit in System Area automatically 
check box on the System tab in the Project Settings dialog box.
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3.1 How the Picture Display is Used

The Picture Display displays pictures. It can change, move, or scale the displayed picture according to values of devices.

• Switch and display pictures by values of devices

3 Picture Display

External device
Touch

D0

bit15 bit0bit3

D0= 0100

bit0bit3

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

Pic0Pic1Pic2
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• Move the picture position by values of devices

• Scale the size of the picture by values of devices and display it

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

External device
Touch

Display picture at X 0, Y 0

Move picture to X 108, Y 45

Move picture to X 216, Y 90

X-coordinate D100= 0
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

X-coordinate D100=
Y-coordinate D101=

0

108
45

216
90

External device
Touch

Shrink picture to 
W 24, H 10

Scale picture to 
W 120, H 50

Scale picture to 
W 216, H 90

Width D100= 24
Height D101=

Width D100=
Height D101=

Width D100=
Height D101=

10

120
50

216
90
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3.2 Picture Display Configuration Procedure

This section describes the configuration procedure for Picture Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Picture Display.

2 Click a point on the edit screen where you want to place the Picture Display.

3 Double-click the dropped Picture Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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3.3 Properties of Picture Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Specifies the method for switching pictures to display from the following. Register pictures in Picture List on the 
View tab.

Bit: Switches the picture to display according to the status of bits in a device.
Example: When Bit is selected and the bits of trigger device D0 are allocated to the following 

pictures.

Switches the picture to display according to the status of the bits.

bit15 bit0bit3

Trigger device D0 

Picture

Pic0Pic1Pic2

0001

Picture to display

Trigger device D0 
bit state

0010 0100 1000

Display picture 
for bit 0

Display picture 
for bit 1

Display picture 
for bit 2

No picture
Display picture 

for bit 1
Display picture 

for bit 2
Action

1110 1100

Pic 0 Pic 1 Pic 1Pic 2 Pic 2

If all bits in the device are 0 or if a bit 
with no associated picture becomes 1, 
display nothing.

If multiple bits are 1, display 
the picture for the lowest 
order bit.
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■ Blink
Select this check box to flash the displayed pictures.

■ Dynamic Position*1

Select this check box to move and display the picture by specifying the coordinates of the picture as values of devices.

Example: When the X-coordinate is D100 and the Y-coordinate is D101
The picture is moved to the values of D100 and D101.

*1 Advanced mode only

Value: Switches the picture to display according to the value of device.
Example: When Value is selected and the values of Trigger Device D0 are allocated to the 

following pictures.

Switches the picture to display according to the value of device.

Trigger Device: Specifies the word device to use as the condition for switching pictures.

Click  to display the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
This option can only be configured when Bit or Value is selected.

0 1 2Trigger device D0 value

Picture

Pic2Pic1Pic0

Pic 1Pic 0 Pic 2

0

Picture to display

Trigger device D0 value 1 2 3

Display picture for 0Action Display picture for 1 Display picture for 2 No picture

If the value of device has 
no picture associated 
with it, display nothing.

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

X Point: Specifies the word device that is the X-coordinate of the picture.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Y Point: Specifies the word device that is the Y-coordinate of the picture.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

0
0

108

45   

216

90

Position of picture to display

Value of Y-coordinate device 
D101

Value of X-coordinate device 
D100 0

0

108

45

216

90
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■ Dynamic Size*1

Select this check box to scale the picture by specifying the size of the picture as values of devices.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Example: When the width device is D100 and the height device is D101
The picture is displayed with its size scaled to the values of D100 and D101.

*1 Advanced mode only

Width: Specifies the word device that is the width of the picture.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Height: Specifies the word device that is the height of the picture.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

When the size of pictures to switch differs and the Dynamic Size check box is cleared, all the pictures are 
displayed with the same size as Pic0.

When moving and scaling pictures, set the values of devices so the picture is not moved or scaled outside 
the screen's display area.

24

10

120

50

216

90

24

10

120

50

216

90

Size of picture to display

Value of Height device D101

Value of Width device D100
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● View Tab

■ Picture List
Registers the pictures to display on the Picture Display. The picture number (Pic number) and the file name of the 
registered picture are displayed in the list.

*1 Advanced mode only

Pic number

Set: Registers a picture to the list. If you select a Pic number with a picture that is already registered, that 
number is overwritten with the new picture.
Select a Pic number on the list, and then click this button to display Picture Manager. Specify the picture to 
register with Picture Manager.

Insert: Inserts the picture in the position selected on the list.
Select the Pic number on the list at the position to insert the picture, and then click this button to display 
Picture Manager. Specify the picture to insert. The picture at the insertion point shifts one Pic number 
down. The picture cannot be inserted when pictures are registered to all the Pic numbers.

Remove: Deletes the registered picture from the list.
Select a Pic number on the list, and then click this button to delete the selected picture from the list.

Up: Shifts the selected settings upward in the list.
Down: Shifts the selected settings downward in the list.
Recover Background*1:

Select this check box to recover the background of the area where the picture had been displayed after the 
picture is switched. When this check box is cleared, the background is filled with the screen's Background 
Color.
When parts or drawings are arranged so they overlap the background of the Picture Display (below), the 
background of parts and drawings is displayed as follows if the Picture Display picture is hidden.

However, when the background part is the Alarm List Display, Alarm Log Display, bar chart, line chart, or 
pie chart, the missing sections will remain.

Picture Display

Check box cleared Check box selected

Drawing

The screen is filled with 
Background Color, so 
background parts and 
drawings are missing.

Since background parts 
and drawings are 
redrawn, they return to 
their original state.



SmartAXIS Touch User’s Manual 9-47

3 Picture Display

9

D
ata D

isplays

■ Image
Displays picture for the Pic number that has been selected in the Picture List.

■ Coordinates

■ Size

If the Recover Background check box is selected, the number of parts that can be placed on a single 
screen decreases. If an error message appears when the Picture Display is displayed on the Touch screen, 
clear the Recover Background check box or reduce the number of parts.

• When the Dynamic Position check box or the Dynamic Size check box is selected on the General tab, 
the Recover Background check box cannot be selected.

• When the Recover Background check box and the Blink check box on the General tab are selected, 
the picture is repeatedly displayed and hidden.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 2 to (Base Screen horizontal size)

H: 2 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Picture Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Example: When Trigger Type is While ON, Device is LM0

While LM0 is 0, the condition is not satisfied and the Picture Display does not display the picture.
While LM0 is 1, the condition is satisfied and the Picture Display displays the picture.

■ Trigger Type
Selects the condition to enable the Picture Display from the following.

LM0:

Touch

0

LM0: 1

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
picture

Hide 
picture

Always Enabled: The Picture Display is always enabled.

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update Update Update Update Update
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While ON: Enables the Picture Display when the value of device is 1.
Example: When While not satisfying the condition is Not update Picture data

While OFF: Enables the Picture Display when the value of device is 0.
Example: When While not satisfying the condition is Not update Picture data

While satisfying the condition:
Enables the Picture Display when the condition is satisfied.
Example: When While not satisfying the condition is Not update Picture data

Value of Device
1

0

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Value of Device
1

0

Update Do not update Do not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update

UpdateDo not update Do not update Do not update

Display

Data Pic0 Pic1 Pic2 Pic0 Pic1 Pic2 Pic0

Update Update Update

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9



3 Picture Display

9-52 SmartAXIS Touch User’s Manual

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Picture Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Message Display is Used

The Message Display is used to constantly display messages registered in advance and to display text read from 
values of word devices as character codes.
The Message Display can perform the following functions.

• Display messages

• Display text according to value of devices

4 Message Display

Touch

Goal reached

External device
Touch

Goal

Goal 1234K

Goal 5678K

D100 : 

D101 : 

0031(Hex)

3233(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3132(Hex)‘1’ ‘2’

3334(Hex)

D102 : 4B00(Hex)

D100 : 

D101 : 

3536(Hex)‘5’ ‘6’

3738(Hex)

D102 : 4B00(Hex)

‘4’‘3’

‘K’

‘7’

(NULL) ‘1’

‘3’‘2’

‘8’

(NULL)

‘K’ (NULL)

‘K’ (NULL)

Always show Show according to 
value of devices

Goal          \

Message details

Display

D100

D101

D102

Display only always shown text
Do not show if upper byte of the Reference 
Device starting address is 00 (NULL)

Value of Reference 
Devices

Action

Display always shown text and text 
shown according to value of device

Display always shown text and text 
shown according to value of device

4B00(Hex)

3233(Hex)

0031(Hex)

4B00(Hex)

3334(Hex)

3132(Hex)

4B00(Hex)

3738(Hex)

3536(Hex)

‘3’ ‘4’

‘1’

‘7’ ‘8’

‘5’

‘2’ ‘3’

(NULL)

‘M’

‘6’‘2’ ‘1’

‘K’ (NULL) ‘K’ (NULL) ‘K’ (NULL)

GoalGoal     1234K Goal   5678K
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• Scroll messages

• Change the message and plate color according to a value of device

Touch

Line A

A : 1234K pcs.

pcs.        Line B

8K pcs.

Message details

Line A : 1234K pcs.        Line B : 5678K pcs.

External device
Touch

FT SERIES

FT SERIES

D0 : 

D0 : 

D0 : 

D0 : 

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

0 x 0 00 x F 7

Lower byteUpper byte

0 x 9 00 x F 7

Text colorPlate color

Text colorPlate color
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4.2 Message Display Configuration Procedure

This section describes the configuration procedure for Message Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Display.

2 Click a point on the edit screen where you want to place the Message Display.

3 Double-click the dropped Message Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Message Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.

To read values of word devices as character codes with text registered in Text Manager and display it as 
text, enter “\@” (1 to 8) in Text for the Text ID at the position to display the value of device as text. The 
channels configured under Data are allocated in order from the first “\@”. The text is displayed according to 
the values of devices in order from the first reference device.
However, in the following situations “\@” is not handled as text to display according to values of devices and 
is displayed unchanged.
• When Font is Windows for Text ID configured in Text Manager
• When the number of “\@” configured in Text for Text ID is greater than the number of channels 

configured with devices
(Text for the character codes corresponding to the values of devices is only displayed for the number of 
channels in order from the beginning.)
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■ Message
Enter the text to display. The maximum number is 610 characters. You can enter multi-line messages by inserting a 
newline. To configure text to display according to values of devices, enter “\@” (1 to 8) at the location to read the 
values of word devices as character codes and display them as text. The channels configured under Data are 
allocated in order from the first “\@”. The text is displayed according to the values of devices in order from the first 
reference device.
Example: The device configured in Ch1 is allocated to the first “\@”. The device configured in Ch2 is allocated to the 

second “\@”.

The characters that can be entered vary based on to the font selected for Font on the Format tab. For details, refer 
to Chapter 2 “1.2 Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

■ Data
These options are used to register or edit the devices with values to read as character codes.

Now    \

Goal    \

Always show Show according to values of devices

Ch1

Ch2

• To enter Unicode characters, click  to display the Unicode Input dialog box. Enter the characters in 
the Unicode Input dialog box, and then click OK.

• To display the backslash (\), enter a backslash (\) before the backslash (\).
Example:\\

(Settings): Lists the settings for the text to display according to values of devices.

No.: Shows the channel numbers (Ch1 to Ch8).

Device: Shows the reference device configured for the channel.

Words: Shows the number of words used by the reference device.

Reference Device: Specifies the word device that stores the values read as character codes.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
Set the values of devices to the character codes for the language used. For details, refer to 
Chapter 2 “Character Code Table” on page 2-14.

Words: Specifies the number of words for the length of the text to display (1 to 64). Values of devices 
for the configured amount of words are read as character codes starting from the device 
address set by Reference Device. 2 single-byte characters can be displayed by 1 word.

Set: Registers the settings for the text to display according to values of devices to the list. If you 
select a number that is already registered, that number is overwritten with the new settings.
Select a Ch number on the list, and then click this button to register the Reference Device 
and Words settings.
Always register the settings from Ch1.

Insert: Inserts the settings in the position selected on the list.
Select a Ch number on the list, and then click this button to insert the Reference Device and 
Words settings. The settings at the insertion point shift down one line. Settings cannot be 
inserted if all the Ch numbers are configured.

Remove: Deletes the registered settings from the list.
Select a Ch number, and then click this button to delete the selected settings from the list.
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.

■ Align Text depending on the length of the Displayed message*1

Select this check box to align text as standard to the number of characters that will be displayed.
When cleared, the maximum number of characters (set number of words) is always aligned as standard.
Example: When there are 2 characters of text to always display on the first line, 6 characters of text to always display 

on the second line and 6 characters of text (3 words) to display according to values of device, Align Text 
Horizontal is set to Center, and the text to display according to values of device is blank (when only 6 
characters are always displayed on the second line)

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

• When using text displayed according to values of devices, the characters are counted as single-byte 
characters and the display area for the characters is indicated by dotted lines. Therefore, when the text 
to display according to values of devices is double-byte characters, the display area actually required 
differs from the area indicated by the dotted lines.
Example: When 1 word of text to display according to values of devices is set to vertical writing, the 

vertical size of the dotted lines is displayed as 2 single-byte characters.

Aligned to 
left edge

Horizontal
display

Next
characters

2 single-byte chars. 1 double-byte char.

Dotted line frame is
2 chars. High

Check box: ClearedCheck box: Selected

Always show Show according to
values of device

E FCDAB E FCAB
AB

AB

D E FCAB
AB

D

Characters to show Maximum characters

1st line text :

2nd line text :

Blank
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■ Scroll*1

Select this check box to enable scrolling display displaying of messages.

*1 Advanced mode only

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of devices, the text color, or the displayed text changes, the 

message is scrolled from the beginning.

When the Scroll check box is selected, take care about the following points.
• This setting is only enabled when the Enable check box in the Blink group box on the Option tab is 

cleared.
• The number of parts that can be arranged on a single screen decreases. If the Touch displays an error 

message, clear the Scroll check box, or reduce the number of parts on the screen.
• When the scan time of the Touch is long, scrolling speed may become slow.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Message Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
When disabled, the plate and flange are displayed, but the message is not displayed. 
Example: When Trigger Type is While ON, Device is LM0

While LM0 is 0, the condition is not satisfied and the Message Display does not display the message.
While LM0 is 1, the condition is satisfied and the Message Display displays the message.

■ Trigger Type
Selects the condition to enable the Message Display from the following.

LM0:

Touch

0

LM0: 1
FT SERIES

Condition 
Not 

satisfied

Condition 
Satisfied

Show 

Hide

Always Enabled: The Message Display is always enabled.

Message Display 
state

Always show message

FT SERIES
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While ON: Enables the Message Display when the value of device is 1.
Example: When While not satisfying the condition is Not display message.

While OFF: Enables the Message Display when the value of device is 0.
Example: When While not satisfying the condition is Not display message.

While satisfying the condition:

Enables the Message Display when the condition is satisfied.
Example: When While not satisfying the condition is Not display message.

1

0

Show 
message

Hide 
message

Hide 
message

Hide 
message

FT SERIES

Show 
message

FT SERIES

Show 
message

FT SERIES

Show 
message

FT SERIES

Value of Device

Message Display 
state

Value of Device

1

0

Show 
message

Hide 
message

FT SERIES

Show 
message

FT SERIES

Show 
message

FT SERIES

Hide 
message

Hide 
message

Hide 
message

Message Switching 
Display state

Show 
message

Hide 
message

Hide 
message

Hide 
message

FT SERIES

Show 
message

FT SERIES

Show 
message

FT SERIES

Show 
message

FT SERIES

Message Display 
state

Satisfied

Not satisfied

Condition
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Change Color by Device
Switches the message or plate color.

Enable: Select this check box to switch the color of the message or plate depending on 
the value of device.

Device: Specifies the word device that stores the color data for the message or plate.

Click  to display the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
Color data assignments that are stored to devices are given below.

This uses address+1 to specify the text color and plate color when the Enable 
check box has been selected.
For color data, refer to Appendix “1 Color Number Correspondence Table” on 
page A-1.

D0=

Lower byteUpper byte

0 x 0 0

Lower byteUpper byte

0 x F 7

D0=

Lower byteUpper byte

0 x 9 00 x F 7

D0 0 x 0 00 x F 7

Lower byteUpper byte

D0 0 x 9 00 x F 7

FT SERIES

FT SERIES

TouchExternal device

Text colorPlate color

Text colorPlate color

Device

bit bit
15 8

bit
7

bit
0Upper byte

Plate colorAddress

Device

Text color

Plate color when blinkingAddress+1 Text color when blinking

Lower byte
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■ Blink
Flashes the message or plate color.

Enable: Turn this check box on to make messages flash.

Trigger device: Specifies the bit device that wlll be used as a condition to trigger flashing. 

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
When the value of device is 0, the color specified in Text Color on the Format tab or in Plate 
Color on the View tab will be displayed.
When the value of device is 1, the color displayed when the device is 0 and the color specified in 
Text Color or Plate Color will be displayed alternately.
Flash intervals are set in Blinking Cycle on the System tab in the Project Settings dialog box.

Text Color: This selects the color (color: 256 colors, monochrome: 8 shades) of text when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This can be set only when the Enable check box is cleared.

Plate Color: This selects the plate color (color: 256 colors, monochrome: 8 shades) when flashing.
Click this button to display the Color Palette. Select a color from the Color Palette.
This can be set only when the Enable check box is cleared.

TouchExternal device

0

1

FT SERIES

FT SERIES
FT SERIES

FT SERIES

Flashing

Trigger device

Text Color and Plate Color are specified in Device under Change Color by Device when the Enable 
check box has been selected in both Blink and Change Color by Device.
Example: When the Device is D0

FT SERIES

FT SERIES

Flashing

TouchExternal device

FT SERIES

FT SERIES

D0 0 x 0 00 x F 7

Lower byteUpper byte

D1 0 x F 70 x 2 3

Lower byteUpper byte

Text Color
Plate Color

Text color when blinking

Plate color when blinking

Text ColorPlate Color

Text color 
when blinking

Plate color 
when blinking

0

1

D0=

Lower byteUpper byte

0 x 0 00 x F 7

D1= 0 x F 70 x 2 3

Device

Trigger device
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■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Message Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.4 String Data Storage Method

The values of devices read as character codes are stored in the upper byte and lower byte of words according to the 
Storage Method of String Data setting. Storage Method of String Data is configured on the System tab in the 
Project Settings dialog box.
For details, refer to Chapter 3 “3.1 System Tab” on page 3-19.

Example: When reference device D100 = 3132 (Hex), D101 = 3334 (Hex), D102 = 3500 (Hex)

• When from Upper byte is selected for Storage Method of String Data

• When from Lower byte is selected for Storage Method of String Data

NULL terminating character

Device
Stored value

Displayed string
Upper byte Lower byte

D100 31 (Hex) 32 (Hex) 12
D101 33 (Hex) 34 (Hex) 34
D102 35 (Hex) 0 5

When handling values of devices as character 
codes, 0 is handled as the NULL terminating 
character to end the string. Therefore, when the 
upper byte is 0, nothing is displayed.

NULL terminating character

Device
Stored value

Displayed string
Upper byte Lower byte

D100 32 (Hex) 31 (Hex) 21
D101 34 (Hex) 33 (Hex) 43
D102 0 35 (Hex)

• When handling values of devices as character codes, 0 is handled as the NULL terminating character to 
end the string. Therefore, when the upper byte is 0, nothing is displayed.

• To display only a single character, set the lower byte to 0.
Example:To display a single-byte 7

3700(Hex)‘7’
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5.1 How the Message Switching Display is Used

The Message Switching Display is used to switch the displayed message according to the value of a word device.

5 Message Switching Display

External device
Touch

D0= 0001

bit0bit3

D0= 0010

bit0bit3

D0= 0100

bit0bit3

D0

bit15 bit0bit3

Msg0 Drying
Heating
Cooling

Msg1

Msg2

Message details
Drying

Heating

Cooling
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5.2 Message Switching Display Configuration Procedure

This section describes the configuration procedure for Message Switching Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Message Switching Display.

2 Click a point on the edit screen where you want to place the Message Switching Display.

3 Double-click the dropped Message Switching Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.



5 Message Switching Display

9-72 SmartAXIS Touch User’s Manual

5.3 Properties of Message Switching Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Switching Method
Selects the method for switching message to display from the following. Messages are registered in Settings on the 
Message tab.

Bit: Switches the message to display according to the status of bits in a device.
Example: When Bit is selected and the bits of trigger device D0 are allocated to the following messages.

Switches the message to display according to the status of the bits.

bit15 bit0bit3

Trigger Device D0 

Msg0 Drying
Heating
Cooling

Msg1

Msg2

Message

0001

Message to display

0010 0100 1000

Display Msg0Action Display Msg1 Display Msg2

1110

Display Msg1No message

Msg0 Msg1 Msg2 Msg1

Trigger Device D0 
bit state

Drying Heating Cooling Heating

If all bits in the device are 0 or if a bit with 
no associated message becomes 1, display 
nothing.

If multiple bits are 1, display the message for 
the lowest order bit.
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■ Trigger Device
Specifies the word device to use as the condition for switching messages.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Value: Switches the message to display according to the value of device.
Example: When Value is selected and the value of Trigger Device D0 are allocated to the following 

messages.

Switches the message to display according to the value of device.

0 :

1 :

2 :

Trigger Device D0 value Msg0 Drying
Heating
Cooling

Msg1

Msg2

Message details

0

Message to display

1 2 3

Display Msg0Action Display Msg1 Display Msg2 No message

Msg0 Msg1 Msg2

Trigger Device D0 value

Drying Heating Cooling

If the value of device has no message
associated with it, display nothing.
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● Message Tab

■ Use Text Manager
Select this check box to use text registered in Text Manager.

■ Settings
Lists the message settings.

■ Text ID
Specifies the Text Manager ID number (1 to 32000) when using text registered in Text Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.

■ Message
Enter the text to display. The maximum number is 3,750 characters. You can enter multi-line messages by inserting a 
newline.
The characters that can be entered vary based on the font selected for Font on the Format tab. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.
This option can only be configured if the Use Text Manager check box is cleared.

No.: Shows the message number (Msg number).
The number of messages that can be registered varies based on Switching Method on the 
General tab.

Bit: Msg0 to Msg15

Value: Msg0 to Msg999

Message: Shows the registered message.

Change: Shows Y when the Change Color check box is selected. Shows N when the check box is 
cleared.

Text: Shows the text color of the message.

Plate: Shows the plate color.

• To enter Unicode characters, click  to display the Unicode Input dialog box. Enter the characters in 
the Unicode Input dialog box, and then click OK.

• To display the backslash (\), enter a backslash (\) before the backslash (\).
Example: \\
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■ Change Color
Select this check box to configure Text Color and Plate Color per Msg number.

When this check box is cleared, the colors are configured by Text Color on the Format tab and Plate Color on the 
View tab.

■ Set
Registers the message and color settings to the list. If you select a Msg number that is already registered, that 
number is overwritten with the new settings.
Select a Msg number on the list, and then click this button to register the Message and Change Color settings.

■ Insert
Inserts the message and color settings in the position selected on the list.
Select a Msg number on the list, and then click this button to insert the Message and Change Color settings. The 
settings at the insertion point shift down one line. Settings cannot be inserted if all Msg numbers are configured.

■ Remove
Deletes the registered settings from the list.
Select a Msg number, and then click this button to delete the selected settings from the list.

Text Color: Selects the text color for the messages when configuring the text color per Msg number (color: 
256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Plate Color: Selects the plate color for the messages when configuring the plate color per Msg number 
(color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Font
Selects the font for displaying text from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text Horizontal
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Align Text Vertical
Selects the text alignment in the vertical direction from the following.
Top, Center, Bottom, Center-Top
Set to Center when the Vertical Writing check box is selected.
For details, refer to Appendix “5 Text Alignment” on page A-5.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Vertical Writing
Select this check box when displaying text vertically.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Scroll*1

Select this check box to enable scrolling display displaying of messages.

*1 Advanced mode only

When the Vertical Writing check box is selected, take care about the following points. This is applicable 
for Windows supports East Asian characters.
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left-

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
left edge

Horizontal
display

Next
characters

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the message is switched, the message is scrolled from the beginning.

When the Scroll check box is selected, take care about the following points.
• The number of parts that can be arranged on a single screen decreases. If the Touch displays an error 

message, clear the Scroll check box, or reduce the number of parts on the screen.
• When the scan time of the Touch is long, scrolling speed may become slow.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9



5 Message Switching Display

9-82 SmartAXIS Touch User’s Manual

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Message Switching Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Alarm List Display is Used

The Alarm List Display works with the Alarm Log function to display messages for active alarms and to display 
multiple messages according to values of devices in a list.

• List currently active alarms out of the alarms configured in the Alarm Log settings

• Display multiple messages according to values of devices

6 Alarm List Display

• Only one Alarm List Display or Alarm Log Display can be configured on a single screen.
• When the active alarm is displayed on the Alarm List Display, the message disappears from the list when 

the alarm is recovered from regardless of the Lock/Unlock setting. To display the alarm message until it 
can be checked, use the Alarm Log Display. Lock/Unlock is configured on the Channel tab in the Alarm 
Log Settings dialog box.

• For the key buttons used with the Alarm List Display, refer to Chapter 7 “Alarm List Display” on page 7-65.
• The number of the message (channel when using the Alarm function) that has focus on the Alarm List 

Display is stored in HMI Special Data Register LSD50.
• The information about where on the list the message that has focus is displayed, out of all the messages 

displayed on the Alarm List Display, is stored in HMI Special Data Register LSD56.

External device
Touch

Current fault Pg. Up

Pg. Dwn

Pump fault
Low air pressure

Pg. Up

Pg. Dwn

D0-0 : 
D0-1 : 
D0-2 : 
D0-3 : 

ID1 Current fault
ID2

ID3

ID4

Pump fault
High pressure
Low air pressure

Message

D0-0
Alarm occurred

0 1

D0-0

D0-1
Alarm occurred

0 1

D0-1

D0-3
Alarm occurred

0 1

D0-3

External device
Touch

Setting 1 : 100 Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

D0= 0001

bit0bit3

D0= 0111

bit0bit3

D0

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200
Setting 3 : 300

Message
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6.2 Alarm List Display Configuration Procedure

This section describes the configuration procedure for Alarm List Display.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

2 Click a point on the edit screen where you want to place the Alarm List Display.

3 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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6.3 Properties of Alarm List Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Message Settings
Selects the method for switching message to display.

Example: When Use Alarm Log Settings is selected, the Source (device to monitor) configured by the Alarm Log 
function is D0, and the following messages are allocated to the channels

The active alarm messages are displayed.

Use Alarm Log Settings: Displays messages for the active alarms. The alarms are configured by the Alarm Log 
settings.

Alarm Log Settings: Displays the Alarm Log Settings dialog box.

New Message List: Displays the messages registered in Text Manager according to the state of bits in the 
trigger device configured on the List tab.

D0-0 : 

D0-1 :  

D0-2 :  

D0-3 :  

ID1 Current fault
ID2

ID3

ID4

Pump fault
High pressure
Low air pressure

Message

Source

Message to display

Source bit state

D0-0

Display ID1Action Display ID2, ID3

1 0 1 1 0

D0-1 0 1 0 1 0

D0-2 0 1 1 1 0

D0-3 0 0 1 1 0

No messageDisplay ID1, ID2, 
ID3, ID4

Display ID1, ID3, 
ID4

Current fault Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Pump fault
High pressure

Pg. Up

Pg. Dwn

Current fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

Current fault
Pump fault
High pressure
Low air pressure

Pg. Up

Pg. Dwn

If all bits in the device are 0 or if a bit with no associated 
message becomes 1, display nothing.
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Example: When New Message List is selected and the bits of Trigger Device D0 are allocated to the following 
messages.

The messages are displayed according to the state of the bits.

■ Display Type
Selects whether or not to simultaneously display multiple messages.

■ Monitor Number of Displayed messages
Select this check box to count the number of displayed messages.
This option can only be configured when the New Message List check box is selected.

Trigger Device D0 

bit15 bit0bit3

ID1 Setting 1 : 100
ID2

ID3

Setting 2 : 200
Setting 3 : 300

Message

0001

Message to display

Trigger Device D0 
bit state

0110 0101 0111 0000

Display ID1 Display ID2, ID3 Display ID1, ID3 No messageAction
Display ID1, ID2, 

ID3

Setting 1 : 100 Pg. Up

Pg. Dwn

Pg. Up

Pg. Dwn

Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 3 : 300

Pg. Up

Pg. Dwn

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

If all bits in the device are 0 or if a bit with no associated 
message becomes 1, display nothing.

List: Simultaneously displays multiple messages.

Sort: Selects the display order when displaying multiple messages.
Old and New can only be configured when the Use Alarm Log Settings check box is selected.

Ascending: Sorts the list in alphabetic order from A to Z.

Descending: Sorts the list in alphabetic order from Z to A.

Old: Sorts the list in order from oldest to newest.

New: Sorts the list in order from newest to oldest.

One Line: Displays only a single message.
When multiple bits are 1, the message for the lowest order bit is displayed.

Message to display

Trigger Device D0 
bit state

0111

Action
Display ID1, ID2, 

ID3

Setting 1 : 100
Setting 2 : 200
Setting 3 : 300

Pg. Up

Pg. Dwn

0111

Message to display

Trigger Device D0
bit state

Display ID1Action

Setting 1 : 100 Pg. Up

Pg. Dwn

(Destination device): Specifies the word device to write the number of displayed messages to.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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● List Tab
The List tab is only displayed when New Message List is selected for Message Settings on the General tab.

■ Number of Blocks
Configures the devices that trigger messages to display and message switching as blocks (0 to 64).

■ Start Text ID
Specifies the Text Manager ID number (1 to 32000) of the message to display. The text ID numbers are sequentially 

configured for all channels from the first block starting with the ID number configured here. Click  to display Text 
Manager.

■ Device Setting Method
Selects the trigger device setting method.

■ (Block settings)
Registers and edits the messages to display for each block channel.

(Block settings)

1 block is composed of 16 channels. 1 device bit can be monitored for each channel. The maximum number 
of device bits that can be monitored is 16 for each block.

Serial: The trigger devices after the block number selected in the block settings are configured with 
sequential addresses.

Random: Configures trigger devices for each block number.

Block No.: Shows the block numbers in the amount specified by Number of Blocks.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to “Individual 
Settings Dialog Box” on page 9-88.

Trigger Device: Shows the word device to use as the condition to display messages.
Double clicking the cell displays the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
When Serial is selected for Device Setting Method, the trigger devices for block numbers after 
the selected block number are automatically configured with the configured trigger device as the 
starting address.

No. of Reg. Text: Shows the number of messages registered to the block.
Double clicking the cell displays the Individual Settings dialog box. For details, refer to “Individual 
Settings Dialog Box” on page 9-88.

Edit: Changes the block settings in list.
Select a block number in the list, and then click this button to display the Individual Settings dialog 
box. For details, refer to “Individual Settings Dialog Box” on page 9-88.
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Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the conditions to display the messages.

■ Trigger Device
Specifies the word device to use as the condition to display messages. The bit of the word device corresponds to the 
message numbers.
Example: When the number of blocks is 1 and D0 is specified as the trigger device

Message number 1-0 device bit is D0-0, message number 1-1 device bit is D0-1, up to message number 
1-15 device bit which is D0-15.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
When Serial is selected for Device Setting Method on the List tab, the trigger devices for block numbers after the 
block number being registered or edited are automatically changed with the configured trigger device as the starting 
address.

■ (Settings)

Insert: Inserts the block settings in the position selected on the list.
Select the block number at the position to insert the settings in the list, and then click this button to 
display the Individual Settings dialog box. For details, refer to “Individual Settings Dialog Box” on page 
9-88.
The settings at the insertion point shift down one line. Settings cannot be inserted if all block 
numbers are configured.

Delete: Deletes the registered settings from the list.
Select a block number on the list, and then click this button to delete the selected settings from the list.

(Settings)

D0-0
D0-1
D0-2

D0-14
D0-15

1-0
1-1
1-2

1-14
1-15

Block 1
16 channels

Msg. No. Device bit

Msg. No.: Displayed as (Block No.)-(Message No.).

Alarm function: Selects whether or not to use the alarm function. Double clicking the cell switches between 
Enable and Disable.

Enable: Monitors the state of the device bit configured for the channel and displays the message.

Disable: The device bit is not monitored and the message is not displayed.

NO/NC: Selects the alarm detection condition. Double clicking the cell switches between NO and NC.

NO: Displays the message when the monitored bit changes from 0 to 1.

NC: Displays the message when the monitored bit changes from 1 to 0.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message.
The text ID is sequentially configured starting with the text ID configured by Start Text ID on 
the List tab.

Text: Shows the text for the specified text ID.
Only shows the first line of text when the text registered to the text ID has multiple lines.
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select the check box and select line color (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color:

Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the 
Color Palette.

Pattern: Selects a pattern for the button.
Click the Pattern button to display the Pattern Palette. Select a pattern from 
the Pattern Palette.

Buttons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Display with Same Text Color
To set the text color for all messages to the same color, select this check box and select the text color to display 
(color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
When this check box is cleared, the color for messages is the text color configured in Text Manager.

W, H: Selects text magnification (0.5, 1 to 8).
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■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only

Set with Number of Lines:
Specifies the number of lines for the message to display for one alarm line.

Number of Lines: Enter the number of lines (1 to 10). To completely display a message that 
contains newlines, a number of lines that is equal to or greater than the number 
of message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.
Number of Lines Magnification H Height

1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.

Height (dots): Enter the height (8 to 160). To completely display a message, a height equal to 
or greater than Magnification H x 16 dots x the number of message lines is 
required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault 

has occurred

has occurred

Pump fault 

Current fault 

Pump fault 

When the message is two lines, 
The second line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is two lines, 
The second line is not shown.



SmartAXIS Touch User’s Manual 9-93

6 Alarm List Display

9

D
ata D

isplays

■ Scroll*1

Select this check box to enable scrolling display displaying of messages.
Can only be set when One Line is selected for Display Type under the General tab.

*1 Advanced mode only

Speed (1: Fastest): Sets the scrolling speed (1 to 10). 1 is fastest, 10 is slowest.

When the Scroll check box is selected operation is follows.
• Messages that include CRs are displayed without the CRs.
• Messages scroll in the direction in which the text is drawn.
• When the text displayed according to values of devices, the text color, the displayed text, or the alarm 

state changes, the message is scrolled from the beginning.

When the Scroll check box is selected, take care about the following points.
• The number of parts that can be arranged on a single screen decreases. If the Touch displays an error 

message, clear the Scroll check box, or reduce the number of parts on the screen.
• When the scan time of the Touch is long, scrolling speed may become slow.
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen
The Options tab is used to configure the reference screen. The reference screen is a Base Screen or Popup Screen 
associated with each individual message. The reference screen is displayed when the key button Ref. is pressed.

When displaying a reference screen, select either Base Screen or Popup Screen as the reference screen type.
When not displaying a reference, select Not Use.
This can only be set when New Message List has been selected in Message Settings on the General tab. When 
Use Alarm Log Settings has been selected, the screen type will become the one selected in Reference Screen on 
the Channel tab in the Alarm Log Settings dialog box.

■ Coordinates

(Reference screen list)

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Motor fault

Pump1 fault

REV

Up

Dwn

Del

Ref.

High pressure

Pump 1 fault

Key button Ref. Reference screenKey buttons Up and Dwn

1. Select a message displayed 
on the Alarm List Display 2. Press the key button Ref. Reference screen opens

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-left corner of 
the reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for Reference 
Screen.
Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)
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■ Screen No. Setting Method
Selects the setting method for the screen numbers on the reference screen list.

■ (Reference Screen List)
Displays a list reference screen numbers and screen titles that have been set to messages.

Serial: Continuously and automatically specifies screen numbers (1 to 3000) that are at or below the 
selected message number.

Example 1: When screen number “100” has been entered for message number 1-0.

Screen numbers “100”, “101”, “102”....are automatically specified in order from message 
number 1-0.

Example 2: When screen number “200” has been entered for message number 1-5.

Message numbers 1-0 to 1-4 are left unchanged and screen numbers “200”, “201”, 
“202”....are automatically specified in order from message number 1-5.

Random: Specifies a reference screen number (1 to 3000) for each message number.

Message No.: Displays the message number.

Screen No.: Displays the reference screen number.
The screen number can be set according to the Screen No. Setting Method. The screen number is 
specified in the screen number input dialog box that appears after double clicking on a cell. Enter a 
screen number (1 to 3000) into Screen No. and then click OK.

When there is not screen for the specified screen number a message confirming the creation of a new 
screen will appear.
If Yes is clicked, a screen will be created. If No is clicked, creating a screen is cancelled.

Title: Displays the title of a reference screen.
When editing a title, editing is performed in the Enter Title dialog box that appears after double 
clicking on a cell. Edit the title and then click OK. The maximum number is 40 characters.

The title can be edited only when the screen number has already been set.
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■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

• The security group for input can only be configured when there are grouped key buttons.
• For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on 

page 21-1.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Alarm List Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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7.1 How the Alarm Log Display is Used 

The Alarm Log Display displays Alarm Log data saved in the data storage area.

• List the message, the occurrence time, recovery time, and confirmation time for the alarms that have occurred

• Display the reference screen for alarms that have occurred

7 Alarm Log Display

Occurrence    Message    Recovered    Confirmed

Fcs. Up Fcs. Dwn Ref. REVERSE

12/01 12 : 00     Current fault          12 : 53                12 : 54

Touch

External device

Occurrence    Message   Recovered   Confirmed

Fcs.Up Fcs.Dwn Ref. REVERSE

12/01 12 : 00     Current fault        12 : 53                12 : 54

0 1

12 : 00

01

12 : 53

12 : 00
Alarm occurred

12 : 53     Recovered

12 : 54      Confirmed

Recovery time

Confirmation time

Message

Occurrence time

Show focus Move focus

Key Button

Display reference screen

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Reference screen

Only one Alarm List Display or Alarm Log Display can be configured on a single screen.

• For the key buttons used with the Alarm Log Display, refer to Chapter 7 “Alarm Log Display” on page 7-65.
• When the Operate the Alarm on List directly check box on the General tab in the Properties of Alarm 

Log Display dialog box is selected, a displayed alarm can be given focus by pressing it on the list.
• The number of lines from the start line to the selected line of the message displayed on the Alarm Log 

Display is stored in HMI Special Data Register LSD56.
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7.2 Alarm Log Display Configuration Procedure

This section describes the configuration procedure for Alarm Log Display.

1 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

2 Click a point on the edit screen where you want to place the Alarm Log Display.

3 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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7.3 Properties of Alarm Log Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Default Settings
These options configure the default settings when the Alarm Log Display is displayed.

■ Displaying Alarms*1

Select these check boxes for alarms to display on the Alarm Log Display.

*1 Advanced mode only

Start Line No.: Specifies what number alarm to display when multiple alarms have occurred.
The range that can be specified is 1 to 5,011.

Sort: Selects the display order for alarms that have occurred as Old or New.

Display Focus on List after changing Screens or occurring Alarms*1:
Select this check box to automatically display the focus at the first item in the list 
after switching screens and when an alarm occurs.

Display Reference Screen*1: Select this check box to automatically display the reference screen for the alarm 
that has focus under the following conditions.
When the focus is displayed
When the focus moves
When a new alarm occurs

Not Recovered and Unconfirmed Alarm: Displays active alarms that have not been recovered and confirmed.
Not Recovered and Confirmed Alarm: Displays alarms that have not been recovered but the key button CHECK 

has been pressed.
Recovered and Unconfirmed Alarm: Displays alarms that have been recovered but the key button CHECK has 

not been pressed.
Recovered and Confirmed Alarm: Displays alarms that have been recovered and the key button CHECK has 

been pressed.
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■ First Alarm*1

An alarm that occurs in a state where no alarms have occurred is called the first alarm. Select the check boxes for the 
operations to execute when the first alarm occurs.

■ Operate the Alarm on List directly*1

Select this check box to display the focus by pressing an alarm displayed on the list.
When an alarm is pressed with no focus displayed, the focus is displayed on that alarm.
When an alarm is pressed that does not have focus when the focus is displayed, the focus is moved to that alarm. 
The focus is no longer displayed when an alarm with focus is pressed.

■ Alarm Log Settings
Displays the Alarm Log Settings dialog box.

*1 Advanced mode only

Display First Alarm to 1st line on List: Always displays the first alarm on the first line of the list.

Change the color of First Alarm: Changes the text color of the first alarm according to the First Alarm 
Color setting. First Alarm Color is configured on the Format tab.
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● Log Tab

■ Show Items
Select these check boxes for the items to display on the Alarm Log Display.

■ (Show items detailed settings)
Each of the show items selected by the check boxes under Show Items can be configured in detail here.

(Show items detailed settings)

Title: Shows the titles on the first line of the list.

Occurrence Time: Shows the time the alarm occurred.

Recovery Time: Shows the time the alarm was recovered from.

Confirmation Time: Shows the time the alarm was confirmed by pressing the key button CHECK.

Occurrence    Message   Recovered   Confirmed

Fcs.Up Fcs.Dwn Ref. REVERSE

12/01 12 : 00     Current fault         12 : 53              12 : 54
Title

Recovery time

Confirmation time

Message

Occurrence time

Title: Enter the titles for the items to display. The maximum number is 20 characters.
Double clicking the cell displays the Unicode Input dialog box. Enter the characters in the 
Unicode Input dialog box, and then click OK.

Width: Specifies the number of characters to display (1 to 40). 1 is the width of a single-byte character, 
2 is the width of a double-byte character.

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM, non-display

Time: Selects the display type of the time from the following.
HH:MM, HH:MM:SS, non-display

• If the title contains a newline, the text after the newline is not displayed. However, if using a Windows 
font for the selected text ID, all the characters are displayed.

• If the title contains a language not supported as standard by the OS, the characters may be garbled when 
displaying the (Show items detailed settings). However, the downloaded data is correctly displayed.

• If you change the display type for Date or Time, the number for Width is automatically adjusted.
• The text color for Message changes according to the alarm state. The text color for Message is 

configured by Occurred Color, Recovered Color, and Confirmed Color on the Format tab.
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■ Title
Select this check box to use text registered in Text Manager for Title in the (Show items detailed settings). The 
Text ID message configured for Occurrence Time, Message, Recovery Time, and Confirmation Time is 
displayed in (Show Items detailed settings).

Text ID: Specifies the Text Manager ID number (1 to 32000) when using text registered in Text 
Manager.

Click  to display Text Manager.

This option can only be configured when the Use Text Manager check box is selected.
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Line Color
When lines are displayed, select the check box and select line color (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Lines

Foreground Color, Background Color:

Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Buttons

■ Coordinates

■ Size

Foreground Color, Background Color: Selects the foreground and background colors of the buttons (color: 256 
colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color 
Palette.

Pattern: Selects a pattern for the button.
Click this button to display the Pattern Palette. Select a pattern from the 
Pattern Palette.

Buttons

Can be set only when there are grouped Key Buttons.

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 20 to (Base Screen horizontal size)

H: 20 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Title Font
Select the font that will be used for the title from the following options.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 Available Text” on page 
2-5.

■ Title Color
Select the color (color: 256 colors, monochrome: 8 shades) of the text for titles.
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Occurred Color, Recovered Color, Confirmed Color, First Alarm Color*1

Select the color (color: 256 colors, monochrome: 8 shades) of the occurred alarm, recovered alarm, confirmed alarm 
and first alarm.
Click this button to display the Color Palette. Select a color from the Color Palette.

*1 Advanced mode only

W, H: Selects text magnification (0.5, 1 to 8).

Blink*1: Select this check box to flash alarms that are displayed on the list.
The flash interval is specified in Blinking Cycle on the System tab in the Project Settings dialog box.

Reverse*1: Select this check box to show in reverse, the text color and plate color of alarms that are displayed on 
the list.

Current fault Current faultCurrent fault

Current fault

Blink Reverse Blink and reverse

When the Key Button CHECK is pressed before recovering a triggered alarm, the alarm display will change 
from the Occurred Color to the Confirmed Color. After this, the alarm that has changed to the Confirmed 
Color will remain in that color and will not change to the Recovered Color even when recovered.
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■ Line Spacing*1

Selects the specification method for line spacing in the list and configures the line spacing.

*1 Advanced mode only

Set with Number of Lines:
Specifies the number of lines for the message to display for one alarm line.
Number of Lines: Enter the number of lines (1 to 10). To completely display a message that 

contains newlines, a number of lines that is equal to or greater than the number 
of message lines is required.

When you enter a value in Number of Lines, Height (dots) is automatically calculated according 
to the display area.
The relationship between the number of lines and the height (dots) is height (dots) = number of 
lines x magnification H x 16.

Number of Lines Magnification H Height

1 1× × 16 = 16 dots

Current fault 

Current fault 

has occurred
Pump fault 

Pump fault 

has occurred

2 1× × 16 =

Current fault 
has occurred

Pump fault 
has occurred

3 1× × 16 =

Current fault 
has occurred

has occurred
Pump fault 

3 2× × 16 =
Number of Lines Magnification H Height

Number of Lines Magnification H Height

32 dots

48 dots

Number of Lines Magnification H Height

96 dots

When the message is 2 lines, 
2nd line is not shown.

Since the alarm line spacing is adjusted with the number of lines for the message fixed, this option is 
convenient to use when displaying multi-line messages.

Set with Dots: Specifies the line spacing for the message to display for one alarm line in dots.
Height (dots): Enter the height (8 to 160). To completely display a message, a height equal to 

or greater than Magnification H x 16 dots x the number of message lines is 
required.

When Magnification H is 1
To display a one-line message, 1 x 16 = 16 dots, a height of 16 dots or higher is required.

To display a two-line message, 2 x 16 = 32 dots, a height of 32 dots or higher is required.

When Magnification H is 2
To display a one-line message, 1 x 32 = 32 dots, a height of 32 dots or higher is required.

To display a two-line message, 2 x 32 = 64 dots, a height of 64 dots or higher is required.

16 dots
Height

Current fault has occurred
Pump fault has occurred

Height Height
16 dots32 dots Current fault 

has occurred

has occurred

Pump fault 

Current fault 

Pump fault 

When the message is two lines, 
The second line is not shown.

Height

32 dots Current fault has occurred
Pump fault has occurred

Height

32 dots Current fault Current fault 
Pump fault 

Pump fault 

Height

64 dots

has occurred

has occurred

When the message is two lines, 
The second line is not shown.

Since only one line of the title is displayed, the title line spacing = 1 (number of lines) x Magnification H 
x 16, regardless of the Line Spacing setting.
Example: When Magnification H is 1, the title line spacing = 1 x 1 x 16 = 16 dots

When Magnification H is 2, the title line spacing = 1 x 2 x 16 = 32 dots
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● Options Tab

The Options tab is displayed in Advanced mode.

■ Reference Screen Settings
The Options tab is used to configure the reference screen. The reference screen is a Base Screen or Popup Screen 
associated with each individual message. The reference screen is displayed when the key button Ref. is pressed.

Reference Screen: Displays the type of screen selected in Reference Screen on the Channel tab in the Alarm 
Log Settings dialog box.

Click  to display the Alarm Log Settings dialog box.

When displaying a reference screen, select either Base Screen or Popup Screen as the 
reference screen type.
When not displaying a reference, select Not Use.

Coordinates X, Y: Specifies the coordinates to display the reference screen.
With the upper-left corner of the screen as the origin, the X and Y coordinates are the upper-
left corner of the reference screen.
This option can only be configured when Base Screen or Popup Screen is selected for 
Reference Screen.
Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Key button Ref. Reference screen

2. Press the key button Ref. Reference screen opens

Key buttons Up and Dwn

1. Select a message displayed on 
the Alarm Log Display

If you overlap the reference screen key button and the move focus key buttons, the reference screen can be 
switched and checked while moving the focus.
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■ Display Block No.
Specifies the range of block numbers that will display the collected alarm log data.

All: Displays the data for all blocks.

Block No.: Displays only the data for the specified blocks in the Alarm Log Display. Alarms in unspecified blocks are 
not displayed, even if active.
Individual block numbers can be specified by separating the numbers with “,”, continuous regions can be 
specified with “-”.

Example: When the number of blocks is 6, enter the following.

To specify blocks 1 to 3: 1-3

To specify blocks 1, 3, 6: 1, 3, 6

To specify blocks 1, 4 to 6: 1, 4-6

No. Device
1-0

1-1

1-2

1-13

1-14

1-15

D100-0

D100-1

D100-2

D100-13

D100-14

D100-15

2-0

2-1

2-2

2-13

2-14

2-15

D101-0

D101-1

D101-2

D101-13

D101-14

D101-15

Block 1

Block 2

5-0

5-1

5-2

5-13

5-14

5-15

D104-0

D104-1

D104-2

D104-13

D104-14

D104-15

Block 5

6-0

6-1

6-2

6-13

6-14

6-15

D105-0

D105-1

D105-2

D105-13

D105-14

D105-15

Block 6

Number of Blocks Specified numbers

1-36

Block 1

Block 2

Block  3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

Block 1

Block 2

Block 3

Block 4

Block 5

Block 6

1,  3,  6 1,  4-6

Blocks to display Blocks to display Blocks to display

• To display the alarms set in blocks 65 to 128 of the Alarm Log settings, select All under Display Block 
No.. If Block No. is selected, only blocks 1 to 64 can be specified.

• For the number of blocks, refer to Chapter 13 “Number of Blocks” on page 13-16.
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■ Security Groups
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

Input: Selects the security group for which operation of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

• The security group for input can only be configured when there are grouped key buttons.
• For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on 

page 21-1.

User Name

Security Group None Group A Group A, Group B

User1 User2 User3

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A
Input: Group B

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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Since the display security group is Group A, User 2 (of Group A) can view the buttons. But since the input security 
group is Group B, User 2 cannot operate the buttons.
Suppose that the Password Screen is now opened and a switch is made to User 3, who is part of both Group A and 
Group B. Group A buttons can be displayed, and Group B buttons can be operated.

Open Password Screen, 
enter password, 
and switch to User3.

For User2, 
Group A parts are displayed but 
Group B parts cannot be operated.

For User3, 
Group A parts are displayed and 
Group B parts can be operated.

Touch

130

Touch Touch

130130

User2 User3

Button

Can operate

ENT

BS CLR OK

Password
�User3

********
A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Button

Cannot operate
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Alarm Log Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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8.1 How the Numerical Display is Used 

The Numerical Display is used to display the value of a word device in the specified format.

• Display the current value of device

• Display the decimal point

• Display the unit

• Blink a value that exceeds the minimum or the maximum

8 Numerical Display

65535

-1

External device
Touch

D100 : FFFF

Display Device : D100
Display Type : Decimal
Data Type : BIN16(+)
Digits : 5

Display Device : D100
Display Type : Decimal
Data Type : BIN16(+/-)
Digits : 5

(Hex)

AD2

?

External device
Touch

D100 : 1234

Display Device : D100
Display Type : Hexadecimal
Data Type : BIN16(+)
Digits : 4

Display Device : D100
Display Type : Decimal
Data Type : BCD4
Digits : 4

(Decimal)

123.4

External device
Touch

D100 : 1234

Display Device : D100
Display Type : Decimal
Data Type : BIN16(+/-)
Digits : 4
Display Floating Point : On
Floating Digits : 1

(Decimal)

1234 pcs.

External device
Touch

D100 : 1234

Display Device : D100
Display Type : Decimal
Data Type : BIN16(+)
Digits : 4
With Unit : On
Text ID : 1
Text : pcs.

(Decimal)

120

External device
Touch

D100 : 120

Display Device : D100
Display Type : Decimal
Data Type : BIN16(+)
Digits : 3
Range : Value
    Minimum : 0
    Maximum : 100
When Data Over
    Blink : Selected

(Decimal)
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8.2 Numerical Display Configuration Procedure

This section describes the configuration procedure for Numerical Displays.

1 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

2 Click a point on the edit screen where you want to place the Numerical Display.

3 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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8.3 Properties of Numerical Display Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Display Type
Selects the display type for the value as Decimal or Hexadecimal.

■ Data Format

Data Type: Selects the type of data for the value.
The data type that can be configured differs according to Display Type. For the data 
types that can be configured, see the table for Digits.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Digits: Specifies the digits to display. The range of digits that can be set varies based on the 
display type and data type. The digits that can be set are as follows.

Display Type Data Type Digits

Decimal display

BIN16 (+), BIN16 (+/-) 1 to 5

BIN32 (+), BIN32 (+/-) 1 to 10

BCD4 1 to 4

BCD8 1 to 8

float32 1 to 10

Hexadecimal 
display

BIN16 (+) 1 to 4

BIN32 (+) 1 to 8

Display Floating Point: Select this check box to display the decimal point.

When the Display Floating Point check box is selected and BIN16(+), BIN16(+/-), BIN32(+), 
BIN32(+/-), BCD4, or BCD8 is selected for Data Type, the source data is an integer, but the value is 
displayed with the decimal point added at the configured floating digits.
However, if float32 is selected for Data Type, the source data is a decimal value.



SmartAXIS Touch User’s Manual 9-117

8 Numerical Display

9

D
ata D

isplays

■ Display Method
Specifies the source of the value to display.

*1 Advanced mode only

Floating Digits: Specifies the number of digits for the fractional part of the decimal value out of the 
number of digits specified by Digits.
This option can only be configured when the Display Floating Point check box is 
selected. The range of digits that can be set for the fractional part varies based on the 
display type and data type. The range of digits that can be set for the fractional part is as 
follows.

Display Type Data Type Floating Digits

Decimal display

BIN16 (+), BIN16 (+/-) 1 to Digits

BIN32 (+), BIN32 (+/-) 1 to Digits

BCD4 1 to Digits

BCD8 1 to Digits

float32 1 to 8

Hexadecimal 
display

BIN16 (+) --

BIN32 (+) --

Floating Symbol*1: Selects the decimal point symbol from the following.
.(dot), :(colon), ;(semicolon), ,(comma), /(slash)
This option can only be configured when the Display Floating Point check box is 
selected.

Example: When Digits is 4 and Floating Digits is 2

When Floating Symbol is .(dot) 12.34

When Floating Symbol is /(slash) 12/34

Suppress Zeros: Select this check box to hide “0” for the upper digits of the integer part.

Example: Suppress Zeros selected: 1234

Suppress Zeros cleared: 00001234

Not Display Sign: Select this check box to hide the - (negative) symbol when displaying negative values.
This option can only be configured when Data Type is BCD4, BCD8, or float32.

Display Device: Specifies the word device that stores the value to display.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the Display Device by the value of 
this device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
For details on indirect reading, refer to Chapter 2 “Indirect Read and Indirect Write 
Settings” on page 2-4.
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● View Tab
The View tab is used to configure the external form of the part including its color and shape.

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts



8 Numerical Display

9-120 SmartAXIS Touch User’s Manual

● Format Tab

■ Size
Selects the text size as 8x16 or 16x16.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ With Unit*1

Select this check box to display units or other characters at the end of a number. Displayed characters must be 
registered in Text Manager. The displayed text color will be as set for Text Color under the Format tab.

*1 Advanced mode only

W, H: Selects text magnification (0.5, 1 to 8).

Text ID: Specifies the Text Manager ID No. (1 to 32000).
Click  to display Text Manager.

Text: Displays the characters of the specified Text ID.

• The maximum number that can be displayed with this function is 4 characters. The fifth and subsequent 
characters of a character string are not displayed. However, if Windows Font is set for the specified Text 
ID characters all the characters are displayed.

• If a carriage return (CR) is included the characters after the CR are not displayed.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

Value: Specifies the minimum and/or the maximum as a constant.

Device: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device is selected, these options specify the source word devices.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

• Select BIN16(+), BIN16(+/-), BIN32(+), BIN32(+/-), BCD4 or BCD8 for Data Type under the 
General tab, and to display a fractional number specify the values of Minimum and Maximum as an 
integer.
Example: To set a value of “1.25” for the upper limit, enter “125”.

• If the value of device to display exceeds the data range that can be processed for the data type selected 
under Data Format on the General tab, “?” is displayed.



8 Numerical Display

9-122 SmartAXIS Touch User’s Manual

■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If the value of word device of the reading source is “120,” which is higher than the upper limit of “100,” or 
“-10,” which is below the lower limit of “0,” a value of 1 will be written to LM0 and the displayed numerical 
value will blink.

Blink: Select this check box to make the value blink when the displayed data exceeds the allowable 
range.

Report: Select this check box and specify the device to write 1 in the report device when the 
displayed data exceeds the allowable range.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

50 120 90

120

-10

9050 -10

Blinking Blinking

1 10 0

Range: Value
  Minimum: 0
  Maximum: 100
When Data Over
  Blink: Selected
  Report Device: LM0

Read data

Display

Data over notification: LM0
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Numerical Display is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. 
Select the operation when the condition is not satisfied as Not display Numerical data or Not update Numerical 
data under While not satisfying the condition. 
Example: When Trigger Type is While ON, Device is LM0, and While not satisfying the condition is Not 

display Numerical data
While LM0 is 0, the condition is not satisfied and the Numerical Display does not display the number.
While LM0 is 1, the condition is satisfied and the Numerical Display displays the number.

■ Trigger Type
Selects the condition to enable the Numerical Display from the following.

LM0:

Touch

0

LM0: 1
1234

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
number

Hide 
number

Data over does not operate for hidden Numerical Displays. Data over is reported if the minimum or 
maximum is exceeded when the Numerical Display changes from hidden to displayed.

Always Enabled: The Numerical Display is always enabled.

Display

Data 99 100 101 102 103 104 105

Update Update Update Update Update Update Update

99 100 101 102 103 104 105
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ While not satisfying the condition
Selects the operation of the Numerical Display when the condition is not satisfied.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While ON: Enables the Numerical Display when the value of device is 1.
Example: When While not satisfying the condition is Not update Numerical data

While OFF: Enables the Numerical Display when the value of device is 0.
Example: When While not satisfying the condition is Not update Numerical data

While satisfying the condition:

Enables the Numerical Display when the condition is satisfied.
Example: When While not satisfying the condition is Not update Numerical data

Value of Device
1

0

UpdateDo not update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update

0 100 100 102 103 103 103

Value of Device
1

0

Update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update Update

99 99 101 101 101 104 105

Update Do not update Do not update Do not update

Display

Data 99 100 101 102 103 104 105

Update Update Update

Satisfied

Not satisfied

Condition

99 99 101 101 101 104 105

Not display Numerical data: The plate and flange are displayed, but number is not displayed.

Not update Numerical data: The last updated number is displayed. The number does not change.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Example: If the user and security group for a part are set as follows:

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.

User Name

Security Group None Group A
User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None
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For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

■ Display with Arithmetic Operation
To apply arithmetic operations to values of devices and writing the results, select this check box and input the 
arithmetic formula.
Example: To multiple the value of device when displayed by 60

Arithmetic Formulas
Arithmetic formulas can be specified by freely combining multiple kinds of data and operators in the following format.

• There is no limit on the number of data items or number of operators. However, the maximum number is 120 
characters.

• Round brackets can be used.

Data

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9

Item Description

@
The device on which the arithmetic operation is performed is specified in the arithmetic formula. Only 
1 device can be set for an arithmetic operation.
The device is as specified for Display Device on the General tab.

Value
Sets the constant values for the arithmetic formula.
The values that can be set depend on the data type selected in Data Format on the General tab. 
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device Specifies the bit device or word device for the arithmetic formula.

External device Touch

D0 1234

1234×60

Display value 
multiplied by 60 for
the value of device

74040 Numerical Input
Destination Device: D0
Display with Arithmetic Operation: @*60

...(up to 120 characters)

OperatorData Data

OperatorData Data
to

Operator Data Operator Data Operator Data Operator Data
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Operators
Specify the type of arithmetic operation to be performed on the data. The operator priority is the same as for scripts. 
For details, refer to Chapter 20 “6.4 About the Priority of the Operator” on page 20-53.

Examples of Arithmetic Formula Input

Item Description

Arithmetic 
operators

Sets the arithmetic operators.

+ Addition Adds  and .

- Subtraction Subtracts  from .

* Multiplication Multiplies  and .

/ Division Divides  by .

% Modulo Calculates remainder after dividing  by .

Bit operator

Sets the bit operator.

& Logical AND Calculates the logical product (AND) of each bit of  and .

| Logical OR Calculates the logical sum (OR) of each bit of  and .

^ Logical XOR 
(exclusive OR)

Calculates the exclusive logical sum (XOR) of each bit of  and 
.

<< Left shift Shifts each bit of  to left by  bit(s).

>> Right shift Shifts each bit of  to right by  bit(s).

Input Examples Description

@ + 1

To perform the arithmetic operation and input the result, add 1 to the value entered using the 
Keypad and write the result to the device.

To perform the arithmetic operation and display the result, add 1 to the value of device and display 
the result.

[LDR0] + @ + 100

To perform the arithmetic operation and input the result, add the value of LDR0 to the value entered 
using the Keypad and add 100, and write the result to the device.

To perform the arithmetic operation and display the result, add the value of LDR0 to the value of 
device and add 100, then display the result.

@ & 3

To perform the arithmetic operation and input the result, write the logical AND operation of the value 
entered using the Keypad and 3 to the device.

To perform the arithmetic operation and display the result, a logical AND operation of the value of 
device and 3 is displayed.
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Numerical Display on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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9.1 How the Calendar is Used

The Calendar can be used to display the date and time using the Touch's clock data.

• Display the date and time

• Write 0 or 1 to a device at the configured times

9 Calendar

Touch

12/07 13:45

Touch
External device

ON Time : 10:00
OFF Time : 11:00

09:00

10:00

11:00

0 1

10:00

01

11:00

0

09:00

Report device M0

Action

Time 09:00 09:30 10:00 10:30 11:00

Write

Value of Report Device M0 10 0 1 0

Write

ON Time OFF Time

When Alarm is selected for Calendar Type, you can use just the alarm function without displaying the 
clock on the screen.
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9.2 Calendar Configuration Procedure

This section describes the configuration procedure for Calendars.

1 On the Home tab, in the Parts group, click Data Displays, and then click Calendar.

2 Click a point on the edit screen where you want to place the Calendar.

3 Double-click the dropped Calendar and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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9.3 Properties of Calendar Dialog Box

This section describes items and buttons on the properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Calendar Type
Selects the type of Calendar from the following.

■ Clock
These options configure the type and format of the clock. These options can only be configured when Clock or Clock 
& Alarm is selected for Calendar Type.

Clock: Displays the date and time.

Alarm: Notifies by writing 1 (ON Time) or 0 (OFF Time) to a device at the configured times without 
displaying the clock.

Clock & Alarm: Displays the clock and notifies by writing 1 (ON Time) or 0 (OFF Time) to a device at the configured 
times.

Clock Type: Selects the items to display for the clock from the following.
Time, Day of the Week & Time, Date & Time, Date & Day of the Week & Time

Date: Selects the display type of the date from the following.
YY/MM/DD, MM/DD/YY, DD/MM/YY, MM/DD, DD/MM
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Year: Selects the display type for the year as Double Figures or Four Figures.
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Month: Selects the display type for the month as 1/2/3/... or Jan/Feb/Mar/....
This option can only be configured when Date & Time or Date & Day of the Week & Time is 
selected for Clock Type.

Time: Selects the display type for the time as HH:MM or HH:MM:SS.
HH: hours, MM: minutes, SS: seconds
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● Alarm Tab
These options can only be configured when Alarm or Clock & Alarm is selected for Calendar Type on the 
General tab.

■ Alarm Time
Selects the type of data for the alarm time.

■ (Alarm conditions)
Select the check boxes for the conditions to use as the alarm time.
The Day of the Week check box can only be configured when the Year check box is cleared.

(Alarm conditions)

Value: Specifies the alarm time as values and the day of the week.

Year: Enter the year (0 to 99).

Month: Enter the month (1 to 12).

Day: Enter the day (1 to 31).

Day of the Week: Select the day of the week.

Hour: Enter the hour (0 to 23).

Minute: Enter the minute (0 to 59).

Second: Enter the second (0 to 59).

Device: Configures the alarm time as values of word device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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■ ON Time
Configures the time to write 1 to the report device according to the type of data.

■ OFF Time
Select this check box to configure the time to write 0 to the report device.
The time is configured according to the type of data.

■ Report Device
Specifies the bit device to write the value to at ON Time and OFF Time.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

• After 1 is written to the report time with ON Time, that value is retained.

• After a screen configured with the Calendar is displayed, if the time is in between ON Time and OFF 
Time, 1 is written to the report device.

Value of device retained after ON Time elapses

1

0

09:00 09:30 10:00 10:30 11:00

Value of 
Report Device M0

Time

ON Time

Turn on Touch power
Open screen

1

0

09:00 09:30 10:00 10:30 11:00

Value of 
Report Device M0

Time

ON Time

Writes 1 to notify that ON Time has already elapsed

OFF Time

• The value of Report Device is retained even when the current time exceeds OFF Time.

• After a screen configured with the Calendar is displayed, if the time exceeds OFF Time, 0 is written to the 
report device.

Value of device retained after OFF Time elapses
1

0

10:00 10:30 11:00 11:30 12:00

Value of 
Report Device M0

Time

OFF Time

Turn on Touch power
Open screen

Value of 
Report Device

1

0

Time
10:00 10:30 11:00 11:30 12:00

OFF Time

Writes 0 to notify that OFF Time has already elapsed

ON Time
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● View Tab

■ Browse
Select the type of graphic to represent the part from the list of graphics. Click this button to display the View Browser.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 256 
colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern Palette.

Flange
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■ Coordinates

■ Size

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts is defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Format Tab

■ Size
Selects the text size as 8x16 or 16x16.

■ Style
Selects Regular or Bold for text style.

■ Magnification

■ Align Text
Selects the text alignment in the horizontal direction from the following.
Left, Center, Right
For details, refer to Appendix “5 Text Alignment” on page A-5.

■ Text Color
Selects the color of displayed text (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

W, H: Selects text magnification (0.5, 1 to 8).
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The Calendar is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the time is not displayed. 
Example: When Trigger Type is While ON, Device is LM0

While LM0 is 0, the condition is not satisfied and the Calendar does not display the time.
While LM0 is 1, the condition is satisfied and the Calendar displays the time.

■ Trigger Type
Selects the condition to enable the Calendar from the following.

LM0:

Touch

0

LM0: 1
12/07 13:45

Condition 
Not 

satisfied

Condition 
Satisfied

Show 
time

Hide 
time

Always Enabled: The Calendar is always enabled.

12/07 13:45

Always show time

Calendar state
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While ON: Enables the Calendar when the value of device is 1.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While OFF: Enables the Calendar when the value of device is 0.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

While satisfying the condition:

Enables the Calendar when the condition is satisfied.
Example: When the Not show Calendar check box is cleared under While not satisfying the 

condition

12/07 13:45 12/07 13:45 12/07 13:45 12/07 13:45

1

0

Show timeHide time Hide time Hide timeShow time Show time Show time

Value of Device

Calendar state

Value of Device

1

0

Show timeHide timeShow time Show timeHide time Hide time Hide time

Calendar state
12/07 13:45 12/07 13:45 12/07 13:45

Show timeHide time Show time Hide time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Show time

12/07 13:45

Condition

Satisfied

Not satisfied

Calendar state
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User 1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and a switch is made to User 2 of Group A, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Calendar on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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Charts

This chapter describes how to configure charts and meters and their operation on the Touch.

  

1.1 How the Bar Chart is Used

Bar charts and peak charts can be used to display values of word devices.

• Display values of word devices in a bar chart

• Display values of word devices in a peak chart

• Make the chart blink when the displayed data exceeds the maximum or minimum

Chapter 10 Charts

1 Bar Chart

External device
Touch

D100 : -50

D200 : 120

D300 : 40

External device
Touch

D100 : -50

D200 : 120

D300 : 40

External device
Touch

Range: Value
Minimum : 0
Maximum : 100
When Data Over
   Blink: Selected

D100 : 20

D200 : 80

D300 : 40

D100 : -50

D200 : 90

D300 : 120
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1.2 Bar Chart Configuration Procedure

This section describes the configuration procedure for bar charts.

1 On the Home tab, in the Parts group, click Charts, and then click Bar Chart.

2 Click a point on the edit screen where you want to place the Bar Chart.

3 Double-click the dropped Bar Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Scale tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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1.3 Properties of Bar Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following items.
Horizontal Bar, Vertical Bar, Horizontal Peak, Vertical Peak
Peak charts only display the tip of the bar chart.

Horizontal Bar Horizontal Peak
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■ Data Format

*1 Advanced mode only

Data Type: Selects the data type handled by the chart.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

(Data Type)*1: Selects the type of data used for entering values in Origin, Minimum, and Maximum.

Value: Uses a constant.

Device: Uses a word device.

Origin, Minimum, Maximum: Specifies the origin, minimum, and maximum for the chart.
The origin, minimum, and maximum that can be specified during Basic mode and when 
Value is selected vary based on the data type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.
When Device is selected, these options specify the source word devices.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

If the data displayed in the chart is invalid, 1 is written to System Area 2 Arithmetic error bit (address+2, bit 
5), and an error message is displayed. For details, refer to Chapter 3 “ Arithmetic error” on page 3-25. 
Invalid data is as follows.
• When the minimum is the same as or larger than the maximum
• When the source data includes A through F if Data Type is BCD4 or BCD8
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● Data Tab

■ Settings
Lists the chart settings. The list shows the numbers, reference devices, and colors for the chart.

*1 Advanced mode only

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar and Horizontal Peak, the numbers are listed in order from top. For 
Vertical Bar and Vertical Peak, the numbers are listed in order from the left.

Device: Shows the source word device for the data to display in the chart.

Fg. Normal: Shows the foreground color of the chart when normal.

Fg. Over*1: Shows the foreground color of the chart when data over.

Bg. Normal: Shows the background color of the chart when normal.

Bg. Over*1: Shows the background color of the chart when data over.

Pattern: Shows the chart pattern.

Horizontal Bar

Vertical Bar

Ch1

Ch1 Ch2 Ch3

Ch2

Ch3
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■ Reference Device
Specifies the source word device for the data to display in the chart.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Foreground Color

■ Background Color

■ Pattern
Selects the chart pattern.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Set
Registers the chart settings to the list. If you select a Ch number that is already registered, that number is overwritten 
with the new settings.
Select a Ch number on the list, and then click this button to register the Reference Device, Foreground Color, 
Background Color, and Pattern settings.

■ Insert
Inserts the chart settings in the position selected on the list.
Select a Ch number on the list, and then click this button to insert the Reference Device, Foreground Color, 
Background Color, and Pattern settings. The settings at the insertion point shift down one line. Settings cannot be 
inserted if all Ch numbers are configured.

■ Remove
Deletes the registered settings from the list.
Select a Ch number, and then click this button to delete the selected settings from the list.

*1 Advanced mode only

Normal, Data Over*1: Selects the foreground color for the chart when normal and when data over (color: 256 
colors, monochrome: 8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.

Normal, Data Over*1: Selects the background color for the chart when normal and when data over (color: 256 
colors, monochrome: 8 shades).
Click either button to display the Color Palette. Select a color from the Color Palette.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

Plate color

Foreground Color, Background Color:

Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to open the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange
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■ Space between Bars*1

Specifies the spacing for the bar chart (0 to 100 dots).

■ Coordinates

■ Size

*1 Advanced mode only

Example: If Space between Bars is 10 If Space between Bars is 0

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing

Chart spacing

100 2000

Scale not shown Show scale

10 dots

10 dots

10 dots

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
Select data type.

Specifies the allowable range of values to display.

Value: Specifies the minimum and/or the maximum as a constant.

Device: Specifies the minimum and/or the maximum as a value of word device.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified when Value is selected vary based on the 
data type selected with Data Format on the General tab. For details on data types, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
When Device is selected, these options specify the source word devices.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.



1 Bar Chart

10-10 SmartAXIS Touch User’s Manual

■ When Data Over
These options configure the operation of the part when the allowable range is exceeded.
These options can only be configured when the Minimum or Maximum check boxes are selected under Range.

Example: If the value of word device of the reading source is “110,” which is higher than the upper limit of “100,” or 
“-10,” which is below the lower limit of “0,” a value of 1 will be written to LM0 and the displayed bar will 
blink.

Blink: Select this check box to make the chart blink when the displayed data exceeds the allowable range.

Report: Select this check box to write 1 in the report device when the displayed data exceeds the allowable 
range.

Report Device: Specifies the report device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-
61.

Ch1 data 60

Ch2 data

Ch1
Ch2

10

10 0 1

Display

20

110

50

80

10 -10

Blinking Blinking

Range: Value
   Minimum: 0
   Maximum: 100
When Data Over
   Blink: Selected

   Report Device: LM0

Data over notification: LM0

100500 100500 100500 100500
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● Scale Tab
The Scale tab is displayed in Advanced mode.

The options on the Scale tab vary based on the type selected with Chart Type on the General tab.
Horizontal Bar, Horizontal Peak: X-Axis
Vertical Bar, Vertical Peak: Y-Axis

■ Show Ticks
Select this check box to display a scale on a chart.

Major Divisions: Enter the number of major scale divisions (1 to 20).

Minor Divisions: Enter the number of minor scale divisions (1 to 20).

Show Tick Numbers: Select this check box to display numbers along the scale. The values are displayed in the same 
color as the scale.
This can only be set if Value is selected for Data Format under the General tab.

Color: Selects the color of scales (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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■ Show Gridline
Select this check box to display grid lines on the chart. Grid lines are displayed above the chart.

■ Show Label
Select this check box to display labels on the scale.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for labels.

Display Position: Select from Scale and Data Over to specify the grid line display position.
Scale: Grid lines are displayed according to the number of major scale divisions.

Can only be set when the Show Ticks check box is selected.

Data Over: Grid lines are displayed at the positions of values specified for Maximum and 
Minimum under the Data Over tab.
This option can only be configured when Data Format on the General tab and 
Range on the Data Over tab are set to Value.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Grid line

MaximumMinimum

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32,000) when text registered in Text Manager are used for 
labels.

Click  to display Text Manager.
Can only be set when the Use Text Manager check box is selected.

Text: Inputs characters to be displayed for labels. The maximum number is 40 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.
Can only be input when the Use Text Manager check box is cleared.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

If a carriage return (CR) is included, the characters after the CR are not displayed. However, if Windows 
Font is set for the specified Text ID, all the characters are displayed.



SmartAXIS Touch User’s Manual 10-13

1 Bar Chart

10

Charts

● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The bar chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. Select 
the operation when the condition is not satisfied as Not display Chart data or Not update Chart data under 
While not satisfying the condition.
Example: When Trigger Type is While ON, Device is LM0, and While not satisfying the condition is Not display Chart data

While LM0 is 0, the condition is not satisfied and the bar chart is not displayed.
While LM0 is 1, the condition is satisfied and the bar chart is displayed.

■ Trigger Type
Selects the condition to enable the bar chart from the following.

LM0:

Touch

Condition 
Not 

satisfied

0

LM0:
Condition 
Satisfied

1
Show chart

Hide chart

100500

100500

Data over does not operate for hidden bar charts. Data over is reported if the minimum or maximum is 
exceeded when the bar chart changes from hidden to displayed.

Always Enabled: The bar chart is always enabled.

Ch1 data 50

Ch2 data

Display

10

60

30

70

50

80

70

90

90

Update Update Update Update Update

100500 100500 100500 100500 100500
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

While ON: Enables the bar chart when the value of device is 1.
Example: When While not satisfying the condition is Not update Chart data

While OFF: Enables the bar chart when the value of device is 0.
Example: When While not satisfying the condition is Not update Chart data

While satisfying the condition:

Enables the bar chart when the condition is satisfied.
Example: When While not satisfying the condition is Not update Chart data

Value of Device

1

0

Ch1 data 50

Ch2 data

Display

10

Update

60

30

70

50

Update

80

70

Update

90

90

Do not update Do not update

100500 100500 100500 100500 100500

Value of Device

1

0

Update

Ch1 data 50

Ch2 data

Display

10

60

30

Update

70

50

Update

80

70

90

90

Do not update Do not update

100500 100500 100500 100500 100500

Update Do not update Do not update

Ch1 data 50

Ch2 data

Display

10

60

30

Update

70

50

Update

80

70

90

90

Condition

Satisfied

Not satisfied

100500 100500 100500 100500 100500
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■ While not satisfying the condition
Selects operation of the Bar Chart when condition is not satisfied.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

Not display Chart data: The plate and flange are displayed, but Bar Chart is not displayed.

Not update Chart data: The last updated Bar Chart is displayed. The Bar Chart does not change.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the bar chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Line Chart is Used

The line chart can be used to display values of devices sampled with the Data Log function and the values of multiple 
word devices.

• Display the values of devices sampled with the Data Log function in a trend chart

• Display the values of multiple, continuous devices in a single line chart

2 Line Chart

External device
Touch

D100
60

80

70

70

90

D101
30

40

40

50

70

D102
10

10

20

10

10 0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

There are two types of trend charts, a normal trend chart and a pen recorder trend chart.

External device
Touch

D100 : 1

D101 : 5

D102 : 10

D103 : 50

D104 : 20

D105 : 60

D106 : 10

0

20

40

60

80

100

-20
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2.2 Line Chart Configuration Procedure

This section describes the configuration procedure for Line Charts.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you want to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Data Over tab, Scale tab, Trigger Condition tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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2.3 Properties of Line Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Selects the type of chart from the following.

Log Trend (Normal): Shows values of devices sampled with the Data Log function in a trend chart. The 
displayed chart is updated each time the latest data is sampled and the latest data is 
charted from the left edge. If the sampled data exceeds the number of display points, 
the entire chart is shifted to the left by the configured scroll size and the display is 
updated.
Example: When Display Points is 5 and Scroll Size is 1

Ch1 data 30

Ch2 data 10

Display

80

30

90

40

110

40

110

30

5

Action

0

Scroll, 

display point 6
Display point 1 Display point 2 Display point 3 Display point 4 Display point 5

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120
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Example: When the starting address is D100
The display updates when the value of D100 changes from 0 to 1. The display is erased when the value 
changes to 2. The display is first erased and then updated when the value changes to 3.

Log Trend (Pen Recorder): Shows values of devices sampled with the Data Log function in a trend chart. The 
displayed chart is updated each time the latest data is sampled and the latest data is 
always displayed at the right edge. The entire chart shifts to the left point by point 
and the display is updated.
Example: When Display Points is 5

Scroll, 
display point 6Display point 1 Display point 2 Display point 3 Display point 4 Display point 5

30

10

80

30

90

40

110

40

110

30

5

0

Ch1 data

Ch2 data

Display

Action 

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

0

20

40

60

80

100

-20

120

The chart can display a maximum of 20 lines.

To display multiple items of data, set the sampling conditions and data size for the data to display to the 
same settings. The data cannot be displayed if its sampling conditions or data size is different.

Device Display: Display the values of multiple, continuous devices as a single line chart. The data size 
for the devices is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the starting 
address value (control status) of the continuous devices.
The number of values of devices to display is specified by the value of starting address 
+ 1.
The values of devices from starting address + 2 are displayed on the chart.

Number of display 
points changed

Number of display 
points changed

Action 

(Starting address +2) D102 value

(Starting address +3) D103 value

(Starting address +4) D104 value

(Starting address +5) D105 value

(Starting address +6) D106 value

Display

20

80

70

100

10

50

30

90

90

110

20

60

20

0

80

0

10

0

Update
Erase

Update
Do not erase

Update
Do not erase

Update
Erase

Update
Do not erase

55355
(Starting address +1) D101 value

Number of devices to display values

D100-1 value   Erase

00    1(Starting address) D100-0 value   Update

10

50

20

60

10

10

50

20

60

10

0

20

40

60

80

100

-20

120
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120
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0    1
0    1 0    1 0    1

0    1

If there are many items of data to display, it may take some time to update the display.
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■ Data Format

■ Display Points
Specifies the maximum number of points of data to display on the chart (2 to (Base Screen horizontal size)).
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

■ Scroll Size
Specifies the number of points of data to scroll when updating the chart display (1 to (Base Screen horizontal size)).
This option can only be configured when Log Trend (Normal) is selected for Chart Type.
Example: When Display Points is 5 and Scroll Size is 3

■ Restart Chart
Select this check box to display the chart from the beginning when switching screens.
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for Chart 
Type.

Data Type: Selects the data type handled by the chart from the following.
BIN16(+), BIN16(+/-), BCD4
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the chart.
The minimum and maximum vary based on the selected data type. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.

If BCD4 is selected for Data Type and the read data contains A through F, 1 is written to System Area 2 
Arithmetic error bit (address+2, bit 5), and an error message is displayed. For details, refer to Chapter 3 
“Arithmetic error” on page 3-25.
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2. Shift data 3 points left.1. Reached maximum amount 
    of data to display.

3. Display next data.
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Switch screen Switch screenBase Screen 1 Base Screen 1Base Screen 2

Display chart 
from beginning.
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■ Scroll*1

*1 Advanced mode only

Enable Scroll: To scroll the chart to display past data and to display the cursor, the chart display updating must be 
stopped. To control updating the display, select this check box and specify the bit device or bit of 
the word device to control the display.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
Display updating stops when the value of device changes from 0 to 1. Display updating restarts 
when the value of device changes from 1 to 0.
This option can only be configured when Log Trend (Normal) or Log Trend (Pen Recorder) is 
selected for Chart Type.

Right Scroll Device, Left Scroll Device:

The chart can be scrolled to the right or to the left when display updating is stopped. This option 
specifies the bit device or bit of the word device to scroll the chart left or right.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
The chart scrolls right or left one point of data each time the value of device changes from 0 to 1.
These options can only be configured when the Control Display Update and Scrolling check box 
is selected.
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Scroll right 
1 data point.

Stop updating

Scroll right 
1 data point.

Scroll right 
1 data point.

Stop updating, 
then scroll right 

3 data points.

Value of
Right Scroll Device LM0
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Plate Color
Selects the plate (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Flange

■ Coordinates

Plate color

Foreground Color, Background Color:
Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to open the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts
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■ Size

W, H: Sets width and height to define the size of parts.
W: 5 to (Base Screen horizontal size)
H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Pen (Log) Tab
The Pen (Log) tab is only displayed when Log Trend (Normal) or Log Trend (Pen Recorder) is selected for 
Chart Type on the General tab.

■ Settings
Lists the chart settings.

■ Channel No.
Specifies the Data Log channel number to display on the chart (1 to 128).

■ Data No.
Specifies the data number to display on the chart out of the data contained in the selected Data Log channel number.

■ Line Type
Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

■ Line Size
Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

No.: Shows the numbers for the chart (Ch1 to Ch20).

Channel No.: Shows the Data Log channel number to display on the chart.

Data No.: Out of the data contained in the selected Data Log channel number, shows the data 
number to display on the chart.

Line Type: Shows the chart line type.

Line Size: Shows the chart line size.

Line Color: Shows the chart line color.

Data Log Settings: Displays the Data Log Settings dialog box where you can configure the channel while 
checking the data to display. Select Channel No. under Settings, and then click OK to 
close the Data Log Settings dialog box. Channel No. reflects the selected channel 
number.
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■ Line Color
Selects the line color for the chart (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Set
Registers the chart settings to the list. If you select a Ch number that is already registered, that number is overwritten 
with the new settings.
Select a Ch number on the list, and then click this button to register the settings for the Data Log Channel No. and 
Data No. and the chart Line Type, Line Size, and Line Color.
Always register the settings from Ch1.

■ Insert
Inserts the chart settings in the position selected on the list.
Select a Ch number on the list, and then click this button to insert the settings for the Data Log Channel No. and 
Data No. and the chart Line Type, Line Size, and Line Color. The settings at the insertion point shift down one 
line. Settings cannot be inserted if all Ch numbers are configured.

■ Remove
Deletes the registered settings from the list.
Select a Ch number, and then click this button to delete the selected settings from the list.
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● Pen (Device) Tab
The Pen (Device) tab is only displayed when Device Display is selected for Chart Type on the General tab.

■ Reference Device
Specifies the starting address of the data to display on the chart.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
The data size for the devices is 16 bits.
Updating and erasing the display is controlled by the lower 2 bits of the starting address value (control status).

The number of values of devices to display is specified by the value of starting address + 1.
The values of devices from starting address + 2 are displayed on the chart.
Example: If Reference Device is set to D100, continuous devices are used starting from D100. The used devices 

are as follows.

Bit 15 Bit 0Bit 2

0 : Do not update
1 : Update

0 : Do not erase
1 : Erase

Reserved

D100
D101
D102
D103
D104

Control status (display operation)
Number of data to display values on chart

Data to display values on chart

(Starting address)
+1
+2
+3
+4

D106 value

D105 value

D104 value

D103 value

D102 value

D101 value

D100 value
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50

20

60
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1

5

D102

D103

Values of Devices Displayed chart
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D1060
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■ Line Type
Selects the type of line from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

■ Line Size
Selects the line size from the following.
1 dot, 2 dots, 3 dots, 5 dots

■ Line Color
Selects the line color for the chart (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.
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● Data Over Tab
The Data Over tab is displayed in Advanced mode.

■ Range
The type of data is Value. This option uses constants for the allowable range.
Specifies the allowable range of values to display.

Minimum, Maximum: Select these check boxes to specify the minimum and/or maximum.
The minimum and maximum that can be specified differ according to the data type selected 
with Data Format on the General tab. For details on data types, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

When grid lines are displayed for the minimum and maximum, select the Show Gridline check box on the 
Scale tab and then select Data Over.

Ch1 data 60

Ch2 data
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80

30 -10

Display

Range : Value
Minimum : 0
Maximum : 100 Ch1

Ch2
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● Scale Tab
The Scale tab is displayed in Advanced mode.

■ Show Ticks
Select this check box to display a scale on a chart.

Major Divisions: Enter the number of major scale divisions (1 to 20).
Minor Divisions: Enter the number of minor scale divisions (1 to 20).
Show Tick Numbers: Select this check box to display numbers along the scale. Can only be set for Y-Axis.
Color: Selects the color of scales (color: 256 colors, monochrome: 8 shades).

Click the Color button to display the Color Palette. Select a color from the Color Palette.

The numbers and scales will be the same color.

If the area for displaying the scale is small, the scale will not be displayed properly.
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■ Show Gridline
Select this check box to display grid lines on the chart. The grid lines are displayed on the chart.

■ Show Label
Select this check box to display labels on the scale.

■ Use Text Manager
Select this check box if using the text registered in Text Manager for labels.

Display Position: Select from Scale and Data Over to specify the grid line display position.
Scale: Grid lines are displayed according to the number of major scale divisions.

Can only be set when the Show Ticks check box is selected.

Data Over: Grid lines are displayed at the positions of values specified for Maximum and 
Minimum under the Data Over tab.

Line Type: Selects the type of grid lines from the following.
Solid, Dot, Dash, Long Dash, Long Dash Dot, Long Dash Dot Dot

Color: Specifies grid line color (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Grid lines

Maximum

Minimum

Font: Selects the font for text used in labels from the following.
Japanese, European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic
Can only be set when the Use Text Manager check box is cleared.
The characters that can be displayed depend on the font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.

Text ID: Specifies the Text Manager ID No. (1 to 32,000) when text registered in Text Manager are used for 
labels.

Click  to display Text Manager.
Can only be set when the Use Text Manager check box is selected.

Text: Inputs characters to be displayed for labels. The maximum number is 40 characters.
The characters that can be entered depend on the font selected using Font. For details, refer to 
Chapter 2 “1.2 Available Text” on page 2-5.
Can only be input when the Use Text Manager check box is cleared.

When entering Unicode characters click  to display the Unicode Input dialog box. Enter the characters 
using the Unicode Input dialog box then click OK.

Color: Selects the color of the text used for labels (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

If a carriage return (CR) is included, the characters after the CR are not displayed. However, if Windows 
Font is set for the specified Text ID, all the characters are displayed.
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● Trigger Condition Tab
The Trigger Condition tab is displayed in Advanced mode.

The line chart is enabled while the condition is satisfied, and it is disabled while the condition is not satisfied. When 
disabled, the plate and flange are displayed, but the chart is not displayed.
Example: When Trigger Type is While ON and Device is LM0

While LM0 is 0, the condition is not satisfied and the line chart is not displayed.
While LM0 is 1, the condition is satisfied and the line chart is displayed.

■ Trigger Type
Selects the condition to enable the line chart from the following.

LM0:

Touch

Condition 
Not 

satisfied

0

LM0:
Condition 
Satisfied

1
Show chart

Hide chart

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Always Enabled:The line chart is always enabled.

Always show chart

Chart state
0

20

40

60

80

100

-20
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■ Data Type
Selects the data type handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While ON: Enables the line chart when the value of device is 1.

While OFF: Enables the line chart when the value of device is 0.

While satisfying the condition:

Enables the line chart when the condition is satisfied.
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Hide chart Show chart Hide chart Show chart Show chart Show chart Hide chart

Value of Device

Chart state
0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Value of Device

1

0

Show chart Hide chart Show chart Hide chart Hide chart Hide chart Show chart

Chart state
0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Chart state

Hide chart Show chart Hide chart Show chart Show chart Show chart Hide chart

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

0

20

40

60

80

100

-20

Condition

Satisfied

Not satisfied



2 Line Chart

10-36 SmartAXIS Touch User’s Manual

● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the line chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Pie Chart is Used  

The stacked bar chart and pie chart are used to show the proportion of individual data to the sum of the data.
They can be used to check the relative change in the values of multiple devices in real-time.

• Display the proportion for the sum of values of multiple devices in a stacked bar chart or a pie chart

3 Pie Chart

External device
Touch

1 : 1 : 1

4 : 2 : 1

D100 : 10

D200 : 10

D300 : 10

D100 : 120

D200 : 60

D300 : 30

If the source data is all 0, the chart shows the same proportion for all the data.
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3.2 Pie Chart Configuration Procedure

This section describes the configuration procedure for pie charts.

1 On the Home tab, in the Parts group, click Charts, and then click Pie Chart.

2 Click a point on the edit screen where you want to place the Pie Chart.

3 Double-click the dropped Pie Chart and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Options tab only appears in Advanced mode.
To switch to Advanced mode, click Advanced.
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3.3 Properties of Pie Chart Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Chart Type
Select the type of chart from the following items.

Horizontal Bar: Shows the proportion of the sum of the data as a horizontal stacked bar chart.
Example: When displaying the values for three devices

Vertical Bar: Shows the proportion of the sum of the data as a vertical stacked bar chart.
Example: When displaying the values for three devices

Horizontal Bar display 

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Proportion 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1

Vertical Bar display

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 150

Proportion 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 15 : 5 : 1
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■ Data Type
Selects the data type handled by the chart.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Settings
Lists the chart settings. The list shows the numbers, source devices, and colors for the chart.

■ Reference Device
Specifies the source word device for the data to display in the chart.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Foreground Color
Selects the foreground color for the chart (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

■ Background Color
Selects the background color for the chart (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Pie: Shows the proportion of the sum of the data as a pie chart.
Example: When displaying the values for three devices

Ch3 data 0

Ch2 data 0

50

100

30

60

10

50

Ch1 data 0 100 120 300

Proportion 1 : 1 : 1 2 : 2 : 1 4 : 2 : 1 30 : 5 : 1

Pie chart display

If BCD4 or BCD8 is selected and the read data contains A through F, 1 is written to System Area 2 
Arithmetic error bit (address+2, bit 5), and an error message is displayed. For details, refer to 
Chapter 3 “Arithmetic error” on page 3-25.

No.: Shows the numbers for the chart (Ch1 to Ch10).
For Horizontal Bar, the numbers are listed in order from the left. For Vertical Bar, the numbers are 
listed in order from the top.

For Pie, the numbers are listed clockwise.

Device: Shows the source device.

Fg. Color: Shows the foreground color of the chart.

Bg. Color: Shows the background color of the chart.

Pattern: Shows the chart pattern.

Horizontal bar Vertical bar

Ch1

Ch1 Ch2 Ch3 Ch2

Ch3

Pie chart

Ch1

Ch2

Ch3
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■ Pattern
Selects the chart pattern.
Click this button to display the Pattern Palette. Select a pattern from the Pattern Palette.

■ Set
Registers the chart settings to the list. If you select a Ch number that is already registered, that number is overwritten 
with the new settings.
Select a Ch number on the list, and then click this button to register the Reference Device, Foreground Color, 
Background Color, and Pattern settings.

■ Insert
Inserts the chart settings in the position selected on the list.
Select a Ch number on the list, and then click this button to insert the Reference Device, Foreground Color, 
Background Color, and Pattern settings. The settings at the insertion point shift down one line. Settings cannot be 
inserted if all Ch numbers are configured.

■ Remove
Deletes the registered settings from the list.
Select a Ch number, and then click this button to delete the selected settings from the list.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Flange

■ Coordinates

■ Size

Foreground Color, Background Color:
Selects the foreground and background colors of the flange (color: 256 colors, monochrome: 
8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange.
Click the Pattern button to open the Pattern Palette. Select a pattern from the Pattern Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.
W: 5 to (Base Screen horizontal size)
H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.
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Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the pie chart on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Meter is Used

The meter displays the value of a word device as the movement of a needle.

• Display the value of a word device in a meter

4 Meter

External device
Touch

D100 : 0

D100 : 75

0 100

20 80

40 60

0 100

20 80

40 60
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4.2 Meter Configuration Procedure

This section describes the configuration procedure for meters.

1 On the Home tab, in the Parts group, click Charts, and then click Meter.

2 Click a point on the edit screen where you want to place the Meter.

3 Double-click the dropped Meter and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.

The Range tab, Scale tab and Options tab only appear in Advanced mode.
To switch to Advanced mode, click Advanced.
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4.3 Properties of Meter Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Meter Type
Select the type of meter from the following items.
90 Degree Meter, 180 Degree Meter, 270 Degree Meter

Example: 180 Degree Meter

90-degree meter 180-degree meter 270-degree meter

180-degree meter display

Data 0 10 40 75



SmartAXIS Touch User’s Manual 10-51

4 Meter

10

Charts

■ Data Format

■ Reference Device
Specifies the source word device for the data to display in the meter.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Data Type: Selects the data type handled by the meter.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Minimum, Maximum: Specifies the minimum and maximum for the data.
The minimum and maximum vary based on the selected data type. For details, refer to 
Chapter 2 “1.1 Available Data” on page 2-1.
The needle does not move past the left edge when the data value is the minimum or 
lower.
The needle stops at the right edge when the data value is the maximum or higher.

If BCD4 is selected for Data Type and the read data contains A through F, 1 is written to System Area 2 
Arithmetic error bit (address+2, bit 5), and an error message is displayed. For details, refer to Chapter 3 
“Arithmetic error” on page 3-25.
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● View Tab

■ Browse
Select the type of graphic to be used to represent the part from the list of graphics. Click this button to display the 
View Browser.

■ Needle
Selects the needle color of the Meter (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

■ Plate Color
Selects the plate color of the standard graphic (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Needle color

Plate color
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■ Flange

■ Coordinates

■ Size

Foreground Color, Background Color:

Selects the foreground and background colors of the flange of the standard graphic (color: 
256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

Pattern: Selects a pattern for the flange of the standard graphic.
Click the Pattern button to display the Pattern Palette. Select a pattern from the Pattern 
Palette.

Flange

X, Y: Sets the display position of parts using coordinates.
The X and Y coordinates of parts are defined relative to an origin at the top-left corner of the screen.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)

(0, 0)
X

Y
Screen

Parts

W, H: Sets width and height to define the size of parts.

W: 5 to (Base Screen horizontal size)

H: 5 to (Base Screen vertical size)

Width

Height

Screen

Parts
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● Range Tab
The Range tab is only displayed in Advanced mode.

■ Show Range
Select this check box to show ranges on the meter and configure the number of ranges, range colors, and limits.

Number of Ranges: Specifies the number of ranges (1 to 5).

Range Color: Selects the range color (color: 256 colors, monochrome: 8 shades).
Click this button to display the Color Palette. Select a color from the Color Palette.

Limits: Specifies the limit for the range.
The limit varies based on the selected data type. For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

Example: 180-degree meter, data minimum is 0, maximum is 100, the number of ranges is set to 5

The limit between range 1 and 2: 20
The limit between range 2 and 3: 40
The limit between range 3 and 4: 60
The limit between range 4 and 5: 80

Range 1

Range 2

Range 3

Range 4

Range 5
0 100

20 80

40 60
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● Scale Tab
The Scale tab is displayed in Advanced mode.

■ Show Ticks
Select this check box to display a scale on a or meter.

Major Divisions: Enter the number of major scale divisions (1 to 20).

Minor Divisions: Enter the number of minor scale divisions (1 to 20).

Show Tick Numbers: Select this check box to display numbers along the scale. The values are displayed in the same 
color as the scale.

Color: Selects the color of scales (color: 256 colors, monochrome: 8 shades).
Click the Color button to display the Color Palette. Select a color from the Color Palette.

If the area for displaying the scale is small, the scale will not be displayed properly.
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● Options Tab
The Options tab is displayed in Advanced mode.

■ Security Group
Security groups are a security function for restricting the display and operation of parts.

Display: Selects the security group for which display of parts is restricted. (Default: None)

None: No security function is used.
Administrator, Operator, Reader: Three security groups are set up by default.

Click  to display the Security Group Settings dialog box. If you create a security group on the Security 
Group Settings dialog box, you can select that created group. For details, refer to Chapter 21 “2.2 Adding 
and Editing Security Groups” on page 21-15.

For details about security functions, refer to Chapter 21 “User Accounts and the Security Function” on page 
21-1.



SmartAXIS Touch User’s Manual 10-57

4 Meter

10

Charts

Example: If the user and security group for a part are set as follows:

For User1, who is not included in the specified security group, Group A parts are not displayed.
If the Password Screen is now opened and User2 logs in, Group A parts are displayed.

User Name

Security Group None Group A

User1 User2

Touch

130Line Chart and Bar Chart
Display: Group A

Button
Display: Group A

Numerical Display
Display: None

Open Password Screen, 
enter password, 
and switch to User2.

Group A parts are 
not displayed to User1.

Group A parts are 
displayed to User2.

Touch

130

Touch Touch

130

User1 User2

130Password

ENT

�User2

********

BS CLR OK

A B C D E F G H I J  K L M
N O P Q R S T U V W X Y Z
0 1 2 3 A 5 6 7 8 9
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the meter on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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This chapter describes how to setup commands and their operation on the Touch.

  

1.1 How the Bit Write Command is Used

Writes a 0 or 1 to a bit device.

■ Set

■ Reset

■ Momentary

Chapter 11 Commands

1 Bit Write Command

Touch External device

0

1

Condition

Condition

Not satisfiedNot satisfiedNot satisfied

SatisfiedSatisfiedSatisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 0 to the specified bit device 
when the trigger condition is 
satisfied.

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes a 1 to the specified bit device 
when the trigger condition is 
satisfied.
When the trigger condition is no 
longer satisfied, a 0 is written to the 
specified bit device.

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Toggle

■ Move

Toggles the value of the specified bit 
device when the trigger condition is 
satisfied.
If the value of the bit device is 0 it 
changes to 1, and vice versa.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

This function writes the value in the 
source bit device to the value in the 
destination bit device when the 
trigger condition is satisfied.

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied



SmartAXIS Touch User’s Manual 11-3

1 Bit Write Command

11

Com
m

ands

1.2 Bit Write Command Configuration Procedure

This section describes the configuration procedure for the Bit Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Bit Write Command.

2 Click a point on the edit screen where you want to place the Bit Write Command.

3 Double-click the dropped Bit Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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1.3 Properties of Bit Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Momentary: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

1

State of condition

Data written 1

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 0

Action Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

0

State of condition

Data written 1 0 1

Action WriteWrite Write Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Destination Device
Specify the destination bit device.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Write
Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset.

Example: This fills a contiguous block of bit devices with the same value.

If the bit of the word device is specified, the same value is written to same bit of contiguous word devices.

■ Source Data
Specifies the device where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move.

Example: This button writes the values in a contiguous block of bit devices to a contiguous block of devices at the 
destination.

*1 Advanced mode only

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device 
when the trigger condition is satisfied.

State of condition

Action Toggle Toggle

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Action Move Move

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

*1

1M0

1M1

1M2

1M3

1M4

Action Mode: Set

Write: 5
Destination Device: M0

Condition

SatisfiedSatisfiedSatisfied

Condition

bit bit
15 0

SatisfiedSatisfiedSatisfied

1D0

D1

D2

D3

D4

1

1

1

1

Action Mode: Set

Write: 5
Destination Device: D0-15

Device: Specify the source bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Transfer: Specify the number of bit devices (1 to 64) to move.

1LM0

0LM1

0LM2

1LM3

Device: LM0

Transfer: 4
Destination Device: M0

1M0

0M1

0M2

1M3

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when device changes from 0 to 1.

Falling-edge: Command is executed when device changes from 1 to 0.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

Value of Device

1

0

Action Execution Execution Execution

Execution Execution

Value of Device

1

0

Action

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While satisfying the condition:
The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Bit Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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2.1 How the Word Write Command is Used

Writes a value to a word device. Can be used to indirectly specify the destination address or to perform operations on 
the written value.

• Writes a fixed value to the specified word device when the trigger condition is satisfied.

• Writes the value of device to the specified word device when the trigger condition is satisfied.

• Performs arithmetic on the value to write before writing it to a word device when the trigger condition is satisfied.

2 Word Write Command

Touch External device

D1= 0

100

D1= 100

Write

Destination word device

100

Value

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

Touch External device

D0= 123

D1= 0

D0= 123

D1= 123

Move

Value of device

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied

Touch External device

D0= 100

D1= 23

D2= 0

D0= 100

D1= 23

D2= 123

Add

Write

Value to write

Operator value

Destination word device

Condition

Condition

SatisfiedSatisfiedSatisfied

Not satisfiedNot satisfiedNot satisfied
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■ Set

■ Move

■ Momentary

■ Add, Sub, Multi, Div, Mod, OR, AND, XOR

Writes a fixed value to the specified word device 
when the trigger condition is satisfied.

State of condition

Data written

WriteAction Write

Fixed Value Fixed Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes the value in the source device to the 
destination word device when the trigger 
condition is satisfied. State of condition

Data written

WriteAction Write

Value of Device Value of Device

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Writes the fixed ON Data value to the specified 
word device when the trigger condition is 
satisfied.
Writes the fixed OFF Data value to the specified 
word device when the trigger condition is no 
longer satisfied.

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

Performs arithmetic on the value in a source 
device and a fixed value or a value of device, and 
writes the result to a word device when the 
trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, the value 
in the Source 1 is added to the value in Source 
2 and the result is written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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2.2 Word Write Command Configuration Procedure

This section describes the configuration procedure for the Word Write Command.

1 On the Home tab, in the Parts group, click Commands, and then click Word Write Command.

2 Click a point on the edit screen where you want to place the Word Write Command.

3 Double-click the dropped Word Write Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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2.3 Properties of Word Write Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device to the destination word device when the trigger condition is 
satisfied.

Momentary: Writes the fixed ON Data value to the specified word device when the trigger condition is satisfied.
Writes the fixed OFF Data value to the specified word device when the trigger condition is no 
longer satisfied.

State of condition

Data written

WriteAction Write

Fixed Value Fixed Value

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction Write

Value of Device Value of Device

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

WriteAction

OFF Data

Write

ON Data

Write

OFF Data

Write

ON Data

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied
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■ Data Type
Select the data type to be handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
BIN16(+) and BIN32(+) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

■ Source Data
Select the data type to be handled by the operation selected for Action Mode and enter the value.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Performs arithmetic on the value in a reference device and a fixed value, or the value at a 
device address and writes the result to a word device when the trigger condition is satisfied.

Example: Add (Addition)
When the trigger condition is satisfied, the value in the Source 1 is added to the 
value in Source 2 and the result is written to the word device.

State of condition

Data written

Action

Result

Arithmetic operation
↓

Write

Result

Arithmetic operation
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

State of condition

Data written

Action

Result Result

Addition
↓

Write

Addition
↓

Write

Condition Condition Condition Condition

SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfiedNot satisfiedNot satisfiedNot satisfied

BIN16(+) and BIN32(+) can only be set if Action Mode is set to Move. Because the number of devices 
to transfer is specified in Advanced mode, you do not need to set Data Type.

IF BCD4, BCD8, or float32 is selected and the arithmetic data contains a value inexpressible in BCD, a 1 
is written to System Area 2 Arithmetic error bit (address+2, bit 5) and an error message is displayed.
For details, refer to Chapter 3 “Arithmetic error” on page 3-25.

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Momentary.
If Action Mode is set to Momentary, the value in the ON Data is written when the trigger condition is 
satisfied, and the value in the OFF Data when the trigger condition is no longer satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a hexadecimal.
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■ Destination Device

*1 Advanced mode only

Device: Use a word device.
Specify the device.
Click  to display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1:

Select this check box and specify a device to change the source word device according to 
the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Transfer Specify the number of word devices (1 to 64) to move.
This setting is enabled only if Action Mode is set to Move.
Example: If Transfer is set to 2 and Write is set to 3, the same data in 2 continuous word 

devices will be written to the destination device 3 times.

*1 :

Source Data (Device): LDR0

Write: 3

999LDR0

Destination Device: D100

D100

D101

D102

D103

Transfer: 2 1000LDR1

D104

D105

999

1000

999

1000

999

1000

Condition

SatisfiedSatisfiedSatisfied

Destination Device: Specify the destination word device.
Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device 
according to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Write Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to repeat writing.
This setting is enabled only if Action Mode is set to Set, Momentary, Alternate, or 
Move.
Example: If Data Type is set to BIN16(+) and Write is set to 5, the same data will be 

written to 5 continuous word addresses.

If Data Type is set to BIN32(+) and Write is set to 5, the same data will be 
written to a total of 10 word addresses (2 words 5 times).

*1 :

Destination Device: LDR10
Write: 5

Data Type: BIN16(+)
Source Data (Value): 12345

12345LDR10

12345LDR11

12345LDR12

12345LDR13

12345LDR14

5 words
Condition

SatisfiedSatisfiedSatisfied

Destination Device: LDR10
Write: 5

Data Type: BIN32(+)
Source Data (Value): 987654

LDR10

987654

LDR11

LDR12

987654

LDR13

LDR14

987654

LDR15

LDR16

987654

LDR17

LDR18

987654

LDR19

2 words x 5

Condition

SatisfiedSatisfiedSatisfied
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● Trigger Condition Tab

When the condition has been or is satisfied,  the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when device changes from 0 to 1.

Falling-edge: Command is executed when device changes from 1 to 0.

Value of Device

1

0

Action Execution Execution Execution

Execution Execution

Value of Device

1

0

Action
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition:
The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Word Write Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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3.1 How the Goto Screen Command is Used

Switches to another screen or displays a window.

• Switches between Base Screens when the trigger condition is satisfied.

• Opens and closes other windows (such as the Popup Screen, Device Monitor, Ladder Monitor, Password Screen, 
and Adjust Contrast Screen) when the trigger condition is satisfied.

• Switches to the System Mode when the trigger condition is satisfied.

• Resets the current screen when the trigger condition is satisfied.

3 Goto Screen Command

Touch Touch

130 Full

Tank 1

Condition

SatisfiedSatisfiedSatisfied

Touch Touch

D51

D52 456

D53 0

999

123

Condition

SatisfiedSatisfiedSatisfied

Touch Touch

D51

D52 456

D53 0

999

123

Condition

SatisfiedSatisfiedSatisfied

Touch Touch

130

Condition

SatisfiedSatisfiedSatisfied

Touch Touch

130 0

Condition

SatisfiedSatisfiedSatisfied
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3.2 Goto Screen Command Configuration Procedure

This section describes the configuration procedure for the Goto Screen Command.

1 On the Home tab, in the Parts group, click Commands, and then click Goto Screen Command.

2 Click a point on the edit screen where you want to place the Goto Screen Command.

3 Double-click the dropped Goto Screen Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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3.3 Properties of Goto Screen Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Ladder Monitor: Opens the Ladder Monitor.

Close Ladder Monitor: Closes the Ladder Monitor.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust contrast Screen: Opens the Adjust contrast Screen.

Close Adjust contrast Screen: Closes the Adjust contrast Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

• Open Ladder Monitor and Close Ladder Monitor can only operate when ladder program is selected 
as the programming language in control function. 

• When the current Base Screen is reset using the Reset current screen function, the window and 
internal devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen No.: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup 
Screen, or Close Popup Screen.

Use Reference Device*1: Select this check box and specify a device to specify the screen 
number using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as the 
origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust contrast Screen, or Open Movie 
File Screen.

Use Reference Device*1: Select this check box and specify a device to specify the coordinates 
using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when device changes from 0 to 1.

Falling-edge: Command is executed when device changes from 1 to 0.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

Value of Device

1

0

Action Execution Execution Execution

Execution Execution

Value of Device

1

0

Action

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While satisfying the condition:
The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Goto Screen Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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4.1 How the Script Command is Used

Executes a script when certain conditions are satisfied.

4 Script Command

Touch

// Script A

[D 100] = [D 100] + 1;

if ([D 100] >= 50)

{

     [D 100] = 0;

}

Executes Script

Start Condition

SatisfiedSatisfiedSatisfied

Complex processes such as conditional branching, logical operation, arithmetic operation, function, etc., can 
be programmed in a text format using Scripts. For details, refer to Chapter 20 “Script” on page 20-1.
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4.2 Script Command Configuration Procedure

This section describes the configuration procedure for Script Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Script Command.

2 Click a point on the edit screen where you want to place the Script Command.

3 Double-click the dropped Script Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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4.3 Properties of Script Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when device changes from 0 to 1.

Falling-edge: Command is executed when device changes from 1 to 0.

Value of Device

1

0

Action Execution Execution Execution

Execution Execution

Value of Device

1

0

Action
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Period
Sets the period for command execution from 1 to 3600 (seconds).
Can only be set if Fixed Period is selected as Trigger Type.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

While satisfying the condition:

The command continues being executed while the condition is satisfied.

Fixed Period: Command executes within a fixed time interval.

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution

Fixed time interval Fixed time interval Fixed time interval

Action Execution Execution ExecutionExecution
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● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Script Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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5.1 How the Multi-Command is Used

Executes multiple commands at once.
These commands can be assigned to a Multi-Command.

• Writes a 1 to a bit device, and the value in a word device to another device when the trigger condition is satisfied.

• When the trigger condition is satisfied, executes the script and switches the Base Screen.

5 Multi-Command

Command Description

Bit Write Writes a 0 or 1 to the specified bit device.

Word Write
Writes a value to a word device. You can specify the destination address indirectly, and perform arithmetic 
on the value to be written.

Goto Screen Switches screens or opens other windows.

Key Performs downloads or uploads. Also used to manipulate other parts.

Script Executes a script.

Touch External device

1

Condition

SatisfiedSatisfiedSatisfied

0

D0= 123

D1= 0

D0= 123

D1= 123

Move

Touch

Condition

SatisfiedSatisfiedSatisfied

// Script A

[D 100] = [D 100] + 1;

if ([D 100] >= 50)

{

     [D 100] = 0;

}

Executes the script.
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5.2 Multi-Command Configuration Procedure

This section describes the configuration procedure for Multi-Commands.

1 On the Home tab, in the Parts group, click Commands, and then click Multi-Command.

2 Click a point on the edit screen where you want to place the Multi-Command.

3 Double-click the dropped Multi-Command and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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5.3 Properties of Multi-Command Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum number is 20 characters.

■ Multi-Functions
Add and edit commands to be executed when the trigger condition is satisfied.

Function List: Lists the commands to be executed.

Command Type: Shows the command type.

Command Name: Shows the command name.

Device: Shows the setting when one of the following Command Type is selected.
Shows the destination device for the Bit Write and Word Write commands.
Shows the screen number when Goto Screen is set to Switch to Base 
Screen, Open Popup Screen, or Close Popup Screen.
Shows the script ID for the Script command.

• Executes only the Goto Screen command at the end of the Function List when multiple Switch to Base 
Screen type commands are set for Action Mode.

• Goto Screen commands are not executed from top to bottom as they appear in the Function List. 
Rather, they are executed at the end of the scan of the Touch when the trigger condition is satisfied.

• The function of Key button will affect on the next scan when the trigger condition is satisfied.
• If multiple Key commands are set, only the first and second Key commands in the Function List are 

executed. The third and following Key commands are not executed. Also, only the first Key command that 
specifies a Data Transfer function in the Function List is executed if multiple Key commands are set.

Command Type: Select the command to add.

Bit Write: Writes a 0 or 1 to a bit device or bit of the word device. For details, refer to 
“Properties of Bit Write for Multi-Functions dialog box” on page 11-35.

Word Write: Writes a value to a word device. Can be used to indirectly specify the destination 
address or to perform operations on the written value. For details, refer to 
“Properties of Word Write for Multi-Functions dialog box” on page 11-36.

Goto Screen: Switches to another screen or displays a window. For details, refer to 
“Properties of Goto Screen for Multi-Functions dialog box” on page 11-38.
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Key: Performs a variety of functions including uploading and downloading, copying 
files, and operating other parts. For details, refer to “Properties of Key for Multi-
Functions dialog box” on page 11-40.

Script: Executes a script. For details, refer to “Properties of Script for Multi-Functions 
dialog box” on page 11-42.

Add: Adds a command to the list. A maximum of 32 commands may be added.
Click this button to display the Properties dialog box for the command selected from Command 
Type.

Edit: Changes a command in the list.
Click this button to display the Properties dialog box for the command selected in Function List.

Delete: Deletes a command from the list.
Select the command in the list, and then click this button.

Copy: Copies a command in the list.
Select a command in the list, and then click this button. A copy of the selected command is added 
to the end of the list.

Up: Shifts the selected command upward in the list.

Down: Shifts the selected command downward in the list.
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Properties of Bit Write for Multi-Functions dialog box

Sets the Bit Write command for the Multi-Command.

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Destination Device
Specify the destination bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Write*1

Specify the number of bit devices (1 to 64) at the destination.
This setting is enabled only if Action Mode is set to Set or Reset. For details, refer to “Write” on page 11-5.

■ Source Data
Specifies the device where the data to be written is stored.
This setting is enabled only if Action Mode is set to Move. For details, refer to “Source Data” on page 11-5.

*1 Advanced mode only

Set: Writes a 1 to the specified bit device when the trigger condition is satisfied.

Reset: Writes a 0 to the specified bit device when the trigger condition is satisfied.

Set & Reset: Writes a 1 to the specified bit device when the trigger condition is satisfied.
When the trigger condition is no longer satisfied, a 0 is written to the specified bit device.

Toggle: Toggles the value of the specified bit device when the trigger condition is satisfied.
If the value of the bit device is 0 it changes to 1, and vice versa.

Move: This function writes the value in the source bit device to the value in the destination bit device 
when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 11-4. However, Set & Reset for the 
Multi-Command has the same function as Momentary for the Bit Write Command.

Device: Specify the source bit device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Transfer: Specify the number of bit devices (1 to 64) to move.
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Properties of Word Write for Multi-Functions dialog box

Sets the Word Write command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is satisfied from the following:

■ Data Type
Select the data type handled by the operation selected for Action Mode.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.
BIN16(+) and BIN32(+) can only be set if Action Mode is set to OR, AND, or XOR.

■ Source 1
Specify the source word device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Add, Sub, Multi, Div, Mod, OR, AND, or XOR.

Set: Writes a fixed value to the specified word device when the trigger condition is satisfied.

Move: Writes the value in the source device to the destination word device when the trigger 
condition is satisfied.

Set ON & OFF Data: Writes a fixed value of ON Data to the specified word device when the trigger condition is 
satisfied.
Writes a fixed value of OFF Data to the specified word device when the trigger condition is no 
longer satisfied.

Add, Sub, Multi, Div, Mod, OR, AND, XOR:

Performs arithmetic on the value in a source device and a fixed value or a value of device, and 
writes the result to a word device when the trigger condition is satisfied.

For details about the Action Mode, refer to “Action Mode” on page 11-12. However, Set ON & OFF Data 
for the Multi-Command has the same function as Momentary for the Word Write Command. 

BIN16(+) and BIN32(+) can only be set if Action Mode is set to Move. Because the number of devices 
to transfer is specified in Advanced mode, you do not need to set Data Type.

If BCD4, BCD8, or float32 is selected and the arithmetic data contains a value inexpressible in BCD, a 1 
is written to System Area 2 Arithmetic error bit (address+2, bit 5) and an error message is displayed.
For details, refer to Chapter 3 “ Arithmetic error” on page 3-25.
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■ Source Data
Select the data handled by the operation selected for Action Mode.

■ Destination Device

*1 Advanced mode only

Value: Use a constant.
Only a Value can be handled if Action Mode is set to Set or Set ON & OFF Data.
If Action Mode is set to Set ON & OFF Data, the value in the ON Data is written when the trigger 
condition is satisfied, and the value in the OFF Data when the trigger condition is no longer satisfied.

Hexadecimal: Select this check box to enter the ON Data and OFF Data values as a 
hexadecimal.

Device: Use a word device.
Specify the device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the source word device 
according to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on 
page 2-4.

Transfer*1: Specify the number of word devices (1 to 64) to move.
This setting is enabled only if Action Mode is set to Move.
For details, refer to “Transfer” on page 11-14.

Destination Device: Specify the destination word device.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Use Reference Device*1: Select this check box and specify a device to change the destination word device 
according to the value of the specified device.
This setting is enabled only if Action Mode is set to Move.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Write*1: Specify the number of word devices (1 to 64) at the destination.
For Move, specify how many times to write.
This setting is enabled only if Action Mode is set to Set, Move, or Set ON & OFF Data.
For details, refer to “Write” on page 11-14.



5 Multi-Command

11-38 SmartAXIS Touch User’s Manual

Properties of Goto Screen for Multi-Functions dialog box

Sets the Goto Screen command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Action Mode
Select the action to perform when the trigger condition is met from the following:

Back to previous Screen: Switches to the previous screen. Returns to up to 16 earlier screens.

Switch to Base Screen: Switches between Base Screen.

Open Popup Screen: Opens a Popup Screen.

Close Popup Screen: Closes a Popup Screen.

Open Device Monitor Screen: Opens the Device Monitor Screen.

Close Device Monitor Screen: Closes the Device Monitor Screen.

Open Ladder Monitor: Opens the Ladder Monitor.

Close Ladder Monitor: Closes the Ladder Monitor.

Open Password Screen: Opens the Password Screen.

Close Password Screen: Closes the Password Screen.

Open Adjust contrast Screen: Opens the Adjust contrast Screen.

Close Adjust contrast Screen: Closes the Adjust contrast Screen.

Switch to System Mode: Switches to the Top Page in the System Mode.

Reset current screen: Resets the current Base Screen.

• Open Ladder Monitor and Close Ladder Monitor can only operate when ladder program is selected 
as the programming language in control function.

• When the current Base Screen is reset using the Reset current screen function, the window and 
internal devices restart as if the Base Screens were switched.
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■ Goto Screen

*1 Advanced mode only

Screen No.: If Action Mode is set to Switch to Base Screen, specify the Base Screen number to switch to 
(from 1 to 3000). If Action Mode is set to Open Popup Screen or Close Popup Screen, 
specify the number of the Popup Screen to open or close (from 1 to 3015).
This setting is enabled only if Action Mode is set to Switch to Base Screen, Open Popup
Screen, or Close Popup Screen.

Use Reference Device*1: Select this check box and specify a device to specify the screen 
number using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen or Close Popup Screen.

Coordinates X, Y: Specify the coordinates on the Base Screen for displaying a window.
X and Y specify the upper left corner of the window using the upper left corner of the screen as 
the origin.
This setting is enabled only if Action Mode is set to Open Popup Screen, Open Device 
Monitor Screen, Open Password Screen, Open Adjust contrast Screen, or Open Movie 
File Screen.

Use Reference Device*1: Select this check box and specify a device to specify the coordinates 
using the value of the specified device.

Click  to display the Device Address Settings dialog box. For the 
device address configuration procedure, refer to Chapter 2 “5.1 
Device Address Settings” on page 2-61.
This setting is enabled only if Action Mode is set to Open Popup 
Screen.
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Properties of Key for Multi-Functions dialog box

Sets the Key command for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Key Type
Select the function for the Key command.

The settings explained below appear depending on the type of key selected.

■ Popup Screen No.
The Alt key switches the current Popup Screen used as a Keypad when this button is pressed.
Specify the Popup Screen number to open a Keypad for.
This setting is enabled only if Alt was selected using the Key Browser.

■ Scroll Size
Key Buttons Pg. Up and Pg. Dwn scroll the list up and down, respectively. Key Buttons Fcs. Up and Fcs. Dwn move 
the focus up and down, respectively. This settings specifies the number of pages or lines (1 to 1023 lines) to scroll or 
move the focus per each press of the button.
This setting is enabled only if Pg. Up, Pg. Dwn, Fcs. Up, and Fcs. Dwn are selected using the Key Browser.

Displays settings 
applicable to the 
selected key.

(Key)

Language: Switches the display of the key that is displayed when Keypad is selected in Key Browser. These 
languages are available:
Japanese, European, Central European, Baltic, Cyrillic.

Browse: Opens the Key Browser when clicked. Select a key.
For details, refer to Chapter 7 “4.5 Key Browser” on page 7-66.

(Key): Displays the name of the key selected using the Key Browser.

The function of Key command will affect on the next scan when the trigger condition is satisfied.
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■ Transfer Setting
Key commands Download Project and Upload Project perform the data transfer function specified by their 
names.
These settings specify the source, data to be transfered, and destination.
This setting is enabled only if one of these keys is selected after clicking Data Transfer in the Key Browser.

If Download Project is selected.

If Upload Project is selected.

Source: This is set to the USB flash drive on which the project file to transfer (.ZNV) was saved.

File Path: Specify the path to the project file (.ZNV) to transfer. The maximum number is 247
characters.
Example: Where “FT_DEMO_1.ZNV” is a project file saved on the root directory of a USB 

flash drive:
FT_DEMO_1.ZNV

Source: Specify where to save the project uploaded from Touch. The location is the USB flash drive.

File Path: Specify the path to the folder where the uploaded project file will be saved. The maximum 
number is 247 characters.
Example: To save it to the folder “Uploaded_Project” on a USB flash drive:

Uploaded_Project
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Properties of Script for Multi-Functions dialog box

Sets the script for the Multi-Command. 

■ Command Name
Enter a name for the command. The maximum number is 20 characters.

■ Script ID
Specify the script ID (1 to 32,000) of the script to operate.

Script Manager will open when  is clicked. Select a script from the script list.
For details, refer to Chapter 20 “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script selected in Script Manager.

■ (Script)
Displays the contents of the script selected in Script Manager.
Once this area is double clicked, the Script Editor will open and editing can be done.
For details, refer to Chapter 20 “2.3 Script Editor” on page 20-8.

(Script)
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

Rising-edge: Command is executed when device changes from 0 to 1.

Falling-edge: Command is executed when device changes from 1 to 0.

Satisfy the condition: Command is executed when condition changes from not satisfied to satisfied.

Value of Device

1

0

Action Execution Execution Execution

Execution Execution

Value of Device

1

0

Action

Action

Condition
Satisfied

Not satisfied

Execution Execution Execution
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■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if Satisfy the condition or While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.

While satisfying the condition:
The command continues being executed while the condition is satisfied.

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution



SmartAXIS Touch User’s Manual 11-45

5 Multi-Command

11

Com
m

ands

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Multi-Command on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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6.1 How the Timer is Used

Starts a countdown when the trigger condition is satisfied, and writes 1 to an internal device (HMI Timer Relay LTC) 
once the set time has elapsed.

6 Timer

Touch

LTD0

0

1

LTC0: 0

LTC0: 1

1999 1998 999 1 0
LTD0

Start countdown Set time 
has elapsed

Condition

SatisfiedSatisfiedSatisfied

Start 
countdown

0 0 1 0

Writes 1 
to LTC0

Writes the 
preset value 

to LTD0 and 0 
to LTC0

State of condition

Action

HMI Timer Relay 
LTC0 value

HMI Timer Current Value 
LTD0 value 19991999 1998 999 1 19990

Condition Condition Condition Condition

Not satisfiedNot satisfiedNot satisfied SatisfiedSatisfiedSatisfied SatisfiedSatisfiedSatisfied Not satisfiedNot satisfiedNot satisfied

• The HMI Timer Relay LTC is an internal device (bit device) that changes to 1 once the time set for the 
timer has elapsed.

• The HMI Timer Current Value LTD is an internal device (word device) that stores current values for the 
timer.

• Once switched to the screen that the timer has been placed in, the following values will be given 
regardless of the whether the trigger condition is satisfied or not satisfied.
- HMI Timer Relay LTC: 0
- HMI Timer Current Value LTD: Preset Value
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6.2 Timer Configuration Procedure

This section describes the configuration procedure for Timers.

1 On the Home tab, in the Parts group, click Commands, and then click Timer.

2 Click a point on the edit screen where you want to place the Timer.

3 Double-click the dropped Timer and a Properties dialog box will be displayed.

4 Change the settings on each tab as necessary.
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6.3 Properties of Timer Dialog Box

This section describes items and buttons in the Properties dialog box.

● General Tab

■ Part Name
Enter a name for the part. The maximum characters is 20 characters.

■ Timer Address
Specifies the HMI Timer address (0 to 31).
The device type for the HMI Timer Relay is LTC. The device type where the current value is stored is LTD.

■ Unit
Select the unit of time from sec or 100 msec.

■ Preset Value
Select the data type to use and the enter the preset value.
The preset value is the time from when the timer starts its countdown until 1 is written to the HMI Timer Relay LTC.

Example: When 0 is specified for Timer Address

HMI Timer Relay: LTC0

HMI Timer Current Value: LTD0

Value: When selecting sec in Unit, the preset value is specified with 1 to 65535 (second units) up to a maximum 
of 1092 minutes 15 seconds.
When selecting 100 msec in Unit, the preset value is specified with 1 to 65535 (100 milliseconds units).

Device: Uses the values of word device.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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● Trigger Condition Tab

When the condition has been or is satisfied, the command is executed; when not satisfied, the command is not 
executed.
Example: When Trigger Type is Rising-edge and Device is LM0

The command is executed when LM0 changes from 0 to 1.

■ Trigger Type
Selects the condition to execute the command from the following.

■ Data Type
Selects the data type to be handled by the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

LM0:

Touch

0

LM0: 1

Not 
executed

Executed

Condition 
Not 

satisfied

Condition 
Satisfied

While ON: Command is executed when device is 1.

While OFF: Command is executed when device is 0.

While satisfying the condition:
The command continues being executed while the condition is satisfied.

1

0

Value of Device

Action Execution Execution Execution

1

0

Action

Value of Device

Execution Execution

Action

Condition
Satisfied

Not satisfied

Execution ExecutionExecution ExecutionExecution
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■ Device
Specifies the bit device or bit of the word device to serve as condition.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Condition
Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expression configuration procedure, 
refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

■ Comment
Enter a comment about trigger conditions. The maximum number is 80 characters.



SmartAXIS Touch User’s Manual 11-51

6 Timer

11

Com
m

ands

● Comment Tab
The Comment tab is used to specify the parts arranged on the editing screen, and the popup text displayed when 
the mouse pointer is placed close to No., Name, or Type in the object list.

■ Description
Enter a comment about parts. The maximum number is 80 characters.
Example: When mousing over the Timer on the editing screen

When there are multiple parts of the same shape on the screen, this features makes it possible to 
distinguish between the parts without displaying the Properties dialog box for each part, by just mousing 
over the part.
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12

Control Function

This chapter describes the actions and operations for ladder program and FBD program, basic operation for WindLDR, 
and functions of each instruction and FB.
The functions controlled by ladder programs or FBD programs created with WindLDR is called as control function.

  

1.1 Actions and Operations of Ladder Program and FBD Program

● Ladder Program and FBD Program Actions

■ Input refresh
A capture process is executed at the specified input filter, and the external output is reflected in the internal device 
Input (I).

■ Input delay
There is a delay between an external input and the internal device Input (I). The maximum delay period is calculated 
by the amount of 5 microseconds, filter value and the execution period.

■ Ladder or FBD process
Executes the ladder program or FBD program.

■ Output refresh
Updates the relay output (Q).

Chapter 12 Control Function

1 Control Function Actions

I

Q

I

Start of processing 
for part at top 

of screen

Q

Input

Output

Output 
delay

Output process

Input process

Input delay

Execution Period

Input refresh

Output refresh

Ladder or FBD 
process

Sleep 
(HMI function 

execution)

Control 
function

HMI function

Execution 
Period

External 
input

External 
output

End of processing 
for part at bottom 

of screen

Execution Period

When an input occurs immediately after the input refresh ends, 
the input delay will be the longest because the processor waits 
for the input refresh in the next scan before reflecting the input 
to the input relay.

I

IInput process
Input refresh

Output refresh

Ladder or FBD
process

Sleep 
(HMI function 

execution)

Input refresh

Output refresh

Ladder or FBD
process

Input delay 
(maximum)

Input

External 
input
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■ Output delay
There is a delay between an external output and the internal device Output(Q). The maximum delay period is 
calculated by the amount of 300 milliseconds and the execution period.

■ Control function
A control function refers to three processes: input refresh, ladder or FBD process, and output refresh.
For details of control function settings, refer to Chapter 3 “4 Special Functions” on page 3-45, and the “SmartAXIS 
Ladder Programming Manual” or the "SmartAXIS FBD Programming Manual".

■ Sleep
Sleep refers to the time used by the control function subtracted from the Execution Period. This is when the processor 
executes HMI function.

■ Execution Period
The Execution Period refers to one scan of the control function (input refresh + ladder or FBD process + output 
refresh) and HMI function (sleep).
The control function is executed once every specified execution interval.

■ HMI function
Parts laid out on the screen are processed from top to bottom only when the control function is in sleep mode.
Display processing pauses when execution of the next control function begins, and resumes when the function goes 
to sleep again.
When processing reaches the bottom of the screen, processing returns to the top of the screen.

When an output occurs immediately after the output refresh 
ends, the output delay will be the longest because the processor 
waits for the output refresh in the next scan before reflecting 
the output to the output relay.

Q

QOutput process

Input refresh

Output refresh

Ladder or FBD
process

Sleep 
(HMI function 

execution)

Input refresh

Output refresh

Ladder or FBD
process

Output delay 
(maximum)

Output

External 
output

Only control devices can be used for control function.

If execution of the control function takes more than half of the time specified for the Execution Period, the 
processor automatically extends the Execution Period so that the control function completes within 1/2 of 
the Execution Period. In this instance, error number 7 will be stored in HMI Special Data Register LSD53.

There is a delay in the ladder program or FBD program. Take this delay time into consideration when 
specifying the Execution Period. For example, if it is necessary to capture external inputs within 100 
milliseconds, set the Execution Period to 90 milliseconds. The default Execution Period is 10 milliseconds. If 
you don't change the default value, it will be the same as the M8123 (10 milliseconds clock) operation 
period. In this case, M8123 is always ON or OFF.
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● Executing and Stopping Ladder Programs or FBD Programs
This section describes operations to start and stop the Touch.

The ladder program or FBD program is executed (RUN) and stopped (STOP) by using the Touch operations, or by 
external input with the stop input and reset input functions.
For details on stop input settings, refer to Chapter 3 “4.2 Stop Input” on page 3-48.
For details on reset input settings, refer to Chapter 3 “4.3 Reset Input” on page 3-49.

Switching from RUN to STOP is executed by END process of the ladder program or Scan End process of the FBD 
program, and the following functions are stopped.

• For outputs during STOP, keep or clear can be selected by special internal relay M8025 (Maintain Outputs While 
Ladder Program Operation Stopped). For details on M8025 (Maintain Outputs While Ladder Program Operation 
Stopped), refer to Chapter 27 “Special Internal Relay (M)” on page 27-5.

• The current values of timer instructions and timer FB are reset. For details, refer to the follows:
- Ladder program: Timer instruction
 Chapter 5 "Basic Instructions" - "TML (1-sec Timer)" in the "SmartAXIS Ladder Programming Manual"

- FBD program: Timer FB
 Chapter 8 "The timer FB" in the "SmartAXIS FBD Programming Manual"

Also, when switching from STOP to RUN, device states are cleared or kept according to Memory Backup in 
Function Settings. For details, refer to Chapter 3 “4.6 Keep and Clear Control Devices” on page 3-53.

Make sure your safety before turning the Touch on and off. Incorrect operation may cause machine 
damage or accidents.

Ladder program: High-speed counter, User interrupt, Catch input, Timer interrupt

FBD program: High-speed counter, Catch input
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2.1 Basic Operation for WindLDR

This section describes basic procedures for operating WindLDR.

● Start WindLDR

On the WindO/I-NV3 View tab, in the Workspace group, click  (control function).
WindLDR starts.

Next, create a ladder program.

2 Ladder Program

• The programming language can be changed in the PLC Selection dialog box. The PLC Selection dialog box 
can also be accessed using the following methods.
- Click PLC Type on the status bar, and then click PLC Selection on the displayed drop-down list.
- On the Configuration tab, in the PLC group, click PLC.

• To change the default programming language, select the programming language on the PLC Selection 
dialog box, and then click Use as Default.
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● Creating Ladder Program
This section describes the procedure for creating a simple ladder program in WindLDR.

Create a simple program using WindLDR. The sample program performs the following operation:
• When input I0 is turned on, output Q0 is turned on.
• When input I1 is turned on, output Q1 is turned on.
• When both inputs I0 and I1 are turned on, output Q2 flashes in 1-sec increments.

For details about basic and advanced instructions, refer to the "SmartAXIS Ladder Programming Manual".

Rung No. Input I0 Input I1 Output Operation

1 ON OFF Output Q0 is turned ON.

2 OFF ON Output Q1 is turned ON.

3 ON ON Output Q2 flashes in 1-sec increments.

One collection of a group of instructions that control output or advanced instructions is called a rung. 
WindLDR manages programs in rung units. Function descriptions can be configured as rung comments for 
individual rungs.
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Inserting a NO contact of input I0

1 On the WindLDR Home tab, in the Instruction group, click Basic, and then click A (Normally Open).
The symbol for NO contact is displayed at the mouse pointer.

2 Move the mouse pointer to the first column of the first line where you want to insert a NO contact, and then click the 
left mouse button. 
The NO contact is created on the ladder line and the properties are displayed in the Property window.

3 Set the device in the Property window.
Enter "I0" for Device and press ENTER.
A NO contact of input I0 is programmed in the first column of the first ladder line.

Instructions can be entered using the right-click menu or the keyboard.
If entering an instruction using the right-click menu, open the menu, click Basic Command (B), and then 
click A (Normally Open).

If entering NO contact from the keyboard, press  and then select NO contact from the Coil Selection 
dialog box and press ENTER.
For details, refer to the online help for WindLDR.

A



SmartAXIS Touch User's Manual 12-7

2 Ladder Program

12

Control Function

Inserting a NC contact of input I1

1 On the WindLDR Home tab, in the Instruction group, click Basic, and then click B (Normally Closed).
The symbol for NC contact is displayed at the mouse pointer.

2 Move the mouse pointer to the second column of the first ladder line where you want to insert a NC contact, and then 
click the left mouse button.
The NC contact is created on the ladder line and the properties are displayed in the Property window.

3 Set the device in the Property window.
Enter "I1" for Device and press ENTER.
A NC contact of input I1 is programmed in the first column of the first ladder line.
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Inserting Output Q0

1 On the WindLDR Home tab, in the Instruction group, click Basic, and then click OUT (Output).
The symbol for Output is displayed at the mouse pointer.

2 Move the mouse pointer to the third column of the first ladder line where you want to insert an output coil, and then 
click the left mouse button.
The output is created on the ladder line and the properties are displayed in the Property window.

3 Set the device in the Property window.
Enter "Q0" for Device and press ENTER.
Output Q0 is connected to the series circuit of the NO contact for input I0 and the NC contact for input I1.

This completes programming for rung 1.
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Creates Rung 2

1 A new rung is inserted.

To insert a rung, on the Home tab, in the Editing group, click Append, and then click Append a Rung.

2 Enter NC contact I0 and NO contact I1, and Output Q1.

Enter NC contact I0 and NO contact I1, and Output Q1 in the same way as described from “Inserting a NO contact of 
input I0” on page 12-6 to “Inserting Output Q0” on page 12-8.

Rungs can be added using the right-click menu or the keyboard.
If inserting a rung using the right-click menu, open the menu and click Append (N), and then click Rung 
(R).
If inserting a rung from the keyboard, press ENTER.
For details, refer to the online help for WindLDR.
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Creates Rung 3

1 Insert a rung and enter NO contact I0, NO contact I1, and Output M0010.

2 A new ladder line is inserted.
To insert a ladder line, on the Home tab, in the Editing group, click Append, and then click Append a Ladder 
Line.

3 Enter NO contact M0010, NO contact M8121, and Output Q2.
M8121 is a special internal relay that repeatedly toggles ON/OFF on a 1 second cycle.

This completes programming for rung 1 to 3.

One output or computation instruction can be laid out on each ladder line. If entering multiple outputs or 
computation instructions within a single rung, or if setting input conditions that extend over multiple lines, 
insert a ladder line to the rung.
Ladder lines can be inserted using the right-click menu or the keyboard.
If inserting a rung using the right-click menu, open the menu and click Append (N), and then click Ladder 
Line (L).

If inserting a rung from the keyboard, press .
For details, refer to the online help for WindLDR.
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Conversion of Programs

1 Confirms that programs have been correctly created.

On the Home tab, in the Program group, click Convert.
When the instruction symbols are connected correctly, conversion is completed successfully. If any error is found, the 
errors are listed on the Info Window screen. Then, make corrections as necessary.

Information window
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Monitor Operation

Another powerful function of WindLDR is to monitor the PLC operation on the computer. The input and output status 
of the sample program can be monitored in the ladder diagram.
On the WindLDR Online tab, in the Monitor group, click Monitor.
When both inputs I0 and I1 are on, the ladder diagram on the monitor screen looks as follows:

Rung 1:
When both inputs I0 and I1 are on, 
output Q0 is turned off.

Rung 2:
When both inputs I0 and I1 are on, 
output Q1 is turned off.

Rung 3:
When both inputs I0 and I1 are on, 
internal relay M10 is turned on. 

M8121 is the 1-sec clock special 
internal relay.

While M10 is on, output Q2 flashes in 
1-sec increments.
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● Exit WindLDR

Click  in WindLDR, and then click Exit WindLDR.

WindLDR closes.

Application button

• If project data is saved during editing in WindO/I-NV3, control function are also saved.

• If you click  in WindLDR and then click Close, or if you close the project file while editing in 

WindO/I-NV3, you will exit WindLDR.
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2.2 Instructions Reference

The instructions for ladder program are divided into basic instructions, which perform sequencing, and advanced 
instructions, which perform moves, comparisons, Boolean computations, binary arithmetic operations, bit shifts, and 
other operations. Some instruction words cannot be used in interrupt processes.

● Basic Instruction List

In an interrupt process, the processing of the main program is interrupted, using the interrupt input, timer 
interrupt, and high-speed counter of function settings, and a specified subroutine is executed. If a 
subroutine that includes instruction words that cannot be used in interrupt processes is executed, a ladder 
program execution error occurs.

The input and operation of SmartAXIS ladder program requires specialist knowledge.
To make effective use of the SmartAXIS, take the time to develop a thorough understanding of the 
contents and programs in this manual.

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

LOD

Load 
The LOD instruction starts the logical 
operation with an NO (normally open) 
contact.
Stores intermediate results and reads 
contact status 

YES

LODN

Load Not 
The LODN instruction starts the logical 
operation with an NC (normally closed) 
contact.
Stores intermediate results and reads 
contact status 

YES

OUT

Output 

Outputs the result of bit logical operation YES

OUTN

Output Not 
Outputs the inverted result of bit logical 
operation 

YES

SET

Set 
Sets output, internal relay, data register 
bit or shift register

YES

RST

Reset 
Resets output, internal relay, data 
register bit or shift register

YES

AND

And 

Series connection of NO contact YES

ANDN

And Not 

Series connection of NC contact YES

OR

Or 

Parallel connection of NO contact YES

ORN

Or Not 

Parallel connection of NC contact YES

S

R
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AND·LOD

And Load 

Series connection of circuit blocks YES

OR·LOD

Or Load 

Parallel connection of circuit blocks YES

BPS Bit Push 
Saves the result of bit logical operation 
temporarily 

YES

BRD Bit Read 
Reads the result of bit logical operation 
which was saved temporarily 

YES

BPP Bit Pop 
Restores the result of bit logical 
operation which was saved temporarily 

YES

SOTU

Single Output Up 

Falling-edge differentiation output NO

SOTD

Single Output Down 

Rising-edge differentiation output NO

TML

1-sec Timer 

1 sec On Delay timer NO

TIM

100-ms Timer 

100 msec ON Delay timer NO

TMH

10-ms Timer 

10 msec ON Delay timer NO

TMS

1-ms Timer 

1 msec ON Delay timer NO

TMLO

1-sec Off-delay Timer 

1 sec OFF Delay timer NO

TIMO

100-ms Off-delay Timer 

100 msec OFF Delay timer NO

TMHO

10-ms Off-delay Timer 

10 msec OFF Delay timer NO

TMSO

1-ms Off-delay Timer 

1 msec OFF Delay timer NO

CNT

Counter

Adding counter  NO

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

SOTU

SOTD

TML

***
T***

TIM

****

T***

TMH

****

T***

TMS

****

T***

TMLO

****

T***

TIMO

****

T***

TMHO

****

T***

TMSO

****

T***

CNT

****

C***
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CDP

Dual Pulse Reversible Counter 

Dual Pulse Reversible Counter NO

CUD

Up/Down Selection Reversible Counter

Up/down selection reversible counter  NO

CNTD

Double-word Adding Counter 

Double-word adding counter  NO

CDPD

Double-word Dual Pulse Reversible Counter 

Double-word dual pulse reversible 
counter  

NO

CUDD

Double-word Up/Down Selection Reversible Counter 

Double-word up/down selection 
reversible counter

NO

SFR

Forward shift register 

Forward shift register NO

SFRN

Reverse shift register 

Reverse shift register NO

CC=

Counter Comparison (=) 
Equal to comparison of counter current 
value 

YES

CC>=

Counter Comparison (>=)
Greater than or equal to comparison of 
counter current value 

YES

DC=

Data Register Comparison (=) 
Equal to comparison of data register 
value 

YES

DC>=

Data Register Comparison (>=)
Greater than or equal to comparison of 
data register value 

YES

MCS

Master Control Set

Starts a master control YES

MCR

Master Control Reset  

Ends a master control YES

JMP

Jump 

Jumps a designated program area YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

CDP

****

C***

CUD

****

C***

CNTD

****

C***

CDPD

****

C***

CUDD

****

C***

SFR

****

R***

SFRN

****

R***

CC＝
****

C***

CC>=

****

C***

DC＝
****

D****

DC>=

****

D****

MCS

MCR

JMP
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JEND

Jump End 

Ends a jump instruction YES

END

End 

Ends a program YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

JEND

END
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● Advanced Instruction List

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

NOP

NOP 

No Operation YES

MOV

Move When input is on, 16- or 32-bit data from device 
designated by S1 is moved to device designated by D1.
S1 → D1

YES

MOVN

Move Not When input is on, 16- or 32-bit data from device 
designated by S1 is inverted bit by bit and moved to 
device designated by D1.
S1 NOT → D1

YES

IMOV

Indirect Move 
When input is on, the values contained in devices 
designated by S1 and S2 are added to determine the 
source of data. The 16- or 32-bit data so determined is 
moved to destination, which is determined by the sum of 
values contained in devices designated by D1 and D2.
S1 + S2 → D1 + D2

YES

IMOVN

Indirect Move Not 

When input is on, the values contained in devices 
designated by S1 and S2 are added to determine the 
source of data. The 16- or 32-bit data so determined is 
inverted and moved to destination, which is determined 
by the sum of values contained in devices designated by 
D1 and D2.
S1 + S2 NOT → D1 + D2

YES

IBMV

Indirect Bit Move 
When input is on, the values contained in devices 
designated by S1 and S2 are added to determine the 
source of data. The 1-bit data so determined is moved to 
destination, which is determined by the sum of values 
contained in devices designed by D1 and D2. 
S1 + S2 → D1 + D2

YES

IBMVN

Indirect Bit Move Not 

When input is on, the values contained in devices 
designated by S1 and S2 are added to determine the 
source of data. The 1-bit data so determined is inverted 
and moved to destination, which is determined by the 
sum of values contained in devices designated by D1 and 
D2.
S1 + S2 NOT → D1 + D2

YES

BMOV

Block Move 
When input is on, N blocks of 16-bit word data starting 
with device designated by S1 are moved to N blocks of 
destinations, starting with device designated by D1. N-W 
specifies the quantity of blocks to move.
S1, S1+1, S1+2, ... , S1+N–1 → D1, D1+1, 
D1+2, ... , D1+N–1

YES

NSET

N Data Set 
When input is on, N blocks of 16- or 32-bit data in 
devices designated by S1, S2, S3, ... , Sn are moved to N 
blocks of destinations, starting with device designated by 
D1.
S1, S2, S3, ... , Sn → D1, D2, D3, ... , Dn

YES

NRS

N Data Repeat Set When input is on, 16- or 32-bit data designated by S1 is 
set to N blocks of destinations, starting with device 
designated by D1.
S1 → D1, D2, D3, ... , Dn–1

YES

XCHG

Exchange When input is on, the 16- or 32-bit data in devices 
designated by D1 and D2 are exchanged with each other. 

YESWord data type: D1 ↔ D2

Double-word data type: D1·D1+1 → D2, D2+1

NOP

REP

**

D1(R)

*****

S1(R)

*****

MOV(*)

REP

**

D1(R)

*****

S1(R)

*****

MOVN(*)

IMOV(*) REP

**

D1(R)

*****

S1(R)

*****

S2

*****

D2

*****

IMOVN(*) REP

**

D1(R)

*****

S1(R)

*****

S2

*****

D2

*****

IBMV REP

**

D1(R)

*****

S1(R)

*****

S2

*****

D2

*****

IBMVN REP

**

D1(R)

*****

S1(R)

*****

S2

*****

D2

*****

N_W

*****

S1

*****

BMOV(W) D1

*****

S2

*****

S1

*****

NSET(*) S3

*****

D1

*****

S1

*****

N-W

*****

NRS(*) D1

*****

D1

*****

XCHG(*) D2

*****
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TCCST

Timer/Counter Current Value Store  When input is on, 16- or 32-bit data designated by S1 is 
read out and stored to the current value of device 
designated by D1.
S1 → D1

YES

CMP=

Compare Equal To 

When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are compared. When S1 data is 
equal to S2 data, destination device D1 is turned on. 
When the condition is not met, D1 is turned off. YES

Data type W or I: S1 = S2 → D1 on

Data type D, L, or F: S1·S1+1 = S2·S2+1 → D1 on

CMP<>

Compare Unequal To 

When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are compared. When S1 data is 
not equal to S2 data, destination device D1 is turned on. 
When the condition is not met, D1 is turned off. YES

Data type W or I: S1 ≠ S2 → D1 on

Data type D, L, or F: S1·S1+1 S2·S2+1→ D1 on

CMP<

Compare Less Than 

When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are compared. When S1 data is 
less than S2 data, destination device D1 is turned on. 
When the condition is not met, D1 is turned off. YES

Data type W or I: S1 < S2 → D1 on

Data type D, L, or F: S1·S1+1 < S2·S2+1 → D1 on

CMP>

Compare Greater Than 

When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are compared. When S1 data is 
greater than S2 data, destination device D1 is turned on. 
When the condition is not met, D1 is turned off. YES

Data type W or I: S1 > S2 → D1 on

Data type D, L, or F: S1·S1+1 > S2·S2+1 → D1 on

CMP<=

Compare Less Than or Equal To 

When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are compared. When S1 data is 
less than or equal to S2 data, destination device D1 is 
turned on. When the condition is not met, D1 is turned 
off.

YES

Data type W or I: S1 ≤ S2 → D1 on

Data type D, L, or F: S1·S1+1 ≤ S2·S2+1 → D1 on

CMP>=

Compare Greater Than or Equal To 

When input is on, 16- or 32-bit data designated by source 
devices S1 and S2 are compared. When S1 data is greater 
than or equal to S2 data, destination device D1 is turned 
on. When the condition is not met, D1 is turned off. YES

Data type W or I: S1 ≥ S2 → D1 on

Data type D, L, or F: S1·S1+1 ≥ S2·S2+1 → D1 on

ICMP>=

Interval Compare Greater Than or Equal To

When input is on, the 16- or 32-bit data designated by 
S1, S2, and S3 are compared. When the condition is met, 
destination device D1 is turned on. When the condition is 
not met, D1 is turned off.

YES
Data type W or I: S1 ≤ S2 ≤ S3 → D1 on

Data type D, L, or F:

S1·S1+1 ≤ S2·S2+1 ≤ S3·S3+1 → D1 on

LC=

Load Compare Equal To 

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is equal to S2 
data, the output to the following instructions is turned on. 
When the condition is not met, the output is turned off. YES

Data type W or I: S1 = S2

Data type D, L, or F: S1·S1+1 = S2·S2+1

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

REP

**

D1(R)

*****

S1(R)

*****

TCCST(*)

REP

**

D1(R)

*****

S2(R)

*****

CMP=(*)

AND/OR

S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

CMP<>(*)

AND/OR

S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

CMP<(*)

AND/OR

S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

CMP>(*)

AND/OR

S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

CMP<=(*)

AND/OR

S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

CMP>=(*)

AND/OR

S1(R)

*****

D1

*****

S2

*****

ICMP>=(*) S1

*****

S3

*****

LC=(*)

****    ****
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LC<>

Load Compare Unequal To 

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is equal to S2 
data, the output to the following instructions is turned 
on. When the condition is not met, the output is turned 
off.

YES

Data type W or I: S1 ≠ S2

Data type D, L, or F: S1·S1+1 ≠ S2·S2+1

LC<

Load Compare Less Than 

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is less than S2 
data, the output to the following instructions is turned 
on. When the condition is not met, the output is turned 
off.

YES

Data type W or I: S1 < S2

Data type D, L, or F: S1·S1+1 < S2·S2+1

LC>

Load Compare Greater Than 

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is greater than 
S2 data, the output to the following instructions is turned 
on. When the condition is not met, the output is turned 
off.

YES

Data type W or I: S1 > S2

Data type D, L, or F: S1·S1+1 > S2·S2+1

LC<=

Load Compare Less Than or Equal To

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is less than or 
equal to S2 data, the output to the following instructions 
is turned on. When the condition is not met, the output is 
turned off.

YES

Data type W or I: S1 ≤ S2

Data type D, L, or F: S1·S1+1 ≤ S2·S2+1

LC>=

Load Compare Greater Than or Equal To

This instruction constantly compares 16- or 32- bit data 
designated by S1 and S2. When S1 data is greater than 
or equal to S2 data, the output to the following 
instructions is turned on. When the condition is not met, 
the output is turned off.

YES

Data type W or I: S1 ≥ S2

Data type D, L, or F: S1·S1+1 ≥ S2·S2+1

ADD

Addition 
When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are added. The result is set to 
destination device D1 and carry (M8003). YES
Data type W or I: S1 + S2 → D1, CY

Data type D, L, or F: S1·S1+1 + S2·S2+1→ D1·D1+1, CY

SUB

Subtraction 

When input is on, 16- or 32-bit data designated by 
source device S2 is subtracted from 16- or 32-bit data 
designated by source device S1. The result is set to 
destination device D1 and borrow (M8003). YES

Data type W or I: S1  - S2 → D1, BW

Data type D, L, or F: S1·S1+1  - S2·S2+1 → D1·D1+1, BW

MUL

Multiplication 

When input is on, 16- or 32-bit data designated by 
source device S1 is multiplied by 16- or 32-bit data 
designated by source device S2. The result is set to 
destination device D1. When the result exceeds the valid 
range for data types D or L, the special internal relay 
M8004 (ladder program execution error) is turned on.

YES

Data type W or I: S1 X S2 → D1·D1+1 

Data type D, L, or F: S1·S1+1 X S2·S2+1 → D1·D1+1

Symbol Name and Diagram Function
Interrupt 
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Execution

LC<>(*)

****    ****

LC<(*)

****    ****

LC>(*)

****    ****

LC<=(*)

****    ****

LC>=(*)

****    ****

REP

**

D1(R)

*****

S2(R)

*****

ADD(*) S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

SUB(*) S1(R)

*****

REP

**

D1(R)

*****

S2(R)

*****

MUL(*) S1(R)

*****
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DIV

Division 

When input is on, 16- or 32-bit data designated by 
source device S1 is divided by 16- or 32-bit data 
designated by source device S2. The quotient is set to 
16- or 32-bit destination device D1, and the remainder is 
set to the next 16- or 32-bit data. Data type F does not 
generate a remainder.
When S2 is 0 (dividing by 0), the special internal relay 
M8004 (ladder program execution error) is turned on.

YESData type W or I:

  S1 ÷ S2 → D1 (quotient), D1+1 (remainder) 

Data type D or L:

  S1·S1+1 ÷ S2·S2+1 → D1·D1+1 (quotient), 

D1+2·D1+3 (remainder) 

Data type F:

  S1·S1+1 ÷ S2·S2+1 → D1·D1+1 (quotient)

INC

Increment 
When input is on, one is added to the 16- or 32-bit data 
designated by device S/D and the result is stored to the 
same device. YES
Data type W or I: S/D + 1 → S/D

Data type D or L: S/D·S/D+1 + 1 → S/D·S/D+1

DEC

Decrement 
When input is on, one is subtracted from the 16- or 32-
bit data designated by device S/D and the result is stored 
to the same device. YES
Data type W or I: S/D – 1 → S/D

Data type D or L: S/D·S/D+1 – 1 → S/D·S/D+1 

ROOT

Root 

When input is on, the square root of device designated 
by S1 is extracted and is stored to the destination 
designated by D1.
The square root is calculated to two decimals, omitting 
the figures below the second place of decimals, and 
multiplied by 100.

YES

Data type W:

When input is on, the square root of device designated 
by S1·S1+1 is extracted and is stored to the destination 
designated by D1·D1+1.
The square root is calculated to two decimals, omitting 
the figures below the second place of decimals, and 
multiplied by 100.

Data type D:

When input is on, the square root of device designated 
by S1·S1+1 is extracted and is stored to the destination 
designated by D1·D1+1.

Data type F:

SUM

Sum  

Calculate the total of designated data, depending on the 
calculation option.
ADD:
When input is on, N blocks of 16- or 32-bit data starting 
at device designated by S1 are added and the result is 
stored to device designated by D1. S2 specifies the 
quantity of data blocks.
XOR:
When input is on, N blocks of 16-bit data starting at 
device designated by S1 are XORed and the result is 
stored to device designated by D1. S2 specifies the 
quantity of data blocks.

YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

REP

**

D1(R)

*****

S2(R)

*****

DIV(*) S1(R)

*****

S / D

*****

INC(*)

S / D

*****

DEC(*)

S1

*****

ROOT(*) D1

*****

S1 → D1

S1·S1+1 → D1·D1+1

S1·S1+1 → D1·D1+1

S2

*****

S1

*****

SUM(*)

ADD/XOR

D1

*****
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ANDW

AND Word When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are ANDed, bit by bit. The 
result is set to destination device D1.
S1 · S2 → D1

YES

ORW

OR Word When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are ORed, bit by bit. The result 
is set to destination device D1.
S1 + S2 → D1

YES

XORW

Exclusive OR Word When input is on, 16- or 32-bit data designated by 
source devices S1 and S2 are exclusive ORed, bit by bit. 
The result is set to destination device D1.

 → D1

YES

SFTL

Shift Left 

When input is on, N_B-bit data string starting with 
source device S1 is shifted to the left by the quantity of 
bits designated by device Bits. 
The result is set to source device S1, and the last bit 
status shifted out is set to a carry (special internal relay 
M8003). Zero or 1 designated by source device S2 is set 
to the LSB.
CY ← S1

YES

SFTR

Shift Right 

When input is on, N_B-bit data string starting with 
source device S1 is shifted to the right by the quantity of 
bits designated by device Bits. 
The result is set to source device S1, and the last bit 
status shifted out is set to a carry (special internal relay 
M8003). Zero or 1 designated by source device S2 is set 
to the MSB.
S1 → CY

YES

BCDLS

BCD Left Shift 

When input is on, the 32-bit binary data designated by 
S1 is converted into 8 BCD digits, shifted to the left by 
the quantity of digits designated by S2, and converted 
back to 32-bit binary data. 
Valid values for each of S1 and S1+1 are 0 through 
9999.
The quantity of digits to shift can be 1 through 7.
Zeros are set to the lowest digits as many as the digits 
shifted.

YES

WSFT

Word Shift 
When input is on, N blocks of 16-bit word data starting 
with device designated by D1 are shifted up to the next 
16-bit positions. At the same time, the data designated 
by device S1 is moved to device designated by D1. S2 
specifies the quantity of blocks to move.

YES

ROTL

Rotate Left 
When input is on, 16- or 32-bit data of the designated 
source device S1 is rotated to the left by the quantity of 
bits designated by device bits. 
The result is set to the source device S1, and the last bit 
status rotated out is set to a carry (special internal relay 
M8003).

YES

ROTR

Rotate Right 
When input is on, 16- or 32-bit data of the designated 
source device S1 is rotated to the right by the quantity of 
bits designated by device bits. 
The result is set to the source device S1, and the last bit 
status rotated out is set to a carry (special internal relay 
M8003).

YES

HTOB

Hex to BCD 

When input is on, the 16- or 32-bit data designated by 
S1 is converted into BCD and stored to the destination 
designated by device D1.
Valid values for the source device are 0 through 9999 for 
the word data type, and 0 through 9999 9999 for the 
double-word data type.
S1 → D1

YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

S2(R)

*****

S1(R)

*****

ANDW(*) S3(R)

*****

REP

**

S2(R)

*****

S1(R)

*****

ORW(*) S3(R)

*****

REP

**

S2(R)

*****

S1(R)

*****

XORW(*) S3(R)

*****

REP

**
S1 S2⊕

S2

*****

S1

*****

SFTL N_B

*****

bits

**

S2

*****

S1

*****

SFTR N_B

*****

bits

**

S1

*****

BCDLS S2

**

S2

*****

S1

*****

WSFT D1

*****

S1

*****

ROTL(*) bits

**

S1

*****

ROTR(*) bits

**

S1

*****

HTOB(*) D1

*****



SmartAXIS Touch User's Manual 12-23

2 Ladder Program

12

Control Function

BTOH

BCD to Hex 

When input is on, the BCD data designated by S1 is 
converted into 16- or 32-bit binary data and stored to the 
destination designated by device D1.
Valid values for the source device are 0 through 9999 
(BCD) for the word data type, and 0 through 9999 9999 
(BCD) for the double-word data type.
S1 → D1

YES

HTOA

Hex to ASCII 

When input is on, the 16-bit binary data designated by 
S1 is read from the lowest digit as many as the quantity 
of digits designated by S2, converted into ASCII data, 
and stored to the destination starting with the device 
designated by D1.
The quantity of digits to convert can be 1 through 4.
S1 → D1, D1+1, D1+2, D1+3

YES

ATOH

ASCII to Hex 

When input is on, the ASCII data designated by S1 as 
many as the quantity of digits designated by S2 is 
converted into 16-bit binary data, and stored to the 
destination designated by device D1.
Valid values for source data to convert are 30h to 39h 
and 41h to 46h.
The quantity of digits to convert can be 1 through 4.
S1, S1+1, S1+2, S1+3 → D1

YES

BTOA

BCD to ASCII 

When input is on, the 16- or 32-bit binary data 
designated by S1 is converted into BCD, and converted 
into ASCII data. The data is read from the lowest digit as 
many as the quantity of digits designated by S2. The 
result is stored to the destination starting with the device 
designated by D1.
The quantity of digits to convert can be 1 through 5 for 
the word data type, and 1 through 10 for the double-
word data type.

YES

Word data type: S1 → D1, D1+1, D1+2, D1+3, D1+4

Double-word data type: S1·S1+1 → D1, D1+1, D1+2, ... , D1+9

ATOB

ASCII to BCD 

When input is on, the ASCII data designated by S1 as 
many as the quantity of digits designated by S2 is 
converted into BCD, and converted into 16- or 32-bit 
binary data. The result is stored to the destination 
designated by device D1.
Valid values for source data to convert are 30h through 
39h.
The quantity of digits to convert can be 1 through 5 for 
the word data type, and 1 through 10 for the double-
word data type.

YES

Word data type: S1, S1+1, S1+2, S1+3, S1+4 → D1

Double-word data type: S1, S1+1, S1+2, ... , S1+9 → D1·D1+1

ENCO

Encode

When input is on, a bit which is on is sought. The search 
begins at S1 until the first point which is set (on) is 
located. The quantity of points from S1 to the first set 
point (offset) is stored to the destination designated by 
device D1. 
If no point is on in the searched area, 65535 is stored to 
D1.

YES

DECO

Decode When input is on, the values contained in devices 
designated by S1 and D1 are added to determine the 
destination, and the bit so determined is turned on.

YES

BCNT

Bit Count
When input is on, bits which are on are sought in an 
array of consecutive bits starting at the point designated 
by source device S1. Source device S2 designates the 
quantity of bits searched. The quantity of bits which are 
on is stored to the destination designated by device D1.

YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

S1

*****

BTOH(*) D1

*****

S2

*****

S1

*****

HTOA(*) D1

*****

S2

*****

S1

*****

ATOH(*) D1

*****

S2

*****

S1

*****

BTOA(*) D1

*****

S2

*****

S1

*****

ATOB(*) D1

*****

S1

*****

ENCO

Bits

D1

*****

S1

*****

DECO D1

*****

S2

*****

S1

*****

BCNT D1

*****
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ALT

Alternate Output 

When input is turned on, output, internal relay, or shift 
register bit designated by D1 is turned on and remains 
on after the input is turned off. 
When input is turned on again, the designated output, 
internal relay, or shift register bit is turned off.
The ALT instruction must be used with a SOTU or SOTD 
instruction, otherwise the designated output, internal 
relay, or shift register bit repeats to turn on and off in 
each scan.

YES

CVDT

Convert Data Type 

When input is on, the data type of the 16- or 32-bit data 
designated by S1 is converted and stored to the 
destination designated by device D1. 
Data types can be designated for the source and 
destination, separately.

When the same data type is designated for both source 
and destination, the CVDT instruction has the same 
function as the MOV instruction.
Unless F (float) data type is selected for both source and 
destination, only the integral number is moved, omitting 
the fraction.
When the source data exceeds the range of destination 
data type, the destination stores a value closest to the 
source data within the destination data type.
S1 → D1

YES

DTDV

Data Divide 
When input is on, the 16-bit binary data designated by S1 
is divided into upper and lower bytes. The upper byte 
data is stored to the destination designated by device D1. 
The lower byte data is stored to the device next to D1.
S1 → D1, D1+1

YES

DTCB

Data Combine 

When input is on, the lower-byte data is read out from 2 
consecutive sources starting with device designated by 
S1 and combined to make 16-bit data. The lower byte 
data from the first source device is moved to the upper 
byte of the destination designated by device D1, and the 
lower byte data from the next source device is moved to 
the lower byte of the destination.
S1, S1+1 → D1

YES

SWAP

Data Swap 
When input is on, upper and lower byte- or word-data of 
a word- or double-word-data designated by S1 are 
exchanged, and the result is stored to destination 
designated by D1.
S1 → D1

YES

WEEK

Weekly Timer Specified day of the week and ON time and OFF time are 
compared with the current day/time, and the result is 
output

NO

YEAR

Yearly Timer 
Specified date and current date are compared and result 
is output NO

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

 D1

*****

ALT
SOTU

D1 (R)

*****

S1 (R)

*****

CVDT

*TO*

REP

**

Data Type W, I D, L, F
Source S1 S1·S1+1
Destination D1 D1·D1+1

S1

*****

DTDV(*) D1

*****

S1

*****

DTCB(*) D1

*****

D1 (R)

*****

S1 (R)

*****

SWAP(*) REP

**

D1

*****

S2

*****

WEEK S1

*****

S3

*****

D1

*****

S2

*****

YEAR S1

*****

S3

*****
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LABEL

Label 

This is the label number, from 0 to 127 (all-in-one type 
CPU) or 0 to 255 (slim type CPU), used at the program 
address where the execution of program instructions 
begins for a program branch.
An END instruction may be used to separate a tagged 
portion of the program from the main program. In this 
way, scan time is minimized by not executing the 
program branch unless input conditions are satisfied.
Note: The same label number cannot be used more 
than once.

YES

LJMP

Label Jump 

When input is on, jump to the address with label 0 
through 127 (all-in-one type CPU) or 0 to 255 (slim type 
CPU) designated by S1.
When input is off, no jump takes place, and program 
execution proceeds with the next instruction.
The LJMP instruction is used as an “either/or” choice 
between two portions of a program. Program execution 
does not return to the instruction following the LJMP 
instruction, after the program branch.

YES

LCAL

Label Call 

When input is on, the address with label 0 through 127 
(all-in-one type CPU) or 0 to 255 (slim type CPU) 
designated by S1 is called. When input is off, no call 
takes place, and program execution proceeds with the 
next instruction.
The LCAL instruction calls a subroutine, and returns to 
the main program after the branch is executed. A LRET 
instruction (see below) must be placed at the end of a 
program branch which is called, so that normal program 
execution resumes by returning to the instruction 
following the LCAL instruction.
Note: The END instruction must be used to separate the 
main program from any subroutines called by the LCAL 
instruction.
A maximum of four LCAL instructions can be nested. 
When more than four LCAL instructions are nested, a 
ladder program execution error will result, turning on 
special internal relay M8004.

YES

LRET

Label Return 

This instruction is placed at the end of a subroutine 
called by the LCAL instruction. When the subroutine is 
completed, normal program execution resumes by 
returning to the instruction following the LCAL 
instruction.
The LRET must be placed at the end of the subroutine 
starting with a LABEL instruction. When the LRET is 
programmed at other places, a ladder program execution 
error will result, turning on special internal relay M8004.

YES

DJNZ

Decrement Jump Non-zero 

When input is on, the value stored in the data register 
designated by S1 is decremented by one and is checked. 
If the resultant value is not 0, program execution jumps 
to address with label 0 through 127 (all-in-one CPU) or 
255 (slim CPU) designated by S2. If the decrement 
results in 0, no jump takes place, and program execution 
proceeds with the next instruction.

YES

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

LABEL

***

LJMP S1

*****

LCAL S1

*****

LRET

S2

*****

S1

*****

DJNZ
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IOREF

I/O Refresh 

When input is on, 1-bit I/O data designated by source 
device S1 is refreshed immediately regardless of the scan 
time.
When I (input) is used as S1, the actual input status is 
immediately read into an internal relay starting with 
M300 allocated to each input available on the CPU 
module.
When Q (output) is used as S1, the output data in the 
RAM is immediately written to the actual output available 
on the CPU module.
Refresh instructions are useful when a real-time 
response is required in a user program which has a long 
scan time. The refresh instruction is most effective when 
using the refresh instruction at a ladder step immediately 
before using the data.
The IOREF instruction can be used with an interrupt 
input or timer interrupt to refresh data.

YES

HSCRF

High-speed Counter Refresh 

When input is on, the HSCRF instruction refreshes the 
high-speed counter current values in special data 
registers in real time.
The current values of four high-speed counters HSC1 
through HSC4 are usually updated in every scan. The 
HSCRF can be used in any place in the ladder diagram 
where you want to read the updated high-speed counter 
current value.

YES

DI

Disable Interrupt 
When input is on, interrupt inputs and timer interrupt 
designated by source device S1 are disabled. NO

EI

Enable Interrupt 
When input is on, interrupt inputs and timer interrupt 
designated by source device S1 are enabled. NO

XYFS

XY Format Set 
When input is on, the format for XY conversion is set. 
The XY coordinates define the linear relationship 
between X and Y. 

NO

CVXTY

Convert X to Y When input is on, the X value designated by device S2 is 
converted into corresponding Y value according to the 
linear relationship defined in the XYFS instruction. The 
conversion result is set to the device designated by D1.

NO

CVYTX

Convert Y to X When input is on, the Y value designated by device S2 is 
converted into corresponding X value according to the 
linear relationship defined in the XYFS instruction. The 
conversion result is set to the device designated by D1.

NO

AVRG

Average 

When input is on, sampling data designated by device S1 
is processed according to sampling conditions designated 
by devices S2 and S3.
When sampling is complete, average, maximum, and 
minimum values are stored to 3 consecutive devices 
starting with device designated by D1, then sampling 
completion output designated by device D2 is turned on.

NO

DTML

1-sec Dual Timer While input is on, destination device D1 repeats to turn 
on and off for a duration designated by devices S1 and 
S2, respectively.
The time range is 0 through 65535 sec.

NO

DTIM

100-msec Dual Timer While input is on, destination device D1 repeats to turn 
on and off for a duration designated by devices S1 and 
S2, respectively.
The time range is 0 through 6553.5 sec.

NO

DTMH

10-msec Dual Timer While input is on, destination device D1 repeats to turn 
on and off for a duration designated by devices S1 and 
S2, respectively.
The time range is 0 through 655.35 sec.

NO

Symbol Name and Diagram Function
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IOREF S1

*****

HSCRF

*

DI S1

**

EI S1

**

Yn

*****

Xn

*****

S1

*

XYFS(*) Y0

*****

X0

*****

.....

S2

*****

S1

*****

CVXTY(*) D1

****

S2

*****

S1

*****

CVYTX(*) D1

****

D2

*****

D1

*****

AVRG(*) S3

*****

S2

*****

S1

*****

D2

*****

S2

*****

DTML S1

*****

D1

*****

D2

*****

S2

*****

DTIM S1

*****

D1

*****

D2

*****

S2

*****

DTMH S1

*****

D1

*****
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DTMS

1-msec Dual Timer While input is on, destination device D1 repeats to turn 
on and off for a duration designated by devices S1 and 
S2, respectively.
The time range is 0 through 65.535 sec.

NO

TTIM

Teaching Timer While input is on, the ON duration is measured in units of 
100 ms and the measured value is stored to a data 
register designated by destination device D1.
The measured time range is 0 through 6553.5 sec.

NO

RAD

Degree to Radian When input is on, the degree value designated by source 
device S1 is converted into a radian value and stored to 
the destination designated by device D1.
S1·S1+1° × /180 → D1·D1+1 rad

YES

DEG

Radian to Degree When input is on, the radian value designated by source 
device S1 is converted into a degree value and stored to 
the destination designated by device D1.
S1·S1+1 rad × 180/  → D1·D1+1°

YES

SIN

Sine When input is on, the sine of the radian value designated 
by source device S1 is stored to the destination 
designated by device D1.
sin S1·S1+1 → D1·D1+1

YES

COS

Cosine When input is on, the cosine of the radian value 
designated by source device S1 is stored to the 
destination designated by device D1.
cos S1·S1+1 → D1·D1+1

YES

TAN

Tangent When input is on, the tangent of the radian value 
designated by source device S1 is stored to the 
destination designated by device D1.
tan S1·S1+1 → D1·D1+1

YES

ASIN

Arc Sine 

When input is on, the arc sine of the value designated by 
source device S1 is stored in radians to the destination 
designated by device D1.
asin S1·S1+1 → D1·D1+1 rad
If the S1·S1+1 value is not within this range, an 
indefinite value is stored to D1·D1+1.
The S1·S1+1 value must be within the following range:
-1.0 ≤ S1·S1+1 ≤ -1.0
If the S1·S1+1 value is not within this range, an 
indefinite value is stored to D1·D1+1.

YES

ACOS

Arc Cosine 

When input is on, the arc cosine of the value designated 
by source device S1 is stored in radians to the 
destination designated by device D1.
acos S1·S1+1 → D1·D1+1 rad
If the S1·S1+1 value is not within this range, an 
indefinite value is stored to D1·D1+1.
The S1·S1+1 value must be within the following range:
-1.0 ≤ S1·S1+1 ≤ -1.0
If the S1·S1+1 value is not within this range, an 
indefinite value is stored to D1·D1+1.

YES

ATAN

Arc Tangent When input is on, the arc tangent of the value 
designated by source device S1 is stored in radians to 
the destination designated by device D1.
atan S1·S1+1 → D1·D1+1 rad

YES

LOGE

Natural Logarithm When input is on, the natural logarithm of the binary 
data designated by source device S1 is stored to the 
destination designated by device D1.
loge S1·S1+1 → D1·D1+1

YES

LOG10

Common Logarithm When input is on, the common logarithm of the binary 
data designated by source device S1 is stored to the 
destination designated by device D1.
log10 S1·S1+1 → D1·D1+1

YES

Symbol Name and Diagram Function
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D2

*****

S2

*****

DTMS S1

*****

D1

*****

TTIM D1

*****

D1

*****

S1

*****

RAD(F)

π

D1

*****

S1

*****

DEG(F)

π

D1

*****

S1

*****

SIN(F)

D1

*****

S1

*****

COS(F)

D1

*****

S1

*****

TAN(F)

D1

*****

S1

*****

ASIN(F)

D1

*****

S1

*****

ACOS(F)

D1

*****

S1

*****

ATAN(F)

D1

*****

S1

*****

LOGE(F)

D1

*****

S1

*****

LOG10(F)
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EXP

Exponent 
When input is on, e is raised to the power S1·S1+1 
designated by source device S1 and is stored to the 
destination designated by device D1.
e (base of natural logarithm) = 2.7182818
eS1·S1+1 → D1·D1+1

YES

POW

Power 
When input is on, binary data designated by source 
device S1 is raised to the power S2·S2+1 designated by 
source device S2 and the operation result is stored to the 
destination designated by device D1.
S1·S1+1S2·S2+1 → D1·D1+1

YES

FIFOF

FIFO Format When input is on, FIFOF instruction initializes an FIFO 
data file. Each data file has unique number 0 through 9. 
A maximum of 10 data files can be used in a user 
program.

NO

FIEX

First-In Execute When input is on, the data stored in data registers 
starting with the device designated by S1 is stored to the 
corresponding FIFO data file.

YES

FOEX

First-Out Execute When input is on, the data is retrieved from the 
corresponding FIFO data file and stored to the data 
registers starting with the device designated by D1.

YES

NDSRC

N Data Search 

When input is on, a value specified by device S1 is 
sought. Data registers are searched, starting with the 
data register designated by device S2. Device S3 
specifies the quantity of 1-word or 2-word blocks of data 
registers to search, depending on the data type.
The offset of the data register where a match first occurred 
is stored in data register designated by device D1. The 
quantity of times the value was matched is stored in the 
next data register. When the search results in no match, 
65535 is stored in device D1 and 0 is stored in device D+1.

NO

TADD

Time Addition When input is on, time data designated by source device 
S2 are added to date/time data designated by source 
device S1, depending on the selected mode. The result is 
stored to destination device D1 and carry (M8003).
S1 + S2 → D1, CY

YES

TSUB

Time Subtraction When input is on, time data designated by source device S2 
are subtracted from date/time data designated by source 
device S1, depending on the selected mode. The result is 
stored to destination device D1 and borrow (M8003).
S1 – S2 → D1, CY

YES

HOUR

Hour

While input is on, the ON duration is measured. The 
measured time value (hour, minute, and second) is stored 
to 3 consecutive data registers designated by destination 
device D1 and compared with the preset value designated 
by source device S1. When the D1 value reaches the S1 
value, an output or internal relay designated by destination 
device D2 is turned on. Two data registers starting with 
destination device D3 are reserved for system work area.
S1 ↔ D1 → D2 

NO

HTOS

HMS to Sec When input is on, time data in hours, minutes, and 
seconds designated by source device S1 is converted into 
seconds. The result is stored to destination device D1.
Hours, minutes, seconds → Seconds

YES

STOH

Sec to HMS When input is on, time data in seconds designated by 
source device S1 is converted into hours, minutes, and 
seconds. The result is stored to destination device D1.
Seconds → Hours, minutes, seconds

YES

SCRPT

Script

Calls and executes a script from the ladder program. YES

PID

PID

Performs PID control. NO

Symbol Name and Diagram Function
Interrupt 
Program 

Execution

D1

*****

S1

*****

EXP(F)

S2

*****

S1

*****

POW(F) D1

****

D2

****

S2

*****

FIFOF(W)

*

S1

****

D1

****

FIEX(W)

*

S1

*****

FOEX(W)

*

D1

*****

D1

*****

S2

*****

NDSRC(W) S1

*****

S3

*****

S2

***

S1

***

TADD

Mode

D1

*****

S2

***

S1

***

TSUB

Mode

D1

*****

D3

*****

D1

*****

HOUR S1

*****

D2

*****

D1

*****

S1

*****

HTOS

D1

*****

S1

*****

STOH

D1

*****

S1

*****

SCRPT

S4
＊＊＊＊＊

S2
＊＊＊＊＊

PID S1
＊＊＊＊＊

S3
＊＊＊＊＊
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● Available Data
The available data types for each command word are as follows.

In WindLDR data types are displayed as follows: BIN16(+) as W (word), BIN16(+/-) as I (integer), 
BIN32(+) as D (double word), BIN32(+/-) as L (long), and float32 as F (float).

Group

Data Type 

W I D L F

Word Integer Double word Long Float

NOP NOP NO NO NO NO NO

Move 

MOV YES YES YES YES YES

MOVN YES YES YES YES NO

IMOV YES NO YES NO YES

IMOVN YES NO YES NO NO

IBMV(N) YES NO NO NO NO

BMOV YES NO NO NO NO

NSET YES YES YES YES YES

NRS YES YES YES YES YES

XCHG YES NO YES NO NO

TCCST YES NO YES NO NO

Data 
Comparison 

CMP= YES YES YES YES YES

CMP<> YES YES YES YES YES

CMP< YES YES YES YES YES

CMP> YES YES YES YES YES

CMP<= YES YES YES YES YES

CMP>= YES YES YES YES YES

ICMP>= YES YES YES YES YES

LC= YES YES YES YES YES

LC<> YES YES YES YES YES

LC< YES YES YES YES YES

LC> YES YES YES YES YES

LC<= YES YES YES YES YES

LC>= YES YES YES YES YES

Binary 
Arithmetic 

ADD YES YES YES YES YES

SUB YES YES YES YES YES

MUL YES YES YES YES YES

DIV YES YES YES YES YES

INC YES YES YES YES NO

DEC YES YES YES YES NO

ROOT YES NO YES NO YES

SUM(ADD) YES YES YES YES YES

SUM(XOR) YES NO NO NO NO

Boolean 
Computation 

ANDW YES NO YES NO NO

ORW YES NO YES NO NO

XORW YES NO YES NO NO
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Shift and Rotate 

SFTL NO NO NO NO NO

SFTR NO NO NO NO NO

BCDLS NO NO YES NO NO

WSFT YES NO NO NO NO

ROTL YES NO YES NO NO

ROTR YES NO YES NO NO

Data Conversion 

HTOB YES NO YES NO NO

BTOH YES NO YES NO NO

HTOA YES NO NO NO NO

ATOH YES NO NO NO NO

BTOA YES NO YES NO NO

ATOB YES NO YES NO NO

ENCO NO NO NO NO NO

DECO NO NO NO NO NO

BCNT NO NO NO NO NO

ALT NO NO NO NO NO

CVDT YES YES YES YES YES

DTDV YES NO NO NO NO

DTCB YES NO NO NO NO

SWAP YES NO YES NO NO

Week 
Programmer 

WEEK NO NO NO NO NO

YEAR NO NO NO NO NO

Program 
Branching 

LABEL NO NO NO NO NO

LJMP NO NO NO NO NO

LCAL NO NO NO NO NO

LRET NO NO NO NO NO

DJNZ NO NO NO NO NO

I/O Refresh
IOREF NO NO NO NO NO

HSCRF NO NO NO NO NO

Enable/Disable 
Interrupt

DI NO NO NO NO NO

EI NO NO NO NO NO

Coordinate 
Conversion 

XYFS YES YES NO NO NO

CVXTY YES YES NO NO NO

CVYTX YES YES NO NO NO

Average AVRG YES YES YES YES YES

Dual / Teaching 
Timer 

DTML NO NO NO NO NO

DTIM NO NO NO NO NO

DTMH NO NO NO NO NO

DTMS NO NO NO NO NO

TTIM NO NO NO NO NO

Group

Data Type 

W I D L F

Word Integer Double word Long Float
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Trigonometric 
Function 

RAD NO NO NO NO YES

DEG NO NO NO NO YES

SIN NO NO NO NO YES

COS NO NO NO NO YES

TAN NO NO NO NO YES

ASIN NO NO NO NO YES

ACOS NO NO NO NO YES

ATAN NO NO NO NO YES

Logarithm / 
Power 

LOGE NO NO NO NO YES

LOG10 NO NO NO NO YES

EXP NO NO NO NO YES

POW NO NO NO NO YES

File Data 
Processing 

FIFOF YES NO NO NO NO

FIEX YES NO NO NO NO

FOEX YES NO NO NO NO

NDSRC YES YES YES YES YES

Clock 

TADD NO NO NO NO NO

TSUB NO NO NO NO NO

HOUR NO NO NO NO NO

HTOS NO NO NO NO NO

STOH NO NO NO NO NO

Script SCRPT YES YES YES YES YES

PID PID NO NO NO NO NO

Group

Data Type 

W I D L F

Word Integer Double word Long Float
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3.1 Basic Operation for WindLDR

This section describes basic procedures for operating WindLDR.

● Start WindLDR

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (control function).
WindLDR starts.

2 If the ladder program editing screen is displayed, click FT1A Touch on the status bar, and then click PLC Selection 
on the displayed drop-down list.
The PLC Selection dialog box is displayed.

3 Select FBD, and then click OK.

Next, create a FBD program.

3 FBD Program

The PLC Selection dialog box can also be displayed by clicking PLC Type in the PLC group on the 
Configuration tab.

To change the default programming language, select the programming language, and then click Use as 
Default.
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● Creating FBD Program
This section describes the procedure for creating a FBD program in WindLDR. 

Create a sample program using WindLDR that performs the following operation: 
• When input I0 and input I1 are both on, output Q0 turns on. 
• When either input I1 or input I2 is on, output Q1 repeatedly turns on and off in a one second cycle.

Insert input I0 

1 On the WindLDR Home tab, in the Function Block group, click Terminal, and then click I (Digital Input). 

2 Move the mouse pointer to the FBD editor, and then click the mouse button.
Input I0 is inserted at the position of the mouse pointer. 

For details about FB, refer to the "SmartAXIS FBD Programming Manual".

Circuit block Input I0 Input I1 Input I2 Action

Q0 ON ON – Turn output Q0 on 

Q1
– OFF ON Repeatedly turn output Q2 on and off in a one 

second cycle– ON OFF

The output FB and all the FBs connected on the left side of that output FB's input connectors are called the 
circuit block. The output value of the output FB is the execution result for a single circuit block. 
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Insert the AND (logical AND) FB 

1 On the WindLDR Home tab, in the Function Block group, click Basic, and then click AND (Logical AND). 

2 Move the mouse pointer to the FBD editor, and then click the mouse button.
AND B0 is inserted at the position of the mouse pointer. 

Connect input I0 and AND B0 with a connection line 

1 On the WindLDR Home tab, in the Line group, click Draw Line. 

2 Move the mouse pointer to the input I0 output connector. 
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3 Click the mouse button and drag the line to the AND B0 input 1 connector. 

4 Release the mouse button. 
The input I0 output connector and the AND B0 input 1 connector are connected. 

Insert output Q0 and connect it to the AND B0 output 

1 On the WindLDR Home tab, in the Function Block group, click Terminal, and then click Q (Digital Output). 

2 Move the mouse pointer to the FBD editor, and then click the mouse button. 
Output Q0 is inserted at the position of the mouse pointer. 

3 Connect the AND B0 output connector and the output Q0 input connector with a connection line. 
Connect them in the same manner as “Connect input I0 and AND B0 with a connection line” on page 12-34.
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Insert input I1 and connect it to AND B0 input 2 

Insert input I1 in the same manner as “Insert input I0” on page 12-33 and connect it with a connection line in the 
same manner as “Connect input I0 and AND B0 with a connection line” on page 12-34.

Insert input I2 and XOR B1 and connect input I1 and input I2 to XOR B1 input 1 and input 2 

The FB output connectors can be connected to multiple FB input connectors. Multiple FB output connectors 
cannot be connected to a single FB input connector. 
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Insert special internal relay M8121, AND B2, and output Q1 and connect them with connection lines 

This completes the FBD program. 

Conversion of Programs

1 Confirm that the program has been correctly created. 
On the WindLDR Home tab, in the Program group, click Convert. 
If the FBs are correctly connected, the conversion will be successful. If errors are found, a list of errors is displayed in 
the information window. Fix those errors in order.

M8121 is a special internal relay that repeatedly turns on and off in a one second cycle. For details on the 
special internal relay, refer to Chapter 27 “Special Internal Relay (M)” on page 27-5.

Information window
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Monitor Operation

You can monitor the operation of the downloaded program with WindLDR's monitor function. 

1 After the program is successfully downloaded, on the WindLDR Online tab, in the Monitor group, click Monitor.
The Touch state is displayed on the WindLDR screen. 

2 Monitor the following operations. 

• When you turn on both input I0 and input I1, output Q0 turns on. 

• When you turn on either input I1 or input I2, output Q1 repeatedly turns on and off in a one second cycle. 

This concludes the monitor operation. 

• You can monitor the state of the input connectors and output connectors for each FB. When input 
connectors, output connectors, and connection lines are red, they are on. Blue is off. 

• For details on the state of unconnected input connectors in the FBs, refer to the chapters for the FBs in 
the "SmartAXIS FBD Programming Manual".
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● Exit WindLDR

Click  in WindLDR, and then click Exit WindLDR.

WindLDR closes.

Application button

• If project data is saved during editing in WindO/I-NV3, control function are also saved.

• If you click  in WindLDR and then click Close, or if you close the project file while editing in 

WindO/I-NV3, you will exit WindLDR.
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3.2 FB Reference

In the FBD program, there are FBs such as logical operation FBs that perform logical operations, timer FB to perform 
processing using timer devices and counter FB to perform processing using counter devices. If the output of a FB is 
inverted, the execution results of the FB are inverted and output. For FBs that support inverted output, refer to the 
following table.

● Input FB

● Output FB

Programming and operating the user program of the SmartAXIS requires special knowledge.
To make effective use of the SmartAXIS, develop a thorough understanding of the contents of this manual 
and the FBD programming.

Symbol Name and Diagram Function
Output 

Inversion

I

Digital Input

Inputs ON/OFF information from an external 
device to the Touch.

NO

SM

Special Internal Relay
Special internal relays can be used as bit inputs 
for FBs. Special function is allocated to each 
special internal relay.

NO

R

Shift Register

Outputs ON/OFF state of a shift register device. NO

AI

Analog Input •For the analog inputs (A10, AI1) in the Touch, 
the analog input values can be linearly 
converted with the AI FB parameter settings 
within the range of -32,768 to 32,767.

•For the analog input cartridge (AI2 to AI5), the 
analog input values can be linearly converted 
with the function area settings. For how to 
configure the function area settings, refer to 
Chapter 3 “4.15 Analog Cartridge” on page 3-88.

NO

I
OUT

SM
OUT

R
OUT

AI
AOUT

Symbol Name and Diagram Function
Output 

Inversion

Q

Digital Output

Outputs ON/OFF information from the Touch to 
an external.

NO

M

Internal Relay

A bit unit FB used internally in the Touch. NO

Q
IN OUT

M
IN OUT
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● Logical Operation FB

Symbol Name and Diagram Function
Output 

Inversion

AND

Logical AND

Implements logical AND for a maximum of four 
input signals (ON/OFF) and outputs the result.

NO

NAND

Negative Logical AND
Implements negative logical AND for a maximum 
of four input signals (ON/OFF) and outputs the 
result.

NO

OR

Logical OR

Implements logical OR for a maximum of four 
input signals (ON/OFF) and outputs the result.

NO

NOR

Negative Logical OR
Implements negative logical OR for a maximum of 
four input signals (ON/OFF) and outputs the 
result.

NO

XOR

Exclusive Logical OR
Implements exclusive logical OR for a maximum 
of two input signals (ON/OFF) and outputs the 
result.

NO

XNOR

Negative Exclusive Logical OR
Implements negative exclusive logical OR for a 
maximum of two input signals (ON/OFF) and 
outputs the result.

NO

NOT

Negation

Outputs the result of negating the input signal 
(ON/OFF).

NO

SOTU

Shot Up

Turns on the output for one scan when the input 
signal turns from off to on.

NO

SOTD

Shot Down

Turns on the output for one scan when the input 
signal turns from on to off.

NO

TRUTH

Truth Table A truth table for the output can be configured 
corresponding to the 16 combination of the four 
input signals, and TRUTH FB outputs the result 
according to the table.

YES

＆IN1 OUT
IN2
IN3
IN4

＆IN1 OUT
IN2
IN3
IN4

≥1IN1 OUT
IN2
IN3
IN4

≥1IN1 OUT
IN2
IN3
IN4

=1IN1 OUT
IN2

=1IN1 OUT
IN2

1IN OUT

SOTUIN OUT

SOTDIN OUT

TRUTHIN1 OUT
IN2
IN3
IN4
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● Timer FB

Symbol Name and Diagram Function
Output 

Inversion

TIMU

On-delay Count Up Timer After the execution input turns on, the output is 
turned on when the on-delay time elapses. The 
current value is incremented from zero to the 
preset value.

NO

TIMD

On-delay Count Down Timer After the execution input turns on, the output is 
turned on when the on-delay time elapses. The 
current value is decremented from the preset 
value to zero.

NO

TIMOU

Off-delay Count Up Timer When the execution input turns on, the output is 
turned on. After the execution input turns off, the 
output is turned off when the off-delay time 
elapses. The current value is incremented from 
zero to the preset value.

NO

TIMOD

Off-delay Count Down Timer When the execution input turns on, the output is 
turned on. After the execution input turns off, the 
output is turned off when the off-delay time 
elapses. The current value is decremented from 
the preset values to zero.

NO

TIMCU

On/off-delay Timer After the execution input turns on, the output is 
turned on when the on-delay time elapses. After 
the execution input turns off, the output is turned 
off when the off-delay time elapses.

NO

SPULS

Single Shot Pulse

After the execution input turns on, the output is 
turned on for the configured time period.

NO

DTIM

Dual Timer

The output is turned on and off according to the 
configured ON and OFF time.

NO

RPULS

Random Pulse Output

The output is turned on for the length of random 
time within the configured range of time.

NO

TIMU
100 ｍs

TRG OUT

TIMD
100 ms

TRG OUT

TIMOU
100 ms

TRG OUT
RST

TIMOD
100 ms

TRG OUT
RST

TIMCU
100 ms

TRG OUT
RST

SPULS
100 ms

TRG OUT
RST

DTIM
100 ms

EN OUT

RPULS
100 ms

EN OUT
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● Counter FB

● Shift Register FB

● Data Comparison FB

● Data Conversion FB

Symbol Name and Diagram Function
Output 

Inversion

CNT

Adding Counter When the clock input is turned on, the current 
value is incremented by one. The output is turned 
on when the current value reaches the preset 
value.

NO

CUD

Up/Down Selection Reversible Counter When the clock input is turned on, the current 
value is incremented or decremented by one 
according to the up/down selection input. The 
current value is compared with ON/OFF 
thresholds. The output is turned on or off 
according to the comparison result.

NO

HOUR

Hour Meter Accumulates the ON duration of the execution 
input in hours, minutes, and seconds. The output 
is turned on when the accumulated time reaches 
the configured time.

NO

CNTRST OUT
UP

CUDPRST OUT
CLK
U/D

HOUREN OUT
RST

Symbol Name and Diagram Function
Output 

Inversion

SFR

Shift Register
When the execution input turns on, the shift 
registers are shifted to the specified shift 
direction.

YESSFRTRG OUT
RST

DI
DIR

Symbol Name and Diagram Function
Output 

Inversion

CMP

Data Comparison
Two comparison values are compared and the 
output is turned on or off according to the 
comparison result.

YES

STTG

Schmitt Trigger
The comparison value and the ON/OFF thresholds 
are compared and the output is turned on or off 
according to the comparison result.

YES

RCMP

Range Comparison
The comparison value and the upper/lower limits 
are compared and the output is turned on or off 
according to the comparison result.

YES

CMPEN OUT
DAT1
DAT2

STTGEN OUT
DATA

ON
OFF

RCMPEN OUT
DATA

UL
LL

Symbol Name and Diagram Function
Output 

Inversion

ALT

Alternate Output

Sets/resets the output. YESALTTRG OUT
SET
RST
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● Week Programmer FB

● Script FB

● Special FB

Symbol Name and Diagram Function
Output 

Inversion

WEEK

Weekly Timer
Compares the specified day of the week, ON time, 
and OFF time with the current time and outputs 
the result.

NO

YEAR

Yearly Timer

Compares the specified date with the current date 
and outputs the result.

NO

WEEKEN OUT
INI

YEAREN OUT
INI

Symbol Name and Diagram Function
Output 

Inversion

SCRPT

Script Enables you to program complicated processing 
with the script language that supports conditional 
branching, logical operations, arithmetic 
operations, and functions.

NOSCRPTEN OUT

Symbol Name and Diagram Function
Output 

Inversion

HSC

High-speed Counter
Operates the high-speed counter configured in 
the function area settings. Turns on/off the high-
speed counter gate input/clear input.

YES

RSFF

RS Flip-flop
When the set input turns on, the output turns on 
and is kept on. When the reset input turns on, the 
output turns off.

YES

HSCGT OUT
RST
CLR

RSFFSET OUT
RST
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● Available Data
The available data types for each FB are as follows.

*1 Analog inputs (AI0, AI1) do not support the word type. When using the analog input cartridge (AI2 to AI5), configure the AI 
FB data type in the function area settings. For how to configure the function area settings, refer to Chapter 3 “4.15 Analog 
Cartridge” on page 3-88.

In WindLDR data types are displayed as follows: BIN16(+) as W (word), BIN16(+/-) as I (integer), 
BIN32(+) as D (double word), BIN32(+/-) as L (long), and float32 as F (float).

FB
Data type

W I D L F

Word Integer Double 
word Long FloatGroup Name Symbol

Input

Digital Input I NO NO NO NO NO

Special Internal Relay SM NO NO NO NO NO

Shift Register R NO NO NO NO NO

Analog Input AI YES*1 YES*1 NO NO NO

Output
Digital Output Q NO NO NO NO NO

Internal Relay M NO NO NO NO NO

Logical Operation

Logical AND AND NO NO NO NO NO

Negative Logical AND NAND NO NO NO NO NO

Logical OR OR NO NO NO NO NO

Negative Logical OR NOR NO NO NO NO NO

Exclusive Logical OR XOR NO NO NO NO NO

Negative Exclusive Logical OR XNOR NO NO NO NO NO

Negation NOT NO NO NO NO NO

Shot Up SOTU NO NO NO NO NO

Shot Down SOTD NO NO NO NO NO

Truth Table TRUTH NO NO NO NO NO

Timer

On-delay Count Up Timer TIMU YES NO NO NO NO

On-delay Count Down Timer TIMD YES NO NO NO NO

Off-delay Count Up Timer TIMOU YES NO NO NO NO

Off-delay Count Down Timer TIMOD YES NO NO NO NO

On/off-delay Timer TIMCU YES NO NO NO NO

Single Shot Pulse SPULS YES NO NO NO NO

Dual Timer DTIM YES NO NO NO NO

Random Pulse Output RPULS YES NO NO NO NO

Counter

Adding Counter CNT YES NO YES NO NO

Up/Down Selection Reversible 
Counter CUD YES NO YES NO NO

Hour Meter HOUR YES NO NO NO NO

Shift Register Shift Register SFR NO NO NO NO NO

Data Comparison

Data Comparison CMP YES YES YES YES NO

Schmitt Trigger STTG YES YES YES YES NO

Range Comparison RCMP YES YES YES YES NO

Data Conversion Alternate Output ALT NO NO NO NO NO

Week Programmer
Weekly Timer WEEK NO NO NO NO NO

Yearly Timer YEAR NO NO NO NO NO

Script Script SCRPT YES YES YES YES YES

Special
High-speed Counter HSC YES NO YES NO NO

RS Flip-flop RSFF NO NO NO NO NO
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4.1 Overview

When you want to increase the number of I/Os to be connected to a single Touch, you can achieve this using the 
remote I/O function.
In addition to the built-in I/Os of the Touch, you can expand the number of I/Os up to a maximum of 90 inputs and 
54 outputs.
Configure the Touch to which inputs and outputs need to be expanded as the remote I/O master, and configure the 
Pro/Lite to be the remote inputs and outputs as the remote I/O slaves.
The remote I/O master is configured on connections 1 through 3 in the Function Area Settings dialog box.
The Touch configured as a remote I/O master can connect to one remote I/O slave per one connection. When the 
connections 1 through 3 are all used for remote I/O, the remote I/O master can connect to a maximum of three 
remote I/O slaves.
For the remote I/O slave function and configuration procedure, refer to the "SmartAXIS Pro/Lite User's Manual".

4 Remote I/O

Ethernet

Connection 1

Connection 2

Connection 3

Pro/Lite
Remote I/O slave

Pro/Lite
Remote I/O slave

Touch 
Remote I/O master

Pro/Lite
Remote I/O slave

• If a communication timeout occurs at a remote I/O slave, all outputs of the remote I/O slave are turned 
off.
Depending on the details of the control on the remote I/O slave side, this may lead to a hazardous 
situation, so set the master receive timeout to an ample length. If the master receive timeout setting is 
made long, the time that the remote I/O slave outputs remain on also becomes long when communication 
is actually lost. Set the master receive timeout to a value suited to each application.

• The SmartAXIS configured as remote I/O master/slave communicates over Ethernet. When other 
SmartAXIS or other network devices are connected on the same LAN, the I/O refresh timing for the 
remote I/O slaves is affected by those devices.
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4.2 Remote I/O Master

The Touch can be used as a remote I/O master by configuring the Touch as a remote I/O master in WindLDR. The 
settings can be configured in the Function Area Settings dialog box of WindLDR.
The digital input information from the remote I/O slaves connected with connection 1 through 3 is input to I40 to I75, 
I80 to I115, and I120 to I155. The analog input information from the remote I/O slaves is stored to D8149 to D8156, 
D8158 to D8165, and D8167 to D8174.
The output information for Q40 to Q61, Q80 to Q101, and Q120 to Q141 on the remote I/O master is output from the 
remote I/O slaves connected with connection 1 through 3. For details on data communication between the remote I/
O master and the remote I/O slaves, refer to "Remote I/O Communication Memory Refresh Image" on page 12-48.

● Specifications

Item Description

Connection 1

Digital inputs I40 to I75

Digital outputs Q40 to Q61

Analog inputs D8149 (=AI10) to D8156 (=AI17)

Remote I/O slave 1 communication error status D8148

Remote I/O slave 1 communication error M8005

Remote host
IP address 000.000.000.000 to 255.255.255.255

Port number 0 to 65535

Timeout 100 ms to 25,500 ms (100 ms increments)

Connection 2

Digital inputs I80 to I115

Digital outputs Q80 to Q101

Analog inputs D8158 (=AI20) to D8165 (=AI27)

Remote I/O slave 2 communication error status D8157

Remote I/O slave 2 communication error M8006

Remote host
IP address 000.000.000.000 to 255.255.255.255

Port number 0 to 65535

Timeout 100 ms to 25,500 ms (100 ms increments)

Connection 3

Digital inputs I120 to I155

Digital outputs Q120 to Q141

Analog inputs D8167 (=AI30) to D8174 (=AI37)

Remote I/O slave 3 communication error status D8166

Remote I/O slave 3 communication error M8007

Remote host
IP address 000.000.000.000 to 255.255.255.255

Port number 0 to 65535

Timeout 100 ms to 25,500 ms (100 ms increments)

Refresh period
Communication processing Scan asynchronous

Data update Each scan end
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● Remote I/O Communication Memory Refresh Image
Data communication between the remote I/O master and the remote I/O slaves is conducted as shown in the 
diagram below.

● Connection Status with Remote I/O Slaves
The connections status of each remote I/O slave can be confirmed by referring to the special internal relays and 
special data registers of the SmartAXIS configured as the remote I/O master.

Remote I/O 

Slave 2

I0 to I35

Q0 to Q21

Analog inputs

D8040 to D8047
Remote I/O 

Slave 3

I0 to I35

Q0 to Q21

Analog inputs

D8040 to D8047

I0 to I35

Q0 to Q21

Analog inputs

D8040 to D8047

Connection 1

I40 to I75

Q40 to Q61

Analog inputs

D8149 to D8156

Connection 2

I80 to I115
Q80 to Q101
Analog inputs

D8158 to D8165

Connection 3

I120 to I155

Q120 to Q141

Analog inputs

D8167 to D8174

I0 to I35

Q0 to Q21

Analog inputs

D8040 to D8047

Remote I/O 
master

Remote I/O 
slave 1

Item Connection port Device Description

Connection status

Connection 1 M8110 Indicates the connection status with the 
corresponding slave.
OFF: Not connected, ON: Connected

Connection 2 M8111

Connection 3 M8112

IP address of the 
connected slave

Connection 1 D8110 to D8113

Stores the IP address of the slave.Connection 2 D8114 to D8117

Connection 3 D8118 to D8121

Port number of the 
connected slave

Connection 1 D8130
Stores the connected port number of the 
slave.

Connection 2 D8131

Connection 3 D8132
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● Communication Error Information with the Remote I/O Slaves
Communication errors with the remote I/O slaves can be confirmed by referring to M8005 to M8007 (remote I/O 
slave communication error). The details of the communication error can be confirmed by referring to D8148, D8157, 
and D8166 (remote I/O slave communication error status).

*1 The remote I/O master can communicate with the remote I/O slave, but this state indicates a system error has occurred on 
the remote I/O slave. Check the status of the remote I/O slave.

● Remote I/O Communication Timing Chart

Establish connection

The remote I/O master issues a communication request to the remote I/O slave in the END processing.

Communication timeout

Item Device Description

Remote I/O slave 1 communication error M8005 ON: Communication error occurs (ON while the error is 
occurring)
OFF: Communicating normally

Remote I/O slave 2 communication error M8006

Remote I/O slave 3 communication error M8007

Remote I/O slave 1 communication error status D8148 0: Normal
1: Communication timeout error
2: Connection disconnected
10: Slave output error*1

Remote I/O slave 2 communication error status D8157

Remote I/O slave 3 communication error status D8166

1. The remote I/O master's initial state is that the remote slave communication error (M8005 to M8007) is on and the 
remote slave communication error status (D8148, D8157, D8166) is "2" (connection disconnected).

2. The remote I/O master attempts to establish a connection with remote I/O slave 1, but the connection cannot be 
established. At the event above, the remote I/O slave 1 communication error (M8005) is kept on, and the remote 
I/O slave 1 communication status (D8148) is kept as "2" (connection disconnected).

3. When the connection is successfully established afterward, the remote I/O slave 1 communication error (M8005) 
turns off, and the remote I/O slave 1 communication error status (D8148) also becomes "0" (normal).

4. Communication with remote I/O slave 1 is continued.

ON

OFF

Remote I/O master

Establish connection wait time 
(fixed by system: 1.5 s)

END processing

Remote I/O slave 1 
communication error 
(M8005)

Remote I/O slave 1

D8148 = 2

D8148 = 0

1. 2. 3. 4.

One scan

1. While communicating with the remote I/O slave, the remote slave communication error (M8005 to M8007) is off 
and the remote slave communication error status (D8148, D8157, D8166) is "0" (normal).

2. If the response for a request issued to remote I/O slave 2 takes longer than the communication timeout, the 
remote I/O slave 2 communication error (M8006) turns on and the remote I/O slave 2 communication error status 
(D8157) becomes "1" (communication timeout error).

3. When a response from remote I/O slave 2 is returned, the remote I/O slave 2 communication error (M8006) turns 
off, and the remote I/O slave 2 communication error status (D8157) becomes "0" (normal).

ON

OFF

Remote I/O master

Communication 
timeout time

END processing

Remote I/O slave 2 
communication error 
(M8006)

Remote I/O slave 2

D8157 = 0

D8157 = 1

1. 2. 3.

D8157 = 0

One scan
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Communication with Multiple Remote I/O Slaves

The above timing chart is an example where the communication with remote I/O slave 1 is the fastest and the 
communication with remote I/O slave 3 is the slowest.
1. The remote I/O master is able to perform remote I/O communication in END processing and it simultaneously 

issues requests to all remote I/O slaves.
2. The time until the response is returned is affected by the state of the network connecting the remote I/O slaves. 

Therefore, new requests are only issued for remote I/O slaves that have returned a response.
3. When multiple responses are received in one scan, new requests are issued for all of those simultaneously in END 

processing.

Remote I/O 
master

Remote I/O 
slave 1

1. 2. 3.

Remote I/O 
slave 2

Remote I/O 
slave 3

END processing

One scan

Remote Communication Speed
The communication speed in remote I/O communication is affected by such factors as the state of the 
network line and the communication cable. As a reference for communication speed, when performing 
remote I/O communication using a 100BASE-T compatible cable and switching hub, it takes a minimum of 
approximately 5 ms after the remote I/O master issues a request until the response from the remote I/O 
slave is reflected as inputs.
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● Procedure
To use the Touch as a remote I/O master, you must configure the Function Area Settings tab and download the 
ladder program or FBD program to the Touch.

1 On the WindO/I-NV3 View tab, in the Workspace group, click  (Control Function) .

WindLDR starts.

2 On the WindLDR Configuration tab, in the Function Area Settings group, click Connection Settings.

The Function Area Settings dialog box is displayed.

3 Click Communication Mode for the connection to configure, and then select Remote I/O Master.
The Remote I/O Master dialog box is displayed.

4 Click Remote Host No. and select New Remote Host....
The Remote Host dialog box is displayed.
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5 Configure IP Address and Port of the remote I/O slave to connect.

6 Click OK.
When the settings are correctly configured, the details configured in the Remote Host dialog box is displayed in 
Remote Host No..

7 For Receive Timeout (ms), configure the receive timeout with the remote I/O slave.

8 Click OK.
Configuring the remote I/O master is completed.

The default port number of the remote I/O slave is 2110.
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This chapter describes how to configure the Alarm Log function and its operation on the Touch.

  

1.1 How the Alarm Log Function is Used

The Alarm Log function samples the occurrence of alarms and recovery information by monitoring and evaluating the 
state of devices.
The Alarm Log function can perform the following functions.

• Monitor device states and create Alarm Log data

• Monitor device states and detect alarms

• Display an alarm screen when an alarm occurs

• Make a sound of the buzzer and screen flashing the screen when an alarm occurs

Chapter 13 Alarm Log Function

1 Overview

Touch

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No.  Message  Occurrence Time  Recovery Time  Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00  12/01 12:53:10  12/01 12:54:30

Touch

External device

0 1 Alarm occurred

Touch

External device

0 1 Voltage 
drop

Alarm screen

Alarm occurred

Beep

Touch

External device

0 1

Alarm occurred
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• Output Alarm Log data to the external memory

USB flash drive
Output to USB flash drive

Alarm Log data (CSV)

Touch
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1.2 Alarm States

Alarms have three states: occurred, recovered, and confirmed.

Example: When the source device (the device to monitor) is D100-0, the error state (when an alarm has occurred) is 
ON, the channel is set to Unlock, and the used key button is CHECK
When the source device is ON, the alarm changes to the “Occurred” state. When the source device is OFF, 
the alarm changes to the “Recovered” state. When CHECK is pressed, the alarm changes to the 
“Confirmed” state.

If CHECK is pressed before the source device changes to OFF, the alarm changes to the “Confirmed” state 
regardless of the state of the source device.

Alarm state Details

Occurred
Indicates that an alarm has occurred. There are two types of alarms that occur.
First Alarm: The first alarm that occurs in a state where no alarms have occurred.
Second and later: An alarm that has occurred while another alarm is active.

Recovered
Indicates that the alarm that occurred has been recovered from.
However, for channels set to lock, the alarm is not recovered from until a key button is pressed 
(CHECK or All Chk.).

Confirmed Indicates the key button CHECK or All Chk. was pressed.

Record occurrence time D100-0 : ON

D100-0 : OFF

D100-0 : OFF

Source device state

Occurred

Record recovery time Recovered

Record confirmation time Confirmed

Alarm Log data

Press CHECK

No alarm 
occurring state

NO/NC is NO, so the state is 
“Occurred”

Lock/Unlock is Unlock, so the 
state is “Recovered”

Alarm state

Record occurrence timeD100-0 : ON

D100-0 : OFF

Alarm state

Occurred

Record confirmation time Confirmed

Record recovery time  Recovered

Alarm Log data

Press CHECK

D100-0 : OFF

Source device state
No alarm 

occurring state

NO/NC is NO, so the state is 
“Occurred”

Lock/Unlock is Unlock, so the 
state is “Recovered”
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1.3 Sampling Data

Data is sampled each time the alarm occurs, is recovered from, or confirmed. 
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

1
Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 – –

Channel No. 1-2: No alarm

2

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:00) 1-1 Voltage drop 12/01/2011 12:50:00 – –

Channel No. 1-2: Alarm occurred
1-2

Temperature 
abnormal

12/01/2011 12:50:10 – –
(12:50:10)

3

Channel No. 1-1:
Recovered from 
alarm

Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:20) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 –

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 – –
(12:50:10)

4

Channel No. 1-1: CHECK pressed Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:50:30) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 – –
(12:50:10)

5

Channel No. 1-1: Alarm occurred Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: Alarm
1-2

Temperature 
abnormal

12/01/2011 12:50:10 – –
(12:50:10)

1-1 Voltage drop 12/01/2011 12:51:00 – –

6

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2: CHECK pressed
1-2

Temperature 
abnormal

12/01/2011 12:50:10 – 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 – –

7

Channel No. 1-1: Alarm Ch.No. Message Occurrence Time Recovery Time Confirmation Time

(12:51:00) 1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

Channel No. 1-2:
Recovered from 
alarm 1-2

Temperature 
abnormal

12/01/2011 12:50:10 12/01 12:53:00 12/01 12:52:10
(12:52:10)

1-1 Voltage drop 12/01/2011 12:51:00 – –
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1.4 Data Configuration

The sampled data is composed of the channel number, message, alarm state, time, and label.
The relationship between the Alarm Log function settings and the sampled data is as follows.

1. Data storage amount: The amount of data that can be saved in the data storage area. For details, refer to “Data 
Storage Amount” on page 13-7.

2. Channel No.: Composed of (Block No.)-(Channel No.). The devices to monitor and the conditions for alarm 
occurrence and recovery are configured in the channels. When the sampled data is output 
as a CSV file, the displayed label is “Ch.No.”.

3. Message: The message displayed when an alarm has occurred.

4. Alarm state and time: The alarm state (occurred, recovered, confirmed) and the time the alarm occurred, was 
recovered from, and confirmed. When the sampled data is output as a CSV file, the 
displayed label varies based on the output method.

5. Label: When the sampled data is output as a CSV file, this is the text displayed in the label row.
This cannot be changed.

Alarm Log settings

Sampled data
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For sampled data, the format for displayed items varies based on the output method.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The labels displayed in the label row are “Ch.No.”, “Message”, “Occurrence Time”, “Recovery Time”, and 
“Confirmation Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The labels displayed in the label row are “Ch.No.”, “Message”, “State”, and “Time”.
Example: When the message for channel number 1-1 is “Voltage drop” and the message for channel number 1-2 is 

“Temperature abnormal”

Ch.No. Message Occurrence Time Recovery Time
Confirmation 

Time

1-1 Voltage drop 12/01/2011 12:50:00 12/01 12:50:20 12/01 12:50:30

1-2 Temperature abnormal 12/01/2011 12:50:10 -- 12/01 12:52:10

1-1 Voltage drop 12/01/2011 12:51:00 -- --

Ch.No. Message State Time

1-1 Voltage drop Occurred 12/01/2011 12:50:00

1-2 Temperature abnormal Occurred 12/01/2011 12:50:10

1-1 Voltage drop Recovered 12/01/2011 12:50:20
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1.5 Saving and Deleting Data

● Saving Data
You can select whether or not to save the sampled data in the data storage area. The method to save data is 
configured on the Channel tab in the Alarm Log Settings dialog box.

When Saving Data to the Data Storage Area

Select Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.

If the number of active alarms exceeds the Alarm Log data storage amount set for the data storage area, the data is 
processed with either of the following methods.

■ Fixed
If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

■ Rotate
If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data is saved.

Data Storage Amount
The maximum amount of data that can be saved in the data storage area is 5011.

Touch

External device

0 1

12:00

01

12:53

12:00
Alarm occurred

12:53    Recovered

12:54    Confirmed

Alarm Log data

 No.  Message  Occurrence Time  Recovery Time  Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:00  12/01 12:53:10  12/01 12:54:30

Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data

When the backup battery is depleted, the data in the Alarm Log is erased when the Touch is turned off.
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When Not Saving Data to the Data Storage Area

Select No Store under Data in the Auto-Setup dialog box or in the Individual Settings dialog box.
Use this option to monitor a device state and display only detected active alarms on the Alarm List Display.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV3, click the arrow under Clear, and then click All or Alarm Log Data. For 

details, refer to Chapter 23 “4 Clear” on page 23-22.
• On the Top Page in the System Mode, press  Main Menu, Initial Setting, Initialize, and Alarm Log in order.

Alarm List Display

Touch

External device

Voltage drop Pg. 
Up

Pg. 
Dwn0 1 Alarm occurred
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1.6 Using Data and Detected Alarms

The saved data and detected alarms can be used in the following ways.

● Using Saved Data
The saved data can be used in the following ways.

● Using Detected Alarms
• Display alarms with the Alarm List Display

Display detected alarms with the Alarm List Display.
For details, refer to “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” 
on page 13-27.

• Display data with the Alarm Log Display
Display Alarm Log data with the Alarm Log Display.
For details, refer to Chapter 9 “7 Alarm Log Display” 
on page 9-99.

• Save to and read from an external memory
Alarm Log data is saved in a CSV file format into the 
external memory which it can be read on your 
computer.
For details, refer to “4.4 Saving Data as a CSV File” 
on page 13-32.

To use with the Touch To use with devices other than the Touch

Alarm Log data

 Ch.No.  Message  Occurrence Time  Recovery Time  Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:05  12/01 12:01:10  12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09  12/01 12:02:21  12/01 12:02:55

 1-1 Voltage drop  12/01/2011 12:02:00  12/01 12:03:11  12/01 12:05:12

 1-3 Overcurrent  12/01/2011 12:30:21  12/01 12:55:15  12/01 13:00:00

 1-1 Voltage drop  12/01/2011 12:45:36  12/01 12:53:12  12/01 12:57:41

Select Ref.

Occurred  Message  Recovered  Confirmed
12/01 12:51  Temperature abnormal  12:53 12:52

12/01 12:00  Voltage drop  12:53 12:52

Alarm Log data
(CSV)

Book1

Sheet1 Sheet2 Sheet3

Alarm List Display

Touch

External device

Voltage drop Pg. 
Up

Pg. 
Dwn0 1 Alarm occurred
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This section describes the configuration procedure for the Alarm Log function.

2.1 Configuring the Devices to Monitor and the Alarm Detection Condition

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device to monitor under Source Device Type on the Channel tab.

If you select Word, devices are configured per block.
If you select Bit, devices are configured per channel.

3 Set the number of blocks to manage in Number of Blocks.

One channel is used for one device to monitor. One block is 16 channels.
The number of blocks that can be set varies based on the Source Device Type setting.

4 Select the reference screen type in Reference Screen.

The reference screen is associated with the channel. This screen is displayed when the key button Ref. is pressed.
If a reference screen is not displayed, select Not Use.

5 To batch register all channels, click Auto. To individually register each channel, click Edit.

An example when Auto is clicked is described here.
The Auto-Setup dialog box is displayed.

2 Alarm Log Function Configuration Procedure
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6 Specify the device to monitor in Source.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
For the Auto-Setup dialog box, the device addresses are sequentially set starting with the specified device address 
from the highlighted row in Settings.

7 Under Data, select whether or not to save Alarm Log data in the date storage area.

To display Alarm Log data on the Touch or to output the data to a file, select Store.
If you select No Store, Alarm Log data is not created, but device states are monitored.

8 Under Alarm function, select whether or not to use the alarm function.

For channels with Disable selected, device states are not monitored and Alarm Log data is not created.

9 Under NO/NC, select the alarm detection condition.

If you select NO, the alarm occurs when the monitored bit changes from 0 to 1. If you select NC, the alarm occurs 
when the monitored bit changes from 1 to 0.

10 Under Lock/Unlock, select whether or not to automatically recover based on the state of the monitored bit.
If you select Unlock, the alarm is automatically recovered from based on the bit state when the monitored bit 
becomes the normal state.
If you select Lock, even if the monitored bit becomes the normal state, the alarm remains active until the key button 
CHECK is pressed.

11 Select the Text ID check box and specify the message to display when the alarm occurs as a Text Manager ID 
number (1 to 32000).
Number of blocks x 16 (number of channels) text IDs are used starting from the set ID number.

12 Specify the screen number (1 to 3000) to display when the key button Ref. is pressed in Reference Screen No.
Number of blocks x 16 (number of channels) screens are used starting from the screen number.
This option can only be configured when Base Screen or Popup Screen is selected in Reference Screen.

13 Click OK.
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The devices to monitor and the messages are batch configured and displayed in Settings of Alarm Log Settings 
dialog box.

14 Click OK.
The Alarm Log Settings dialog box closes.
This concludes configuring the devices to monitor and the alarm detection condition.

Next, configure the functions to execute using saved data and detected alarms.
 “4.1 Displaying Saved Data with the Alarm Log Display” on page 13-25
 “4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm” on page 13-27
 “4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred” on page 13-30
 “4.4 Saving Data as a CSV File” on page 13-32
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This section describes items and buttons on the Alarm Log Settings dialog box.

3.1 Alarm Log Settings Dialog Box

● General Tab
The General tab is used to configure what kind of data to sample when an alarm occurs and the methods for saving 
and deleting the sampled data.

■ Storage Method
Selects the data processing method when the number of active alarms exceeds the Alarm Log data storage amount 
set for the data storage area.

3 Alarm Log Settings Dialog Box

Fixed: If the saved data exceeds the Alarm Log data storage amount, the new data is not saved.

Rotate: If the saved data exceeds the Alarm Log data storage amount, the oldest data is deleted and the new data 
is saved.

Alarm Log data storage amount

New data

Alarm Log data storage amount

Oldest data
(delete)

New data



3 Alarm Log Settings Dialog Box

13-14 SmartAXIS Touch User’s Manual

■ Monitoring Period (x 100 msec)
Specifies the period to write the state of the monitored device to the Touch (6 to 500 (100 milliseconds units)).

■ Monitor Number of Active Alarms
Select this check box to count the number of active alarms.

■ Monitor How Many Times Each Alarm has occurred
Select this check box to count the number of alarms that has occurred per channel.

■ Clear Log Data for Recovered Alarms
Select this check box to delete recovered data out of the saved Alarm Log data.

■ Monitor the State of Each Alarm
Select this check box to check the alarm state per channel.

The following values are written to the bits depending on the alarm state.

(Destination Device): Specifies a word device to write the number of active alarms.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-61.

(Top Device): Specifies a word device to write the number of alarms that has occurred. Number of blocks x 16 
(number of channels) addresses are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-61.
Example: When the number of blocks is 2 and LKR100 is specified as the starting device

The number of alarms that has occurred for channel number 1-0 is saved in LKR100. 
The number of alarms that has occurred for channel 1-1 is saved in LKR101, and this 
pattern continues up to LKR131 where the number of alarms that has occurred for 
channel number 2-15 is saved.

Starting device

Block 1
16 channels

Block 2
16 channels

Channel No.
LKR100
LKR101
LKR102

LKR114
LKR115
LKR116
LKR117
LKR118

LKR130
LKR131

1-0
1-1
1-2

1-14
1-15
2-0
2-1
2-2

2-14
2-15

• If you specify HMI Keep Registers (LKR) as the destination word device, the number of alarms that has 
occurred is retained even when the Touch power is turned off.

• The amount of Alarm Log data saved in the data storage area with the Alarm Log function is stored in 
HMI Special Data Register LSD57.

• To monitor the number of alarms that has occurred, number of blocks x 16 (number of channels) devices 
are required from the set starting device. If the destination device does not exist, “Device range error” 
occurs on the Touch.

• If the values of devices that are counting the number of alarms that has occurred are overwritten by 
another process, the alarms cannot be accurately counted.

(Trigger Device): Specifies the bit device or bit of the word device to serve as condition to delete data. The recovered 
data is deleted when the value of the configured device changes from 0 to 1. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

(Top Device): Specifies a word device to write the alarm state. Number of blocks x 16 (number of channels) 
addresses are used starting from the set device address.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” 
on page 2-61.

Bit 15 Bit 0Bit 3

0: Before alarm/after recovery
1: After alarm

0: Second and later alarm (Alarm that has occurred again while an alarm is active)
1: First alarm (First alarm that occurred)

0: After confirm
1: Before confirm

Reserved
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■ Call Popup Screen
These settings configure the Popup Screen to display when an alarm occurs. The Popup Screen displayed when an 
alarm occurs is called the alarm screen.

 

■ Number of Stored Data
Specifies the maximum amount of Alarm Log data saved in the data storage area. Data is saved up to the set amount. 
The maximum amount of data that can be saved in the data storage area is 5011.

Click  to open the Data Storage Area Management dialog box. You can change the allocation of data storage area 
memory in the Data Storage Area Management dialog box. For details, refer to Chapter 16 “Data Storage Area” on 
page 16-1.

Call Popup Screen: Select this check box to display the alarm screen when an alarm occurs.

Screen No.: Specifies the alarm screen number (1 to 3015) to display when an alarm occurs.

Coordinates X, Y: Specifies the coordinates to display the alarm screen.
With the upper-left corner of the screen as the origin, the upper-left corner of the 
alarm screen is the X and Y coordinates.
Specify the coordinates in 1 dot units.
X: 0 to (Base Screen horizontal size - 1)
Y: 0 to (Base Screen vertical size - 1)
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● Channel Tab
The Channel tab is used to configure the devices to monitor and the alarm detection condition.

■ Source Device Type
Selects the type of device to monitor.

■ Number of Blocks
Configures the Alarm Log data in block units. The number of blocks that can be set varies based on the Source 
Device Type setting and the Touch model.

■ Reference Screen
Select the type of reference screen from the following items.
Base Screen, Popup Screen, Not Use
The reference screen is displayed when a message is selected on the Alarm List Display or the Alarm Log Display and 
the key button Ref. is pressed. It is the Base Screen or Popup Screen associated with each channel.

Word: Uses a word device. Devices are configured per block.

Bit: Uses a bit device. Devices are configured per channel.

Word: 0 to 128

Bit: 0 to 8

One block is composed of 16 channels. One device can be monitored for each channel. The maximum 
number of devices that can be monitored is 16 for each block.

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Time

09:15   Motor fault

Message

10:02   Pump1 fault

REV

Up

Dwn

Del

Ref.

10:28   High pressure

13:02   Pump 1 fault

Pump 1 faultPump 1 fault
Pump 1 output low

Stop Start

Press Stop, check the air, 
then press Start.

Air Press.

kg/m2
0000

Key button Ref.

1. Select a message displayed  
on the Alarm List Display  
or the Alarm Log Display

Reference screen

2. Press the key button Ref. The reference screen opens
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■ Settings
The Alarm Log settings for each channel are edited here.

■ Auto
Batch registers or changes the settings for all the channels.
Click this button to open the Auto-Setup dialog box. The Auto-Setup dialog box settings are reflected in all the 
channels.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

■ Edit
Registers or changes, the settings for the selected channel.
Select a channel, and then click this button to open the Individual Settings dialog box. The settings for the selected 
channel are reflected in the Individual Settings dialog box.
For details, refer to “Auto-Setup Dialog Box and Individual Settings Dialog Box” on page 13-18.

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell opens the Individual Settings 
dialog box.

Source: Shows the bit device or bit of the word device to monitor. Double clicking the cell opens the 
Device Address Settings dialog box.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.

Data: Shows whether or not to save Alarm Log data in the date storage area.
Double clicking the cell switches between Store and No Store.

Alarm function: Shows whether or not the alarm function is used. Double clicking the cell switches between 
Enable and Disable. Channels switched to Disable cannot be configured. Device states are 
not monitored and Alarm Log data is not created.

NO/NC: Shows the alarm detection condition. Double clicking the cell switches between NO and NC.

Lock/Unlock: Shows whether or not to automatically recover based on the state of the monitored bit. 
Double clicking the cell switches between Lock and Unlock.

Text ID: Shows the Text Manager ID number (1 to 32000) to use for the message displayed when an 
alarm occurs. Double clicking the cell allows you to specify the Text Manager ID number.

Text Message: Shows the text for the specified text ID. Double clicking the cell opens Text Manager.

Reference Screen No.: Shows the screen number to display when the key button Ref. is pressed. Double clicking the 
cell opens the Individual Settings dialog box.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.
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Auto-Setup Dialog Box and Individual Settings Dialog Box

With the Auto-Setup dialog box, the Alarm Log settings for all channels are batch registered or changed.
With the Individual Settings dialog box, the Alarm Log settings for the selected channel are registered or changed.

■ Channel*1

Shows the block number and the channel number for the selected channel.

■ Block Settings
Configures Source and Data in block units.

*1 Individual Settings dialog box only

Block No.: Shows the block number for the channel selected in Settings.

Channel No.: Shows the channel number for the channel selected in Settings.

Source: For the Auto-Setup dialog box, the device addresses are sequentially set from block number 1-
channel number 1, starting with the specified device address.
For the Individual Settings dialog box, if Source Device Type on the Channel tab is Word, 
the 16 channels for the block selected at the start of the specified device address are batch 
configured. For Bit, the selected channel is individually configured.

Click  to open the Device Address Settings dialog box where you can edit the device address. 
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.

Data: Selects whether or not to save Alarm Log data in the date storage area.
For the Auto-Setup dialog box, all the channels are batch configured.
For the Individual Settings dialog box, the 16 channels for the selected block are batch 
configured.

Store: Alarm Log data can be displayed on the Touch or output to file.

No Store: Alarm Log data is not created, but device states are monitored.
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■ Channel Settings
The trigger condition for the channel is configured here.

Alarm function: Selects whether or not to use the alarm function.

Enable: Monitors the state of the device configured for the channel and samples 
the alarm information.

Disable: Does not monitor the state of the device. No Alarm Log data is created.

NO/NC: Selects the alarm detection condition.

NO: The alarm occurs when the monitored bit changes from 0 to 1.

NC: The alarm occurs when the monitored bit changes from 1 to 0.

Lock/Unlock: Selects whether or not to automatically recover based on the state of the monitored bit.

Lock: Even if the monitored bit returns the normal state, the alarm remains 
active until the key button CHECK is pressed.

Unlock: The alarm is automatically recovered from based on the bit state when the 
monitored bit returns the normal state.

Example: When NO/NC is NO

Press CHECK Record confirmation time

Record recovery time

Record occurrence time

Unlock

Record confirmation time
Record recovery time

No operation

Record occurrence time

Lock

0 1

0 1

Monitored bit

Alarm occurred

The display on the Alarm List Display disappears when the alarm is recovered from, regardless of the Lock/
Unlock setting. To keep displaying the alarm until CHECK is pressed, use the Alarm Log Display.

Text ID: To use text registered in Text Manager as the message to display when an alarm occurs, 
select this check box and specify the Text Manager ID number to use as the message. 
Number of blocks x 16 (number of channels) text IDs are used starting from the set ID 
number.

Click  to open Text Manager where you can edit the text.

Text: Shows the text for the specified text ID.

Reference Screen No.: Specifies the screen number (1 to 3000) to display when the key button Ref. is pressed. 
Number of blocks x 16 (number of channels) screens are used starting from the screen 
number.
This option can only be configured when Base Screen or Popup Screen is selected in 
Reference Screen.



3 Alarm Log Settings Dialog Box

13-20 SmartAXIS Touch User’s Manual

● External Memory Tab
The External Memory tab is used to configure whether or not to output saved data to the external memory.

The output data is stored in the following folder on the external memory.
\External memory folder\ALARMLOG

The default External Memory Folder name is “HGDATA01”. For details, refer to Chapter 26 “1.5 Setting the External 
Memory Folder” on page 26-12.

Sampled data after starting output to the external memory is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory.

All the data is saved on the external memory when the trigger devices changes from 0 to 1. If a file with the same 
name already exists on the external memory, that file is overwritten. The maximum amount of output data is the 
amount configured by the data storage area.

*1 Advanced mode only

Touch

Alarm Log data (CSV)

Output to 
USB flash drive

USB flash driveAlarm Log data

0 1

Trigger Device

 Ch.No.  Message  Occurrence Time  Recovery Time  Confirmation Time

 1-1 Voltage drop  12/01/2011 12:00:05  12/01 12:01:10  12/01 12:01:30

 1-2 Temperature abnormal  12/01/2011 12:01:09  12/01 12:02:21  12/01 12:02:55

 1-1 Voltage drop  12/01/2011 12:02:00  12/01 12:03:11  12/01 12:05:12

 1-3 Overcurrent  12/01/2011 12:30:21  12/01 12:55:15  12/01 13:00:00

 1-1 Voltage drop  12/01/2011 12:45:36  12/01 12:53:12  12/01 12:57:41

Data to be output (all)

Output stops if there is insufficient free space on the external memory. USB flash drive error information is 
stored in HMI Special Data Register LSD33.

Trigger Device: Specifies the bit device or bit of the word device to serve as condition for batch output. For the 
device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.
Data is output to file when the trigger device changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.
The default is “ALMHTO.CSV”. To change the file name, enter a new file name. The maximum 
number is 120 characters (including the extension).

Add Device data to File Name*1: Select this check box to add the bottom three digits of 
the value of device configured by File Name Device to 
the end of the file name for the output data.
Example: When the value of device configured by File 

Name Device is 123, the file name is 
“ALMHTO123.CSV”.

File Name Device: Specifies the word device that is the source for the value 
to add to the file name. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61. This option can only be 
configured when the Add Device data to File Name 
check box is selected.
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■ Real Time
Select this check box to output data to the external memory in real time.

With real time output, data is saved to the external memory in three minute intervals after the Touch starts running. 
When there is already data with the same file name on the external memory, data is appended to that file. If there 
was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the 
labels.

If the interval to update the Alarm Log is shorter than real time output (the interval for writing to the external 
memory), that Alarm Log is recorded up to the 1,023rd item, and then afterwards, old data is discarded in order and 
replaced with new data.

 

*1 Advanced mode only

Touch

Alarm Log data (CSV)

Output to 
USB flash drive

Alarm Log data

 Time  State  Ch.No.  Message

 12/01/2011 12:00:05  Occurred  1-1 Voltage drop

 12/01/2011 12:01:09  Occurred  1-2 Temperature abnormal

 12/01/2011 12:01:10  Recovered  1-1 Voltage drop

 12/01/2011 12:03:30  Confirmed  1-1 Voltage drop

 12/01/2011 12:03:09  Occurred  1-3 Overcurrent

 12/01/2011 12:04:33  Recovered  1-2 Voltage drop

 12/01/2011 12:05:15  Confirmed  1-2 Voltage drop

 12/01/2011 12:08:41  Recovered  1-3 Overcurrent

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that

Data to be output after 
another 3 minutes

3 minute interval 
after operation starts

USB flash drive

Real time output stops when the file size of the Alarm Log data exceeds 256 MB or when there is insufficient 
space on the external memory. USB flash drive error information is stored in HMI Special Data Register LSD33.

• When the value of HMI Special Relay LSM18 changes from 0 to 1, the data at that time is first output in 
real time to the USB flash drive, and then access to the USB flash drive is stopped.

• You can check the free space on the USB flash drive with HMI Special Data Register LSD34 to 35.

Trigger condition: Select the check boxes for the items that will trigger the output of Alarm Log data to the external 
memory.

Occurrence: Alarm Log data is output to the external memory when an alarm has occurred.

Recovery: Alarm Log data is output to the external memory when the alarm is recovered 
from.

Confirmation: Alarm Log data is output to the external memory when the key button CHECK was 
pressed.

Month/day/year hour:minute:second is output for the trigger condition occurrence time, recovery time, and 
confirmation time.

File Name: Enter the file name for the output data or shows the file name.
The default is “ALMHTA.CSV”. To change the file name, enter a new file name. The maximum 
number is 120 characters (including the extension).

Add Device data to File Name*1: Select this check box to add the bottom three digits of the 
value of device configured by File Name Device to the end of 
the file name for the output data.
Example: When the value of device configured by File Name 

Device is 123, the file name is “ALMHTA123.CSV”.

File Name Device: Specifies the word device that is the source for the value to add 
to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61. This option can only be configured when the Add 
Device data to File Name check box is selected.
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• The function to sample data operates when Alarm Log data is being saved to the external memory.
• The methods to erase Alarm Log files saved on the external memory are as follows.

- To erase files during operation using parts, on the External Memory tab on the Project Settings dialog 
box, select the Remove Files stored in External Memory check box and the All Alarm Log data 
check box, and then configure the trigger device. Assign that trigger device to a part.

- To erase files with WindO/I-NV3, click Clear on the Online tab, and then click Stored Data in 
External Memory to open the Clear Data dialog box. Select the Alarm Log Data check box, and then 
click OK.
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● Options Tab
The Options tab is used to configure whether or not the Touch’s internal buzzer operates and the screen flashing.

■ Trigger Buzzer when Alarm occurs
Select this check box to make a sound of the buzzer when an alarm has occurred.

■ Screen flashing when Alarm occurs
Select this check box to have the screen flash when an alarm occurs.
For monochrome LCD models, the backlight changes to red while the screen is flashing.

■ Buzzer and Screen Flashing*1

This item selects the condition for the alarm to sound the buzzer or to flash the screen. This item can only be 
configured when the Buzzer when Alarm occurs or the Screen flashing when Alarms occurs is selected.

■ Stop the Sound of the Buzzer and Screen flashing*1

Select the check box for the items that will trigger the sound of the buzzer and screen flashing to stop.

*1 Advanced mode only
*2 The first alarm that has occurred in a state where no alarms are active

All Alarms: The buzzer is triggered and the screen flashing each time an alarm occur.
Only First Alarm: The buzzer is triggered and the screen flashing only when the first alarm*2 occurs. No beeps 

will sound and no screen will flash when another alarm is already active.

When touch everywhere on the screen: The sound of the buzzer and screen flashing stops when you touch 
anywhere on the screen.

When press CHECK/All Chk. button: The sound of the buzzer and screen flashing stops when you touch 
the key buttons CHECK or All Chk. on the Alarm Log Display.

When all Alarms are recovered: The sound of the buzzer and screen flashing stops when all the 
alarms are recovered from.

• While the sound of the buzzer is sounding, System Area 1 (address+1, bit 6) is 1.
• While the screen is flashing, System Area 1 (address+1, bit 2) is 1. 

For monochrome LCD models, System Area 1 (address+1, bit 3) is 0 and System Area 1 (address+1, bit 
4) is 1 while the screen flashing.

• To stop the sound of the buzzer and the screen flashing when an alarm has occurred, use the following 
methods.
- Press the key button Stop the Sound of the Buzzer and Screen flashing
- When a condition selected with the Stop the Sound of the Buzzer and Screen flashing check boxes 

is satisfied
- To stop the sound of the buzzer, set System Area 1 (address+1, bit 6) to 0
- To stop the screen flashing, set System Area 1 (address+1, bit 1 to 4) to 0

However, when System Area 1 (address+1, bit 6) is 1 for a reason other than the occurrence of an alarm, 
the sound of the buzzer does not stop until 0 is written. When System Area 1 (address+1, bit 1 to 4) are 1,  
the alarm is triggered, however, the screen flashing doesn't stop until 0 is written into it.
• If you stop the screen flashing, the backlight turns off when System Area 1 (address+1, bit 0), and the 

backlight turns on when it is 1.
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4.1 Displaying Saved Data with the Alarm Log Display

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device to monitor under Source Device Type on the Channel tab and specify Number of 
Blocks.

3 Select the channel number to register, and then click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device to monitor in Source and select Store under Data.

4 Using Data and Detected Alarms
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5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and then click OK.

6 Repeat steps 3 through 5 to register all the channels.

7 Click OK.

The Alarm Log Settings dialog box closes.

8 On the Home tab, in the Parts group, click Data Displays, and then click Alarm Log Display.

9 Click a point on the edit screen where you want to place the Alarm Log Display.

10 Double-click the dropped Alarm Log Display and a Properties dialog box will be displayed.

11 Change the settings on each tab as necessary.
For details, refer to Chapter 9 “7.3 Properties of Alarm Log Display Dialog Box” on page 9-101.

12 Click OK.

The Properties of Alarm Log Display dialog box closes.
This concludes configuring the Touch to display saved data with the Alarm Log Display.
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4.2 Displaying Registered Messages with the Alarm List Display According to the Active Alarm

1 On the Configuration tab, in the System Setup group, click Alarm Log.
The Alarm Log Settings dialog box is displayed.

2 Select the type of device to monitor under Source Device Type on the Channel tab and specify Number of Blocks.

3 Select the channel number to register a message to, and then click Edit.
The Individual Settings dialog box is displayed.

4 Specify the device to monitor in Source and select No Store under Data.

5 Select Enable under Alarm function and configure NO/NC and Lock/Unlock.

6 Select the Text ID check box, and then click .
Text Manager opens.
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7 Enter the message in Text.

8 Click Select.

9 Click OK in the Individual Settings dialog box.

The registered message is displayed in Settings of the Alarm Log Settings dialog box.

10 Repeat steps 3 through 9 to register messages for all the channels.

11 Click OK.
The Alarm Log Settings dialog box closes.

The messages to use can be registered in advance in Text Manager.



SmartAXIS Touch User’s Manual 13-29

4 Using Data and Detected Alarms

13

Alarm
 Log Function

12 On the Home tab, in the Parts group, click Data Displays, and then click Alarm List Display.

13 Click a point on the edit screen where you want to place the Alarm List Display.

14 Double-click the dropped Alarm List Display and a Properties dialog box will be displayed.

15 On the General tab, under Message Settings, select Use Alarm Log Settings.

16 Configure the other settings and the settings on each tab as necessary.
For details, refer to Chapter 9 “6.3 Properties of Alarm List Display Dialog Box” on page 9-85.

17 Click OK.

The Properties of Alarm List Display dialog box closes.
This concludes configuring the Touch to display registered messages with the Alarm List Display according to the 
active alarm.
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4.3 Make a Sound of the Buzzer and Flash the Screen when an Alarm has Occurred

1 On the Configuration tab, in the System Setup group, click Alarm Log.

The Alarm Log Settings dialog box is displayed.

2 Select the type of device to monitor under Source Device Type on the Channel tab and specify Number of 
Blocks.

3 Select the channel number to register a message to, and then click Edit.

The Individual Settings dialog box is displayed.

4 Specify the device to monitor in Source and select Store under Data.

5 Select Enable under Alarm function, configure NO/NC and Lock/Unlock, and then click OK.
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6 Click the Options tab in the Alarm Log Settings dialog box.

7 Select the Trigger Buzzer when Alarm occurs check box to make a sound of the buzzer when an alarm has 
occurred.

8 Select the Screen flashing when Alarm occurs check box to have the screen flashing when an alarm has 
occurred.

9 Click OK.

The Alarm Log Settings dialog box closes.

This concludes configuring the settings to make a sound of the buzzer and the screen flashing when an alarm has 
occurred.
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4.4 Saving Data as a CSV File

● Saving Data as a CSV File
The Alarm Log data can be saved to the external memory as a CSV file.
The procedure to save the data is as follows.
On the WindO/I-NV3 System Setup tab, click Alarm Log to display the Alarm Log Settings dialog box. Select an 
output method check box on the External Memory tab and configure the items. The data can be saved to the 
External Memory Folder on the external memory. For details, refer to “External Memory Tab” on page 13-20.

● Data Structure and Output Example
The data structure for files output with batch output and real time output is different.

■ Batch
Batch output shows the recovery and confirmation time for an alarm that has occurred on a single line.
The data structure of files output with batch output is as follows. Bold items are replaced by the Alarm Log settings, 
sampled data, project file name, and WindO/I-NV3 version.

Files saved to external memory are read using WindO/I-NV3.
On the WindO/I-NV3 Online tab, click the arrow under Upload, and then click Data in external memory 
to display the Upload from external memory dialog box. Select the Alarm Log Data check box, specify the 
location to save the files in Path, and then click OK to be able to save the files in the specified folder.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time"

Data row

" Channel number","Message"," MM/DD/YYYY HH:MM:SS"," MM/DD/YYYY HH:MM:SS",
" MM/DD/YYYY HH:MM:SS"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V1.00" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Ch.No.","Message","Occurrence Time","Recovery Time","Confirmation Time" - 74 bytes

" 1-0","Voltage drop"," 08/11/2011 14:46:12"," 08/11 14:46:13"," 08/11 14:46:16" - 82 bytes

" 1-1","Temperature abnormal"," 08/11/2011 14:47:18"," 08/11 14:47:19", " 08/11 14:47:20" - 90 bytes

·
·
·
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■ Real Time
Real time output displays the alarm state and the time the alarm became that state on a single line each time an 
alarm occurs, is recovered from, or is confirmed.
The data structure of files output with real time output is as follows. Bold items are replaced by the Alarm Log 
settings, sampled data, project file name, and WindO/I-NV3 version.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Title row "Time","State","Ch.No.","Message"

Data row
" MM/DD/YYYY HH:MM:SS","State"," Channel number","Message"

·
·
·

Output example Data size of each row

"Project Name","Dimmer Console","V1.00" - 41 bytes

"File Type","Alarm Log Data" - 30 bytes

- 2 bytes

"Time","State","Ch.No.","Message" - 35 bytes

" 08/11/2011 14:46:12","Occurred"," 1-0","Voltage drop" - 57 bytes

" 08/11/2011 14:46:13","Recovered"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:46:16","Confirmed"," 1-0","Voltage drop" - 58 bytes

" 08/11/2011 14:47:18","Occurred"," 1-1","Temperature abnormal" - 65 bytes

·
·
·

• The data size for each row is counted as 2 bytes for full-width characters, one byte for half-width 
characters, and two bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS



4 Using Data and Detected Alarms

13-34 SmartAXIS Touch User’s Manual



SmartAXIS Touch User’s Manual 14-1

14

D
ata Log Function

This chapter describes how to configure the Data Log function and its operation on the Touch.

  

1.1 How the Data Log Function is Used

The Data Log function samples values of devices with the Touch using the configured sampling condition. The 
sampled values of devices are saved in internal memory along with the sampling time.
The Data Log function can perform the following functions.

• Sample values of devices at a fixed time interval

• Sample values of devices when a value of device changes

• Output Data Log data to the external memory

Chapter 14 Data Log Function

1 Overview

Touch

External device

D100 : 123

D100 : 55

12 : 00

12 : 05

12 : 10

D100 : 0

Touch

External device

D100 : 123
0 1

USB flash drive
Output to USB flash drive

Data Log data (CSV)

Touch
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• Copy Data Log data to internal devices

Touch

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time  Data001

 01/01/2011 12:00:30  120

 01/01/2011 12:01:30  121

 01/01/2011 12:02:30  122

 01/01/2011 12:03:30  123

 01/01/2011 12:04:30  124

 01/01/2011 12:05:30  125

 01/01/2011 12:06:30  126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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1.2 Sampling Values of Devices

The Touch samples target values of devices at a fixed time interval or when a value of device changes.

● Sampling Values of Devices at a Fixed Time Interval
When sampling values of devices (D100 to D102) at a 5 minute interval (Time: 300 seconds) with the data storage 
amount in the data storage area is set to 3, the Touch samples Data Log data as follows.

1 5 minutes after data sampling starts, the Touch stores the values for devices D100 to D102.

2 10 minutes after data sampling starts, the Touch stores the values for devices D100 to D102.

3 15 minutes after data sampling starts, the Touch stores the values for devices D100 to D102.

4 20 minutes after data sampling starts, the Touch stores the values for devices D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

Touch

External device

12 : 05 : 00

12 : 10 : 00

12 : 15 : 00

D100 D101 D102
20  80 2

10  70 3

30  90 1

 ataDseciveD fo seulaV stored on the Touch

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

hcuoT eht no derots ataDseciveD fo seulaV

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:10:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4

Deleted
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● Sampling Values of Devices when Value of Device Changes
When sampling values of devices (D100 to D102), when a bit device configured as the sampling condition switches 
from 0 to 1 and the data storage amount in the data storage area is set to 3, the Touch samples Data Log data as 
follows.

1 When data sampling starts and the bit device configured as the sampling condition switches from 0 to 1, the Touch 
stores the values for devices D100 to D102.

2 When the sampling condition device switches from 0 to 1 the second time, the Touch stores the values for devices 
D100 to D102.

3 When the sampling condition device switches from 0 to 1 the third time, the Touch stores the values for devices D100 
to D102.

4 When the sampling condition device switches from 0 to 1 the fourth time, the Touch stores the values for devices 
D100 to D102.

Since the data storage amount in the data storage area is set to 3, the oldest data is deleted in order to make room 
for the newest data.

Touch

External device
D100 D101 D102
20  80 2

0 1

0 1

0 1

0 1

 ataDseciveD fo seulaV stored on the Touch

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
01/01/2011 12:01:00 10 70 3 01/01/2011 12:05:00 20 80 2
01/01/2011 12:02:00 20 80 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:03:00 30 90 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:04:00 10 70 3
01/01/2011 12:05:00 20 80 2
01/01/2011 12:06:00 30 90 1
01/01/2011 12:07:00 10 70 3
01/01/2011 12:08:00 20 80 2
01/01/2011 12:09:00 30 90 1
01/01/2011 12:10:00 10 70 3
01/01/2011 12:11:00 20 80 2
01/01/2011 12:12:00 30 90 1
01/01/2011 12:13:00 10 70 3
01/01/2011 12:14:00 20 80 2
01/01/2011 12:15:00 30 90 1
01/01/2011 12:16:00 10 70 3

1
2

3

0 1

hcuoT eht no derots ataDseciveD fo seulaV

Time
Value

Sampling Time
Value

3 ataD2 ataD1 ataD201D101D001D
···

···
···

···

01/01/2011 12:17:00 40 60 2 01/01/2011 12:13:00 10 70 3
01/01/2011 12:18:00 30 60 1 01/01/2011 12:15:00 30 90 1
01/01/2011 12:19:00 10 90 3 01/01/2011 12:20:00 20 80 2
01/01/2011 12:20:00 20 80 2

4
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1.3 Data Configuration

The sampled data is composed of the sampling time, values of devices, and labels.
The relationship between the Data Log function settings and the sampled data is as follows.

1. Channel The sampled data is in channel units. A maximum of 20 channels can be configured.
2. Data storage amount: The amount of sampled data to save. The maximum amount that can be configured per 

device differs according to the model. For details, refer to “Data Storage Amount” on 
page 14-6.

3. Amount of data: The amount of data configured for a channel. The maximum amount of data that can 
be configured is 128. The maximum number of devices that can be configured to 
sample values is 128 total for all channels.
For example, when the amount of data for channel 1 is set to 128, this is the maximum 
amount total for all channels, so channel 2 through 20 cannot be configured.

4. Sampling time label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the sampling time column.

5. Data label: When the sampled data is output as a CSV file, this label is displayed in the label row 
for the data number columns.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data No. 1 settings

Data No. 2 settings
Data No. 3 settings

Data No. 3: Value of device

3. Amount of data

5. Data label

1. Channel 1 to 20

2. Data storage amount

Data No. 2: Value of device

Data No. 1: Value of device
Time the value of device was sampled

4. Sampling time label

Data Log settings

Sampled data
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1.4 Saving and Deleting Data

● Saving Data
The sampled values of devices, along with the sampling time, are all saved in the data storage area.

If the saved data exceeds the Data Log data storage amount per device, the old data is deleted and the new data is saved.

Data Storage Amount

When saving the sampled data to the data storage area, set the data storage amount per device. The amount of data 
that can be saved in the data storage area is calculated from the configured data storage amount per device and data 
amount for each channel.
The maximum amount of data that can be saved in the data storage area is 12,528. When saving two devices, the 
number of data that can be saved in the data storage area is 6,264.

● Deleting Data
The method to delete sampled data from the data storage area is as follows.
• On the Online tab in WindO/I-NV3, click the arrow under Clear, and then click All or Data Log Data. For details, 

refer to Chapter 23 “4 Clear” on page 23-22.
• Press Main Menu on the Top Page in the System Mode, Initial Setting, Initialize, Data Log in order.

Sample values of devices

Touch

External device

Data Log data

 Sampling Time  Data001  Data002  Data003

 01/01/2011 12:00:00  20  120  201

 01/01/2011 12:10:00  21  121  204

 01/01/2011 12:20:00  22  122  206

 01/01/2011 12:30:00  23  123  206

 01/01/2011 12:40:00  24  124  210

 01/01/2011 12:50:00  25  125  218

Data Log data storage amount per device

Oldest data
(delete)

New data

When the backup battery is depleted, the data in the Data Log is erased when the Touch is turned off.
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1.5 Using the Data

The saved data can be used in the following ways.

• Display the data in the Line Chart
Configure the data channel numbers and data 
numbers and display the data in the Line Chart.
For details, refer to “4.1 Display the Data in the Line 
Chart” on page 14-25.

• Save to and read from an external memory
Data Log data is saved in a CSV file format into the 
external memory which it can be read on your 
computer.
For details, refer to “4.3 Saving Data as a CSV File” 
on page 14-37.

• Display the data with the Numerical Input or the 
Numerical Display
Copy the data to an internal device and display it with 
the Numerical Input or the Numerical Display.
For details, refer to “4.2 Displaying Data as Numerical 
Values” on page 14-27.

 Sampling Time Data001 Data002 Data003

 01/01/2011 12:00:00 20 120 201

 01/01/2011 12:10:00 21 121 204

 01/01/2011 12:20:00 22 122 206

 01/01/2011 12:30:00 23 123 206

 01/01/2011 12:40:00 24 124 210

Data Log data

To use with the Touch To use with devices other than the Touch

Book1

Data Log data
(CSV)

Sampling Time Data001 Data002 Data003 Data004

24
124
210

Data001

Data002

Data003
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This section describes the configuration procedure for the Data Log function.

2.1 Configuring the Sampling Condition and Devices for Sampling Data

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Select the channel number to register the Data Log settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

2 Data Log Function Configuration Procedure
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3 On the General tab, under Log function, select Enable.

4 Select the data size for the source device in Data Size.

5 Specify the device for sampling data in Source.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

6 Select the condition for sampling data under Sampling Method.

■ Fixed Period
Samples the value of source device at a fixed interval. If Fixed Period is selected, specify Time in seconds.

■ Event Bit
Samples the value of source device each time the monitored bit device or bit of the word device changes from 0 to 1. 
If Event Bit is selected, specify the device to monitor as the condition for sampling data in Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Event Word
Samples the value of source device each time the value of monitored word device changes. Specify the word device 
to monitor as the condition for sampling data in Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
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7 Click the Data tab.

The channel number selected on the General tab is displayed in Channel No.

8 In Number of Data, specify the number of devices to sample starting with the source device configured on the 
General tab.

The sequential devices from the starting address for the number of configured devices are displayed in Settings.

9 Enter the label to display in the sampling time column when the data is output as CSV under Sampling Time, in Label.

To use text registered in Text Manager, select the Use Text Manager check box and specify the ID number of the 
text to use as the label.

Click  to open Text Manager where you can edit the text.

10 Configure the details in Settings.
To batch register all the data settings for all data numbers, click Auto.
To individually register the data settings for each data number, select a data number, and then click Edit.

The dialog box that corresponds to each button is displayed.
An example when Edit is clicked is described here.

11 Check that the data number selected under Settings in Data No. is displayed.

12 Select the display type for the sampled value of device with Display Type.
The display type selected here is the display type for the numerical values when the data is output as CSV.

13 Select the data type for the sampled value of device with Data Type.
The data type selected here is the data type for the numerical values when the data is output as CSV.
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14 Enter the text to display in the data label in Label.
The text entered here is the label row for the data number columns when the data is output as CSV.
If you selected the Use Text Manager check box on the Data tab, specify the ID number for the text to use in the 
label.

15 Click OK to close the Data Settings dialog box.
To individually register Data Log settings on the Individual Settings dialog box, repeat steps 11 through 14.

16 Click OK to close the Individual Settings dialog box.

17 Repeat steps 2 through 16 to register Data Log settings for all of the channel numbers to use.

18 Specify the Data Log data storage amount per device.

Click  for Number of Stored Data for Data Log per Device to display the Data Storage Area Management dialog 
box.

Increase the number for Number of Stored Data for Data Log per Device.
Click OK to close the Data Storage Area Management dialog box.

19 Click OK.
The Data Log Settings dialog box closes.
This concludes configuring the sampling conditions and devices for sampling data.

Next, configure the functions to execute using sampled data.
 “4.1 Display the Data in the Line Chart” on page 14-25
 “4.2 Displaying Data as Numerical Values” on page 14-27
 “4.3 Saving Data as a CSV File” on page 14-37
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This section describes the items and buttons on the Data Log Settings dialog box and the Individual Settings dialog box.

3.1 Data Log Settings Dialog Box

All the devices to sample values from and their sampling conditions are collectively managed in the Data Log Settings 
dialog box.

■ Settings
Edits the Data Log settings for each channel.

3 Data Log Settings Dialog Box

Channel No.: Shows the channel number. Double clicking the cell displays the Individual Settings dialog box 
where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on 
page 14-14.

Log function: Shows whether or not the Data Log function is used. Double clicking the cell switches between 
Enable and Disable. If switched to Disable, that channel’s settings all return to the default 
settings.

Data Size: Shows the data size for the source device. Double clicking the cell switches between 16-bit and 
32-bit. This option can only be set when Enable is selected in Log Function.

Source: Specifies the device to sample values from. Double clicking the cell displays the Device Address 
Settings dialog box where you can edit the device address. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61. This option can only 
be set when Enable is selected in Log Function.
The size of the data to sample is 16 bits.

Sampling Method: Shows the condition for sampling data. Double clicking the cell switches between Fixed Period, 
Event Bit, and Event Word. This option can only be set when Enable is selected in Log Function.

Data Size: Shows the data size for the device that is the sampling condition. Double clicking the cell switches 
between 16-bit and 32-bit. This option can only be set when Event Word is selected in Sampling 
Method.

Range: Shows the time in seconds (1 to 9999) to sample data in a fixed interval when Fixed Period is 
selected in Sampling Method. Double clicking the cell displays the Individual Settings dialog box 
where you can edit the settings. For details, refer to “3.2 Individual Settings Dialog Box” on page 14-
14.
Shows the device that is the condition for sampling data when Event Bit or Event Word is 
selected in Sampling Method. Double clicking the cell displays the Device Address Settings 
dialog box where you can edit the device address. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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■ Edit
Registers or changes the settings for the selected channel number.
Select a channel number, and then click this button to display the Individual Settings dialog box. The settings for the 
selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 14-14.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

■ Clear Log Data
Select this check box to erase the data saved in the data storage area.

■ Number of Stored Data for Data Log per Device
Shows the maximum amount of data storage per device for Data Log data saved in the data storage area. If data is 
saved up the maximum amount and then the maximum is exceeded, the old data is deleted and the new data is saved.
The default is 0.

Click  to display the Data Storage Area Management dialog box where you can change the allocation of data 
storage area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

*1 Advanced mode only

Monitor: Shows the write destination device for the amount of data when monitoring the amount of 
sampled data. Shows No when not monitoring. Double clicking the cell displays the Individual 
Settings dialog box where you can edit the settings. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 14-14. This option can only be set when Enable is selected in Log 
Function.

Batch: Shows the trigger device that triggers batch output when batch outputting all the data saved in 
the data storage area to the external memory. Shows No when there is no batch output. Double 
clicking the cell displays the Individual Settings dialog box where you can edit the settings. For 
details, refer to “3.2 Individual Settings Dialog Box” on page 14-14.

Real Time: Shows whether or not to perform real time output. Double clicking the cell switches between 
Yes and No. Data is output to the external memory in 3 minute intervals for Yes channels. This 
option can only be set when Enable is selected in Log Function.

No. of Data*1: Shows the number of devices to sample in a channel. Double clicking the cell displays the 
Individual Settings dialog box where you can edit the settings. For details, refer to “3.2 
Individual Settings Dialog Box” on page 14-14. This option can only be set when Enable is 
selected in Log Function.

(Trigger device): Specifies the bit device that triggers the erasure of the data. The data for all channels is erased 
when the value of the configured device changes from 0 to 1. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the Data Log settings for the selected channel.

● General Tab
The General tab is used to configure the source devices for sampling data and the sampling conditions.

■ Channel No.
Specifies the channel number for sampling data (1 to 20).

■ Log function
Selects whether or not to use the Data Log function.

■ Data Size*1

Selects the data size of the source device as 16-bit or 32-bit.
The value of device in the selected data size is read and saved in the data storage area.

■ Source
Specifies the word device that is the source for sampling data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

*1 Advanced mode only

Enable: Samples values of devices and saves the data along with the sampling time.

Disable: Does not sample values of devices.
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■ Sampling Method
Sets the condition for sampling values of devices.

■ Monitor Number of Stored Data
Select this check box to monitor the number of times values of devices are sampled. The sampling count is written to 
the specified device. The maximum sampling count is 12,528.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the allocated data storage area as the save destination for Data Log 
data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device.

Usage = Current amount of Data Log data ÷ Data Log data storage amount per device (omits values after the decimal point)

*1 Advanced mode only

Fixed Period: Samples the value of source device at a fixed interval.

Time (sec): Specifies the time in seconds (1 to 9999).
This option can only be set when Fixed Period is selected.

Event Bit: Samples the value of source device each time the bit device or bit of the word device changes from 
0 to 1.

Event Word: Samples the value of source device each time the value of word device changes.

Device: Specifies the word device that triggers sampling data.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
This option can only be set when Event Bit or Event Word is selected.

(Destination Device): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.

Report when Sampling Count has reached or exceeded Threshold*1:

Writes 1 in the report device when the current sampling count reaches or 
exceeds the set threshold.

Threshold*1: Specifies the sampling count (1 to 12,528) that is the basis for reporting.

Report Device*1: Specifies the destination bit device or the destination bit of the word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

(Destination Device): Specifies the destination word device to write the current usage of the amount of Data Log data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.

Report when % Space Used has reached or exceeded Threshold*1:

Writes 1 in the report device when the current usage reaches or exceeds the 
set threshold.

Threshold*1: Specifies the usage (1 to 100) that is the basis for reporting.

Report Device*1: Specifies the destination bit device or the destination bit of the word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
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● External Memory Tab
The External Memory tab is used to configure whether or not to output saved data to the external memory.

The output data is stored in the following folder on the external memory.
\External memory folder\DATALOG

The default External Memory Folder name is “HGDATA01”. For details, refer to Chapter 26 “1.5 Setting the External 
Memory Folder” on page 26-12.

Data that is sampled after starting output to the external memory is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory.

All the data is saved on the external memory when the trigger devices changes from 0 to 1. If a file with the same 
name already exists on the external memory, that file is overwritten. The maximum amount of output data is the 
amount configured by the data storage area or 1,024.

*1 Advanced mode only

Touch

Data Log data (CSV)

Output to 
USB flash drive

USB flash driveData Log data

 Sampling Time  Data001  Data002  Data003

 01/01/2011 12:00:30  20 120  201

 01/01/2011 12:01:30  21 121  204

 01/01/2011 12:02:30  22 122  206

 01/01/2011 12:03:30  23 123  206

 01/01/2011 12:04:30  24 124  210

 01/01/2011 12:05:30  25 125  210

 01/01/2011 12:06:30  26 126  218 0 1

Trigger Device

Data to be output
(all)

Output stops if there is insufficient free space on the external memory. USB flash drive error information is 
stored in HMI Special Data Register LSD33.

Trigger Device: Specifies the bit device or bit of the word device that triggers batch output. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-
61.
Data is output to file when the trigger device changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.
The default is “LOGOn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Add Device data to File Name*1: Select this check box to add the bottom three digits of the 
value of device configured by File Name Device to the 
end of file name for the output data.
Example: When the channel number is 1 and the value of 

device configured by File Name Device is 123, 
the file name is “LOGO01123.CSV”.

File Name Device: Specifies the word device that is the source for the value to 
add to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61. This option can only be configured 
when the Add Device data to File Name check box is 
selected.



3 Data Log Settings Dialog Box

14-18 SmartAXIS Touch User’s Manual

■ Real Time
Select this check box to output data to the external memory in real time.

With real time output, data is saved to the external memory in three minute intervals after the Touch starts running. 
When there is already data with the same file name on the external memory, data is appended to that file. If there 
was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of output 
data differs according to the settings for the output channel such as the amount of data, the data size, and the labels.

If the sampling interval is shorter than real time output (the interval for writing to the external memory), that Data 
Log is recorded up to the data storage amount - 1, and then afterwards, old data is discarded in order and replaced 
with new data.

*1 Advanced mode only

Touch

Data Log data (CSV)

Output to 
USB flash drive

Data Log data

 Sampling Time  Data001  Data002  Data003

 01/01/2011 12:00:30  20 120  201

 01/01/2011 12:01:30  21 121  204

 01/01/2011 12:02:30  22 122  206

 01/01/2011 12:03:30  23 123  206

 01/01/2011 12:04:30  24 124  210

 01/01/2011 12:05:30  25 125  210

 01/01/2011 12:06:30  26 126  218

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that
Data to be output 
after another 
3 minutes

3 minute interval 
after operation 

starts

USB flash drive

Real time output stops when the file size of the Data Log data exceeds 256 MB or when there is insufficient 
space on the external memory. USB flash drive error information is stored in HMI Special Data Register 
LSD33.

• When the value of HMI Special Internal Relay LSM18 changes from 0 to 1, the data at that time is first 
output in real time to the USB flash drive, and then access to the USB flash drive is stopped.

• The text font configured for the starting device is output as the label font.
• You can check the free space on the USB flash drive with HMI Special Data Registers LSD34 to 35.

File Name: Enter the file name for the output data or shows the file name.
The default is “LOGAn.CSV”. (n: Data log channel number)
To change the file name, enter a new file name. The maximum number is 120 characters (including 
the extension).

Add Device data to File Name*1: Select this check box to add the bottom three digits of the 
value of device configured by File Name Device to the end of 
the file name for the output data.
Example: When the channel number is 1 and the value of 

device configured by File Name Device is 123, the 
file name is “LOGA01123.CSV”.

File Name Device: Specifies the word device that is the source for the value to add 
to the file name. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61. This option can only be configured when the Add 
Device data to File Name check box is selected.

• The function to sample data operates when Data Log data is being saved to the external memory.
• The methods to erase Data Log files saved on the external memory are as follows.

- To erase files during operation using parts, on the External Memory tab on the Project Settings dialog 
box, select the Remove Files and the All Data Log files check boxes, and then configure the trigger 
device. Assign that trigger device to a part.

- To erase files with WindO/I-NV3, click Clear on the Online tab, and then click Stored Data in 
External Memory to display the Clear Data dialog box. Select the Data Log Data check box, and then 
click OK.
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● Data Tab
The Data tab is used to configure the data to sample.

■ Channel No.
Shows the selected channel number.

■ Number of Data
Specifies the number of devices (1 to 128) for sampling data. Samples values of devices in this amount starting with 
the device configured as the source device on the General tab.

■ Use Text Manager
Select this check box to use text registered in Text Manager for labels when outputting data as CSV.

■ Label

The maximum amount of data that can be configured for one channel is 128. However, if 32-bit is selected 
for Data Size, it is counted as 16-bit data times 2 devices, so the maximum number devices that can be 
configured for one channel is 64. Data Size is configured with the General tab on the Individual Settings 
dialog box.

Sampling Time: Specifies the label to display in the sampling time column when outputting data as CSV.

Text ID Specifies the Text Manager ID number (1 to 32000) when text registered in Text 
Manager are used for labels.

Click  to open Text Manager where you can edit the text.
This option is only enabled if you select the Use Text Manager check box.

(Text) Enter the text to display in the label. The maximum number is 40 characters.
Text can only be entered when the Use Text Manager check box is cleared. The 
registered text is displayed when a text ID is specified.
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■ Settings
Settings is used to configure the details of the data to sample for each data number in the selected channel.

■ Auto
Batch registers or changes the settings for all the data.
Click this button to display the Auto-Setup dialog box. The details configured on the Auto-Setup dialog box are 
registered for all the data.
For details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

■ Edit
Registers or changes the settings for the selected data.
Select the data, and then click this button to display the Data Settings dialog box. The details configured on the Data 
Settings dialog box are registered or changed for the selected data.
For details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

Data No.: Shows the data numbers for the amount of data specified by Number of Data. Double clicking 
the cell displays the Data Settings dialog box. The data number cannot be edited. For details, refer 
to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

Device: Shows the device as sequential numbers starting with the source device specified on the General 
tab. Double clicking the cell displays the Data Settings dialog box. The device cannot be edited. For 
details, refer to “Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

Display Type: Shows the display type for numerical values when data is output as CSV. Double clicking the cell 
displays the Data Settings dialog box where you can edit the data settings. For details, refer to 
“Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

Data Type: Shows the data type for numerical values when data is output as CSV. Double clicking the cell 
displays the Data Settings dialog box where you can edit the data settings. For details, refer to 
“Auto-Setup Dialog Box and Data Settings Dialog Box” on page 14-21.

Text ID: Shows the Text Manager ID number when text registered in Text Manager is used for labels. 
Double clicking the cell opens Text Manager where you can edit the text.
Text ID is only displayed when you select the Use Text Manager check box.

Label: Shows the text to display as labels when data is output as CSV. Double clicking the cell allows you 
to edit the label. The maximum number is 40 characters.
Text can only be entered when the Use Text Manager check box is cleared.
The default label is “Data” and the data number.
Example: Data001
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Auto-Setup Dialog Box and Data Settings Dialog Box

With the Auto-Setup dialog box, all the data for the selected channel is batch registered or changed.
With the Data Settings dialog box, the selected data for the selected channel is registered or changed.

Data No.: Displays 1 when the Auto-Setup dialog box was displayed by clicking Auto.
Displays the data number for the selected data when the Data Settings dialog box was displayed 
by clicking Edit.

Display Type: Select the display type as Decimal or Hexadecimal for numerical values when data is output as 
CSV.

Data Type: Select the data type for numerical values when data is output as CSV. For details, refer to Chapter 
2 “1.1 Available Data” on page 2-1.
When float32 is selected, the maximum number of digits for the integer part is 10 and the 
number of digits for the decimal part is 5.

Text ID: Specifies the Text Manager ID number (1 to 32000) when text registered in Text Manager are 
used for labels. For the Auto-Setup dialog box, Text ID is automatically configured sequentially 
starting with the specified text ID.

Click  to open Text Manager where you can edit the text.
Text ID can only be configured when you select the Use Text Manager check box.

Label: Enter the text to display as the label when data is output as CSV. The maximum number is 40 
characters.
The default label is Data+number.
Example: Data001
This item is only displayed on the Data Settings dialog box when the Use Text Manager check 
box is cleared.
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● Options Tab
The Options tab only appears in Advanced mode. To switch to Advanced mode, click Advanced on the Data Log 
Settings dialog box.

To display the data saved in the data storage area as numerical values on the Touch, copy this data to the specified 
internal device.

■ Copy Data Log Data
Select this check box to copy data to a device.

Destination Device: Specifies the destination device for copied data. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
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■ Starting Point
Selects the starting point of the data to copy.

Example: 1. For Newest Data, the starting point is the newest sampling time data.
2. For Oldest Data, the starting point is the oldest sampling time data.
3. For Specify by Value of Device and source device: 3, the starting point is the third item of data from 
the oldest sampling time data.

■ Number of Data
Selects the specification method for the amount of data to copy.

■ Stored Order of Data
Selects the order to copy data.

Example: When Starting Point is Newest Data and Number of Data is 3, data is copied in the following order 
starting from device LDR10 configured in Destination Device.

Newest Data: Sets the starting point as the newest data.

Oldest Data: Sets the starting point as the oldest data.

Specify by Value of Device: Specifies which data from the oldest data to set as the starting point.

Specifies the source word device. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

Data Log data
Sampling Time Value

2. Oldest Data read starting point → 12/18/2011 17:44:10 20
12/18/2011 18:34:10 21

3. Specify by Value of Device read starting point (source device: 3) → 12/19/2011 19:24:43 22
12/19/2011 20:01:54 24
12/19/2011 21:39:21 26

1. Newest Data read starting point → 12/20/2011 05:57:06 28

Value: Uses a constant.
Specifies the amount to copy (1 to 64).

Device: Uses a word device.
Specifies the source word device. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.

The maximum amount of data that can be copied to the internal device is 64.

From Newest to Oldest: Of the data to copy, copies from the start point in order of the newest data first.

From Oldest to Newest: Of the data to copy, copies from the start point in order of the oldest data first.

Data Log data
Sampling Time Value Destination Device Value

12/18/2011 17:44:10 20 Configured device → LDR10 28 ← Copy from newest data
11RDL:: 26

12/19/2011 19:24:43 21RDL22 24
12/19/2011 20:01:54 24

Newest data 
read starting point →

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Destination Device Value
Configured device → LDR10 24 ← Copy from oldest data

LDR11 26
LDR12 28

Amount of data: 3
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■ Target Data
Selects the data to copy from the Data Log data.

Example: When Start No. is 2 and End No. is 4, data 2 to 4 is the copy target.

■ Trigger Condition
Selects the condition to start copying.

Sampling Time: Select this check box to copy the sampling time data from the Data Log data. When this check 
box is selected, values of devices are copied in order from the data for data number 1.

Value of Device: Select this check box to copy the value of device from the Data Log data.

Data No.: Selects the specification method for the data number of the value to copy.

Value: Uses a constant.

Device: Uses a word device.

Start No.: Of the data to copy, specifies the data number of the data to start 
copying.
If you select Value, specify the data number (1 to 128).
If you select Device, specify the source device. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.
When the Sampling Time check box is selected, the data number 
is 1. This cannot be changed.

End No.: Of the data to copy, specifies the data number of the data to end 
copying.
If you select Value, specify the data number (1 to 128).
If you select Device, specify the source device. You can only 
specify an internal device. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.

Start No. End No.
Data No.: 1 2 3 4 5

↓ ↓ ↓ ↓ ↓
Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5

10/01/2011 12:34:56 100 60 240 60 240
10/02/2011 03:45:12 200 80 450 80 450

Copy target

Always: Copies each time the data is updated.

Device: Specifies the device that triggers the start of copying the data. Copies the data when the value 
of the specified device changes from 0 to 1.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
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4.1 Display the Data in the Line Chart

You can display the sampled data in the Line Chart.

1 On the Home tab, in the Parts group, click Charts, and then click Line Chart.

2 Click a point on the edit screen where you want to place the Line Chart.

3 Double-click the dropped Line Chart and a Properties dialog box will be displayed.

4 On the General tab, select Chart Type as Log Trend (Normal) or Log Trend (Pen Recorder).

4 Using the Data
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5 Click the Pen (Log) tab.

6 Specify Channel No. and Data No. for the data to display in the chart.

7 Select Line Type, Line Size, and Line Color.

8 Click Set.

The data to display in the chart is registered in the channel number (Ch1 to Ch20) for the chart selected in Settings.

9 Repeat steps 6 through 8 to register the data to display in the chart.

10 Click OK.
The Properties dialog box closes.
This concludes configuring the Line Chart.

Click Data Log Settings to display the Data Log Settings dialog box where you can configure the channel 
while checking the data to display. Select Channel No. under Settings, and then click OK to close the 
Data Settings dialog box. Channel No. reflects the selected channel number.
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4.2 Displaying Data as Numerical Values

You can display data in the Numerical Display by copying data saved in the data storage area to an internal device 
according to the conditions configured with the Options tab on the Individual Settings dialog box.

● Copying Data to Internal Devices

Copying Sampling Time Data

Sampling time data is copied as a BCD value to the six sequential devices starting with the device configured by 
Destination Device.
The sampling time data is copied in year, month, day, hour, minute, second order regardless of the Stored Order of 
Data setting.

■ Example
When the sampling time 10/01/2011 12:01:30 is copied to the destination device

Data Read Start Position and Copy Order of Data to the Destination Device

The data to copy and the order differs according to the Starting Point and the Stored Order for Data settings.

■ Example 1
Copying three items of the newest data in the Data Log to the destination device

Data Log data
Sampling Time Value Destination Device Value

10/01/2011 12:01:30 20 Configured device → LDR10 2011 ← Year
LDR11 10 ← Month
LDR12 1 ← Day
LDR13 12 ← Hour
LDR14 1 ← Minute
LDR15 30 ← Second

Item Setting

Destination Device LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Newest to Oldest

Data Log data
Sampling Time Value Destination Device Value

12/18/2011 17:44:10 20 Configured device → LDR10 28 ← Copy from newest data
11RDL:: 26

12/19/2011 19:24:43 21RDL22 24
12/19/2011 20:01:54 24

Newest data 
read starting point →

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 3
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■ Example 2
Copying three items of the newest data in the Data Log in order from the oldest to the destination device

■ Example 3
Setting the starting point to the fourth item of the oldest data in the Data Log and copying three items of data from 
the newest to the destination device

Item Setting

Destination Device LDR10

Starting Point Newest Data

Number of Data 3

Stored Order of Data From Oldest to Newest

Data Log data
Sampling Time Value Destination Device Value

12/18/2011 17:44:10 20 Configured device → LDR10 24 ← Copy from oldest data
11RDL:: 26

12/19/2011 19:24:43 21RDL22 28
12/19/2011 20:01:54 24

Newest data 
read starting point →

12/19/2011 21:39:21 26
12/20/2011 05:57:06 28

Amount of data: 3

Item Setting

Destination Device LDR10

Starting Point Specify by Value of Device (value is 4)

Number of Data 3

Stored Order of Data From Newest to Oldest

Data Log data
Sampling Time Value Destination Device Value

12/18/2011 17:44:10 20 Configured device → LDR10 28 ← Copy from newest data

Specify by Value of Device 
read starting point

12/19/2011 07:24:09 11RDL12 26
12/19/2011 19:24:43 21RDL22 24

(Source device: 4) → 12/19/2011 20:01:54 24
12/19/2011 21:39:21 26
12/20/2011 05:57:06 28
12/20/2011 15:26:17 29
12/21/2011 06:46:57 31

Amount of data: 3
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Copying Data when 32-bit is Selected as the Data Size

When 32-bit is selected for Data Size on the General tab on the Individual Settings dialog box, two destination 
devices are required for a single item of data.

■ Example 1
Copying the newest data in the Data Log with the data size selected as 32-bit to the destination device LDR 10.

Item Setting

Destination Device LDR 10

Starting Point Newest Data

Number of Data 2

Data Size 32-bit

Stored Order of Data From Newest to Oldest

Data log data
Sampling Time Value Destination Device Value

12/18/2011 17:44:10
87654321 

(hex)
Configured device→ LDR 10 3344 ←Copy from newest data

LDR 11 1122
21 RDL:: 7788

12/19/2011 19:24:43
12345678 

(hex)
LDR 13 5566

12/19/2011 20:01:54
55667788 

(hex)

Newest data 
read starting point→ 12/19/2011 21:39:21

11223344 
(hex)

Amount of data: 2

The data copy order for the device selected with a data size of 32-bit is configured on the Project Settings 
dialog box, on the System tab, with Storage Method of 32-bit Numerical Data. For details, refer to 
Chapter 3 “3.1 System Tab” on page 3-19.
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Copying Multiple Items of Data

When copying multiple items of data, first all the sampling times for the data are copied in order starting with the 
device configured as the destination device, then the values of devices for all the data are copied in order.
For example, data is copied in this order: first sampling time → second sampling time → ... → first data 1 value of 
device → first data 2 value of device → second data 1 value of device → second data 2 value of device and so on.

■ Example 1: When the amount of data is greater than the data to copy
When the sampling time and values of devices from data start number 1 to end number 3 are copied to the 
destination device as two items of data

Item Setting

Destination Device LDR10

Starting Point Newest Data

Number of Data 2

Stored Order of Data From Oldest to Newest

Target Data
Sampling Time, Value of Device

Data No.: Start No. 1, End No. 3

Data Log data

Sampling Time Data 1 Data 2 Data 3 Data 4 Data 5
10/01/2011 12:00:30 10 40 100 20 120

10/01/2011 12:34:56 100 60 240 30 200

10/02/2011 03:45:12 200 80 450 70 400 ← Newest Data read starting point

Destination Device Value
Configured device → LDR10 2011 ← Copy from oldest data

LDR11 10

← First sampling time

LDR12 01

LDR13 12

LDR14 34

LDR15 56

LDR16 2011

← Second sampling time

LDR17 10

LDR18 02

LDR19 03

LDR20 45

LDR21 12

LDR22 100 ← First data 1 value

LDR23 200 ← Second data 1 value

LDR24 60 ← First data 2 value

LDR25 80 ← Second data 2 value

LDR26 240 ← First data 3 value

LDR27 450 ← Second data 3 value

1.

2.

3. 4. 5.

1.

2.

3.

4.

5.
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■ Example 2: When the amount of data is less than the data to copy
When the sampling time and values of devices from data start number 1 to end number 3 are copied to the 
destination device as two items of data

Item Setting

Destination Device LDR10

Starting Point Newest Data

Number of Data 2

Stored Order of Data From Oldest to Newest

Target Data
Sampling Time, Value of Device

Data No.: Start No. 1, End No. 3

When writing with the following settings, “Device range error” is displayed.
• Starting Point is 0 or a value larger than the amount of saved data
• Start No. is 0 or a value larger than Data No.
• End No. is 0 or a value larger than Data No.
• Start No. is a value larger than End No.

Data Log data

Sampling Time Data 1 Data 2 Data 3 (no data)

10/01/2011 12:00:30 10 40

10/01/2011 12:34:56 100 60

10/02/2011 03:45:12 200 80 ← Newest Data read starting point

Destination Device Value
Configured device → LDR10 2011 ← Copy from oldest data

LDR11 10

← First sampling time

LDR12 01

LDR13 12

LDR14 34

LDR15 56

LDR16 2011

← Second sampling time

LDR17 10

LDR18 02

LDR19 03

LDR20 45

LDR21 12

LDR22 100 ← First data 1 value

LDR23 200 ← Second data 1 value

LDR24 60 ← First data 2 value

LDR25 80 ← Second data 2 value

LDR26 0 ← First data 3 value

LDR27 0 ← Second data 3 value

1.

2.

3. 4.

1.

2.

3.

4.

If the amount of data in the Data Log is less
than the data to copy, 0 is stored
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● Displaying Data on the Numerical Display
You can copy sampled data to an internal device and display it with the Numerical Display.

1 On the Configuration tab, in the System Setup group, click Data Log.

The Data Log Settings dialog box is displayed.

2 Click Advanced.

The dialog box switches to Advanced mode.

3 Under Settings, select the channel number for the data to display numerical values of on the Numerical Display, then 
click Edit.

The Individual Settings dialog box is displayed.



SmartAXIS Touch User’s Manual 14-33

4 Using the Data

14

D
ata Log Function

4 Select Enable for Log function on the General tab and configure Data Size, Source, and Sampling Method.

5 Specify the number of devices to sample in Number of Data on the Data tab, and configure Display Type and 
Data Type for each item of data in Settings.

6 Click the Options tab.

7 Select the Copy Data Log Data check box.

8 Specify the destination device for the copied data in Destination Device.

You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

9 Select the data that is the start point for copying data in Starting Point.

■ Newest Data
Set the starting point to read as the newest data.

■ Oldest Data
Set the starting point to read as the oldest data.

■ Specify by Value of Device
Specifies which data from the oldest data to set as the starting point to read by value of device, and sets that data as 
the starting point to read.
Specifies the source word device. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
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10 Select the specification method for the amount of data to copy in Number of Data.

■ Value
Use a constant.
Specifies the amount to copy (1 to 64).

■ Device
Use a word device.
Specifies the source word device. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

11 Select the order to copy data in Stored Order of Data.

■ From Newest to Oldest
Of the data to copy, copies from the start point in order of the newest data first.

■ From Oldest to Newest
Of the data to copy, copies from the start point in order of the oldest data first.

12 Select the data to copy from the data in Target Data.
Select the Sampling Time check box to copy the sampling time data from the data.
Select the Value of Device check box to copy the value of device from the data. When not copying the value of 
device, proceed to step 15.

13 Select the specification method for the data number to copy the value in Data No..

■ Value
Use a constant.

■ Device
Use a word device.

14 Specify the data number of the data to start copying out of the data to copy with Start No..
If you select Value, specify the data number (1 to 128).

If you select Device, specify the source device. You can only specify an internal device. Click  to display the 
Device Address Settings dialog box. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.
When the Sampling Time check box is selected, the data number is 1. This cannot be changed.

15 Specify the data number of the data to end copying out of the data to copy with End No..
If you select Value, specify the data number (1 to 128).

If you select Device, specify the source device. You can only specify an internal device. Click  to display the 
Device Address Settings dialog box. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

16 Select the condition to start copying in Trigger Condition.

■ Always
Copies each time the data is updated.

■ Device
Specifies the device that triggers the start of copying the data. Copies the data when the value of the specified device 

changes from 0 to 1. Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

17 Click OK to close the Individual Settings dialog box.

The maximum amount of data that can be copied to the internal device is 64.
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18 Click OK to close the Data Log Settings dialog box.

19 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

20 Click a point on the edit screen where you want to place the Numerical Display.

21 Double-click the dropped Numerical Display and a Properties dialog box will be displayed.

22 Select the display type for the copied data with Display Type on the General tab.

23 Select the data type for the copied data in Data Type under Data Format.

24 Specify the number of digits to display in Digits under Data Format.
The range of digits that can be set differs according to the display type and data type.
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25 Specify the source device for the copied data in Display Device under Display Method.
For sequential devices of the amount of data to copy starting with Destination Device configured on the Options 
tab on the Data Log Settings Individual Settings dialog box, set Display Device for each Numerical Display to those 
devices.
Example: When Destination Device is LDR10, Number of Data is 3

Specify three Numerical Displays with Display Device specified as LDR10, LDR11 and LDR12

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

26 Click OK.
The Properties dialog box closes.

27 Repeat step 17 through 26 to configure the Numerical Displays for the amount of data to copy.
This concludes configuring the Numerical Display.

Touch

External device

(Internal device)

124
125
126

Data Log data

 Sampling Time  Data001

 01/01/2011 12:00:30  120

 01/01/2011 12:01:30  121

 01/01/2011 12:02:30  122

 01/01/2011 12:03:30  123

 01/01/2011 12:04:30  124

 01/01/2011 12:05:30  125

 01/01/2011 12:06:30  126

LDR10 : 126

LDR11 : 125

LDR12 : 124

Copy
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4.3 Saving Data as a CSV File

● Saving Data as a CSV File
The Data Log data can be saved to the external memory as a CSV file.
The procedure to save the data is as follows.
On the WindO/I-NV3 System Setup tab, click Data Log to display the Data Log Settings dialog box. Select a 
channel number to save to the external memory, and then click Edit to display the Individual Settings dialog box. 
Select an output method check box on the External Memory tab and configure the items. The data can be saved to 
the External Memory Folder on the external memory. For details, refer to “External Memory Tab” on page 14-16.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Data Log settings, sampled data, project file name, and WindO/I-NV3 version.

Files saved to external memory are read using WindO/I-NV3.
On the WindO/I-NV3 Online tab, click the arrow under Upload, and then click Data in external memory 
to display the Upload from external memory dialog box. Select the Data Log Data check box, specify the 
location to save the files in Path, and then click OK to be able to save the files in the specified folder.

Headers

“Project Name”,”Project name”,”Version number”
“File Type”,”Log type”
Blank row
“Channel No.”,”Channel number”
“Source”,”Source device”
“Sampling Method”,”Sampling condition (type)”
“Sampling condition (label)”,”Sampling condition (configuration details)”
Blank row

Label row “Label (sampling time)”,”Label (data number 1)”,”Label (data number 2)”... times the amount of data

Data row

“MM/DD/YYYY HH:MM:SS”,Data number 1 data value,Data number 2 data value... times the amount of 
data

·
·
·

Output example Data size of each row
“Project Name”,”Dimmer Console”,”V1.00” - 41 bytes
“File Type”,”Data Log Data” - 29 bytes

- 2 bytes
“Channel No.”,”1” - 19 bytes
“Source”,”LDR 100” - 20 bytes
“Sampling Method”,”Fixed Period” - 34 bytes
“Time[Sec]”,”1” - 17 bytes

- 2 bytes
“Sampling Time”,”Data001”,”Data002” - 37 bytes
“08/23/2011 18:32:04”,171,234 - 32 bytes

·
·
·

• The data size for each row is counted as two bytes for full-width characters, one byte for characters, and 
two bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the year in the data row.
• The display type for the date and time differs according to the language configured in Project Settings, 

on the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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This chapter describes how to configure the Operation Log function and its operation on the Touch.

  

1.1 How the Operation Log Function is Used

The Operation Log function records events that have occurred on the Touch, including user operations such as 
pressing a button or changing the operation mode.
You can perform the following actions using the Operation Log function.

• Record turning on the Touch power

• Record switching the Base Screen

• Record changing the user

• Record changing the operation mode

Chapter 15 Operation Log Function

1 Overview

Power ON

Touch

130

Touch

12:00
Run Mode

Full

Tank 1Switch to Base Screen

TouchTouch

130

12:01
Base Screen 2Base Screen 1

Touch

130

Touch

130
Change Users

Group parts not displayed on User2 screen

User1
12:02
User2

TouchTouch

130
Change Operation Modes

Run Mode
12:03
System Mode
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• Record pressing a touch switch

• Record writing a value to a device by pressing a touch switch

• Output Operation Log data to the external memory

Touch

130

12:04
Press touch switch

Touch

100
100

100

D1= 100

Write 100

ValueExternal device

12:05
Press touch switch

100→D1

Output to USB flash drive

Operation Log data
(CSV)

USB flash drive

Touch
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1.2 Recorded Events

The recorded events are as follows.

■ Power ON
This operation is recorded when the Touch power is turned on.

■ Switch to Base Screen
This operation is recorded by the following events.
• Switched the Base Screen by pressing the Goto Screen Button or a Multi-Button
• Switched the Base Screen by pressing the key button Ref. on the Alarm List Display or the Alarm Log Display
• Switched the Base Screen by executing the Goto Screen Command or a Multi-Command
• Switched the Base Screen by writing a screen number to System Area 1 Display screen number (address+0)

■ Change Users
This operation is recorded by the following events.
• Switched the user by entering a password on the Password Screen
• Switched the user by writing a value of device
• Switched to the default user

■ Change Operation Modes
This operation is recorded by the following events.
• Switched to System Mode by pressing the Goto Screen Button or a Multi-Button
• Switched to System Mode by executing the Goto Screen Command or a Multi-Command
• Switched to System Mode by pressing System Mode on the Maintenance screen
• Switched to Run Mode from System Mode by pressing Run on the Top Page in the System Mode
• Switched to Monitor Mode from Run Mode by clicking Start Monitor on the WindO/I-NV3 Online tab
• Switched to Run Mode from Monitor Mode by clicking Stop Monitor on the WindO/I-NV3 Online tab

■ Press buttons
This operation is recorded by the following events.
• Pressing a Bit Button, Word Button, Goto Screen Button, Multi-Button, Selector Switch, Potentiometer, Numerical 

Input, Character Input
• Pressing the key buttons ENT, Download Project, Upload Project, All Chk., Del. All, Ref., Stop the Sound 

of the Buzzer and Screen flashing

■ Write Data to any Devices
This operation is recorded by the following event.
Writing a value to a device by pressing a Bit Button, Word Button, Multi-Button, Selector Switch, Potentiometer, 
Numerical Input, Character Input

• If User is selected in Default User in the User Accounts dialog box, a Change Users event occurs when 
the power is turned on and when the operation mode is changed.

• If the Switch to Base Screen check box is selected, a Switch to Base Screen event also occurs when 
a Change Users event occurs.

The Operation Log is only recorded during Run Mode.
Switching from Run Mode to System Mode and switching from System Mode to Run Mode is recorded. 
Switching from System Mode to Data Transfer Mode and switching from Data Transfer Mode to System 
Mode is not recorded.

The Operation Log only records touch switch presses for parts created in WindO/I-NV3.
Operations for the following screens and buttons displayed in messages and title bars are not recorded.
• System screen
• Password screen
• System error messages
• Popup screen title bar
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1.3 Data Configuration

The recorded data is composed of a label, time, user name, screen number, event name, part name, device, and 
content after the change.
The relationship between the Operation Log function settings and the recorded data is as follows.

1. Event: Events that occur on the Touch due to operations including user operations. Only the checked 
events are recorded.

2. Data storage amount:The amount of data to record. For details, refer to “Data Storage Amount” on page 15-6.
3. Label: When the recorded data is output as a CSV file, this is the text displayed in the label row.
4. Sampling Time: The time the event occurred.

The display type for the date and time varies based on the language configured in Project 
Settings, on the Project Details tab, in Language.
YYYY/MM/DD 
HH:MM:SS:

Japanese

MM/DD/YYYY 
HH:MM:SS:

European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic

5. User Name: The user name when the event occurred.
The user name is only recorded when the Use Security functions check box is selected on the 
General tab in the User Accounts dialog box.

6. Screen No.: The screen type and number that was displayed when the event occurred.
Base n: Base Screen (n: screen number)

Example: Base 1
Popup n: Popup Screen (n: screen number)

Example: Popup 10
7. Event Name: When the recorded data is output as a CSV file, this is the text displayed as a label to describe the 

event that occurred. This item is configured in the Data Labels dialog box.

Operation Log settings

Recorded data
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8. Part Name: The part name for the pressed touch switch when the Press buttons event occurs.
9. Device Address: The destination device when the Write Data to any Devices event occurs.

When an indirect write is used, the device specified by the indirect value is recorded.
Example: When the device configured as the destination for the value 100 is LDR100 and the 

indirect value is 3

10. Changed to: The result produced from the event that occurred. The recorded content varies based on the 
event that occurred.
Switch to Base Screen: The screen type and number after switching.

Base n: Base Screen (n: screen number)
Example: Base 1

Change Users: The user name after the change.
Change Operation Modes: The operation mode after the change.

Run Mode: Run Mode
System Mode: System Mode
Monitor Mode: Monitor Mode

Write Data to any Devices: The value written to the device by pressing the touch switch. This value 
is handled as BIN16 (+). For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.
The value written to the device is recorded as BIN16 (+) regardless of 
the data type.
Example: When -10 (0xFFF6) is written to device D0

If the written value is 2 words (32 bits), each word is recorded (16 bits). 
For the storage order for 32-bit device data, the upper word and lower 
word are stored following the Storage Method of 32-bit Numerical 
Data setting. Storage Method of 32-bit Numerical Data is 
configured on the System tab in the Project Settings dialog box. For 
details, refer to Chapter 3 “3.1 System Tab” on page 3-19.
Example: When Storage Method of 32-bit Numerical Data is from 

Lower word and 12345678 (0xBC614E) is written to device 
D0 with the data type BIN32 (+)

Event Name Part Name Details Changed to
Press buttons WordSwitch1 – –

Write Data to any Devices – LDR103 100

Event Name Part Name Details Changed to
Press buttons WordSwitch1 – –

Write Data to any Devices – D0 65526 (0xFFF6)

Event Name Part Name Details Changed to
Press buttons WordSwitch1 – –

Write Data to any Devices – D0 24910 (0x614E)
Write Data to any Devices – D1 188 (0xBC)
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1.4 Saving and Deleting Data

● Saving Data
The recorded data is saved in the data storage area.

If the saved data exceeds the Operation Log data storage amount, the oldest data is deleted and the new data is 
saved.

Data Storage Amount

The maximum amount of data that can be saved in the data storage area is 3579.

● Deleting Data
The method to delete recorded data from the data storage area is as follows.
• On the WindO/I-NV3 Online tab, click the arrow under Clear, and then click All or Operation Log Data. For 

details, refer to Chapter 23 “4 Clear” on page 23-22.
• On the Top Page in the System Mode, press Main Menu, Initial Setting, Initialize, and Opn Log in order.

Touch

130

Operation Log data

 Sampling Time User  Screen No.  Event Name  Part Name  Details  Changed to

 12/01/2011 12:00:10  - Base1  Power ON  - - -

 12/01/2011 12:01:23  User1  Base1  Switch to Base Screen  - - Base2

 12/01/2011 12:02:45  User1  Base2  Change Users  - - User2

 12/01/2011 12:03:06  User2  Base2  Change Operation Modes  - - System Mode

 12/01/2011 12:04:11  User2  Base2  Press buttons  BitSwitch  - -

 12/01/2011 12:04:11  User2  Base2  Write Data to any Devices  - LDR 0 55

Operation Log data storage amount

Oldest data
(delete)

New data

When the backup battery is depleted, the data in the Operation Log is erased when the Touch is turned off.

The maximum amount of data that can be recorded by a single operation is 150 items. When writing to 
multiple devices in a single operation using the Multi-Button or other part, data over 150 items cannot be 
recorded. If the data to be recorded in a single operation exceeds 150 items, HMI Special Internal Relay 
LSM22 is set to 1. For details, refer to Chapter 27 “HMI Special Internal Relay (LSM)” on page 27-1.
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1.5 Using the Data

The saved data can be used in the following ways.

• Save to and read from an external memory
Operation log data is saved in a CSV file format into the 
external memory which it can be read on your computer.
For details, refer to “4.1 Saving the Data as a CSV File” on 
page 15-17.

Operation Log data

 Sampling Time User  Screen No.  Event Name  Part Name  Details  Changed to

 12/01/2011 12:00:10  - Base1  Power ON  - - -

 12/01/2011 12:01:23  User1  Base1  Switch to Base Screen  - - Base2

 12/01/2011 12:02:45  User1  Base2  Change Users  - - User2

 12/01/2011 12:03:06  User2  Base2  Change Operation Modes  - - System Mode

 12/01/2011 12:04:11  User2  Base2  Press buttons  BitSwitch  - -

 12/01/2011 12:04:11  User2  Base2  Write Data to any Devices  - LDR 0 55

Operation Log data
(CSV)

Book1

Sheet1 Sheet2 Sheet3

 Sampling Time User Screen No. Event Name Part Name Details Changed to

 12/01/2011 12:00:10 - Base1 Power ON - - -

 12/01/2011 12:01:23 User1 Base1 Switch to Base Screen - - Base2

 12/01/2011 12:02:45 User1 Base2 Change Users - - User2

 12/01/2011 12:03:06 User2 Base2 Change Operation Modes - - System Mode

 12/01/2011 12:04:11 User2 Base2 Press buttons BitSwitch - -

 12/01/2011 12:04:11 User2 Base2 Write Data to any Devices - LDR 0 55
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This section describes the configuration procedure for the Operation Log function.

2.1 Configuring the Events and the Condition for Recording

1 On the Configuration tab, in the System Setup group, click Operation Log.

The Operation Log Settings dialog box is displayed.

2 Select the Enable Operation Log Settings check box.

3 Select the check boxes for the events to record under Target Events to record.

2 Operation Log Function Configuration Procedure

Power ON: The following items are recorded when the Touch power is turned on.
Time, screen number, event name

Switch to Base Screen: The following items are recorded when the Base Screen is switched.
Time, user name, screen number, event name, changed to

Change Users: The following items are recorded when the user is changed.
Time, user name, screen number, event name, changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, user name, screen number, event name, changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, user name, screen number, event name, part name

Write Data to any Devices: The following items are recorded when a value is written to a device by pressing a 
touch switch.
Time, user name, screen number, event name, device, changed to
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4 Configure the Operation Log data storage amount in Number of Stored Data.

Click  to display the Data Storage Area Management dialog box.
Specify the Operation Log data storage amount in Number of Stored Data for Operation Log, and then click OK.
The Data Storage Area Management dialog box closes.

5 Select the condition to record events in Trigger condition.

■ Always
Always records events.

■ Device
Records events when the specified device is 1. You can only specify an internal device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

6 Click OK.

The Operation Log Settings dialog box closes.
This concludes configuring the events and the condition for recording.
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This section describes items and buttons on the Operation Log Settings dialog box.

3.1 Operation Log Settings Dialog Box

● General Tab
The General tab is used to configure the events and the condition for recording.

■ Enable Operation Log Settings
Select this check box to use the Operation Log function.

■ Target Events to record
Selects the events to record. Select the check boxes for the events to record.

3 Operation Log Settings Dialog Box

Power ON: The following items are recorded when the Touch power is turned on.
Time, screen number, event name

Switch to Base Screen: The following items are recorded when the Base Screen is switched.
Time, user name, screen number, event name, changed to

Change Users: The following items are recorded when the user is changed.
Time, user name, screen number, event name, changed to

Change Operation Modes: The following items are recorded when the operation mode is changed.
Time, user name, screen number, event name, changed to

Press buttons: The following items are recorded when a touch switch is pressed.
Time, user name, screen number, event name, part name

Write Data to any Devices: The following items are recorded when a value is written to a device by pressing a 
touch switch.
Time, user name, screen number, event name, device, changed to

Edit Data Labels: Displays the Data Labels dialog box.
The Data Labels dialog box is used to edit the text displayed in the label row and the 
event names displayed in the data rows when the recorded data is output as a CSV file.
For details, refer to “Data Labels Dialog Box” on page 15-12.
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■ Monitor Number of Stored Data
Select this check box to count the amount of recorded Operation Log data. The amount of recorded data is written to 
the specified device.

■ Monitor % Space Used in Data Storage Area
Select this check box to monitor the usage of the data storage area allocated as the save destination for Operation 
Log data. The usage is calculated from the data storage amount allocated to the data storage area and the amount of 
saved data, and then written to the specified device.

Usage = Current amount of Operation Log data ÷ Operation Log data storage amount (omits values after the decimal point)

■ Clear Log Data
Select this check box to erase the Operation Log data saved in the data storage area.

■ Number of Stored Data
Shows the maximum amount of Operation Log data to save in the data storage area. Data is saved up to the set 
amount. The maximum amount of data that can be saved in the data storage area is 3579.

Click  to open the Data Storage Area Management dialog box where you can change the allocation of data storage 
area memory. For details, refer to Chapter 16 “Data Storage Area” on page 16-1.

■ Trigger Condition
Selects the trigger condition for the Operation Log function.

*1 Advanced mode only

(Destination Device): Specifies the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.

Report when Number of Stored Data has reached or exceeded Threshold*1:
Writes 1 to the report device when the current amount of data reaches or 
exceeds the set threshold.

Threshold*1: Specifies the amount of data (1 to 3579)  that is the basis for reporting.

Report Device*1: Specifies the destination bit device or the bit of the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

(Destination Device): Specifies the destination word device to write the current usage of the amount of Operation 
Log data storage.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.

Report when % Space Used has reached or exceeded Threshold*1:
Writes 1 in the report device when the current usage reaches or exceeds the 
set threshold.

Threshold*1: Specifies the usage (1 to 100) that is the basis for reporting.

Report Device*1: RSpecifies the destination bit device or the bit of the destination word device.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

(Trigger Device): Specifies the bit device that triggers the erasure of the data. The saved data is erased when the 
value of the configured device changes from 0 to 1. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Always: Always records events.
Device: Records events when the specified device is 1. You can only specify an internal device.

For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
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Data Labels Dialog Box

The Data Labels dialog box is where you can edit labels for recorded data and event names when saving data as a 
CSV file.

Label of Recorded Data

■ Use Text Manager
Select this check box to use text registered in Text Manager for recorded data labels when saving data as a CSV file.

■ Label of Recorded Data
Specifies the text to display in the label row in Text or Text ID.

The details for each label row label is as follows.

Text: Double click the cell to enter the text to display as the label. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text 
registered in Text Manager as the label.
This option is only enabled if you select the Use Text Manager check box.

Sampling Time: The label for the column to display the time the event occurred.

User Name: The label for the column to display the user name when the event occurred.

Screen No.: The label for the column to display the screen type and number that was displayed when the event 
occurred.

Event Name: The label for the column to display the name of the event that occurred on the Touch by an 
operation including a user operation.

Part Name: The label for the column to display the part name for the pressed touch switch when the Press 
buttons event occurs.

Device Address: The label for the column to display the destination device when the Write Data to any Devices 
event occurs.

Changed to: The label for the column to display the result produced from the event that occurred. The recorded 
content varies based on the event that occurred.
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Event Name

■ Use Text Manager
Select this check box to use text registered in Text Manager for the event names when saving data as a CSV file.

■ Event Name
Specifies the text to display in Event Name in Text or Text ID.

Event name details are as follows.

Text: Double click the cell to enter the text to display as the event name. The maximum number is 40 
characters.
Text can only be entered when the Use Text Manager check box is cleared.

Text ID: Double click the cell to specify the Text Manager ID number (1 to 32000) when using text registered in 
Text Manager as the event name.
This option is only enabled if you select the Use Text Manager check box.

Power ON: The event name when the Touch power is turned on.

Switch to Base Screens: The event name when the base screen is switched.

Change Users: The event name when the user is changed.

Change Operation Modes: The event name when the Touch operation mode is changed.

Press buttons: The event name when a touch switch is pressed.

Write Data to any Devices: The event name when a value is written to a device by pressing a touch switch.
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● External Memory Tab
The External Memory tab is used to configure whether or not to output saved data to the external memory.

The output data is stored in the following folder on the external memory.
\External memory folder\OPERATIONLOG

The default External Memory Folder name is “HGDATA01”. For details, refer to Chapter 26 “1.5 Setting the External 
Memory Folder” on page 26-12.

Data recorded after starting output to the external memory is not included in the output data.
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■ Batch
Select this check box to batch output all the sampled data to the external memory.

All the data is saved on the external memory when the trigger device changes from 0 to 1. If a file with the same 
name already exists on the external memory, that file is overwritten. The maximum amount of output data is the 
amount configured by the data storage area.

*1 Advanced mode only

Touch

USB flash drive

Operation Log data
(CSV)

Output to 
USB flash drive

Operation Log data

0 1

Trigger Device

Data to be output
(all)

 Sampling Time User  Screen No.  Event Name  Part Name  Details  Changed to

 12/01/2011 12:00:10  - Base1  Power ON  - - -

 12/01/2011 12:01:23  User1  Base1  Switch to Base Screen  - - Base2

 12/01/2011 12:02:45  User1  Base2  Change Users  - - User2

 12/01/2011 12:03:06  User2  Base2  Change Operation Modes  - - System Mode

 12/01/2011 12:04:11  User2  Base2  Press buttons  BitSwitch  - -

 12/01/2011 12:04:11  User2  Base2  Write Data to any Devices  - LDR 0 55

 12/01/2011 12:07:30  User2  Base2  Switch to Base Screen  - - Base3

Output stops if there is insufficient free space on the external memory. USB flash drive error information is 
stored in HMI Special Data Register LSD33.

Trigger Device: Specifies the bit device that triggers batch output. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
Data is output to file when the trigger device changes from 0 to 1.

File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGO.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters 
(including the extension).

Add Device data to File Name*1: Select this check box to add the bottom three digits of 
the value of device configured by File Name Device to 
the end of the file name for the output data.
Example: When the value of device configured by File 

Name Device is 123, the file name is 
“OPLOGO123.CSV”.

File Name Device: Specifies the word device that is the source for the value 
to add to the file name. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61. This option can only be 
configured when the Add Device data to File Name 
check box is selected.
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■ Real Time
Select this check box to output data to the external memory in real time.

With real time output, data is saved to the external memory in three minute intervals after the Touch starts running. 
When there is already data with the same file name on the external memory, data is appended to that file. If there 
was no update to the data during the three minutes, it is not output.
Data is appended to the file until the size of the file reaches the restriction size (256 MB), so the maximum amount of 
output data varies based on the settings for the output channel such as the amount of data, the data size, and the 
labels.
If the interval events occur more quickly than the time it takes to accomplish the real time output (the interval for 
writing to the external memory), the Operation Log is recorded up to the data storage amount - 1, and then 
afterwards, old data is discarded in order and replaced with new data.

*1 Advanced mode only

Touch

Operation Log data
(CSV)

Output to 
USB flash drive

Operation Log data

 Sampling Time User  Screen No.  Event Name  Part Name  Details  Changed to

 12/01/2011 12:00:10  - Base1  Power ON  - - -

 12/01/2011 12:01:23  User1  Base1  Switch to Base Screen  - - Base2

 12/01/2011 12:02:45  User1  Base2  Change Users  - - User2

 12/01/2011 12:03:06  User2  Base2  Change Operation Modes  - - System Mode

 12/01/2011 12:04:11  User2  Base2  Press buttons  BitSwitch  - -

 12/01/2011 12:04:11  User2  Base2  Write Data to any Devices  - LDR 0 55

 12/01/2011 12:07:30  User2  Base2  Switch to Base Screen  - - Base3

Data to be output 
3 minutes after 
operation starts

Data to be output 
3 minutes after that

Data to be output 
after another 
3 minutes

3 minute interval 

after operation starts

USB flash drive

Real time output stops when the file size of the Operation Log data exceeds 256 MB or when there is insufficient 
space on the external memory. USB flash drive error information is stored in HMI Special Data Register LSD33.

• When the value of HMI Special Internal Relay LSM18 changes from 0 to 1, the data at that time is first 
output in real time to the USB flash drive, and then access to the USB flash drive is stopped.

• You can check the free space on the USB flash drive with HMI Special Data Registers LSD34 and 35.

File Name: Enter the file name for the output data or shows the file name.
The default is “OPLOGA.CSV”.
To change the file name, enter a new file name. The maximum number is 120 characters (including 
the extension).

Add Device data to File Name*1:
Select this check box to add the bottom three digits of the value of device configured by File 
Name Device to the end of the file name for the output data.
Example: When the value of device configured by File Name Device is 123, the file name is 

“OPLOGA123.CSV”.
File Name Device:

Specifies the word device that is the source for the value to add to the file name. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61. 
This option can only be configured when the Add Device data to File Name check box is 
selected.

• The function to record data operates when Operation Log data is being saved to the external memory.
• The methods to erase Operation Log files saved on the external memory are as follows.

- To erase files during operation using parts, on the External Memory tab in the Project Settings dialog 
box, select the Remove Files stored in External Memory check box and the All Operation Log 
data check box, and then configure the trigger device. Assign that trigger device to a part.

- To erase files with WindO/I-NV3, click Clear on the Online tab, and then click Stored Data in 
External Memory to open the Clear Data dialog box. Select the Operation Log Data check box, and 
then click OK.
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4.1 Saving the Data as a CSV File

● Saving the Data as a CSV File
The Operation Log data can be saved to the external memory as a CSV file.
The procedure to save the data is as follows.
On the WindO/I-NV3 Configuration tab, click Operation Log to display the Operation Log Settings dialog box. 
Select an output method check box on the External Memory tab and configure the items. The Operation Log data 
is saved to the External Memory Folder on the external memory according to the External Memory tab settings. For 
details, refer to “External Memory Tab” on page 15-14.

● Data Structure and Output Example
The data structure of the output file is as follows. The data structure for files output with batch output and real time 
output is the same.
Bold items are replaced by the Operation Log settings, recorded data, project file name, and WindO/I-NV3 version.

4 Using the Data

Files saved to external memory are read using WindO/I-NV3.
On the WindO/I-NV3 Online tab, click the arrow under Upload, and then click Data in external memory 
to display the Upload from external memory dialog box. Select the Operation Log Data check box, specify 
the location to save the files in Path, and then click OK to be able to save the files in the specified folder.

Headers

"Project Name","Project name","Version number"

"File Type","Log type"

Blank row

Label row
"Sampling Time","User Name","Screen No.","Event Name","Part Name","Device 
Address","Changed to"

Data row

" MM/DD/YYYY HH:MM:SS","User Name","Screen Type & No.","Event","Part 
Name","Device Address", "Changed to"

･
･
･

Output example Data size of each row

"Project Name","Dimmer Console","V1.00" - 41 bytes

"File Type","Operation Log Data" - 34 bytes

- 2 bytes

"Sampling Time","User","Screen No.","Operation","Part Name","Details","Changed to" - 84 bytes

" 12/01/2011 12:00:10","-","Base 1","Power ON","-","-","-" - 60 bytes

" 12/01/2011 12:01:23","User1","Base 1","Switch to Base Screen","-","-", "Base2" - 81 bytes

·
·
·

• The data size for each row is counted as 2 bytes for full-width characters, one byte for half-width 
characters, and two bytes for newlines. The total for each row is the total amount of space for the file.

• A space is inserted before the date in the data row.
• The display type for the date and time varies based on the language configured in Project Settings, on 

the Project Details tab, in Language.
Japanese: YYYY/MM/DD HH:MM:SS
European, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic: MM/DD/YYYY HH:MM:SS
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16

D
ata Storage Area

This chapter describes how to configure the data storage area and its operation on the Touch.

  

1.1 What is the Data Storage Area?

The data storage area is the area in the Touch’s internal memory where saved data is not erased even when the 
power is turned off. The HMI Keep Registers (LKR) and the HMI Keep Relays (LK) are allocated in this area.
The following data can be saved in the data storage area.

• Alarm Log data
 Chapter 13 “Alarm Log Function” on page 13-1

• Data Log data
 Chapter 14 “Data Log Function” on page 14-1

• Operation Log data
 Chapter 15 “Operation Log Function” on page 15-1

Chapter 16 Data Storage Area

1 Overview

• When there is no remaining battery power, the data in the data storage area is erased when the Touch 
is turned off.

• If you download the project data from WindO/I-NV3, the Alarm Log data, Operation Log data, and Data 
Log data stored in internal memory are erased, and all internal devices are reset except for the HMI Keep 
Registers (LKR) and the HMI Keep Relays (LK).
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1.2 Data Storage Area

● Data Storage Area Capacity and Types of Storable Data
You can allocate areas to save Alarm Log data, Operation Log data, and Data Log data, as well as areas to use as HMI 
Keep Registers (LKR) and HMI Keep Relays (LK). The unallocated leftover area is free space.

● Minimum and Maximum Amount of Data Storage and Number of Addresses
The minimum and maximum amount of data storage and the minimum and maximum number of addresses that can 
be configured for the data storage area is as follows.

Alarm Log data Operation Log 
data

Data Log data HMI Keep Registers
(LKR)

HMI Keep Relays
(LK) Free space

Data storage area (102,400 bytes)

Data type Minimum Maximum

Number of Stored Data for Alarm Log 0 5,011

Number of Stored Data for Operation Log 0 3,579

Number of Stored Data for Data Log per Device 0 12,528

Number of HMI Keep Register (LKR) 1,024 8,192

Number of HMI Keep Relay (LK) 1,024 8,192
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This section describes the configuration procedure for the data storage area.

1 On the Configuration tab, in the System Setup group, click Data Storage Area.

The Data Storage Area Management dialog box is displayed.

2 Specify the amount of Alarm Log data to save in the data storage area in Number of Stored Data for Alarm Log
(0 to 5011).

3 Specify the amount of Operation Log data to save in the data storage area in Number of Stored Data for 
Operation Log (0 to 3579).

4 Specify the amount of Data Log data per device to save in the data storage area in Number of Stored Data for 
Data Log per Device (0 to 12528).

5 Specify the number of HMI Keep Register (LKR) addresses in Number of HMI Keep Register (LKR) (1024 to 
8192).

6 Specify the number of HMI Keep Relay (LK) addresses in Number of HMI Keep Relay (LK) (1024 to 8192).

7 Click OK.

The Data Storage Area Management dialog box closes.
This concludes configuring the data storage area.

2 Data Storage Area Configuration Procedure
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This section describes items and buttons on the Data Storage Area Management dialog box.

3.1 Data Storage Area Management Dialog Box

The areas to save Alarm Log data, Operation Log data, and Data Log data and the areas to use as HMI Keep 
Registers (LKR) and HMI Keep Relays (LK) are allocated in the Data Storage Area Management dialog box.

■ Number of Stored Data for Alarm Log
Specifies the amount of Alarm Log data to save in the data storage area (0 to 5011).
Alarm Log data is only saved in the data storage area when Store is selected under Block Settings, Data in the 
Auto-Setup dialog box or in the Individual Settings dialog box for Alarm Log Settings.

■ Number of Stored Data for Operation Log
Specifies the amount of Operation Log data to save in the data storage area (0 to 3579).

■ Number of Stored Data for Data Log per Device
Specifies the amount of Data Log data per device to save in the data storage area (0 to 12528).
Data Log data is only saved in the data storage area when Enable is selected under Log function on the General 
Tab in the Individual Settings dialog box for Data Log Settings.

■ Number of HMI Keep Register (LKR)
Specifies the number of HMI Keep Register (LKR) addresses (1024 to 8192).

■ Number of HMI Keep Relay (LK)
Specifies the number of HMI Keep Relay (LK) addresses (1024 to 8192).

■ Free Space
Shows the amount of free space in the data storage area (in bytes).

■ Default
Returns the configured values to their default values.

3 Data Storage Area Management Dialog Box
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This chapter describes how to configure the Preventive Maintenance function and its operation on the Touch.

  

1.1 How the Preventive Maintenance Function is Used

The Preventive Maintenance function monitors the state of devices and counts the time the value of the monitored 
devices are 1, as well as the number of times the values of monitored devices change to 1.
The Preventive Maintenance function can perform the following functions.

• Monitor devices that turn on lighting or warning lights and count the operation time

• Report the replacement time for lighting and warning lights by the counted operation time

• Monitor devices connected to buttons and relays and count the operation count

• Report the inspection time for buttons and relays by the counted operation count

Chapter 17 Preventive Maintenance Function

1 Overview

Lighting

Warning light

External device

Touch

1230 hoursLighting

360 hoursWarning 
light

Lighting

Warning light

Please replaceLighting

Replace soonWarning 
light

Touch

External device

Button

Relay

123 timesButton

1000 timesRelay

Touch

External device

Button

Relay

Button

Please inspect

Inspect soon

Relay

Touch

External device
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1.2 Counting the Operation Time and Operation Count

The operation time and operation count are counted up to the set maximum value. The counted operation time and 
operation count are saved in HMI Keep Registers (LKR) and the values are retained until they are reset. To reset a 
counted value, set the value of the configured HMI Keep Register (LKR) to 0.
The maximum value that can be configured varies based on the data type of the destination device for the operation 
time and operation count.

● Counting the Operation Time
While the value of Monitor Device is 1, 1 is added to the value of device (Operation Time Device) configured in 
Measure Operation Time for each second that elapses. The operation time is not counted when it is less than one 
second.
The counted operation time is written to the device configured in Measure Operation Time.

Example: When the value of Monitor Device M0 is 1, 1 is added to the value of Operation Time Device LKR0.

● Counting the Operation Count
When the value of Monitor Device changes from 0 to 1, 1 is added to the value of device (Operation Count Device) 
configured in Measure Operation Count.
The counted operation count is written to the device configured in Measure Operation Count.

Example: When the value of Monitor Device M0 changes from 0 to 1, 1 is added to the value of Operation Count 
Device LKR0.

3 sec.

1 sec. 1 sec. 1 sec.

3.4 sec.

1 sec. 1 sec. 1 sec.

0.5 sec. 0.5 sec.

Value of
Monitor Device M0

Value of 
Operation Time Device LKR0

1

0

Operation time
0.4 sec.

0 1 2 3 3 3 3 3 3 3 3 4 5 6 6

Not counted Not counted

If the value of Monitor Device changes from 0 to 1 in an interval shorter than the Touch scan time and the 
communication cycle with external devices, the operation time and operation count is not counted 
normally. You can check the maximum Touch scan time (x 1 millisecond) with the value of HMI Special 
Data Register LSD4. You can check the communication cycle with external devices (x 1 millisecond) with 
the value of HMI Special Data Register LSD6. For details, refer to Chapter 27 “HMI Special Data Register 
(LSD)” on page 27-9.

1

0

Operation count

0 1 1 1 1 1 2 2 3 3 3 4 4 4 4

1 2 3 4

Value of
Monitor Device M0

Value of
Operation Count Device LKR0
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1.3 Thresholds

The threshold is a value that is the criterion for reporting to a configured device (Report Device) when the value 
counted for the operation time or operation count (the value of Operation Time Device or Operation Count Device) 
has reached the threshold value. 1 is written to the configured device when the operation time and operation count 
reach the threshold.

Example: When the value of Operation Time Device LKR0 reaches the threshold set for level 1 through level 3, 1 is 
written to the Report Device configured for each level, LM1 through LM3.

Level Threshold Report Device

Level 1 10 LM1

Level 2 15 LM2

Level 3 20 LM3

1

0

1

0

1

0

Value of
Operation Time Device LKR0

Value of 
 Report Device LM1

Value of 
Report Device LM2

Value of 
Report Device LM3

Level 3

9 10 11 12 13 14 15 16 17 18 19 20 21 22

Level 1 threshold Level 2 threshold Level 3 threshold

Level 1

Level 2
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This section describes the configuration procedure for the Preventive Maintenance function.

2.1 Counting Operation Time and Operation Count

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.
The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of devices to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.
Select Operation Time + Operation Count.
The Operation Time and Operation Count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.
The Individual Settings dialog box is displayed.

5 Specify the bit device or bit of the word device to monitor with Monitor Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

2 Preventive Maintenance Function Configuration Procedure
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6 Select the Measure Operation Time check box on the Operation Time tab.

If you are not counting the operation time, leave the Measure Operation Time check box cleared and proceed to 
step 9.

7 Specify the destination device for the counted operation time.

You can only specify an HMI Keep Register (LKR).

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

8 Select the data type for the value of the Measure Operation Time device from Data Type.

This concludes configuring operation time counting.

9 Click the Operation Count tab.

10 Select the Measure Operation Count check box.
If you are not counting the operation count, leave the Measure Operation Count check box cleared and proceed to 
step 13.

11 Specify the destination device for the counted operation count.
You can only specify an HMI Keep Register (LKR).

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

12 Select the data type for the value of the Measure Operation Count device from Data Type.
This concludes configuring operation count counting.

13 Click OK to close the Individual Settings dialog box.

14 Repeat steps 2 through 13 to register settings to count the operation time and operation count in all the used 
numbers.
This concludes configuring operation time and operation count counting.

Next, configure the functions to execute using counted data.
 “4.1 Displaying the Counted Operation Count on a Numerical Display” on page 17-11
 “4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold” on page 17-14
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This section describes the items and buttons on the Preventive Maintenance Settings dialog box and the Individual 
Settings dialog box.

3.1 Preventive Maintenance Settings Dialog Box

The Preventive Maintenance Settings dialog box is used to manage the preventive maintenance settings for each 
monitored device.

■ Number of Items
Specifies the number of devices (1 to 256) to monitor. The numbers for the amount of configured devices is displayed 
in Settings.

■ Display Options
Select the item to display in Settings from the following:

■ Settings
Edits the settings for each number.

3 Preventive Maintenance Settings Dialog Box

Operation Time: Operation time settings are displayed in Settings.
Operation Count: Operation count settings are displayed in Settings.
Operation Time + Operation Count: Operation time and operation count settings are displayed in Settings.

No.: Shows the number of the preventive maintenance settings to manage. Double clicking 
the cell displays the Individual Settings dialog box. For details, refer to “3.2 Individual 
Settings Dialog Box” on page 17-8.

Monitor Device: Shows the bit device or bit of the word device to count the operation time or operation count.
Double clicking the cell displays the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Operation Time Device: Shows the destination device for the counted operation time. You can only specify an 
HMI Keep Register (LKR).
Double clicking the cell displays the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option is only displayed when Operation Time or Operation Time + Operation 
Count is selected in Display Options.

Data Type: Shows the date type of the operation time device. Double clicking the cell displays the Individual 
Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 17-8.
This option is only displayed when Operation Time or Operation Time + Operation 
Count is selected in Display Options.
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■ Edit
Registers or changes the settings for the selected number.
Select a number, and then click this button to display the Individual Settings dialog box. The configured content for 
the selected number is reflected in the Individual Settings dialog box. For details, refer to “3.2 Individual Settings 
Dialog Box” on page 17-8.

■ Remove
Deletes the settings for the selected number.
Select a number, and then click this button.

■ Up
Shifts the selected settings upward in the list.

■ Down
Shifts the selected settings downward in the list.

Level 1 to 3 Threshold: Shows the time as a constant or a device that is the criterion for reporting at level 1 
through level 3. For a constant, double clicking the cell displays the Individual Settings 
dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 17-8. For a 
device, the Device Address Settings dialog box is displayed. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option is only displayed when Operation Time or Operation Time + Operation 
Count is selected in Display Options.

Level 1 to 3 Report Device: Shows the bit device or bit of the word device for reporting when the operation time 
reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.
This option is only displayed when Operation Time or Operation Time + Operation 
Count is selected in Display Options.

Operation Count Device: Shows the destination device for the counted operation count. You can only specify an 
HMI Keep Register (LKR).
Double clicking the cell displays the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.
This option is only displayed when Operation Count or Operation Time + Operation 
Count is selected in Display Options.

Data Type: Shows the date type of the operation count device. Double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on 
page 17-8.
This option is only displayed when Operation Count or Operation Time + Operation 
Count is selected in Display Options.

Level 1 to 3 Threshold: Shows the count as a constant or a device that is the criterion for reporting at level 1 
through level 3. For a constant, double clicking the cell displays the Individual Settings 
dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 17-8. For a 
device, the Device Address Settings dialog box is displayed. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option is only displayed when Operation Count or Operation Time + Operation 
Count is selected in Display Options.

Level 1 to 3 Report Device: Shows the bit device or bit of the word device for reporting when the operation count 
reaches or exceeds the level 1 through level 3 thresholds.
Double clicking the cell displays the Device Address Settings dialog box. For the device 
address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on 
page 2-61.
This option is only displayed when Operation Count or Operation Time + Operation 
Count is selected in Display Options.
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3.2 Individual Settings Dialog Box

The Individual Settings dialog box is used to configure the operation time and operation count settings for each 
monitored device.

● Operation Time Tab
The Operation Time tab is used to configure the destination device for the counted operation time and the report 
conditions when the threshold is reached or exceeded.

■ Measure Operation Time
Select this check box to count the operation time.

■ Data Type
Select the data type for the operation time device as BIN16 (+) or BIN32 (+). For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

■ Report when Operation Time has reached or exceeded Threshold level
Select this check box to report when the counted operation time reaches or exceeds the threshold. 

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and report device.

No.: Shows the number selected in Settings in the Preventive Maintenance Settings dialog box. To 
change the set number, specify a number (1 to 256).
You can only specify a number of the amount of devices configured by Number of Items in 
the Preventive Maintenance Settings dialog box.

Monitor Device: Specifies the bit device or bit of the word device to count the operation time or operation count.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

(Operation Time Device): Specifies the destination device for the counted operation time. You can only specify an 
HMI Keep Register (LKR).

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

If you specify the same device as the operation time device for multiple numbers, the counted operation 
time is added in total by all the monitored devices for each number and the function will not be able to 
count normally.

Value: Uses a constant as the threshold.
Device: Uses a value of device as the threshold.

Threshold Specifies the time as a constant or a device that is the criterion for reporting at level 1. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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■ Level 2
Select this check box to configure the level 2 threshold and report device.

■ Level 3
Select this check box to configure the level 3 threshold and report device.

● Operation Count Tab
The Operation Count tab is used to configure the destination device for the counted operation count and the report 
conditions when the threshold is reached or exceeded.

■ Measure Operation Count
Select this check box to count the operation count.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation time reaches 
or exceeds the level 1 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Threshold Specifies the time as a constant or a device that is the criterion for reporting at level 2. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation time reaches 
or exceeds the level 2 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Threshold Specifies the time as a constant or a device that is the criterion for reporting at level 3. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation time reaches 
or exceeds the level 3 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

(Operation Count Device): Specifies the destination device for the counted operation count. You can only specify an 
HMI Keep Register (LKR).

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

If you specify the same device as the operation count device for multiple numbers, the counted operation 
count is added in total by all the monitored devices for each number and the function will not be able to 
count normally.
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■ Data Type
Select the data type for the operation count device as BIN16 (+) or BIN32 (+). For details, refer to Chapter 2 “1.1 
Available Data” on page 2-1.

■ Report when Operation Count has reached or exceeded Threshold level
Select this check box to report when the counted operation count reaches or exceeds the threshold.

■ (Data Type)
Selects the type of data for the threshold.

■ Level 1
Configures the level 1 threshold and report device.

■ Level 2
Select this check box to configure the level 2 threshold and report device.

■ Level 3
Select this check box to configure the level 3 threshold and report device.

Value: Uses a constant as the threshold.

Device: Uses a value of device as the threshold.

Threshold Specifies the count as a constant or a device that is the criterion for reporting at level 1. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation count reaches 
or exceeds the level 1 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Threshold Specifies the count as a constant or a device that is the criterion for reporting at level 2. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation count reaches 
or exceeds the level 2 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Threshold Specifies the count as a constant or a device that is the criterion for reporting at level 3. For a 

constant, the range that can be set varies based on the data type. For a device, click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, 
refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Report Device: Specifies the bit device or bit of the word device for reporting when the operation count reaches 
or exceeds the level 3 threshold.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
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4.1 Displaying the Counted Operation Count on a Numerical Display

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of devices to monitor in Number of Items.

3 Select the item to display in Settings with Display Options.

Select Operation Count.
Operation count settings are displayed in Settings.

4 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

5 Specify the bit device or bit of the word device to monitor with Monitor Device.

4 Using the Data
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6 Click the Operation Count tab.

7 Select the Measure Operation Count check box and specify the destination device for the counted operation count.

8 Select the data type for the value of the Measure Operation Count device from Data Type.

9 On the Home tab, in the Parts group, click Data Displays, and then click Numerical Display.

10 Click a point on the edit screen where you want to place the Numerical Display.

11 Double-click the dropped Numerical Display and the Properties dialog box is displayed.
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12 On the General tab, under Display Type, click Decimal.

13 Under Data Format, in Data Type, select the data type for the value to display.
Select the same data type as the data type selected on the Operation Count tab in the Preventive Maintenance 
settings Individual Settings dialog box.

14 Specify Digits for the value to display.
The digits that can be set varies based on the display type or data type.

15 Under Display Method, in Display Device, specify the destination device for the counted operation count.
Select the same device as the device configured with Measure Operation Count on the Operation Count tab in 
the Preventive Maintenance settings Individual Settings dialog box.

16 Click OK.
The properties dialog box closes.
This concludes the configuration to display the counted operation count on a Numerical Display.
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4.2 Notifying with a Beep when the Counted Operation Time Reaches the Threshold

1 On the Configuration tab, in the System Setup group, click Preventive Maintenance.

The Preventive Maintenance Settings dialog box is displayed.

2 Specify the number of devices to monitor in Number of Items.

3 Select the number to register the Preventive Maintenance settings to in Settings, then click Edit.

The Individual Settings dialog box is displayed.

4 Specify the bit device or bit of the word device to monitor with Monitor Device.

5 Select the Measure Operation Time check box on the Operation Time tab and specify the destination device for 
the counted operation time.

6 Select the data type for the value of the Measure Operation Time device from Data Type.
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7 Select the Report when Operation Time has reached or exceeded Threshold level check box.

8 Select the type of data for the threshold.

If you select Value, specify the threshold as a constant.
If you select Device, specify the threshold as a value of device.

9 Configure Threshold for level 1.
When you select Value as the threshold data type, specify the threshold as a constant. The range for the constant 
that can be set varies based on the data type.

When you select Device as the threshold data type, specify the threshold as a value of device. Click  to display the 
Device Address Settings dialog box. For the device address configuration procedure, refer to Chapter 2 “5.1 Device 
Address Settings” on page 2-61.

10 Configure Report Device for level 1.

Specify the bit device or bit of the word device for reporting when the threshold is reached or exceeded. Click  to 
display the Device Address Settings dialog box. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-61.
You can only specify an internal device.

11 Click OK to close the Individual Settings dialog box.

12 Click OK to close the Preventive Maintenance Settings dialog box.

13 On the Configuration tab, in the System Setup group, click Alarm Log.
The Alarm Log Settings dialog box is displayed.
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14 On the Channel tab, under Source Device Type, select Bit and specify Number of Blocks.

15 Select the channel number to register the Level 1 Report Device to, and then click Edit.
The Individual Settings dialog box is displayed.

16 Specify the Level 1 Report Device in Source and select No Store under Data.
Set Source to the Level 1 Report Device configured on the Operation Time tab in the Preventive Maintenance 
settings Individual Settings dialog box.

17 Select Enable under Alarm function, select NO under NO/NC, and then click OK.
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18 Switch the alarm function for all the unused channel numbers to Disable in the Alarm Log Settings dialog box.
Select all the unused channels, and then click Edit. To select multiple channels, press and hold SHIFT or CTRL while 
you click the specific them.
The Individual Settings dialog box is displayed.

Under Channel Settings, in Alarm function, select Disable and then click OK.
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19 Click the Options tab in the Alarm Log Settings dialog box.

20 Select the Trigger Buzzer when Alarm occurs check box.

21 Click OK.
The Alarm Log Settings dialog box closes.
This concludes the configuration to notify with a beep when the counted operation time reaches the threshold.
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This chapter describes how to configure the Recipe function and its operation on the Touch.

  

1.1 How the Recipe Function is Used

The Recipe function batch writes values prepared in advanced to specified devices and batch reads the values for 
specified devices according to the state of a device. Use this function for situations such as configuring the initial 
values of an external device when the Touch starts running. The data used by the Recipe function is called recipe 
data for the data saved in internal memory, a recipe file for data saved to the external memory, and recipe values for 
the values written to devices that were saved in recipe data and recipe files.
The Recipe function can perform the following functions.

• Batch write the recipe values saved in internal memory to devices when a value of device changes from 0 to 1

• Batch write the recipe values saved on the external memory to devices when a value of device changes from 0 to 1

• Batch read value of a device and save them to the external memory as a recipe file when a value of device changes 
from 0 to 1

Chapter 18 Recipe Function

1 Overview
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To keep the values of devices, you can use recipe function. The recipe function saves them as a recipe file 
in the external memory. For example, save the values of devices before the power is turned off and write 
them the next time the power is turned on.
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1.2 Data for Recipes

The data handled by the Recipe function is based on the starting device address for the amount of data selected.
Example:When the Top Device is D100 and the Number of Data is 10

D100 value 1111

D101 value 2222

D102 value 3333

D103 value 4444

D104 value 5555

D105 value 6666

D106 value 7777

D107 value 8888

D108 value 9999

D109 value 11111
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1.3 Data Configuration

The relationship between the Recipe function settings and the data for recipes is as follows.

1. Number of blocks: The operation using the data for recipes is configured in blocks (0 to 64). One block is 16 
channels.

2. Channels: Destination devices and recipe values are configured in channels. One channel is used for one 
item of data for the recipe.

3. Number of Data: The amount of data configured for one channel. The maximum number of data that can be 
configured is 8,192.

4. Top Device: The starting address of the destination devices for recipe values and the source devices for 
values of devices.

5. Data: The values to write to the devices.

Recipe settings

Data for recipes

If there are many word devices for the data for the recipe, it will take time to read and write them. For 
example, when using the Recipe function to configure initial values, if other processes are executed before 
the function is finished writing all the settings, you may experience unexpected results. Monitor the System 
Area 2 Transferring recipe bit (address+3, bit 4) while the recipe is transferring and wait until reading and 
writing the data for the recipe is finished before executing other processes. For details, refer to Chapter 3 
“System Area” on page 3-23.
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This section describes the configuration procedure for the Recipe function.

2.1 Configuring Recipe Function Operations and Devices

1 On the Configuration tab, in the System Setup group, click Recipe.
The Recipe Settings dialog box is displayed.

2 Specify the number of blocks to use as data for the recipe in Number of Blocks.
The operation using the data for the recipe is configured in blocks (0 to 64). One channel is used for one item of data 
for the recipe. One block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of devices that can be 
configured for one channel is 8,192 devices.

3 Select the number of the data for the recipe to configure in Settings, and then click Edit.
The Individual Settings dialog box is displayed.

4 On the Channel tab, under Recipe function, select Enable.
The channel for the block number displayed in Channel is enabled.

2 Recipe Function Configuration Procedure



SmartAXIS Touch User’s Manual 18-5

2 Recipe Function Configuration Procedure

18

Recipe Function

5 Enter the name for the Recipe function in Recipe Name.

The maximum number is 40 characters.

6 Specify the destination device for the Recipe values in Top Device.

To read values of devices and save them as a recipe file, specify the source device of the values.

Click  to display the Device Address Settings dialog box.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

7 Select the data type for the values to write with Data Type.

To read values of devices and save them as a recipe file, specify the type of data for the read values.

8 With Number of Data, specify the number of destination devices starting with the device address configured by Top 
Device.

To read values of devices and save them as a recipe file, specify the number of source devices.
The sequential device addresses from the starting address for the number of configured devices is displayed in Data 
List on the Data tab.
The amount of data that can be set varies based on the data type. When BIN16 (+), BIN16 (+/-), or BCD4 is 
selected for Data Type, up to 8,192 items of data can be configured. When BIN32 (+), BIN32 (+/-), or BCD8 is 
selected, up to 4,096 items of data can be configured.

9 With Display Type, select the display type for Data to configure in Data List on the Data tab.

To save data to a recipe file, the display type is decimal for all.

10 Click the Data tab.

The data for the recipe in the amount specified by Number of Data on the Channel tab is configured in Data List. 
In Device, the devices are sequentially configured starting from the device address specified by Top Device.

11 Double click the data cell for each number in Data List to enter the value to write to the device.
The value of device that can be configured varies based on Data Type and Display Type configured on the 
Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering values of devices is unnecessary.
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12 Click the Block tab.

13 Select the destination to save recipe data to under Access to.
This option is set by block.

■ External Memory
Use a recipe file saved to the external memory.

■ Internal Memory
Use recipe data saved to internal memory.

If you selected Internal Memory, proceed to step 17.

14 Enter the file name for the recipe file in File Name.
The default is “RCPn.CSV”. (n: four digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including extension).
If there is a recipe file with the same file name on the external memory, the existing file is overwritten with the new 
file.

15 Select the operation using the data for the recipe under Trigger Setting.
This option is set by block.

■ Read/Write
Save batch read values of devices to the external memory as a recipe file or write them to devices as recipe values.
This option can only be configured when External Memory is selected under Access to.

■ Read-only
Save batch read values of devices to the external memory as a recipe file.
This option can only be configured when External Memory is selected under Access to.

■ Write-only
Write recipe values to devices.

If you select Write-only, proceed to step 17.

16 Specify the device that triggers batch reading values of devices and saving them to the external memory as a recipe 
file in Read Trigger.
This option is set by block.

Click  to display the Device Address Settings dialog box.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

If you selected Read-only, proceed to step 18.
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17 Specify the device that triggers batch writing recipe values to devices in Write Trigger.
This option is set by block.

Click  to display the Device Address Settings dialog box.
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

18 Click OK to close the Individual Settings dialog box.

19 Repeat steps 3 through 18 to register data for the recipe to all the used channels.

20 Click OK.
The Recipe Settings dialog box closes.

For details on how to create and edit the data for recipes, refer to “4 Creating and Deleting Data for Recipes” on page 
18-14.
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This section describes the items and buttons on the Recipe Settings dialog box and the Individual Settings dialog box.

3.1 Recipe Settings Dialog Box

Use the Recipe Settings dialog box to collectively manage the save destination of data for recipes, the devices for 
writing recipe values and reading values of devices, and those execution conditions.

■ Number of Blocks
The operation using the data for the recipe is configured in blocks (0 to 64). One channel is used for one item of data 
for the recipe. One block is 16 channels.
The maximum number of blocks that can be configured is 64 blocks. The maximum number of devices that can be 
configured for one channel is 8,192 devices.

■ Settings
Edits the recipe settings for each channel.

3 Recipe Settings Dialog Box

No.: Displayed as (Block No.)-(Channel No.). Double clicking the cell displays the Individual Settings 
dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Access to: Shows the save destination for the data for the recipe. Double clicking the cell switches between 
Internal Memory and External Memory.

Trigger Setting: Shows the operation using the data for the recipe. When External Memory is selected for 
Access to, double clicking the cell switches between Write-only, Read/Write, and Read-
only. Shows Write-only when Internal Memory is selected for Access to.

Read Trigger: Shows the device that triggers saving the recipe file. Double clicking the cell displays the Device 
Address Settings dialog box. For the device address configuration procedure, refer to Chapter 2 
“5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Read-only is selected under Trigger 
Setting.

Write Trigger: Shows the device that triggers writing recipe values to devices. Double clicking the cell displays 
the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Write-only is selected under 
Trigger Setting.

Recipe function: Shows whether or not to use the Recipe function. Double clicking the cell switches between 
Enable and Disable.

Recipe Name: Shows the name of the Recipe function for each channel. Double clicking the cell displays the 
Individual Settings dialog box. For details, refer to “3.2 Individual Settings Dialog Box” on page 
18-10.
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■ Edit
Registers or changes the settings for the selected number.
Select a number in Settings, and then click this button to display the Individual Settings dialog box. The settings for 
the selected channel are reflected in the Individual Settings dialog box.
For details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.

■ Write Recipe Files to External Memory
Saves all the settings in every channel on the Recipe Settings dialog box to the external memory as a recipe file.
Click this button to display the Select Drive dialog box.
Only saves channels configured with Access to set to External Memory and Recipe function set to Enable.

Top Device: Shows the starting address of the destination devices for recipe values and the source devices 
for values of devices. Double clicking the cell displays the Device Address Settings dialog box. 
For the device address configuration procedure, refer to Chapter 2 “5.1 Device Address 
Settings” on page 2-61.
This option can only be configured when Recipe function is Enable.

Data Type: Shows the data type of the source or destination values of devices. Double clicking the cell 
displays the Individual Settings dialog box. For details, refer to “3.2 Individual Settings Dialog 
Box” on page 18-10.

Number of Data: Shows the number of source or destination devices starting with the device address configured 
by Top Device. Double clicking the cell displays the Individual Settings dialog box. For details, 
refer to “3.2 Individual Settings Dialog Box” on page 18-10.

Display Type: Shows the display type of Data in Data List configured on the Data tab in the Individual 
Settings dialog box. Double clicking the cell displays the Individual Settings dialog box. For 
details, refer to “3.2 Individual Settings Dialog Box” on page 18-10.
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3.2 Individual Settings Dialog Box

Use the Individual Settings dialog box to register or edit the recipe settings for the selected channel.

● Block Tab
The Block tab is used to configure settings that are managed by blocks such as the save destination for the data for 
the recipe to use, the Recipe function operation, and the trigger setting.

■ Access to
Selects the save destination for data for the recipe to use when writing values to devices.

■ File Name
Enter the file name of the recipe file to save on the external memory.
The default is “RCPn.CSV”. (n: four digit sequential number)
To change the file name, enter a new file name. The maximum number is 120 characters (including the extension).
If there is a recipe file with the same file name on the external memory, the existing file is overwritten with the new 
file.

■ Trigger Setting
Selects the operation using the data for the recipe.

External Memory: Uses a recipe file saved to the external memory.
Requires an external memory with a saved recipe file. For details, refer to “4.2 Creating Recipe 
Files” on page 18-17.

Internal Memory: Uses recipe data saved to internal memory.
Since recipe data is handled as a portion of project data, it may put pressure on the volume of 
project data that can be downloaded. One item of recipe data uses two bytes when the top 
device data type is 16 bits and it uses four bytes when the top device data type is 32 bits.
Example: When the top device data type is 16 bits and using one block of 16 channels of recipe 

data with a data amount of 10
2 x 10 x 1 x 16 = 320 bytes
When the top device data type is 32 bits and using 64 blocks of 16 channels of recipe 
data with a data amount of 100
4 x 100 x 64 x 16 = 409.6 kilobytes

Read/Write: Saves values of batch read devices to the external memory as a recipe file and writes them 
to devices as recipe values.
This option can only be configured when External Memory is selected under Access to.

Read-only: Saves values of batch read devices to the external memory as a recipe file.
This option can only be configured when External Memory is selected under Access to.

Write-only: Writes recipe values to devices.
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■ Read Trigger
Specifies the device that triggers batch reading values of devices and saving them to the external memory as a recipe 
file.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Read-only is selected under Trigger Setting.

■ Write Trigger
Specifies the device that triggers batch writing recipe values to devices by block.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
This option can only be configured when Read/Write or Write-only is selected under Trigger Setting.

■ Monitoring Period
Shows the period to monitor the write device and the read device. This period is for detecting alarms so it is the same 
as the period to monitor device states. This option is configured on the General tab in the Alarm Log Settings dialog 
box.

Each bit of the word device configured by the read trigger corresponds to a channel.
When a bit changes from 0 to 1, a read to the device is executed.
Example: When the block 1 read trigger is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

Each bit of the word device configured by the write trigger and the read trigger corresponds to a channel.
When a bit changes from 0 to 1, a write to the device is executed.
Example: When the block 1 write trigger is specified as LDR0000

LDR0000-0 corresponds to channel 1-0, LDR0000-1 to channel 1-1, through to LDR0000-15 which 
corresponds to channel 1-15.

bit bit

Channel 1-0

15 0

LDR0000

Channel 1-15

• When recipe values are batch written to devices with Access to set to External Memory and Trigger 
Setting set to Read/Write or Write-only, if no recipe file exists in the “RECIPE” folder in the External 
Memory Folder on the external memory, 0 is written to all the devices.

• If a value of device reads and recipe value writes occur simultaneously, first the values of devices are 
read, then the recipe values are written.
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● Channel Tab
The Channel tab is used to configure the recipe name for the selected channel and the devices to read and write 
values to.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Recipe function
Selects whether or not to use the Recipe function.

■ Recipe Name
Enter the name for the Recipe function to differentiate the channel. The maximum number is 40 characters. The 
default is “Recipen”. (n: four digit sequential number)

■ Top Device
Specifies the starting address of the destination devices for recipe values and the source devices for values of devices.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
The specified device addresses are configured sequentially from the number 1 in Data List on the Data tab.

■ Data Type
Selects the type of data for recipe values to write and values of devices that are read. For details, refer to Chapter 2 
“1.1 Available Data” on page 2-1.

■ Number of Data
Specifies the number of source or destination devices starting with the device address configured by Top Device.
The sequential device addresses from the starting address for the number of configured devices is displayed in Data 
List on the Data tab.
The amount of data that can be set varies based on the data type. When BIN16 (+), BIN16 (+/-), or BCD4 is 
selected for Data Type, up to 8,192 items of data can be configured. When BIN32 (+), BIN32 (+/-), or BCD8 is 
selected, up to 4,096 items of data can be configured.

■ Display Type
Selects the display type for Data in Data List configured on the Data tab as Decimal or Hexadecimal.
Values when saving data to a recipe file are decimal.

Block No.: Shows the block number for the channel selected in Settings.

Channel No.: Shows the channel number for the channel selected in Settings.

Enable: Writes recipe values to devices, reads values of devices and saves them to the external memory 
as a recipe file.

Disable: The Recipe function is not used.
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● Data Tab
The Data tab is used to configure recipe values written to devices.

■ Channel
Shows the block number and the channel number for the selected channel.

■ Data List
Enter the recipe values to write to devices for each number in the selected channel.

■ Import
Displays the Open dialog box.
Select a recipe file, and then click Open to overwrite the data in Data List with the selected recipe file.

■ Export
Displays the Save As dialog box.
Select the location to save the recipe file, enter a file name, and then click Save to save the recipe file for the 
selected channel.
The saved recipe file can be edited using Notepad, commercially available text editors, and spreadsheet software.

Block No.: Shows the block number for the channel selected in Settings.

Channel No.: Shows the channel number for the channel selected in Settings.

No.: Shows the data numbers for the amount of data specified by Number of Data.

Device: Devices are sequentially configured starting from the device address specified by Top Device 
on the Channel tab.

Data: Double click a cell to enter a recipe value. The value that can be configured varies based on 
Data Type and Display Type configured on the Channel tab.
When Read-only is selected under Trigger Setting on the Block tab, entering recipe values 
is unnecessary.
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4.1 Editing Recipe Data

You can export recipe data for the selected channel, edit the recipe values in a saved file, and import a recipe file 
back into WindO/I-NV3.

1 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

2 Select the channel number to export its recipe data in Settings, and then click Edit.

The Individual Settings dialog box is displayed.

3 Click the Data tab, and then click Export.

The Save As dialog box is displayed.

4 Creating and Deleting Data for Recipes
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4 Specify the save location in Save in, and then click Save.

The file name specified on the Block tab in the Individual Settings dialog box is entered in File name.

5 Open the exported recipe data file.

Use Notepad, a commercially available text editor, or spreadsheet software.

6 Edit the values and save the file.

7 Return to the Data tab in the Individual Settings dialog box, and then click Import.

The Open dialog box is displayed.
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8 Specify the file, and then click Open.

The recipe data is imported.

9 Click OK.

The Individual Settings dialog box closes.

10 Click OK.
The Recipe Settings dialog box closes.
This concludes editing recipe data.
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4.2 Creating Recipe Files

Recipe files can be created on the external memory with the following procedure. The recipe values configured on the 
Data tab in the Individual Settings dialog box are saved in recipe files.
 “Creating Recipe Files in the Recipe Settings Dialog Box” on page 18-17
 “Creating Recipe Files when Downloading Project Data” on page 18-19
 “Creating Recipe Files with a Text Editor” on page 18-20

● Creating Recipe Files in the Recipe Settings Dialog Box

1 Insert a USB flash drive in the computer.

2 On the Configuration tab, in the System Setup group, click Recipe.

The Recipe Settings dialog box is displayed.

3 Click Write Recipe Files to External Memory.

The Select Drive dialog box is displayed.

USB flash drive

Computer
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4 Specify the drive for USB flash drive, and then click OK.

■ Drive
Specifies the drive assigned to the external memory.

■ Network
Displays the Map Network Drive dialog box. This dialog box allows you to specify a drive on the network.

■ External Memory Folder
Specifies the folder to save the created recipe file.

Click  to display the Project Settings dialog box. You can specify the External Memory Folder used as the save 
destination.

5 Click OK.

The Recipe Settings dialog box closes.

The “RECIPE” folder is created in the External Memory Folder used as the save destination, and the recipe files for the 
channels configured with Access to set to External Memory and Recipe function set to Enable in the Recipe 
Settings dialog box are created.
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● Creating Recipe Files when Downloading Project Data
When a project download is executed, the “RECIPE” folder is created in the External Memory Folder on the external 
memory inserted in the Touch and the recipe files are created. The recipe files are only created for channels 
configured with Access to set to External Memory and Recipe function set to Enable in the Recipe Settings 
dialog box.

1 Insert a USB flash drive into the Touch.

2 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

If the project data was changed, a confirmation message to save the project data is displayed.
Click OK to save the project data and display the Download dialog box.
Click Cancel to stop to save the project data.

3 Select the Download Recipe Files to External Memory check box.

The External Memory Folder is configured in the Project Settings dialog box. For details, refer to Chapter 26 
“1.5 Setting the External Memory Folder” on page 26-12.

USB flash drive

Touch
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4 Verify Communication Settings, and then click Download.
Since the recipe files are downloaded to the external memory inserted in the Touch, use the same settings as when 
communicating with the Touch.
To change Communication Settings, click Change to display the Communication Settings dialog box. Change 
Communicate with, Port, and Baud Rate. For details, refer to Chapter 23 “1 Communicating with the Touch” on 
page 23-1.

5 Click Yes.
The Download Project dialog box is displayed and the project files start downloading.
When finished downloading, a completion message is displayed.

6 Click OK.

7 Click Close.

● Creating Recipe Files with a Text Editor
You can edit recipe files using Notepad, commercially available text editors, or spreadsheet software.

1 Write the data for the amount of data in “value of device” comma (,) new line order.

If the amount of data in the recipe file is lower than the amount of data for the top device configured on the Channel 
tab in the Individual Settings dialog box, 0 is written in the rest of the devices.

2 Save the file with the “.csv” extension.

Give the file the file name configured on the Block tab in the Individual Settings dialog box. If the file name is 
different, 0 is written to all the devices.

3 Copy the edited recipe files to the “RECIPE” folder in the External Memory Folder on the external memory.

If security is enabled in the Touch project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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4.3 Editing Recipe Files

The recipe file that was read can be edited using Notepad, commercially available text editors, or spreadsheet 
software.

You can read and display the data saved from the Touch to 
the external memory as a recipe file on a computer.

USB flash drive

Book1

Recipe File

100

150

200

You can upload recipe files from the external memory using WindO/I-NV3.
On the WindO/I-NV3 Online tab, click the arrow under Upload, and then click Stored Data in External 
Memory to display the Upload Data from External Memory dialog box. Select the Recipe Files check box, 
specify the location to save the recipe files in Path, and then click OK to be able to save the recipe files in 
the specified folder.
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4.4 Deleting Recipe Files

The methods to delete recipe files saved on the external memory are as follows.
To delete files with WindO/I-NV3, on the Online tab, in the Touch group, click Clear, and then click Stored Data in 
External Memory to display the Clear Data in external memory dialog box. Select the Recipe Files check box, 
and then click OK.
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This chapter describes the Text Group function and how to configure text groups and text.

  

1.1 How the Text Group Function is Used

Text groups are a function where the text used for such purposes as registration text, messages for parts, chart 
labels, and titles for Popup Screens are registered in advance. The registered text is loaded and displayed when 
displaying parts and screens. The text can be managed collectively including editing the registered text and adding or 
deleting text.
Text groups can perform the following functions.

• Switch the displayed language by value of device.

• Use common text for parts.

Chapter 19 Text Group

1 Overview

External device
Touch

目標達成

D100 : 1

D100 : 2

D100 : 3

Text ID: 1 目標達成

Group 1: English Group 2: Chinese Group 3: Japanese

Goal reached

Goal reached

Touch

RUN STOP

Base Screen 1

Base Screen 2

RUN STOP

Text ID: 1 RUN
Text ID: 2 STOP

Group 1: English
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1.2 Functions that Support Text Groups

The functions that support text groups are as follows.

Item Setting

Screen Popup Screen Title

Drawings Text Text

Buttons

Bit Button Registration Text

Word Button Registration Text

Goto Screen Button Registration Text

Key Button Registration Text

Selector Switch Registration Text

Lamps
Pilot Lamp Registration Text

Multi-State Lamp Registration Text

Data 
Displays

Numerical Input Unit

Message Display Message

Message Switching 
Display

Message

Alarm List Display Message

Alarm Log Display Message, Title

Numerical Display Unit

Charts
Bar Chart X-axis and Y-axis scale labels

Line Chart X-axis and Y-axis scale labels

Alarm Log Messages displayed in data output as CSV

Data Log Labels displayed in data output as CSV

Operation Log Recorded item labels and event names displayed in data output as CSV

When the text group is switched, the displayed Base Screen is reset. Popup Screens and internal devices 
have the same behavior as when the Base Screen is switched. If the Close while changing Base Screen 
check box is selected on the Options tab in the properties dialog box for the Popup Screen, the displayed 
Popup Screen is closed. The behavior of the internal devices differs according to the internal devices. For 
details, refer to Chapter 27 “Internal Devices” on page 27-1.
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This section describes the configuration procedure for text groups and text.

2.1 Creating Text Groups

1 On the Configuration tab, in the System Setup group, click Text Group.

The Text Group Settings dialog box is displayed.

2 In Number of Text Groups, specify the number of text groups to create (1 to 16).

The configured number of text groups are enabled.

3 Under Text Group Name, enter the name for each text group.

The maximum number for the Text Group name is 20 characters.

For one text group, proceed to step 7.

2 Text Groups and Text Configuration Procedure
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4 In Default Group, select the text group to use when the Touch power is turned on and when switched to run mode.

5 Select the Use Dynamic Text check box.

6 With Trigger Device, specify the word device to use as the condition to switch the text group.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
These options can only be configured when Number of Text Groups is specified as two or more.

7 Click OK to close the Text Group Settings dialog box.

This concludes creating text groups.

When the value of device is 0, the text group switches to the default group.
If the value of device is invalid, the text group is not switched.
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2.2 Registering Text

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 With Text Group, select the text group to register text to.

The default is “1-Group 1” only. To manage text by groups, create the groups in the Text Group Settings dialog box. 

Click  to display the Text Group Settings dialog box. For details, refer to “Text Group Settings Dialog Box” on page 
19-15.

3 With Text ID, specify the ID number to register (1 to 32,000).

4 With Font under Text Attribute, select the font to use for the text to register from the following.

European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, Windows

5 With Text Color under Text Attribute, select the color of the text to register (color: 256 colors, monochrome: 8 
shades).

Click Color to display the Color Palette. Select a color from the Color Palette.

When Windows is selected, all the fonts installed on the computer can be used. This allows you to display 
fonts and languages that are not installed on the Touch.
Click Change to display the Font Settings dialog box. Configure the details such as the font, style, and size. 
For details, refer to Chapter 2 “Windows Font” on page 2-12.
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6 In Text under Text Attribute, enter the text to register.

The maximum number is 3750 characters.
The characters that can be entered vary based on the font selected by Font. For details, refer to Chapter 2 “1.2 
Available Text” on page 2-5.

7 Click Add/Edit.

The text is registered and displayed in the text list.

8 Repeat steps 2 through 7 to create the necessary text in each text group.

9 Click Close.

A save confirmation message is displayed.

10 Click OK.
The confirmation message and Text Manager close.
This concludes registering text.

• You can enter multi-line text by inserting a newline. The newline is displayed as \n and is counted as two 
characters.

• To enter Unicode characters, click   to display the Unicode Input dialog box. Enter the characters in 

the Unicode Input dialog box, and then click OK.
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● Saving Registered Text as a CSV File
To use registered text in another project, save the text as a CSV file or as a text file. This file is called a text list.

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 With Text Group, select the text group where the text ID to save is registered.

For one text group, proceed to step 3.

3 Click Export.

The Save As dialog box is displayed.

4 Select Save in, enter File name, and then click Save.

5 Click Close to close Text Manager.

This concludes saving a text list.
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● Importing Text from a Text List
A text list saved as a CSV file or as a text file can be imported into Text Manager for the project being edited.

1 On the View tab, in the Workspace group, click  (Text Manager).

Text Manager is displayed.

2 With Text Group, select the text group to register the imported text to.

For one text group, proceed to step 3.

3 Click Import.

The Text Message List dialog box is displayed.

4 Click List File. 

The Open dialog box is displayed. 



SmartAXIS Touch User’s Manual 19-9

2 Text Groups and Text Configuration Procedure

19

Text G
roup

5 Select a saved text list, and then click Open.

The text is displayed in the list.

6 Click the text to import.

7 Click OK.

If there is text with an already registered ID number in Text Manager, a confirmation message to overwrite that text 
is displayed.
• Click Yes to overwrite the text with the ID number displayed in the confirmation message.
• Click Yes To All to overwrite all the text.
• Click No to display the next confirmation message without overwriting the text with the ID number displayed in the 

confirmation message.
• Click Cancel to stop importing text.

8 Click Close in Text Manager.

A save confirmation message is displayed.

9 Click OK.

The confirmation message and Text Manager close.
This concludes importing text from a text list.

To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.
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2.3 Switching the Displayed Language by Value of Device

When multiple text groups have been created, the text group can be switched with a value of device to display a 
different language.
This section describes an example when the registration text for a button changes between English, Chinese, and 
Japanese.

1 Following the steps in “Creating Text Groups” on page 19-3, specify Number of Text Groups as 3, and under Text 
Group Name, enter “English” for Group 1, “Chinese” for Group 2, and “Japanese” for Group 3. Select the Use 
Dynamic Text check box and set Trigger Device to D100.

2 Following the steps in “Registering Text” on page 19-5, register the text.

3 Create a Bit Button.
On the Home tab, in the Parts group, click Buttons, and then click Bit Button.

4 Click a point on the edit screen where you want to place the Bit Button.

External device
Touch

RUN STOP

Bit Button 2 (Text ID: 2)

Bit Button 1 (Text ID: 1)

D100 :

D100 :

D100 :

1

2

3

Text ID: 1

Group 1: English Group 2: Chinese

Text ID: 2

Group 3: Japanese

RUN
STOP

運転
停止

運転 停止

Text ID: 1 運転
Group 1: English Group 2: Chinese

Text ID: 2 停止

Group 3: Japanese

RUN
STOP
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5 Double-click the dropped Bit Button and the properties dialog box is displayed.

6 Click the Registration Text tab.

7 Select the Use Text Manager check box.

8 Specify 1 for the Text ID under OFF.

9 Configure the settings on each tab as necessary, and then click OK.

The Properties of Bit Button dialog box closes.

10 Repeat steps 3 through 9 and create a Bit Button to use text ID 2 for the registration text.
This concludes configuring the settings to switch the displayed language by a value of device.
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This section describes items and buttons in Text Manager and on the Text Group Settings dialog box.

3.1 Text Manager

The text that is loaded and displayed when objects and Popup Screens are displayed is collectively managed with 
Text Manager.

■ Text ID
Shows the ID number (1 to 32,000).
When registering text, specify the ID number to register (1 to 32,000).
When using registered text when displaying parts and screens, specify the ID number to use (1 to 32,000).

■ Text Group
Selects the group where text is registered.
The default is “1-Group 1” only. To manage text by groups, create the groups in the Text Group Settings dialog box. 

Click  to display the Text Group Settings dialog box. For details, refer to “Text Group Settings Dialog Box” on page 
19-15.

■ Text Attribute
This area configures the text to register and the font and color for the text.

3 Text Manager

Font: Selects the font used for displaying text from the following.
European, Japanese, Chinese, Taiwanese, Korean, Central European, Baltic, Cyrillic, 
Windows

Text Color: Selects the color of the text to register (color: 256 colors, monochrome: 8 shades).
Click Color to display the Color Palette. Select a color from the Color Palette.

Text: Enter the text to register here. The maximum number is 3,750 characters.
The characters that can be entered vary based on the font selected by Font. For details, refer 
to Chapter 2 “1.2 Available Text” on page 2-5.
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■ Text Messages List
The attributes for the registered text are displayed in this list.

■ Add/Edit
Registers the settings in Text Attribute to the ID number specified by Text ID. When you specify an ID number 
that is already registered, that ID number is overwritten with the new settings. The registered text and its attributes 
are displayed in the Text Messages List.
.

■ Delete
Deletes the text with the ID number selected in the Text Messages List. Click this button and the Confirm Message 
Delete Dialog dialog box is displayed.
• Click Yes to delete the text with the ID number displayed in the confirmation message from all the text groups.
• Click Yes To All to delete the text for all the ID numbers selected in the Text Messages List from all the text 

groups.
• Click No to display the next confirmation message without deleting the text with the ID number displayed in the 

confirmation message.
• Click Cancel to stop deleting the text.

■ Reduce
Deletes the text with ID numbers that are registered in the Text Message List but are not used in the project. This can 
decrease the amount of project data and reduce the amount of internal memory used on the Touch.

■ Find
Displays the Find dialog box.
The text entered in Find what is searched for in Message in the Text Messages List.

Windows Font: Sets the font to be used as the Windows Font.
Select Windows using Font to display the current setting. To change the setting, click Change 
to display the Font Settings dialog box.
For details, refer to Chapter 2 “Windows Font” on page 2-12.

• You can enter multi-line text by inserting a newline. The newline is displayed as \n and is counted as two 
characters.

• To enter Unicode characters, click  to display the Unicode Input dialog box. Enter the characters in 

the Unicode Input dialog box, and then click OK.

ID: Shows the ID number (1 to 32,000).

Font: Shows the font to use to display the registered text.

Color ID: Shows the color ID for the registered text (color: 256 colors, monochrome: 8 shades).

Message: Shows the registered text.

To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.

When Find is clicked after selecting a range of text, it will only search within the selected range.
To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.
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■ Replace
Displays the Replace dialog box.
The text entered in Find what is searched for in Message in the Text Messages List and that text is replaced with 
the text entered in Replace with.

■ Import
Imports text in a text list saved as a CSV file or as a text file.
Click this button to display the Text Message List dialog box. For details, refer to “Importing Text from a Text List” on 
page 19-8.

■ Export
Saves the text for the text group being edited as a CSV file or as a text file. This file is called a text list. The types of 
files that can be saved are as follows.
• CSV file (comma delimited) (*.csv)
• CSV file (semicolon delimited) (*.csv)
• Text file (comma delimited) (*.txt)
• Text file (semicolon delimited) (*.txt)
• Unicode text file (tab delimited) (*.txt)

Click this button to display the Save As dialog box. For details, refer to “Saving Registered Text as a CSV File” on page 
19-7.
The saved text list can be imported with Import.

■ Other Groups
When text with the same ID number as the text selected in the Text Messages List is registered to other text 
groups, that text is displayed in this list.

■ Select
Closes Text Manager and sets the ID number selected in Text Manager Text Messages List in the dialog box or 
screen that opened Text Manager. This button is only enabled when Text Manager was called from the properties 
dialog box of an object.

■ Close
Closes Text Manager.

When Replace is clicked after selecting a range of text, it will only search and replace within the selected 
range.
To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.

When Unicode text file (tab delimited) (*.txt) is selected, the file can handle multiple languages by 
using a commercially available text editor or spreadsheet software that supports Unicode.

Group Name: Shows the group name.

Font: Shows the font for the registered text.

Color ID: Shows the color ID for the registered text (color: 256 colors, monochrome: 8 shades).

Message: Shows the registered text.

When Text Manager was called from the properties dialog box of an object, Add/Edit, Delete, Reduce, 
Replace, Import, and Export are disabled. These buttons are only enabled when Text Manager is 
displayed with the following operations.
• Double click Text Manager in the Project window
• On the View tab, in the Workspace group, click  (Text Manager)
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3.2 Text Group Settings Dialog Box

The groups for switching text are managed in the Text Group Settings dialog box.

■ Number of Text Groups
Specifies the number of text groups (1 to 16). The configured number of text groups are created.

■ Text Group Name
Enters the names of the text groups.
The maximum number for the Text Group name is 20 characters.

■ Default Group
Select the group to use when the Touch power is turned on and when switching to run mode.

■ Use Dynamic Text
Select this check box to switch the text group according to the value of device.
Specify the word device to use as the condition to switch the text group.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
These options can only be configured when Number of Text Groups is specified as two or more.

When the value of device is 0, the text group switches to the text group set as the default group.
If the value of device is invalid, the text group is not switched.
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This chapter describes the script function, editing and management of the script, definition method, and definition 
sample.

 

1.1 Overview of the Script Function

● What is the script function?
Complex processes such as conditional branching, logical operation, arithmetic operation, functions, etc., can be 
programmed in a text format using Script Function.
The scripts can be executed in a Script Command, a Global Script, a ladder program, or a FBD program.
For ladder program and FBD program details, refer to the following.
• Ladder program: SCRPT instruction
"SmartAXIS Ladder Programming Manual" - Chapter 27 "Script"

• FBD program: Script FB
 "SmartAXIS FBD Programming Manual" - Chapter 17 "The script FB"

As an example, the logical product (AND) calculation described as  in a ladder diagram is described as 

[LM 100] & [LM 101] in text format in the script.

■ Description and management of the script
The script is programmed by WindO/I-NV3 script editor, and managed by Script Manager.

■ Example of using the script
As an example, when reading the data from the external device and displaying on the Touch, the load on the external 
device can be reduced for processes such as conditional branching or function calculation, which apply a heavy load 
on the external device, by processing it with a script on the Touch.

Chapter 20 Script

1 About the Script Function

LM100 LM101

• By using the Script Editor, conditional expressions, operators, and functions can be described by selecting 
them from a list, and an error in the script can also be determined. The script can also be exported as a 
text file, so the script can be edited by a text editor such as Notepad, and the edited script can be 
imported back into the Script Editor by saving it as a text file.
For details, refer to “2.3 Script Editor” on page 20-8.

• Script Manager can manage the script collectively by adding, deleting, organizing, etc., the script created 
by the Script Editor.
For details, refer to “2.2 Script Manager” on page 20-7.

// Change the additional value 
// depending on the value of D10  
if ([D 10] <= 9) 
{ [D 10] = [D 10] + 10; } 
else 
{ [D 10] = [D 10] + 20; } 
// Change the additional value 
// depending on the value of D11 
if ([D 11] <= 19) 
{ [D 11] = [D 11] + 20; } 
else 
{ [D 11] = [D 11] + 40; } 
// Change the additional value 
// depending on the value of D12 
if ([D 12] <= 29) 
{ [D 12] = [D 12] + 30; } 
else 
{ [D 12] = [D 12] + 60; } 
// Change the additional value 
// depending on the value of D13 
if ([D 13] <= 39) 
{ [D 13] = [D 13] + 40; } 
else 
{ [D 13] = [D 13] + 80; }

Touch
External device

Get the result by processing with script 

D10 0 → 10

D11 10 → 30

D12 30 → 90

D13 50 → 130

D10 0

D11 10

D12 30

D13 50

Read the data not processed

Write the result

Process with script to decrease 
the load of external device.

D10 10

D11 30

D12 90

D13 130
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1.2 Types and Trigger Conditions of the Script for HMI Function

● Types of scripts
There are two types of scripts used.

■ Script Command
This is a script that executes in accordance with trigger conditions in the same way as other parts, such as buttons or 
lamps, for each screen.
• It is executed only in the screens where it is placed.
• Multiple scripts can be set for each screen.
For details, refer to Chapter 11 “4 Script Command” on page 11-25.

■ Global Script
This is a script that operates within the whole project. This script is executed at the end of Touch scan process in 
accordance with the trigger condition.
Only one global script can be set to a project.
For details about setup, refer to “3 Global Script” on page 20-12.

● Trigger condition of the script
Trigger conditions that can be set for the script are as follows:

■ Rising-edge
Script is executed when trigger device changes from 0 to 1.

■ Falling-edge
Script is executed when trigger device changes from 1 to 0.

■ Satisfy the condition
Script is executed when the set condition is met.
This can only be set for the Script Command.

■ While satisfying the condition
Script is executed while the set condition is met.
This can only be set for the Script Command.

■ Fixed Period
Script is executed at set intervals.

■ Always ON
Script is executed on every scan of the Touch.
This can only be set for the Global Script.

Script

Trigger Condition

Rising-edge
Falling-

edge
Satisfy the 
condition

While 
satisfying 

the 
condition

Fixed Period Always ON

Script Command YES YES YES YES YES NO

Global Script YES YES NO NO YES YES
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1.3 Data Type of the Script

It is required to set the data type appropriate for the range of data to be used, such as the maximum and minimum 
values of the data used in the script, negative numbers or real numbers required, etc., considering what is to be 
processed with the script.

● Data Types
There are seven types of data that can be processed by the script function.
For details about the data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Data type is set by the Script Editor.
For the setting method, refer to “2.3 Script Editor” on page 20-8.

Types of the data 
type

Required 
word count

Range that can be processed

BIN16 (+) 1 0 to 65535

BIN16 (+/-) 1 -32768 to 32767

BIN32 (+) 2 0 to 4294967295

BIN32 (+/-) 2 -2147483648 to 2147483647

BCD4 1 -999 to 9999

BCD8 2 -9999999 to 99999999

float32 2

-3.4×1038 to -1.18×10-38

0

1.18×10-38 to 3.4×1038

There are functions that cannot be used when the data types are different. Please refer to the format list.
 For details, refer to “4 Script Definition Method” on page 20-14.

WindLDR data types are displayed as follows: BIN16(+) as W (word), BIN16(+/-) as I (integer), BIN32(+) 
as D (double word), BIN32(+/-) as L (long), and float32 as F (float). For details, refer to the follows:
• Ladder program
 "SmartAXIS Ladder Programming Manual" - Chapter 4 "Instructions Reference" - "Data Types for 

Advanced Instructions"
• FBD program
 "SmartAXIS FBD Programming Manual" - Chapter 4 "FB Reference" - "Data types"
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1.4 Script Error of HMI Function

This section describes the types, cause, and information of script errors.

● Types and causes of script errors
Script will stop running when an error occurs.

● Error information
Script error information is stored in the following locations. An error message is displayed on the screen when a script 
error has occurred.

Types of script error Cause

Processing error
Dividend was divided by 0 for division and residue calculation.

Data types are BCD, float32, and value out of range is specified.

Execution time over error The execution time for one script exceeded 3,000 milliseconds.

Writing count error Data count written to the external device address in one script has exceeded 64.

Indirect device error

Indirect read from external device address is performed while the HMI Special 
Internal Relay LSM14 or LSM15 is 1.

Indirect read or indirect write of external device address is performed with the 
Global Script.

Parameter error
Value out of range was specified as argument for LINE function, RECTANGLE 
function, or CIRCLE function.

Category Storage location Stored value

Existence of a script error
Bit 10 of the System Area address 
+2

0 No error

1 Error

Script ID of the script with an error HMI Special Data Register LSD52
1 to 

32,000
Script ID

Types of script errors HMI Special Data Register LSD53

1 Processing error

2 Execution time over error

3 Writing count error

4 Indirect device error

5 Parameter error

• If there is a script error, bit 10 (11th bit) of the starting device +2 (third word from the beginning) of the 
System Area will be 1.

The starting device of the System Area is set in the System tab of the Project Settings dialog box.
For details about the System Area, refer to Chapter 3 “System Area” on page 3-23.

• For ladder program and FBD program errors, refer to Chapter 30 “2.2 Program Execution Error” on page 
30-5.

Starting device +1 +2 +3 +4 +5 +6 +7

System Area 1 System Area 2 System Area 3 System Area 4

+8 +9

0123456789101112131415

1st word 2nd word

11th bit

3rd word 4th word 5th word 6th word 8th word7th word 10th word9th word



SmartAXIS Touch User’s Manual 20-5

2 Editing and Management of the Script

20

Script

  

2.1 Script Registration Procedure

This section describes the procedure to create a script and register it in the project.
The registered script can be used in a Multi-Button, Script Command, Multi-Command and Global Script.

1 On the View tab, in the Workspace group, click  (Script Manager).

Script Manager opens.

2 Click Add.

Script Editor opens.

3 Specify Script ID.

When creating a new script, enter the script ID (1 to 32000).

2 Editing and Management of the Script
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4 Enter Script Name.

The maximum number for the script name is 40 characters.

5 Select Data Type.

6 Type in a program to Script.

7 When the script is finished, click OK.

The created script is shown in Script List.

8 Click Close on Script Manager.

A save confirmation message is displayed.

9 Click OK.

The scripts are saved in the project data and Script Manager closes.
If you click Cancel, Script Manager closes without saving the scripts.

Be sure to match the Data Type of the script with the types of data being used within the script.
For example, if the script contains numbers with decimals, the Data Type of the script would be float32. If 
the script contains only whole numbers between 0 and 65535, the Data Type of the script would be 
BIN16(+).

To create a script using the samples provided by WindO/I-NV3, under Function List, select Category and 
Function, and then click Insert Format. The sample shown in Format is inserted at the cursor position in 
Script.

When you are in the following dialog boxes, clicking  will open Script Manager. When you close Script 
Manager, you will be taken back to the original dialog box.
• Global Script General tab
• Script Command properties General tab
• Multi-function script properties for Multi-Buttons and Multi-Commands
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2.2 Script Manager

Script Manager can add, delete and manage the script created by Script Editor.

■ Script List
Displays a list of registered scripts.

■ Script
Displays the contents of the script selected in the script list.

■ Add
Displays the Script Editor dialog box to add a script.
For details, refer to “2.3 Script Editor” on page 20-8.

■ Edit
Displays the Script Editor dialog box to allow editing of the selected script. For details, refer to “2.3 Script Editor” on 
page 20-8.

■ Delete
Deletes the script selected in the script list.
If a script is used in a project or parts, it cannot be deleted.

■ Reduce
Deletes the scripts that are registered in the script list but are not used in the project.

■ Select
The highlighted script in the script list is selected and Script Manager is closed.

■ Close
Closes Script Manager.

Script ID: Displays the script ID (1 to 32,000) of the registered scripts.

Error: OK is displayed when there is no error in the registered script and NG is displayed when there is an error.

Script Name: Displays the script name of the registered scripts.

When Close is clicked after a change has been made in the script list, a confirmation message to save is 
displayed. The change will be saved when OK is clicked. The change will be discarded and Script Manager 
closed when Cancel is clicked.
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2.3 Script Editor

A new script can be created or the script selected in Script Manager can be edited using Script Editor.

■ Script ID
To create a new script, enter the script ID (1 to 32,000).
To edit an existing script, the set script ID is displayed.

■ Script Name
Enter the script name. The maximum number for script name is 40 characters.

■ Data Type
Select the data type to be processed by the script.
For details about the data type, refer to “1.3 Data Type of the Script” on page 20-3.

■ Script
Enter the script.
Single script limitation is 240 characters per line with up to 1024 lines.

■ Error Check
The script being edited is checked for errors.

■ Import
The Open dialog box is displayed.
By selecting a script saved (exported) in a text format (*.txt) and clicking Open, the imported script is inserted at the 
cursor position of the script being edited.

(Description)
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■ Export
The Save As dialog box is displayed.
By selecting a save location and clicking Save, the script being edited is saved in text format (*.txt). A saved script 
can be inserted in the script clicking Import.

■ Options
The Options dialog box is displayed.
The fonts and color of the text, tab indents, etc., used in the Script text box are set in the Options dialog box. For 
details, refer to “Script Formatting Options dialog box” on page 20-11.

■ Find
The Find dialog box is displayed.
Enter the text to be searched for in the Find What box.

■ Replace
The Replace dialog box is displayed.
Text entered in Find what will be replaced with the text entered in Replace with.

■ Show/Hide Function List
Switches between showing and not showing the Function List and Script Compilation Output.

■ Cursor
Displays the current position of the cursor in the Script text box by line number and column number.

When Find is clicked after selecting a range in the Script text box, it will only search within the selected 
range.

• This is useful when replacing device addresses.
• When Replace is clicked after selecting a range in the Script text box, it will only search and replace 

within the selected range.

The size of the script edit box can be changed by dragging the right bottom corner of the Script Editor. By 
hiding the Function List and Script Compilation Output, the script editing area (text box) will become 
larger, making the editing of script easier.
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■ Function list

■ Script Compilation Output
The contents of any errors found when using error check are displayed.
By double-clicking on the comment displayed in the Script Compilation Output, the part corresponding to the error 
is highlighted in the Script text box.

■ OK
Error check is performed for the script being edited and save it.

■ Cancel
Closes Script Editor without saving the script being edited.

Category: Lists the categories of the functions.

Function: Lists the functions of the selected category.

Format: Displays the definition example of the selected function.

(Description): Displays the description of the selected function.

Insert Format: Contents displayed in the selected Format are inserted at the cursor position.

Insert Device: The Device Address Settings box is displayed.
By specifying the device address and clicking on OK, specified device address is inserted 
at the cursor position.

Depending on the error, there may be an error in the line that is different from the line displayed in the 
Script Compilation Output, or multiple errors may be displayed.

If there is an error in the script being edited, a message will appear before saving the script. It is possible to 
save a script with an error.
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● Script Formatting Options dialog box
Font, Size, Tab indent, and Color used in the Script text box of the Script Editor can be specified.

■ Font
The font name for the text displayed in the Script is entered or selected.

■ Size
The font size (dots) for the text displayed in the Script is entered or selected.

■ Sample
Displays a sample of the text with the Font and Size as specified in the Script text box.

■ Tab indent
Specify the position of the indent when a tab is inserted (1 to 20).

■ Color
Displays each of the text colors for Comment, Keyword, and Device.
The Color dialog box is displayed when the color button is clicked.

Text other than comment, keyword, or device is displayed in black.
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A Global Script is a script that operates throughout the entire project, regardless of which screen is currently being 
displayed. Only one Global Script can be set for a project. This script is executed at the end of scan process of Touch 
in accordance with the trigger condition.

3.1 Setting procedures for Global Script

Global Script is setup using the following procedures.

1 On the Configuration tab, in the System Setup group, click Global Script.

The Global Script dialog box is displayed.

2 Click General tab and Trigger Condition tab.

Set or confirm the items displayed in each of the tabs.

● General Tab

■ Use Global Script
To use the Global Script, select the Use Global Script check box.

■ Script ID
Specify the script ID (1 to 32,000) of the script to operate.

Script Manager is displayed when  is clicked. The script can be selected from the script list of Script Manager. For 
details, refer to “2.2 Script Manager” on page 20-7.

■ Script Name
Displays the name of the script specified by the script ID.

■ Script
Displays the contents of the script specified by the script ID.

3 Global Script

With Global Script, you cannot do indirect read and indirect write of the external device addresses.
(It can be setup in WindO/I-NV3, but it will not operate on the Touch.)
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● Trigger Condition Tab

■ Trigger Type
Specify the condition to execute the script.

■ Device
Specify the bit device or bit of the word device.
This is enabled only when Rising-edge or Falling-edge is selected in Trigger Type.

■ Period (sec)
Specify the scan frequency in seconds (1 to 3,600).
This is enabled only when Fixed Period is selected in Trigger Type.

Rising-edge: Script is executed when trigger device changes from 0 to 1.

Falling-edge: Script is executed when trigger device changes from 1 to 0.

Always ON: Script is executed constantly.

Fixed Period: Script is executed at set intervals.
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4.1 Format List

This section describes the format and operation of control statements, operators, functions, etc.
Enter everything except comments in single-byte. For specific definition examples, refer to “5 Script Coding 
Examples” on page 20-22.

● Control statements

Conditional expressions are described as , ,  here. Execution lines are described as 
, ,  ...

■ Conditional branching

■ Repeat

4 Script Definition Method

Format Description

if
   else
   else if

if ( )
{ ; }

Execution line is executed if the conditional expression is satisfied.

if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression is satisfied.
Execution line 2 is executed if it is not satisfied.

if ( )
{ ; }
else if ( )
{ ; }
else
{ ; }

Execution line 1 is executed if the conditional expression 1 is satisfied.
Conditional expression 2 is determined if conditional expression 1 is not 
satisfied, and execution line 2 is executed if conditional expression 2 is 
satisfied.
Execution line 3 is executed if conditional expression 2 is not satisfied too.

switch
   case
   default

switch ( )
{
  case constant 1:
    ;
    break;
  case constant2:
    ;
    break;
  default:
    :
    break;
}

Execution line 1 is executed if the value of conditional expression matches 
constant 1.
Execution line 2 is executed if the value of conditional expression matches 
constant 2.
Execution line 3 is executed if the value of conditional expression does not 
match constant 1 nor constant 2.
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

Format Description

while

while ( )
{
  ;
}

Execution line is repeatedly executed while the conditional expression is 
satisfied.

• It will go into an infinite loop when the conditional expression is always 
satisfied, so do not set fixed values or devices that do not change as the 
conditional expression.

• Do not write a value to the external device address in the while definition.
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■ Halt and exit

● Operator
Device, constant, and temporary device are described as ,  here, and expression is described as , 

, .

■ Relational operator

■ Logical operator

■ Arithmetic operator

Format Description

break

while ( )
{
  if ( )
  {
    ;
    break;
  }
 ;
}

;

Process will be as follows while the conditional expression 1 is satisfied.
• Execution line 2 is continuously executed while the conditional expression 2 is 

not satisfied.
• Once the conditional expression is satisfied, it will go out of the loop by break 

(not executing execution line 2), and execution line 3 is executed.

break

switch ( )
{
  case constant 1:
    ;
    break;
  case constant 2:
    ;
    break;
}

;

When the conditional expression 2 matches the constant 1, it will halt the 
determination of constant 2 by break after executing execution line 1, and 
process will move to execution line 3.

return return; It will exit the script, and execute the next parts or script.

Operator Format Description

==  == Compares if  is equal to .

!=  != Compares if  is not equal to .

<  < Compares if  is less than .

<=  <= Compares if  is equal or less than .

>  > Compares if  is greater than .

>=  >= Compares if  is equal or greater than .

Operator Format Description

&& ( ) && ( ) Calculates the logical product (AND) of  and .

|| ( ) || ( ) Calculates the logical sum (OR) of  and .

! !( ) Reverses the logic of .

Operator Format Description

+  + Adds  and .

-  - Subtracts  from .

*  * Multiplies  and .

/  / Divides  by .

%  % Calculates remainder after dividing  by .
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■ Bit operator

● Function
Device, constant, and temporary device are described as , , , ... here.

■ Bit function

■ Word function

Arithmetic operation

(Continued to next page)

Operator Format Description

&  & 
Calculates the logical product (AND) of each bit of  and .
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

|  | 
Calculates the logical sum (OR) of each bit of  and .
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

^  ^ 
Calculates the exclusive logical sum (XOR) of each bit of  and .
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

~ ~

Reverses the logic of each bits of .
For word device and fixed values, 0 will be 65535, and 65535 will be 0.
For bit device, 0 will be 1, and 1 will be 0.
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

<<  << 
Shifts each bit of  to left for  bit(s).
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

>>  >> 
Shifts each bit of  to right for  bit(s).
• This can only be used for data types BIN16 (+), BIN16 (+/-), BIN32 (+), 

BIN32 (+/-), BCD4, and BCD8.

Function Format Description

Bit set SET( );
Turns bit device  to 1.
It will be same result as  = 1;.

Bit reset RST( );
Turns bit device  to 0.
It will be same result as  = 0;.

Bit reverse REV( );
Reverses the 1 and 0 of bit device .
It will be same result as  = ~ ;.

Function Format Description

Maximum 
value MAX( , , )

Maximum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Minimum 
value MIN( , , )

Minimum value out of , ,  is returned.

• This can be used for all data types.
• Up to 15 arguments can be defined.

Exponential 
function EXP( )

Exponential function of  is returned.

• This can only be used for data type float32.

Natural 
logarithm
(Base: e)

LOGE( )
Natural logarithm (base is e) for  is returned.

• This can only be used for data type float32.
• Set a value larger than 0 for argument.

Common 
logarithm
(Base: 10)

LOG10( )
Common logarithm (base is 10) for  is returned.

• This can only be used for data type float32.
• Set a value larger than 0 for argument.

Exponentiation POW( , )
 to the  power is returned.

• This can only be used for data type float32.
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Arithmetic operation (Continued)

Data type conversion

Function Format Description

Square root ROOT( )
Square root of  is returned.

• This can only be used for data type float32.

Sine SIN( )

Sine of  (-1 - +1) is returned. Specify arbitrary formula to represent 

angle (units in radian) for argument .

• This can only be used for data type float32.

Cosine COS( )

Cosine of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type float32.

Tangent TAN( )

Tangent of  (-1 - +1) is returned. Specify arbitrary formula to 

represent angle (units in radian) for argument .

• This can only be used for data type float32.

Arcsine ASIN( )

Arcsine of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type float32.

Arccosine ACOS( )

Arccosine of  (-1 - +1) in radian value (0 - π) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type float32.

Arctangent ATAN( );

Arctangent of  (-1 - +1) in radian value (-π/2 - +π/2) is returned. 

Specify arbitrary formula for argument .

• This can only be used for data type float32.

Conversion 
from Angle to 

Radian
RAD( );

Value of  is converted from degree (°) to radian, and the value is returned.

• This can only be used for data type float32.

Conversion 
from Radian 

to Angle
DEG( );

Value of  is converted from radian to degree (°), and the value is returned.

• This can only be used for data type float32.

Function Format Description

Conversion 
from BCD to 

Binary
BCD2BIN( )

BCD value of  is returned in binary value.

• This can be used with data types BIN16 (+), BIN16 (+/-), BIN32 (+), 
and BIN32 (+/-).

Conversion 
from Binary to 

BCD
BIN2BCD( )

Binary value of  is returned in BCD value.

• This can be used with data types BIN16 (+), BIN16 (+/-), BIN32 (+), 
and BIN32 (+/-).

Conversion 
from float32 

to Binary
FLOAT2BIN( )

Float32 value of  is returned in binary value.
Values under the decimal point is truncated.

• This can be used with data types BIN32 (+) and BIN32 (+/-).

Conversion 
from Binary to 

float32
BIN2FLOAT( )

Binary value of  is returned in float32 value.

• This can be used with data types BIN32 (+) and BIN32 (+/-).

Conversion 
from Decimal 

to String 
character

DEC2ASCII( , )

Decimal number value  is converted to a character string, and store 
in order with  as a starting device.

• This can be used with data types BIN16 (+), BIN16 (+/-), BIN32 (+), 
BIN32 (+/-), BCD4, and BCD8.

Conversion 
from String 
character to 

Decimal

ASCII2DEC( )

Character string  is returned as decimal number value.

• This can be used with data types BIN16 (+), BIN16 (+/-), BIN32 (+), 
BIN32 (+/-), BCD4, and BCD8.
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Data comparison and copy

Character string operation*1

Only internal devices can be specified as an argument for character string operation function.
Termination character NULL (0x00) is treated as end of character string when character string is handled. Also, 
termination character NULL is not included in the length of the character string.

*1 HMI function only

Function Format Description

Data 
comparison MEMCMP( , , )

: Starting device of comparison target 1
: Starting device of comparison target 2
: Range of comparison (in words)

Values of device  for  words and values of device  
for  words are compared.
1 is returned if all the values of devices match, and 0 is returned if any 
of the value does not match.
• Specified range is compared in word unit, and result is returned.
• Up to 64 words can be compared.

Data copy MEMCPY( , , )

: Starting device of copy source
: Starting device of copy target
: Range of copy (in words)

Values from  for  words are copied to  for  
words respectively.
• Specified range is copied in word unit.
• Up to 64 words can be copied.

Bit device
(1 word length)
to
Bit device
(1 word length)

BITS2BITS( , );

: Starting device of copy target (bit device)
: Starting device of copy source (bit device)

Copies one word worth of data from  to .
• 16 bits are processed from the starting bit device as one word.
• This can only be used in control functions.

Bit device
(1 word length)
to
Word device

BITS2WORD( , );

: Starting device of copy target (bit device)
: Starting device of copy source (word device)

Copies one word worth of data from  to .
• 16 bits are processed from the starting bit device as one word.
• This can only be used in control functions.

Word device
to
Bit device
(1 word length)

WORD2BITS( , );

: Starting device of copy target (word device)
: Starting device of copy source (bit device)

Copies one word worth of data from  to .
• 16 bits are processed from the starting bit device as one word.
• This can only be used in control functions.

Function Format Description

Character 
string copy STRCUT( , , , )

: Starting device of copy target
: Starting device containing copy source character string
: Start location of copy (0-127)
: Number of characters to copy (1-128)

From the character string starting from , character string 
from  bytes forward for  characters are stored into 

 for  characters.

Character 
number count STRLEN( ) Number of characters for character string starting from  is 

returned.

Character 
string 
concatenation

STRCAT( , )
To the character string starting from , the character string 
starting from  is concatenated, and  is returned to 
beginning.

Character 
string search STRSTR( , )

From the character string starting from , character string 
starting from  is searched, and location found (number of 
characters from beginning -1) is returned.
The maximum number for character string to search is 128 
characters.
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Draw*1

This is a function to draw an object on the screen. Top left corner of the screen is coordinates X=0 and Y=0.
When a device is used as an argument, an object is drawn with the changed value when the value is changed. 
However, the object that is already drawn is not erased. To erase the drawn object, overwrite it with the background color.
When an out-of-range value is used as an argument, 5 is stored in the LSD53 and script is halted.

(Continued to next page)
*1 HMI function only

Function Format Description

Drawing of 
straight line

LINE( , , , ,
     , , )

Straight line connecting the start coordinate and end coordinate is drawn.
: Start coordinate X, : Start coordinate Y, : End 

coordinate X, : End coordinate Y, : Line width, 
: Line type, : Line color

• : Line width, : Line type, : Line color can be omitted.
• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.

LINE( , , , )

• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).
• : Line color is specified by the color data. It will be set to 

255 (white) when omitted. 
For color data, refer to Appendix “1 Color Number 
Correspondence Table” on page A-1.

Drawing of 
Rectangle

RECTANGLE( , , ,
          , , ,
          , , ,
          , )

Rectangle with left top corner as start coordinate and bottom right corner 
as end coordinate is drawn.

: Start coordinate X, : Start coordinate Y, : End 
coordinate X, : End coordinate Y, : Line width, : 
Line type, : Foreground color, : Background color, : 
Pattern, : Rounded corner type, : Rounded corner radius
• : Line width, : Line type, : Foreground color, 

: Background color, : Pattern, : Rounded 
corner type, : Rounded corner radius can be omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.
• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).

RECTANGLE( , , ,
          )

• : Foreground color, : Background color is specified 
by the color data. It will be set to 255 (white) when omitted. 
For color data, refer to Appendix “1 Color Number 
Correspondence Table” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (None) when omitted.
• Specification of : Rounded corner type is as follows.

It will be set to 0 (None) when omitted.
• : Rounded corner radius is specified with number of dots (0 - 200). 

It will be set to 0 (0 dot) when omitted.

Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash Long Dash 
Dot

Long Dash 
Dot Dot

Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash Long Dash 
Dot

Long Dash 
Dot Dot

Set 
value 0 2 3 4 7 8

Line 
type None Foreground 

100%
Foreground 

25%
Foreground 

50%
Background 
100%

Horizontal 
lines

Set 
value 9 10 11 12 13

Line 
type

Vertical 
lines

Slant 
Upwards

Slant 
Down-wards Cross-hatch Tint

Set value 0 1 2
Line type None Straight Curve
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Draw (Continued)

Offset

Function Format Description

Drawing 
of circle 
and ellipse

CIRCLE( , , , ,
       , , , ,
       )

A circle with specified radius from center coordinate is drawn.
: Center coordinate X, : Center coordinate Y, : 

X axis radius, 
: Y axis radius, : Line width, : Line type, 

: Foreground color, 

: Background color, : Pattern
• : Line width, : Line type, : Foreground 

color, : Background color, : Pattern can be 
omitted.

• Specification of : Line width is as follows:

It will be set to 1 (1 dot) when omitted.

• Specification of : Line type is as follows.

It will be set to 1 (Solid) when omitted or when the line width is 
set to anything other than 1 (1 dot).
• : Foreground color, : Background color is specified 

by the color data. It will be set to 255 (white) when omitted.
For color data, refer to Appendix “1 Color Number 
Correspondence Table” on page A-1.

• Specification of : Pattern is as follows.

It will be set to 0 (none) when omitted.

CIRCLE( , , , )

Function Format Description

Indirect 
specification OFFSET( , )

: Reference device

: Device to store the indirect value (0 to 32767)

Specify the device  words from .

Indirect read
Specify OFFSET function to the right of the assignment 
statement.

Format example:  = OFFSET( , )

Operation:
Stores the value of device in  words 

from  into .

Indirect write
Specify OFFSET function to the left of the assignment statement.

Format example: OFFSET( , ) = 

Operation:
Stores the value of  into the 

device words from .

• Store the value appropriate for the data type as the indirect 
value. As an example, when the data type is BCD4, store the 
indirect value of BCD4 into the device.

Set value 1 2 3 5
Line width 1 dot 2 dots 3 dots 5 dots

Set value 1 2 3 4 5 6

Line type Solid Dot Dash Long Dash
Long Dash 

Dot
Long Dash 
Dot Dot

Set value 0 2 3 4 7 8

Line type None
Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Horizontal 
lines

Set value 9 10 11 12 13

Line type
Vertical 

lines
Slant 

Upwards
Slant 

Down-wards
Cross-hatch Tint
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● Other
This section provides definitions for constant, device, temporary device, and comment.

■ Constant
Constant can be defined as decimal or hexadecimal numbers.

Sample definition of decimal numbers

There are 2 ways to define hexadecimal numbers.

Sample definition of hexadecimal numbers

■ Device Address
Device Address is defined with the device symbol and address within “[” and “]”.

Definition of the device

Sample definition

■ Temporary Device
Temporary device is a device that can be used only with the script. It can store a value and can be used as a variable.
It is defined with a device symbol “@” followed by address (HMI function: 1 to 16, Control function: 1 to 32).

Definition of the temporary device

Sample definition

■ Comment
A note defined in the script is called a comment. The line with “//” defined at the beginning of a line will become a comment.
“//” is defined with a single-byte. Double-byte characters can be used after “//”.

Definition of comment

Sample definition

1234 Define the numeric value directly.

-1234 Define the negative number with a “-” (minus) symbol at the beginning.

12.34 Decimal number can be defined for real numbers (float32).
Define a “.” (period) between the whole numbers and decimal numbers.

0x12AB Define “0” (zero) and “x” (lower case x) at the beginning of the value.

12ABh Append “h” at the tail of the value.

[Device symbol address] (“ ” represents a space.)

[LDR 100]

@Address (Space between the device symbol “@” and address is not required.)

@2 Temporary device number 2

All the values for temporary devices are set to “0” when the execution of the script is started.

// Arbitrary note

// Store the initial value to calculation 
data [LDR 100] for process A
[LDR 100] = 1234;
:
:

←This line is not executed.

• It will be useful to use comments to explain the contents of the script (especially when the editor of the 
script has changed or some time has passed since editing).

• Comments are ignored (not executed) when the script is executed, so they can be defined freely without 
worrying about the execution time.
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This section provides script coding examples for control statements, arithmetic operators, and functions, as well as 
the descriptions of their operations. However, the devices that can be used and their notation varies based on HMI 
functions and control functions. Please program a script with the devices and notation that can be used for each 
respective function. 

5.1 Control Statements

Script

Operation description
If the value of LDR100 is not 0, then 100 is stored in LDR200.

Script

Operation description
If the value of LM100 is not 0, then LDR300, LDR400, and LDR500 are added and that value is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0 and the value of LDR200 is also not 0, then 0x1234 is stored in LDR300.
If the value of LDR100 is not 0 and the value of LDR200 is 0, then nothing is executed.
If the value of LDR100 is 0, then nothing is executed regardless of the value of LDR200.

5 Script Coding Examples

■ Example 5.1.1 Conditional branch

if ([LDR 100])
{

[LDR 200] = 100;
}

■ Example 5.1.2 Conditional branching

if ([LM 100])
{

[LDR 200] = [LDR 300] + [LDR 400] + [LDR 500];
}

■ Example 5.1.3 Conditional branching

if (0 != [LDR 100])
{

if (0 != [LDR 200])
{

[LDR 300] = 0x1234;
}

}
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Script

Operation description
If either the value of LDR100 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If the value of both LDR100 and LDR200 is 0, 100 is added to LDR500 and that value is stored in LDR400.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the values of LDR100, LDR200, and LDR300 are all not 0, then 100 is stored in LDR400.
If the values of LDR100 and LDR200 are not 0 and the value of LDR300 is 0, then 200 is stored in LDR400.
If either the value of LDR100 or LDR200 is 0, then nothing is executed regardless of the value of LDR300.

■ Example 5.1.4 Conditional branching

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}
else
{

[LDR 400] = [LDR 500] + 100;
}

■ Example 5.1.5 Conditional branching

if ([LDR 100] == 0)
{

[LDR 200] = 0x1234;
}
else if ([LDR 100] == 1)
{

[LDR 200] = 0x5678;
}
else
{

[LDR 200] = 0x9999;
}

■ Example 5.1.6 Conditional branching

if ([LDR 100])
{

if ([LDR 200])
{

if ([LDR300])
{

[LDR 400] = 100;
}
else
{

[LDR 400] = 200;
}

}
}
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Operation description
If the value of LDR100 is larger than 0, then 1 is repeatedly added to the value of LDR200 and 1 is repeatedly 
subtracted from the value of LDR100.
In the script example above, when the while statement repeats ten times, the value of LDR100 becomes 0 and the 
while statement ends.
After this script executes, the value of LDR100 is 0 and the value of LDR200 is 20.

Script

Operation description
While the value of LDR100 is 0, the while statement repeats.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will terminate, and 
after [LM 0] changes to 1, execution breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, execution breaks out of the while statement loop. After execution, the value of LDR100 
is 0, the value of LDR200 is 5, the value of LDR300 is 5, and LM0 is 1.

■ Example 5.1.7 Iteration

[LDR 100] = 10;
[LDR 200] = 10;

while (0 < [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}

■ Example 5.1.8 Iteration

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 300] = [LDR 200)
{

SET([LM 0]);
break;

}
}
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Script

This script stores the values of LDR10 through LDR19 in LDR100 through LDR109.
It operates as follows.
First, the indirect value LDR0 is initialized and set to 0.
First iteration (loop): The value of LDR0 is 0, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR10, 0 words from LDR10, is stored in LDR100, 0 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 1.

Second iteration (loop): The value of LDR0 is 1, so the condition “[LDR 0] < 10” is true and the statements inside 
while are executed.

• The value of LDR11, 1 word from LDR10, is stored in LDR101, 1 word from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 2.

:
(Repeats in this manner for the third to ninth iterations)

:
Tenth iteration (loop): The value of LDR0 is 9, so the condition “[LDR 0] < 10” is true and the statements inside while 
are executed.

• The value of LDR19, 9 words from LDR10, is stored in LDR109, 9 words from LDR100.
• 1 is added to the value of the indirect value LDR0 so that it becomes 10.

The value of LDR0 is 10, so the condition “[LDR 0] < 10” is false and execution breaks out of the while loop.
After execution, the values of LDR100 through LDR109 are the values of LDR10 through LDR19.

■ Example 5.1.9 Indirect write and indirect read using iteration (while statement)

// Transfer LDR10 through LDR19 to LDR100 through LDR109

// Initialize the indirect value
[LDR 0] = 0;

// Loop ten times
while ([LDR 0] < 10)
{

// Transfer 1 word by indirect assignment
OFFSET([LDR 100], [LDR 0]) = OFFSET([LDR 10], [LDR 0]);
// Increment indirect value
[LDR 0] = [LDR 0] + 1

}
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Operation description
This example converts a decimal value to octal using a while statement.
By repeating the process to divide the original decimal data by 8 and converting each digit to octal in a while 
statement, the conversion is implemented up to four digits.
The unconverted decimal value is stored in LDR100. After the script is executed, the converted octal value is stored in 
LDR200.

■ Example 5.1.10 Decimal to octal conversion using a while statement

// Convert a decimal value to octal
// - For example, convert 10 (dec) to 12 (oct), 16 (dec) to 20 (oct)
// - Convert a value to octal up to 4 digits max

@1 = 0; // while counter
@2 = [LDR 100]; // gets original data
@3 = 1; // decimal base
@4 = 0; // calculation results

// repeat four times
while (@1 < 4)
{

// Extract 1st octal digit from original data. Store working result in @10.
@10 = @2 % 8;
// Convert the extracted results to decimal and add to results
@4 = @4 + (@10 * @3);

// Increase the decimal base by one digit
@3 = @3 * 10;
// Reduce the original data by one digit
@2 = @2 / 8;
// If @2 is 0, terminate the while statement
if (0 == @2)
{

break;
}

// Increment while counter by 1
@1 = @1 + 1;

}

// Store the calculation result in LDR200
[LDR 200] = @4;
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Operation description
If the value of LDR100 is 10, then 0x1234 is stored in LDR200.
If the value of LDR100 is 999, then 0x5678 is stored in LDR200 and LM10 turns on.
If the value of LDR100 is not 10 or 999, then nothing is executed.

Script

Operation description
If the value of LDR100 is 0, then 0x1234 is stored in LDR200.
If the value of LDR100 is 1, then 0x5678 is stored in LDR200.
If the value of LDR100 is not 0 or 1, then 0x9999 is stored in LDR200.

Script

Operation description
If the value of LDR100 is not 0x1234, then 0 is stored in LDR300.
If the value of LDR100 is 0x1234, then 0x5678 is stored in LDR200 and the script terminates.
The return statement does not break out of a function like the break statement, it terminates the script and executes 
the next part or script.

■ Example 5.1.11 Conditional branching with switch

switch ([LDR 100])
{

case 10:
[LDR 200] = 0x1234;
break;

case 999:
[LDR 200] = 0x5678;
SET([LM 10]);
break;

}

■ Example 5.1.12 Conditional branching with switch using the default statement

switch ([LDR 100])
{

case 0:
[LDR 200] = 0x1234;
break;

case 1:
[LDR 200] = 0x5678;
break;

default:
[LDR 200] = 0x9999;
break;

}

■ Example 5.1.13 Terminate the script with the return statement

if (0x1234 == [LDR 100])
{

[LDR 200] = 0x5678;
return;

}
[LDR 300] = 0;
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Operation description
While the value of LDR100 is 0, the while statement repeats until LDR200 and LDR300 are equal.
Inside the while statement, if the values of LDR200 and LDR300 are equal, the while statement will end and 
execution breaks out of the while statement.
In the script example above, the values of LDR200 and LDR300 are equal when the while statement repeats twice, 
and after LM0 changes to 1, the while statement ends. After execution, the value of LDR100 is 0, the value of LDR200 
is 5, the value of LDR300 is 5, and the value of LM0 is 1.

5.2 Relational Operators

Script

Operation description
If the value of LDR100 is equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is not equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is less than the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.1.14 Break out of a loop with the break statement

[LDR 100] = 0;
[LDR 200] = 3;
[LDR 300] = 5;

while ([LDR 100] == 0)
{

[LDR 200] = [LDR 200] + 1;

if ([LDR 200] == [LDR 300)
{

SET([LM 0]);
break;

}
}

■ Example 5.2.1 Equal to

if ([LDR 100] == [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.2 Not equal to

if ([LDR 100] != [LDR 200])
{

[LDR 300] = 0x100;
}

■ Example 5.2.3 Less than

if ([LDR 100] < [LDR 200])
{

[LDR 300] = 0xl00;
}
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Operation description
If the value of LDR100 is less than or equal to the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than the value of LDR200, then 0x100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is greater than or equal to the value of LDR200, then 0x100 is stored in LDR300.

■ Example 5.2.4 Less than or equal to

if ([LDR 100] <= [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.5 Greater than

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}

■ Example 5.2.6 Greater than or equal to

if ([LDR 100] > [LDR 200])
{

[LDR 300] = 0xl00;
}
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Script

Operation description
If the value of LDR100 is equal to the value of LDR200, and if the value of LDR300 is equal to the value of LDR400 
and LDR500 added together, then 100 is stored in LDR600.
If either ([LDR 100] == [LDR 200]) or ([LDR 300] == [LDR 400] + [LDR 500]) is false, the processing in the brackets 
“{ }” is not executed.

Script

Operation description
If the value of LDR100 is not 0 or the value of LDR200 is not 0, then 100 is stored in LDR300.
If either is true, the processing in the brackets “{ }” is executed.

Script

Operation description
If the value of LDR100 is not equal to 0x1234, then 100 is stored in LDR300.

Script

Operation description
If the value of LDR100 is 0, then 100 is stored in LDR300.
This is the same as the code “if (0==[LDR 100]))”.

■ Example 5.3.1 Logical AND

if (([LDR 100] == [LDR 200]) && ([LDR 300] == [LDR 400] + [LDR 500]))
{

[LDR 600] = 100;
}

■ Example 5.3.2 Logical OR

if ((0 != [LDR 100]) || (0 != [LDR 200]))
{

[LDR 300] = 100;
}

■ Example 5.3.3 Logical inversion

if (!([LDR 100] == 0x1234))
{

[LDR 300] = 100;
}

■ Example 5.3.4 Logical inversion

if (!(0 !=[LDR 100]))
{

[LDR 300] = 100 ;
}
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5.4 Arithmetic Operators

Script

Operation description
The values of LDR100 and LDR200 are added together and the result is stored in LDR300.

Script

Operation description
The value of LDR200 is subtracted from the value of LDR100 and the result is stored in LDR300.

Script

Operation description
The values of LDR100 and LDR200 are multiplied together and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the result is stored in LDR300.

Script

Operation description
The value of LDR100 is divided into the value of LDR200 and the remainder is stored in LDR300.

■ Example 5.4.1 Addition

[LDR 300] = [LDR 100] + [LDR 200];

■ Example 5.4.2 Subtraction

[LDR 300] = [LDR 100] - [LDR 200];

■ Example 5.4.3 Multiplication

[LDR 300] = [LDR 100] * [LDR 200];

■ Example 5.4.4 Division

[LDR 300] = [LDR 100] / [LDR 200];

■ Example 5.4.5 Modulo

[LDR 300] = [LDR 100] % [LDR 200];
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5.5 Bitwise Operators

Script

Operation description
If the bitwise logical AND operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical AND operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
If the bitwise logical OR operation on the values of LM100 and LM101 is 1, LM200 changes to 1.
If the bitwise logical OR operation on the values of LM100 and LM101 is 0, LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The logical XOR operation on the value of LDR100 and each bit in 0xFF is stored in LDR200.
For example, if the value of LDR100 is 15 (0x0F), then LDR200 is 240 (0xF0).

■ Example 5.5.1 Logical AND

if ([LM 100] & [LM 101])
{

SET([LM 200)]);
}
else
{

RST([LM 200]);
}

LM100 LM101 LM200

■ Example 5.5.2 Logical OR

if ([LM 100] | [LM 101])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM101

LM200

■ Example 5.5.3 Logical XOR (exclusive OR)

[LDR 200] = [LDR 100] ^ 0xFF;
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Operation description
The bits in the value of LDR100 are flipped and stored in LDR200.
For example, if the value of LDR100 is 0, then LDR200 is 65535.

Script

Operation description
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 1, then LM200 changes to 1.
If the bitwise logical OR operation on the value of LM102 and the result of the bitwise logical AND operation on the 
value of LM100 and the inverted result of the value of LM101 is 0, then LM200 changes to 0.
The operation is the same as the following ladder diagram.

Script

Operation description
The value of LDR100 is shifted left by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 1 and the value of LDR200 is 3, 1 is shifted 3 bits to the left and the result 8 is 
stored in LDR300.

Script

Operation description
The value of LDR100 is shifted right by only the amount of the value of LDR200 and the result is stored in LDR300.
For example, if the value of LDR100 is 8 and the value of LDR200 is 3, 8 is shifted 3 bits to the right and the result 1 
is stored in LDR300.

■ Example 5.5.4 Inversion

[LDR 200] = ~[LDR 100];

■ Example 5.5.5 Inversion

if (([LM 100] & ~ [LM 101]) | [LM 102])
{

SET([LM 200]);
}
else
{

RST([LM 200]);
}

LM100

LM102

LM200LM101

■ Example 5.5.6 Left shift

[LDR 300] = [LDR 100] << [LDR 200];

■ Example 5.5.7 Right shift

[LDR 300] = [LDR 100] >> [LDR 200];
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Script

Operation description

Turns LM100 to 1. The result is the same as [LM 100] = 1.

Script

Operation description

Turns LM100 to 0. The result is the same as [LM 100] = 0.

Script

Operation description

Flips LM100 1 and 0. The result is the same as [LM 100] = ~[LM 100].

■ Example 5.6.1 Set a bit

SET([LM 100]);

■ Example 5.6.2 Reset a bit

RST([LM 100]);

■ Example 5.6.3 Invert a bit

REV([LM 100]);
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5.7 Word Functions

● Arithmetic operations

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the maximum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Out of the values stored in LDR100, LDR110, LDR120, LDR130, and LDR140, stores the minimum value in LDR200.
Up to 15 arguments can be used.

Script

Operation description
Calculates the exponential function of the value of D20 and the result is stored in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the natural logarithm of the value of D20 and the result is stored in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the logarithm of the value of D20 with 10 as the base and the result is stored in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the power of a value.
For example, when the value of D20 is 10 and the value of D30 is 5, the function calculates 10 to the power of 5 and 
stores the result in D10.
Only the data type float32 can be used.

■ Example 5.7.1 Maximum value

[LDR 200] = MAX([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.2 Minimum value

[LDR 200] = MIN([LDR 100], [LDR 110], [LDR 120], [LDR 130], [LDR 140]);

■ Example 5.7.3 Exponential function

[D 10] = EXP([D 20]);

■ Example 5.7.4 Natural logarithm

[D 10] = LOGE([D 20]);

■ Example 5.7.5 Common logarithm

[D 10] = LOG10([D 20]);

■ Example 5.7.6 Power

[D 10] = POW([D 20],[D 30]);
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Script

Operation description
Calculates the square root of the value of [D20] and the result is stored in [D10].
Only the data type float32 can be used.

Script

Operation description
Calculates the sine of the radian value of D20 and stores the result in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the cosine of the radian value of D20 and stores the result in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the tangent of the radian value of D20 and stores the result in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the arcsine of the value of D20 and stores the result as radians in D10.
Only the data type float32 can be used.

Script

Operation description
Calculates the arccosine of the value of D20 and stores the result as radians in D10.
Only the data type float32 can be used.

■ Example 5.7.7 Square root

[D 10] = ROOT([D 20]);

■ Example 5.7.8 Sine

[D 10] = SIN([D 20]);

■ Example 5.7.9 Cosine

[D 10] = COS([D 20]);

■ Example 5.7.10 Tangent

[D 10] = TAN([D 20]);

■ Example 5.7.11 Arcsine

[D 10] = ASIN([D 20]);

■ Example 5.7.12 Arccosine

[D 10] = ACOS([D 20]);
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Operation description
Calculates the arctangent of the value of D20 and stores the result as radians in D10.
Only the data type float32 can be used.

Script

Operation description
Converts the value of D20 from degrees (°) to radians and stores the result in D10.
Only the data type float32 can be used.

Script

Operation description
Converts the value of D20 from radians to  degrees (°) and stores the result in D10.
Only the data type float32 can be used.

■ Example 5.7.13 Arctangent

[D 10] = ATAN([D 20]);

■ Example 5.7.14 Convert angle to radians

[D 10] = RAD([D 20]);

■ Example 5.7.15 Convert radians to angle

[D 10] = DEG([D 20]);
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● Data type conversions

Script

Operation description
Converts the BCD value in LDR100 to a binary value and stores it in LDR200.
For example, if the BCD value 10 (16 as a binary value) is stored in LDR100, 10 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a BCD value and stores it in LDR200.
For example, if the binary value 16 (10 as a BCD value) is stored in LDR100, 16 (BCD value) is stored in LDR200.

Script

Operation description
Converts the float value in LDR100 to a binary value and stores it in LDR200.
For example, if the float value 1234 (0x449A4000 as a binary value) is stored in LDR100, 1234 (binary value) is stored 
in LDR200. If the float value 1234.56 (0x449A51EC as a binary value) is stored in LDR100, the value after the decimal 
point is discarded and 1234 (binary value) is stored in LDR200.

Script

Operation description
Converts the binary value in LDR100 to a float value and stores it in LDR200.
For example, if the binary value 1234 is stored in LDR100, the float value 1234 (0x449A4000 as a binary value) is 
stored in LDR200.

■ Example 5.7.16 Convert BCD to binary

[LDR 200] = BCD2BIN([LDR 100]);

■ Example 5.7.17 Convert binary to BCD

[LDR 200] = BIN2BCD([LDR 100]);

■ Example 5.7.18 Convert float32 to binary

[LDR 200] = FLOAT2BIN([LDR 100]);

■ Example 5.7.19 Convert binary to float32

[LDR 200] = BIN2FLOAT([LDR 100]);
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Operation description
Converts the decimal numeric value in LDR200 to a string and stores it in order with LDR100 as the starting address.

Converting 1234 (when the data type is BIN16+)

Converting -12345 (when the data type is BIN16+/-)

Converting 1234567890 (when the data type is BIN32+)

Converting -1234567890 (when the data type is BIN32+/-)

■ Example 5.7.20 Convert decimal to string

DEC2ASCII([LDR 100], [LDR 200]);

• This function can be used with data types BIN16(+), BIN16(+/-), BIN32(+), BIN32(+/-), BCD4, and 
BCD8.

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes are 
stored in the reverse of the following explanation.
For details, refer to Chapter 3 “3.1 System Tab” on page 3-19.

• A NULL terminating character (0x00) is added to the end of the string.

Device
Stored value

Device Stored value Upper byte Lower byte
LDR200 1234 LDR100 '1' = 0x31 '2' = 0x32

LDR101 '3' = 0x33 '4' = 0x34
LDR102 0x00 0x00

Terminating character

Device
Stored value

Device Stored value Upper byte Lower byte
LDR200 -12345 LDR100 '-' = 0x2D '1' = 0x31

LDR101 '2' = 0x32 '3' = 0x33
LDR102 '4' = 0x34 '5' = 0x35
LDR103 0x00 0x00

Terminating character

Device
Stored value

Device Stored value Upper byte Lower byte
LDR200

1234567890
LDR100 '1' = 0x31 '2' = 0x32

LDR201 LDR101 '3' = 0x33 '4' = 0x34
LDR102 '5' = 0x35 '6' = 0x36
LDR103 '7' = 0x37 '8' = 0x38
LDR104 '9' = 0x39 '0' = 0x30
LDR105 0x00 0x00

Terminating character

Device
Stored value

Device Stored value Upper byte Lower byte
LDR200

-1234567890
LDR100 '-' = 0x2D '1' = 0x31

LDR201 LDR101 '2' = 0x32 '3' = 0x33
LDR102 '4' = 0x34 '5' = 0x35
LDR103 '6' = 0x36 '7' = 0x37
LDR104 '8' = 0x38 '9' = 0x39
LDR105 '0' = 0x30 0x00

Terminating character
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Script

Operation description
Converts the stored string starting at LDR200 to a decimal and stores the result in LDR100.
The number of digits that can be converted is the maximum number of digits for each data type with added sign.
If the string to convert contains NULL or characters that cannot be converted to numeric values, the string is 
converted up to that character.

Setting the string “1234” (when the data type is BIN16+)

Setting the string “1234567” (when the data type is BIN16+)

Setting the string “-12345” (when the data type is BIN16+/-)

String “1234567890” (when the data type is BIN32+)

■ Example 5.7.21 Convert string to decimal

[LDR 100] = ASCII2DEC([LDR 200]);

• This function can be used with data types BIN16(+), BIN16(+/-), BIN32(+), BIN32(+/-), BCD4, and 
BCD8.

• Only internal devices can be used.
• When using functions that handle strings, check the Storage Method of string data setting on the 

System tab in the Project Settings dialog box. Depending on the setting, the upper and lower bytes are 
stored in the reverse of the following explanation.
For details, refer to Chapter 3 “3.1 System Tab” on page 3-19.

Device
Stored value

Upper byte Lower byte Device Stored value

LDR200 '1' = 0x31 '2' = 0x32 LDR100 1234

LDR201 '3' = 0x33 '4' = 0x34

LDR202 0x00 0x00
Terminating character

Device
Stored value

Upper byte Lower byte Device Stored value

LDR200 '1' = 0x31 '2' = 0x32 LDR100 12345

LDR201 '3' = 0x33 '4' = 0x34

LDR202 '5' = 0x35 '6' = 0x36

LDR203 '7' = 0x37 0x00
Terminating character

Device
Stored value

Upper byte Lower byte Device Stored value

LDR200 '-' = 0x2D '1' = 0x31 LDR100 -12345

LDR201 '2' = 0x32 '3' = 0x33

LDR202 '4' = 0x34 '5' = 0x35

LDR203 0x00 0x00
Terminating character

Device
Stored value

Upper byte Lower byte Device Stored value

LDR200 '1' = 0x31 '2' = 0x32 LDR100 - 101 1234567890

LDR201 '3' = 0x33 '4' = 0x34

LDR202 '5' = 0x35 '6' = 0x36

LDR203 '7' = 0x37 '8' = 0x38

LDR204 '9' = 0x39 '0' = 0x30

LDR205 0x00 0x00
Terminating character
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● Data comparison and copying

Script

Operation description
Compares the value of 10 words from LDR100 (up to LDR109) with the value of 10 words from LDR200 (up to 
LDR209).
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

Script

Operation description
Compares the third bit of LDR100 through the third bit of LDR109 with the state of the bits from LM0 to LM9.
If the value for each is entirely equal, 1 is stored in LDR0. If even a single one is not equal, 0 is stored.

■ Example 5.7.22 Word-unit data comparison

[LDR 0] = MEMCMP([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Compare each

LDR107 LDR207

Even if the data type is set to BIN32+, BIN32+/-, BCD8, or float32, the comparison is performed from the 
starting device in word units.

■ Example 5.7.23 Bit-unit data comparison

[LDR 0] = MEMCMP([LDR 100-2], [LM 0], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

Compare each

3rd bit of LDR107 LM7

Even if the data type is set to BIN32+, BIN32+/-, BCD8, or float32, the comparison is performed from the 
starting device in bit units.
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Operation description
Copies the value of 10 word devices from LDR200 (up to LDR209) to 10 word devices from LDR100 (up to LDR109).

Script

Operation description
Copies the third bit of 10 words from LDR100 (up to LDR109) to the bit state for 10 bits of devices from LM0 (up to LM9).

Script

Operation description
A value of 1 word length from I004 (I004 to I023) is copied to the bit states of a 1 word region from M0000 (M0000 
to M0017).

*1 Control function only

■ Example 5.7.24 Word-unit data copy

MEMCPY([LDR 100], [LDR 200], 10);

LDR100
LDR101
LDR102

LDR108
LDR109

LDR200
LDR201
LDR202

LDR208
LDR209

Copy each

LDR107 LDR207

Even if the data type is set to BIN32+, BIN32+/-, BCD8, or float32, the data is copied from the starting 
device in word units.

■ Example 5.7.25 Bit-unit data copy

MEMCPY([LM 0], [LDR 100-2], 10);

3rd bit of LDR100
3rd bit of LDR101
3rd bit of LDR102

3rd bit of LDR108
3rd bit of LDR109

LM0
LM1
LM2

LM8
LM9

3rd bit of LDR107LM7

Copy each

Even if the data type is set to BIN32+, BIN32+/-, BCD8, or float32, the bits are copied from the starting 
device in bit units.

■ Example 5.7.26 Copy 1 word from bit devices to bit devices*1

BITS2BITS(I004, M0000);

M0000
M0001

I004
I005

Copy each

M0017 I023



SmartAXIS Touch User’s Manual 20-43

5 Script Coding Examples

20

Script

Script

Operation description
A value of 1 word length from I004 (to I023) is copied to the value of device D0000.
This is the same as BITS2BITS(I004, D0000.0);.

Script

Operation description
The value of device D0100 is copied to the bit states of a value of 1 word length from M0000 (M0000 to M0017).
This is the same as BITS2BITS(D1000.0, M0000);.

*1 Control function only 

■ Example 5.7.27 Copy 1 word from bit devices to a word device*1

BITS2WORD(I004, D0000);

■ Example 5.7.28 Copy 1 word from a word device to bit devices*1

WORD2BITS(D0100, M0000);
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● String operations
When using functions that handle string data, check the Storage Method of string data setting in the project 
settings.
For details, refer to Chapter 3 “3.1 System Tab” on page 3-19.

Script

Operation description
Stores in order from LDR100 character count 3 (3 characters worth) from start position 2 (starting from 0, so the 3rd 
character) of the string “ABCDEFG” that starts from LDR200.

Copy from string “ABCDEFG” at start position 2, character count 3

Script

Copy from string “ABCDEFG” at start position 1, character count 4

*2 HMI function only

*2

■ Example 5.7.29 Copy a string

STRCUT([LDR 100], [LDR 200], 2, 3);

The start position can be specified in the range from 0 to 127, the character count can be specified in the 
range from 1 to 128.

STRUCT([LDR 100], [LDR 200], 1, 4);

Device Stored value Start 
position

Character 
count

Device Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'C' = 0x43

Lower byte 'B' = 0x42 1 Lower byte 'D' = 0x44

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'E' = 0x45

Lower byte 'D' = 0x44 3 Lower byte 0x00 Terminating character

LDR202
Upper byte 'E' = 0x45 4

Lower byte 'F' = 0x46 5

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

3 characters

Device Stored value Start 
position

Character 
count

Device Stored value

LDR200
Upper byte 'A' = 0x41 0

LDR100
Upper byte 'B' = 0x42

Lower byte 'B' = 0x42 ←1 Lower byte 'C' = 0x43

LDR201
Upper byte 'C' = 0x43 ←2

LDR101
Upper byte 'D' = 0x44

Lower byte 'D' = 0x44 3 Lower byte 'E' = 0x45

LDR202
Upper byte 'E' = 0x45 4

LDR102
Upper byte 0x00 Terminating character

Lower byte 'F' = 0x46 5 Lower byte 0x00

LDR203
Upper byte 'G' = 0x47 :

Lower byte 0x00 Terminating character

4 characters
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Operation description
Finds the length (character count) of the string starting from LDR200 and stores that in LDR100.

■ Example 5.7.30 Count a string

[LDR 100] = STRLEN([LDR 200]);

• The only devices that can be specified as function arguments in string operations are internal devices.
• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 

in the string length.)

Device Stored value Device Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 7
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 'D' = 0x44

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Device Stored value Device Stored value

LDR200
Upper byte 'A' = 0x41

LDR100 3
Lower byte 'B' = 0x42

LDR201
Upper byte 'C' = 0x43

Lower byte 0x00

LDR202
Upper byte 'E' = 0x45

Lower byte 'F' = 0x46

LDR203
Upper byte 'G' = 0x47

Lower byte 0x00

Character 
count

Terminating character

Character 
count

Terminating character
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Operation description
Concatenates the string starting from LDR200 to the string starting from LDR100.

■ Example 5.7.31 Concatenate strings

STRCAT([LDR 100], [LDR 200]);

• Only internal devices can be used.
• The NULL terminating character (0x00) is the end of the string. (The terminating character is not included 

in the string length.)

Device Stored value Device Stored value

LDR100
Upper byte 'A' = 0x41

LDR100
Upper byte 'A' = 0x41

Lower byte 'B' = 0x42 Lower byte 'B' = 0x42

LDR101
Upper byte 'C' = 0x43

LDR101
Upper byte 'C' = 0x43

Lower byte 0x00 Lower byte 'D' = 0x44

LDR102
Upper byte 'E' = 0x45

Device Stored value Lower byte 'F' = 0x46

LDR200
Upper byte 'D' = 0x44

LDR103
Upper byte 'G' = 0x47

Lower byte 'E' = 0x45 Lower byte 0x00 Terminating character

LDR201
Upper byte 'F' = 0x46

Lower byte 'G' = 0x47

LDR202
Upper byte 0x00

Lower byte 0x00

Concatenate
Terminating 
character

Terminating character
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Operation description
Searches for the search string “DEFG” that starts from LDR200 in the string to be searched “ABCDEFGHIJKLMNO” that 
starts from LDR100 and stores the position of the occurrence of the string in LDR0. If not found, -1 is stored in LDR0.

If “?” is specified as a character to search for, it is handled as an arbitrary single-byte character.
When specifying “?” (0x3F) as a character, specify it as “~?” (0x7E3F) in two bytes.
When specifying “~” (0x7E) as a character, specify it as “~~” (0x7E7E) in two bytes.

When searching for “DEFG” and the string was found

When searching for “WXYZ” and the string was not found

■ Example 5.7.32 Search a string

[LDR 0] = STRSTR([LDR 100], [LDR 200]);

• The maximum number for the search string is 128 characters.
• Only internal devices can be used.

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device Stored value Device Stored value Device Stored value

LDR200
Upper byte 'D' = 0x44

LDR100
Upper byte 'A' = 0x41 0

LDR0 3
Lower byte 'E' = 0x45 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'F' = 0x46

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 ←3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105

Upper 
byte 'K' = 0x47 10

Lower 
byte 'L' = 0x4C 11

LDR106

Upper 
byte 'M' = 0x4D 12

Lower 
byte 'N' = 0x4E 13

LDR107

Upper 
byte 'O' = 0x4F 14

Lower 
byte 0x00 Terminating character

Position

Search string String to be searched Search result
Device Stored value Device Stored value Device Stored value

LDR200
Upper byte 'W' = 0x57

LDR100
Upper byte 'A' = 0x41 0

LDR0 -1
Lower byte 'X' = 0x58 Lower byte 'B' = 0x42 1

LDR201
Upper byte 'Y' = 0x59

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'Z' = 0x5A Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

Position
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When searching for “?” as an arbitrary single-byte character

When searching for “?” as a character

When searching for “~” as a character

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device Stored value Device Stored value Position Device Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '?' = 0x3F Lower byte 'B' = 0x42 1

LDR201
Upper byte 'G' = 0x47

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'H' = 0x48 Lower byte 'D' = 0x44 3

LDR202
Upper byte 0x00 Terminating 

character LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Lower byte 'F' = 0x46 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device Stored value Device Stored value Position Device Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '?' = 0x3F

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48

LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Terminating 
character Lower byte '?' = 0x3F 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106

Upper 
byte 'M' = 0x4D 12

Lower 
byte 'N' = 0x4E 13

LDR107

Upper 
byte 'O' = 0x4F 14

Lower 
byte 0x00 Terminating character

tluser hcraeSdehcraes eb ot gnirtSgnirts hcraeS
Device Stored value Device Stored value Position Device Stored value

LDR200
Upper byte 'E' = 0x45

LDR100
Upper byte 'A' = 0x41 0

LDR0 4
Lower byte '~' = 0x7E Lower byte 'B' = 0x42 1

LDR201
Upper byte '~' = 0x7E

LDR101
Upper byte 'C' = 0x43 2

Lower byte 'G' = 0x47 Lower byte 'D' = 0x44 3

LDR202
Upper byte 'H' = 0x48

LDR102
Upper byte 'E' = 0x45 ←4

Lower byte 0x00 Terminating 
character Lower byte '~' = 0x7E 5

LDR103
Upper byte 'G' = 0x47 6
Lower byte 'H' = 0x48 7

LDR104
Upper byte 'I' = 0x49 8
Lower byte 'J' = 0x4A 9

LDR105
Upper byte 'K' = 0x47 10
Lower byte 'L' = 0x4C 11

LDR106
Upper byte 'M' = 0x4D 12
Lower byte 'N' = 0x4E 13

LDR107
Upper byte 'O' = 0x4F 14
Lower byte 0x00 Terminating character
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● Drawing

Script

Operation description
Draws a line connecting the start coordinates X=20, Y=20 and the end coordinates X=60, Y=60 on the screen where 
the script is running. The line has a line width of 3 (3 pixels), line type of 1 (solid line), and line color of 20 (red).

Script

Operation description
Draws a line connecting the start coordinates X=0, Y=0 and the end coordinates X=150, Y=100 on the screen where 
the script is running. The line width, line type, and line color have been omitted, so the line's line width is 1 (1 pixel), 
the line type is 1 (solid line), and the line color is 255 (white).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=20, Y=20 and 
the end coordinates (the coordinates of the rectangle's lower-right corner) X=100, Y=60 on the screen where the 
script is running. The rectangle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 24 (green), 
background color is 22 (yellow), pattern is 13 (tint), rounding type is 2 (curve), and rounding radius is 5 (5 pixels).

Script

Operation description
Draws a rectangle with the start coordinates (the coordinates of the rectangle's upper-left corner) X=0, Y=0 and the end 
coordinates (the coordinates of the rectangle's lower-right corner) X=150, Y=100 on the screen where the script is 
running. The line width, line type, foreground color, background color, pattern, rounding type, and rounding radius are 
omitted, so the rectangle's line width is 1 (1 pixel), line type is 1 (solid line), foreground color and background color is 
255 (white), pattern is 0 (none), rounding type is 0 (none), and rounding radius is 0 (0 pixels).

Script

Operation description
Draws a circle with the center coordinate X=100, Y=100, the X-axis radius 60 pixels, and the Y-axis radius 60 pixels. 
The circle's line width is 1 (1 pixel), line type is 2 (dotted line), foreground color is 26 (light blue), background color is 
0 (black), and pattern is 4 (foreground 50%).

Script

Operation description
Draws an ellipse with the center coordinate X=100, Y=100, the X-axis radius 80 pixels, and the Y-axis radius 40 pixels. 
The line width, line type, foreground color, background color, and pattern are omitted, so the ellipse's line width is 1 (1 
pixel), line type is 1 (solid line), foreground color and background color is 255 (white), and pattern is 0 (none).

*2 HMI function only

*2

■ Example 5.7.33 Draw a line

LINE(20, 20, 60, 60, 3, 1, 20);

■ Example 5.7.34 Draw a line (omitting arguments)

LINE(0, 0, 150, 100);

■ Example 5.7.35 Draw a rectangle

RECTANGLE(20, 20, 100, 60, 1, 2, 24, 22, 13, 2, 5);

■ Example 5.7.36 Draw a rectangle (omitting arguments)

RECTANGLE(0, 0, 150, 100);

■ Example 5.7.37 Draw a circle or ellipse

CIRCLE(100, 100, 60, 60, 1, 2, 26, 0, 4);

■ Example 5.7.38 Draw a circle or ellipse (omitting arguments)

CIRCLE(100, 100, 80, 40);
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● Indirect assignment

Script

Operation description
When the value of D20 is 8, the value of LDR18, the device 8 words from LDR10, is read and stored in LDR200.

Script

Operation description
When the value of D20 is 3, the constant 1234 is stored in LDR13, the device 3 words from LDR10.

■ Example 5.7.39 Indirect read

[LDR 200] = OFFSET([LDR 10],[D 20]);

Read

0000LDR10 0008D20

+8

1234LDR181234LDR200

■ Example 5.7.40 Indirect write

OFFSET([LDR 10],[D 20]) = 1234;

Write

0000LDR10 0003D20

+3

1234LDR131234
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This section describes important notes when defining a script.

6.1 Important Notes Regarding the While Definition

■ Define so it will not go into an infinite loop.
The execution expression is repeatedly executed while the conditional expression is satisfied.
However, it will go into an infinite loop when the conditional expression is satisfied continually.

In the conditional expression of the while definition, it states to exit the loop when the value of LDR100 turns 0. 
However, the value stored in the LDR100 is not changed after storing 10 in the first line of the script, so it will go into 
an infinite loop.

When using the while definition, define it so it will not go into an infinite loop.
The value of LDR100 will become 0 when the while definition is repeated 10 times in the next example, and it will get 
out of the while definition.

■ Define it so it will not continue the process for longer than the time limit.
In a script of HMI function when the processing of a single script continues for more than the time limit due to a while 
definition, etc., an execution time over error occurs and that script will be halted. Define the script so the execution 
time for one script does not exceed 3,000 milliseconds.
For details, refer to “1.4 Script Error of HMI Function” on page 20-4.

■ Do not write into the external device address.
In a script of HMI function, a script error occurs when writing to external device addresses in a while definition. 

6.2 Number of Devices That Can Be Used

Number of external device addresses that can be set in single script with WindO/I-NV3 are 64 for read device and 64 
for write device.
When the total number of write data to an external device address exceeds 64 in a single script while executing a 
script with Touch, that script will be halted with an error.

6 Important Notes

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
} 

[LDR 100] = 10;

while (0 != [LDR 100])
{

[LDR 200] = [LDR 200] + 1;
[LDR 100] = [LDR 100] - 1;

}
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6.3 Write Delay

In a script of HMI function the writing process to external device addresses is performed at the end of a script, so it 
may not operate correctly due to the write delay. 

Example where write delay occurs

Initial value of D100 is 0.
Since the write destination of 1000 in first line is the external device address, the value is not reflected immediately, 
and the value of D100 is still 0 when the second line is executed.
Therefore, the value where 5000 is added to 0 (value of D100) would be written to D200 in second line.
The value of D100 will be 1000 and the value of D200 will be 5000 when above script is executed.

There are 2 countermeasures for cases like this.

● Not using the device cache
Write delay does not occur when writing to the internal device, so the calculation is performed only in the internal 
device, and only the result will be written to the external device address.

● Using the device cache
Problems with the write delay to the external device address can be avoided by caching the value of the external 
device address into the internal memory. To use the device cache, setup as follows in WindO/I-NV3.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 In the System tab, click Advanced.

[D 100] = 1000;
[D 200] = [D 100] + 5000;

[LDR 0] = 1000;
[LDR 0] = [LDR 0] + 5000;
[D 200] = [LDR 0];



SmartAXIS Touch User’s Manual 20-53

6 Important Notes

20

Script

3 Select the Use Device Cache check box.

4 Click OK.

6.4 About the Priority of the Operator

As a basic rule, operators are calculated in order from left of the line, but when multiple calculations are combined, 
they are calculated in following priority.

This setting will be applied not only to the script, but to the whole project.

Priority Operator

High ()

! ~ -(Negative number)

* / %

+ -(Subtraction)

<< >>

&

^

|

< <= > >=

== !=

&&

||

Low =
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U
ser Accounts and the Security Function

This chapter describes user accounts and the Security function, how to configure them, and their operation on the 
Touch and in WindO/I-NV3.

  

1.1 User Accounts

The Security function protects access to data and Touch displays and operations using accounts. Accounts are the 
privileges to use the Touch and data. By assigning accounts to users, you can protect the Touch from being 
inappropriately operated and protect project data from alterations and misuse.
Accounts assigned to users are called user accounts.

In WindO/I-NV3, security groups are used as accounts.
There are two types of security groups. One type protects access to data. The other type protects Touch displays and 
operations. To protect access to data, assign one of the provided security groups to a user. To protect Touch 
displays and operations, assign a user-created security group to a user.

A user name and password are associated with a user account and up to 15 user accounts can be created.

If you configure a password for a user account assigned to a security group, access to data and Touch displays and 
operations are password protected.
For password protected operations, users are prompted to enter their user name and password as necessary on the 
Touch Password screen or the WindO/I-NV3 Enter Password dialog box.

Chapter 21 User Accounts and the Security Function

1 Overview

Password screen Enter Password dialog box

User

Assign

Account

User account

Privileges to operate the Touch

Privileges to access data

Assign Assign

Provided security groups User-created security 
groups (12 max)

Protect displays and operationsProtect data

Administrator

Operator

Reader

GroupA

GroupB

User account: User account:

User4User3 User15User2User1

11111111 22222222 33333333 44444444 EEEEEEEEPassword:

User name:

User account:

Password

ENT

↑

↓

→←

▼User
********

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

If a password is not configured for a user account, access to data and Touch displays and operations cannot 
be protected.
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1.2 Protecting Data

● Protecting Access to Data
Security groups that protect access to data can perform the following functions.

• Protect from changes by editing project data

• Protect from alterations or misuse by downloading data

• Protect from the loss of data by upload

The Enter Password dialog box is displayed.

Opening project data

USB flash drive

TouchComputer

The Enter Password dialog box is displayed.

Download

Download

Recipe files

Project data

Computer

USB flash drive

Touch

Upload

Upload
The Enter Password dialog box is displayed.

Alarm Log data
Data Log data
Operation Log data
Recipe files

Project data
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• Protect from data erasures and formatting external memory by unauthorized access

• Protect from alterations and misuse by changing to the System Mode

• Protect from unauthorized browsing by displaying Device Monitor

• Protect from the loss of data or alterations by the execution of the USB Autorun function

Computer

USB flash drive

TouchDeleting data

The Enter Password dialog box is displayed.

Deleting data
Formatting

The Password screen is displayed.

Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

TouchTouch

The Password screen is displayed.

Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

TouchTouch

USB flash drive

Touch

The Password screen is displayed.

Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

Touch
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● Security Groups that Protect Access to Data
Three security groups have been provided to protect access to data. These security groups are Administrator, 
Operator, and Reader. Each one of these security groups can only be assigned to a single user.

■ Administrator
The Administrator group possesses complete access rights to project data. This security group can execute all 
necessary operations including editing project data and changing Touch project data.

■ Operator
The Operator group can partially change project data by changing values of devices. This security group download 
data to external memory.

■ Reader
The Reader group can read data stored on external memory.

● Operations Subject to Password Protection
If you configure a password for a user account assigned to a security group to protect access to data, access to data 
is password protected. The operations that are subject to password protection and the security group that the 
password is valid for are as follows.

*1 External memory inserted into the Touch

The provided user account has the security groups Administrator, Operator, and Reader allocated to it. 
Passwords have not been configured for this user account. To protect access to data, a password must be 
configured for the user account.

User1

Provided security groups

Administrator

Operator

Reader

Operations subject to password protection
Security group that the password is valid for

Administrator Operator Reader

Data editing
Opening projects YES NO NO

Reusing screens YES NO NO

Modifying data

Downloading project data YES NO NO

Downloading data to external memory*1 YES NO NO

Downloading data to external memory*1 while the 
Touch is running

YES YES NO

Uploading project data YES NO NO

Uploading external memory data*1 YES YES YES

Deleting all data YES NO NO

Deleting external memory data*1 YES NO NO

Formatting external memory*1 YES NO NO

Switching to the Top Page in the System Mode YES NO NO

Displaying Device Monitor YES YES NO

Executing the USB Autorun function YES NO NO

To password protect operations, the lowest level security group out of the security groups enabled with a 
password must be assigned to a user account.
The security levels, from highest to lowest, are Administrator > Operator > Reader.
Example: To password protect the operation to display Device Monitor, assign the Operator security group 

to a user account. If a user account assigned to the Operator security group does not exist, the 
operation is not password protected.
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1.3 Protecting Displays and Operations

● Displays and Operations that can be Protected with the Security Function
Security groups can be assigned to users to protect Touch displays and operations. These groups are capable of the 
following actions.

• Protecting the display of screens

• Protecting the display of parts

• Protecting the operation of parts

Switch user account.Goto Screen Button 
(Switch to Base Screen 2)

No user

The Password 
screen is displayed.

Base Screen 2 is 
displayed.

Full

Tank 1
Base Screen 1

User2
User2

Password

ENT

▼User2

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

********

TouchTouchTouch

Base Screen 2 

Cannot be 

displayed

Base Screen 2 

Can be displayed

Switch user account.

The Password 
screen is displayed.

Line Chart is 
displayed.

Goto Screen Button
(Open Password Screen)

Line Chart that can only be displayed with User2

User2
User2

No user

Password

ENT

▼User2

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

********

TouchTouchTouch

Line Chart

Can be displayed
Line Chart

Cannot be 

displayed

Switch user account.

The Password screen 
is displayed.

The Numerical Input 
can be operated.

Goto Screen Button
(Open Password Screen)

Numerical Input that can only be operated by User2

User2
User2

999999 999

999

No user

Password

▼User2

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

********

TouchTouchTouch

Numerical Input

Can be operated

Numerical Input

Can be operated
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● Security Groups that Protect Touch Displays and Operations
The security groups that protect the display and operation of screens and parts are user-created. Only the user 
accounts assigned to the same security group as the security group configured for the screens and parts can display 
and operate those screens and parts.
The security group for screens and parts is configured in the Options tab in the Properties dialog box for the screen 
or part. The input security group to protect operations can only be configured for parts with an input function.

Example: If the user and security group for the part are set as follows:

If the password screen is opened and the user switches to User2 in GroupA, the parts for GroupA are displayed. The 
parts for GroupB cannot be operated.

If the password screen is opened and the user switches to User3 in GroupA and GroupB, the parts for GroupA are 
displayed and the parts for GroupB can be operated.

User Name

Security Group GroupA GroupA, GroupB GroupB

User2 User3 User4

Touch

999

Default user: None

Line Chart and Bar Chart
Display: GroupA

Button
Display: GroupA
Input: GroupB

Goto Screen Button (Open Password Screen)
Display: None
Input: None

Numerical Input
Display: None
Input: GroupB

Touch Touch Touch

User2

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User2.

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated.

With User2, GroupA parts are 
shown, GroupB parts cannot be 
operated.

999 999 999999
Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9Cannot be 

operated
Cannot be 
operated

DisplayedNot 
displayed

With User3, GroupA parts are 
shown, GroupB parts can be 
operated.

User3

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated.

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User3.

999 999 999

999
Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9Cannot be 

operated
Can be 
operated

DisplayedNot 
displayed

Parts that are not displayed on the screen cannot be operated regardless of the input security group.
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If the password screen is opened and the user switches to User4 in GroupB, only the displayed parts for GroupB can 
be operated. The GroupA parts are not displayed.

Touch Touch Touch

User4

With User4, GroupA parts are 
hidden, displayed GroupB parts 
can be operated.

With no user, GroupA parts 
are hidden, GroupB parts 
cannot be operated.

Open the password screen with the Goto 
Screen Button, enter the password, and 
switch to User4.

999 999 999

999

999999
Password

ENT

▼User

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

Can be 
operated

Not 
displayed

Cannot be 
operated

Not 
displayed

GroupA is not configured for User4, so the button in the lower right of the screen is not displayed. Parts that 
are not displayed on the screen cannot be operated, even by the user configured with the input security 
group.
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This section describes the configuration procedure for the Security function.

2.1 Creating and Editing User Accounts

● Creating a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The User Accounts dialog box is displayed.

2 Select the Use Security functions check box.

The settings related to user accounts are displayed.
The user account already provided with WindO/I-NV3 is as follows.

2 Security Function Configuration Procedure

No.: 1

User Name: User

Password: (blank)

Security Group: Administrator, Operator, Reader
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3 Click Add.
The New User Account dialog box is displayed.

4 Specify the user number (1 to 15) in No.
This number is used when switching the user account according to the value of device.

5 Enter the name for the new user in User Name.
The maximum number for the user name is eight characters. Only alphanumeric characters and symbols can be used.

6 Enter the password in Password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be 
used.

7 Click the Group Membership tab.
Assign the security groups to the user being created.
Administrator, Operator, and Reader have already been provided in Security Group. These three security 
groups cannot be used in multiple user accounts. To use them with the user account being created, delete the 
security group from the user account they are assigned to beforehand.

If you will not add a new security group, proceed to step 11.

If you will not assign a security group, proceed to step 12.

You cannot use the following characters in the user name.
\ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place. 

User3User2User1

Administrator AdministratorOperator

Reader
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8 Click Add.
The New Security Group dialog box is displayed.

9 Enter the name of the new group in New Group, and then click << Add.
The maximum number for the group name is 15 characters.
The created group name is added to Security Group. Repeat this procedure to create multiple security groups.

10 Click OK.
The group added is displayed in Security Group.

11 Select the security groups in Security Group on the New User Account dialog box to assign to the user being 
created, and then click << Copy.
The security groups are copied to To.
The security groups that you create can be used in multiple user accounts.

To delete the security groups assigned to the user, select the security groups to delete in To, and then click Delete.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.

User3 User4User2User1

Created security 
groups (12 max)

GroupA

GroupB

GroupC

GroupC

GroupB GroupB GroupC

Multiple user accounts can use the same security groups.

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group, and then click Delete to delete the security groups. 

However, security groups configured for user accounts, screens, and parts cannot be deleted.
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12 Click OK.
If you will not continue creating a user account, proceed to step 14.

13 Repeat steps 3 through 12 and create all of the necessary user accounts.

14 Click OK.
The User Accounts dialog box closes.
This concludes creating a user account.

You can configure a user account to be enabled when the Touch power is turned on and when switching the 
Run Mode in Default User.
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● Editing a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The User Accounts dialog box is displayed.

2 Select the user account to edit, and then click Edit.

The Change User Account dialog box is displayed.

3 On the General tab, change User Name and Password.



SmartAXIS Touch User’s Manual 21-13

2 Security Function Configuration Procedure

21

U
ser Accounts and the Security Function

4 Click the Group Membership tab.

Change the security groups assigned to the user.

If you will not assign a security group or you will not delete a security group, proceed to step 7.

5 Select the security groups in Security Group to assign to the user being edited, and then click << Copy.

The security groups are copied to To.

If you will not delete a security group, proceed to step 7.

6 Select the security groups assigned to the user to delete in To, and then click Delete.

The security groups are deleted from To.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.
• Select the security groups in Security Group, and then click Delete to delete the security groups. 

However, security groups configured for user accounts, screens, and parts cannot be deleted.
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7 Click OK.

8 Click OK to close the User Accounts dialog box.

This concludes editing a user account.

● Deleting a User Account

1 On the Configuration tab, in the Protect group, click User Accounts.

The User Accounts dialog box is displayed.

2 Select the user account to delete, and then click Remove.

The user account is deleted.

3 Click OK.

The User Accounts dialog box closes.
This concludes deleting a user account.
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2.2 Adding and Editing Security Groups

● Adding a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Enter the name of the new group in New Group, and then click << Add.

The maximum number for the group name is 15 characters.
The created group name is added to Security Group. Repeat this procedure to create multiple security groups.

3 Click OK.

The Security Group Settings dialog box closes.
This concludes adding a security group.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.
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● Changing the Name of a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Select the security group in Security Group to change the name of, and then click Rename.

The Change Security Group Name dialog box is displayed.

3 Change the name of the security group to the new group name in New Name.

The maximum number for the group name is 15 characters.

4 Click OK.

The Change Security Group Name dialog box closes.

5 Click OK.

The Security Group Settings dialog box closes.
This concludes changing the name of a security group.

The group name for Administrator, Operator, and Reader cannot be changed.

“ ” (Japanese), “None” (English), and “ ” (Chinese) cannot be used for the group name.
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● Deleting a Security Group

1 On the Project window, double click Security Group Settings.

The Security Group Settings dialog box is displayed.

2 Select the security group in Security Group to delete, and then click Delete.

The security group is deleted.

3 Click OK.

The Security Group Settings dialog box closes.
This concludes deleting a security group.

To select multiple security groups, press and hold SHIFT or CTRL while you click the specific items.

• Security groups configured for user accounts, screens, and parts cannot be deleted.
• Administrator, Operator, and Reader cannot be deleted.
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2.3 Protecting the Display and Operation of Screens and Parts

● Protecting the Display of Screens
Here you will configure the security group for a screen to protect the display of that screen.
This section describes an example where the display of Base Screen 2 is protected when switching to Base Screen 2 
by pressing the Goto Screen Button.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-8, create the following user account.

To automatically display the Password screen when the user attempts to switch to a Base Screen they cannot access 
with the current user account using the Goto Screen Button, in the User Accounts dialog box, in the Options tab, 
select the Require a password automatically check box. For displaying the Password screen, refer to “4.1 
Entering the Password on the Touch” on page 21-36.

User2

Goto Screen Button
(Switch to Base Screen 2) Full

Tank 1
Base Screen 1 Base Screen 2

No user

TouchTouch

Base Screen 2

Can be displayed

Base Screen 2

Cannot be 

displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2
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2 Place a Goto Screen Button on Base Screen 1.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

3 Click a point on the edit screen where you want to place the Goto Screen Button.

4 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

5 Select Switch to Base Screen for Action Mode.

6 Specify the screen number of the Base Screen to switch to with Screen No. under Goto Screen.

2 is specified here.

7 Click OK.

The Properties of Goto Screen Button dialog box closes.
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8 Create the Base Screen to switch to and configure the security group.
On the Home tab, in the Screens group, click the arrow under New, and then click Base Screen.
The Screen Properties dialog box is displayed.

9 Specify the screen number of the Base Screen to switch to with No. on the General tab.
This is the same screen number as the screen number specified in step 6. 2 is specified here.

10 Click the Options tab.
 

11 With Security Group, select the security group to allow the display of the Base Screen.
GroupA is selected here.

12 Configure the settings on each tab as necessary, and then click OK.
The Screen Properties dialog box closes.
This concludes configuring the project to protect the display of screens.
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Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Switch to Base Screen.

The Password screen is displayed.

2 Press ▼ and select User2.

3 Enter the password.

1. Press ↑, ↓, ←, and → to move the cursor to the character selected and then press ENT.

2. Repeat 1 to enter all the characters for the password.
3. Press ↑, ↓, ←, and → to move the cursor to OK and then press ENT.

If the correct password is entered, the user account changes to User2 and the Password screen closes.
Base Screen 2 is displayed.

Press the Goto Screen Button.
Base Screen 1

No user

Touch

Password

ENT

▼User2

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

Password

ENT

▼User2

*

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9 1 2

Password

ENT

▼User2

********

BS CLR

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

OK
1 2

User2

Full

Tank 1
Base Screen 2

Touch
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● Protecting the Display of Parts
Here you will configure the security group for a part to protect the display of that part.
This section describes an example where the display of the Line Chart is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-8, create the following user account.

2 Create a Line Chart and configure the display security group.
On the Home tab, in the Parts group, click Charts, and then click Line Chart.

3 Click a point on the edit screen where you want to place the Line Chart.

4 Double-click the dropped Line Chart and the Properties dialog box is displayed.

Goto Screen Button
(Open Password Screen)

User2
No user

TouchTouch

Line Chart

Can be displayed

Line Chart

Cannot 

be displayed

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA

User2



SmartAXIS Touch User’s Manual 21-23

2 Security Function Configuration Procedure

21

U
ser Accounts and the Security Function

5 Click Advanced.

The Options tab is displayed.

6 Click the Options tab.

7 Select the security group to allow the display of the Line Chart with Display under Security Group.

GroupA is selected here.

8 Configure the settings on each tab as necessary, and then click OK.

The Properties of Line Chart dialog box closes.
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9 Place a Goto Screen Button to display the password screen on the Base Screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

10 Click a point on the edit screen where you want to place the Goto Screen Button.

11 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

12 Select Open Password Screen for Action Mode.

13 Specify the display location in coordinates for the password screen to open above the Base Screen with Coordinates 
X, Y.
With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)
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14 Click OK.
The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the display of a part.

Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.

The Password screen is displayed.

2 Press ▼ and select User2.

3 Enter the password.

1. Press ↑, ↓, ←, and → to move the cursor to the character selected and then press ENT.

2. Repeat 1 to enter all the characters for the password.
3. Press ↑, ↓, ←, and → to move the cursor to OK and then press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Line Chart is displayed.

Press the Goto Screen Button.

No user

Touch

Password

ENT

▼User2

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

Password

ENT

▼User2

*

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9 1 2

Password

ENT

▼User2

********

BS CLR

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

OK
1 2

User2

Touch
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● Protecting the Operation of Parts
Here you will configure the security group for a part to protect the operation of that part.
This section describes an example where the operation of the Numerical Input is protected.

Configuration Procedure

1 Following the procedure in “Creating a User Account” on page 21-8, create the following user account.

2 Create a Numerical Input and configure the input security group.
On the Home tab, in the Parts group, click Data Displays, and then click Numerical Input.

3 Click a point on the edit screen where you want to place the Numerical Input.

4 Double-click the dropped Numerical Input and the Properties dialog box is displayed.

Goto Screen Button
(Open Password Screen)

User2
No user

999999 999

TouchTouch

Numerical Input

Can be operated

Numerical Input

Cannot be 

operated

The keypad is not displayed, 

nothing can be operated.

To change the user account, a button or command is required to open the Password screen.

User Name

Security Group GroupA
User2
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5 Click Advanced.

The Options tab is displayed.

6 Click the Options tab.

7 Select the security group to allow the operation of the Numerical Input with Input under Security Group.

GroupA is selected here.

8 Configure the settings on each tab as necessary, and then click OK.

The Properties of Numerical Input dialog box closes.
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9 Place a Goto Screen Button to display the password screen on the Base Screen.
On the Home tab, in the Parts group, click Buttons, and then click Goto Screen Button.

10 Click a point on the edit screen where you want to place the Goto Screen Button.

11 Double-click the dropped Goto Screen Button and the Properties dialog box is displayed.

12 Select Open Password Screen for Action Mode.

13 Specify the display location in coordinates for the password screen to open above the Base Screen with Coordinates 
X, Y.
With the upper-left corner of the screen as the origin, the upper-left corner of the window is the X and Y coordinates.

X: 0 to (Base Screen horizontal size - 1)

Y: 0 to (Base Screen vertical size - 1)
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14 Click OK.

The Properties of Goto Screen Button dialog box closes.
This concludes configuring the project to protect the operation of a part.

Operating Procedure

This section describes an example when the current user account has no default user.

1 Press the Goto Screen Button configured with Open Password Screen.
The Password screen is displayed.

2 Press ▼ and select User2.

3 Enter the password.

1. Press ↑, ↓, ←, and → to move the cursor to the character selected and then press ENT.

2. Repeat 1 to enter all the characters for the password.
3. Press ↑, ↓, ←, and → to move the cursor to OK and then press ENT.

If the correct password is entered, the user account changes to User2 from no default user and the Password screen 
closes.
The Numerical Input can be operated.

Press the Goto Screen Button.

No user

999

Touch

Password

ENT

▼User2

BS CLR OK

A B C D E F G H I J K L M
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Password
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BS CLR OK
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Password
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▼User2

********
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OK
1 2

User2

999999

Touch
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This section describes items and buttons on the User Accounts dialog box.

3.1 User Accounts Dialog Box

The passwords and security groups assigned to user accounts are collectively managed in the User Accounts dialog 
box.

● General Tab

■ Use Security functions
Select this check box to protect access to data and to protect Touch displays and operations by accounts. The settings 
related to user accounts are displayed.
When this check box is cleared, switching to System Mode, displaying the monitor, and accessing data are protected 
by a single password. The SmartAXIS Touch is not protected if Password is left blank.

3 User Accounts Dialog Box

User Name: Enter the name for the user account.
The maximum number for the user name is eight characters. Only alphanumeric characters and 
symbols can be used.

You cannot use the following characters in the user name.
\ / : * ? “ < > |

Password: Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters 
and numbers can be used.

Write down the password so you do not forget it and save that note in a safe place.
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■ Users for this project

■ Add
Makes a new user account. You can create a maximum of 15. Click this button to display the New User Account dialog 
box. In the New User Account dialog box, the user name, password, and security groups are assigned to the user 
account. For details, refer to “New User Account Dialog Box and Change User Account Dialog Box” on page 21-32.

■ Edit
Select a number in Users for this project, and then click this button to display the Change User Account dialog box. 
In the Change User Account dialog box, the user name, password, and security groups are changed. For details, refer 
to “New User Account Dialog Box and Change User Account Dialog Box” on page 21-32.

■ Remove
Deletes the user account with the selected number. Select a number, and then click this button.

■ Default User
Select the user account to be enabled when the Touch power is turned on and when switching the Run Mode.
If None is selected, no user account is selected when the Touch power is turned on and when the Run Mode is 
changed. Screens and parts cannot be displayed or operated that are protected by a security group.

No.: Displays the number (1 to 15) used when switching the user account according to the value of 
device. Double clicking the cell displays the Change User Account dialog box. For details, refer 
to “New User Account Dialog Box and Change User Account Dialog Box” on page 21-32.

User Name: Displays the name for the user account. Double clicking the cell displays the Change User 
Account dialog box. For details, refer to “New User Account Dialog Box and Change User 
Account Dialog Box” on page 21-32.

Password: Displays the password for the user account. Double clicking the cell displays the Change User 
Account dialog box. For details, refer to “New User Account Dialog Box and Change User 
Account Dialog Box” on page 21-32.

Security Group: Displays all of the security groups for user accounts. Double clicking the cell displays the 
Change User Account dialog box. For details, refer to “New User Account Dialog Box and 
Change User Account Dialog Box” on page 21-32.
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New User Account Dialog Box and Change User Account Dialog Box

In the New User Account dialog box, the user name, password, and security groups are assigned to an account and 
that user account is added.
In the Change User Account dialog box, the user name, password, and security groups for the selected user account 
are changed.

General Tab

■ No.
In the New User Account dialog box, this setting specifies the number (1 to 15) when switching the account according 
to the value of device.
When Edit was clicked and the Change User Account dialog box was displayed, this item displays the selected user 
account number.

■ User Name
Enter the name for the user account.
The maximum number is eight characters. Only alphanumeric characters and symbols can be used.

■ Password
Enter the password.
The number of characters for the password is 4 to 15. Only uppercase alphabetic characters and numbers can be 
used.

You cannot use the following characters in the user name.
\ / : * ? “ < > |

Write down the password so you do not forget it and save that note in a safe place.
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Group Membership Tab

■ To: (user name being configured)
Displays the user name and the list of security groups assigned to the user.

■ << Copy
Assigns the security groups to the user displayed in To.
Select the security groups in Security Group, and then click this button to add them to To.

■ Delete
Deletes the security groups assigned to the user.
Select the security groups in To, and then click this button.

■ Security Group
Displays a list of all the security groups. The provided security groups (Administrator, Operator, and Reader) are 
grayed out if assigned to another user account.

■ Add
Makes a new security group. You can create a maximum of 12.
Click this button to display the New Security Group dialog box. New security groups are added in the New Security 
Group dialog box. For details, refer to “Adding a Security Group” on page 21-15.

■ Rename
Select a security group in Security Group, and then click this button to display the Change Security Group Name 
dialog box. Change the name of the security group in the Change Security Group Name dialog box. For details, refer 
to “Changing the Name of a Security Group” on page 21-16.
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● Options Tab
These settings can only be configured when the Use Security functions check box is selected on the General tab.

■ Change User by Device
Select this check box to switch the user account according to the value of device.
The user account is specified by using the number on the General tab.

Example: When the trigger device is D0 and the default user is selected as User1

The user account switches according to the value of device.

■ Back to Default User
Select this check box to automatically switch to the default user when the Touch is unused for an extended period of 
time.

(Trigger device): Specifies the word device to write the number.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

1 2 3No.

User Name User3User2User1
(Default user)

0

User account

Value of Trigger device D0

Switch to default 
user account

1

Switch to user 
account no. 1

2

Switch to user 
account no. 2

3

Switch to user 
account no. 3

4

NoneAction

User3 User3User2User1 User1

The user account is not switched when the 
value of device is a number not configured to 
a user account or an invalid number.

If the value of device is 0, 
the user is switched to the 
default user.

After: Specify the time (0 to 60 minutes) to switch to the default user after the Touch is last used.
If 0 is set, the Touch switches back to the default user immediately, even if the user account was 
changed.



SmartAXIS Touch User’s Manual 21-35

3 User Accounts Dialog Box

21

U
ser Accounts and the Security Function

■ Status of Password Entry
Select this check box to monitor the entry status of the password on the Password screen.

The following bits change to 1 depending on the password input status. These bits become 0 when the Password 

screen opens or when a button other than ENT or  (Close) is pressed on the Password screen.

■ Require a password automatically
Select this check box to automatically display the Password screen when the user attempts to switch to a Base Screen 
that cannot be accessed with the current user account by using a Goto Screen Button or Goto Screen Command 
configured with Switch to Base Screen for the Action Mode in the Properties dialog box.

(Destination device): Specifies a word device to write the password entry status.

Click  to display the Device Address Settings dialog box. For the device address 
configuration procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Bit 
position

Function Parameters

0
This bit stores the information when the correct password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Correct password entered

1
This bit stores the information when an incorrect password was 
entered on the Password screen and ENT was pressed.

0: Password being entered
1: Incorrect password entered

2 This bit stores the information when  (Close) was pressed on 

the Password screen.

0: Password being entered
1: Password entry canceled

3 to 7 Reserved –
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When a password is configured for a user account, the user is prompted to enter their password with the following 
operations.
• Accessing password protected data
• Executing password protected displays and operations

4.1 Entering the Password on the Touch

To execute password protected operations, the user must open the Password screen and switch the user account.
The Password screen is opened with a Goto Screen Button or Goto Screen Command configured with Password 
Screen. The Password screen is also automatically displayed on the Touch when the following operations are 
executed.
• Switching to a Base Screen for a security group that cannot be displayed by the current user account with the Goto 

Screen Button, Multi-Button, Goto Screen Command, or Multi-Command when the Require a password 
automatically check box is selected on the Options tab in the User Accounts dialog box

• Switching to Top Page in the System Mode or displaying the Device Monitor with the Maintenance screen, Goto 
Screen Button, Multi-Button, Goto Screen Command, or Multi-Command

• Downloading or uploading project data  with a Key Button, Multi-Button, or Multi-Command
• Executing the USB Autorun function

4 Password Input

• Operations where the Password screen is not displayed are as follows.
- Switching the Base Screen using the System Area
- Displaying the alarm screen for the Alarm Log Settings
- Opening the keypad with the Numerical Input or Character Input
- Opening the Ref. screen with the Alarm Log Display
- For screens that are already open when the user account was switched by opening the Password screen 

with the Goto Screen Button or Goto Screen Command
• When the user account is switched, the displayed Base Screen is reset. Popup screens and internal 

devices have the same behavior as when the Base Screen is switched. However, if the Close while 
changing Base Screen check box is selected on the Options tab in the Properties dialog box for the 
popup screen, the popup screen is closed when the Base Screen is switched. The behavior of the internal 
devices varies based on the internal devices. For details, refer to Chapter 27 “Internal Devices” on page 
27-1.

• When the Touch has been installed vertically, the password screen is displayed horizontally.
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● Password Screen Configuration

■ User Name
Displays the selected user name.

■ ▼
Switches the user name. Changes the user name in order of user account number. When the last user name is 
changed, it returns to the first user name.

■ Password
The entered password is displayed as “*”.

■ Key list

■
Moves the character list cursor up.

■
Moves the character list cursor left.

■
Moves the character list cursor right.

■
Moves the character list cursor down.

■ ENT
Enters the selected character in Password or executes the selected command.

■  (Close) button

Cancels password entry and closes the Password screen.

Password

ENT

▼User

********

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U VWX Y Z
0 1 2 3 4 5 6 7 8 9

User Name

Close button

Password

Key list

Cursor

Cursor Highlights the selected character or command.

A to Z, 0 to 9: The available characters which can be used in the Password. Select with the cursor and press ENT 
to enter the selected character in Password.

: Select with the cursor and press ENT to delete one character entered in Password.

: Select with the cursor and press ENT to delete all the characters entered in Password.

: Select with the cursor and press ENT to confirm the entered password and start verifying the user 
name and password.
If the entered password is correct, the Password screen closes and the operation executes.
If the entered password was incorrect, the password entered on the Password screen is deleted and 
the screen returns to input mode.

↑

↑

↑

↑
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4.2 Entering the Password in WindO/I-NV3

When a user account assigned with Administrator is configured with a password, the Enter Password dialog box is 
displayed in WindO/I-NV3 as required and the user is prompted to enter their password.
The operations that display the Enter Password dialog box are as follows.
• Opening projects
• Reusing screens
• Downloading project data
• Downloading data to external memory*1

• Downloading data to external memory*1 while the Touch is running
• Uploading project data
• Uploading external memory data*1

• Deleting all data
• Deleting external memory data*1

• Formatting external memory*1

● Enter Password Dialog Box

■ User Name
Selects the user name. This item can only be selected when multiple user accounts are registered.

■ Password
Enter the password. The entered password is displayed as “*”.

■ OK
Confirms the entered password and starts verifying the user name and password.
If the entered password is correct, the Enter Password dialog box closes and the operation executes.
If the entered password is incorrect, a confirmation message is displayed.

■ Cancel
Cancels password input and closes the Enter Password dialog box.

*1 External memory inserted into the Touch
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This chapter describes the communication between the Touch and the external device.

  

1.1 Overview

PLC Link Communication refers to the communiation protocol used for communication with the Touch, via the CPU 

Unit*1 or PLC Link Unit*1 Programming Port of the external device connected to the Touch.
The Touch continuously reads the value of device of external devices on the currently displayed screen, and external 
devices (such as relays and registers) on the screens are updated with the latest data at all times.
When a button is pressed or a command is executed in the Touch screen, the value is written to the external device.

*1 Unit names vary based on the manufacturer of the external device. 

Chapter 22 Communication

1 PLC Link Communication

Touch

1234

External device

PLC Link Commuication

0 1

Read

Write

D0:

M0:

1234
Numerical Display
Reference Device: D0

Bit Button
Destination Device: M0

For details regarding the PLC Link Communication, refer to Chapter 1 "PLC Link Communication" and 
Chapter 2 "Connection to a PLC" in the "External Device Setup Manual".
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● PLC Link Connection Types
There are two basic types of connections. 1:1 Communication, where an external device is connected to a Touch; and 
1:N Communication, where multiple external devices are connected to a Touch. 

■ 1:1 Communication
The Touch is connected to a single external device.

■ 1:N Communication
The Touch is connected to multiple external devices.

1.2 PLC Link Communication Settings

The external devices connected to the Touch and connection types are selected on the Select Communication Driver 
dialog box, or the Change Communication Driver dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 3 “Create new project data by using the interactive quick start” on page 3-1.

• Click Communication Driver on the status bar to display the Change Communication Driver dialog box. For 
details, refer to Chapter 3 “Changing Communication Drivers” on page 3-15.

Specify Manufacturer and Communication Driver for each CPU Unit*1 or each PLC Link Unit*1 of the external 
device. For details regarding the correspondence model, refer to the "External Device Setup Manual."

*1 Unit names vary based on the manufacturer of the external device.

Touch External device

Read

Write

PLC Link Communication

Touch

Station No.1

Station No.2

Station No.3

External device
Read

Write

Read

Write

Read

Write

PLC Link Communication
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2.1 Overview

O/I Link Communication is a protocol for communication between Master and Slave, where a Touch connected to the 
external device is configured as a Master and multiple Touch (Slaves) communicate with the external device via the 
Master.
The Master Touch unit communicates with the external device by means of PLC Link Communication. The Master 
Touch is called an O/I Link Master and a slave Touch connected to the O/I Link Master is called an O/I Link Slave. A 
maximum of 15 O/I Link Slaves can be connected to an O/I Link Master.

2.2 O/I Link Communication Settings

These settings are configured under the O/I Link tab on the Project Settings dialog box. The Project Settings dialog 
box can also be accessed using the following methods.
• Click Project on the Configuration tab.
• Double click Project Settings in the Project window.
The O/I Link Communication Settings can only be configured when O/I Link Master or O/I Link Slave is selected 
in Protocol under Interface Settings on the Communication Interface tab. For details, refer to Chapter 3 “3.6 
O/I Link Tab” on page 3-37.

2 O/I Link Communication

Read Write

5678

External device

0 1

Read

Write

D1: 

M1:

5678

Touch
O/I Link Slave

(Slave 1)

Touch
O/I Link Slave

(Slave 2)

Touch
O/I Link Slave

(Slave 15)

Touch
O/I Link Master

O/I Link Communication

PLC Link Communication

Numerical Display
Reference Device: D1

Bit Button
Destination Device: M1

Read Write Read Write

• The MICRO/I models that can communicate with the Touch using O/I Link Communication are the 
HG2G-S/-5S/-5F, and HG3G/4G.

• For details regarding the O/I Link Communication, refer to Chapter 3 "O/I Link Communication" in the 
"External Device Setup Manual".
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3.1 Overview

DM Link Communication reads and writes value to external devices using the Touch's dedicated DM Link memory. The 
device type of dedicated DM Link memory is DM.
This method uses a dedicated IDEC protocol, so a communication program is required in the external device.

● Communication Methods
There are two basic types of DM Link Communication. 1:1 Communication, where the Touch is connected to an 
external device; and 1:N Communication, where multiple Touch are connected to an external device.

■ 1:1 Communication
The external device is connected to a single Touch.

The Event Transmission function from the Touch can be used with 1:1 communication.
The Event Transmission function is a function that works as follows. When value in the dedicated DM Link memory of 
the Touch is changed, the data is transmitted from the Touch to the external device.

3 DM Link Communication

Touch

999

5678

External device

DM Link Communication

Read

Write

DM0: 999

DM1: 1234 5678

DM0

DM1

DM2

DM8190

DM8191

Dedicated DM Link memory

Numerical Display
Destination Device: DM0

Numerical Display
Reference Device: DM1

For details regarding the DM Link Communication, refer to Chapter 4 "DM Link Communication" in the 
"External Device Setup Manual".

Touch

Dedicated DM 
Link memory

External device DM Link 1:1 Communication

Read

Write

Touch

Event transmission
Dedicated DM 
Link memory

External device

DM0: 0

DM1: 0

DM2: 0

100

150

200

DM0: 100

DM1: 150

DM2: 200

DM Link 1:1 Communication
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■ 1:N Communication
The external device is connected to multiple Touch.

3.2 DM Link Communication Settings

DM Link Communication settings are selected on the Select Communication Driver dialog box, or the Change 
Communication Driver dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 3 “Create new project data by using the interactive quick start” on page 3-1.

• Click Communication Driver on the status bar to display the Change Communication Driver dialog box. For 
details, refer to Chapter 3 “Changing Communication Drivers” on page 3-15.

Select IDEC System in Manufacturer, and then select DM Link (1:1) or DM Link (1:N) in Communication 
Driver.

Station No.1

Station No.2

Station No.3

Touch

Dedicated DM 
Link memory

Dedicated DM 
Link memory

Dedicated DM 
Link memory

External device
Read

Write

Read

Write

Read

Write

DM Link 1:N Communication

The Event Transmission function cannot be used with 1:N communication.
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4.1 Overview

In this case, there is no communication with an external device, so the Touch operates as a standalone unit.
It is only possible to operate the Touch with relays and registers.

4.2 No External devices Settings

No external devices settings are selected on the Select Communication Driver dialog box, or the Change 
Communication Driver dialog box.
• When creating new project data by following displayed dialog boxes and configuring settings step by step, by 

clicking , and then clicking New, the Select Communication Driver dialog box is displayed. For details, refer 
to Chapter 3 “Create new project data by using the interactive quick start” on page 3-1.

• Click Communication Driver on the status bar to display the Change Communication Driver dialog box. For 
details, refer to Chapter 3 “Changing Communication Drivers” on page 3-15.

Select IDEC System in Manufacturer, and then select No External Device in Communication Driver.

4 No External Devices

Touch

Internal device

No external devices
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5.1 Overview

User Communication allows you to develop a communication protocol to transmit and receive data from an external 
device, such as a bar code reader. The Touch supports the user communication with start and stop synchronization 
(full duplex) and a maximum of 1,500 bytes of data transmission or reception.

User Communication is supported up to three interfaces of the Touch, either serial, Ethernet, or USB interfaces.

5 User Communication

Touch

External device

Data receptionData transmission

User communication

External device

PLC Link Communication

Up to 31 external devices can be connected when the serial interface is RS485. However, it is necessary to 
thoroughly check command settings, error handling, and other detailed command specifications when 
considering the capability of communicating with two or more external devices to decide the number of 
external devices to be connected.
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5.2 User Communication Settings Procedure

This section describes the procedure for setting user communication.

● Setting user communication for a communication interface

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box is displayed.

2 Click the Communication Interface tab.

3 Select the interface for user communication under Interface Configuration, and then select the user 
communication in Protocol under Interface Settings.

The User Communication tab is displayed.
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4 Specify the items for Interface Settings.

Setting items vary based on the interface.
• Serial Interface
 For details, refer to Chapter 3 “When Port is selected under Interface Configuration” on page 3-28.

• Ethernet Interface
 For details, refer to Chapter 3 “When Protocol1, Protocol2, or Protocol3 is selected for Ethernet under 

Interface Configuration” on page 3-30.

• USB Interface
 For details, refer to Chapter 3 “When USB2 is selected under Interface Configuration” on page 3-31.

5 Click the User Communication tab.

6 Select the user communication under Settings, and then click Browse.

Select the user communication configured on the Communication Interface tab.
Protocol Manager is displayed.
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7 Select the user communication protocol under Protocol List, and then click Select.

The name of the configured user communication protocol set on the User Communication tab in the Project 
Settings dialog box is displayed in Protocol Name under Settings, and the protocol settings are displayed under 
Protocol. In addition, the command settings selected under Protocol are displayed under Command.

8 Click OK.

This concludes configuring user communication for communication interfaces.
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● Creating a New User Communication Protocol

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 Click Add.

The User Communication Protocol Settings dialog box is displayed.

3 Enter the name of the user communication protocol in the Protocol Name.

The maximum number for protocol name is 40 characters.

You cannot use the following characters in the protocol name.
\ / : , ; * ? " < > |
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4 Set the time out (0 to 255) from when 1 frame of data has been received to when the next frame of data starts to be 
received in Receiving Character Time Out (x100 msec).

A frame refers to a data string from the beginning to the end of a command. These setting items are used only with 
receive command.

5 Click Edit.

The Command Settings dialog box is displayed.

6 Set Transmission (TXD) command.
Enter a comment for transmission command in Comment.

The maximum number is 40 characters.

7 Select TXD in Command Type.

Specify the transmitted data to the external device connected to the Touch and the conditions for transmitting data.

8 Specify the bit device or bit of the word device for reporting that data transmission was successfully completed in 
Completed Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

9 Specify the destination word device for the transmitted data size and error information in Status Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

10 Set the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted in 
Transmission Wait (x100 msec).

11 Select the condition to transmit data in Trigger Type under Trigger Condition from the following.

■ Rising-edge
Data is transmitted when the value of device changes from 0 to 1.
Specify the bit device or bit of the word device as the condition.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Falling-edge
Data is transmitted when the value of device changes from 1 to 0.
Specify the bit device or bit of the word device as the condition.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
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■ Satisfy the condition
Data is transmitted when condition changes from not satisfied to satisfied.
Specify the conditional expression in Condition and select the data type handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ Fixed Period
Data is transmitted at a fixed time interval.
Set the time interval between data transmissions as 1 to 3600 (seconds) in Period (sec).

12 Set data for transmission command.
Click Edit.
The Data Settings dialog box is displayed.

13 Select data type in Type.
Data setting items are displayed.
For details on transmission command, refer to “Transmission (TXD) Command” on page 22-37.
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14 Set the data, and then click OK.
The data configured in Command is displayed.

15 Repeat steps 12 through 14 to set all the data for the transmission command.

16 Click OK.
The transmission command configured under Protocol is displayed.

17 Specify Receive (RXD) command.
Click Edit.

The data are displayed in Command in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.
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18 Specify Receive (RXD) command.
Enter a comment for receive command in Comment.
The maximum number is 40 characters.

19 Select RXD in Command Type.
Define the data configuration for received data from the external device.

20 Specify the bit device or bit of the word device for reporting that data receiving was successfully completed in 
Completed Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
If the value of Completed Device automatically is not set to 0 after it is set to 1, select the Not Clear Completed 
Device automatically check box.

21 Specify the destination word device for the received data size and error information in Status Device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

22 Select the condition for being ready to receive data in Trigger Type under Trigger Condition from the following.

■ Always Enabled
The device is always ready to receive data. Proceed to step 24.

■ While ON
Ready to receive data when the value of device is 1.
Specify the bit device or bit of the word device as the condition.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ While OFF
Ready to receive data when the value of device is 0.
Specify the bit device or bit of the word device as the condition.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ While satisfying the condition
Ready to receive data while a condition is satisfied.
Specify the conditional expression in Condition and select the type of data handled by the conditional expression in 
Data Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions configuration 
procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.
For details on data types, refer to Chapter 2 “1.1 Available Data” on page 2-1.
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23 Set the time out (0 to 255) from when the trigger condition is satisfied in Receiving Time Out (x100 msec) to 
when 1 frame of data has been received.
A frame refers to a data string from the beginning to the end of a command.

24 Set data for receive command.
Click Edit.
The Data Settings dialog box is displayed.

25 Select data type in Type.
Data setting items are displayed.
For details on receive command, refer to “Receive (RXD) Command” on page 22-50.

26 Specify the data, and then click OK.
The data configured in Command on the Command Settings dialog box is displayed.
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27 Repeat steps 24 through 26 to specify all the data for the receive command.

28 Click OK.
The receive command configured in Protocol on the User Communication Protocol Settings dialog box is displayed.

To add a transmission command, repeat steps 5 through 16.

To add a receive command, repeat steps 17 through 28.

29 Configure all commands, click OK.
User communication protocols are registered in Protocol List on Protocol Manager.

The data are displayed in Command in the order they were set. To change the order of data, select data, 
and then click Up or Down to shift it.
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30 Click Close.
This concludes registering user communication protocol.
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● Using registered user communication protocol on another computer

Saving registered user communication protocol as a file

To use the user communication protocol registered in Protocol Manager on another computer, save it as a file.

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 Select the user communication protocol in Protocol List, and then click Export.

The Save As dialog box is displayed.

3 Specify Save in, and then click Save.

The name of the saved file will be the name of the protocol. 

To select multiple user communication protocols, press and hold SHIFT or CTRL while you click the specific 
items.
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Importing user communication protocol

1 On the View tab, in the Workspace group, click  (Protocol Manager).

Protocol Manager is displayed.

2 On Protocol Manager, click Import.

The Open dialog box is displayed.

3 Specify the user communication protocol file, and then click Open.

The user communication protocol is registered in Protocol Manager. The name of the user communication protocol file 
is set as the name of the protocol.

To select multiple user communication protocols, press and hold SHIFT or CTRL while you click the specific 
items.

When a user communication protocol file with the protocol name already exists, a confirmation message is 
displayed.
• Click Overwrite to overwrite the existing user communication protocol.
• Click Rename to display the Protocol File Name Settings dialog box. Enter a new name for Protocol File 

Name, and then click OK to add the user communication protocol with the protocol name entered for 
Protocol File Name. For details, refer to “Protocol File Name Setting Dialog Box” on page 22-25.

• Click Cancel to stop importing the user communication protocol.
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5.3 Protocol Manager

The protocol for user communication is collectively managed in Protocol Manager.

■ Protocol List
Displays a list of registered user communication protocols and sample protocols provided by WindO/I-NV3.

■ Add
Adds user communication protocols to the Protocol List.
Click this button to display the User Communication Protocol Settings dialog box. Specify the user communication 
protocol to be registered in the User Communication Protocol Settings dialog box. For details, refer to “User 
Communication Protocol Settings Dialog Box” on page 22-23.

■ Edit
Changes the selected user communication protocol.
Click this button to display the User Communication Protocol Settings dialog box. Change the user communication 
protocol in the User Communication Protocol Settings dialog box. For details, refer to “User Communication Protocol 
Settings Dialog Box” on page 22-23.

■ Delete
Deletes the selected user communication protocol.

■ Import
Imports a saved user communication protocol file. Click this button to display the Open dialog box. For details, refer 
to “Importing user communication protocol” on page 22-20.

■ Export
Export and saves a selected user communication protocol as a file.
Click this button to display the Save As dialog box. For details, refer to “Saving registered user communication 
protocol as a file” on page 22-19.
Saved user communication protocols can be imported using Import.

■ Copy
Copies the selected user communication protocol.
Click this button to display the Protocol File Name Settings dialog box. For details, refer to “Protocol File Name Setting 
Dialog Box” on page 22-25.

The bar code reader protocols such as Barcode-Reader1, Barcode-Reader2, and Barcode-Reader3 are 
supplied as samples with WindO/I-NV3.
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■ Protocol
The command settings for the user communication protocol selected in the Protocol List are displayed.

■ Command
Shows a list of command settings for the selected user communication protocol. Double clicking the line displays the 
Data Settings dialog box.

■ Select
The highlighted user communication protocol in the protocol list is selected and Protocol Manager is closed.

■ Close
Close Protocol Manager.

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Completed: Shows the device for reporting when transmission or receiving of data is successfully completed. 
Double clicking the cell displays the Command Settings dialog box.

Status: Shows the destination device for the transmitted or received data size and error information. Double 
clicking the cell displays the Command Settings dialog box.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. The 
displayed content varies based on Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:

Shows the bit device as the condition. Double clicking the cell displays the 
Command Settings dialog box.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period in seconds.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. Double clicking the cell displays the Command Settings 
dialog box.
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● User Communication Protocol Settings Dialog Box
The command for user communication protocol is collectively managed in the User Communication Protocol Settings 
dialog box.

■ Protocol Name
Enter the name of the user communication protocol. The maximum number for protocol name is 40 characters.

■ Receiving Character Time Out (x100 msec)
Specify the time out value (0 to 255) from when 1 frame of data has been received to when the next frame of data 
starts to be received. A frame refers to a data string from the beginning to the end of a command. If the Receiving 
Character Time Out is set to 0, it is not monitored. These setting items are used only with receive command.

Example: When the received data (1 frame) is 2 bytes, While ON is selected as Trigger Type in Trigger 
Condition and LM100 is set to Device, LM101 is set to Completed Device, and LDR110 is set to Status 
Device

The data of second byte starts to be received before exceeding the Receiving Character Time Out duration
after the data of first byte is received, and the values of the Completed Device and Status Device when
receiving of the data has been successfully completed are as follows.
• The value of the Completed Device LM101 changes to 1.

When the Not Clear Completed Device automatically check box is not selected, when the value of
the Trigger Condition device LM100 changes from 0 to 1, the value of the Completed Device LM101
changes to 0. 
When the Not Clear Completed Device automatically check box is selected, the value of Completed
Device LM101 remains 1, so set 0 if necessary.

• The value of the Receiving Character Time Out (address+0, bit 15) of the Status Device LDR110 remains
0.

You cannot use the following characters in the protocol name.
\ / : , ; * ? " < > |

Value of Receiving Character Time Out 
(address+0, bit 15) 

of Status Device LDR110

Value of Completed Device 
LM101

Receive command

Value of LM100 when 
Trigger Condition is While ON

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data
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When the Receiving Character Time Out duration exceeds until the data of second byte starts to be 
received after the data of first byte is received, the value of the Receiving Character Time Out (address+0, 
bit 15) of the Status Device LDR110 changes to 1 and the Completed Device LM101 remains 0. In addition, 
when the value of the Trigger Condition device LM100 changes from 0 to 1, the value of LDR110 (address 
+0, bit 15) changes to 0.

■ Protocol
Displays a list of command settings for the user communication protocol selected during editing. The maximum 
amount that can be configured is 32 commands per protocol.

■ Edit
Adds or changes commands.
To add a command, select an empty line for the protocol, and then click this button. To change a command, select a 
command for the protocol, and then click this button. For details, refer to “Command Settings Dialog Box” on page 
22-26.

■ Insert
Inserts a command in the selected position of the protocol.
Click this button to insert a command. The command at the insertion position shift down 1 line. When 32 commands 
are already set, you cannot insert a command. For details, refer to “Command Settings Dialog Box” on page 22-26.

■ Delete
Deletes the selected command.

Value of Receiving Character Time Out  
(address+0, bit 15) 

of Status Device LDR110

Value of Completed Device 
LM101

Receive command

1

0

1

0

1

0

Receiving Character Time Out duration

First byte of receive data Second byte of receive data

Value of LM100 when 
Trigger Condition is While ON

No.: Shows the number for managing command settings. Double clicking the cell displays the Command 
Settings dialog box.

Type: Shows the type of command. Double clicking the cell displays the Command Settings dialog box.

Completed: Shows the device for reporting when transmission or receiving of data is successfully completed. 
Double clicking the cell displays the Device Address Settings dialog box.

Status: Shows the destination device for the transmitted or received data size and error information. Double 
clicking the cell displays the Device Address Settings dialog box.

Trigger Type: Shows the trigger type for data transmission or being ready to receive data. Double clicking the cell 
displays the Command Settings dialog box.

Condition: Shows the condition of trigger type for data transmission or being ready to receive data. The 
displayed content varies based on Trigger Type.

Always Enabled: Trigger conditions are not necessary, so nothing is displayed.

Rising-edge, Falling-edge, While ON, or While OFF:

Shows the bit device as the condition. Double clicking the cell displays the 
Command Settings dialog box.

While satisfying the condition or Satisfy the condition:

Shows the conditional expression.

Fixed Period: Shows the period.

Comment: Shows the command comment. Double clicking the cell displays the Command Settings dialog box.

Size: Shows the command data size in bytes. Double clicking the cell displays the Command Settings 
dialog box.
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■ Copy
Copies the selected command.
Click this button to copy the selected command and add it to the end of the Protocol List.

■ Command
Displays data of the command selected in the protocol. Double clicking the line displays the Data Settings dialog box.

■ Copy to Protocol Manager
Copies a user communication protocol during editing and copies it to Protocol Manager.
Click this button to copy the user communication protocol and add it to the Protocol List of Protocol Manager.
This is enabled only when the User Communication Protocol Settings dialog box under the User Communication 
tab on the Project Settings dialog box is displayed.
When a protocol of the same name has already been saved, an overwrite confirmation message is displayed.
Click Overwrite to overwrite the existing protocol.
Click Rename to display the Protocol File Name Settings dialog box. Enter a new protocol name, and then click OK to 
save the protocol.
Click Cancel to stop saving the protocol.

■ OK
Adds or changes the user communication protocol and closes the User Communication Protocol Settings dialog box.
When a protocol of the same name has already been saved, an overwrite confirmation message is displayed.
Click Overwrite to overwrite the existing protocol.
Click Rename to display the Protocol File Name Settings dialog box. Enter a new protocol name, and then click OK to 
save the protocol.
Click Cancel to stop saving the protocol.

■ Cancel
Closes the User Communication Protocol Settings dialog box, without adding or changing the user communication 
protocol.

Protocol File Name Setting Dialog Box

Specify the name of a user communication protocol.

■ Protocol File Name
Enter the name of the user communication protocol. The maximum number for protocol name is 40 characters.

The User Communication Protocol Settings dialog box under the User Communication tab on the Project 
Settings dialog box can be displayed in the following ways.
• Click Edit.
• Click Browse, and then click Add or Edit in Protocol Manager.

You cannot use the following characters in the protocol name.
\ / : , ; * ? " < > |
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● Command Settings Dialog Box
Specify the command details for user communication protocol.

■ Comment
Enter a comment for a command. The maximum number is 40 characters.

■ Command Type
Select the type of communication command from the following items.

TXD: A command for data transmission from the Touch to an external device.

Processing of transmission command is as follows.

Example: When Trigger Type in Trigger Condition is Rising-edge, Device is LM100 and 
Completed Device is LM101
When the value of the Trigger Condition device LM100 changes to 1, data is transmitted
by user communication from the Touch to the external device. When data transmission is
successfully completed, the value of the Completed Device LM101 changes to 1.

Transmission 
dataTransmission

1
(31h)

2
(32h)

3
(33h)

4
(34h)

External device
Touch

Value of LM100 when 
Trigger Condition is 

Rising-edge

1

0

Value of Completed Device 
LM101

1

0

Transmission data

State in which user 
communication is 

not operating

State in which data can be
 transmitted by user communication

State in which user 
communication is 

not operating

Complete 
transmission

Start 
transmission
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■ Completed Device
Specify the bit device or bit of the word device for reporting that data transmission or receiving was successfully 
completed. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Example: When Trigger Type in Trigger Condition is While ON, Device is LM100 and Completed Device is 
LM101

When data receiving is successfully completed, the value of the Completed Device LM101 changes to 1.
When the value of the Trigger Condition device LM100 changes from 0 to 1, the value of the Completed
Device LM101 changes to 0.

RXD: A command for analyzing and processing data received by the Touch from an external device.

Processing of receive command is as follows.

Example: When Trigger Type in Trigger Condition is While ON, Device is LM100 and 
Completed Device is LM101
When the value of the Trigger Condition device LM100 changes to 1, data can be received
(ready to receive) by user communication, so when data is transmitted from the external
device, the Touch starts to receive the data. When data receiving is successfully 
completed, the value of the Completed Device LM101 changes to 1.

Receive dataReceive
1

(31h)
2

(32h)
3

(33h)
4

(34h)

External device

Touch

Value of LM100 when 
Trigger Condition is 

While ON

1

0

Value of Completed Device 
LM101

1

0

Receive data

Data transmission from 
external device

State in which user 
communication is 

not operating

State in which data can be
 received by user communication

State in which user 
communication is 

not operating

Complete 
receiving

Start 
receiving

Value of Completed Device 
LM101

Receive command

Value of LM100 when 
Trigger Condition is 

While ON

1

0

1

0

Receive data 1 frame
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■ Not Clear Completed Device automatically
Select this check box when the value of the Completed Device is not set to 0 automatically after it changes to 1. This can 
be configured when RXD is selected in Command Type.

Example: When Trigger Type in Trigger Condition is While ON, Device is LM100 and Completed Device is 
LM101

When the Not Clear Completed Device automatically check box is not selected:
When data receiving is successfully completed, the value of the Completed Device LM101 changes to 1.
When the first data of the next frame is received, the value of the Completed Device LM101 changes to 0.

When the Not Clear Completed Device automatically check box is selected:
When data receiving is successfully completed, the value of the Completed Device LM101 is set to 1. Even
after the first data of the next frame is received, the value of the Completed Device LM101 does not
change to 0.

Value of Completed Device 
LM101

Receive command

Value of LM100 when 
Trigger Condition is 

While ON

1

0

1

0

Receive data 1 frame Receive data 1 frame

1

0

1

0

Receive data 1 frame Receive data 1 frame

Value of Completed Device 
LM101

Receive command

Value of LM100 when 
Trigger Condition is 

While ON
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■ Status Device
Specify the destination word device for the transmitted or received data size and error information. Error information 
and command data size is stored at the beginning of the configured device address. When data transmission or 
receiving has not successfully completed, the value of each bit changes to 1. The bits of the Status Device changes to 
0 when the trigger condition is satisfied and they are not changed to 0 automatically. When Always Enabled is 
selected in Trigger Condition of receive command, the value of the Status Device is kept as long as a Clear 
command is not executed.
You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.
Example: When LDR110 is configured as Status Device

When TXD is selected as Command Type:

Address Bit Function Cause Solution

+0

0 BCC Error

• The Calculation Start Position and Calculation 
End Position are not stored in 1 frame.

• The Calculation End Position is set before 
Calculation Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII 
(LCR), the data size from Calculation Start 
Position to Calculation End Position is odd 
bytes.

• The data contains data other than ASCII 
(30h to 39h, 41h to 46h) data.

Change the Calculation 
Start Position and 
Calculation End Position 
settings and the 
transmission data.

1, 2 Reserved

3
Registering 
Constant Data Error

When data type is Registering Constant 
(Character) or Registering Constant 
(Hexadecimal), the value of the Index 
Device does not match the Index No. of the 
registered Registering Constant.

Change the data stored in 
the Index Device.

4 Reserved

5
Use Reference 
Device Data Error

When data type is Device and the Use 
Reference check box is selected, the device 
address in which the value of the Reference 
Device is stored as offset has exceeded the 
valid range.

Change the value stored in 
the Reference Device.

6
Device Data 
Variable 
Specification Error

When data type is Device, the Variable 
check box is selected and Device is selected, 
the value of device is negative or exceeds the 
setting (number of bytes x number of words).

Change the value of device 
to a positive value or to a 
value that does not exceed 
the setting (number of bytes 
x number of words).

7
Transmission 
Command Abandon 
Error

When transmitting data after the Trigger 
Condition is satisfied, the command with the 
same Command No. was transmitting data or 
transmission (transmission is not completed).

Increase the time interval 
for starting transmission.

8 to 15 Reserved

Address Function Description

+1 Transmission Data Size (bytes) Stores the size of transmission data.

LDR110
LDR111

Error information and time out information
Transmitted or received data size (bytes)

(Starting address) +0
+1

When the Error Information bit changes to 1, data is not transmitted, and the Transmission Completed 
Device does not change to 1.
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When RXD is selected as Command Type:

 *1  Receive a to f and device adata conversion error occurs if the system-soft version is V4.01 or older. For details, refer to “6.2 Target Information Dialog 
Box” on page 23-29.

Address Bit Function Cause Solution

+0

0 BCC error

The BCC that calculated the receive data did not 
match the BCC that is appended to the receive data.

Check the transmission data 
from the external device.

• The Calculation Start Position and Calculation 
End Position are not stored in 1 frame.

• The Calculation End Position is set before 
Calculation Start Position.

Change the Calculation 
Start Position and 
Calculation End Position 
settings.

• When Calculation Type is Modbus ASCII (LCR), the 
data size from Calculation Start Position to Calculation 
End Position is odd bytes.

• The data contains data other than ASCII (30h to 
39h, 41h to 46h) data.

Change the Calculation Start 
Position and Calculation End 
Position settings and the 
transmission data from the 
external device.

1 Received Data 
Size Error

• When data type is Device and the Variable check box is 
selected, 1 frame of process is completed before one of 
Constant (Character), Constant (Hexadecimal), 
Registering Constant (Character), Registering 
Constant (Hexadecimal), BCC, or Skip is processed.

• When data type is Device and the Variable 
check box is not selected, the receive data size 
of the receive data does not match that of the 
specified receive command.

Check the transmission data 
from the external device.

2
Registering 
Constant Data 
Error

The Constant (Character) or Constant 
(Hexadecimal) set up with the receive command 
does not match the receive data.

Check the transmission data 
from the external device.

3 Registering 
Constant Error

No data matches the registered setting of the 
Registering Constant data.

Check the transmission data 
from the external device.

4 Device Data 
Conversion Error

• When data type is Device and Conversion 
Type is ASCII (HEX) to Binary, a code other 
than 0 to 9 or A to F, a to f *1 receives as data.

• When data type is Device and Conversion Type is 
ASCII (DEC) to Binary, a code other than 0 to 9 
receives as data. Or the converted data exceeds 65535.

Check the transmission data 
from the external device.

5
Device Data 
Reference 
Device Error

When data type is Device and the Use Reference check 
box is selected, the device address in which the value of the 
Reference Device is stored as offset has exceeded the valid 
range. Or the number of words setting of the device is 
beyond the range of device address for which data is stored.

Change the value of the 
Reference Device or the 
change the number of 
words.

6
Terminal Code of 
Receive Data 
Miscompare Error

In the receive command whose trigger condition is 
being satisfied, the start code matches while the 
terminal code does not match.

Check the transmission data 
from the external device.

7 Device Storing 
Error

In the multiple Receive (RXD) Commands 
processing, the number of the same-time stored 
devices which is sum of the number of the stored 
device of Device and the number of the index 
device of Registering Constant (Character) or 
Registering Constant (Hexadecimal), is over 
800 words.

Change settings so that the total 
number of devices used for storage 
at one time does not exceed 800 
words.
Change settings so that the trigger 
conditions for several receive 
commands are not satisfied, to 
reduce the number of receive 
commands that are processed. 

8 to 13 Reserved

14 Receiving Time 
Out

1 frame of data is not received even when the 
preset Receiving Time Out duration has passed 
after the Trigger Condition is satisfied. 

Check the transmission data 
from the external device.

15
Receiving 
Character Time 
Out

While 1 frame of data is being received, even after the time out 
period—the specified time interval between receiving data 
(from when 1 frame of data has been received to when the 
next frame of data starts to be received)—has elapsed, the next 
frame of data does not start to be received.

Check the transmission data 
from the external device.

Address Function Description
+1 Receive Data Size (bytes) Stores the size of receive data.

After the Receiving Character Time Out duration has elapsed, the receive data is analyzed. When the Error 
Information bit changes to 1, data is not received, and the Receiving Completed Device does not change to 1.
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■ Transmission Wait (x100 msec)
Specify the wait time (0 to 255) from when the trigger condition is satisfied to when the data is transmitted. This can 
be configured only when TXD is selected in Command Type on the Command Settings dialog box.
After the Transmission Wait duration has elapsed from when the trigger condition is satisfied, transmission starts.

Example: When Trigger Type in Trigger Condition is Rising-edge and Device is LM100

■ Receiving Time Out (x100 msec)
Set the time out (0 to 255) from when the trigger condition is satisfied to when 1 frame of data has been received. A 
frame refers to a data string from the beginning to the end of a command. If the Receiving Character Time Out is set 
to 0, it is not monitored. 
This can be configured only when RXD is selected in Command Type, and While ON, While OFF, or While 
satisfying the condition is selected in Trigger Type.

When 1 frame of data could not be received, even though the Receiving Time Out duration has elapsed from when 
the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device (address+0, bit 14) 
changes to 1. When the Receiving Time Out duration elapses, the value of the Completed Device does not change to 
1, and the receive data is not processed.
When the trigger condition again changes from not satisfied to satisfied, the value of the Receiving Time Out of the 
Status Device (address+0, bit 14) changes to 0. When the value of this bit is not 0, the Receiving Time Out cannot be 
detected.

Example: When Trigger Type in Trigger Condition is While ON, Device is LM100, Status Device is LDR110, 
Completed Device is LM101 and the Not Clear Completed Device automatically check box is not 
selected
When Status Device is LDR110, error information and time out information is stored in each bit of
LDR110.

When receiving of 1 frame of data is completed before the Receiving Time Out duration has elapsed from
when the trigger condition is satisfied, the value of the Receiving Time Out of the Status Device LDR110
(address+0, bit 14) remains 0.

Transmission command

Value of LM100 when 
Trigger Condition is 

Rising-edge

1

0

Transmission data 1 frame

Transmission 
Wait duration

Transmission data 1 frame

Transmission 
Wait duration

Value of Device when 
Trigger Condition is 

While ON

1

0

1

0

Receiving Time Out duration

Value of the Receiving Time Out 
(address+0, bit14) 

of the Status Device

Receive command

Value of LM100 when 
Trigger Condition is While ON

1

0

1

0
Value of Completed Device LM101

1

0

Receive data 1 frame

Receiving Time Out duration

Receive data 1 frame

Value of Receiving Time Out  
(address+0, bit 14) 

of Status Device LDR110
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When receiving of 1 frame of data could not be completed by the time the Receiving Time Out duration
elapses from when the trigger condition is satisfied, the value of the Receiving Time Out of the Status
Device LDR110 (address+0, bit 14) changes to 1.

■ Trigger Condition
Set the trigger conditions for transmission or receiving of data.

When TXD is selected as Command Type:

1

0

0

1

0

1

Receive command

Value of LM100 when 
Trigger Condition is While ON

Value of Completed Device LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address+0, bit 14) 

of Status Device LDR110

1

0

0

1

0

1

Receive command

Value of LM100 when 
Trigger Condition is While ON

Value of Completed Device LM101

Receive data 1 frame

Receiving Time Out duration

Value of Receiving Time Out 
(address+0, bit 14) 

of Status Device LDR110

Trigger Type: A condition for data transmission is selected from the following.
Rising-edge: Data is transmitted when the value of device changes from 0 to 1.

Falling-edge: Data is transmitted when the value of device changes from 1 to 0.

Satisfy the condition:
Data is transmitted when the condition changes from not satisfied to satisfied.

Value of Device
1

0

Action Execution Execution Execution

1

0

Value of Device

Action Execution Execution

Action Execution

Condition
Satisfied

Not satisfied

Execution Execution
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When RXD is selected as Command Type:

Fixed Period: Data is transmitted at a fixed time interval.

Data Type: Select the data type handled by the conditional expression.
Can only be set if Satisfy the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as condition. You can only specify the HMI device.
Can only be set if Rising-edge or Falling-edge is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Sets the condition formula.
Can only be set if Satisfy the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Period (sec): Specify the period for command execution from 1 to 3600 (seconds).
This is enabled only when Fixed Period is selected in Trigger Type.

Trigger Type: Selects the condition to be ready to receive data from the following.

Always Enabled: The Touch is always ready to receive data.

While ON: Ready to receive data when the value of device is 1.

While OFF: Ready to receive data when the value of device is 0.

While satisfying the condition:
Ready to receive data while the condition is satisfied.

Data Type: Select the data type handled by the conditional expression.
Can only be set if While satisfying the condition is selected as Trigger Type.
For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Device: Specifies the bit device or bit of the word device to serve as condition. You can only specify the HMI device.
Can only be set if While ON or While OFF is selected as Trigger Type.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.

Condition: Sets the condition formula.
Can only be set if While satisfying the condition is selected as Trigger Type.

Click  to display the Trigger Condition Settings dialog box. For the conditional expressions 
configuration procedure, refer to Chapter 2 “5.2 Setting Conditional Expressions” on page 2-63.

Fixed time interval Fixed time interval Fixed time interval

Action ExecutionExecutionExecution

Action Always Enabled

Value of Device
1

0

Enabled Enabled EnabledAction

1

0

Enabled EnabledEnabled

Value of Device

Action

Enabled Enabled Enabled

Condition
Satisfied

Not satisfied

Action
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■ Command
Shows a list of command data. Double clicking the line displays the Data Settings dialog box.
For details, refer to “Data Settings Dialog Box” on page 22-36. The maximum amount that can be configured is 32 
commands per protocol.
The content displayed in lists varies based on the type of command.

Constant (Character): Displays the specified data enclosed in " ". 
"Data"
Example: "1234"

Constant (Hexadecimal): Displays the specified data with each byte value enclosed in ' '. 
'Data of the first byte' 'Data of the second byte' 'Data of the third byte' 'Data of the 
forth byte'
Example: '31' '32' '33' '34'

Device: Displays the specified data enclosed by < >, in the following order. 
<Device   Conversion Type   Number of bytes   Variable   Words   Storage Method of data>

Device: Displays the device address enclosed by [ ]
When the Use Reference Device check box is selected, 
displays as OFFSET([Device], [Reference Device]) 

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Conversion Type: Display the conversion methods for values of devices as 
follows.
B16-A: When Binary (HEX) to ASCII is selected
B10-A: When Binary (DEC) to ASCII is selected
N: When No Conversion is selected

Variable: When the Variable check box is selected, variables are 
displayed as follows.
V00: When NULL (00h) is selected for transmission 
command
V [Device]: When Device is selected for transmission 
command
V: In the case of receive command

Words: Displays the number of word devices for transmitting or 
receiving data.

Storage Method of data: Displays the handling method for value of read device as 
follows.
U: When from Upper byte is selected
L: When from Lower byte is selected

Example: <OFFSET([LDR0100], [LDR0300]) N 2V[LDR0200] 2 U>

Registering Constant (Character):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device>> (N = 1 to 100)

Data: Displays the data enclosed by " "

Index Device: Displays the device address enclosed by [ ]

Example: <<1:"123" 2 :"456" 3 :"789" [LDR0100]>>

Registering Constant (Hexadecimal):

Displays the specified data enclosed in << >>. 
<<Index No. of No. 1: Data of No. 1 Index No. of No. 2: Data of No. 2 ... Index No. of 
No. N: Data of No. N Index Device>> (N = 1 to 100)

Data: Displays the data enclosed by ' '

Index Device: Displays the device address enclosed by [ ]

Example: <<1:'313233' 2:'343536' 3 :'373839' [LDR0100]>>
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■ Command Size
Displays the data size of a configured command.
The calculation method for command size varies based on the type selected in Command Type on the Command 
Settings dialog box. The command size calculation methods are as follows.

■ OK
Save the settings.

■ Cancel
Cancel the saving of settings.

BCC: Displays the specified data enclosed in BCC ( ). 
BCC(Calculation Start Position   Calculation End Position   Calculation Type    
Conversion Type   Number of bytes)

Calculation Start Position:

Displays the data position where the BCC calculation 
starts.

Calculation End Position:

Displays the data position where the BCC calculation ends.

Calculation Type: Display the methods to calculate the data between the 
Calculation Start Position and Calculation End Position as 
follows.
XOR: When XOR is selected
ADD: When ADD is selected
ADD2: When ADD (2's Complement) is selected

Conversion Type: Display the conversion methods for values of devices as 
follows. 
B16-A: When Binary (HEX) to ASCII is selected
N: When No Conversion is selected

Number of bytes: Displays the number of bytes of the transmitted or 
received data.

Example: BCC(2 1 XOR N 2)

Skip: Displays the specified data enclosed in Skip( ). 
Skip(Number of bytes)
Example: Skip(2)

Edit Add or change data.
To add data, select an empty line in the Command, and then click this button. To 
change data, select data in the Command, and then click this button. For details, refer 
to “Data Settings Dialog Box” on page 22-36.

Insert Insert data at the position of the selected command.
Click this button to display the Data Settings dialog box. And specify the data. The data 
at the insertion point shifts down by 1 item. When 32 data items are already set, you 
cannot insert data.

Delete Deletes the selected data.

Up Shifts the selected data upward in the command.

Down Shifts the selected data downward in the command.

TXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Device x Words of Device

RXD: Number of bytes for Constant Data + Number of bytes for a data of Registering Constant + Number of 
bytes of BCC + Number of bytes of Skip + Number of bytes of Device x Words of Device
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● Data Settings Dialog Box
Specify the transmitted or received data by a command.

■ Type
Selects data types from the following items.
Constant (Character), Constant (Hexadecimal), Device, Registering Constant (Character), Registering 
Constant (Hexadecimal), BCC, Skip

Skip can only be configured when RXD is selected in Command Type on the Command Settings dialog box.

Setting item varies based on the selection in Command Type on the Command Settings dialog box.

When TXD is selected, refer to “Transmission (TXD) Command” on page 22-37.

When RXD is selected, refer to “Receive (RXD) Command” on page 22-50.
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● Transmission (TXD) Command

Constant (Character)

The character data is sent without being converted. 
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data (1 to 1500 bytes) to be transmitted. The size of a single-byte character is one byte and that of a 
double-byte character is two bytes.

Example: Constant (Character) for transmission command data

When the trigger condition is satisfied, the character data is transmitted in the following order.

Item Setting

Data 1234

1234 1
(31h)

Transmission data
Data

2
(32h)

3
(33h)

4
(34h)

Order of transmission

No 
conversion
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Constant (Hexadecimal)

The hexadecimal data is sent without being converted.
Use this setting to send a control code of ASCII data (00h to 1Fh).
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data (1 to 1500 bytes) to be transmitted.

Example: Constant (Hexadecimal) for transmission command data

When the trigger condition is satisfied, 1234h is transmitted in the order 12h and 34h.

Item Setting

Data 1234

1234h
No 

conversion

12h

Transmission data
Data

34h

Order of transmission
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Device

The value of device is either not converted or converted to ASCII and then sent as data with the specified size.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Device is selected under Type on the Data Settings dialog box.

■ Conversion Type:
Select the conversion rule for the value of device from the following.

■ Device
Specify the source word device for transmitted data. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Use Reference Device
To change the source word device for transmitted data according to values of device, select this check box and 
specify a device. This can be configured only when No Conversion is selected under Conversion Type. You can 
only specify an internal device.
For details, refer to Chapter 2 “Indirect Read and Indirect Write Settings” on page 2-4.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Storage Method of data
Select the handling method for the value of read device. This can be configured only when No Conversion is 
selected under Conversion Type.

■ Number of bytes
Specify the number of bytes of transmitted data. The number of bytes that can be specified varies based on the 
setting under Conversion Type.

■ Words
Specify the number of word devices (1 to 99) of transmitted data.

Binary (HEX) to ASCII: Considers the value of device as binary-coded hexadecimal number and converts it to ASCII 
data.

Binary (DEC) to ASCII: Considers the value of device as binary-coded decimal number and converts it to ASCII 
data.

No Conversion: No conversion is performed.

from Upper byte: Value of devices are read from the upper byte.

from Lower byte: Value of devices are read from the lower byte.

Binary (HEX) to ASCII: 1 to 4

Binary (DEC) to ASCII: 1 to 5

No Conversion: 1 to 2
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■ Variable
Select this check box to change the transmitted data size according to conditions. This can be configured only when 
No Conversion is selected under Conversion Type. When the check box is not selected, the amount of data 
(bytes) transmitted is data (bytes) for Number of bytes x Words.

Examples: Device for transmission command data

Example 1

When the trigger condition is satisfied, the value of device is read and data is transmitted in the following order.

Example 2

When the trigger condition is satisfied, the value of device is read and data is transmitted in the following order.

NULL (00h): Send the data from the start data of the value of device up to 00 (hexadecimal). Data 00 will not 
be sent. This setting is effective for sending only the character data section of character data 
having 00 (hexadecimal) as the last data.

Device: Specify a word device to which a number of bytes is applied for transmitted data.

Click  to display the Device Address Settings dialog box. For the device address configuration 
procedure, refer to Chapter 2 “5.1 Device Address Settings” on page 2-61.
When the value of device exceeds Number of bytes x Words, or when it is negative, the Device 
Data Variable Specification Error (address+0, bit 6) of the Status Device changes to 1, and 
transmission does not occur.

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable OFF

1234hLDR100:
5678hLDR101:
9ABChLDR102:

No conversion

12h

Upper Lower
Value of Device

34h

56h 78h

9Ah BCh

from Upper byte 
1 byte

Transmission data

12h 56h 9Ah

Order of transmission

Words: 3

LDR100:
LDR101:

Transmission data

34h 12h 78h

9ABChLDR102:

9Ah BCh

56h BCh 9Ah

Order of transmission

1234h
5678h

12h 34h

56h 78h

No conversion

Upper Lower
Value of Device

from Lower byte 
2 bytes

Words: 3
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Example 3

When the trigger condition is satisfied, the value of device is read, and data is converted to ASCII and transmitted in 
the following order.

Example 4

When the trigger condition is satisfied, the value of device is read, and data is converted to ASCII and transmitted in 
the following order.

Example 5

When the trigger condition is satisfied, the value of device is read and data is transmitted in the following order.

Item Setting

Conversion Type Binary (HEX) to ASCII

Device LDR100

Use Reference Device OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type Binary (DEC) to ASCII

Device LDR100

Use Reference Device OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Upper byte

Number of bytes 2

Words 2

Variable ON, NULL

1234hLDR100:
5678hLDR101:

Binary (HEX) to ASCII

1
(31h)

Value of Device
4

(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

2 bytes

Transmission data

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Order of transmission

Words: 2

1234LDR100:
5678LDR101:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

6
(36h)

3
(33h)

7
(37h)

8
(38h)

3
(33h)

4
(34h)

7
(37h)

8
(38h)

Binary (DEC) to ASCII

Value of Device
Transmission data

Order of transmission

2 bytes
Words: 2

1234hLDR100:
0056hLDR101:

No conversion

12h

Upper Lower
Value of Device

34h

56h00h
from Upper byte 

2 bytes

Transmission data

12h 34h

Order of transmission

Words: 2
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Example 6

When the trigger condition is satisfied, the value of device is read and data is transmitted in the following order.
When the LDR200 value is 3

Example 7

When the trigger condition is satisfied, the value of device is read and data is transmitted in the following order.
When the LDR200 value is 2

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable ON, Device: LDR200

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device ON, Device: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:

No conversion

Transmission data

34h 12h 78h

Order of transmission

1234h
5678h

12h 34h

56h 78h

Upper Lower
Value of Device

from Lower byte 
2 bytes

Words: 2

LDR200=3

1234hLDR100:
5678hLDR101:
2537hLDR102:
4619hLDR103:

No conversion

25h

Upper Lower

Value of Device

37h

46h 19h

LDR200=2

Words: 2

Transmission data

25h 37h 46h 19h

Order of transmission

from Upper byte 
2 bytes
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Registering Constant (Character)

From the registered character data, character data according to the value of device is read and transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Transmission command for Registering Constant (Character) data

When the trigger condition is satisfied, the data of the Index No. according to the value of device is transmitted.
When the LDR100 value is 2

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device LDR100

1231:
4562:
7893: Index Device

LDR100=2

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

4
(34h)

5
(35h)

6
(36h)

Order of transmission
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Registering Constant (Hexadecimal)

From the registered hexadecimal data, the hexadecimal data according to the value of device is read and transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down one line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device
Specify the source word device to serve as the Index No. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Transmission command for Registering Constant (Hexadecimal) data 

When the trigger condition is satisfied, the data of the Index No. according to the value of device is transmitted.
When the LDR100 value is 3

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device LDR100

1234h1:
5678h2:
2537h3:

Index Device
LDR100=3

DataIndex No.

Number of 
Registering 

Constants: 3

Transmission data

25h 37h

Order of transmission
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BCC (Block Check Code)

A BCC for the transmission data is automatically calculated and appended to the transmission data at an arbitrary 
position and transmitted.
This can be configured only when TXD is selected in Command Type on the Command Settings dialog box, and 
BCC is selected under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position of transmission data at which BCC calculation starts (1 to 15). The position is counted backwards, 
with the first position of the transmission data taken as 1.

■ Calculation End Position
Specify the position of transmission data at which BCC calculation ends (0 to 15). The position is counted forwards, 
with the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Transmission data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Transmission data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type: 
Binary (HEX) to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters.

Example: 37h, 35h→75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h→37h, 35h
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■ Conversion Type
After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specifed conversion type, select 1 or 2 for the number of bytes for transmission 
data.

Example: BCC for transmission command data
This example describes the case of transmitting the BCC calculation result from the following transmission data as 
BCC data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No Conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Send the result of step 5 in the order of the lower byte and upper byte.
Example: 1234h→34h, 12h

Binary (HEX) to ASCII Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): BA → 42h, 41h

Modbus RTU (CRC): BA30h → BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Binary (HEX) to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Bytes and BCC data
When the converted data is 3034h, the data appended to the transmission data is as follows.

• When Calculation Type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Binary (HEX) to ASCII conversion the resulting two bytes of data 
is appended to the transmission data. 

• When Calculation Type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is appended to the 
transmission data.

0
(30h)

(Second byte)  (First byte)

4
(34h)

1 byte

BCC data
Converted data

4
(34h)

0
(30h)

4
(34h)

BCC data

0
(30h)

4
(34h)

Converted data

2 bytes

(Second byte)  (First byte)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

BCC data

4241h

Binary (HEX) to ASCII

Data 

Converted data

2 bytes

(Second byte)  (First byte)

BAh 30h BAh 30hBA30h

No conversion

BCC dataData 

Converted data

2 bytes

(Second byte)  (First byte)
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● Receive (RXD) Command

Constant (Character)

The received data is considered as character data and compared with the data specified without being converted.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Character) is selected under Type on the Data Settings dialog box.

■ Data
Enter character data (1 to 1500 bytes) designated to be received. The size of a single-byte character is one byte and 
that of a double-byte character is two bytes.

Example: Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 22-66.

Item Setting

Data 1234

1234 1
(31h)

Data used for comparison with received data
Specified data

2
(32h)

3
(33h)

4
(34h)

Order of reception

No 
conversion
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Constant (Hexadecimal)

The received data is considered as hexadecimal data and compared with the data specified without being converted.
Use this setting to receive a control code of ASCII data (00h to 1Fh).
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Data
Enter hexadecimal data (1 to 1500 bytes) designated to be received.

Example: Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the following data.

When a Constant (Character) is set at the beginning of a command, the first one byte is recognized as the 
start code. When a Constant (Character) is set at the end of a command, the last one byte is recognized as 
the terminal code.
For details, refer to “Start Code and Terminal Code” on page 22-66.

Item Setting

Data 1234

1234h
No conversion

12h

Data used for comparison with received data
Specified data

34h

Order of reception
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Device

From the received data, data of the specified size is unconverted, or converted to binary format, and stored in the 
device.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Device is selected under Type on the Data Settings dialog box.

■ Conversion Type
Select conversion processing for the received data from the following.

■ Device
Specify the word device for storing the received data. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61 .

■ Use Reference Device
To change the word device for storing the received data according to values of devices, select this check box and 
specify a device. You can only specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

■ Storage Method of data
Select the handling method for received data. This can be configured only when No Conversion is selected under 
Conversion Type.

■ Number of bytes
Specify the received data size to be stored per word. The number of bytes to be specified varies based on 
Conversion Type.

■ Words
Specify the number of word devices (1 to 250) for storing the received data.

ASCII (HEX) to Binary: Considers the received data as a hexadecimal number and converts it to binary data.

ASCII (DEC) to Binary: Considers the received data as a decimal number and converts it to binary data.

No conversion: No conversion is performed.

from Upper byte: Values of devices are stored from the upper byte.

from Lower byte: Values of devices are stored from the lower byte.

ASCII (HEX) to Binary: 1 to 4

ASCII (DEC) to Binary: 1 to 5

No Conversion: 1 to 2
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■ Variable
Select this check box to store data up to either Constant (Character) data, or Constant (Hexadecimal) data 
from the beginning of the received data in a device. Stores data of the size specified under Words.
When the stored data is smaller than the size specified under Words, the values of all remaining devices will stored 0.

When the check box is not selected, the amount of data (bytes) stored is Number of bytes x Number of words.

Examples: Device for receive command data

Example 1

When the trigger condition is satisfied, the received data is stored in devices in the following order.

Example 2

When the trigger condition is satisfied, the received data is stored in devices in the following order.

3231hLDR100:
3433hLDR101:
0000hLDR102:

1
(31h)

Value of Device
2

(32h)

3
(33h)

4
(34h)

Number of specified words: 3Number of words for stored data: 2

The stored data is smaller than the size specified for Words.

No 
conversion

Stored data

Insufficient by 1 word
0 is stored.

When the Variable check box is selected, observe the following points.
• When data is set expect for the end of a command, set Constant (Character) data or Constant 

(Hexadecimal) data following Device data.
• When there is no data stored in the device, all of the values of devices specified under Words will be 0.
• The maximum amount of the received data stored in the device is Number of bytes x Number of words. 

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable OFF

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 2

Variable OFF

3100hLDR100:
3200hLDR101:
3300hLDR102:

No conversion

1
(31h)

Upper Lower
Value of Device

0
(00h)

2
(32h)

0
(00h)

3
(33h)

0
(00h)

Received data

1
(31h)

2
(32h)

3
(33h)

Order of reception

Words: 3from Upper byte 
1 byte

from Lower byte 
2 bytes

3231hLDR100:
3433hLDR101:

No conversion

2
(32h)

Upper Lower
Value of Device

1
(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
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Example 3

When the trigger condition is satisfied, the received data is stored in devices in the following order.

Example 4

When the trigger condition is satisfied, the received data is stored in devices in the following order.

Example 5

When the trigger condition is satisfied, the received data is stored in devices in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device. Constant 
(Hexadecimal) data is not stored.

Item Setting

Conversion Type ASCII (HEX) to Binary

Device LDR100

Use Reference Device OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type ASCII (DEC) to Binary

Device LDR100

Use Reference Device OFF

Number of bytes 2

Words 2

Variable OFF

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Upper byte

Number of bytes 1

Words 3

Variable ON

0012hLDR100:
0034hLDR101:

ASCII (HEX) to Binary

2
(32h)

Value of Device
1

(31h)

4
(34h)

3
(33h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2
2 bytes

12LDR100:
34

(DEC)
(DEC)LDR101:

ASCII (DEC) to Binary

2
(32h)

Value of Device
1

(31h)

4
(34h)

3
(33h)

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

Words: 2

Received data

2 bytes

3100hLDR100:
3300hLDR101:
0000hLDR102:

1
(31h)

Value of Device

The stored data is smaller than the 
size specified for Words.

0 is stored.

NUL
(00h)

3
(33h)

NUL
(00h)

1
(31h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Upper byte 
1 byte

Constant (HEX) data

Constant (Character) data
0 is stored.

Stored data
No 

conversion

Insufficient by 1 word
0 is stored.
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Example 6

When the trigger condition is satisfied, the received data is stored in devices in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device. Constant 
(Hexadecimal) data is not stored.

Example 7

When the trigger condition is satisfied, the received data is stored in devices in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device. Constant 
(Hexadecimal) data is not stored.

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device OFF

Storage Method of data from Lower byte

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type ASCII (HEX) to Binary

Device LDR100

Use Reference Device OFF

Number of bytes 1

Words 3

Variable ON

3231hLDR100:
0033hLDR101:
0000hLDR102:

1
(31h)

Value of Device
2

(32h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Order of reception

Words: 3

Received data

Upper Lower

from Lower byte 
2 bytes

Constant (HEX) dataStored data
No 

conversion

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0001hLDR100:
0003hLDR101:
0000hLDR102:

ASCII (HEX) to Binary Value of Device
1

(31h)

3
(33h)

3
(33h)

1
(31h)

ETX
(03h)

Order of reception

Words: 3

The stored data is smaller than the 
size specified for Words.

1 byte

Received data
Constant (HEX) dataStored data

Insufficient by 1 word
0 is stored.
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Example 8

When the trigger condition is satisfied, the received data is stored in devices in the following order.
Data from the beginning of the received data to Constant (Hexadecimal) data is stored in the device. Constant 
(Hexadecimal) data is not stored.

Example 9

When the trigger condition is satisfied, the received data is stored in devices in the following order.
When the LDR200 value is 2

Item Setting

Conversion Type ASCII (DEC) to Binary

Device LDR100

Use Reference Device OFF

Number of bytes 2

Words 3

Variable ON

Item Setting

Conversion Type No Conversion

Device LDR100

Use Reference Device ON, Device: LDR200

Storage Method of data from Upper byte

Words 2

Variable OFF

LDR100:
LDR101:
LDR102:

2
(32h)

Value of Device
1

(31h)

3
(33h)

NUL
(00h)

1
(31h)

2
(32h)

3
(33h)

ETX
(03h)

Words: 3
12
3

(DEC)
(DEC)

0

ASCII (DEC)
 to Binary

(DEC)

2 bytes

Received data
Constant (HEX) dataStored data

Order of reception

Constant (Character) data
0 is stored.

The stored data is smaller than the 
size specified for Words.

Insufficient by 1 word
0 is stored.

0000hLDR100:
0000hLDR101:
3132hLDR102:
3334hLDR103:

No conversion

1
(31h)

Upper  Lower

Value of Device

2
(32h)

3
(33h)

4
(34h)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception

LDR200=2

Words: 2Bytes: 2
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Registering Constant (Character)

The received data is compared with the registered character data and the number of the matching character data is 
stored in the device.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Character) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered character data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the character data.

■ Data
Enter the character data (1 to 1500 bytes) to be registered. The size of a single-byte character is one byte and that of 
a double-byte character is two bytes.
The character data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a character data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device
Specify the word device for storing the Index No. of the character data matching the received data. You can only 
specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

No.: Shows the ID No. (1 to 100) of the character data.

Index: Shows the Index No. of the character data.

Data: Shows the character data.
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Example: Registering Constant (Character) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered data, and the value of the 
Index No. 2 of the matching data is stored in Index Device LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 123

Index No. 2: 456

Index No. 3: 789

Index Device LDR100

Received data

Compare

4
(34h)

5
(35h)

6
(36h)

Order of reception

2LDR100:
Value of the Index Device1231:

4562:
7893:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)
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Registering Constant (Hexadecimal)

The received data is compared with the registered hexadecimal data and the number of the matching hexadecimal 
data is stored in the device.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Registering Constant (Hexadecimal) is selected under Type on the Data Settings dialog box.

■ Number of Registering Constants
Specify the number of data of the registered hexadecimal data (1 to 100).

■ Registering Constants

■ Index
Specify the Index No. (0 to 65535) of the hexadecimal data.

■ Data
Enter the hexadecimal data (1 to 1500 bytes) to be registered.
The hexadecimal data of different size or the same data with a different number cannot be registered.

■ Set
Register the Index and Data settings to the list. When a number that is already registered is selected, it is 
overwritten with the new setting.

■ Insert
Insert a hexadecimal data setting to the selected number in the list.
Click this button to insert the Index and Data setting. The settings at the insertion point shift down 1 line. Settings 
cannot be inserted when all numbers are already set.

■ Delete
Delete the selected settings from the list.

■ Index Device
Specify the word device for storing the Index No. of the hexadecimal data matching the received data. You can only 
specify an internal device.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

No.: Shows the ID No. (1 to 100) of the hexadecimal data.

Index: Shows the Index No. of the hexadecimal data.

Data: Shows the hexadecimal data.
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Example: Registering Constant (Hexadecimal) for receive command data

When the trigger condition is satisfied, the received data is compared with the registered hexadecimal data, and the 
value of the Index No. 2 of the matching data is stored in Index Device LDR100.
When the LDR100 value is 3

Example of applying Registering Constant
When the same device address is specified for the Index Device for Registering Constant (Character) data or 
Registering Constant (Hexadecimal) data and for Use Reference Device for Device data, the data storage 
destination for each unit of received data can be changed.

When the following commands are received

• The first 1 byte is taken as the start code. Constant (Hexadecimal) data is not stored.

• The received data is compared with the registered data, and the value of the Index No. 2 (DEC) of the matching 
data is stored in Index Device LDR100.

Item Setting

Number of Registering Constants 3

Registering Constants

Index No. 1: 1234

Index No. 2: 5678

Index No. 3: 2537

Index Device LDR100

Received data

Compare

25h 37h

Order of reception

3LDR100:
Value of the Index Device1234h

5678h
2537h

1:
2:
3:

DataIndex No.

Number of 
Registering 

Constants: 3

(DEC)

Data type Item Setting

Constant (Hexadecimal) Data 02

Registering Constant (Character)

Number of Registering Constants 2

Registering Constant
Index No. 1: AA

Index No. 2: BB

Index Device LDR100

Device

Conversion Type No Conversion

Device LDR100

Use Reference Device ON, Device: LDR200

Storage Method for Data from Upper byte

Bytes 2

Words 2

Variable OFF

Constant (Hexadecimal) Data 0D

STX
(02h)

B
(42h)

B
(42h)

1
(31h)

2
(32h)

CR
(0Dh)

STX
(02h)

Received data

Compare

B
(42h)

B
(42h)

Order of reception

2LDR100:
Value of the Index DeviceAA

BB
1:
2:

DataIndex No.
Number of 
Registering 

Constants: 2
(DEC)
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• Since the Indirect Device LDR100 of Device of the receive command data is 2 (DEC), the data is stored in the 
device LDR202, which is offset by +2.

• The last 1 byte is taken as the terminal code. Constant (Hexadecimal) data is not stored.

0000hLDR200:
0000hLDR201:
3132hLDR202:

Value of Device

LDR100=2

CR
(0Dh)
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BCC (Block Check Code)

The BCC comparison data is automatically calculated from the receive data and compared with the BCC part of the 
receive data.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
BCC is selected under Type on the Data Settings dialog box.

■ Calculation Start Position
Specify the position (1 to 15) in the receive data where BCC calculation starts. The position is counted backwards, 
with the first position of the receive data taken as 1.

■ Calculation End Position
Specify the position (0 to 15) in the receive data where BCC calculation ends. The position is counted forwards, with 
the data position before the BCC taken as 0.

■ Calculation Type
Select the method to calculate the data between the Calculation Start Position and Calculation End Position.

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

Receive data:

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(5) (4) (3) (2) (1) (0)Calculation End Position:

Receive data:

XOR: Calculates the data with exclusive logical add.

ADD: Calculates the data using addition.

ADD (2's Complement): Calculates the data using addition, inverts the bit and adds one.

Modbus ASCII (LCR): Calculation is performed according to the following procedure. Conversion Type:
Binary (HEX) to ASCII, Number of bytes: 2

1. Convert the ASCII characters between Calculation Start Position and Calculation End 
Position into 1-byte hexadecimal data for each set of two characters. 
Example: 37h, 35h → 75h

2. Calculate the sum of the data obtained in step 1.

3. Invert the bit of the result of step 2 and add one. (2’s complement)

4. Convert the lower one byte data of the result of step 3 into ASCII characters.
Example: 75h → 37h, 35h
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■ Conversion Type
After calculating the data using the specified calculation type, select the type of conversion for the data from the 
following.

■ Number of bytes
After converting according to the specified conversion type, select 1 or 2 for the number of bytes for comparison 
data.

Example: BCC for receive command data
This example describes the case of comparing the BCC calculation result for the following receive data with the BCC 
part of the receive data.

• Calculation Start Position and Calculation End Position
When Calculation Start Position is 2 and Calculation End Position is 1: Calculates the range 1234.

• Calculation Type

• Conversion Type
When the BCC calculation result is 0004h, the converted data is as follows.

Modbus RTU (CRC): CRC-16 (Generating polynomial:x16+x15+x2+1) is calculated according to the following 
procedure. Conversion Type: No Conversion, Number of bytes: 2

1. Obtain an exclusive OR (XOR) of 1 byte data at Calculation Start Position and FFFFh.

2. If the least significant bit of the result of step 1 is 0, shift to the right by one bit. If the 
bit is 1, shift to the right by 1 bit and obtain XOR of the result and the value (A001h).

3. Repeat step 2 to shift 8 times.

4. Obtain XOR of the next one byte of data and the result of step 3.

5. Repeat steps 2 through 4 until the data at Calculation End Position is processed.

6. Compare the result of step 5 in the order of the lower byte and upper byte.

Example: 1234h → 34h, 12h

Binary (HEX) to ASCII: Considers the data as binary-coded hexadecimal number and converts it to ASCII data.

No conversion: No conversion is performed.

XOR: 31h^32h^33h^34h^=04h

ADD: 31h+32h+33h+34h=CAh

ADD (2's Complement): Inverts the bit of CAh+1=36h

Modbus ASCII (LCR): BA→42h, 41h

Modbus RTU (CRC): BA30h→BAh, 30h

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC CR
(0Dh)

(1) (2) (3) (4) (5) (6)Calculation Start Position:

(5) (4) (3) (2) (1) (0)Calculation End Position:

Data used for BCC calculation

0004h

Binary (HEX) to ASCII

0
(30h)

Data
4

(34h)

0004h

No conversion

00h
Data

04h
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• Number of bytes and comparison data
When the converted data is 3034h, the data used for comparison with the BCC part of the receive data is as 
follows.

• BCC data comparison
The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 1-byte 34h, there is a match since the BCC part data 
is 34h.
When there is no match, the BCC Error (address+0, bit 0) of the Status Device changes to 1.

• When the calculation type is Modbus ASCII (LCR)
When the BCC calculation result is 4241h after Binary (HEX) to ASCII conversion the resulting two bytes of data 
is used for comparison with the BCC part of the receive data.

• When the calculation type is Modbus RTU (CRC)
When the BCC calculation result is BA30h with no conversion the two bytes of data is used for comparison with the 
BCC part of the receive data.

0
(30h)

4
(34h)

Comparison data

4
(34h)

Bytes: 1

Converted data
(Second byte)  (First byte)

0
(30h)

4
(34h)

0
(30h)

4
(34h)

Comparison data

Bytes: 2

Converted data
(Second byte) (First byte)

1
(31h)

4
(34h)

5
(35h)

2
(32h)

STX
(02h)

3
(33h)

BCC
(34h)

CR
(0Dh)

Comparison data

Match

Receive data BCC part

4
(34h)

B
(42h)

A
(41h)

B
(42h)

A
(41h)

Comparison data

4241h

Binary (HEX) to ASCII

Data

Bytes: 2

Converted data
(Second byte) (First byte)

BAh 30h BAh 30hBA30h
No conversion

Comparison data
Data

Bytes: 2

Converted data
(Second byte) (First byte)
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Skip

The data with the specified number of bytes in the receive data will be ignored.
This can be configured only when RXD is selected in Command Type on the Command Settings dialog box, and 
Skip is selected under Type on the Data Settings dialog box.

■ Number of bytes
Specify the number of bytes (1 to 249) of receive data to be ignored.

Example: Skip for receive command data 

In the received four byte data (1 (31h), 2 (32h), 3 (33h), 4 (34h)), only the data for 3 (33h) and 4 (34h) is received 
and the two bytes of 1 (31h) and 2 (32h) are discarded.

Item Setting

Number of bytes 2

Enabled data

4
(34h)

3
(33h)

2 bytes
(Ignored)

Received data

1
(31h)

2
(32h)

3
(33h)

4
(34h)

Order of reception
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● Start Code and Terminal Code
A start code starts data reception and a terminal code judges the terminal of data reception. A start code and a 
terminal code can be configured for either Constant (Character) or Constant (Hexadecimal) settings for receive 
command. The first 1 byte of the constant is recognized as the start code and the last 1 byte as the terminal code.

Code 00h to 7Fh can be set when Data Length under Interface Settings is 7 bits, and 00h to FFh when the data 
length is 8 bits. Data Length is configured under the Communication Interface tab on the Project Settings dialog 
box.
The procedure for terminal of data reception varies whether or not the receive data contains a start code and a 
terminal code, and whether the Variable check box for Device for receive command data is selected.
In the following description, With Variable indicates that the Variable check box for Device for receive command 
data is selected and Without Variable indicates that the Variable check box is not selected. Also, when there are 
multiple Device set for receive command data, and at least 1 command has the Variable check box selected, this 
corresponds to With Variable.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

Set Set
Set

Not set

Reception is started with the start code and terminated with the terminal code.

When the terminal code is followed by BCC, the data including the number of bytes of 
BCC is received.

Set Not set

Set

Reception is started with the start code and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started with the start code and the data is received according to the length of 
the command.

Not set Set
Set

Not set

Reception is started from the beginning and terminated with the terminal code.

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data:

Constant (HEX)

'34' '35' '0d'
Constant (HEX)DeviceCommand settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d'
Device

Receive

Constant (HEX) Constant (HEX)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' '33' <[LDR0100] N 2 2 U>Receive data: '34' '35' '0d' BCC(1 0 XOR N 1)
BCCDevice

Receive

Constant (HEX) Constant (HEX)Command settings:

Start code 02h Terminal code 0dh

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant (HEX)

<<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (HEX)Device With Variable

Maximum command length

Receive

Command settings:

Start code 02h Terminal code: None

'02' '31' '32' <[LDR0100] N 2V 2 U>Receive data:

Constant (HEX)

'03' <<1:”AB” 2:”CD” [LDR0200]>>
Constant (HEX) Registering Constant (HEX)Device With Variable

Receive

Command settings:

Start code 02h Terminal code: NoneReceiving character 
time out occurs.

'02' '31' '32' <[LDR0100] N 2 2 U>Receive data:

Constant (HEX)

<<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (HEX)Device Without Variable

Command length

Receive

Command settings:

Start code 02h Terminal code: None

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (HEX) Device

'34' '35' '0d'
Constant (HEX)

Receive

Command settings:

Start code: None Terminal code 0dh
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Not set Not set

Set

Reception is started from the beginning and the data is received according to the 
maximum command length.

Reception is terminated when the Receiving Character Time Out occurs.

Not set

Reception is started from the beginning and terminated when the data is received 
according to the length of the command.

Start code Terminal 
code Variable Description of the procedure for terminal of data reception

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 
Device With Variable

Maximum command length

Receive

Command settings:
Constant 

(Character)

Start code: None Terminal code: None

Skip(2) <[LDR0100] N 2V 2 U>Receive data:

Skip

“123” 

Constant 
(Character) Device With Variable

Receive

Command settings:

Start code: None Terminal code: None

Receiving character time out occurs.

<[LDR0100] N 2 2 U>Receive data: <<1:”AB” 2:”CD” [LDR0200]>>
Registering Constant (HEX)Device Without Variable

Command length

Receive

BCC(1 0 XOR N 1)
BCCCommand settings:

Start code: None Terminal code: None

• When trigger conditions are satisfied for two or more receive commands for which both start code and 
terminal code are set, all commands are analyzed and processed for receive processing. Since 
commands with and without errors may be mixed depending on the results of data reception analysis of 
each command, take extra caution regarding error handling.

• While the trigger condition is satisfied for a receive command for which either a start code or terminal 
code is not set, only this command is processed for data reception when the trigger condition of another 
command is being satisfied. When two or more commands exist for which either start code or terminal 
code is not set, the command with the biggest number for managing the protocol is processed.

• When a start code of the receive command for which a start code is set cannot be received, all of the 
receive data is ignored and abandoned. No error occurs.

• When start code is received with a receive command for which start code and terminal code are set, the 
data reception is completed after the maximum number of bytes received in case of continuous reception 
of data that does not match the terminal code of all receive command in which the trigger conditions is 
satisfied.
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5.4 Example of User Communication Settings

This section describes examples of user communication settings and command operations.

● Example 1
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Constant (Character), Device, 

Constant (Hexadecimal) command settings when the trigger condition device changes to 1 
• Receive command for receiving, processing, and storing data in devices, using Constant (Hexadecimal), Constant 

(Character), Device, Constant (Hexadecimal) command settings, for data transmitted from an external device, 
when the trigger condition device is 1

■ User Communication Settings dialog box settings

■ Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 100 (DEC) to LDR100 of transmission command data Device.

2 Change the trigger condition LM100 from 0 to 1 to start command transmission.

After the transmission wait duration (five seconds), the transmission data is sent. The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device LM101 changes to 1.
• When the value of each bit of address+0 for Status Device LDR110 is 0, transmission is completed without an error.

Item Setting

Protocol Name Sample 1

Receiving Character Time Out 30 (×100 msec)

Item Setting

Comment TXD command

Command Type TXD

Completed Device LM101

Status Device LDR110

Transmission Wait 50 (×100 msec)

Trigger Condition While ON, Device: LM100

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'05'

Constant 
(Character)

"D"

Device
Conversion Type: Binary (DEC) to ASCII, 
Number of bytes: 4, Words: 1
Device: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

0
(30h)

0
(30h)

0
(30h)

EQN
(05h)

1
(31h)

CR
(0Dh)

Transmission data:

Constant
(HEX)

Constant 
(Character) Device 

Command settings:

Constant
(HEX)
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■ Receive command: Command Settings dialog box settings

Operation for receive command

1 When data transmission of the transmission command is completed, the value of LM101 changes to 1, and since the 
same device is specified for the trigger condition user communication becomes ready for receiving.

2 Data is transmitted from the external device and the transmitted data is received and processed.

The receive data is as follows.

Since a value of 100 is written to LDR100 at the time of transmission, the data is stored in device LDR220, which 
corresponds to an offset of +100 from LDR120.

• When data reception is successfully completed, the Completed Device LM102 changes to 1.
• When the value of each bit of address+0 of Status Device LDR130 is 0, reception is completed without an error.

Item Setting

Comment RXD command

Command Type Receive

Completed Device LM102

Not Clear Completed Device 
automatically

No

Status Device LDR130

Receiving Time Out 0 (No Receive Time Out)

Trigger Condition While ON, Device: LM101

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'02'

Constant 
(Character)

"D"

Device
Conversion Type: ASCII (HEX) to Binary, 
Number of bytes: 4, Words: 1
Device: LDR120, Reference Device: LDR100

Constant 
(Hexadecimal)

'0D'

D
(44h)

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

CR
(0Dh)

Receive data:

Constant
(HEX)

Constant 
(Character) Device 

Command settings:

Constant
(HEX)

0000LDR120:
0000LDR121:

1234hLDR220:

Value of Device

LDR230=100
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● Example 2
This section describes an example of user communication protocol settings for creating the following commands and 
command operations.
• Transmission command for transmitting data using Constant (Hexadecimal), Registering Constant (Character), 

Device, BCC, Constant (Hexadecimal) command settings when the trigger condition device changes to 1
• Receive command for receiving, processing, and storing data in devices, using Constant (Hexadecimal), Registering 

Constant (Character), Skip, Device, BCC, Constant (Hexadecimal) command settings, for data transmitted from an 
external device, when the trigger condition device is 1

■ User Communication Settings dialog box settings

■ Transmission command: Command Settings dialog box settings

Operation for transmission command

1 Write a value of 10 (DEC) to LDR200 for Registering Constant (Character) for transmission command data.

AB is selected.

2 Write a value of 3132h to LDR210 and 3334h to LDR211 for Device for transmission command data.

3 Change the trigger condition LM200 from 0 to 1 to start command transmission.

The transmission data is as follows.

• When data transmission is successfully completed, the Completed Device LM201 changes to 1.
• When the value of each bit of address+0 for Status Device LDR220 is 0, transmission is completed without an error.

Item Setting

Protocol Name Sample 2

Receiving Character Time Out 30 (×100 msec)

Item Setting

Comment TXD command

Command Type Transmit

Completed Device LM201

Status Device LDR220

Transmission Wait 0 (×100 msec)

Trigger Condition While ON, LM200

Command
Data Settings dialog box settings

Constant 
(Hexadecimal)

'05'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device: LDR200

Device
No Conversion, from Upper byte, Number of bytes: 2, 
Words: 2
Device: LDR210

BCC
Start Calculation Position: 1, End Calculation Position: 0, 
XOR, Binary (HEX) to ASCII, 2 bytes

Constant 
(Hexadecimal)

'0D0A'

AB10:
CD20: Index Device

LDR200=10

DataIndex No.

Number of Registering Constants: 2

Transmission data

A
(41h)

B
(42h)

Order of transmission

3
(33h)

4
(34h)

1
(31h)

EQN
(05h)

2
(32h)

CR
(0Dh)

LF
(0Ah)

A
(41h)

B
(42h)

0
(30h)

2
(32h)

BCC

Transmission data:

Constant
(HEX)

Registering 
Constant (Character) Device 

Command settings:

Constant
(HEX)
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■ Receive command: Command Settings dialog box settings

Operation for receive command

1 Change the trigger condition LM202 from 0 to 1 to be ready for receiving user communication.

2 Data is transmitted from the external device and the transmitted data is received and processed.
The receive data is as follows.

• The receive data is compared with the character data, and the value of the matching Index No. (10 (DEC)) is stored 
in Index Device LDR230.

• The 2 bytes (specified with Skip) of the receive command data 43h and 44h are ignored.
• Since the Reference Device LDR 230 of Device of the receive command data is 10 (DEC), the data is stored in the 

device LDR250 and LDR251, which is offset by +10.

• [STX] ABCD1234 is calculated with BCC of receive command data and compared with 3032h.
- When Calculation Start Position is 1 and Calculation End Position is 0: Calculates the range STX ABCD1234.

- The BCC calculation type is XOR.
02h^41h^42h^43h^44h^31h^32h^33h^34h^=02h

Item Setting
Comment RXD command
Command Type Receive
Completed Device LM203
Not Clear Completed Device 
automatically No

Status Device LDR260
Receiving Time Out 0 (No Receive Time Out)
Trigger Condition While ON, Device: LM202

Command
Data Settings dialog box 
settings

Constant 
(Hexadecimal) '02'

Registering 
Constant 
(Character)

10: "AB", 20: "CD", Index Device: LDR230

Skip 2 bytes

Device
Conversion Type: No Conversion, from Upper byte, 
Number of bytes: 2, Words: 2
Device: LDR240, Reference Device: LDR230

BCC Calculation Start Position: 1 Calculation End Position: 0, XOR
Binary (HEX) to ASCII, 2 bytes

Constant 
(Hexadecimal) '0D''0A'

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

Skip

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

BCC
Constant

(HEX) Device 
Constant

(HEX)
Command settings:

Registering 
Constant (Character)

Receive data:

Received data

Compare

A
(41h)

B
(42h)

Order of reception

10LDR230:

Value of the Index Device

AB10:
CD20:

DataIndex No.
Number of

 Registering
 Constants: 2

(DEC)

0000hLDR240:
0000hLDR241:

3132hLDR250:

Value of Device

LDR230=10

(1) (2) (3) (4) (5) (6) (7) (8) (9)Calculation Start Position:

(5) (4) (3)(8) (7) (6) (2) (1) (0)Calculation End Position:

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

Data used for BCC calculation
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- When the BCC calculation result is 0002h, the converted data will be 3032h.

- When the converted data is 3032h, the data for comparison with the BCC part of the receive data will be 3032h.

- The comparison data is compared with the BCC part of the receive data.
In the following receive data, when the comparison data is the 2-byte 3032h, there is a match since the BCC part 
data is 3032h.
When there is no match, the BCC Error (address+0, bit 0) of Status Device changes to 1.

• When data reception is successfully completed, the Completed Device LM203 changes to 1.
• When the value of each bit of address+0 for Status Device LDR250 is 0, transmission is completed without an error.

0002h

Binary (HEX) to ASCII

0
(30h)

Data
2

(32h)

0
(30h)

2
(32h)

Comparison data

0
(30h)

2
(32h)

Bytes: 2

Converted data
(Second byte)  (First byte)

Comparison data

Match

Receive data BCC part

3
(33h)

4
(34h)

1
(31h)

STX
(02h)

2
(32h)

A
(41h)

B
(42h)

C
(43h)

D
(44h)

CR
(0Dh)

LF
(0Ah)

0
(30h)

2
(32h)

0
(30h)

2
(32h)
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5.5 Compatible USB Bar Code Readers

The following USB bar code readers can be used with the Touch:

5.6 Connection Diagram for User Communication

When connecting an external device to the Touch via user communication, refer to the following connection diagram.

■ Serial interface (RS232C)

■ Serial interface (RS422/485)

*1 in selected country only

Manufacturer Type Number

IDEC DATALOGIC QD2130*1

• Set the USB Barcode Reader to USB-KBD(Keyboard) setting.
• The Touch handles the new line code as 0x0A.

1 SD
Pin No. Name

2 RD
3 RS
4 CS
5 SG

-FG
Pin No.Name

-RD
-SD
-SG

Shield Wire
TouchExternal device (RS232C)

8 RDA(RD+)
Pin No. Name

9 RDB(RD-)
6 SDA(SD+)
7 SDB(SD-)
5 SG

-FG
Pin No.Name

-SDA
-SDB
-RDA
-RDB
-SG

Shield Wire
TouchExternal device (RS485/422)

Terminal

There is no pin No. corresponding to TERM. When a termination resistor is necessary, insert one with 
suitable resistance value between pin 8 (RDA) and pin 9 (RDB). For details, refer to Chapter 1 "2 Important 
Points Regarding Wiring" in the "External Device Setup Manual".
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This chapter describes in detail on how to setup the online function and the operation of the Touch.

  

1.1 How the Online Function is Used

The online function enables communication with the Touch in WindO/I-NV3. This communication between 
WindO/I-NV3 and the Touch, implemented using an exclusive protocol called maintenance communication.
The online function enables the following.

•  Write a project data into the Touch.

• Write files to an external memory inserted in the Touch.

Chapter 23 Online Function

1 Communicating with the Touch

Computer
Touch

Download

Project data

When project data is downloaded using the online function, the Alarm Log data, Data Log data, and 
Operation Log data in the data storage area are deleted. All internal devices except for the HMI Keep 
Register (LKR) and HMI Keep Relay (LK) are cleared.

• The following functions can be executed with downloading of project data.
- Download additional fonts.
- Download the runtime system.
- Download recipe files to an External Memory Folder in external memory inserted in the Touch.
- Clear the HMI Keep Register (LKR) and HMI Keep Relay (LK) after download.
- Start running the control functions after download.

• For details on writing project data to an external memory inserted in the computer, refer to Chapter 26 
“Downloading” on page 26-6.

Computer

USB flash drive

Download

Touch

Recipe file
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• Read the project data downloaded to the Touch and then save it to a computer.

• Delete the data stored in the internal memory or the external memory inserted in the Touch and format the 
external memory inserted in the Touch.

• Display the information about the runtime system and project data of the Touch.

Computer

Upload

Touch

Project data

• It is possible to upload recipe files from an External Memory Folder in external memory inserted in the 
Touch, together with uploading of project data.

• For details on reading project data saved on an external memory using WindO/I-NV3, refer to Chapter 26 
“Uploading” on page 26-9.

Computer

USB flash drive

Deleting data

Deleting data
Formatting

Touch

Computer

System 
Information

Touch
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• Edit a project data in WindO/I-NV3 while checking Touch operation by displaying and changing values of devices 
and switching screens using the monitor function.

Computer Touch

130

External device

Screen monitor

LDR1= 0 130

Computer

Switches to Base Screen 2.

Touch

130

Full

Tank 1

External device

External device

Base Screen 1

Base Screen 2

For details about monitor function, refer to Chapter 24 “1 Monitoring with WindO/I-NV3” on page 24-1.
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1.2 Connect Touch to a Computer

Connection type varies according to the interface between the Touch and computer.

● USB cable connection
The computer must be running Windows 10/8/7 (64-bit and 32-bit versions), and must have a USB 1.1/2.0 port.

● Ethernet cable connection
The computer must be equipped with an Ethernet port.

Computer

USB cableA plug Mini-B plug

To USB port To USB interface

Touch

• A USB driver must be installed when connecting the Touch to a computer with a USB cable. Install the 
USB driver when making the connection for the first time.

For details, refer to “How to install USB driver”. Click ▼ to the right of the  icon at the top right 
corner of the WindO/I-NV3 window and click How to install USB driver to display How to install USB 
driver.

• The USB driver does not have to be installed for subsequent connections.
Note, the connection must use the same USB port that was connected to when installing the USB driver. 
The computer will not recognize the Touch immediately if the USB cable is connected to a different USB 
port.

• Multiple Touch connections using different USB ports on the same computer are not supported.
• The computer cannot be connected to the Touch via a USB hub.

Computer

Ethernet cable

To Ethernet port To Ethernet interface

Touch

It is necessary to configure the Touch according to the local network that is used.
On the Communication Interface tab in the Project Settings dialog box, specify the IP address, subnet 
mask, and default gateway, and clear the Forbid Maintenance Communication check box. For details, 
refer to Chapter 3 “3.2 Communication Interface Tab” on page 3-27.
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1.3 Change Communication Settings

To communicate with the Touch in WindO/I-NV3, configure the settings such as communication speed and port used 
to match the connection method for the Touch.

1 On the Home tab, in the Project group, click Comm.Setup.

The Communication Settings dialog box is displayed.

2 Change the settings on each tab as necessary and then click OK.

■ Communicate with
Select the device to communicate with from the following items.

Touch: Communicate with the Touch connected to the computer.
For details, refer to “Using the online function for Ethernet communication” on page 23-7.

O/I Link Slaves: Communicate with an O/I Link Slave Touch via an O/I Link Master.
For details, refer to “Using the online function with an O/I Link Slave via an O/I Link Master” 
on page 23-8.

Computer

USB cable

Ethernet cable

Touch

O/I Link Communication

Computer

USB cable

Ethernet cable

Touch
O/I Link Master

Touch
O/I Link Slave

(Slave 15)

Touch
O/I Link Slave

(Slave 2)

Touch
O/I Link Slave

(Slave 1)

Read Write
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■ Port
Select the communication port on the computer from the following items.

■ Time Out (min)
Specify the time to wait for a response from the Touch (1 minute to 20 minutes).
This option can only be configured when Ethernet is selected for Port.

External Memory: Read or write data to the external memory inserted in the Touch connected to the computer.
For details, refer to Chapter 26 “1.4 Reading/Writing Data” on page 26-3.

USB: Connect the USB port on the computer to the USB interface on the Touch.

Ethernet: Connect the Ethernet port on the computer to the Ethernet interface on the Touch.

The initial values of the network settings on the Touch are as follows.

IP Address: 192.168.0.1

Subnet Mask: 255.255.255.0
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● Using the online function for Ethernet communication
Select Ethernet under Port on the Target IP Address dialog box.

To download project data

Click Download in the Download dialog box to display the Target IP Address dialog box. 
Specify the Ethernet settings (IP address, subnet mask, and default gateway) for the Touch.
Select the Touch IP addresses and you can batch download project data to multiple Touch.
It is also possible to change the Ethernet settings (IP address, subnet mask, and default gateway) of the Touch to 
which you are downloading after project data is downloaded.

■ Target List

■ Add
Adds a download destination for project data to the list. Click this button to open IP Address Manager. Using 
IP Address Manager, specify the Ethernet settings for the Touch to which you are downloading.

■ Delete
Deletes download destinations from the list.

■ Change Settings
Changes the Ethernet settings of the Touch to which you are downloading after project data is downloaded.
Select a download destination from the list, and then click Change Settings to display IP Address Manager. Using 
IP Address Manager, specify the Ethernet settings of the Touch after downloading.

It is necessary to set the IP address, subnet mask, and default gateway of the Touch according to the local 
network that is used.
For details about Ethernet communication, refer to Chapter 3 “3.2 Communication Interface Tab” on page 
3-27.

The initial values of the network settings on the Touch are as follows.

IP Address: 192.168.0.1

Subnet Mask: 255.255.255.0

Download to: Shows the current IP address for the Touch to download the project data to.

Set IP Address: Shows the IP address for the Touch after downloading the project data.

Set Subnet Mask: Shows the subnet mask for the Touch after downloading the project data.

Set Default Gateway: Shows the default gateway for the Touch after downloading the project data.

Even if the Ethernet settings of the Touch are changed by using the Target IP Address dialog box when 
downloading a project, the Ethernet settings in the editing project data are not changed.
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To execute any function except project data download

The Target IP Address dialog box will be displayed when any of the following functions are executed.
• Upload a project data.
• Upload data from an external memory inserted in the Touch.
• Delete data stored in the internal memory.
• Delete data from or formatting an external memory inserted in the Touch.
• Display information about runtime system and project data.
• Monitor the Touch.
Specifies the IP address of the Touch used for communication.

■ Target IP Address
Specify the IP address for the target Touch to execute this function.

Click  to display IP Address Manager. Specify the IP address for the target Touch with IP Address Manager.

● Using the online function with an O/I Link Slave via an O/I Link Master
Select O/I Link Slaves under Communicate with on the Communication Settings dialog box.

To download project data

Click Download in the Download dialog box to display the Target Slaves dialog box.
Specify the slave station number of the Touch to which you are downloading. You can download project data to 
multiple Touchs.
Also, it is possible to change the slave station number the Touch to which you are downloading after project data is 
downloaded.

■ Target
Select slave stations (Slave 1 through Slave 15 of the download target).

When a Touch used as an O/I Link Master or O/I Link Slave is connected with a computer, select Touch in 
the Communication Settings dialog box.
For details about O/I Link Communication, refer to Chapter 22 “2 O/I Link Communication” on page 22-3.

• The MICRO/I models that can communicate with the Touch using O/I Link Communication are the HG2G-
S/-5S/-5F, and HG3G/4G.

• During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.
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■ Set Slave No.
The slave station number of the Touch to which you are downloading is changed after project data is downloaded.
Specifies the new slave station number (1 to 15) applied to the Touch after downloading a project data.

■ Master IP Address
Specifies the IP address of the O/I Link Master that is used to communicate between the O/I Link Slave and the 
external device.

Click  to display IP Address Manager. Specify the IP address for the O/I Link Master with IP Address Manager.

This option can only be displayed when O/I Link Slave is selected for Communicate with and Ethernet is 
selected for Port in the Communication Settings dialog box.

To execute any function except project data download

The Target Slave dialog box will be displayed when any of the following functions are executed.
• Upload project data.
• Upload data from an external memory inserted in the Touch.
• Delete data stored in the internal memory of the Touch.
• Delete data from or format an external memory inserted in the Touch.
• Display information about runtime system and project data.
• Monitor the Touch.
Specifies the O/I Link Slave.

■ Target Slave
Select the slave station number (Slave 1 to Slave 15) that will be the subject of the operation.

■ Master IP Address
Specify the IP address of the O/I Link Master that is used to communicate between the O/I Link Slave and the 
external device.

Click  to display IP Address Manager. Specify the IP address for the O/I Link Master with IP Address Manager.

This option can only be displayed when O/I Link Slave is selected for Communicate with and Ethernet is 
selected for Port in the Communication Settings dialog box. 

If the slave station number of the Touch is duplicated after downloading, communication is not possible.

Even if the slave station number of the Touch configured in the Target IP Address dialog box when 
downloading a project is rewritten, project data remains unchanged during editing.
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● IP Address Manager
You can register target Ethernet settings for performing online function via Ethernet communication to the project 
data.

■ IP Address List
Ethernet settings registered in the project data are displayed in this list.

■ IP Address
Enter the IP address to register in the project data.

■ Subnet Mask
Enter the subnet mask to register in the project data.

■ Default Gateway
Enter the default gateway to register in the project data.

■ Comment
Enter comment to register in the project data.

■ Add New
Adds IP Address, Subnet Mask, Default Gateway, and Comment to the list.

■ Delete
Deletes the selected IP address from the list.

■ Select
Closes IP Address Manager, and apply the Ethernet settings selected from the list.

IP Address: Shows the IP address.

Subnet Mask: Shows the subnet mask.

Default Gateway: Shows the default gateway.

Comment: Shows comment.
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2.1 Downloading Project Data to the Touch

1 Change communication settings according to the connection method between the computer and the Touch.

In the Communication Settings dialog box, select Touch from Communicate with. To communicate with the Touch 
as an O/I Link Slave via an O/I Link Master, select O/I Link Slave. For details, refer to “1.3 Change Communication 
Settings” on page 23-5.

2 Open a project to download.

3 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

4 Select data for download under Download Data.

■ All
Download the entire project data.

■ Modified Data Only
Downloads files modified since the previous download.
If download fails, select All to download.

■ Select Files
Download the specified files. Click Browse to display the Open Screens dialog box. Select Screen Type, select the 
screen to be downloaded from Screen List and then click OK. The selected screen is added to the list.

2 Downloading

To download a project without opening it, on the Home tab, in the Project group, click the Download 
icon. The Open dialog box is displayed. Select a file then click Open. The Download dialog box is displayed. 
Proceed to Step 4.

When project data is downloaded to the Touch, the Touch screen data is overwritten.

If the project data was changed, a confirmation message to save the project data is displayed.
• Click OK to save the project data and display the Download dialog box.
• Click Cancel to return to the editing screen without saving the project data.
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5 Click Download.

• When Communicate with is set to Touch and Port to USB, the project data starts downloading.
• When Communicate with is set to Touch and Port to Ethernet, the Target IP Address dialog box is displayed. 

Specify the IP address of the Touch, and then click OK to start the download. For details, refer to “To download 
project data” on page 23-7.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to download to, then click OK to start the download.
If Port is set to Ethernet, specify the IP address of the O/I Link Master via which to download. For details, refer to 
“To download project data” on page 23-8.

6 Click Yes.

The Download Project dialog box is displayed and the project file starts downloading.
When finished downloading, a completion message is displayed.

7 Click OK.

8 Click Close on the Download Project dialog box.

This concludes downloading project data.

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

• Do not turn off the Touch while project data is downloading.
• If project data downloading fails and communication is not possible, turn the Touch off and on, then 

download the data once again.
• During communication with an O/I Link Slave using the online function, O/I Link Master operation is 

stopped.

For details on writing project data to an external memory inserted in the computer, refer to Chapter 26 
“Downloading” on page 26-6.
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2.2 Download Dialog Box

This section describes items and buttons of the Download dialog box.

■ Communication Settings

■ Download Data
Selects data to be downloaded.

■ Automatic start Control Function after download
After project data is downloaded, the ladder program or FBD program starts automatically (M8000 is set to 1).

■ Clear Keep Device
Select this check box to clear Keep Device after the project data is downloaded. Note that when a project data with a 
changed data storage area setting is downloaded, Keep Device are always cleared.

Communicate with: Available computer devices are displayed.

Port: Available communication ports on the computer are displayed.

Change: Changes communication settings. Click this button to display the Communication Settings dialog 
box. For details, refer to “1.3 Change Communication Settings” on page 23-5.

All: All project data is downloaded.

Modified Data Only: Only files that were updated since the previous download are downloaded.
If an upload fails, select All to download.

Select Files: Specifies a screen for download.

Browse: The screen to be downloaded is added to the list. Click Browse to display 
the Open Screens dialog box. Select Screen Type, then select the screen to 
be downloaded from Screen List, and then click OK. The selected screen is 
then added to the list.

Specific Data List: Lists the properties of the specified screen

No.: Displays the Screen No. of the specified screen

Title: Displays the title of the specified screen

Screen Type: Displays the screen type of the specified screen

File Name: Displays the file name of the specified screen

Options: Used for settings to download runtime system and additional fonts. Click to display the Options 
dialog box. For details, refer to “Options dialog box” on page 23-15.
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■ Download Recipe Files to External Memory
Select this check box to create a RECIPE folder or recipe files in an External Memory Folder on an external memory 
inserted in the Touch when downloading projects. Only on channels for which Save to in the Recipe Settings dialog 
box is set to External Memory, and Recipe Function is set to Use.
• When Download Data is set to All, recipe files are created for all channels for which recipe data is set.
• When Download Data is set to Modified Data Only, only recipe files on channels where recipe data has 

changed are created.
• When Download Data is set to Select Files, no recipe file is created.

■ Download
• When Communicate with is set to Touch and Port to USB, the project data starts downloading.
• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the Touch, and then click OK to start the download. For details, refer to “To 
download project data” on page 23-7.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to download to, then click OK to start the download.
If Port is set to Ethernet, specify the IP address of the master via which to download. For details, refer to “To 
download project data” on page 23-8.

• When Communicate with is set to External Memory, the Select Drive dialog box is displayed. Select the 
external memory drive, then click OK to start the download. For details, refer to “2.3 Downloading Files to an 
External Memory Inserted in the Touch” on page 23-16.

■ Cancel
Stops downloading of project data.

• Do not turn off the Touch while project data is downloading.
• If project data downloading fails and communication is not possible, turn the Touch off and on then 

download the data once again.
• During communication with an O/I Link Slave using the online function, O/I Link Master operation is 

stopped.
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Options dialog box

Download runtime system and additional fonts.

■ Download Runtime system
Select this check box to force download runtime system, irrespective of the runtime system version of the Touch, 
when downloading project data. Normally this option should not be used.

■ Download additional fonts
Select this check box to download additional fonts when downloading project data.
If this check box is selected, the following additional fonts can be selected for download to the Touch.
Japanese Large Font (First standard), Japanese Large Font (Second Standard), Chinese, Taiwanese, 
Korean, European Large Font, Central European, Baltic, and Cyrillic.

• For details about additional fonts, refer to Chapter 2 “Installed Fonts in the Touch” on page 2-6.
• Clear the Download Additional Fonts check box, to delete all additional fonts that have been 

downloaded to the Touch.
• The additional fonts downloaded to the Touch whose check box is cleared will be deleted from the Touch.

Target font size (byte): Shows the total size of the basic fonts and selected additional fonts.
If no additional fonts are selected for download to the Touch, shows the size of 
the basic fonts.

Downloadable project size (byte): Shows the amount of project data that can be downloaded. This figure varies 
according to the additional fonts selected.

Target Font Information: Confirms the additional fonts installed on the Touch.
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2.3 Downloading Files to an External Memory Inserted in the Touch

Specified files can be downloaded to an external memory inserted in the Touch. The files are downloaded to External 
Memory Folder specified in the Project Settings dialog box for the current project.

1 Insert the external memory into the Touch.

2 Change communication settings according to the connection method between the computer and the Touch.

In the Communication Settings dialog box, select Touch from Communicate with. To communicate with the Touch 
as an O/I Link Slave via an O/I Link Master, select O/I Link Slave. For details, refer to “1.3 Change Communication 
Settings” on page 23-5.

3 On the Home tab, in the Project group, click the arrow under Download.

4 Select the method for downloading the file to the external memory.

The Open dialog box is displayed.

■ Files to External Memory
Stops operation of the Touch and downloads the file to the external memory inserted in the Touch. When the file 
download is complete, operation resumes.

■ Files to External Memory while running
Downloads the file to the external memory inserted in the Touch without stopping operation of the Touch.

5 Select the file, and then click Open.

• When Communicate with is set to Touch and Port to USB, the project data starts downloading.
• When Communicate with is set to Touch and Port to Ethernet, the Target IP Address dialog box is displayed. 

Specify the IP address of the Touch, and then click OK to start the download. For details, refer to “To execute any 
function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to download to, then click OK to start the download.
If Port is set to Ethernet, specify the IP address of the master via which to download. For details, refer to “To 
execute any function except project data download” on page 23-9.

USB flash device
Touch

While editing project data, even if you click the arrow under Download in the Transfer group on the 
Online tab, the download menu will be displayed.

If security is enabled in the Touch project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.



SmartAXIS Touch User's Manual 23-17

2 Downloading

23

O
nline Function

6 Click Yes.

The External Memory Maintenance dialog box is displayed and the file starts downloading.
When finished downloading, a completion message is displayed.

7 Click OK.

8 Click Close in the External Memory Maintenance dialog box.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.

To create a recipe file on an external memory inserted in the computer, use Save Recipe File to External 
Memory in the Recipe Settings dialog box. For details, refer to Chapter 18 “Creating Recipe Files in the 
Recipe Settings Dialog Box” on page 18-17.
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Project data in the Touch or in an external memory inserted in a computer can be read using WindO/I-NV3 and saved 
to the computer.

3.1 Upload Project Data from the Touch

1 Change communication settings according to the connection method between the computer and the Touch.

In the Communication Settings dialog box, select Touch from Communicate with. To communicate with the Touch 
as an O/I Link Slave via an O/I Link Master, select O/I Link Slave. For details, refer to “1.3 Change Communication 
Settings” on page 23-5.

2 On the Home tab, in the Project group, click the Upload icon.

• When Communicate with is set to Touch and Port is set to USB, the Upload dialog box is displayed.
• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the Touch, and then click OK to start the upload. For details, refer to “To 
execute any function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to communicate with, and then click OK to display the Upload dialog box.
If Port is set to Ethernet, specify the IP address of the master via which to upload. For details, refer to “To 
execute any function except project data download” on page 23-9.

3 Uploading

While editing project data, project data can be uploaded from the Touch even by clicking the Upload icon 
in the Transfer group on the Online tab.

If project data is being edited, project data will be closed. If the project data was changed, a confirmation 
message to save the project data is displayed.
• Click Yes to save the project data and display a dialog box corresponding to the communication settings.
• Click No to close the project data without saving changes and display a dialog box corresponding to the 

communication settings.
• Click Cancel to stop uploading and return to the editing screen without saving the project data.

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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3 Check the project data details, and then click Upload.

If there is a project file with the same file name in the upload folder, an overwrite confirmation message is displayed.
• Click Yes to start uploading the project data.
• Click Cancel to stop uploading the project data.
When finished uploading, a completion message is displayed.

■ Project Name
The project file is saved with the currently displayed name. To change the project name, enter a new name for the 
file. The maximum number is 50 characters.

■ Location
The uploaded project file is saved to the currently displayed location. To change the location of the saved file, 

click . The Save Project After Uploading dialog box is displayed. Select a location, and then click Save.

4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message to open the project is displayed.

You cannot use the following characters in the project name.
\ / : * ? " < > |
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6 Click OK.

The uploaded project opens.
This concludes uploading of project data.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.

For details on reading project data saved on an external memory using WindO/I-NV3, refer to Chapter 26 
“Uploading” on page 26-9.
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3.2 Upload Dialog Box

This section describes the settings and buttons of the Upload dialog box.

■ Project Name
The project file is saved with the currently displayed name. To change the project name, enter a new name for the 
file. The maximum number is 50 characters.

■ Comment
Displays comment on project data downloaded to the Touch.

■ Type Number
Displays the type number selected in project data downloaded to the Touch.

■ Modified
Displays the time that project data downloaded to the Touch was last saved in WindO/I-NV3.

■ Location
Specifies the location for saving uploaded project files.

Click  to display the Save Project After Uploading dialog box. Select the location for saving, then click Save.

■ Upload files used in this project from the External Memory
To upload files located on an external memory inserted in the Touch that are used by the project together with 
project data, select the file to be uploaded from the following.
Recipe Files

■ Upload
Starts uploading of project data.

■ Cancel
Stops uploading of project data.

You cannot use the following characters in the project name.
\ / : * ? " < > |
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Deletes data from the Touch or from an external memory inserted in the Touch.

4.1 Clear Data from the Touch

1 Change communication settings according to the connection method between the computer and the Touch.

In the Communication Settings dialog box, select Touch from Communicate with. To communicate with the Touch 
as an O/I Link Slave via an O/I Link Master, select O/I Link Slave. For details, refer to “1.3 Change Communication 
Settings” on page 23-5.

2 Open project data.

3 On the Online tab, in the Touch group, click Clear, then click the data to be deleted.

■ All
Deletes project data, Alarm Log data, Data Log data, and Operation Log data. It also clears the HMI Keep Register 
(LKR) and HMI Keep Relay (LK).

■ Alarm Log Data
Deletes the data collected by the Alarm Log function.

■ Data Log Data
Deletes the data collected by the Data Log function.

■ Operation Log Data
Deletes the data collected by the Operation Log function.

■ Data of all Device Addresses
Clears the data of all device addresses.

■ Stored Data in External Memory
After stopping operation, deletes data saved to an External Memory Folder on an external memory.
Click this to display the Clear Data dialog box. For details, refer to “4.2 Deleting Data from an External Memory 
Inserted in the Touch” on page 23-24.

• When Communicate with is set to Touch and Port to USB, deletion of the data starts.
• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the Touch, and then click OK to start deletion of the data. For details, refer to 
“To execute any function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to communicate with, and then click OK to start deletion of the data.
If Port is set to Ethernet, specify the IP address of the master to be used. For details, refer to “To execute any 
function except project data download” on page 23-9.

4 Clear

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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4 Click Yes.

5 Click Close.

This concludes clearing data.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.
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4.2 Deleting Data from an External Memory Inserted in the Touch

1 Change communication settings according to the connection method between the computer and the Touch.

In the Communication Settings dialog box, select Touch from Communicate with. To communicate with the Touch 
as an O/I Link Slave via an O/I Link Master, select O/I Link Slave. For details, refer to “1.3 Change Communication 
Settings” on page 23-5.

2 Open project data.

3 On the Online tab, in the Touch group, click Clear, then click Stored Data in External Memory.

The Clear Data dialog box is displayed.

4 Select the check box for the data items to be deleted from the External Memory Folder.

Alarm Log Data, Data Log Data, Operation Log Data, and Recipe Files

5 Click OK.

• When Communicate with is set to Touch and Port to USB, deletion of the data starts.
• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 

displayed. Specify the IP address of the Touch, and then click OK to start deletion of the data. For details, refer to 
“To execute any function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to communicate with, and then click OK to start deletion of the data.
If Port is set to Ethernet, specify the IP address of the master to be used. For details, refer to “To execute any 
function except project data download” on page 23-9.

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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6 Click Yes.

7 Click Close.

This concludes clearing data on the external memory.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.
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Stops operation of the Touch and formats an external memory inserted in the Touch.

5.1 Formatting an External Memory Inserted in the Touch

1 Change communication settings according to the connection method between the computer and the Touch.

If communicating with a Touch inserted in a computer, in the Communication Settings dialog box, select Touch from 
Communicate with. To communicate with the Touch as an O/I Link Slave via an O/I Link Master, select 
O/I Link Slave. For details, refer to “1.3 Change Communication Settings” on page 23-5.

2 Open project data.

3 On the Online tab, in the Touch group, click Format.

• When Communicate with is set to Touch and Port is set to USB, a formatting confirmation message is 
displayed.

• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 
displayed. Specify the IP address of the Touch, and then click OK to display the formatting confirmation message. 
For details, refer to “To execute any function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to communicate with, and then click OK to display the formatting confirmation message.
If Port is set to Ethernet, specify the IP address of the master to be used. For details, refer to “To execute any 
function except project data download” on page 23-9.

4 Click Yes.

5 Click Close.

This concludes formatting the external memory.

5 Formatting

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.
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Displays information about the runtime system and downloaded project data of the Touch.
This function can be used to show information about project data during editing and to simultaneously check details 
of project data downloaded to the Touch.

6.1 Displaying System Information

1 Change communication settings according to the connection method between the computer and the Touch.

If communicating with a Touch inserted in a computer, in the Communication Settings dialog box, select Touch from 
Communicate with. To communicate with the Touch as an O/I Link Slave via an O/I Link Master, select 
O/I Link Slave. For details, refer to “1.3 Change Communication Settings” on page 23-5.

2 On the Home tab, in the Project group, click Target Info..

• When Communicate with is set to Touch and Port is set to USB, the System Information dialog box is 
displayed.

• When Communicate with is set to Touch and Port is set to Ethernet, the Target IP Address dialog box is 
displayed. Specify the IP address of the Touch, and then click OK to display the System Information dialog box. For 
details, refer to “To execute any function except project data download” on page 23-8.

• When Communicate with is set to O/I Link Slave, the Target Slave dialog box is displayed. Specify the slave 
station of the Touch to communicate with, and then click OK to display the System Information dialog box.
If Port is set to Ethernet, specify the IP address of the master to be used. For details, refer to “To execute any 
function except project data download” on page 23-9.

6 System Information

While editing project data, information about runtime system and project data can be displayed even by 
clicking Target Info. in the Touch group on the Online tab.

If security is enabled in the Touch project, the Password Screen is displayed. Enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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3 Check information about the runtime system and project data.

4 When you have finished checking the information, click OK.

5 Click Close.

This concludes checking system information.

• To check the additional fonts installed on the Touch, click Font Information. The Font Information 
dialog box is displayed. For details, refer to “Font Information Dialog Box” on page 23-30.

• To check information about the external memory inserted in the Touch, click External Memory 
Information. The External Memory Information dialog box is displayed. For details, refer to “External 
Memory Information Dialog Box” on page 23-30.

During communication with an O/I Link Slave using the online function, O/I Link Master operation is 
stopped.
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6.2 Target Information Dialog Box

This section describes the settings and buttons of the Target Information dialog box.

■ Target Runtime Information

■ Target Project Information

■ Opened Project Information

Product Series: Shows the type number of Touch

Runtime Version: Shows the runtime system version of the Touch.

Memory Space (byte): Shows the maximum amount of project data (bytes) that can be downloaded to the Touch.

Font Information: Checks the additional fonts currently installed on the Touch. Click this button to display the 
Font Information dialog box. For details, refer to “Font Information Dialog Box” on page 23-
30.

External Memory Information: Checks the state of an external memory inserted in the Touch, its total capacity, 
available capacity, and used capacity. Click this button to display the External Memory 
Information dialog box. For details, refer to “External Memory Information Dialog Box” 
on page 23-30.

Project Name: Shows the project name of projects downloaded to the Touch.

Modified Date: Displays the time that project data downloaded to the Touch was last saved in WindO/I-NV3.

Project Version: Displays the version of WindO/I-NV3 used to create the project data downloaded to the 
Touch.

External Device Manufacturer: Displays the external device manufacturer configured in the project downloaded to the 
Touch.

Protocol: Displays the communication driver configured in the project downloaded to the Touch.

Driver Version: Displays the version of the communication driver.

Project Name: Shows the project name of the project being edited.

Modified Date: Displays the time that the project being edited was last saved in WindO/I-NV3.

Version Number: Displays the version of WindO/I-NV3 used to create the project being edited.

This function can be used to show information about a project that is being edited and simultaneously check 
information about project data downloaded to the Touch.
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Font Information Dialog Box

This dialog box is used to check the state of installed additional fonts.

The installation status of each additional font is shown to the right of the font. The following additional fonts can be 
installed.
• Japanese Large Font (First standard)
• Japanese Large Font (Second standard)
• Chinese
• Taiwanese
• Korean
• European Large Font
• Central European
• Baltic
• Cyrillic

External Memory Information Dialog Box

Checks the state of an external memory inserted in the Touch, its total capacity, available capacity, and used 
capacity.

State: Shows the state of the external memory inserted in the Touch.

Memory Capacity: Shows the total capacity (bytes) of the external memory inserted in the Touch.

Free Space: Shows how much of the capacity (bytes) of the external memory inserted in the Touch is 
currently available for use.

Used Space: Shows how much of the capacity (bytes) of the external memory inserted in the Touch is 
currently in use.
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This chapter describes the monitor function that checks operation of the created project data.
Monitor function enables the values of internal devices and the values of external devices to be checked and changed. 
This can be done in two ways: using WindO/I-NV3 on a computer connected to the Touch, or directly on the screen 
of the Touch.

  

1.1 How the Monitor Function in WindO/I-NV3 is Used

Monitor function in WindO/I-NV3 can be performed as follows.

• Checking values of devices used on the screen of the Touch

• Checking values of specified devices

• Checking values of devices of sequential addresses

Chapter 24 Monitor Function

1 Monitoring with WindO/I-NV3

Computer Touch
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Length: 3
(Starting address)
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• Checking the state of external devices connected to the Touch

• Displaying the value of device in a popup

• Highlighting objects while satisfying conditions

Object List window Script Editor

Computer

Disconnect

Connect

Touch

130

External device

External device

External Device Monitor

Station No. 0
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Station 
No. 0
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• Switching to the screen of the Touch

• Opening current screen

Computer

Switches to Base Screen 2.

Touch

130

Full

Tank 1

External device

External device

Base Screen 1

Base Screen 2

Computer

Opens to 
Base Screen 2.

Touch

Full

Tank 1

Full

Tank 1

External device

External device

Base Screen 2

Base Screen 2

Click

Monitor function in WindLDR can be performed as follows.
• Monitoring the ladder program
refer to Chapter 12 “Monitor Operation” on page 12-12

• Monitoring the FBD program
refer to Chapter 12 “Monitor Operation” on page 12-38
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1.2 Debugging in WindO/I-NV3

This section describes the procedure for monitoring values of devices and debugging in WindO/I-NV3.

1 Change the communication setting to match the connection method between computer and Touch.

For details, refer to Chapter 23 “1.3 Change Communication Settings” on page 23-5.

2 On the Online tab, in the Monitors group, click Start Monitor.

The Touch switches to monitor mode and Monitor Mode is displayed at the bottom left of the screen.

3 On the Online tab, in the Monitors group, click the following button or enter the number to the text box to switch 
the screen displayed on the Touch to the Monitor screen.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using  (Back).

■  (First Screen)
Switches to the Base Screen of the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not sequential, switches to the screen of next lowest number.

■  (Specified Screen)
Switches to the Base Screen with the specified number.

■  (Next Screen)
Switches to the screen with screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive, switches to the screen of next highest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

4 On the Online tab, in the Monitors group, click Open Current Screens.

 The screen displayed on Touch opens in the editing window.

If a password has been configured for the project data, the Enter Password screen will be displayed. Enter 
the password. For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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5 On the Online tab, in the Monitors group, select the monitor being used.

When monitoring starts, the screen monitor is displayed.

■ Screens
Automatically checks device addresses used on the screen displayed on the Touch. For details, refer to “Screen 
Monitor” on page 24-6.

■ Object List
Displays values of devices in a popup on the Object List window. It also highlights objects while satisfying 
conditions. For details, refer to “1.3 Display the Value of Device in Popup” on page 24-16, and “1.4 Highlighting 
Objects While Satisfying Conditions” on page 24-16.

■ Custom
Registers monitored devices individually and displays the value of devices. For details, refer to “Custom Monitor” on 
page 24-7.

■ Batch
Registers monitored devices as a batch for sequential addresses and displays the value of devices. For details, refer to 
“Batch Monitor” on page 24-14.

■ External Devices
Displays the state of external devices connected to the Touch. For details, refer to “External Device Monitor” on page 
24-15.

6 Check operation of project data by monitoring and changing values of devices, and edit project data if there is an 
error.

If the monitored screen is switches, repeat steps 3 through 4.

7 Download the edited project data to the Touch.

8 On the Online tab, in the Monitors group, click Stop Monitor.

To reflect edits made during debugging, it is necessary to perform a download.
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● Screen Monitor
Automatically displays device addresses used on the screen displayed on the Touch. Enables values of devices to be 
monitored and changed.

■ Device Address
Displays the device addresses used on the screen displayed on the Touch.

 next to Comment toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

■ Comment
Displays comments on device addresses saved in Tag Editor. Comments are displayed only after you click  next to 
Device Address to display a popup menu, then click Comment and select the check box. 

■ Value
Displays the current value of device address in decimal format. To change a value, double-click a cell and then specify 
a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to display a popup menu, 
then click HEX and BIN and select the check box.

■ Hexadecimal, Binary
Displays the current value of device address in hexadecimal and binary format. To change a value, double-click a cell 
and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

Comments are displayed only after you click  next to Value to display a popup menu and then select the HEX and 
BIN check box.

■ Data Type
Selects the data type of the selected value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

• The values of device addresses configured as write-only, such as destination device address for bit 
buttons, cannot be monitored. “????” is displayed in this case.

• If BIN32, BCD8, or float32 is selected from Data Type for the address of highest number, the values 
stored in the device address are displayed repeatedly.

• If BIN32, BCD8, or float32 is selected from Data Type, sequential addresses (lower word to upper 
word) are used.
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● Custom Monitor
Enables the values of registered device addresses to be monitored and changed.

■ Add to List
Saves device addresses registered in Monitor to project data as a custom monitor list. A saved lists can be monitored 
by selecting it from the List.
Click this button to display the Device List Name Setting dialog box. For details, refer to “Saving Registered Device 
Addresses to Project Data as a Custom Monitor List” on page 24-10.

■ Device
Registers the device addresses to monitor individually.
Click this button to display the Device Address Settings dialog box. For details, refer to “Registering the device 
addresses to monitor individually” on page 24-8.

■ Script
Batch saves all device addresses used in a script.
Click this button to display Script Manager. For details, refer to “Batch Saving Device Addresses Used in Scripts” on 
page 24-9.

■ Import
Imports the device addresses from a device list saved as a CSV text file.
Click this button to display the Open dialog box. For details, refer to “Importing Devices from a Device List” on page 
24-12.

■ Export
Saves the device addresses displayed in Monitor as a CSV text file. This file is called a Device List.
Click this button to display the Save As dialog box. For details, refer to “Saving a Custom Monitor List as a CSV File” 
on page 24-11.
The saved device list can be imported using Import.

■ Clear
Deletes all the device addresses displayed in Monitor.

■ List
Displays a custom monitor list saved with the project data.
Select a list to clear the device addresses shown in Monitor and display the device addresses in the list.
Double-click a cell to display the Device List Name Setting dialog box. The name of the custom monitor list can be 
edited.
Select a list and press DELETE to delete it from the List.



1 Monitoring with WindO/I-NV3

24-8 SmartAXIS Touch User's Manual

■ Monitor
The registered device addresses are displayed in a list.
Select the custom monitor list from the List to show the device addresses registered in the list.

Registering the device addresses to monitor

Registering the device addresses to monitor individually

Click Device. Or, double-click a cell under Device Address in Monitor, and then click .
The Device Address Settings dialog box is displayed. For details on configuring device address settings, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

Device Address: The registered device addresses are displayed.

Double-click a cell to register or change a device address. Click  to display the Device 
Address Settings dialog box. For details on how to configure device address settings, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

 toggles between showing and hiding comments. When comments are displayed, click  to 
display a popup menu, then click Comment and select the check box.

Comment: Displays comments on device addresses saved in Tag Editor. Comments are displayed only 
after you click  next to Device Address to display a popup menu, then click Comment 
and select the check box.

Value: Displays the current value of device address in decimal format. To change a value, double-
click a cell and then enter a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.

Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to 
display a popup menu, then click HEX and BIN and select the check box.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.

Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.

Data Type Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available 
Data” on page 2-1.

• If BIN32, BCD8, or float32 is selected from Data Type for the address of highest number, the values 
stored in the device address are displayed repeatedly.

• If BIN32, BCD8, or float32 is selected from Data Type, sequential addresses (lower word to upper 
word) are used.
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Batch Saving Device Addresses Used in Scripts

1 Click Script.

Script Manager is displayed.

2 Select the script ID of the script for the device address to be batch-saved, and then click Select.

All the device addresses used by the script are registered.
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Saving Registered Device Addresses to Project Data as a Custom Monitor List

If registered device addresses are saved with project data as a list, then even when the project data is later 
reopened, the device addresses can be called from the List to be reutilized.

1 Click Add to List.

The Device List Name Setting dialog box is displayed.

2 Enter a name for the custom monitor list.

The maximum number is 40 characters. Only alphanumeric characters and symbols can be used.

3 Click OK.

The custom monitor list is added to the List.

4 Saving project data.

The following characters cannot be used for names of custom monitor list.
\ / : * ? " < > |

If a project file is closed without saving, custom monitor lists will not be saved with the project data.
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Saving a Custom Monitor List as a CSV File

To use a custom monitor list (registered devices list) in another project, save it as a CSV text file. This file is called a 
Device List.

1 Click Export.

The Save As dialog box is displayed.

2 Select Save in, enter a File name, and then click Save.

This concludes saving device list.
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Importing Devices from a Device List

Imports the device addresses from a device list saved as a CSV text file into custom monitor.

1 Click Import.

The Device List dialog box is displayed.

2 Click .

The Open dialog box is displayed.

3 Select a saved device list, and then click Open.

The device addresses are listed.
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4 Click the device address to import.

5 Click OK.

If there is an already registered device address on the Custom Monitor, an overwrite confirmation message is 
displayed.
• Click Yes to overwrite the device address displayed in the confirmation message.
• Click Yes To All to overwrite all the device addresses.
• Click No to display the next confirmation message without overwriting the device address displayed in the 

confirmation message.
• Click Cancel to stop importing device addresses.

The device is added to Monitor.

To select multiple items of text, press and hold SHIFT or CTRL while you click the specific items.
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● Batch Monitor
Displays sequential addresses as a batch.

■ Target
Select Touch or External Devices from the device addresses that include the device addresses to be set.

■ Station No.
Specify the station number of the external device. The range of possible settings can be varies according to the 
selected communication drivers.
This option can only be configured when 1:N Communication is selected under Connection in the Select 
Communication Driver dialog box or the Change Communication Driver dialog box.

■ Device Type
Selects the device type.
The list only shows device types that can be used.

■ Address
Specify the address. The range that can be set varies based on the device type selected.

■ Bit
Specify the bit (0 to 15) of the word device when a word device is selected in Device.

■ Length
Specifies the number of device addresses displayed in the list (Bit of the word device specification: 1 to 16, Other 
than above: 1 to 1000).

■ Data Type
Selects the data format of the displayed value. For details, refer to Chapter 2 “1.1 Available Data” on page 2-1.

■ (Monitor)
Automatically displays the selected device addresses, in the number specified under Length, from top to bottom, 
consecutively.

(Monitor)

Device Address: The specified device addresses are displayed.
 toggles between showing and hiding comments. When comments are displayed, click  to 

display a popup menu, then click Comment and select the check box.

Value: Displays the current value of device address in decimal format. To change a value, double-
click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Click  to toggle display of HEX and BIN format. To display HEX and BIN values, click  to 
display a popup menu, then click HEX and BIN and select the check box.
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● External Device Monitor
Displays the state of external devices connected to the Touch.
Can be used only for 1:N communication devices.

■ (Connection status)
Displays the state of external devices connected to the Touch. If a red cross appears over the icon of an external 

device ( ), communication is stopped.
Clicking the external device icon enables switching between connection and disconnection.

■ (Station No.)
Displays the station number of all external devices used in the project.

Hexadecimal, Binary: Displays the current value of device address in hexadecimal and binary format. To change a 
value, double-click a cell and then specify a value.
The value range depends on the data type. For details, refer to Chapter 2 “1.1 Available Data” 
on page 2-1.
Comments are displayed only after you click  next to Value to display a popup menu and 
then select the HEX and BIN check box.

• If BIN32, BCD8, or float32 is selected from Data Type for the address of highest number, the values 
stored in the device address are displayed repeatedly.

• If BIN32, BCD8, or float32 is selected from Data Type, sequential addresses (lower word to upper 
word) are used.

(Connection status)
(Station No.)
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1.3 Display the Value of Device in Popup

During monitoring, mousing over device addresses displayed in the Object List window or device addresses in a 
script opened in Script Editor displays the current value in a popup window.

• Object List window

• Script Editor

1.4 Highlighting Objects While Satisfying Conditions

When the Trigger Condition is satisfied during monitoring, the objects for which conditions are being satisfied are 
highlighted in the Object List window.

• Popup viewing of values of devices in the Object List window works only if the screen displayed in the 
Object List window matches the screen displayed on the Touch.

• Popup viewing of values of devices in Script Editor works only if the script during editing is being used by 
a global script command or a script command on the screen displayed on the Touch.

• The maximum number for popup window is 80 characters. Any characters entered after the 80th will not 
be displayed.

• If 65 or more device addresses are displayed in the Object List window, monitor refreshing and popup 
message will slow down.
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1.5 Switching the Screen of the Touch

During monitoring, it is possible to switch to the screen displayed on the Touch using a WindO/I-NV3 command.

■  (Back)
You are returned to the Base Screen that was displayed immediately before the screen was switched.

■  (Forward)

Advances to the Base Screen that was displayed immediately before the screen was switched using the  (Back).

■  (First Screen)
Switches to the Base Screen with the lowest screen number in the project data.

■  (Previous Screen)
Switches to the Base Screen of screen number one lower than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, this command switches to the closest number.

■  (Specified Screen)
Switches to the Base Screen of a specified number.

■  (Next Screen)
Switches to the Base Screen of screen number one higher than the Base Screen currently displayed. If the screen 
numbers are not consecutive numbers, switches to the closest number.

■  (Last Screen)
Switches to the Base Screen of highest screen number in the project data.

1.6 Open Current Screens

To automatically open the screen displayed on the Touch during monitoring and put it into an active state, click Open 
Current Screens. 
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It is possible to change values of devices and check the operation on the Touch, without connecting to a computer.

2.1 How the Monitoring Function is Used

Monitoring in the Touch can perform the following functions.

• Checking and changing the value of specified device

• Checking ladder program

2 Monitoring on the Touch

Touch

��

Touch

� � � � ESC OK

IMOV
N

M0001

I0000

D0000
-01

00001

00002
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2.2 Device Monitor

By registering device addresses in Run Mode, both data monitoring and changing can be conducted. Registered 
device addresses are listed in Device Monitor in ascending order (A to Z, 0 to 9). Registered device addresses are 
saved until power to the Touch is turned OFF, or the mode is changed.

● Displaying Device Monitor

1 Press the upper-left corner of the screen on the Touch for three seconds or more.

The Maintenance Screen is displayed.

2 Press Device Monitor.

Device Monitor is displayed.

• Available device address range depends on types and settings of external devices. Selecting unavailable 
device address, “Communication error” happens and it can not be back in without reboot. For details, 
refer to Chapter 30 “1.1 Errors Displayed on the Screen” on page 30-1.

• If three Popup Screens are displayed on the screen (or if two Popup Screens are displayed in the Alarm 
Log Settings), in order to use Device Monitor in the same way on Popup Screens, the Device Monitor 
cannot be used. 

Press and hold three 
or more seconds

Touch

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.
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● Device Address Registration

1 Press Select on Device Monitor.

The Select Device screen is displayed.

2 Press Up or Dwn to select the device type.

3 Enter the address and then press ENT.

• Press CLR to clear all values entered for the address.
• Press CAN to stop registering devices.

The device address is registered to Device Monitor.

4 Repeat steps 1 through 3 to register all device addresses to be monitored.

Dec/Hex

��

�

�

The next address of the device address entered previously is automatically displayed in the Select Device 
screen.

�

�

• If a device address is invalid, pressing ENT will not return to Device Monitor.
• For 1:N communication, : is displayed. Enter the station number as a 2-digit hexadecimal value. Press :, 

specify the station number and then enter the address.
• Control device addresses are displayed on Device Monitor with a # before the device type.

Example: When setting D100

Device Monitor: #D100

Ladder Monitor: D100

Dec/Hex

��
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● Changing Value of Device

1 Press Up or Down to select the device to be changed the value.

2 Press Data on Device Monitor.

The Write Data screen is displayed.

3 Press  to switch the display type for values of devices.

Switches between DEC and HEX.

4 Enter the value of device and press ENT.

• Press CLR to delete the entered value of device.
• Press CAN to stop entering the value of device.

The value of device is changed.

Dec/Hex

��

Dec/Hex

��

Dec/Hex

Dec/Hex

Dec/Hex

• If a value of device is invalid, pressing ENT will not return you to Device Monitor.
• If the display type is decimal, A to F cannot be used.

Dec/Hex

��
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● Device Monitor Configuration

■ Title Bar

Displays the title,  (Move) button, and (Close) button.

■
Switches the display type for the current value of device. Switches between DEC and HEX.

■ (Device Address)
The registered device address is displayed.

■ (Value)
The current value of device is displayed.

■ (Focus)
Highlights the selected device address.

■ ▲
Moves the focus up by one line.

■ ▼
Moves the focus down by one line.

■ Data
Changes the value of the selected device address. Press to display the Write Data Screen. For details, refer to 
“Changing Value of Device” on page 24-21.

■ Del
Deletes the selected device address.

■ Select
Registers a selected device address. Press to display the Select Device Screen. For details, refer to “Device Address 
Registration” on page 24-20.

Dec/Hex

��

Close button

(Value)

Move button

(Device Address)

(Focus)

Title bar

 (Move) button: Moves the Device Monitor.

 (Close) button: Closes the Device Monitor.

Dec/Hex
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2.3 Ladder Monitor

This function displays the ladder program along with execution states. This enables you to visually understand the 
states of the ladder program. The Ladder Monitor can only be used when ladder program is selected as the 
programming language for control function. For details, refer to Chapter 2 "Ladder Program Monitoring on the 
SmartAXIS" in the "SmartAXIS Ladder Programming Manual".

● Displaying Ladder Monitor
Use the Goto Screen Button, the Goto Screen Command, or the follow method to display the Ladder Monitor.

1 Press the upper-left corner of the screen on the Touch for 3 seconds or more.
The Maintenance Screen is displayed.

2 Press Ladder Monitor.
The select line screen is displayed.

3 Press Last Monitored Line or Go To ....
Select Last Monitored Line to display the Ladder Monitor and start the monitor from the last monitored line.
Select Go To ... to display the Go To screen. Enter the desired line and press  to display the Ladder Monitor and 
start the monitor from the specified line.

● Moving the focus

1 The Ladder Monitor is displayed.
Use the Goto Screen Button, the Goto Screen Command, or the Maintenance Screen to display the Ladder Monitor.

2 Press , , , and  to move the focus to the desired position.
Press and hold to repeatedly move the focus.

● Displaying instruction parameters

1 The Ladder Monitor is displayed.
Use the Goto Screen Button, the Goto Screen Command, or the Maintenance Screen to display the Ladder Monitor.

2 Press , , , and  to move the focus to the desired instruction.  

3 Press .
The detailed information screen is displayed. 

4 Press .
Closes the detailed information screen.

Press and hold three 
or more seconds

Touch

If a password has been configured for the project data, the Enter Password screen will be displayed. Select 
a user name and then enter a password. For details, refer to Chapter 21 “User Accounts and the Security 
Function” on page 21-1.

When the following operations are performed, Last Monitored Line is reset to the first line of the ladder 
program. 
• The power is turned on.
• The project is downloaded.

↑ ↑

↑ ↑

↑ ↑

↑ ↑
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● Ladder Monitor Configuration

■  Display
This area displays the ladder program and the parameters for the instructions.

Touch

� � � � ESC OK

IMOV
N

M0001

I0000

D0000
-01

00001

00002
Display

Focus

Operation buttons

Ladder program: Displays the ladder program used by the running project.
Up to five symbols can be displayed per line.
Example:

Line No.: Shows the ladder program line number.

Symbol: Shows the instruction symbol.  

Focus: Displays the selected instruction with the colors reversed.  

Device addresses or instructions:

The LOD, LODN, OUT, OUTN, SET, RST, AND, ANDN, OR, and ORN instructions 
display the device address under the symbol. The displayed device addresses are as 
follows.
"Device type (one character)" + "Address (four characters)" (+ "Bit position (two 
characters)")
For details, refer to Chapter 27 “1.2 Control Device Addresses” on page 27-4 and 
Chapter 27 “2.2 Control Device Addresses” on page 27-12.
MCS, MCR, JMP, END, LABEL, LJMP, LCAL, and LRET instructions are displayed in one 
line on the screen. 
The instructions other than those listed above display the instruction name under 

 up to a maximum of five characters.

MOV

M0000

I0000

M0001 M0002

00001

00002
M0003 M0004

Line No.

Symbol Focus

Device addresses 
or instructions

Details of the following instructions can be displayed in the details screen:

Basic instructions: LOD, LODN, OUT, OUTN, SET, RST, AND, ANDN, OR, ORN, TML, TIM, TMH, TMS, 
TMLO, TIMO, TMHO, TMSO, CNT, CDP, CUD, CNTD, CDPD, CUDD, SFR, SFRN, CC=, 
CC>=, DC=, DC>=

Move instructions: MOV, MOVN, IMOV, IMOVN, IBMV, IBMVN

Binary arithmetic instructions:

ADD, SUB, MUL, DIV, INC, DEC, ROOT, SUM
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■ Operation button

Details: Displays detailed information for the selected instruction. Select an instruction on the ladder 
program and press  to display. The displayed content varies based on the instruction.
Example:

Label: Shows the name and data type of the instruction.

Instruction: Shows the instruction name up to a maximum of 5 characters.

Data type: Shows the data type. The displayed data types are as follows.
W (word), I (integer), D (double word), L (long), F (float)

Parameter: Shows the configuration details for the instruction.

OPCODE: MOV  (W)
S1 -: D0000 = 1234
D1 R: D0123 = 1234
REP : 03/99

Parameter

Label

Instruction Data type

: Moves the focus right by one line.

: Moves the focus left by one line.

: Moves the focus up by one line.

: Moves the focus down by one line.

: Toggles the contact state for the selected NO contact or NC contact.
Press and hold to display the detailed information for the instruction with focus.

: The operation varies based on the content displayed in the display.

Ladder program: Closes the Ladder Monitor.

Details: Closes the detailed information screen.

↑

↑

↑

↑
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This chapter describes the Project Transfer function to upload and download project data to the Touch using external 
memory.
The function to exchange data using external memory is generically referred to as the Data Transfer function.

  

1.1 How the Project Transfer Function is Used

The project transfer function uploads or downloads project data between the Touch and an external memory inserted 
in the Touch.

● Download project data saved on an external memory to the Touch. However, you must create project 
data for transfer.

● Upload the project data used for operation on the Touch and save it to an external memory.

1.2 Project Data Transfer Procedures

The following methods can be used to upload or download project data between the Touch and an external memory 
inserted in the Touch.

• Using the USB Autorun function
 For details, refer to Chapter 26 “2 USB Autorun Function” on page 26-18.

• Using Key Buttons, Multi-Buttons, or Multi-commands
 For details, refer to “1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data” on 

page 25-5.

Chapter 25 Data Transfer Function

1 Project Transfer Function

Create Project File 
for Transfer Download

TouchComputer

Project File
(ZNV Format)

USB flash drive

Project File
(ZNV Format)

Upload

Touch

USB flash drive

Project File
(ZNV Format)

When using the project transfer function and a project file is uploaded, the project file name is “project 
name + file extension (.ZNV)”.
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1.3 Converting Project Data for Transfer

Project data must be converted to dedicated data for transfer in order to download project data to the Touch using 
the project transfer function.
Use the following procedure to create project data for transfer using an external memory.

1 Insert a USB flash drive in the computer's USB port.

2 Open the project data to transfer using WindO/I-NV3.

3 On the Home tab, in the Project group, click the Download icon.

The Download dialog box is displayed.

4 Check that Communication Settings is External Memory, and then click Download.

The Select Drive dialog box is displayed.

Computer
USB flash drive

To USB Port

When the project data has not been saved after it was opened, a save confirmation message is displayed.
Click OK to save the project data and display the Download dialog box.
Click Cancel to return to the editing screen without saving the project data.

1. If Communication Settings is not External Memory, click Change.
The Communication Settings dialog box is displayed.

2. Select External Memory for Communicate with, and then click OK.
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5 Specify the drive for the USB flash drive, and then click OK.

A continue download confirmation message is displayed.

■ Drive
Specify the drive assigned to the external memory.

■ Network
Displays the Network Drive Assignment dialog box. You can specify a drive on the network.

■ External Memory Folder
Specify the folder where the project data is to be downloaded.

Click  to display the Project Settings dialog box. You can specify an External Memory Folder as the download 
destination.

6 Click Yes.

The Download dialog box is displayed and the project data is now being saved.
When this process is complete, a message is displayed.

7 Click OK.
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8 Click Close on the Download Project dialog box.

The project data for transfer is created in the External Memory Folder on an external memory.

For details about the created data folder and file structure, refer to Chapter 26 “External Memory Devices” 
on page 26-1. 

If the folder or file structure on the External Memory Folder is modified, the Touch and WindO/I-NV3 will 
not be usable.
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1.4 Using Key Buttons, Multi-Buttons, or Multi-Commands to Transfer Project Data

● Download

1 Create a project file for transfer (.ZNV) and save it on a USB flash drive.

For details, refer to “1.3 Converting Project Data for Transfer” on page 25-2.

2 Insert a USB flash drive in the Touch.

3 Press the Key Button or Multi-Button or execute the Multi-Command configured with Download Project under Data 
Transfer on the Key Browser.

● Upload

1 Insert a USB flash drive in the Touch.

2 Press the Key Button or Multi-Button or execute the Multi-Command configured with Upload Project under Data 
Transfer on the Key Browser.

Allocate a Key Button, Multi-Button, or Multi-Command configured with the project transfer function to the 
Touch.
 For details, refer to Chapter 7 “4 Key Button” on page 7-49.
 For details, refer to Chapter 7 “5 Multi-Button” on page 7-68.
 For details, refer to Chapter 11 “5 Multi-Command” on page 11-31.

Touch

USB flash drive

Touch

USB flash drive
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1.5 Precautions

• An error message is displayed if the project data upload or download fails.
For details, refer to Chapter 30 “1 Error Messages” on page 30-1.

• While the project transfer function is running, the Touch stops processing other functions.

• When project data is downloaded using the project transfer function, the HMI Keep Registers and the HMI Keep 
Relays are cleared. Control device addresses kept by Memory Backup in Function Settings are not cleared.

• If a project file (ZNV format) exists with the same name in the save destination when uploading a project file (ZNV 
format), the file is overwritten with the uploaded file without displaying an overwrite confirmation message.

• When using the project transfer function, make the project data file name half-width alphanumeric characters.

• While running the project transfer function using a Key Button, Multi-Button, or Multi-Command, if a data transfer 
function (project transfer) is initiated, the only function that will work is the currently running function. If two or 
more data transfer functions are configured to a Multi-Button or Multi-Command, only the data transfer function 
displayed at the top of the function list on the parts property dialog box will run.

• When running the project transfer function, the external memory device must have enough free space equivalent 
to the size of the ZNV project file. Check that there is sufficient free space on the external memory device that will 
be used with the project transfer function. If the device does not have sufficient free space, the project upload or 
download may fail.
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This chapter describes the specifications, functions, and notes to observe when using external memory devices with 
the Touch.

  

1.1 How the USB Flash Drive Function is Used

The following functions are available when a USB flash drive is inserted in the Touch.

• USB Autorun function
 Refer to “2.1 Overview of the USB Autorun Function” on page 26-18.

• USB Popup Screen function
 Refer to “1.8 USB Popup Screen Function” on page 26-15.

• Transferring projects
 Refer to “Chapter 25 Data Transfer Function” on page 25-1.

• Alarm Log output
 Refer to Chapter 13 “External Memory Tab” on page 13-20.

• Data Log output
 Refer to Chapter 14 “External Memory Tab” on page 14-16.

• Operation Log output
 Refer to Chapter 15 “External Memory Tab” on page 15-14.

• Reading/writing recipe data
 Refer to Chapter 18 “Recipe Function” on page 18-1.

1.2 Specifications

The specifications of supported USB flash drives are as follows.

• Max capacity 32 GB.

• Compatible with FAT16 or FAT32 formatted USB flash drives.

• The maximum file size that can be read and written is 256 MB.

• Character set support only for alphanumeric characters.

• File names may be up to 120 characters long. (Includes file extensions.)

• File paths may be up to 250 characters long. (Includes file extensions and drive characters.)

• Drive letters cannot contain the following characters:
\ " & ( ) * + , . / : ; < > [ ]  = | ^

• File and directory names cannot contain the following characters:
\ / : * ? " < > |

Chapter 26 External Memory Devices
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Check the IDEC web site for more information about compatible USB flash drives.



1 USB Flash Drives

26-2 SmartAXIS Touch User's Manual

1.3 File Structure

When downloading or uploading data using the WindO/I-NV3, the following files and folders are accessible.
By default, the External Memory Folder on the external memory is named “HGDATA01”. For details, refer to “1.5 
Setting the External Memory Folder” on page 26-12.

USB flash drive

HGDATA01 (External Memory Folder)

HGDATA02

HGDATA03

Folder name File name Description

ALARMLOG

[user-defined].CSV
Default file name

Batch: ALMHTO.CSV
Real time: ALMHTA.CSV

Alarm Log data

DATALOG

[user-defined].CSV
Default file name

Batch: LOGO**.CSV
Real time: LOGA**.CSV

Data Log data
(** corresponds to the data number)

OPERATIONLOG

[user-defined].CSV
Default file name

Batch: OPLOGO.CSV
Real time: OPLOGA.CSV

Operation Log data

RECIPE
[user-defined].CSV
Default: RCP****.CSV

Recipe data
(*** corresponds to the recipe 
number)

NVDATA [Project name].ZNV Project files

Users can create multiple external memory folders for different projects on a single USB flash drive. Note, 
the External Memory Folder on the external memory must reside on the root directory.

Do not alter project files (ZNV format). Altered files cannot be used with Touch.
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1.4 Reading/Writing Data

● Using WindO/I-NV3 to read and write to an external memory inserted in the Touch
This procedure shows how to read and write data to the External Memory Folder specified for the project currently 
running on the Touch.
Use either method below to make the connection.
• Connect a USB cable to the USB port on the computer and the USB interface on the Touch.
• Connect an Ethernet cable to the Ethernet port on the computer and the Ethernet interface on the Touch.

Communication settings

Follow these procedures to configure the communication device and port to allow reading and writing to the USB flash 
drive inserted in the Touch.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Select Touch under Communicate with.

3 Select the type of connection under Port, and then click OK.

Computer Touch

USB Cable

Ethernet Cable

USB flash drive

To USB Port To USB Interface

Mini-B PlugA Plug

To Ethernet Port To Ethernet Interface
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Downloading

This procedure shows how to download a specified file into the External Memory Folder on the external memory for 
the currently running project.

1 On the Home tab, in the Project group, click the arrow under Download.

2 Click Files to External Memory or Files to External Memory while running.
The Open dialog box appears.

■ Files to External Memory
This function temporarily stops the Touch and then downloads files to the USB flash drive inserted in the Touch. Touch 
resumes running when files have been downloaded.

■ Files to External Memory while running
This function downloads files to the USB flash drive inserted in the Touch without stopping the Touch.

3 Specify the file name, and then click Open.
A confirmation message appears.

4 Click Yes.
The External Memory Maintenance dialog box appears and the file download begins.
When the download is complete, a message box appears.

5 Click OK.

If security is enabled in the Touch project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.
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6 Click Close on the External Memory Maintenance dialog box.

Uploading

This procedure shows how to upload specified data from the External Memory Folder on the external memory for the 
currently running project.

1 On the Home tab, in the Project group, click the arrow next to Upload.

2 Click Stored Data in External Memory.

The Upload from External Memory dialog box appears.

3 Specify the type of data to upload by checking the appropriate items.

4 Specify the destination folder in the Path box.

5 Click OK.

The External Memory Maintenance dialog box appears and the data upload begins.
A message box appears when the data upload is complete.

The following kinds of data can be uploaded.
• Alarm Log Data
• Data Log Data
• Operation Log Data
• Recipe Files

• Click  to display the Select a Folder dialog box and specify the destination folder for uploading.
• After starting WindO/I-NV3, Alarm Log data, Data Log data, and Recipe files can be uploaded from an 

External Memory Folder without opening project data.

If security is enabled in the Touch project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.



1 USB Flash Drives

26-6 SmartAXIS Touch User's Manual

6 Click OK.

7 Click Close on the External Memory Maintenance dialog box.

● Using Downloader to read and write to a USB flash drive inserted in the Touch
Maintenance is performed on data in the External Memory Folder on the external memory specified for the project 
currently running on the Touch.

Downloading

This procedure shows how to download a specified file into the External Memory Folder on the external memory for 
the currently running project.

1 In Downloader, under the External Memory Maintenance, click Files to External Memory or Files to External 
Memory while running.

The Open dialog box appears.

2 Specify the file name, and then click Open.

This procedure saves the data to the External Memory Folder on the USB flash drive inserted in the Touch.

Uploading

This procedures shows how to upload specified data from the External Memory Folder on the external memory for the 
currently running project.

1 In Downloader, under External Memory Maintenance, click Upload.

The Upload from External Memory dialog box appears.

2 Specify the data to upload and where to save it to, then click OK.

This procedure uploads data to the External Memory Folder on the USB flash drive inserted in the Touch and saves it 
in the user-specified location.
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● Using WindO/I-NV3 to read and write to a USB flash drive inserted in the computer
This procedure shows how to read and write from a USB flash drive inserted in the computer's USB port.

Communication settings

To read and write to the USB flash drive inserted in the computer, the External Memory must be selected under the 
Communication with. Configure the communication settings as follows before downloading or uploading.

1 On the Home tab, in the Project group, click Comm. Setup.

The Communication Settings dialog box appears.

2 Under Communicate with, select External Memory, and then click OK.

Downloading

This procedure shows how to download the project data to the External Memory Folder on the USB flash drive.

1 Open the project data to download using WindO/I-NV3.

2 On the Home tab, in the Project group, click the icon above Download.

The Download dialog box appears.

Computer
USB flash drive

To USB port
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3 Click Download.

The Select Drive dialog box appears.

4 Select the external memory drive, and then click OK.

A confirmation message appears.

■ Drive
Specify the drive assigned as the external memory drive.

■ Network
The Network Drive Assignment dialog box appears. This dialog box allows you to specify a drive on the network.

■ External Memory Folder
Specify the destination folder for downloading project data.

Click  to display the Project Settings dialog box. This procedure allows you to specify the External Memory Folder 
on the external memory where the download will be stored.

5 Click Yes.

The Download dialog box appears and the file download begins.
When the download is complete, a completion message appears.
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6 Click OK.

7 Click Close on the Download dialog box.

Uploading

This procedure shows how to upload the project data from the External Memory Folder on the USB flash drive 
inserted in the computer, to the computer.

1 On the Home tab, in the Project group, click Upload.

The Select External Memory Folder dialog box appears.

2 Select the external memory drive, and then click OK.

The Upload dialog box appears.

■ External Memory Folder
Displays the folder specified in the Project tree described next.

■ Project
Specify the destination folder for uploading the project data.

■ Drive
Specify the drive assigned as the external memory drive.

■ Network
The Network Drive Assignment dialog box appears. This dialog box allows you to specify a drive on the network.
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3 Click Upload.

The Upload dialog box appears and the file upload begins.
When the upload is complete, a completion message appears.

4 Click OK.

5 Click Close on the Upload dialog box.

A confirmation message appears indicating the project will be opened.

6 Click OK.

The uploaded project opens.
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● Manipulating files using the file management functions provided with the OS
It is possible to use Explorer or any other program provided with the Windows OS to replace the recipe data that 
Touch uses. 
Insert the USB flash drive into the computer and save the new file(s) using the same name as the existing files in 
each folder under the External Memory Folder.

● External memory writing timing
If the write timing setting for Alarm Log, Data Log, and Operation Log data is set to Real Time to USB flash drive, 
the data is stored in the file output buffer once.
The writing timing from the file output buffer to the USB flash drive is as follows.
• Within three minutes of an output event to the USB flash drive.
• When the HMI Special Internal Relay LSM18 changes to 1.
• When switching to the Top Page in the System Mode.
• When downloading/uploading project data.
• When the Access Pause button is pressed.

In the following events, WindO/I-NV3 writes the data in the file output buffer to the USB flash drive once, 
and then moves on to the next process. This creates a processing delay which can cause WindO/I-NV3 to 
raise a communication error when downloading or uploading a project file. If a communication error 
occurs, try downloading or uploading the project file again.
• When data exists in the file output buffer
• When attempting to switch to the Top Page in the System Mode while reading/writing to the USB flash 

drive.
• When downloading or uploading project data.
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1.5 Setting the External Memory Folder

The External Memory Folder on the external memory can be renamed using WindO/I-NV3.

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the External Memory tab, enter the desired name in the External Memory Folder text box.

Use only alphabetic characters (A to Z) and numbers (0 to 9) and the maximum number is 8 characters.

3 Click OK.

• It is not possible to change folder names and file names other than the External Memory Folder.
• The External Memory Folder is named “HGDATA01” if project data has never been downloaded to the 

Touch.
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1.6 Deleting Files on the USB Flash Drive

When the value of device that uses as a condition for deleting a file changes from 0 to 1, the file is deleted from the 
External Memory Folder of the USB flash drive inserted in the Touch.

1 On the Configuration tab, in the System Setup group, click Project.
The Project Settings dialog box appears.

2 On the External Memory tab, select the Remove Files check box.

3 Specify the range of files to delete by checking the appropriate items.

■ All Alarm Log files
Deletes all files in the ALARMLOG folder.

■ All Data Log files
Deletes all files in the DATALOG folder.

■ All Operation Log files
Deletes all files in the OPERATIONLOG folder.

■ Trigger Device
Specifies the bit device or the bit of a word device to serve as condition for deleting files.

Click  to display the Device Address Settings dialog box. For the device address configuration procedure, refer to 
Chapter 2 “5.1 Device Address Settings” on page 2-61.

4 Click OK.

The online function in WindO/I-NV3 can also be used to delete files on the USB flash drive.
For details, refer to Chapter 23 “4 Clear” on page 23-22.
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1.7 Formatting the USB Flash Drive

The USB flash drive inserted in the Touch can be formatted with the WindO/I-NV3 online function.

1 On the Online tab, in the Touch group, click Format.

A confirmation message appears warning that existing data will be deleted.

2 Click Yes.

The External Memory Maintenance dialog box appears and formatting begins.
When the external memory has been formatted, the display returns to the External Memory Maintenance dialog box.

3 Click Close.

Always format the USB flash drive before using it.

In Communication Settings, Communicate with must be set to Touch in advance, and Port must be 
set to USB in advance. For details on how to configure these settings, refer to “Communication settings” on 
page 26-3.

If security is enabled for the project saved on the external memory, the Password Screen is displayed. 
Select the user name and enter the password. For details, refer to Chapter 21 “User Accounts and the 
Security Function” on page 21-1.
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1.8 USB Popup Screen Function

The USB Popup Screen function displays a specific screen by simply inserting a USB flash drive in the Touch.
This provides an easy way to display a message when the operator inserts a USB flash drive.

●  When a USB flash drive is inserted a popup window is automatically displayed.

Configuration Procedure

1 Create the popup window to be displayed when USB flash drive 1 is inserted.

On the Home tab, in the Screens group, click the arrow under New and then click Popup Screen.
The Screen Properties dialog box is displayed.

2 Change the settings on each tab as necessary, and then click OK.

3 Arrange the object on the editing screen as required.

4 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

5 On the Autorun tab, select the Open Popup Screen when USB Flash Drive is inserted check box.

6 Specify the Screen No. of the Popup Screen to display, and the Coordinates, then click OK.

For details, refer to Chapter 3 “3.9 Autorun Tab” on page 3-41.
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Operating Procedure

Insert the USB flash drive into the Touch.

The Popup Screen appears.

USB flash drive Touch

Touch

USB flash drive was inserted.Popup Screen

If security is enabled for the Popup Screen that is displayed by the USB Popup Screen function, the 
Password Screen is displayed. Select the user name and enter the password.
For details, refer to “2.4 USB Autorun Function Security” on page 26-26.

When the USB Popup Screen function is enabled, if the USB flash drive contains a definition file (hgauto.ini) 
for use with the USB Autorun function, both functions will appear on the menu screen.
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1.9 Precautions

• USB flash drives have a limitation on the number of times they can be written to.
Regularly backup data on the USB flash drive.

• Never turn the power off or remove the USB flash drive while reading/writing to it. Otherwise, the data on the USB 
flash drive may be destroyed. Should this occur, reformat the USB flash drive.

• Multiple USB flash drives cannot be used at the same time.

• Before turning off the power to the Touch or before removing the USB flash drive, set HMI Special Internal Relay 
LSM18 to 1 and check that HMI Special Internal Relay LSM19 is 0.

• The message Saving USB flash drive appears while reading or until writing stops.
To resume reading/writing to the USB flash drive, re-insert it.

• If an unusable USB flash drive is inserted, the error message USB flash drive not available appears.

• Do not alter project files (ZNV format). Altered files cannot be used with Touch.

• Do not connect the USB flash drive to the Touch through a USB hub.
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2.1 Overview of the USB Autorun Function

The USB Autorun function automatically displays a menu screen from which the user can execute predefined 
commands when a USB flash drive is inserted into the Touch.

The commands that can be executed with the USB Autorun function are as follows.

● Downloading a project file
Downloads a project file (ZNV format) saved on a USB flash drive to the Touch.

When the download is complete, the Touch will reset and start running from the beginning of the project that was 
just downloaded.

● Uploading a project file
Uploads the project file (ZNV format) used to operate the Touch and saves it to a USB flash drive.

When the upload is complete, the Touch will reset and start over at the beginning of the project.

2 USB Autorun Function

USB Autorun Function Menu Screen

USB flash drive

Change Program

Copy Program

Run All Cancel

Confirmation

Press the button

USB Autorun
definition file
(hgauto.ini)

Touch

• This allows operators to change project files without using a computer.
• These defined processes are called commands, and the file that contains the details of the command and 

menu screen is called the USB Autorun definition file (hgauto.ini).
• A USB Autorun definition file (hgauto.ini) must be stored on the USB flash drive to use the USB Autorun 

function.

Save

Save
Download

Computer
USB flash drive

Touch

USB Autorun
definition file
(hgauto.ini)

Project file
(ZNV format)

Project file
(ZNV format)

Refer to Chapter 25 “1 Project Transfer Function” on page 25-1 for important notes and limitations.

Save Upload

Computer
USB flash drive

Touch

USB Autorun
definition file
(hgauto.ini)

Project file
(ZNV format)

Refer to Chapter 25 “1 Project Transfer Function” on page 25-1 for important notes and limitations.
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2.2 USB Autorun Function Configuration Procedure

● Executing commands using the USB Autorun function

Configuration Procedure

1 On the Configuration tab, in the System Setup group, click Project.

The Project Settings dialog box appears.

2 On the Autorun tab, select the Enable USB Autorun check box, and then click OK.

For details, refer to Chapter 3 “3.9 Autorun Tab” on page 3-41.

• When enabling the USB Autorun function using the Touch, on the Top Page in the System Mode, press 
Main Menu, Initial Setting, System Op., and then press Autorun.

• If the USB Autorun function of the Touch is not enabled, the menu screen will not be displayed, even if a  
USB flash drive is inserted into the Touch.

• Once the USB Autorun function of the Touch is enabled, the function will remain enabled until either a 
project file with the Enable USB Autorun check box unchecked is downloaded, or the function is 
disabled via the System Mode.
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3 Create a USB Autorun definition file (hgauto.ini) and save it on the USB flash drive.

For details, refer to “2.3 Creating a USB Autorun Definition File” on page 26-22.

4 Prepare the necessary files and store them on the USB flash drive.

The necessary files are as follows.

• To download a project file
Create a project file (ZNV format).
For details, refer to Chapter 25 “1.3 Converting Project Data for Transfer” on page 25-2.

Operating Procedure

1 Insert the USB flash drive into the Touch.

The menu screen for the USB Autorun function appears.

Save

Computer
USB flash drive

USB Autorun
definition file
(hgauto.ini)

Save

Computer
USB flash drive

Project file
(ZNV format)

USB flash drive Touch

If the menu screen does not appear, follow these troubleshooting tips. Correct the problem and re-insert 
the USB flash drive.

Cause: USB Autorun definition file (hgauto.ini) does not exist on the USB flash drive.

Solution: Create a USB Autorun definition file and save it on the USB flash drive. For details, refer to 
“2.3 Creating a USB Autorun Definition File” on page 26-22.

Cause: The USB Autorun definition file (hgauto.ini) contains an error.

Solution: For details, refer to “2.3 Creating a USB Autorun Definition File” on page 26-22.

Cause: The USB Autorun function is disabled in the Touch settings.

Solution: Enable the USB Autorun function by referring to steps 1 and 2 on page 26-19.
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2 Press the command to execute.

The command executes.

3 When the command finishes executing, a screen appears indicating the execution result.

Press Ack to close the execution result screen and display the menu screen.

Change Program

Copy Program

Run All Cancel

Confirmation

Press the button.

Touching Run All causes all commands defined in the USB Autorun definition file (hgauto.ini) to execute 
one by one.

• If security is enabled in the Touch project, the Password Screen is displayed. Select the user name and 
enter the password.
For details, refer to “2.4 USB Autorun Function Security” on page 26-26.

• Do not remove the USB flash drive while command is executing.

Change ProgramFunction

The following function completed

Ack

Result

If a command executes with a button (except the Run All), the menu screen is displayed after touching 
Ack on the execution result screen.
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2.3 Creating a USB Autorun Definition File

The menu screen that appears when a USB flash drive inserted in the Touch is defined in the USB Autorun definition 
file.
The USB Autorun definition file is created using the following methods.

• Created with the USB Autorun definition file creation tool
 Refer to USB Autorun Definition File Creation Tool manual.

• Created with the text editor
 Refer to “Created using the text editor” on page 26-22.

● Created using the text editor
You create this file using Notepad or any commercially available text editor. Fill in the items in each section and save 
the file with the name “hgauto.ini”.

The USB Autorun definition file has these three sections.
Enter the items and definitions for each section.

[AUTORUN] section (required)
Specify the number of command items, enable/
disable the buttons, and the display language to use.

[AUTORUN]
item = 2
button_command = Enable
button_runall = Enable
language = English

[COMMAND] section (required)
Specify the command to execute and its parameters.
Create buttons to execute the number of commands 
specified in the [AUTORUN]: section from 
[COMMAND_1] to [COMMAND_5], in that order.

[COMMAND_1]
command = PRO_DOWNLOAD
src_path = "B:\NV3DATA\FT_PROJECT.ZNV"
reset_keep_device = Enable
title = "Change Program"
[COMMAND_2]
command = PRO_UPLOAD
dst_path = "B:\Uploaded_Project"
title = "Copy Program"

[COMMENT] section
Enter text to display, as necessary, at the bottom of 
the menu screen.

[COMMENT]
comment = "Press the button."

Change Program

Copy Program

RunAll Cancel

Confirmation

Press the button.

[COMMAND_1]
execution button

Button to close
the menu screen

Execution button for all commands

[COMMAND_2]
execution button

Displays text entered
in [COMMENT]
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[AUTORUN] section

■ item (required)
Specify the number of commands used from 1 to 5. The USB Autorun function will fail to execute if a value other than 
1 to 5 is specified.

■ button_command

■ button_runall

■ language

[COMMAND] section

■ command (required)

command = PRO_DOWNLOAD

■ src_path (required)
Specify the path (250 or less characters) where the project file is to be downloaded.
Use  “B:\” for a USB flash drive.

■ reset_keep_device
Specify whether to initialize the keep devices or not when the project file is downloaded. However, when project data 
that changes the settings of the data storage area is downloaded, the keep devices are always initialized.

Specify whether to enable or disable the execution buttons for [COMMAND_1] to [COMMAND_5].
Enable: Enables the button.
Disable: Disables the button.

If this item is left blank or contains an illegal value, the Touch assumes “Enable”.

Specify whether to enable or disable the execution buttons for Run All.
Enable: Enables the button.
Disable: Disables the button.

If this item is left blank or contains an illegal value, the Touch assumes “Enable”.

Specify the language to use for the button labels and messages.
Japanese: Shift-JIS
European: English
Chinese: GB2312
Taiwanese: BIG5
Korean
Central European
Baltic
Cyrillic

If this item is left blank or contains an illegal value, the Touch assumes “Japanese”.

Specify the command to execute.
PRO_DOWNLOAD: Download a project file.
PRO_UPLOAD: Upload a project file.
The items required differ for each command except for the “title” item.

Enable: Initializes the keep device.
Disable: Does not initialize the keep devices.

If this item is left blank or contains an illegal value, the MICRO/I assumes "Enable".
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command = PRO_UPLOAD

■ dst_path (required)
Specify the path to the folder (250 or less characters) where the uploaded project file will be saved.
Use  “B:\” for a USB flash drive.

Common items

■ title
Enter a title for the button label using 1 line of 14 characters or less.
• When using a semicolon (;), backslash (\), or double quotations ("), a backslash (\) as an escape character will be 

automatically inserted before those characters and will thus be calculated as 2 single-byte characters.

[COMMENT] section

■ comment
Enter a comment using 1 line of 29 characters or less.
• When using a semicolon (;), backslash (\), or double quotations ("), an escape character (\) will be automatically 

inserted before those characters and will thus be calculated as 2 single-byte characters.

Notes on comments

To add comments to the USB Autorun definition file, use a semicolon (;).
All text after the semicolon (;) and up to the line feed will be treated as a non-executable comments.

Restrictions

• The maximum number of characters per line is 512 single-byte characters including line feed codes.
All the text on the line will be ignored if there are more than 512 single-byte characters on the line.

• Each item must be described as a single line. If a line feed occurs before the end of the description, all characters 
after the line feed are ignored.

• The maximum size of the USB Autorun definition file (hgauto.ini) is 512 KB. The file cannot be used if it exceeds 
this limit.

• Only line feed codes of the format generally supported by Windows (CR+LF) are supported. If any other format is 
used, the USB Autorun definition file (hgauto.ini) will fail to run properly.

Sample definition file and explanation

Sample definition

; sample hgauto.ini

(1)

[AUTORUN]
item = 5 ; number of items
button_command = Enable ; enable individual command buttons
button_runall = Enable : enable the "Run All" button.
language =English ; use English

(2)

[COMMAND_1]
command = PRO_DOWNLOAD ; download the project file
src_path = "B:\FT_DEMO_1.ZNV" ; source path
title = "Change Program" ; button label

(3)

[COMMAND_2]
command = PRO_UPLOAD ; upload a project file
dst_path = "B:\Uploaded_Project" ; destination path
title = "Copy Program" ; button label

(4)
[COMMENT]
comment = "Press the button." ; Message shown at bottom of screen.
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Explanation

(1)This definition file displays two command execution buttons on the menu screen displayed by the USB Autorun 
function. It also enables the Run All button. All button labels and messages are displayed in English.

(2)Downloading a project file from a USB flash drive to the Touch.

(3)Uploading a project to a USB flash drive.

(4)Displays messages below the menu screen for the USB Autorun function.

[AUTORUN]
Defines the number of commands to use and details about the menu 
screen.

item = 2 Specifies that two commands will be used.

button_command = Enable
Enables execution buttons for each command from [COMMAND_1] 
to [COMMAND_2].

button_runall = Enable Enables the Run All button.

language = English Displays all button labels and messages in English.

[COMMAND_1]
Defines the command assigned to execution button [COMMAND_1]. 
This is the first command that executes when Run All is touched.

command = PRO_DOWNLOAD Executes "Download a project file".

src_path = "B:\FT_DEMO_1.ZNV"
Downloads the project file “FT_DEMO_1.ZNV” saved on the USB 
flash drive (B:) to the Touch.

title = "Change Program" Displays the text “Change Program” as the button label.

[COMMAND_2]
Defines the command assigned to execution button [COMMAND_2]. 
This is the fourth command that executes when Run All is touched.

command = PRO_UPLOAD Executes "Upload a project file".

dst_path = "B:\Uploaded_Project"
Uploads the project file used to operate the Touch and saves it to 
the Uploaded_Project folder on the USB flash drive (B:).

title = "Copy Program" Displays the text “Copy Program” as the button label.

[COMMENT]
Defines the number of commands to use and details about the 
menu screen.

comment = "Press the button." Displays the text “Press the button.” below the menu screen.
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2.4 USB Autorun Function Security

If security has been enabled for the Touch project, Touch displays the Password Screen when the USB Autorun 
function runs.

Select the user name from the security group that has command execution permissions, enter the password, and 
touch ENT.

● Execution privileges by security groups
With the Touch, a password-authenticated user account with the security group "Administrator" is necessary.

Password

ENT

User1
********

BS CLR OK

A B C D E F G H I J K L M
N O P Q R S T U V W X Y Z
0 1 2 3 4 5 6 7 8 9

Command
Security Group

Administrator Operator Reader

Downloading a project file YES NO NO

Uploading a project file YES NO NO

If you press  (Close) instead of entering a password, no commands are executed and the menu screen 

closes. To re-execute the USB Autorun function, insert the USB flash drive again.
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This chapter describes internal devices available for the SmartAXIS.
The Touch includes an internal HMI device to control HMI functions, and control device for control functions.

  

1.1 HMI Device Addresses

■ HMI Internal Relay (LM)
This is a bit-unit device used for the HMI function. It can store 2,048 addresses.

■ HMI Keep Relay (LK)
This is a bit-unit device that holds the values of device used for the HMI function. The value of this device can be set 
to 0 by clearing the project data download option or online function, or it becomes zero if the backup battery is 
drained. The address range can be varied between 1,024 and 8,192. For details, refer to Chapter 16 “Minimum and 
Maximum Amount of Data Storage and Number of Addresses” on page 16-2.

■ HMI Temporary Relay (LBM)
This is a bit-unit device for temporarily storing values for the HMI function. The value of this device switches between 
screens and text groups and user accounts, and it becomes 0 if the screen is reset. It can store 128 addresses.

■ HMI Special Internal Relay (LSM)
Special functions are assigned to each bit by the bit-unit device. It can store 64 addresses.

Chapter 27 Internal Devices

1 Bit Devices

Internal Device Name Symbol R/W Address Range Base

HMI Internal Relay LM R/W 0 to 2,047 10

HMI Keep Relay LK R/W Variable 10

HMI Temporary Relay LBM R/W 0 to 127 10

HMI Special Internal Relay LSM R/W 0 to 63 10

HMI Timer Relay LTC R 0 to 31 10

R/W stands for Read/Write. R/W enables reading and writing of values, whereas R enables reading only.

Address Function/Part
LSM0 Normally set to 1.

LSM1
1 only on the second scan when Base Screen is switched.
It also operates when switching text group or user account, or resetting the display screen.

LSM2
1 only on the first scan when Base Screen is switched.
It also operates when switching text group or user account, or resetting the display screen.

LSM3
0 only on the first scan when Base Screen is switched.
It also operates when switching text group or user account, or resetting the display screen.

LSM4 Alternates between 0 and 1 on each scan of the Touch.
LSM5 1 only on the first scan when Popup Screen is opened.
LSM6 1 while touch panel is pressed.

LSM7
Alternates between 0 and 1 each time data is read (read scan) from all the external devices being 
used.

LSM8 After powering ON value is 1 until the initially displayed screen switches to another screen.

LSM9
When value changes from 0 to 1, the backup data stored in flash memory is restored.
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.

LSM10
When value changes from 0 to 1, the data of Keep Relay and Keep Register configured in the Data 
Storage Area, and the current backlight settings are transferred to flash memory.
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.
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LSM11
Changes from 0 to 1 when the Base Screen is switched, after the values of all the external devices 
being used are read, and remains 1 until there is a switch to another screen.
It also operates when switching text group or user account, or resetting the display screen.

LSM12 1 only on the first scan when Popup Screen is closed.

LSM13
Value becomes 0 when Popup Screen is opened, and then changes from 0 to 1 after all the values of 
all the external devices being used by that Popup Screen are read. 

LSM14
When the indirect value of an indirect device positioned on the Base Screen changes, value becomes 
1, and reading of the indirect device starts. When reading is complete value becomes 0.

LSM15
When the indirect value of an indirect device positioned on a Popup Screen changes, value becomes 1, 
and reading of the indirect device starts. When reading is complete value becomes 0.

LSM16 to 17 Reserved

LSM18
When value changes from 0 to 1, access to USB flash drive is stopped. The access state can be 
checked with the value of LSM19.
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.

LSM19
Value is 1 while there is access to USB flash drive. If value is 0 the USB flash drive can be safely 
ejected.

LSM20 to 21 Reserved

LSM22
This is the Operation Log function. When data in excess of the amount that can be recorded in one 
operation occurs, the value becomes 1. 
When it becomes 1 value does not become 0 until the Touch is reset or 0 is written.

LSM23 to 24 Reserved
LSM25 Value is 1 while data is being written to USB flash drive.
LSM26 to 47 Reserved
LSM48 200 millisecond clock (alternates between 0 and 1 every 100 milliseconds)
LSM49 1 second clock (alternates between 0 and 1 every 500 milliseconds)
LSM50 to 52 Reserved

LSM53
When the value changes to 1, the preset values for IP address, subnet mask, and default gateway 
(LSD192 to 203) are written to the Touch, then it automatically resets. After the Touch is reset, the 
value becomes 0.

LSM54 to 63 Reserved

Address Function/Part

• Since the HMI Special Internal Relay can be written to, even if a write is attempted, the contents will not 
change.

• Transfer of the LSM10 Keep Relay and Keep Register to the flash memory can take an excess of one second. 
Writing to the flash memory can be repeated a maximum of 100,000 times. Keep writing to the flash memory 
to a minimum. LSM10 cannot be used while the ladder program is running. LSM10 does not work while the 
ladder program or FBD program is running.

• When there is no remaining battery power, data transferred with LSM10 will be restored once the power to 
the Touch has been turned on.

The period of processing for all of the parts set on the displayed screen is called a scan of the Touch. It is 
not related to the period of reading the value of external devices.
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A timing chart for the HMI Special Internal Relay controlled by operation of the Touch is shown below.

■ HMI Timer Relay (LTC)
The HMI Timer is a bit-unit device that can be changed to 1 in value of device switched by the Timer from Parts. It 
can store 32 addresses.

1

0
LSM0

1

0
LSM1

1

0
LSM2

1

0
LSM3

1

0
LSM4

1

0
LSM8

Processing 1st scan

1

0
LSM5

1

0
LSM12

2nd scan 3rd scan 4th scan 1st scan 2nd scan 3rd scan

Popup Screen open Popup Screen close

Power on Base Screen switch
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1.2 Control Device Addresses

■ Input (I)
Inputs (I) are relays to receive input signals through the input terminals.

■ Output (Q)
Outputs (Q) are relays to send the processed results to the output terminals.

■ Remote Input (I)
Remote inputs (I) are devices to input the on/off state from external devices connected to remote I/O slaves to the 
Touch.

■ Remote Output (Q)
Remote outputs (Q) are devices to output the on/off information from the Touch to external devices connected to 
remote I/O slaves.

■ Timer (T)
Control device timers are bit unit devices that become 1 when the time is up.

■ Counter (C)
Control device counters are bit unit devices that become 1 when the count is up.

■ Shift registers (R)
Shift registers (R) are registers to shift the data bits according to pulse inputs.

■ Internal Relay (M)
Internal relays (M) are relays used in the Touch and cannot be outputted to the output terminals.

*1 The last digit of the device address is 0 to 7 in octal notation.

Internal Device Name Symbol R/W Address Range Base

Input I R 0 to 17 8

Output Q R/W 0 to 13 8

Remote Input I R
40 to 75
80 to 115
120 to 155

8

Remote Output Q R/W
40 to 61
80 to 101
120 to 141

8

Timer Bit T R 000 to 199 10

Counter Bit C R 000 to 199 10

Shift Register R R/W 0 to 127 10

Internal Relay M R/W 0 to 1277 10*1

Special Internal Relay M R/W 8000 to 8177 10*1

R/W stands for Read/Write. R/W enables reading and writing of values, whereas R enables reading only.

• Control devices must have a "#" before the device type only when the WindO/I-NV3 is used.
In addition, on the Device Monitor a "#" is displayed before the device type.

Example: When setting D100

WindO/I-NV3: #D100

WindLDR: D100

• Values can only be written from the HMI function to outputs (Q) while the ladder program or FBD program is 
running.

• Do not simultaneously write values to the same control device using the HMI function and the control function.
• Operations in scripts of control function are as follows.

- Bit of Data register can be handled as a bit device.
- Calculations in which both bit and word devices are used are not allowed.
- Bit devices are always processed as bits, and values of those devices are 0(OFF) or 1(ON).
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■ Special Internal Relay (M)
Special internal relays (M) are bit devices used internally on the Touch. Each bit has been assigned a special function.

Although the device code for internal relays (M0000 to M1277) and special internal relays (M8000 to M8177) 
is the same ("M"), the device characteristics are different. Special functions are assigned to each bit of the 
special internal relay.

Do not change the status of reserved special internal relays, otherwise the Touch may not operate 
correctly.

Device 
Address Description CPU 

Stopped
Power 

OFF
Read/
Write Ladder FBD

M8000

Start Control
M8000 controls the state of the ladder program or FBD 
program (RUN/STOP). When M8000 is turned on, the ladder 
program or FBD program is executed, and when turned off, 
the ladder program or FBD program stops. Stop input and 
reset input have precedence over M8000 (start control).  
M8000 maintains its status when the Touch is powered down. 
When the data to be maintained during power failure is broken 
after the Touch has been off for a period longer than the 
battery backup duration, the Touch restarts ladder program 
operation or FBD program operation or not as selected in 
Configuration, Run/Stop Control, Run/Stop Selection 
at Memory Backup Error. 
For details, refer to Chapter 3 “4.4 Run/Stop Selection at 
Memory Backup Error” on page 3-51.

Maintained Maintained Write YES YES

M8001 1-sec Clock Reset
While M8001 is on, M8121 (1-sec clock) is turned off. Cleared Cleared Write YES YES

M8002

All Outputs OFF
When M8002 is turned on, all outputs go off until M8002 is 
turned off. Self-maintained circuits using outputs also go off 
and are not restored when M8002 is turned off.

Cleared Cleared Write YES YES

M8003

Carry (Cy) and Borrow (Bw)
When a carry or borrow results from executing an addition or 
subtraction instruction, M8003 turns on. For details, refer to 
Chapter 4 "Instructions Reference" – "Carry and Borrow" in the 
"SmartAXIS Ladder Programming Manual".

Cleared Cleared Read YES ―

M8004

Program Execution Error
When an error occurs while executing a ladder program or 
FBD program, M8004 turns on.
For details, refer to Chapter 30 “2.2 Program Execution Error” 
on page 30-5.

Cleared Cleared Read YES YES

M8005 Remote I/O Slave Communication Error
Special internal relays used by remote 
I/O.
For details, refer to Chapter 12 “4.2 
Remote I/O Master” on page 12-47.

Remote I/O Slave 1
Communication Error

Operating Cleared Read YES YES

M8006
Remote I/O Slave 2
Communication Error

Operating Cleared Read YES YES

M8007
Remote I/O Slave 3
Communication Error

Operating Cleared Read YES YES

M8010

In Daylight Saving Time Period
When the daylight saving time is enabled, M8010 is turned on 
while in the daylight saving time period. When the daylight 
saving time is disabled, M8010 is always off.

Operating Cleared Read YES YES

M8011, 
8012

Reserved ― ― ― ― ―

M8013

Calendar/Clock Data Write/Adjust Error Flag
When an error occurs while calendar/clock data is written or 
clock data is adjusted, M8013 turns on. If calendar/clock data 
is written or clock data is adjusted successfully, M8013 turns 
off.

Operating Cleared Read YES YES

M8014

Calendar/Clock Data Read Error Flag
When an error occurs while calendar/clock data is read from 
the internal clock to the special data registers (D8008 to 
D8014), M8014 turns on. If calendar/clock data is read 
successfully, M8014 turns off.

Operating Cleared Read YES YES

M8015 Reserved ― ― ― ― ―
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*1 Read only

M8016
Calendar Data Write Flag
When M8016 is turned on, data in data registers D8015 through 
D8018 (calendar new data) are set to the internal clock.

Operating Cleared Write YES YES

M8017
Clock Data Write Flag
When M8017 is turned on, data in data registers D8019 
through D8021 (clock new data) are set to the internal clock. 

Operating Cleared Write YES YES

M8020
Calendar/Clock Data Write Flag
When M8020 is turned on, data in data registers D8015 through 
D8021 (calendar/clock new data) are set to the internal clock. 

Operating Cleared Write YES YES

M8021

Clock Data Adjust Flag
When M8021 is turned on, the clock is adjusted with respect to 
seconds. If seconds are between 0 and 29 for current time, 
adjustment for seconds will be set to 0 and minutes remain the same. 
If seconds are between 30 and 59 for current time, adjustment for 
seconds will be set to 0 and minutes are incremented by 1. 

Operating Cleared Write YES YES

M8022, 
8023 Reserved ― ― ― ― ―

M8024

BMOV/WSFT Executing Flag
While the BMOV or WSFT is executed, M8024 turns on. When 
completed, M8024 turns off. If the Touch is powered down 
while executing BMOV or WSFT, M8024 remains on when the 
Touch is powered up again.

Maintained Maintained Read YES ―

M8025

Maintain Outputs While Ladder Program Operation Stopped
Outputs are normally turned off when the ladder program 
operation is stopped. M8025 is used to maintain the output 
statuses when the ladder program operation is stopped. When 
the ladder program operation is stopped with M8025 turned on, 
the output ON/OFF statuses are maintained. When the ladder 
program operation restarts, M8025 is turned off automatically.

Maintained Cleared Write YES YES

M8026, 
8027 Reserved ― ― ― ― ―

M8030

Special Internal Relays for High-Speed 
Counter (Group 1/I0)
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Comparison Output Reset Cleared Cleared Read/
Write YES YES*1

M8031 Gate Input Maintained Cleared Read/
Write YES YES*1

M8032 Reset Input Maintained Cleared Read/
Write YES YES*1

M8033 Reset Status Maintained Cleared Read YES YES
M8034 Comparison ON Status Maintained Cleared Read YES YES
M8035 Overflow Maintained Cleared Read YES YES
M8036 Underflow Maintained Cleared Read YES YES
M8037 Count Direction Maintained Cleared Read YES YES

M8040

Special Internal Relays for High-Speed 
Counter (Group 2/I2)
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Comparison Output Reset Cleared Cleared Read/
Write YES YES*1

M8041 Gate Input Maintained Cleared Read/
Write YES YES*1

M8042 Reset Input Maintained Cleared Read/
Write YES YES*1

M8043 Comparison ON Status Maintained Cleared Read YES YES
M8044 Overflow Maintained Cleared Read YES YES
M8045 
to 8047, 
8050 to 
8054

Reserved ― ― ― ― ―

Device 
Address Description CPU 

Stopped
Power 

OFF
Read/
Write Ladder FBD
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Device 
Address Description CPU 

Stopped
Power 

OFF
Read/
Write Ladder FBD

M8055

Special Internal Relays for High-Speed 
Counter (Group 3/I3)
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Comparison Output Reset Cleared Cleared Read/
Write YES YES*1

M8056 Gate Input Maintained Cleared Read/
Write YES YES*1

M8057 Reset Input Maintained Cleared Read/
Write YES YES*1

M8060 Comparison ON Status Maintained Cleared Read YES YES
M8061 Overflow Maintained Cleared Read YES YES
M8062 
to 8067, 
8070

Reserved ― ― ― ― ―

M8071 Interrupt Input I2 Status Turns on when the corresponding 
user interrupt is allowed. When 
interrupt inputs are disabled, these 
internal relays are turned off.
(ON: Allowed, OFF: Prohibited) 

Cleared Cleared Read YES ―
M8072 Interrupt Input I3 Status Cleared Cleared Read YES ―
M8073 Interrupt Input I4 Status Cleared Cleared Read YES ―
M8074 Interrupt Input I5 Status Cleared Cleared Read YES ―
M8075 
to 8077, 
8080

Reserved ― ― ― ― ―

M8081 Interrupt Input I2 Edge This flag indicates whether the 
interrupt input is triggered with a 
rising edge or falling edge.
(ON: Rising, OFF: Falling)

Cleared Cleared Read YES ―
M8082 Interrupt Input I3 Edge Cleared Cleared Read YES ―
M8083 Interrupt Input I4 Edge Cleared Cleared Read YES ―
M8084 Interrupt Input I5 Edge Cleared Cleared Read YES ―
M8085 
to 8087, 
8090

Reserved ― ― ― ― ―

M8091 Catch Input ON/OFF Status
When a rising or falling input edge is 
detected during a scan, the input statuses 
of catch inputs Group 1/I0 through Group 
6/I7 at the moment are set to M8090 
through M8095, respectively, without 
regard to the scan status. Only one edge 
is detected in one scan. 

Group 2/I2 Maintained Cleared Read YES YES
M8092 Group 3/I3 Maintained Cleared Read YES YES
M8093 Group 4/I4 Maintained Cleared Read YES YES

M8094 Group 5/I6 Maintained Cleared Read YES YES

M8095 
to 
M8107

Reserved ― ― ― ― ―

M8110
Connection Status
Special internal relays used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote 
I/O Master” on page 12-47.

Remote I/O Slave 1
Connection Status Operating Cleared Read YES YES

M8111 Remote I/O Slave 2
Connection Status Operating Cleared Read YES YES

M8112 Remote I/O Slave 3
Connection Status Operating Cleared Read YES YES

M8113 
to 8117

Reserved ― ― ― ― ―

M8120

Initialize Pulse
When the ladder program starts running, M8120 turns on for a period 
of one scan.

Cleared Cleared Read YES YES

M8121

1-sec Clock
While M8001 (1-sec clock reset) is off, M8121 generates clock pulses in 
one second increments, with a duty ratio of 1:1 (500 milliseconds on and 
500 milliseconds off).

Operating Cleared Read YES YES

M8120

1 scan time

Start

M8121

500msec500msec

1sec
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Device 
Address Description CPU 

Stopped
Power 

OFF
Read/
Write Ladder FBD

M8122

100-msec Clock
M8122 always generates clock pulses in 100 milliseconds increments, 
whether M8001 is on or off, with a duty ratio of 1:1 (50 milliseconds on 
and 50 milliseconds off).

Operating Cleared Read YES YES

M8123

10-msec Clock
M8123 always generates clock pulses in 10 milliseconds increments, 
whether M8001 is on or off, with a duty ratio of 1:1 (5 milliseconds on 
and 5 milliseconds off).

Operating Cleared Read YES YES

M8124

Timer/Counter Preset Value Changed
When timer or counter preset values are changed, M8124 
turns on. When a ladder program or FBD program is 
downloaded to the Touch or when the changed timer/counter 
preset value is cleared, M8124 turns off.

Maintained Cleared Read YES YES

M8125 In-operation Output
M8125 remains on while the ladder program is running. Cleared Cleared Read YES YES

M8126 
to 8143 Reserved ― ― ― ― ―

M8144
Timer Interrupt Status
When timer interrupt is enabled, M8144 is turned on. When 
disabled, M8144 is turned off.

Cleared Cleared Read YES ―

M8145 
to 8147 Reserved ― ― ― ― ―

M8150 
to 8152

Comparison Result Greater Than
Each bit turns ON in accordance with the results of the 
CMP=(Compare(=)) command and ICMP>=(interval comparison) 
command.
For CMP=(Compare(=)) command: M8150 = S1>S2, M8151 = 
S1=S2, M8152 = S1<S2
For ICMP>=(interval comparison) command: M8150=S2>S1, 
M8151=S3>S2, M8152=S1>S2>S3
For details about comparison results of the 
CMP=(Compare(=)) and ICMP>=(interval comparison) 
commands, refer to the "SmartAXIS Ladder Programming 
Manual".

Maintained Cleared Read YES ―

M8153 
to 8165 Reserved ― ― ― ― ―

M8166

Special Internal Relays for High-Speed 
Counter (Group 4/I4)
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Comparison Output Reset Cleared Cleared Read/
Write YES YES*1

M8167 Gate Input Maintained Cleared Read/
Write YES YES*1

M8170 Reset Input Maintained Cleared Read/
Write YES YES*1

M8171 Comparison ON Status Maintained Cleared Read YES YES
M8172 Overflow Maintained Cleared Read YES YES

M8173

Special Internal Relays for High-Speed 
Counter (Group 5/I5)
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Comparison Output Reset Cleared Cleared Read/
Write YES YES*1

M8174 Gate Input Maintained Cleared Read/
Write YES YES*1

M8175 Reset Input Maintained Cleared Read/
Write YES YES*1

M8176 Comparison ON Status Maintained Cleared Read YES YES
M8177 Overflow Maintained Cleared Read YES YES

M8122

50msec50msec

100msec

M8123

5msec5msec

10msec
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2.1 HMI Device Addresses

■ HMI Data Register (LDR)
8,192 points are available.

■ HMI Keep Register (LKR)
The value in these registers is retained during power OFF.
The maximum number of HMI Keep Register depends upon the number set in WindO/I-NV3. For details, refer to
Chapter 16 “Minimum and Maximum Amount of Data Storage and Number of Addresses” on page 16-2.

■ HMI Temporary Register (LBR)
This register value will be cleared to 0 when a text group or user account is changed, when a screen is reset or the 
screen is changed. 128 points are available.

■ HMI Timer (Current  value) (LTD)
HMI Timer stores the current value of Timer from the parts. 32 points are available.

■ HMI Special Data Register (LSD)
The HMI Special Data Registers (256 points) perform the following special operations.

2 Word Devices

Internal Device Name Symbol R/W Address Range Base

HMI Data Register LDR R/W 0 to 8191 10

HMI Keep Register LKR R/W Variable 10

HMI Temporary Register LBR R/W 0 to 127 10

HMI Timer (Current) LTD R 0 to 31 10

HMI Special Data Register LSD R/W 0 to 255 10

R/W stands for Read/Write. R/W enables reading and writing of values, whereas R enables reading only.

Address Function/Part

LSD0 to 3 Reserved

LSD4 Scan time Maximum value of the Touch (msec)

LSD5 Screen switch response time (msec)

LSD6 Read scan communication time (msec)

LSD7 Scan counter (incremented at each scan of the Touch)

LSD8 1 second counter (incremented each second)

LSD9 10 millisecond counter (increments every 10 msec)

LSD10 100 millisecond counter (incremented every 100 msec)

LSD11 200 millisecond counter (incremented every 200 msec)

LSD12 500 millisecond counter (incremented every 500 msec)

LSD13 Stores the current Year data from the Touch. “Year” (4 BCD digits)

LSD14 Stores current time data from Touch. “Month” (2 BCD digits)

LSD15 Stores current time data from Touch. “Day” (2 BCD digits)

LSD16 Stores current time data from Touch. “Hour” (2 BCD digits)

LSD17 Stores current time data from Touch. “Minute” (2 BCD digits)

LSD18 Stores current time data from Touch. “Second” (2 BCD digits)

LSD19 Stores current time data from Touch. “Day-of-week” (1 BCD digit)
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LSD20
When a value of 1 is written into this device address, the internal clock in Touch is updated 
according to the data stored in LSD21 to 26. It automatically resets to 0 after the update.

LSD21 Stores preset value in the Touch internal clock "Year". (2 BCD digits)

LSD22 Stores preset value in the Touch internal clock "Month". (2 BCD digits)

LSD23 Stores preset value in the Touch internal clock "Day". (2 BCD digits)

LSD24 Stores preset value in the Touch internal clock "Hour". (2 BCD digits)

LSD25 Stores preset value in the Touch internal clock "Minute". (2 BCD digits)

LSD26 Stores preset value in the Touch internal clock "Second". (2 BCD digits)

LSD27 Current value of the scan time for Touch (msec)

LSD28 Minimum value of the scan time for Touch (msec)

LSD29, 30 Reserved

LSD31 Stores the currently displayed screen number.

LSD32
Set a value (in reference to a Base Screen number you want to switch to) and it will 
automatically switch to a specified Base Screen number.
Note, after switching to a Base Screen, the value stored automatically resets to 0.

LSD33

USB flash drive error status
0: Normal
1: USB flash drive not inserted/incompatible memory
2: Formatting error
3: Access error/insufficient free space/read-write failure

LSD34 USB flash drive available capacity lower word (kB)

LSD35 USB flash drive available capacity upper word (kB)

LSD36 USB flash drive full capacity lower word (kB)

LSD37 USB flash drive full capacity upper word (kB)

LSD38 Ladder program or FBD program processing time (msec)

LSD39 to 48 Reserved

LSD49 O/I Link Slave station number

LSD50

The sequence value of the message number (or channel number if the alarm function is 
being used) selected by the cursor in the Alarm List Display is stored.
A value of between 1 and 1024 (allocated using ((project No. - 1) x 16 + bit position + 1)) is 
stored for the number.

LSD51 Color or Monochrome LCD models: Brightness Adjustment 0 to 31

LSD52 The ID number of the script for which the error occurred

LSD53 Script error status

LSD54 Reserved

LSD55 Monochrome LCD models: Contrast Adjustment 0 to 31

LSD56
The number of lines of data from the start line to the line currently selected with the cursor 
displayed in the Alarm List Display/Alarm Log Display is stored.

LSD57
The number of log data pieces stored in the Data Storage Area by the Alarm Log function is 
stored. (0 to 1,024)

LSD58

USB flash drive download status
During download of a file to USB flash drive with WindO/I-NV3 the following bits turns ON.
When downloading is complete, the bit turns OFF.
Bit 2: Recipe data
Bit 4: Project data

LSD59 to 66 Reserved

LSD67

Stores the connection status for TCP clients and the TCP server for the User Communication 
set to the Ethernet interface.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

Address Function/Part
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LSD68

When the value changes from 0 to 1, the connections for the TCP clients and the TCP server 
for the User Communication set to the Ethernet interface are forcibly disconnected.
Bit 0: User Communication 1
Bit 1: User Communication 2
Bit 2: User Communication 3

LSD69 to 100 Reserved

LSD101 Polling period register for the O/I Link Slave

LSD102 Slave registration setting register for O/I Link Master

LSD103 Reserved

LSD104 Slave online information register for O/I Link Master

LSD105 Reserved

LSD106 Slave error information register for O/I Link Master

LSD107 to 111 Reserved

LSD112 to 127 Refer to details on registers for communication drivers in "External Device Setup Manual".

LSD128 to 191 Reserved

LSD192 to 195

The preset value for IP address of the Touch. When the value of LSM53 is changed to 1, the 
values of these device addresses are written to the Touch. When the power is turned on, the 
set values of the project are read to these device addresses.
Example: The IP address is 192.168.0.1
LSD192=192, LSD193=168, LSD194=0, LSD195=1

LSD196 to 199

The preset value for subnet mask of the Touch. When the value of LSM53 is changed to 1, 
the values of these device addresses are written to the Touch. When the power is turned on, 
the set values of the project are read to these device addresses.
Example: The subnet mask is 255.255.254.0
LSD196=255, LSD197=255, LSD198=254, LSD199=0

LSD200 to 203

The preset value for default gateway of the Touch. When the value of LSM53 is changed to 
1, the values of these device addresses are written to the Touch. When the power is turned 
on, the set values of the project are read to these device addresses.
Example: The default gateway is 192.168.0.24
LSD200=192, LSD201=168, LSD202=0, LSD203=24

LSD204 to 255 Reserved

Address Function/Part

• LSD4 and 6 store the maximum value, and when the Base Screen is switched, they are reset.
• The values of LSD4 to 6 are included errors of +/- 10 milliseconds.
• The values of LSD38 to 40 are included errors of +/- 10 milliseconds.
• When registers LSD7, 8, 9, 10, 11 or 12 contain FFFF (H) and are incremented, the value becomes 0.
• When you reckon time by using LSD9, the time difference (in 10 milliseconds units) from the previous value 

can be calculated.
• The range for the “Year” in LSD13 is 2000 to 2099, and reverts to 2000 after 2099.
• When 1 is written to LSD20, internal clock is updated by the contents of LSD21 to 26. Note that if there is 

even 1 incorrect data item in LSD21 to 26, the internal clock of the Touch is not updated.
• The display format for LSD31 is set under Screen No. Format in Project Settings. (BCD, BIN)
• This data format for LSD32 is the same as Screen No. Format in Project Settings. (BCD, BIN)

If the screen number is not exist in the project, “No Screen Data” message will appear.
If 0xFFFF(Hex) is written to LSD32, Touch will display the Top Page in the System Mode.
In case that the current screen is changed by System Area 1 and LSD32 at the same instant, the screen 
number of the System Area 1 will be displayed.

• By using the LSD50 value in the Message Switching Display you can display the message that corresponds to 
the cursor in the Alarm List Display.

• Refer to Chapter 20 “1.4 Script Error of HMI Function” on page 20-4 regarding LSD52 and LSD53.
• LSM7 and LSD6, 102 to 107 are not available for slave units when using O/I Link Communication.
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2.2 Control Device Addresses

■ Input (WI)
Devices for handling bit device inputs (I) in word units

■ Output (WQ)
Devices for handling bit device outputs (Q) in word units

■ Shift Register (WR)
Devices for handling bit device shift registers (R) in word units

■ Internal Relay (WM)
Devices for handling bit device internal relays (M) in word units

■ Special Internal Relay (WM)
Devices for handling bit device special internal relays (M) in word units

■ Timer (TP, TC)
This timer is used internally by the Touch. These can be used as an ON delay Timer or OFF delay Timer.

■ Counter (CP, CC)
This counter is used internally by the Touch. These can be used as an addition type counter or reverse counter.

■ Data Register (D)
This is a word unit device used for storing numerical data internally in the Touch. It can also be used as a bit unit 
device.

*1 Multiples of 20 only
*2 Multiples of 16 only

Device Name Symbol R/W Address Range Base

Input WI R 0,40,60,80,100,120,140 10

Output WQ R/W 0,40,60,80,100,120,140 10

Shift Register WM R/W 0 to 112*2 10

Internal Relay WR R/W 0 to 1260*1 10

Special Internal Relay WM R/W 8000 to 8160*1 10

Timer Setting Value TP R/W 000 to 199 10

Timer Count Value TC R 000 to 199 10

Counter Setting Value CP R/W 000 to 199 10

Counter Count Value CC R 000 to 199 10

Data Register D R/W 0000 to 1999 10

Special Data Register D R/W 8000 to 8199 10

R/W stands for Read/Write. R/W enables reading and writing of values, whereas R enables reading only.

• Control devices must have a "#" before the device type only when the WindO/I-NV3 is used.
In addition, on the Device Monitor a "#" is displayed before the device type.

Example: When setting D100

WindO/I-NV3: #D100

WindLDR: D100

• Do not simultaneously write values to the same control device using the HMI function and the control function.
• Operations in scripts of control function are as follows.

- Bit of Data register can be handled as a bit device.
- Calculations in which both bit and word devices are used are not allowed.
- Bit devices are always processed as bits, and values of those devices are 0(OFF) or 1(ON).
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■ Special Data Register (D)
This is a word unit device used for storing numerical data internally in the Touch. Each data register is assigned a 
special function. It can also be used as a bit unit device.

Although the device code for the data registers (D0000 to D1999) and special data registers (D8000 to 
D8199) is the same ("D"), the device characteristics are different. Special functions are assigned to each 
special data register.

Do not change the data of reserved area, otherwise the Touch may not operate correctly.

Device 
Address 

Description Updated Ladder FBD

D8000
Quantity of Inputs 
The total of input points provided on the Touch is stored to D8000. 

When I/O 
initialized 

YES YES

D8001
Quantity of Outputs 
The total of output points provided on the Touch is stored to D8001.

When I/O 
initialized 

YES YES

D8002

CPU Module Type Information
Information about the Touch is stored to D8002.
0: SmartAXIS Pro/Lite 12-I/O type
1: SmartAXIS Pro/Lite 24-I/O type
2: SmartAXIS Pro/Lite 40-I/O type
3: SmartAXIS Pro/Lite 48-I/O type
4: SmartAXIS Touch

Power-up YES YES

D8003, 
8004

Reserved ― ― ―

D8005

General Error Code
SmartAXIS general error information is stored to D8005. When a general error 
occurs, the bit corresponding to the error occurred turns on.
The general error and the program execution error can be cleared by writing “1” 
to the most significant bit of D8005 using a ladder program or FBD program.
For details, refer to Chapter 30 “2.1 General Error Codes” on page 30-3.

When error 
occurred

YES YES

D8006

Program Execution Error Code 
The ladder program or FBD program execution error information is stored to 
D8006. When a program execution error occurs, the error code corresponding to 
the error occurred is stored to D8006.
For details, refer to Chapter 30 “2.2 Program Execution Error” on page 30-5.

When error 
occurred

YES YES

D8007 Reserved ― ― ―
D8008

Calendar/Clock Current Data (Read only) 
Used to read calendar and clock data from the internal clock.

Year Every 500 msec YES YES
D8009 Month Every 500 msec YES YES
D8010 Day Every 500 msec YES YES

D8011
Day of 
Week

Every 500 msec YES YES

D8012 Hour Every 500 msec YES YES
D8013 Minute Every 500 msec YES YES
D8014 Second Every 500 msec YES YES
D8015

Calendar/Clock New Data (Write only) 
Used to write calendar and clock data to the internal clock.

Year ― YES YES
D8016 Month ― YES YES
D8017 Day ― YES YES

D8018
Day of 
Week

― YES YES

D8019 Hour ― YES YES
D8020 Minute ― YES YES
D8021 Second ― YES YES
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D8022 Reserved ― ― ―

D8023 Scan Time Data
These are special data registers for checking the 
scan time.
For details, refer to Chapter 12 “Control function” on
page 12-2.

Scan Time Current Value Every scan YES YES

D8024 Scan Time Maximum Value At occurrence YES YES

D8025 Scan Time Minimum Value At occurrence YES YES

D8026 to 
8032

Reserved ― ― ―

D8033 Interrupt Input Jump Destination Label No.
Jump destination label numbers for interrupt inputs are stored in 
these special data registers. To use interrupt inputs, store the label 
number that corresponds to the special data register allocated to 
the interrupt input.
For details, refer to Chapter 3 “4.9 Interrupt Input” on page 3-74.

I2 ― YES ―
D8034 I3 ― YES ―

D8035 I4 ― YES ―

D8036

Timer Interrupt Jump Destination Label No. 
The jump destination label number when the timer interrupt occurs is stored in 
D8036. To use the timer interrupt, store the corresponding label number.
For details, refer to Chapter 3 “4.13 Timer Interrupt” on page 3-84.

― YES ―

D8037

Interrupt Input Jump Destination Label No.
Jump destination label numbers for interrupt inputs are stored in 
these special data registers. To use interrupt inputs, store the label 
number that corresponds to the special data register allocated to 
the interrupt input.
For details, refer to Chapter 3 “4.9 Interrupt Input” on page 3-74.

I5 ― YES ―

D8038, 
39

Reserved ― ― ―

D8040 Analog Input Value
The analog input values to the analog input terminals are converted 
to digital values (0 to 1000) and stored to the corresponding special 
data registers.
For FBD, a linear transformation can be configured for the analog 
input (AI). Even when a linear transformation is configured for AI, 
the special data registers store the analog values (0 to 1000) before 
the linear transformation.
D8040=AI0, D8041=AI1

AI0 Every scan YES YES

D8041 AI1 Every scan YES YES

D8042
Analog Input Status
The analog input status to the analog input terminals is stored to 
the corresponding special data registers.
For details, refer to Chapter 3 “4.12 Analog Input” on page 3-81.
D8042 = AI0, D8043 = AI1

AI0 Every scan YES YES

D8043 AI1 Every scan YES YES

D8044
Analog Output Value
The analog output values to the analog output terminals are stored to 
the corresponding special data registers in digital values.
For details, refer to Chapter 3 “4.14 Analog Output” on page 3-86.
D8044 = AQ0, D8045 = AQ1

AQ0 Every scan YES YES

D8045 AQ1 Every scan YES YES

D8046
Analog Output Status
The analog output status to the analog output terminals is stored to 
the corresponding special data registers.
For details, refer to Chapter 3 “4.14 Analog Output” on page 3-86.
D8046 = AQ0, D8047 = AQ1

AQ0 Every scan YES YES

D8047 AQ1 Every scan YES YES

D8048,
D8049

Reserved ― ― ―

D8050 High-Speed Counter (Group 1/I0) 
These special data registers are 
used with the high-speed counter 
function.
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Upper Word
Current Value Every scan YES YES

D8051 Lower Word
D8052 Upper Word

Preset Value ― YES YES
D8053 Lower Word
D8054 Upper Word

Reset Value ― YES YES
D8055 Lower Word

Device 
Address 

Description Updated Ladder FBD
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D8056 High-Speed Counter (Group 2/I2) 
These special data registers are 
used with the high-speed counter 
function and the frequency 
measurement function.
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Upper Word Current Value / Frequency 
Measurement Value (I2) 

Every scan YES YES
D8057 Lower Word
D8058 Upper Word

Preset Value ― YES YES
D8059 Lower Word
D8060 Upper Word

Reset Value ― YES YES
D8061 Lower Word

D8062 to 
8067

Reserved ― ― ―

D8068 High-Speed Counter (Group 3/I3) 
These special data registers are 
used with the high-speed counter 
function and the frequency 
measurement function.
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Upper Word Current Value / Frequency 
Measurement Value (I3) 

Every scan YES YES
D8069 Lower Word
D8070 Upper Word

Preset Value ― YES YES
D8071 Lower Word
D8072 Upper Word

Reset Value ― YES YES
D8073 Lower Word

D8074 to 
8076

Reserved ― ― ―

D8077

Out of Analog Input Range Status 
If the analog input signal exceeds 11 V or 21 mA, the corresponding bits of 
D8077 (bit 0, 1) become 1. If the signal falls below 11 V or 21 mA, the bits 
become 0.
If the analog input signal falls below 2 mA, the corresponding bits of D8077 (bit 
2, 3) become 1. If the signal exceeds 2 mA, the bits become 0.
The assignment of each analog input is as follows.

― YES YES

D8078 to 
8109

Reserved ― ― ―

D8110 to 
8113 IP Address of the Connected Slave

Special data registers used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote I/O 
Master” on page 12-47.

IP Address of the 
Connected Slave 1

Each second YES YES

D8114 to 
8117

IP Address of the 
Connected Slave 2

Each second YES YES

D8118 to 
8121

IP Address of the 
Connected Slave 3

Each second YES YES

D8122 Cartridge Slot 1 Information
The information of the Cartridge Slot 1 is stored to 
the special data registers. For details, refer to 
“Cartridge Slot Information” on page 27-18.

Type ID/Status ― YES YES

D8123 System Software Version ― YES YES

D8124 Cartridge Slot 2 Information
The information of the Cartridge Slot 2 is stored to 
the special data registers. For details, refer to 
“Cartridge Slot Information” on page 27-18.

Type ID/Status ― YES YES

D8125 System Software Version ― YES YES

D8126 to 
8129

Reserved ― ― ―

D8130
Port Number of the Connected Slave
Special data registers used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote I/O 
Master” on page 12-47.

Port Number of the 
Connected Slave 1

Each second YES YES

D8131
Port Number of the 
Connected Slave 2

Each second YES YES

D8132
Port Number of the 
Connected Slave 3

Each second YES YES

D8133 Reserved ― ― ―

Device 
Address 

Description Updated Ladder FBD

bit
15

bit
0

bit
7

bit
8

Analog input  AI1 (Out of range error: minimum)
Analog input  AI0 (Out of range error: minimum)

Analog input  AI1 (Out of range error: maximum)
Analog input  AI0 (Out of range error: maximum)

3
 
1

 
2

 
4

 
5

 
6
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D8134 High-Speed Counter(Group 4/I4) 
These special data registers are 
used with the high-speed counter 
function and the frequency 
measurement function.
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Upper Word Current Value / Frequency 
Measurement Value (I4) 

Every scan YES YES
D8135 Lower Word
D8136 Upper Word

Preset Value ― YES YES
D8137 Lower Word
D8138 Upper Word

Reset Value ― YES YES
D8139 Lower Word

D8140 High-Speed Counter (Group 5/I5) 
These special data registers are 
used with the high-speed counter 
function and the frequency 
measurement function.
For details, refer to Chapter 3 “4.7 
High-Speed Counter” on page 3-55.

Upper Word Current Value / Frequency 
Measurement Value (I5)

Every scan YES YES
D8141 Lower Word
D8142 Upper Word

Preset Value ― YES YES
D8143 Lower Word
D8144 Upper Word

Reset Value ― YES YES
D8145 Lower Word

D8146, 
8147

Reserved ― ― ―

D8148

Remote I/O Slave 1
Special data registers used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote I/O 
Master” on page 12-47.

Connection Error Status
When a 
communication 
error occurs

YES YES

D8149 Analog input (AI10) Every scan YES YES
D8150 Analog input (AI11) Every scan YES YES
D8151 Analog input (AI12) Every scan YES YES
D8152 Analog input (AI13) Every scan YES YES
D8153 Analog input (AI14) Every scan YES YES
D8154 Analog input (AI15) Every scan YES YES
D8155 Analog input (AI16) Every scan YES YES
D8156 Analog input (AI17) Every scan YES YES

D8157

Remote I/O Slave 2
Special data registers used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote I/O 
Master” on page 12-47.

Connection Error Status
When a 
communication 
error occurs

YES YES

D8158 Analog input (AI20) Every scan YES YES
D8159 Analog input (AI21) Every scan YES YES
D8160 Analog input (AI22) Every scan YES YES
D8161 Analog input (AI23) Every scan YES YES
D8162 Analog input (AI24) Every scan YES YES
D8163 Analog input (AI25) Every scan YES YES
D8164 Analog input (AI26) Every scan YES YES
D8165 Analog input (AI27) Every scan YES YES

D8166

Remote I/O Slave 3
Special data registers used by remote I/O.
For details, refer to Chapter 12 “4.2 Remote I/O 
Master” on page 12-47.

Connection Error Status
When a 
communication 
error occurs

YES YES

D8167 Analog input (AI30) Every scan YES YES
D8168 Analog input (AI31) Every scan YES YES
D8169 Analog input (AI32) Every scan YES YES
D8170 Analog input (AI33) Every scan YES YES
D8171 Analog input (AI34) Every scan YES YES
D8172 Analog input (AI35) Every scan YES YES
D8173 Analog input (AI36) Every scan YES YES
D8174 Analog input (AI37) Every scan YES YES
D8175 Reserved ― ― ―

Device 
Address 

Description Updated Ladder FBD
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D8176

Analog Input/Output Value to the Analog Cartridge (Port 1)
• For the analog input type
The analog input values to the analog cartridges are converted to 
digital values and stored to the corresponding special data registers.
• For the analog output type
The analog output values to the analog cartridges are stored to the 
corresponding special data registers in digital values.
For details, refer to Chapter 3 “4.15 Analog Cartridge” on page 3-
88.
D8176 = AI2/AQ2, D8177 = AI3/AQ3

AI2/AQ2 Every scan YES YES

D8177 AI3/AQ3 Every scan YES YES

D8178
Analog Status to the Analog Cartridge (Port 1)
The analog status to the analog cartridges is stored to the 
corresponding special data registers.
For details, refer to Chapter 3 “4.15 Analog Cartridge” on page 3-
88.
D8178 = AI2/AQ2, D8179 = AI3/AQ3

AI2/AQ2 Every scan YES YES

D8179 AI3/AQ3 Every scan YES YES

D8180 to 
8185

Reserved ― ― ―

D8186

Analog Input/Output Value to the Analog Cartridge (Port 2)
•For the analog input type
The analog input values to the analog cartridges are converted to 
digital values and stored to the corresponding special data 
registers.

•For the analog output type
The analog output values to the analog cartridges are stored to 
the corresponding special data registers in digital values.

For details, refer to Chapter 3 “4.15 Analog Cartridge” on page 3-
88.
D8186 = AI4/AQ4, D8187 = AI5/AQ5

AI4/AQ4 Every scan YES YES

D8187 AI5/AQ5 Every scan YES YES

D8188
Analog Status to the Analog Cartridge (Port 2)
The analog status to the analog cartridges is stored to the 
corresponding special data registers.
For details, refer to Chapter 3 “4.15 Analog Cartridge” on page 3-
88.
D8188 = AI4/AQ4, D8189 = AI5/AQ5

AI4/AQ4 Every scan YES YES

D8189 AI5/AQ5 Every scan YES YES

D8190 to 
8199

Reserved ― ― ―

Device 
Address 

Description Updated Ladder FBD
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Cartridge Slot Information
The type IDs, status information, system software version of the digital I/O cartridge and the analog cartridge are 
written to the special data registers as the cartridge slot information. The allocation of information is as follows.

D8122, D8123 = Cartridge Slot 1 Information 
D8124, D8125 = Cartridge Slot 2 Information 

The system software version displays the version of the software written to the cartridge.

Type ID List

Status List

Type ID
Type Number

Hexadecimal Binary
0x00 0000 0000 FC6A-PJ2A
0x01 0000 0001 FC6A-PK2AV
0x02 0000 0010 FC6A-PK2AW
0x03 0000 0011 FC6A-PJ2CP
0x09 0000 1001 FC6A-PTS4, FC6A-PTK4
0x0A 0000 1010 FC6A-PN4
0xFF 1111 1111 Not connected

Status
Description

Hexadecimal Binary
0x00 0000 0000 Normal

0x81 1000 0001 
Communication error (An error has occurred in the communication 
between the Touch and a cartridge.)

0x82 1000 0010
Unknown device is detected (The attached cartridge is not recognized by 
the Touch.)

0x83 1000 0011
Device setting error (No cartridge is attached or the attached cartridge is 
different from that set in the ladder program or the FBD program.)

0x84 1000 0100
Device writing error (The attempt to set the operation of the cartridge 
failed.)

D8122, D8124

D8123, D8125

Status Type ID

Reserved System Software Version

Bit
15

Bit
0

Bit
7

Bit
8
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Bit
15
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Touch Setup

This chapter describes the Touch setup screen and how to perform setup.

  

1.1 Maintenance Screen Overview

You can display the Maintenance screen in Run Mode. It will allow you to access the System Mode, make Brightness/
Contrast adjustment, do Device Monitor, Ladder Monitor, and Start/Stop.

Maintenance Screen functions are indicated below:

*1 When ladder program is selected for control function
*2 When FBD program is selected for control function

Chapter 28 Touch Setup

1 Maintenance Screen

Color LCD models Monochrome LCD models

Button Description

System Mode
In System Mode, you can specify the initial settings and initialize data of the Touch.
For details, refer to “2 System Mode Overview” on page 28-3.

Device Monitor
Shows the Device Monitor. This screen can be used to register devices and monitor and change 
values of devices. For details, refer to Chapter 24 “2.2 Device Monitor” on page 24-19.

Brightness/Contrast
Color LCD models:

The control of brightness adjustment of the screen is displayed. 
Adjusts the brightness of the screen.

Monochrome LCD models: 
The control of brightness and contrast adjustment of the screen is 
displayed. Adjusts the brightness and contrast of the screen.

Ladder Monitor
Ladder is displayed and allows you to monitor ladder programs. For details, refer to Chapter 24 “2.3 
Ladder Monitor” on page 24-23. The Ladder Monitor only operates when ladder program is selected 
as the programming language for the control function.

Ladder Start/Stop*1

FBD Start/Stop*2

Manipulates start control (M8000) to run and stop the ladder program or FBD program operation. 

While the ladder program operation is stopped, "Ladder STOP*1" or "FBD STOP*2" flashes at the 
lower-right corner of the Touch screen.

• If a password has been configured for the project data and press System Mode, Device Monitor or 
Ladder Monitor, the Enter Password screen will be displayed. Select a user name, and then enter the 
password. For details, refer to Chapter 21 “User Accounts and the Security Function” on page 21-1.

• When the Stop Input or Reset Input is on, M8000 (Start Control) cannot control the state of the ladder 
program or FBD program (RUN/STOP).
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1.2 Displaying the Maintenance Screen

Press the upper-left corner of the Touch screen for three seconds or more.
If the Base Screen is switched before three seconds have elapsed, the load operation for the Maintenance Screen will 
be canceled. Please press it again.

1.3 Adjusting Screen Brightness

1 On the Maintenance screen, press Brightness (Color LCD models), or Brightness/Contrast (Monochrome LCD 
models).

2 Press  or  to adjust to your preferred brightness.

*1 Monochrome LCD models only

Press and hold 3 
or more seconds

Touch

• To display the Maintenance Screen, select the Enable Maintenance check box under the System tab 
in the Project Settings dialog box.

• If a touch switch is placed in the upper-left corner of the screen, switching to the Maintenance Screen 
will not be possible.

Color LCD models Monochrome LCD models

Color LCD models Monochrome LCD models

You can also adjust the screen brightness and contrast by using the following items.

•  or  buttons on the Top Page in System Mode
• The values of HMI Special Data Registers

Brightness: LSD51

Contrast*1: LSD55
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The System Mode allows you to access the internal Touch initial settings, self diagnosis, and clearing logged data. In 
this mode, the project in the Touch will not be running.

2.1 System Mode Screens

In the System Mode, the content of the Top Page appears. (as shown below).

The following items are included on the Top Page and Main Menu. When you press the button of an item the 
operation and settings screen for that item will be displayed.

■ Top Page

■ Main Menu

2 System Mode Overview

Color LCD models Monochrome LCD models

パスワード

For information on accessing the Touch System Mode, refer to “1.2 Displaying the Maintenance Screen” on 
page 28-2. 

Item Descriptions See page

Run Switches to Run Mode. Page 28-9

Main Menu Displays the Main Menu. Page 28-3

Item Descriptions See page

Initial Setting
Allows adjustment of settings relating to operation, 
communication parameters, and log data of the Touch.

Page 28-5

Clock Setting Allows setting of the internal clock of the Touch. Page 28-9

Run Switches to Run Mode. Page 28-9

System Info.
Displays information relating to the type number, 
project, as well as runtime system of the Touch.

Page 28-9

Top Page Moves to the Top Page. Page 28-10

Self Diag.
Executes self diagnosis of memory, the touch panel, display, 
communication and other self diagnosis.

Page 28-10

The screens under the Top Page in the System Mode are displayed in English only.
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2.2 Names and Layout of Setup Menus

Main Menu Initial Setting System Op. Backlight

Start Time

Details

Default Scr. No.

Password

Autorun

Alarm Log

Data Log

Op. Log

Touch PnlAdj

Initialize

Retry Cycles

Time Out

Trans. Wait

Comm. Driver

Parameter1

Parameter2

Parameter3

Parameter4

O/I Link Set1

O/I Link Set2

O/I Link

RS232C

RS422/485

Comm. I/F

TP/CP Change
IP Address

Default Gateway

Misc Setting

Ext. IP Address
Clock Setting

Run

System Info. System

System2

Font

Top Page

Self Diag. Memory

Display LCD

Draw

Brightness

Backlight

Buzzer

Contrast

Trace

Fixed Points

Sequent

Touch Panel

IN OUT

HSC

I/O

Comm.

Seq. Check
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3.1 Initial Setting

Press Initial Setting on the Main Menu to display the initial setting screen. You can use this screen to input the 
settings for Touch operation and communication parameters, and to clear the logs. To return to the Main Menu, press 
Main Menu at the top of the screen.

● System Op. (System Operation)
From the Main Menu, press Initial Setting, and then System Op. to display the system operation menu screen. 
You can use this screen to set the items below. Press the button for each item to set it.

■ Backlight
This item sets the amount of time (in minutes) until the backlight turns off automatically when the screen is not 
touched or switched for a preset amount of time. 
From the Main Menu, press Initial Setting, System Op., and then Backlight. 
To set a value, enter the value using the Keypad, and then press ENT. 
Press CAN to cancel the entered value and display the currently set value.

■ Start Time
This item sets the amount of time (in minutes) until communication with the external device starts after Touch power 
ON. This can be used to synchronize boot times with the external device.
From the main menu, press Initial Setting, System Op., and then Start Time.
To set a value, enter the value using the Keypad, and then press ENT. 
Press CAN to cancel the entered value and display the currently set value.

3 Settings

• To return to the initial settings screen, press Init Set at the top of the screen.
• To return to the system operation menu screen from any of the settings screens below, press System 

Op. at the top of the screen.

• The setting is not updated if you display another screen before pressing ENT.
• Setting a time of 0 turns off the backlight automatically.

The setting is not updated if you display another screen before applying the setting.
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■ Details (Detailed Settings)
The following items can be set.
• Whether or not to have a sound made when a touch switch is pressed.
• Select the screen number to be displayed as a binary number or BCD (binary coded decimal).
• To set blink cycle.
• Display the error message in Japanese or English.
From the Main Menu, press Initial Setting, System Op., and then Details.

Select the item to change using ▲ or ▼ . The selected item is highlighted. 
Each press of CHG changes the property of the selected item. Repeat this procedure until the desired properties are 
displayed. 
Press ENT to apply the changes.

■ Default Scr. No. (Default Screen Number)
This item sets the No. (as a decimal value) of the screen to display after power ON. 
From the main menu, press Initial Setting, System Op., and then Default Scr. No.
To set a value, use the keypad to enter a value. 
Press ENT on the keypad to apply the value entered.
Press CAN to cancel the entered value and display the currently set value.

■ Password
Specifies a password to use to move to System Mode. This changes the password for the "Administrator" Security 
Group of the WindO/I-NV3.
From the Main Menu, press Initial Setting, System Op., and then Password.
Press Change Password to display the password input screen. 
To enter a password, use the arrow keys (↑, ↓, ←, →), to move the cursor to a selected character and then press 
ENT.
Once the the password is entered, move the cursor to OK, and then press ENT to confirm the password entered. To 
cancel changing the password, move the cursor to CAN, and then press ENT.
To clear the password input field, move the cursor to CLR, and then press ENT.

■ Autorun
You have the option to enable or disable the USB Autorun function.
When Autorun is enabled, Autorun function will be executed when a USB flash drive is inserted to the Touch.
From the Main Menu, press Initial Setting, System Op., and then Autorun.

The setting is not updated if you display another screen before applying the setting.

• The setting is not updated if you display another screen before applying the setting.
• If the Default Scr. No. is set to 0, Touch will display the screen set in the external device instead of the 

Default Screen. For details, refer to Chapter 3 “System Area 1” on page 3-23.

• If you want to return to the password screen and decide not to change the password, move the cursor to 
the CAN and press ENT on the password input screen.

• Pressing ENT without entering a password disables the password function.

• When you do not assign a password to a project data, the Password is blank.
• If you forget your password, contact for sales representative.

The setting is not updated if you display another screen before applying the setting.
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● Initialize
From the Main Menu, press Initial Setting, and then Initialize to display the initialization menu screen. 
You can use this screen to set the following items. Press the button for each item to set it.

■ Alarm Log
Clears all the Alarm Log data.
From the Main Menu, press Initial Setting, Initialize, and then Alarm Log.
Press Yes to clear the Alarm Log data.

■ Data Log
Clears all the Data Log data.
From the Main Menu, press Initial Setting, Initialize, and then Data Log.
Press Yes to clear the Data Log data.

■ Op. Log (Operation Log)
Clears all the Operation Log data. 
From the Main Menu, press Initial Setting, Initialize, and then Op. Log.
Press Yes to clear the Operation Log data.

■ Touch PnlAdj (Touch Panel Adjust)
Adjusts the analog touch panel. 
From the Main Menu, press Initial Setting, Initialize, and then Touch PnlAdj.
Press Yes and adjust according to the instructions on the screen.

● Comm. Driver (Communication Driver)
From the Main Menu, press Initial Setting, and then Comm. Driver to display the communication driver menu 
screen.
To specify settings, press the button to select a choice. Comm. Driver setting items vary based on the currently 
connected hardware. For details about settings, refer to the "External Device Setup Manual".
If No External Devices are selected from the Communication Driver, some settings cannot be modified.

● O/I Link
From the Main Menu, press Initial Setting, and then O/I Link to display the O/I link menu screen. 
This screen displays information on the O/I Link. 
(Various settings can be made by pressing O/I Link Set 1 and O/I Link Set 2.)

• To return to the initial settings screen, press Init Set at the top of the screen.
• To return to the initialization menu screen from any of the settings screens below, press Init at the top of 

the screen.

Press the center of  displayed on the screen, in the following order: lower-left corner, lower-right 
corner, upper-left corner, upper-right corner of the Touch screen. The position of the analog touch 
panel is properly adjusted and set.

Press the center of
the symbol.

To return to the initial settings screen, press Init Set at the top of the screen.

• To return to the initial settings screen, press Init Set at the top of the screen.
• For details about settings, refer to the "External Device Setup Manual".



3 Settings

28-8 SmartAXIS Touch User's Manual

● Comm. I/F (Communication Interface)
From the Main Menu, press Initial Setting, and then Comm. I/F to display the communication interface settings 
menu screen. 
You can use this screen to set the items below. Press the button for each item to set.

■ RS232C
Allows the setting of communication parameters for the Serial Interface Port (RS232C).
From the Main Menu, press Initial Setting, Comm. I/F, and then RS232C.

■ RS422/485
Allows the setting of communication parameters for the Serial Interface Port (RS422/485).
From the Main Menu, press Initial Setting, Comm. I/F, and then RS422/485.

■ IP Address
Allows the setting of the IP address and subnet mask.
From the Main Menu, press Initial Setting, Comm. I/F, and then IP Address.
Press <-- or --> to select an item, and then use the Keypad to enter the IP address and subnet mask values. 
Press ENT to apply the entered values.

■ Default Gateway
Specify the default gateway.
From the Main Menu, press Initial Setting, Comm. I/F, and then Default Gateway.
Press <-- or --> to select an item, and then use the Keypad to enter the default gateway value. Press ENT to apply 
the entered value.

■ Misc Setting (Miscellaneous Setting)
Specify whether to allow or prohibit Maintenance Communication via TCP/IP (refer to Chapter 23 “Using the online 
function for Ethernet communication” on page 23-7).
From the Main Menu, press Initial Setting, Comm. I/F, and then Misc Setting.
Each press of CHG changes the property of the selected item. Repeat this procedure until the desired properties are 
displayed. 
Press ENT to apply the entered value.

■ Ext. IP Address (External Device IP Address)
Changes the IP addresses for the external device.
From the Main Menu, press Initial Setting, Comm. I/F, and then Ext. IP Address.

Procedure

1 Press <-- or --> to select the station number, and then enter the station number value with the numeric keypad.

2 Press ENT to confirm the entered value. The IP address for the selected station number is displayed.

3 Press <-- or --> to select the item, and then enter the IP address with the numeric keypad.

4 Press ENT to confirm the entered value.

5 Press SAVE to save the settings.

• To return to the initial settings screen, press Init Set at the top of the screen.
• Press Comm. I/F at the top of the screen to return to the communication interface settings menu 

screen.

The setting is not updated if you display another screen before applying the setting.

The setting is not updated if you display another screen before applying the setting.

The setting is not updated if you display another screen before applying the setting.

If you switch to another screen or change the station number before pressing SAVE, the settings are not 
saved.
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● TP/CP Change (Change the Timer and counter preset value)
Saves the control device timer and counter preset values.
From the Main Menu, press Initial Setting, and then TP/CP Change.
If you press SAVE, the modified values are saved and the project data is updated.
If you press CLEAR, the modified values are restored to the values configured in the project data.

3.2 Clock Setting

Press Clock Setting in the Main Menu to display the clock settings screen. 
Use this screen to set the internal clock of the Touch. 
To return to the Main Menu, press Main Menu at the top of the screen.

Procedure

1 Press <-- or --> to select an item and then the date or time with the numerical keypad.

2 Press ENT to apply the new setting.

3 Press SAVE to save the date/time setting. 

3.3 Run

Switches to the Run Mode to execute the project.

3.4 System Info. (System Information)

From the Main Menu, press System Info., and then press System or System 2 to display the system information screen. 
This screen displays information such as the Touch type number, the type and version number of runtime system. 
To return to the Main Menu, press Main Menu at the top of the screen.

● System
From the Main Menu, press System Info. and then System.
Displays the following settings:
• Touch type number
• MAC address
• Boot software version
• Runtime system version
To return to the system information screen, press System Info. at the top of the screen.

● System 2
From the main menu, press System Info. and then System 2.
Displays the following settings:
• Project file name
• External device manufacturer
• Communication protocol
• Communication driver version
To return to the system information screen, press System Info. at the top of the screen.

● Font
From the Main Menu, press System Info., and then Font.
Displays the font type stored in Touch. 
To return to the system information screen, press System Info. at the top of the screen.

The setting is not updated if you display another screen before applying the setting.

Only the first 15 characters of the project name are displayed.
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3.5 Top Page

Press Top Page in the Main Menu to return to the Top Page.

3.6 Self Diag. (Self Diagnosis)

From the Main Menu, press Self Diag. to display the self-diagnosis screen. 
Use this screen to run Touch internal self-diagnosis. To execute an operation, press the corresponding button. 
To return to the Main Menu, press Main Menu at the top of the screen.

• You need inspection jigs to run self-diagnosis.
• Self Diagnosis is a special screen for factory inspections. Do not use without due reason.
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1.1 Packing Contents

Before installing the Touch, make sure that the specifications of the product conform to your requirements, and that 
no parts are missing or damaged due to accidents during transportation.

Chapter 29 SmartAXIS Specifications

1 Touch

Name Pcs/pack

Touch Unit 1

Instruction Sheet 1

Mounting clips 2

Power plug
(Attached to the Touch)

1

Communication I/F plug
(Attached to the Touch)

1

USB Cable Lock Pin 2

USB Clamp Band 2
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1.2 Type Number

LCD size I/O configuration Bezel color Type No.

3.7inch STN Monochrome 
LCD

Digital sink in: 6pt
Shared digital sink in/analog in: 2pt
Relay out: 4pt

Light gray FT1A-M12RA-W

Dark gray FT1A-M12RA-B

Silver FT1A-M12RA-S

Digital source in: 6pt
Shared digital sink in/analog in: 2pt
Transistor sink out: 4pt
Analog out: 2pt

Light gray FT1A-M14KA-W

Dark gray FT1A-M14KA-B

Silver FT1A-M14KA-S

Digital sink in: 6pt
Shared digital sink in/analog in: 2pt
Transistor source out: 4pt
Analog out: 2pt

Light gray FT1A-M14SA-W

Dark gray FT1A-M14SA-B

Silver FT1A-M14SA-S

3.8inch TFT Color LCD

Digital sink in: 6pt
Shared digital sink in/analog in: 2pt
Relay out: 4pt

Light gray FT1A-C12RA-W

Dark gray FT1A-C12RA-B

Silver FT1A-C12RA-S

Digital source in: 6pt
Shared digital sink in/analog in: 2pt
Transistor sink out: 4pt
Analog out: 2pt

Light gray FT1A-C14KA-W

Dark gray FT1A-C14KA-B

Silver FT1A-C14KA-S

Digital sink in: 6pt
Shared digital sink in/analog in: 2pt
Transistor source out: 4pt
Analog out: 2pt

Light gray FT1A-C14SA-W

Dark gray FT1A-C14SA-B

Silver FT1A-C14SA-S
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1.3 Part Names

■  FT1A-*12RA

No. Name Description

(1) Display

(2) Touch Panel

(3) Power Supply Terminal Connector : Terminal Block 3 pin

(4) Serial Interface (Port)
RS232C, RS422/485
Connector : Terminal Block 9 pin

(5) Ethernet Interface (Ethernet)
IEEE802.3u
10BASE-T/100BASE-TX
Connector : RJ-45

(6) USB Interface (USB1)
USB2.0 (Device)
Connector : Mini-B

(7) USB Interface (USB2)
USB1.1 (External device)
Connector : Type A

(8) Output Terminal (Q0 to Q3) Relay output (10A)

(9) Input Terminal (I0 to I7) Digital input, Analog input

(1), (2)

(5)

(4)

(3) (6) (7)

(8) (9)
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■ FT1A-*14KA/14SA

No. Name Description

(1) Display

(2) Touch Panel

(3) Power Supply Terminal Connector : Terminal Block 3 pin

(4) Serial Interface (Port)
RS232C, RS422/485
Connector : Terminal Block 9 pin

(5) Ethernet Interface (Ethernet)
IEEE802.3u
10BASE-T/100BASE-TX
Connector : RJ-45

(6) USB Interface (USB1)
USB2.0 (Device)
Connector : Mini-B

(7) USB Interface (USB2)
USB1.1 (External device)
Connector : Type A

(8) Output Terminal (Q0 to Q3, AQ0 to AQ1) Transistor output, analog output

(9) Input Terminal (I0 to I7) Digital input, Analog input

(10) Slot 1

Optional product (analog cartridge) expansion
•FC6A-PJ2A
•FC6A-PK2AV
•FC6A-PK2AW
•FC6A-PJ2CP

(11) Slot 2

Optional product (analog cartridge) expansion
•FC6A-PJ2A
•FC6A-PK2AV
•FC6A-PK2AW
•FC6A-PJ2CP

(1), (2)

(5)

(4)

(3) (6) (7)

(8) (9)

(10) (11)
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1.4 External Interfaces

● Serial Interface (Port)

 CAUTION

• Make sure to turn off the power to the Touch before wiring each interface.
• Do not touch the terminals during communication. Doing so may result in electrical shock.
• When keeping power ON, terminals connected to external devices may reach high temperatures. Do not touch 

the terminals immediately after turning the power off.
• Do not touch the terminals immediately after turning the power off. Doing so may result in electrical shock.
• Insert and crimp the wire to the end portion of the ferrule.
• Always use ferrules when wiring stranded wire and multiple wires to the terminal block. Otherwise there is a risk 

of wires becoming disconnected.

Interface Specification RS232C, RS422/485

Connector Detachable Terminal Block 9 pin

Applicable cable
RS232C: AWG16 to AWG28
RS422/485: AWG16 to AWG28 Shielded twisted-pair
Stripped wire length 7 mm (Solid wire)

Recommended ferrule

AI 0.34-8 TQ (For AWG22, For 1 wire)
AI 0.5-8 WH (For AWG20, For 1 wire)
AI-TWIN2 x 0.5-8 WH (For AWG20, For 2 wires)
(Phoenix Contact)

Tightening Torque 0.25 N•m (Screwdriver SZS 0.4 x 2.5, Phoenix Contact)

No. Name I/O Function Communication type

1 SD OUT Send Data

RS232C

2 RD IN Receive Data

3 RS OUT Request to Send

4 CS IN Clear to Send

5 SG ― Signal Ground

RS422/485

6 SDA OUT Send Data (+)

7 SDB OUT Send Data (-)

8 RDA IN Receive Data (+)

9 RDB IN Receive Data (-)

The Touch is not equipped with terminating resistance. When using the RS422/485 interface, insert 
terminating resistance with the appropriate value (around 100 to 120 Ω) between terminal No. 8 (RDA) 
and terminal No. 9 (RDB) as required.
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● I/O Terminals

■ FT1A-*12RA

■ FT1A-*14KA/14SA

Terminal Arrangement

Terminal Arrangement and I/O Wiring Diagrams

■ FT1A-*12RA

Applicable cable AWG16 to AWG22
Stripped wire length 6.5 mm, coating diameter φ3.4 mm or lower (Solid wire)

Recommended ferrule

AI 0.34-8 TQ (For AWG22, For 1 wire)
AI 0.5-8 WH (For AWG20, For 1 wire)
AI 0.75-8 GY (For AWG18, For 1 wire)
AI 1-10 RD (For AWG18, For 1 wire)
AI 1.5-10 BK (For AWG16, For 1 wire)
AI TWIN 2 x 0.75 10GY (For AWG18, For 2 wires)
(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N•m (Screwdriver SZS 0.6 x 3.5, Phoenix Contact)

Applicable cable AWG20 to AWG22
Stripped wire length 5 mm, coating diameter φ2.6 mm or lower (Solid wire)

Recommended ferrule

AI 0.34-8 TQ (For AWG22, For 1 wire)
AI 0.5-8 WH (For AWG20, For 1 wire)
AI-TWIN2 x 0.5-8 WH (For AWG20, For 2 wires)
(Phoenix Contact)

Tightening Torque 0.2 N•m (Screwdriver SZS 0.4 x 2.5, Phoenix Contact)

I0 I1 I2 I3 I4 I5 I6 I7

Analog voltage
output device

2-wire
Sensor

DC IN

Power supply terminal

 

9 RDB

5 SG

1 SD

Port

Q0 COM0 Q1 COM1 Q2 COM2 Q3 COM3

Ry OUT

L L L L

L: Fuse : Load
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■ FT1A-*14KA

■ FT1A-*14SA

L: Fuse : Load

Power supply terminal

 

 

Q0

L

Q1

L

Q2

L

Q3

L

COM
(-)

V
(+)

Tr. OUT Analog OUT

AQ0
(+)

AQ0
(-)

Analog voltage/
current input device

AQ1
(+)

AQ1
(-)

Analog voltage/
current input device

9 RDB

5 SG

1 SD

Port

AI0
(+)

AI0
(-)

AI1
(+)

AI1
(-)

Analog voltage/
current input device

I6 I7I1 I2 I3 I4 I5I0

2-wire
Sensor

DC IN

Power supply terminal

 

 

Q0

L

Q1

L

Q2

L

Q3

L

COM
(+)

V
(-)

L

AQ0
(+)

AQ0
(-)

Analog voltage/
current input device

AQ1
(+)

AQ1
(-)

Analog voltage/
current input device

9 RDB

5 SG

1 SD

Port

Analog voltage/
current input device

: Fuse : Load

I1 I2 I3 I4 I5I0

2-wire
Sensor

AI0
(+)

AI0
(-)

AI1
(+)

AI1
(-)

DC IN

I6 I7

Tr. OUT Analog OUT
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● Input Terminal Specifications

Digital Input Specifications

Analog Input Specifications

■ FT1A-*12RA

*1 This value may vary by device.

Input Points 8

Rated Input Voltage 24V DC

Input Voltage Range 0 to 28.8V DC

Effect of Improper
Input Connection

No damage. 
(If any input exceeding the rated value is applied, permanent damage may be caused.)

Input Type
Sink (FT1A-*12RA/14SA)

Source (FT1A-*14KA)

Input Points
(Terminal No. /Common Line Name)

6 points in 1 common line
(I0 to I5/Power supply "-" terminal)

Rated Input Current
4.4mA (Sink Input)
5.2mA (Source Input)

Input Impedance
5.5kΩ (Sink Input)
4.7kΩ (Source Input)

Input System 
Transfer Time

OFF → ON 2.5 μs + filter value

ON → OFF 5 μs + filter value

Isolation
Between input 
terminals

Not isolated

Internal circuit Not isolated

Input Type Type1 (IEC61131-2)

External Load for I/O Interconnection Not needed

Signal Determination Method Static

Cable Length
(in compliance with EMC standards)

3m

Input Signal Type Voltage Input

Input Points
(Terminal No. /Common Line Name)

2 points in 1 common line
(I6, I7/internal -terminal, SG terminal for Port)

Input Range 0 to 10V DC

Rated Input Current 0.3mA

Input Impedance 78.0KΩ

Digital Resolution 0 to 1,000 (850 steps)

Data Type Binary data: 0 to 1000

Input Value of LSB*1 11.7mV

Type of Input Single-ended input

AD Conversion

Sample Duration Time 2 msec max.

Sample Repetition Time 2 msec max.

Total Input System Transfer Time 3 msec + filtering time + scan time

Input Error

Maximum Error at 25°C ±3.0% of full scale

Temperature Coefficient ±0.04% of full scale/°C

Maximum Error ±5.0% of full scale

General 
Characteristics

Operating Mode Self-scan

Conversion Method Σ∆ type

Status Display Device Monitor screen (LCD)

Maximum Temporary Error during Electrical Noise Tests ±5.0% of full scale

Recommended Cable for Noise Immunity Twisted pair shielded cable
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■ FT1A-*14KA/14SA

*1 This value may vary by device.

Calibration or Verification to Maintain Rated Accuracy Not possible

Maximum Permanent Allowed Overload (No Damage) 28.8V DC

Overload Status (Outside Input Range) Detection Detectable

Isolation
Between input terminals Not isolated

Between input and internal circuit Not isolated

Used as Digital 
Input

Digital Input Type — (IEC 61131-2 digital input type is not supported)

Input Threshold
ON voltage: 15V min. (ON current: 0.20 mA min.)

OFF voltage: 5V max. (OFF current: 0.06 mA max.)

Input Signal Type Voltage/current input (selectable with software)

Input Points
(Terminal No. /Common Line Name)

1 point in 1 common line
AI0+, AI1+/ AI0-, AI1-

Input Range
0 to 10V DC (Voltage Input)
4 to 20mA (Current Input)

Input Impedance
78.0KΩ (Voltage Input)
250Ω (Current Input)

Digital Resolution 0 to 1,000 (850 steps)

Data Type Binary data: 0 to 1000

Input Value of LSB*1 11.7mV (Voltage Input)
16μA (Current Input)

Type of Input Single-ended input

AD Conversion

Sample Duration Time 2 msec max.

Sample Repetition Time 2 msec max.

Total Input System Transfer Time
3 msec + filtering time + scan time (Voltage Input)
12 msec + filtering time + scan time (Current Input)

Input Error

Maximum Error at 25°C ±3.0% of full scale

Temperature Coefficient ±0.04%/°C of full scale

Maximum Error ±5.0% of full scale

General 
Characteristics

Operating Mode Self-scan

Conversion Method SAR

Status Display Device Monitor screen (LCD)

Maximum Temporary Error during Electrical Noise Tests ±5.0% of full scale

Recommended Cable for Noise Immunity Twisted pair shielded cable

Calibration or Verification to Maintain Rated Accuracy Not possible

Maximum Permanent Allowed Overload (No Damage)
28.8V DC (Voltage Input)
40mA (Current Input)

Overload Status (Outside Input Range) Detection Detectable

Isolation
Between input terminals Not isolated

Between input and internal circuit Not isolated

Used as Digital 
Input

Digital Input Type — (IEC 61131-2 digital input type is not supported)

Input Threshold
ON voltage: 15V min. (ON current: 0.20 mA min.)

OFF voltage: 5V max. (OFF current: 0.06 mA max.)
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Equivalent Circuit

■ FT1A-*12RA

■ FT1A-*14KA

■ FT1A-*14SA

Sink Input (I0 to I5) Shared Digital/Analog Input (I6, I7)

In
te

rn
al

 C
irc

ui
t

Input 
circuit

4.3kΩ

1.2kΩ

OV

24V DC

Input 
circuit

56kΩ

22kΩ

OV

24V DC

In
te

rn
al

 C
irc

ui
t

Source Input (I0 to I5) Shared Digital/Analog Input (I6, I7)

Input 
circuit

4.7kΩ

10kΩ

0V

24V DC 24V DC

47kΩ

In
te

rn
al

 C
irc

ui
t

In
te

rn
al

 C
irc

ui
t

Input 
circuit

56kΩ

22kΩ

120kΩ

130kΩ

0V0V

24V DC

Sink Input (I0 to I5) Shared Digital/Analog Input (I6, I7)

In
te

rn
al

 C
irc

ui
t

Input 
circuit

4.3kΩ

1.2kΩ

OV

24V DC
In

te
rn

al
 C

irc
ui

t

Input 
circuit

56kΩ

22kΩ

120kΩ

130kΩ

0V0V

24V DC
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Operating Range

● Output Specifications

Relay Output Specifications

■ FT1A-*12RA

Output Delay

Sink Input (I0 to I5) Source Input

Shared Digital/Analog Input (I6, I7)

2.7mA 5.3mA
Input Current (mA)

5V

15V

24V

Transition Area

ON Area

Input Voltage (V DC)

28.8V

0.9mA 4.4mA

OFF Area

-3.0mA -6.2mA
Input Current (mA)

5V

15V

24V

Transition Area

ON Area

Input Voltage (V DC)

28.8V

-1.0mA -5.2mA

OFF Area

ON Area

5V

15V

24V

28.8V

OFF Area

Transition Area

Input Current (mA)
0.2mA 0.37mA0.06mA 0.3mA

Input Voltage (V DC)

No. of Outputs (Terminal No.) 4 (Q0 to Q3)

Output Type 1a contact

Maximum Load Current 10A

Minimum Switching Load 10 mA/5V DC (reference value)

Initial Contact Resistance 100 mΩ max. (1A, 6V DC)

Electrical Life 100,000 operations min. (rated load 1,800 operations/hour)

Mechanical Life 20,000,000 operations min. (no load 18,000 operations/hour)

Rated Load 250V AC/10A, 30V DC/10A

Dielectric Strength

Between output 
terminal and 
internal circuit 2,300V AC 5mA, 1 minute

Between output 
terminals (COMs)

Status Display Device Monitor screen (LCD display)

OFF delay: 330 msec max.
Chatter: 6 msec max.
ON delay: 6 msec max. 

Command

Output Relay Status

ON

OFF

ON

OFF
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Transistor Output Specifications

■ FT1A-*14KA/SA

Equivalent Circuit

■ FT1A-*14KA/SA

No. of Outputs (Terminal No.) 4 (Q0 to Q3)

Output Type
Sink output (FT1A-*14KA)
Source output (FT1A-*14SA)

Rated Load 24V DC

Operating Load Voltage Range 20.4 to 28.8V DC

Maximum Load Current 0.3A

Voltage Drop (ON voltage) 1V max. (Voltage between COM and output terminal when ON)

Maximum Inrush Current 1A

Leakage Current 0.1 mA max.

Clamping Voltage 39V ±1V

Maximum Lamp Load 8W

Inductive Load L/R=10 ms (28.8V DC, 1 Hz)

External Current Draw
100 mA max., 24V DC
Sink output: power voltage at the +V terminal
Source output: power voltage at the +COM terminal

Isolation Photocoupler isolated

Status Display Device Monitor screen (LCD display)

Sink Output (Q0 to Q3) Source Output (Q0 to Q3)

V (+)

Output

COM (�)

Internal Circuit Internal Circuit

COM (+)

Output

V (�)
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Analog Output Specifications

■ FT1A-*14KA/SA

*1 Overshoot may occur at light loads.
The occurrence of overshoot can be controlled by inserting damping resistance into the circuit. A general guide for the 
damping resistance value is about 150 Ω including the input line impedance for the destination.

No. of Outputs (Terminal No.) 2 (AQ0 to AQ1)

Output Type Voltage/current output

Output Range
0 to 10 V (Voltage output)
4 to 20 mA (Current output)

Output Load
Impedance

2 kΩ min. (Voltage output)
500 Ω max. (Current output)

Load Type Resistance load

Digital Resolution 0 to 1,000 (10bit)

Output Value of LSB
10 mV (Voltage output)
16 μA (Current output)

Data Type Binary data: 0 to 1000

Monotonicity Yes

Output Error

Maximum Error at 
25°C

±0.3% of full scale

Temperature 
Coefficient

±0.02%/°C of full Scale

Reproducibility 
After Stabilization 
Time

±0.4% of full scale

Non-linearity ±0.01% of full scale

Output Ripple 30 mV max.

Overshoot 0%*1

Maximum Error ±1.0% of full scale

Open Current Loop Cannot be detected
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1.5 Specifications

■ Applicable Standards

■ Environmental Specifications

■ Electrical Specifications

FT1A-*12RA

FT1A-*14KA/SA

■ Construction Specifications

*1 When using the Touch as the EMC Standard Approved Products, attach a ferrite core (ZCAT3035-1330 manufactured by TDK 
Corporation) to the power cables and the communication cables.
If there a risk of an error occurring due to noise, install the product separated from sources of noise such as power lines, 
high voltage lines, and load lines. Also attach a ferrite core to the I/O cable (ZCAT3035-1330 manufactured by TDK 
Corporation).

*2 FT1A-*12RA-*: The UL and c-UL certified operating temperature is 0 to 50ºC.

Safety Standard
UL508
CSA C22.2 No.142 (c-UL)

EMC Standard*1 IEC/EN 61131-2:2007

Operating Temperature
0 to 55°C: FT1A-M (Monochrome LCD models)*2 (No freezing)

-20 to 55°C: FT1A-C (Color LCD models)*2 (No freezing)

Relative Humidity 10 to 95% RH (No condensation)

Storage Temperature -20 to +60°C (No freezing)

Storage Humidity 10 to 95% RH (No condensation)

Altitude
Operation: 0 to 2,000m
Transport: 0 to 3,000m

Pollution Degree 2

Corrosion Immunity Free from corrosive gases

Rated Voltage 24V DC

Power Consumption 9.2W max.  When USB2 is unused: 5.8W max.

Power Voltage Range 20.4 to 28.8V DC

Allowable Momentary Power 
Interruption

10 msec max.

Inrush Current 50A max.

Dielectric Strength
Between power and FE terminals: 500V AC, 5mA,1 minute
Between power and output terminals: 2,300V AC, 5mA, 1 minute

Rated Voltage 24V DC

Power Consumption 10.1W max.  When USB2 is unused: 8.1W max.

Power Voltage Range 20.4 to 28.8V DC

Allowable Momentary Power 
Interruption

11 msec max.

Inrush Current 50A max.

Dielectric Strength
Between power and FE terminals: 500V AC, 5mA,1 minute
Between power and output terminals: 500V AC, 5mA, 1 minute

Vibration Resistance 5 to 8.4Hz amplitude 3.5mm, 8.4 to 150Hz acceleration 9.8m/s2

10 times on each of three mutually perpendicular axes (100 minutes) (IEC61131-2)

Shock Resistance 147m/s2, 11ms (5 shocks on each of three mutually perpendicular axes)  
(IEC61131-2)
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■ Performance Specifications

■ EMC Specifications

*2 The backlight life refers to the time until the surface brightness reduces to a half after using continuously at room 
temperatures.

*3 In high temperature environments battery life may be affected, so retention time may be reduced.
*4 The degree of protection for the operating section after the panel is attached. The compliance test has been passed, but this 

is not a guarantee of operation in all environments.

Type Number FT1A-M (Monochrome LCD models) FT1A-C (Color LCD models)

Display

LCD Type STN Monochrome LCD TFT Color LCD

Display Colors 2 Colors (Black, White) 8 shades 65,536 Colors

Effective Display Area [mm] 87.59(W) × 35.49 (H) 88.92 (W) × 37.05 (H)

Display Resolution 240 (W) x 100 (H) pixels

View angle Left/Right/Top/Bottom: 45° Left/Right: 40°, Top: 20°, Bottom: 60°

Contrast Adjustment 32 levels –

Brightness of LCD only
White: 740 [cd/m2]

Red: 135 [cd/m2]
400 [cd/m2]

Brightness Adjustment 32 levels

Backlight
LED (White, Red)
Screen color: White, Pink, Red

LED (White)

Backlight Life*2 50,000 hours nominal

Touch 
Panel

Switch Type Analog Resistive Film

Operating Force 0.2 to 2.5 N

Multiple Operations Impossible

Life 1,000,000 operations

User Memory 5MB

Backup Battery*3

Lithium secondary battery
Backup Duration: Approx. 30 days (typical) (Operating temperature: 25°C)
Charging Time: Approx. 15 hours for charging from 0% to 90% of full charge
Battery Life: 5 years in cycles of 9-hour charging and 15-hour discharging
Replaceability: Not possible to replace battery

Backup Data 128KB

Buzzer Output Single tone (tone length is adjustable)

Degree of Protection IP66F (IEC60529)*4

Weight (approx.)
FT1A-*12RA: 300 g
FT1A-*14KA/SA: 250 g

Type Number FT1A-*12RA FT1A-*14KA/SA

Radiated Emission
Class A : 10m
40dBµV/m quasi-peak (30M to 230MHz)
47dBµV/m quasi-peak (230M to 1GHz)

Electrostatic Discharge
Contact : ±6kV
Air : ±8kV

Electromagnetic Field

10V/m (80 to 1000 MHz)
3V/m (1.4 to 2.0 GHz)
1V/m (2.0 to 2.7 GHz)
80% AM (1kHz)

Fast Transient Burst
±2kV (Power, Output terminal)
±1kV (Port, Ethernet, Input terminal)

±2kV (Power)
±1kV (Port, Ethernet, Input terminal, 
Output terminal)

Surge Immunity
±500V (between +24V-0V)
±1kV (between +24V-FE, 0V-FE)

Conducted Radio
Frequency Immunity

10V (Power, Port, Ethernet, Input terminal, Output terminal)
(150kHz to 80MHz)
80% AM (1kHz)
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1.6 Dimensions

■ FT1A-*12RA
Unit: mm

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are intended for reference only.
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■ FT1A-*14KA/SA
Unit: mm

<Cable Attached Dimensions>

Depending on the type of connection cable used the dimensions shown above will change.
The dimensions given here are intended for reference only.

77
.0

65
.5

116.0 4.0 54.0
(58.9) 104.5

50

15
30

20
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1.7 Installation

● Operating Environment
For designed performance and safety of the Touch, do not install the Touch in the following environments:
• Where dust, briny air, or iron particles exist.
• Where oil or chemical splashes for a long time.
• Where oil mist is filled.
• In direct sunlight.
• Where strong ultraviolet rays exist.
• Where corrosive or combustible gasses exist.
• Where the Touch is subjected to shocks or vibrations.
• Where condensation occurs due to rapid temperature change.
• Where high-voltage or arc-generating equipment (electromagnetic contactors or circuit protectors) exists in the 

vicinity.

● Ambient Temperature
• Allow sufficient space for ventilation, and install the equipment away from heat sources.
• Allow at least 100mm between the Touch and walls or other equipment.
• Do not install the Touch where the ambient temperature exceeds the rated operating ambient temperature range. 

When mounting the Touch in such locations, provide a forced air-cooling fan or air-conditioner to keep the ambient 
temperature within the rated temperature range.

• The Touch is designed to install on a vertical plane so that natural air-cooling is provided. If you install it using any 
other orientation, use forced-air cooling, or lower the ambient operating temperature.

Derating

■ FT1A-*12RA
When using the Touch at an ambient temperature of 45°C or higher, reduce the output current of each output 

terminal as shown in the figure below.*1

Installed upright in landscape orientation

*1 FT1A-*12RA-*: The UL and c-UL certified operating temperature is 0 to 50ºC.

Output Current

10A

5A

1A

0
Ambient Temperature

45°C 50°C 55°C

If operating the FT1A-*12RA in a high-temperature environment, reducing the brightness of the backlight 
can help to limit the temperature rise of internal components.
The relationship between ambient temperature, the output current of each output terminal, and brightness 
is approximately as shown in the figure below.

The values shown above may vary with individual products. Please use this information as a reference at 
the time of design.

Brightness

100%

50%

0 35°C 45°C 50°C 55°C
Ambient Temperature

Output terminal not used

Output Current10A
Output Current5A

Output Current1A
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■ FT1A-*14KA/14SA
When used at ambient temperatures of 40ºC or higher, limit the usage of analog current output and the analog 
cartridge as shown in the figure below.

Power Voltage 
Range

Touch Analog Output Cartridge
Operating 

Temperature

20.4 to 24V DC
Voltage/current output 

cannot be used

Voltage output (FC6A-PK2AV)/
current output (FC6A-PK2AW) 

cannot be used
55ºC

20.4 to 28.8V DC
Current output cannot be 

used

Voltage output (FC6A-PK2AV)/
current output (FC6A-PK2AW) 

cannot be used
50ºC

20.4 to 28.8V DC No restrictions
Voltage output (FC6A-PK2AV)/
current output (FC6A-PK2AW) 

cannot be used
45ºC

20.4 to 28.8V DC
Current output cannot be 

used
Current output (FC6A-PK2AW)

cannot be used
45ºC

20.4 to 28.8V DC No restrictions No restrictions 40ºC

If operating the FT1A-*14KA/14SA in a high-temperature environment, reducing the brightness of the 
backlight can help to limit the temperature rise of internal components.
The relationship between ambient temperature and brightness is approximately as shown in the figure 
below.

The values shown above may vary with individual products. Please use this information as a reference at 
the time of design.

100%

40%

10%

0 30ºC 40ºC 55ºC

Brightness

Ambient Temperature
50ºC

Power Supply Voltage: 20.4 to 24 V
Unit Analog Output: Cannot be used, 
Cartridge: Voltage/current output cartridge cannot be used

Power Supply Voltage: 20.4 to 28.8 V
Unit Analog: No restrictions, 
Cartridge: No restrictions
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●  Installation
• Make a panel cut-out on the panel with the dimensions shown below.

• The Touch has the mounting clip positions not only on the top and bottom side (0.3 to 0.35 N•m). 

 CAUTION

• Do not tighten excessively, otherwise the Touch may warp and cause wrinkle on the display, or 
impair the waterproof characteristics.

• If the mounting clips are tightened obliquely to the panel, the Touch may fall off the panel.
• When installing the Touch into a panel cut-out, make sure that the gasket is not twisted. Especially 

when re-installing, take special care because any twists in the gasket will impair the waterproof 
characteristics.

• Even in the panel thickness range, there is a risk that the waterproof characteristics cannot be 
maintained due to the panel materials and size.

Unit: mm

A B Panel Cut-out

66.0
+1.0
   0

105.0
+1.0
   0

1.0 to 5.0

B 

A 

TOP

BOTTOM
Mounting Clip Position

Mounting Clip

Panel
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● Orientation
The Touch is designed to install on a vertical landscape. If you install it using any other orientation, confirm the 
limitations about operating temperature and the use of the Touch.

Orientation
Operating Ambient Temperature (no freezing)

FT1A-M
(Monochrome LCD models)

FT1A-C
(Color LCD models)

Vertical

Vertical landscape Portrait

0 to 55°C -20 to 55°C

Portrait (Clockwise)

0 to 50°C -20 to 50°C

Portrait (Counter Clockwise)

0 to 55°C -20 to 55°C

Horizontal (Flip)

0 to 55°C -20 to 55°C

Horizontal

0 to 50°C -20 to 50°C

• When installing the Touch in a diagonal, the limitations are same as a horizontal.
• Confirm the visibility of the display in a final installation.
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1.8 Attaching Cartridges (FT1A-*14KA/SA only)

1 Insert flat head screwdrivers into the screwdriver insertion slots in both locations of the unit, and while pushing the 
tabs of the cartridge cover, pull the cartridge cover directly upward to remove it.

2 Pay careful attention to the direction of the cartridge and attach it directly onto the unit.

Screwdriver insertion slot

Cartridge cover

Screwdriver 
insertion slot

 CAUTION

Attach the cartridge directly onto the unit. If the cartridge is attached when tilted, it may be damaged or cause 
communication problems.

Cartridge
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1.9 Wiring

● Power Supply Terminal
• Pin assignment is shown in the following table.

• Use applicable cables for wiring and recommended ferrules (made by Phoenix Contact) as follows.

● Cautions when connecting external devices
The Touch power supply is non-isolating. Interference or external noise from external devices due to wiring may 
cause adverse effects on the internal circuits of the Touch or external devices.
To prevent such damage, choose a proper solution depending on your system setup.
• Use a separate earth ground from the external noise source device.
• The wire for grounding should be thick and short in order to direct the noise from the noise source device to the 

earth ground.
• Use a separate power supply from the external noise source device.
• Insert an isolator on the communication line of the Touch and the non-isolated communication device (i.e. PLC) to 

prevent damage.

 CAUTION

• Turn off the power supply before wiring.
• Make the wiring as short as possible and run all wires as far away as possible from high-voltage 

and large-current cables. Follow all the procedures and precautions when wiring the Touch.
• Separate the Touch power supply wiring from the power lines of I/O devices and motor equipment.
• Ground the functional earth terminal to make sure of correct operation.
• Do not touch the terminals during communication. Doing so may result in electrical shock.
• When keeping power ON, terminals connected to external devices may reach high temperatures. 

Do not touch the terminals immediately after turning the power off.
• Do not touch the terminals immediately after turning the power off. Doing so may result in 

electrical shock.
• Insert and crimp the wire to the end portion of the ferrule.
• Always use ferrules when wiring stranded wire and multiple wires to the terminal block. 

Otherwise there is a risk of wires becoming disconnected.

+ Power supply 24V DC (+24V)

- Power supply 0V (0V)

Functional Earth (FE)

Applicable Cable
AWG16 to AWG22
Stripped wire length 7 mm (Solid wire)

Recommended ferrule

AI 0.34-8 TQ (For AWG22, For 1 wire)
AI 0.5-8 WH (For AWG20, For 1 wire)
AI 0.75-8 GY (For AWG18, For 1 wire)
AI 1-8 RD (For AWG18, For 1 wire)
AI 1.5-8 BK (For AWG16, For 1 wire)
AI-TWIN 2×0.5-8 WH (For AWG20, For 2 wires)
AI-TWIN 2×0.75-8 GY (For AWG18, For 2 wires)
(Phoenix Contact)

Tightening Torque 0.5 to 0.6 N•m (Screwdriver SZS 0.6 x 3.5, Phoenix Contact)
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● Cautions for using the Touch connected to a computer
When connecting the Touch to a computer via the Serial Interface (Port) or USB Interface, the Touch or the computer 
may break down depending on the conditions of the computer. Make sure of the following cautions, in order to 
prevent an accident.
• If the computer has a 3-pin power plug or power plug with a ground lead type. make sure to use a plug socket 

including a ground input electrode or ground the earth lead, respectively.
• If the computer has a 2-pin power plug without ground lead, follow the procedure below when connect the Touch 

to the computer.
(1) Pull out the power plug of the computer from the AC outlet.
(2) Connect the Touch to the computer.
(3) Insert the power plug of the computer into the AC outlet.

1.10 USB Cable Lock Pin Attachment

When using the USB interface (USB1, USB2), attach the USB cable lock pin to prevent disconnecting the USB cable from 
the Touch.

1 Insert the USB cable into the USB port.

2 Strain the “Edge part” of the USB cable lock pin, and insert the “Edge part” to the 2 holes upper the USB port.

3 Fasten the USB clamp band around the USB cable and the clamp part, secure them tightly.

 

Edge Part Clamp part 

Upper Holes 



SmartAXIS Touch User's Manual 29-25

1 Touch

29

Sm
artAXIS Specifications

Fasten the USB clamp band without the space between the clamp part and it, and the inclination.
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1.11 Maintenance and Inspection

Maintain and inspect the Touch periodically to ensure the best performance. Do not disassemble, repair, or modify 
the Touch during inspection.

● Maintenance Screen
Turn on the power to the Touch, then press and hold the upper-left corner of the screen for three seconds or longer. 
The Maintenance Screen appears on the screen.

• Permission to show the Maintenance Screen can be set using WindO/I-NV3 software. For details, refer to Chapter 3 
“3.1 System Tab” on page 3-19.

• The Maintenance Screen is not displayed in the System Mode.

● System Mode
Press the System Mode at the top of the Maintenance Screen. The Top Page appears.

Initial Setting, Self Diagnosis and Initialization of the data, etc can be executed in the System Mode.

Display
Wipe any stain of the display using a soft cloth slightly dampened with neutral detergent or 
alcoholic solvent. Do not use solvents such as thinner, ammonia, strong acid, and strong 
alkaline.

Terminals, Connectors
Check the terminals and connectors to make sure of no loose screws, incomplete insertion, or 
disconnected lines.

Mounting Clips
Make sure that all mounting clips and screws are tightened sufficiently. If the mounting clips are 
loose, tighten the screw to the recommended tightening torque.

Backlight
The Touch backlight cannot be replaced by the customer. When the backlight needs to be 
replaced, contact IDEC.

Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. 
Adjust the touch panel according to the following procedure when there is a gap in the operation 
of the touch panel.

Maintenance Screen (Color LCD models) Maintenance Screen (Monochrome LCD models)

Press and hold 3 
or more seconds

Touch

Top Page (Color LCD models) Top Page (Monochrome LCD models)
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● Adjusting the Brightness and Contrast
The brightness and contrast of the Touch display can be adjusted on the Adjust Brightness/Contrast Screen. Adjust 
the brightness and contrast to the best condition as required.

1 Press the Brightness (color LCD models) or Brightness/Contrast (monochrome LCD models) on the Maintenance 
Screen. 

The Adjust Brightness/Contrast Screen appears.

2 Press  and  at the bottom the Adjust Brightness/Contrast Screen to adjust the contrast to the optimal 
setting.

3 Press  to close the Adjust Brightness/Contrast Screen.

To adjust the brightness and contrast in the System Mode, use  and  located at the bottom of the Top 
Page.

Color LCD models Monochrome LCD models

Color LCD models Monochrome LCD models

Top Page (Color LCD models) Top Page (Monochrome LCD models)

Since contrast adjustment is not possible on color LCD models, the contrast adjust function is not displayed.
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● Adjusting the Touch Panel
A gap may be caused in the operation accuracy of the touch panel by the secular distortion, etc. Adjust the touch 
panel according to the following procedure when there is a gap in the operation of the touch panel.

1 Press Main Menu on Top Page in System Mode. The Main Menu appears.

2 Press Init Set, Initialize, and then Touch PnlAdj. The confirmation screen appears and asks “Adjust Touch Panel 
setting?” is displayed. Press Yes.
The Touch Panel Adjust Screen is displayed.

3 Press the center of the , then the position of the symbol changes one after another. Press five symbols 
sequentially.

4 When normally recognized, the confirmation screen of 2 is restored.

At step 3, when pressing a point away from the center of the , a recognition error will result. Then the  returns 
to the initial position, then repeat the step of 3 again.

Top Page (Color LCD models) Top Page (Monochrome LCD models)

Press the center of
the symbol.

When pressing , make sure to press the center of the symbol. This will ensure the accuracy of the touch 
panel operation.
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2.1 Packing Contents

Before installing the analog cartridge, make sure that the specifications of the product conform to your requirements, 
and that no parts are missing or damaged due to accidents during transportation.

2.2 Type Number

2.3 Part Names

2 Analog Cartridge

Name Pcs/pack

Cartridge 1

Instruction Sheet 1

Cartridge type
Inputs/
outputs

Type Type No.

Analog Output Cartridge
Output: 2 Voltage output: 0 to 10 V FC6A-PK2AV

Output: 2 Current output: 4 to 20 mA FC6A-PK2AW

Analog Input Cartridge

Input: 2
Voltage input: 0 to 10 V
Current input: 0 to 20 mA, 4 to 20 mA

FC6A-PJ2A

Input: 2
Thermocouple input: K, J, R, S , B, E, T, N, C
Resistance thermometer input: Pt100, Pt1000, 
Ni100, Ni1000

FC6A-PJ2CP

No. Name Description

(1) Terminal channel 0

(2) Terminal channel 1

(3) Connection connector for the Touch

(1) (2)

(3)
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2.4 Specifications

■ Analog Output Specifications

■ Analog Input Specifications

Type Number FC6A-PK2AV FC6A-PK2AW FC6A-PJ2A FC6A-PJ2CP

Rated Voltage 5.0 V, 3.3 V (Supplied from the Touch)

Consumption Current
5.0 V: 70 mA
3.3 V: 30 mA

5.0 V: 185 mA
3.3 V: 30 mA

5.0 V: -
3.3 V: 30 mA

5.0 V: -
3.3 V: 30 mA

Weight 15 g 15 g 15 g 15 g

Type Number FC6A-PK2AV FC6A-PK2AW

Output Type
Voltage Range 0 to 10 V -

Current Range - 4 to 20 mA

Load
Impedance 2 kΩ min. 500 Ω max.

Load Type Resistance load

D/A 
Conversion

Cycle Time 20 ms 20 ms

Settling Time 40 ms max. 20 ms max.

Total Output System Transfer Time 60 ms+1 scan 40 ms+1 scan

Output Error

Maximum Error at 25°C ±0.3% of FS ±0.3% of FS

Temperature Coefficient ±0.02%/°C of FS ±0.02%/°C of FS

Reproducibility After Stabilization Time ±0.4% of FS ±0.4% of FS

Non-linearity ±0.01% of FS ±0.01% of FS

Output Ripple 30 mV max. 30 mV max.

Overshoot 0% 0%

Maximum Error ±1.0% of FS ±1.0% of FS

Data

Digital Resolution 4,096 increments (12bit) 4,096 increments (12bit)

LSB Output Value 2.44 mV (0 to 10 V) 3.91 µA (4 to 20 mA)

Data Format in Application 0···4095 (0 to 10 V) 0···4095 (4 to 20 mA)

Monotonicity Yes Yes

Open Current Loop - Cannot be detected

Noise 
Resistance

Maximum Temporary Deviation 
during Electrical Noise Tests

±4.0% of FS max. ±4.0% of FS max.

Recommended Cable Shielded twisted pair

Crosstalk 1 LSB max. 1 LSB max.

Isolation None None

Effect When Output is Incorrectly Wired No Damage No Damage

Calibration to Maintain Rated Accuracy Not possible Not possible

Type Number FC6A-PJ2A FC6A-PJ2CP

Input Type
Voltage 
input

Current 
input

Resistance thermometer Thermocouple

Input Range 0 to 10 V

4 to 
20 mA
0 to 
20 mA

Pt100:
 -200 to +850 °C (-328 to 1562 'F)
Pt1000:
 -200 to +600 °C (-328 to 1112 'F)
Ni100:
 -60 to +180 °C (-76 to 356 'F)
Ni1000:
 -60 to +180 °C (-76 to 356 'F)

(K)-200 to 1300 °C (-328 to 2372 °F)
(J)-200 to 1000 °C (-328 to 1832 °F)
(R)0 to 1760 °C (32 to 3200 °F)
(S)0 to 1760 °C (32 to 3200 °F)
(B)0 to 1820 °C (32 to 3308 °F)
(E)-200 to 800 °C (-328 to 1472 °F)
(T)-200 to 400 °C (-328 to 752 °F)
(N)-200 to 1300  °C (-328 to 2372 °F)
(C)0 to 2315 °C (32 to 4199 °F)

Input Impedance 1 MΩ min. 250 Ω max. 1 MΩ min.

Allowable Conductor Resistance - - 10 Ω max. -

Input Detection Current - - TYP: 0.2 mA 1.0 mA max. -
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*1  The maximum amount of voltage value or current value that can be input without damaging the hardware.

AD 
Conversion

Sample Duration 
Time

10 ms 10 ms 250 ms 250 ms

Total Input System 
Transfer Time 20 ms+1 scan 500 ms+1 scan

Type of Input Single-ended input

Operating Mode Self-scan

Conversion Method SAR

Input 
Error

Maximum Error at 
25°C

±0.1% of FS ±0.1% of FS

±0.1% of FS
Cold junction compensation 
accuracy ±4.0°C or less
 
Exceptions
R, S thermocouple error:
 ±6.0°C
 (0 to 200°C range only)
B thermocouple error:
 Not guaranteed
 (0 to 300°C range only)
K, J, E, T, N thermocouple error:
 ±0.4% FS
 (0°C or lower range only)

Temperature 
Coefficient

±0.02%/°C of FS ±0.02%/°C of FS

Reproducibility After 
Stabilization Time ±0.5% of FS ±0.5% of FS

Non-linearity ±0.01% of FS ±0.01% of FS

Maximum Error ±1.0% of FS ±1.0% of FS

Data

Digital Resolution
4,096 increments 
(12bit)

 Pt100: 10500 (14bit) 
 Pt1000: 8000 (13bit)
 Ni100: 2400 (12bit)
 Ni1000: 2400 (12bit)

 K: 15000 (14bit)
 J: 12000 (14bit)
 R: 17600 (15bit)
 S: 17600 (15bit)
 B: 18200 (15bit)
 E: 10000 (14bit)
 T: 6000 (13bit)
 N: 15000 (14bit)
 C: 23150 (15bit)

LSB Input Value
2.44 mV
(0-10 V)

4.88 µA
(0 to 
20 mA)
3.91 µA
(4 to 
20 mA)

0.1°C
0.18'F

0.1°C
0.18'F

Data Format in 
Application Can be arbitrarily set for each channel in the range of -32,768 to 32,773

Monotonicity Yes

Noise 
Resistance

Maximum Temporary 
Deviation during 
Electrical Noise Tests

±4.0% of FS max.

Recommended cable Shielded twisted pair

Crosstalk 1 LSB max.

Isolation None

Effect When Input is 
Incorrectly Wired No Damage

Maximum Allowable Constant 
Load *1(non-destructive)

13 V 40 mA 13 V

Input Type Modification Software programming

Calibration to Maintain Rated 
Accuracy Not possible

Type Number FC6A-PJ2A FC6A-PJ2CP
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2.5 Dimensions

Unit: mm

2.6 Installation

Refer to Chapter 29 “1.8 Attaching Cartridges (FT1A-*14KA/SA only)” on page 29-22.

44
.6

34.8
12.5

17.8
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2.7 Wiring

● Terminal Arrangement

 CAUTION

• Do not connect a thermocouple to a hazardous voltage component (60V DC or peak 42.4 V or higher 
component).

• Always check the wiring before turning on the power. If the wiring is incorrect, the analog cartridge may be 
damaged. When there is a risk of malfunction due to noise, use a shielded cable for the wiring and connect both 
ends of the shield to the FG.

FC6A-PK2AV FC6A-PK2AW

FC6A-PJ2A FC6A-PJ2CP

Analog voltage input device

0...10 V

+ -

OUT1

+ - NC

Analog voltage input device

0...10 V

+ -

OUT0

+ - NC

Analog current input device

0...20 mA
4...20 mA

- +

OUT0

NC - +

Analog current input device

0...20 mA
4...20 mA

+ -

OUT1

NC + -

Analog current output device

0...20 mA
4...20 mA

- +

IN1

+ - +

Analog voltage output device

0...10 V

+ -

IN0

+ - +

ThermocoupleResistance thermometer

Pt / Ni
A B B’

IN0

A B B’

+ - NC

+ -

IN1

A B B’

+ - NC
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Troubleshooting

This chapter describes the errors that may occur with the Touch and the measures necessary to correct these errors.

  

The Touch displays a variety of error messages in order to assist you in quickly analyze and resolve problems with the 
hardware, communications system, and user screen data.

1.1 Errors Displayed on the Screen

The following error messages are displayed in the event of communication system problems and problems with user 
screen data. When an error occurs, take the appropriate indicated action. If an error persists despite your attempts to 
correct it, contact your nearest sales representative.

Chapter 30 Troubleshooting

1 Error Messages

Error Message Cause Solution
Waiting for default 
screen No.

The default screen number is set at 0. Write the screen number to System 
Area 1 (address+0), or set the Default 
Screen spin box on the System tab of 
the Project Settings dialog box to a 
value other than 0.

No screen data The specified Base Screen does not exist. Set the Base Screen and download it to 
the Touch.

Processing error • This message is displayed when a value is divided by 
0.

• There is data which cannot be handled with the 
BCD4, BCD8, or float32 data types.

• Incorrect calendar data has been saved to the Calendar 
of the Data Display.

Check the calculation or settings.

Communication Error An error occurred during communication with the 
external device.

Check the communication lines and the 
communication settings.
During 1: N communications, the port 
number of the external device on which 
the Communication error has occurred.

Device range error • The data is written to the device with the address 
out of the range.

• The number of devices exceeds the limitation.

Check the device settings.

No USB flash drive 
exists

No USB flash drive inserted when the unit attempted 
to access the USB flash drive.

Insert a USB flash drive.

This USB flash drive is 
not available

• The type of USB flash drive is not recognized by the  
Touch.

• The USB flash drive is broken.

Please use a new recommended USB 
flash drive.

USB flash drive Access 
Error

When the unit attempted to access the USB flash 
drive:
• The USB flash drive did not have enough free space.
• The USB flash drive was removed partway through.
• The USB flash drive was broken.

Create some free space on the USB 
flash drive or get a new one.

ZNV file is not found The project file (ZNV format) was not in the specified 
location on the external memory when a download was 
made using the Project Data Transfer function.

Check whether or not the file is in the 
specified location on the external 
memory.

ZNV file format Error When a download was made using the Project Data 
Transfer function:
• The project file is not in ZNV format.
• The file is corrupt.

Remake the project file (ZNV format).

Product Series is not 
correct

When a download was made using the Project Data 
Transfer function, the model of the downloaded project 
and the model of the destination Touch were different

Check that the model name that is set in 
the file you want to download is the same 
as the model name of the destination 
Touch.
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1.2 Low Battery Voltage

An internal battery maintains clock settings and log data in the Touch. When the battery runs out, keep register data, 
log data and other backup data will be cleared, and the contrast is reset to the default value. If this happens, the 
following message is displayed when the Touch is powered up, so take the indicated action.

Note that in this case, System Area 2 (address+2, bit 14) is set to 1. Turn ON the power again to set the value to 0.

Script error An error occurred for a process in execution of the script. Check the value of LSD52 and LSD53, and 
correct the script. For details, refer to 
Chapter 20 “Script” on page 20-1.

Device write error The script generated a lot of write data, and the write 
operation failed.

Reduce the number of write operations to 
be performed at the same time.

Insufficient memory 
error

The resource memory of the Touch is insufficient 
because of the use of a large number of the following 
parts.
• Pilot Lamps, Multi-State Lamps, and Picture Displays 

with the Recover Background checkbox is selected.
• Message Display and Message Switching Display with the 

Scroll checkbox is selected.
• Parts over the number limit of parts that can be set per 

screen by overlapping Base Screen.

Clear the Recover Background or Scroll 
checkbox, or delete parts to reduce 
memory resource utilization.

Indirect device error Indirect write failure with Word Button or Word Write 
Command.

Do not perform indirect read-write with 
external devices while HMI Special Internal 
Relay LSM14 or LSM15 is ON. 

Check Interface settings Touch cannot change into the Run mode because the 
Interface settings are not correct.

Modify settings using the Communication 
Interface tab of the Project Settings dialog 
box before downloading.

Network off-line This error message is only displayed when O/I Link is 
being used.

See the "External Device Setup Manual" 
for details.

TP/CP The control device timer or counter preset value was 
modified.

Press Main Menu, Initial Setting, and 
then TP/CP Change in order on the Top 
Page in the System Mode

Output circuit error The circuit for the relay output did not operate normally. If this problem occurs frequently, the  
Touch may be damaged and require 
replacement.

Analog input error The user program in which the operation mode of AI0/
AI1 is configured as the current input is downloaded to 
Touch (relay output type).

Configure the operation mode of AI0/AI1 
as the voltage input and download the 
project.

Overcurrent Voltage input is applied is applied to AI0/AI1 that is 
configured as the current input, or the applied current 
input is more than 40 mA.

Confirm the applied current/voltage on 
AI0/AI1 of the Touch (transistor output 
type).
When voltage is applied, configure the 
Operating Mode of AI0/AI1 as the voltage 
input and download the project.
When current is applied, make sure that 
the current input applied is within the 
rated input (0 to 20 mA) and cycle the 
power to the Touch.

Error Message Cause Solution

This message does not show when the Enable Low Battery Warning check box on the System tab of 
the Project Settings dialog box is not selected.

Message Description

Backup data lost The Log Data and Calendar Data are lost. Set the clock again. Keep the power ON for 
about two days to charge the battery.

In case of storing Keep Relay or Keep Register to the flash memory using HMI Special Internal Relay 
(LSM10), stored data is transferred to the memory automatically when Backup data is lost.
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There are two kinds of errors with the control functions of the Touch: general errors and program execution errors.
General errors can be checked by the state of a Special Data Register (D8005), and they can be cleared.
Program execution errors can checked by the state of a Special Data Register (D8006).

2.1 General Error Codes

The error code is stored in Special Data Register D8005. If '1' is stored in each bit of D8005, the corresponding error 
is occurring.
Also, general errors (D8005) and program execution errors (D8006) can be cleared by writing "1" to the most 
significant bit of Special Data Register D8005, using a ladder program or FBD program. Due to parts and 
communication, writing "1" to the most significant bit of D8005 will not clear errors.

● General Error Code List

2 Error Information

15 14 13

Error clear bit

12 11 10 9 8 7 6 5 4 3 2 1 0

Error information bits

D8005

bit bit bit bit

Bit No. Item Cause Solution

0 Power Failure
This error indicates when the power supply is lower 
than the specified voltage. This error is also 
recorded when the power is turned off.

Clear the error code using WindLDR.

1 Watchdog Timer 
Error

The watchdog timer monitors the time required for 
one program cycle (scan time). When the time 
exceeds the allowed time, the watchdog timer 
indicates an error.

Clear the error code using WindLDR. If 
this error occurs frequently, the Touch 
has to be replaced.

2, 3 Reserved – –

4

Timer/Counter 
Preset Value 
Sum Check 
Error

The execution data of timer/counter preset values 
is corrupted. The timer/counter preset values are 
initialized to the values of the ladder program  
automatically. Note that changed preset values are 
cleared and that the original values are restored.

Clear the error code using WindLDR.

5 Reserved – –

6 Keep Data Sum 
Check Error

This error indicates that the data designated to be 
maintained during power failure is corrupted 
because of memory backup failure.
Note that the “keep” data of internal relays and 
shift registers are cleared. Data of counters and 
data registers are also cleared.

If this error occurs in a short period of 
power interruption after the battery 
has been charged as specified, the 
battery is defective and the Touch has 
to be replaced. Clear the error code 
using WindLDR.

7 Program Syntax 
Error

This error indicates that the ladder program or FBD 
program has a syntax error.

Correct the ladder program or FBD 
program, and then download it to the 
Touch.

8 to 12 Reserved – –

13 Program 
Execution Error

This error indicates that invalid data is found 
during execution of a ladder program or FBD 
program. When this error occurs, special internal 
relay M8004 (program execution error) is turned 
on.

Refer to “2.2 Program Execution Error” 
on page 30-5 and fix and clear the 
error code. Clear the error code with 
WindO/I-NV3.

14 Reserved – –

15 Error clear bit – –
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Example: This ladder program clears the error information using the error clear bit of special data 
register D8005.
Turn on M0 and turn on the upper bit of D8005. The error information is cleared at the end of the ladder scan.

● Touch Operating Status and Output during Errors
If an error occurs, the operation and output states of the Touch will be as follows.

*1 Operation starts to run and outputs are turned on or off according to the ladder program as default, but it is also possible to 
stop operation and turn off outputs using the Function Area Settings on WindLDR

M0000

S

D8005.15

R

M0000

1

2

Error Items Operating Status Output Checked at

Power failure Stop OFF Any time

Watchdog timer error Stop OFF Any time

Program (ROM) CRC error Stop OFF Starting operation

TIM/CNT preset value sum check error Maintained Maintained
When checking a change in 
timer/counter setting values

Keep data error Maintained/Stop*1 Maintained/Stop*1 Turning power on

Program syntax error Stop OFF
Downloading a ladder program 
or FBD program

Program execution error Maintained Maintained
Executing a ladder program or 
FBD program



SmartAXIS Touch User's Manual 30-5

2 Error Information

30

Troubleshooting

2.2 Program Execution Error

This error indicates that invalid data is found during execution of a ladder program or FBD program. When this error 
occurs, the special internal relay M8004 (program execution error) is from 0 to 1. The detailed information of this 
error can be viewed from the error code stored in special data register D8006 (program execution error code).

● Ladder Program Execution Error Code (D8006)

Error Code Error Details

1 Source/destination device is out of range.

2 MUL result is out of data type range.

3 DIV result is out of data type range, or division by 0.

4 BCDLS has S1 or S1+1 exceeding 9,999.

5 S1 is 10,000 or higher in the HTOB(W) instruction, or S1 is 100,000,000 or higher in the HTOB(D) instruction.

6 BTOH has any digit of S1 exceeding 9.

7 HTOA/ATOH/BTOA/ATOB has quantity of digits to convert out of range.

8 ATOH/ATOB has non-ASCII data for S1 through S1+4.

9 In the WEEK instruction or WEEK FB, the ON time data is out of range (hour data is 24 or higher, minute data is 
60 or higher), or the OFF time data is out of range (hour data is 25 or higher, minute data is 60 or higher).

10 In the YEAR instruction or YEAR FB, the month and day data is out of range (month data is 13 or higher, day 
data is 32 or higher).

12 CVXTY/CVYTX is executed without matching XYFS.
XYFS and CVXTY/CVYTX have the same S1, but have different data types.

13 CVXTY/CVYTX has S2 exceeding the value specified in XYFS.

14 Label in LJMP, LCAL, or DJNZ is not found.

16 PID instruction execution error.

18 Attempt was made to execute an instruction that cannot be used in an interrupt program. (Refer to Chapter 3 
“4.9 Interrupt Input” on page 3-74.)

19 Attempt was made to execute an instruction that is not available for the external device.

21 DECO has S1 exceeding 255.

22 BCNT has S2 exceeding 256.

23 ICMP>= has S1 < S3.

25 BCDLS has S2 exceeding 7.

26 DI or EI is executed when interrupt input or timer interrupt is not programmed in the Function Area Settings.

27 Work area is broken when using DTML, DTIM, DTMH, DTMS, or TTIM.

28 S1 for trigonometric function instruction is invalid.

29 Result of F (float) data type instruction is out of the data type range.

30 The number of bits configured in SFTL instruction, SFTR instruction or SFR FB exceeds the valid range.

31 In the FIFOF instruction, the FIEX instruction or the FOEX instruction was executed before the FIFO data file was 
registered.

32 TADD, TSUB, HOUR, or HTOS has invalid data for source device S1 or HOUR FB has invalid data for Preset value.

34 NDSRC has invalid data for source device S3.

35 In the SUM instruction, the execution result exceeds the valid range for the selected data type, or S2 data is 0.

36 In a DLOG/TRACE instruction or DLOG/TRACE FB, the size of the CSV file has exceeded 5 MB.

42 The execution is unsuccessful in SCRPT instruction or SCRPT FB.

43 The minimum value is greater than the maximum value in RCMP FB.

44 The shift registers specified by the start shift register and the number of bits in SFR FB does not exist.

45 In RPULS FB, the lower limit of ON time is greater than the upper limit of ON time, or the upper limit of ON time 
is greater than the cycle.
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3.1 When You Cannot Download Project Data

If you are unable to download project data from the WindO/I-NV3, press the top left corner of the panel for three 
seconds while at the same time turning the power off and back on again.

When power is turned on again, the screen in the System Mode is displayed, and then Touch becomes downloadable 
status. If you download using Ethernet and O/I Link, check again each setting of TCP/IP and O/I Link before 
executing the download.

3.2 When the Backlight is OFF and the Buzzer Sounds

If you fail to download the runtime system to Touch, the backlight may turn to OFF and a buzzer may sound 
continuously every second, even after the power has been turned off and on again. If this happens, rectify the 
situation by doing the following:
Download the project and the runtime system by using WindO/I-NV3 via USB cable. When the Touch is in this state, 
projects cannot be downloaded via Ethernet or using an external  memory.
To download the runtime system, when you download a project, click Option on the Download dialog box in WindO/
I-NV3, and then select Download Runtime system on the Options dialog box.

3 Handling Problems
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3.3 When a Problem Occurs with a Control Function

This section describes the procedures to determine the cause of trouble and actions to be taken when any trouble of 
the Control Function occurs while operating the Touch. In case of any trouble, refer to the following table to 
determine the cause and to correct the error.

Problem Cause Action

Ladder program or FBD 
program doesn't execute.

M8000 is not "1". Set "1" to M8000.

The stop or rest input is designated using Function 
Area Settings.

Set "0" to the stop and reset inputs.

Input does not operate 
normally.

Input device is not "1".
Correct the program.

Input device address is incorrect.

The input wiring is incorrect. Correct the input wiring.

The input terminal is not powered.
Supply the rated voltage to the input 
terminal.

Wiring or operation of external device is incorrect. Correct the external device wiring.

Output does not operate 
normally.

Output device addresses are incorrect.
Correct the ladder program or FBD 
program.

Output does not turn on and off.
The output circuit in the Touch is 
damaged. Replace the Touch.

Touch output connection is incorrect. Correctly connect the output.

Ladder program or FBD 
program cannot be 
stopped.

The stop or reset input is designated in the 
Function Area Settings.

Set "1" to the designated input.

The designated stop or reset input does not turn 
on and off.

Input does not work normally. Replace 
the Touch.

M8000 is not "0". Set "0" to M8000.

Watchdog timer error 
occurs.

The scan time exceeds the time configred for the 
watchdog timer.

NOP instruction can reset the watchdog 
timer.
Insert a NOP instruction into the ladder 
program so the time configured for the 
watchdog timer is not exceeded.

The interrupt/catch input 
cannot receive short 
pulses.

The input ON/OFF voltage level are not correct. Make sure of correct input voltage.

Frequency measurement 
does not work.

Signals are not input to the Groups 1 through 5.
Select Single-phase High-speed 
Counter in the Groups 1 through 5.

The function settings in WindLDR is not configured 
correctly.

Specify the used group in the 
frequency measurement settings.
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Appendix

This chapter contains the Color Number Correspondence Table, and describes details about the Color Palette and 
other settings used in WindO/I-NV3.

  

This table is used when using Message Display and Script.  Select a value from the Data column of the table and you 
can change the display color of an object.

Appendix

1 Color Number Correspondence Table

Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data Color No. Data
041 0x29 083 0x53 125 0x7D 167 0xA7 209 0xD1

000 0x00 042 0x2A 084 0x54 126 0x7E 168 0xA8 210 0xD2

001 0x01 043 0x2B 085 0x55 127 0x7F 169 0xA9 211 0xD3

002 0x02 044 0x2C 086 0x56 128 0x80 170 0xAA 212 0xD4

003 0x03 045 0x2D 087 0x57 129 0x81 171 0xAB 213 0xD5

004 0x04 046 0x2E 088 0x58 130 0x82 172 0xAC 214 0xD6

005 0x05 047 0x2F 089 0x59 131 0x83 173 0xAD 215 0xD7

006 0x06 048 0x30 090 0x5A 132 0x84 174 0xAE 216 0xD8

007 0x07 049 0x31 091 0x5B 133 0x85 175 0xAF 217 0xD9

008 0x08 050 0x32 092 0x5C 134 0x86 176 0xB0 218 0xDA

009 0x09 051 0x33 093 0x5D 135 0x87 177 0xB1 219 0xDB

010 0x0A 052 0x34 094 0x5E 136 0x88 178 0xB2 220 0xDC

011 0x0B 053 0x35 095 0x5F 137 0x89 179 0xB3 221 0xDD

012 0x0C 054 0x36 096 0x60 138 0x8A 180 0xB4 222 0xDE

013 0x0D 055 0x37 097 0x61 139 0x8B 181 0xB5 223 0xDF

014 0x0E 056 0x38 098 0x62 140 0x8C 182 0xB6 224 0xE0

015 0x0F 057 0x39 099 0x63 141 0x8D 183 0xB7 225 0xE1

016 0x10 058 0x3A 100 0x64 142 0x8E 184 0xB8 226 0xE2

017 0x11 059 0x3B 101 0x65 143 0x8F 185 0xB9 227 0xE3

018 0x12 060 0x3C 102 0x66 144 0x90 186 0xBA 228 0xE4

019 0x13 061 0x3D 103 0x67 145 0x91 187 0xBB 229 0xE5

020 0x14 062 0x3E 104 0x68 146 0x92 188 0xBC 230 0xE6

021 0x15 063 0x3F 105 0x69 147 0x93 189 0xBD 231 0xE7

022 0x16 064 0x40 106 0x6A 148 0x94 190 0xBE 232 0xE8

023 0x17 065 0x41 107 0x6B 149 0x95 191 0xBF 233 0xE9

024 0x18 066 0x42 108 0x6C 150 0x96 192 0xC0 234 0xEA

025 0x19 067 0x43 109 0x6D 151 0x97 193 0xC1 235 0xEB

026 0x1A 068 0x44 110 0x6E 152 0x98 194 0xC2 236 0xEC

027 0x1B 069 0x45 111 0x6F 153 0x99 195 0xC3 237 0xED

028 0x1C 070 0x46 112 0x70 154 0x9A 196 0xC4 238 0xEE

029 0x1D 071 0x47 113 0x71 155 0x9B 197 0xC5 239 0xEF

030 0x1E 072 0x48 114 0x72 156 0x9C 198 0xC6 240 0xF0

031 0x1F 073 0x49 115 0x73 157 0x9D 199 0xC7 241 0xF1

032 0x20 074 0x4A 116 0x74 158 0x9E 200 0xC8 242 0xF2

033 0x21 075 0x4B 117 0x75 159 0x9F 201 0xC9 243 0xF3

034 0x22 076 0x4C 118 0x76 160 0xA0 202 0xCA 244 0xF4

035 0x23 077 0x4D 119 0x77 161 0xA1 203 0xCB 245 0xF5

036 0x24 078 0x4E 120 0x78 162 0xA2 204 0xCC 246 0xF6

037 0x25 079 0x4F 121 0x79 163 0xA3 205 0xCD 255 0xF7

038 0x26 080 0x50 122 0x7A 164 0xA4 206 0xCE

039 0x27 081 0x51 123 0x7B 165 0xA5 207 0xCF

040 0x28 082 0x52 124 0x7C 166 0xA6 208 0xD0
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The View Browser displays the list of graphics that have been prepared in advance in WindO/I-NV3. The settings 
displayed on View Browser vary based on the parts.
These graphics can be used as the outline of parts.
Example: Bit Button

■ Type
Selects the category of graphics.

■ OFF, ON
Displays the graphic when OFF or ON. Click ON or OFF to switch the graphics displayed on the list.

■ Picture List
Displays the list of registered graphics. Select the graphic to use as the outline of the part.

■ OK
Closes the View Browser and sets the selected graphic to the caller.

2 View Browser
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The Color Palette is used to select colors for drawing objects, text on parts, outlines, flanges, plates and other objects.
The Color Palette appears when you click on the Color button in the object’s Properties dialog box.

● Functions of Color Palette buttons

■ Color
Selects a color. Clicking these buttons sets the Color button to the selected color.

■ >>More, <<Less
Switches the palette display. Clicking >> More shows all the colors assignable to the Color button. Clicking << 
Less shows only the basic colors assignable to the Color button.

■ TMC
This feature allows use of the text color specified in Text Manager. Click this button to use the text color specified in 
Text Manager. The TMC button appears on the Color Palette only if the Use Text Manager check box is selected.

● Color Palette Types
The type of color palette shown varies based on the series being used.

■ 256 Color Palette*1

■ 8 shades Monochrome Palette*2

*1 Color LCD models only
*2 Monochrome LCD models only

3 Color Palette

Color buttons

TMC button

>> More button

<< Less button

TMC button

Color buttons >> More button

<< Less button
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The Pattern Palette is used to select patterns for drawing objects, part outlines, flanges, and other objects.

The Pattern Palette appears when you click on the Pattern button in the object’s Properties dialog box.
Click the Pattern button and select a pattern.

Drawings

Parts

● Foreground and Background Colors
Drawing objects, part outlines and flanges are formed by foreground and background colors.
The selected pattern is applied to the foreground color.

The background color is visible through the unpainted parts of the foreground color.

● Patterns
These patterns are available on WindO/I-NV3.

*1 None can only be applied to drawing objects. Selecting None is the same as not applying any color at all.

4 Pattern Palette

Pattern buttons

Pattern buttons

Foreground color
Background color

Pattern name None*1 Foreground 
100%

Foreground 
25%

Foreground 
50%

Background 
100%

Pattern buttons

Display sample

Pattern name
Horizontal 

lines
Vertical lines Slant Upwards

Slant 
Downwards

Crosshatch Tint

Pattern buttons

Display sample
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Text Alignment is used to adjust the way text appears on Drawing Objects and Parts.

● Horizontal Writing
These examples show how text appears using different combinations of the Align Text Horizontal and Align Text 
Vertical properties.

■ Align Text Vertical

5 Text Alignment

Align Text Horizontal
Left Center Right Center-Left

Align Text 
Vertical

Top ---

Center
(Center-

Top)

Bottom ---

Top: Aligns the text along the top edge.

Center (Center-Top): Centers the text vertically in the center.

Bottom: Aligns the text along the bottom edge.

Aligns text along top edge

Centers text in the middle

Aligns text along bottom edge
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■ Align Text Horizontal

● Vertical Writing
These examples show how text appears for Align Text Horizontal.
Align Text Vertical defaults to Top.

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Center-Left: Centers the line containing the most number of characters, and then aligns the other lines 
to the left end of that line.

Aligns along left edge

Centers text in the middle

Aligns along right edge

Aligns to left end of line with most characters

Centers line with most characters

If Align Text Horizontal is set to Center-Left, Align Text Vertical will automatically be set to Center-
Top. Center-Top results in the same display as Center.

Align Text Horizontal
Left Center Right

Align 
Text 

Vertical
Top
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■ Align Text Horizontal

Left: Aligns the text along the left edge.

Center: Centers the text horizontally in the center.

Right: Aligns the text along the right edge.

Aligns along left edge

Centers text in the middle

Aligns along right edge

Take note of these points when the Vertical Writing check box is selected:
• When there is a mixture of double-byte and single-byte characters, the half-width characters are left 

aligned.

• Dashes are displayed horizontally. Symbols representing voiced and semi-voiced sounds of single-byte 
characters are shown as follows.

Aligned to 
left edge

Horizontal
display

Next
characters
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This section describes details on ladder program processing, instruction execution times, and the byte count for 
instructions.

6.1 Processing in One Scan

While the Touch is running, the Touch performs operations repeatedly such as input refreshing, ladder program 
processing, and error checking. A scan is the execution of all instructions from the first line of the ladder program to 
the END instruction. The time required for this execution is referred to as one scan time. The scan time varies with 
respect to program length. 
The current value of the scan time is stored to special data register D8023 (scan time current value), and the 
maximum value of the scan time is stored to special data register D8024 (scan time maximum value). 

6.2 Executing Program Instructions

During the scan time, the ladder program is executed sequentially from the top to the bottom except when interrupt 
programs are executed. One scan time of a ladder program is approximately equal to the total of execution time of 
each instruction.
For the instruction execution times, refer to “6.4 Execution Times for Instructions” on page A-9.

6.3 Breakdown of END Processing Time

With the Touch, processing that occurs outside ladder program processing is referred to as END processing. This 
includes the processing for I/O refreshing and error checking.

6 Ladder Program

When the processing time for one scan exceeds the specified time, a watch dog timer error occurs and the 
system is reset. For details on the watchdog timer, refer to Chapter 3 “4.17 Watchdog Timer Setting” on 
page 3-98.

Item END Processing Time

Housekeeping (built-in I/O service) 5 msec min.
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6.4 Execution Times for Instructions

Instruction
Device and 
Condition

Execution 
Time (μs)

LOD, LODN
― 1.58

Using data 
register

2.71

OUT, OUTN
― 1.13

Using data 
register

2.17

SET, RST
― 1.08

Using data 
register

2.17

AND, ANDN, OR, ORN
― 0.81

Using data 
register

2.46

AND·LOD, OR·LOD ― 0.85

BPS ― 0.99

BRD ― 0.99

BPP ― 0.99

SOTU, SOTD ― 2.16

TML, TIM, TMH, TMS ― 5.45

TMLO, TIMO, TMHO, TMSO ― 5.45

CNT, CDP, CUD ― 4.33

CNTD, CDPD, CUDD ― 126.1

SFR, SFRN N bits 42.7+0.4n

CC=, CC≥ ― 2.38

DC=, DC≥ ― 2.94

MCS, MCR, JMP, JEND ― ―

END ― ―

NOP ― ―

MOV, MOVN (W, I)
M→M 44.7

D→D 4.3

MOV, MOVN (D, L)
M→M 84.5

D→D 84.5

MOV (F) ― 84.5

IMOV, IMOVN (W)
M+D→M+D 48.4

D+D→D+D 7.7

IMOV, IMOVN (D) D+D→D+D 87.9

IMOV (F) ― 87.9

IBMV, IBMVN
M+D→M+D 47.5

D+D→D+D 47.5

BMOV D→D 90.3+1.4n

NSET (W, I) D→D 1.8+2.5n

NSET (D, L) D→D 1.8+83.0n

NSET (F) D→D 1.8+83.0n

NRS (W, I) D, D→D 16.5

NRS (D, L) D, D→D 732.5

NRS (F) D, D→D 732.5

XCHG D↔D 5.1

TCCST (W) D→T 4.81

TCCST (D) D→T 85.5

CMP (=, <>, <, >, ≤, ≥) (W, I) D↔D→M 47.0

CMP (=, <>, <, >, ≤, ≥) (D, L) D↔D→M 127.5

CMP (=, <>, <, >, ≤, ≥) (F) D↔D→M 127.5

ICMP (≥) D↔D↔D→M 169.5

LC (=, <>, <, >, ≤, ≥) (W, I) D↔D 5.0

LC (=, <>, <, >, ≤, ≥) (D, L) D↔D 86.5

LC (=, <>, <, >, ≤, ≥) (F) D↔D 86.5

ADD (W, I)
M+M→D 86.5

D+D→D 47.3

ADD (D, L)
M+M→D 166.3

D+D→D 167.3

ADD (F) D+D→D 171.9

SUB (W, I)
M-M→D 86.5

D-D→D 47.3

SUB (D, L)
M-M→D 166.3

D-D→D 167.3

SUB (F) D-D→D 171.9

MUL (W, I)
M×M→D 86.5

D×D→D 47.3

MUL (D, L)
M×M→D 166.3

D×D→D 167.3

MUL (F) D×D→D 171.9

DIV (W, I)
M÷M→D 86.5

D÷D→D 9.3

DIV (D, L)
M÷M→D 166.3

D÷D→D 167.3

DIV (F) D÷D→D 171.9

INC (W, I) ― 44.7

INC (D, L) ― 124.5

DEC (W, I) ― 44.7

DEC (D, L) ― 124.5

ROOT (W) →D 5.5

ROOT (D) →D 86.7

ROOT (F) →D 886.5

SUM (W, I) D, D→D 47.6+1.1n

SUM (D, L) D, D→D 90.5+41.5n

SUM (F) D, D→D 90.5+45.0n

ANDW, ORW, XORW (W)
M·M→D, 46.1

D·D→D 5.7

ANDW, ORW, XORW (D) D·D→D 127.1

SFTL, SFTR N_B=100 56.1

BCDLS D→DS1=1 49.9

WSFT D→D 91.3

ROTL, ROTR D, bits=1 44.9

HTOB D→D 10.5

Instruction
Device and 
Condition

Execution 
Time (μs)

D  

D  

D  
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*1 The SCRPT instruction execution time is stored in D1+1 after the instruction is executed.

BTOH D→D 11.1

HTOA D→D 13.7

ATOH D→D 6.0

BTOA D→D 13.7

ATOB D→D 56.3

ENCO M→Dbits=16 6.9

DECO D→M 50.0

BCNT M→Dbits=16 ―

ALT ― 42.7

CVDT
W, I, D, L→F 53.0

F→W, I, D, L 56.3

DTDV D→D 8.9

DTCB D→D 10.4

SWAP (W) ― 8.9

SWAP (D) ― 89.7

WEEK ― ―

YEAR ― ―

LABEL ― ―

LJMP ― ―

LCAL ― ―

LRET ― ―

DJNZ ― ―

IOREF ― 46.8

HSCRF ― 46.8

DI ― 90.3

EI ― 54.1

XYFS ― ―

CVXTY ― ―

CVYTX ― ―

AVRG (W, I) S3=10 6.38

AVRG (D, L) S3=10 49.5

AVRG (F) S3=10 55.1

DTML, DTIM, DTMH ― 60.2

DTMS ― 63.0

TTIM ― 60.3

RAD F→F 143.9

DEG F→F 143.9

SIN, COS F→F 161.1

TAN F→F 149.1

ASIN, ACOS F→F 618.9

ATAN F→F 616.5

LOGE, LOG10 F→F 206.0

EXP F→F 172.5

POW F→F 191.0

FIFOF ― 129.0

FIEX ― 129.0

Instruction
Device and 
Condition

Execution 
Time (μs)

FOEX ― 129.0

NDSRC (W, I) D, D, D→D 19.5

NDSRC (D, L) D, D, D→D 782.5

NDSRC (F) D, D, D→D 782.5

TADD ― 54.4

TSUB ― 54.4

HOUR D→D, Y, D 20.6

HTOS ― 52.7

STOH D→D 92.1

SCRPT ― *1

PID ― ―

Instruction
Device and 
Condition

Execution 
Time (μs)
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6.5 Instruction Bytes

The quantities of bytes of basic and advanced instructions are listed below.

● Basic Instruction

● Advanced Instruction

Basic 
Instruction

Qty of Bytes

When not using 
data registers

Using data 
registers

LOD 4 8

LODN 4 8

OUT 4 8

OUTN 4 8

SET 4 8

RST 4 8

AND 4 8

ANDN 4 8

OR 4 8

ORN 4 8

AND·LOD 4 ―

OR·LOD 4 ―

BPS 4 ―

BRD 4 ―

BPP 4 ―

SOTU 4 ―

SOTD 4 ―

TML 8 ―

TIM 8 ―

TMH 8 ―

TMS 8 ―

TMLO 8 ―

TIMO 8 ―

TMHO 8 ―

TMSO 8 ―

CNT 8 ―

CDP 8 ―

CUD 8 ―

CNTD 8 ―

CDPD 8 ―

CUDD 8 ―

SFR 8 ―

SFRN 8 ―

CC= 8 ―

CC>= 8 ―

DC= 8 ―

DC>= 8 ―

MCS 4 ―

MCR 4 ―

JMP 4 ―

JEND 4 ―

END 4 ―

Basic 
Instruction

Qty of Bytes

When not using 
data registers

Using data 
registers

Advanced Instruction Qty of Bytes

NOP 4

MOV, MOVN 12 to 16

IMOV, IMOVN 16

IBMV, IBMVN 16 to 24

BMOV 12 to 16

NSET 12 to 1,540

NRS 12 to 20

XCHG 12 to 16

TCCST 12 to 16

CMP (=, <>, <, >, <=, >=) 16 to 24

ICMP>= 16 to 28

LC (=, <>, <, >, <=, >=) 12 to 20

ADD, SUB, MUL, DIV 16 to 24

INC, DEC 8

ROOT 12 to 20

SUM 16 to 20

ANDW, ORW, XORW 16 to 24

SFTL, SFTR 12

BCDLS 12 to 16

WSFT 12 to 20

ROTL, ROTR 12

HTOB, BTOH 12 to 16

HTOA 12 to 20

ATOH 12 to 20

BTOA 12 to 20

ATOB 12 to 20

ENCO 12 to 16

DECO 12 to 16

BCNT 12 to 20

ALT 8

CVDT 12 to 20

DTDV 12 to 16

DTCB 12 to 16

SWAP 12 to 16

Advanced Instruction Qty of Bytes
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WEEK 20 to 532

YEAR 24 to 216

LABEL 8

LJMP 8 to 12

LCAL 8 to 12

LRET 8

DJNZ 12 to 16

IOREF 12

HSCRF 8

DI 8

EI 8

XYFS 20 to 268

CVXTY, CVYTX 16 to 20

AVRG 16 to 24

DTML, DTIM, DTMH, DTMS 16 to 20

TTIM 8 to 12

RAD 12 to 16

DEG 12 to 16

SIN 12 to 16

COS 12 to 16

TAN 12 to 16

ASIN 12 to 16

ACOS 12 to 16

ATAN 12 to 16

LOGE 12 to 16

LOG10 12 to 16

EXP 12 to 16

POW 12 to 24

FIFOF 20 to 24

FIEX 12

FOEX 12

NDSRC 16 to 24

TADD 16 to 20

TSUB 16 to 20

HOUR 16 to 24

HTOS 12 to 16

STOH 12 to 16

SCRPT 12 to 16

PID 112

Advanced Instruction Qty of Bytes
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This section describes details on FBD program processing, FB execution time, and the byte count for FBs.

7.1 Processing in One Scan

While the Touch is running, the Touch continue to perform operations such as input refreshing, FBD program 
processing, and error checking. The execution of such a set of processing is defined as a scan. The time required for 
this execution is referred to as one scan time. The scan time varies depending on the created FBD program. 
The current value of the scan time is stored to special data register D8023 (scan time current value), and the 
maximum value of the scan time is stored to special data register D8024 (scan time maximum value). 

7.2 FBD Program Processing

In FBD programs, all of the FBs connected to the output FB (digital output FB or internal relay FB) are executed 
sequentially from the input FBs. The FBD program processing time in one scan is approximately equal to the total of 
execution time of each FB.
For the execution time of each FB, refer to “7.4 FB Execution Time” on page A-14.

7.3 Breakdown of Scan End Processing Time

After processing the FBD program, the Touch processes housekeeping operations at the end of each scan. It is 
referred to as Scan End processing. This includes the operations such as I/O refreshing and error checking.

7 FBD Program

If the processing time for one scan exceeds the specified time for the watchdog timer, a watchdog timer 
error occurs and the system is reset. For details on the watchdog timer, refer to Chapter 3 “4.17 Watchdog 
Timer Setting” on page 3-98.

Item Processing Time

Scan End Processing 5 msec min.
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7.4 FB Execution Time

Group Name Symbol Device and Condition Execution time (μsec)

Logical 
Operation

Logical AND AND ― 73.0

Negative Logical AND NAND ― 73.2

Logical OR OR ― 73.2

Negative Logical OR NOR ― 73.0

Exclusive Logical OR XOR ― 72.6

Negative Exclusive Logical 
OR

XNOR ― 72.8

Negation NOT ― 70.8

Shot Up SOTU ― 72.6

Shot Down SOTD ― 72.8

Truth Table TRUTH ― 73.4

Timer

On-delay Count Up Timer TIMU ― 74.8

On-delay Count Down 
Timer

TIMD ― 74.6

Off-delay Count Up Timer TIMOU ― 75.0

Off-delay Count Down 
Timer

TIMOD ― 75.0

On/off-delay Timer TIMCU ― 77.4

Single Shot Pulse SPULS ― 74.8

Dual Timer DTIM ― 72.2

Random Pulse Output RPULS ― 95.2

Counter

Adding Counter CNT
W (Word) 75.0

D (Double word) 152.0

Up/Down Selection 
Reversible Counter

CUD
W (Word) 75.6

D (Double word) 126.8

Hour Meter HOUR ― 94.6

Shift Register Shift Register SFR ― 50.8

Data 
Comparison

Data Comparison CMP ― 82.0

Schmitt Trigger STTG ― 79.8

Range Comparison RCMP ― 81.6

Data Conversion Alternate Output ALT ― 59.2

Week 
Programmer

Weekly Timer WEEK ― 112.8

Yearly Timer YEAR ― 113.6

Script Script SCRPT ― ―

Special
High-speed Counter HSC ― 159.0

RS Flip-flop RSFF ― 53.2
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7.5 FBD Program Limitation

FBD programs have a limitations on the program size and the number of FBs. Even when the FBD program is less 
than the maximum size, FBs cannot be added to the FBD program if the number of used FBs is at the maximum.
The size of the FBD program is the total of the size of all FBs used in the FBD program.
The number of Block (B) is the number of FBs that use blocks (B) in the program. The number of Timer (T) and 
Counter (C) is the total of devices used in the timer FB and counter FB. These are not the number of timer FBs and 
counter FBs.

Maximum size of FBD program 38,000 bytes

Maximum number of blocks, timers, 
and counters that can be used in the 
FBD program

Block (B) 1,000

Timer (T) 200

Counter (C) 200

The timer FB, counter FB, and depending on the FB, multiple devices may be used. For details about each 
FB, refer to the description in the "SmartAXIS FBD Programming Manual".
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● FB Size and Number of Used Devices
The size (quantities of bytes) and the number of used devices of FBs are listed below.

*1 The size of the WEEK/YEAR FB varies depending on the number of tabs.

Group Name Symbol Qty of Bytes Device type
Number of 

Used devices

Logical 
Operation

Logical AND AND 12

B

1

Negative Logical AND NAND 12 1

Logical OR OR 12 1

Negative Logical OR NOR 12 1

Exclusive Logical OR XOR 8 1

Negative Exclusive Logical 
OR

XNOR 8 1

Negation NOT 8 1

Shot Up SOTU 8 1

Shot Down SOTD 8 1

Truth Table TRUTH 16 1

Timer

On-delay Count Up Timer TIMU 8

T

1

On-delay Count Down 
Timer

TIMD 8 1

Off-delay Count Up Timer TIMOU 12 1

Off-delay Count Down 
Timer

TIMOD 12 1

On/off-delay Timer TIMCU 12 2

Single Shot Pulse SPULS 12 1

Dual Timer DTIM 12 3

Random Pulse Output RPULS 12 3

Counter

Adding Counter
CNT(W) 12

C

1

CNT(D) 12 2

Up/Down Selection 
Reversible Counter

CUD(W) 16 3

CUD(D) 16 6

Hour Meter HOUR 12 3

Shift Register Shift Register SFR 16

B

1

Data 
Comparison

Data Comparison CMP 16 1

Schmitt Trigger STTG 20 1

Range Comparison RCMP 20 1

Data Conversion Alternate Output ALT 12 1

Week 
Programmer

Weekly Timer*1 WEEK 20 to 130 1

Yearly Timer*1 YEAR 24 to 212 1

Script Script SCRPT 12 1

Special
High-speed Counter HSC 12 1

RS Flip-flop RSFF 8 1
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● FBD Program Examples

Example program 1

For example, in the above FBD program, the program size and the number of used devices can be calculated as 
described below.

Example program 2

For example, in the above FBD program, the program size and the number of used devices can be calculated as 
described below.

Block number FB Size (Qty of Bytes)
Number of Used devices

Block (B) Timer (T) Counter (C) 
M8125 SM Special Internal Relay

Special internal relays, inputs, and outputs do not affect the FBD 
program size or the number of used devices.

I1 I Input
Q0 Q Output
B1 WEEK Weekly Timer 24 (Number of tabs: 2) 1 0 0
T0 DTIM Dual Timer 12 0 3 0
B2 OR Logical OR 12 1 0 0

Total 48 (Program size) 2 3 0

Block number FB Size (Qty of Bytes)
Number of Used devices

Block (B) Timer (T) Counter (C) 
I1 I Input

Inputs, analog inputs, and internal relays do not affect the FBD 
program size or the number of used devices.

I2 I Input
I3 I Input
I4 I Input
AI1 AI Analog Input

M0003 M Internal Relay
B1 AND Logical AND 12 1 0 0
B2 OR Logical OR 12 1 0 0
B3 STTG(I) Schmitt Trigger 20 1 0 0
C10 CNT(W) Counter 12 0 0 1

Total 56 (Program size) 3 0 1
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